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Software End User License Agreement
IMPORTANT: PLEASE READ CAREFULLY. The software product provided to you by Topcon Positioning Sys-
tems, Inc. ("TPS") along with its associated manuals and documentation (collectively, the “Software”) is owned
by TPS and your use is subject to the terms and conditions of this Software License End-User Agreement
(“Agreement”) set forth below. If you are entering into this agreement on behalf of a company or other legal
entity, you represent that you have the authority to bind such entity to these terms and conditions, in which case
the terms "you" or "your" shall refer to such entity. If you do not have such authority, or if you do not agree with
these terms and conditions, you may not use the service. TPS also reserves the right to immediately terminate this
agreement and suspend, cancel or delay the service for failure to comply with the terms provided herein.

By clicking the “ACCEPT” button below, or by installing or using the Software, you agree to be bound by the
terms and conditions of this Agreement. In addition, by clicking the “ACCEPT” button below, you agree to be
bound by the terms and conditions of the Terms of Use of the Web site www.magnet-enterprise.com (the “TPS
Site”). If you do not agree, exit out of the TPS Site and you will not be authorized to use the Software or oth-
erwise utilize the documentation accompanying the Software.

Safety. IMPROPER USE OF A TOPCON PRODUCT CAN LEAD TO INJURY TO PERSONS OR
PROPERTY AND/OR MALFUNCTION OF THE PRODUCT. THE PRODUCT SHOULD ONLY BE
REPAIRED BY AUTHORIZED TPS WARRANTY SERVICE CENTERS. USERS SHOULD REVIEW AND
HEED THE SAFETY WARNINGS IN THE MANUAL ACCOMPANYING THE PRODUCT.

Ownership of the Software. The Software and the accompanying documentation are owned by TPS and its
respective licensors and are protected by United States and international copyright laws and other intellectual
property laws.

Professional Use. The Software is designed to be used by a professional. The user is required to be a professional
surveyor or have a good knowledge of surveying and be familiar with the safe use of such products, in order to
understand the user instructions before operating the Software.

Restrictions on Use and Transfer. You may not modify, adapt, translate, reverse engineer, decompile, or dis-
assemble the Software or create derivative works from the Software, any component thereof or any related doc-
umentation, nor may you remove, modify or hide or otherwise make unreadable or non-viewable any notice,
legend, advice, watermark trademark, service mark, or other designation contained on the Software, component
thereof, documentation, or output therefrom. You may not distribute registered copies of the Software to third
parties, including, without limitation rent, lease, or lend the Software to third parties. You agree to not use, permit
the use, or use the Software in violation of any U.S. Federal, state, or local laws or regulations or any foreign law
or regulation, including laws regarding intellectual property rights in or laws or regulations regarding the trading
or exchange of securities or concerning the Software. You further agree to use the Software solely for its inten-
ded purpose. The Software and all related information you may come to learn related to the Software and TPS’
operations in connection therewith is confidential in nature. You agree to take all reasonably necessary pre-
cautions to protect TPS’ confidential information and exercise at least the same degree of care in safeguarding
the confidential information as you would with your own most valuable confidential information.

Support Services. TPS may provide you with support services related to the Software ("Support Services"). Any
supplemental software code provided to you as part of the Support Services shall be considered part of the Soft-
ware and subject to the terms and conditions of this Agreement.

Grant of License to Software. If you have purchased or otherwise received Software from TPS, TPS grants you
the right to install and use copies of the Software on your computer running a validly licensed copy of the oper-
ating system for which the Software was designed (e.g., Windows CE 6.0, Windows Mobile, Windows XP,
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Windows Vista, Windows 7). This license is coterminous with the Term set forth in the Master Subscription
Agreement for the Magnet Terms of Use and is a personal, non-exclusive, non-transferable (except as expressly
set forth herein) license to use such Software under the terms stated herein and in any case only with a single
Device. A “Device” means a personal computer or the product upon which the Software is intended (pursuant to
its applicable documentation) to be installed and used. You may permanently transfer rights under this Agreement
only as part of a permanent sale or transfer of the Device, and only if the recipient agrees to this Agreement. If
the Software is an upgrade, any transfer must also include all prior versions of the Software. The license is effect-
ive until terminated. You may terminate the license at any time by destroying the Software and related doc-
umentation. Without prejudice to any other rights of TPS, TPS may terminate your license if you fail to comply
with the terms and conditions of this Agreement. In such event, you must destroy all copies of the Software in
your possession.

Maintenance of the Software. TPS agrees to provide Maintenance (as defined herein) to you for the first year
from the date you enter into this Agreement, at no additional charge, pursuant to the terms and conditions set forth
herein. Following the first year, and for successive years thereafter (“each year defined as a Term(s)”), in order
to receive continued Maintenance, you must pay the Maintenance Fee at the start of each Term as set forth by
TPS. Failure to renew Maintenance for a new Term may result in you having to enter into a new Agreement in
order to receive Maintenance.

Maintenance is defined as any improvements or modifications to the Software that TPS makes generally available.
Any such improvements or modifications shall become part of the Software for all purposes of this Agreement.
You acknowledge and agree that the Maintenance to be provided by TPS hereunder is limited to the most current
version of the Software and the immediately preceding version. Activation of your Software is required in order to
receive the most currently available Maintenance features.

Disclaimers. EXCEPT FOR ANY WARRANTIES IN A WARRANTY CARD ACCOMPANYING THE
SOFTWARE (AND ALL MAINTENANCE), THE SOFTWARE IS PROVIDED “AS IS.” TPS MAKES NO
PROMISES, REPRESENTATIONS OR WARRANTIES, WHETHER EXPRESSED OR IMPLIED,
REGARDING OR RELATING TO THE SOFTWARE (INCLUDING, WITHOUT LIMITATION, THAT THE
SOFTWARE WILL BE ERROR-FREE OR AVAILABLE FOR USE AT ALL TIMES) OR CONTENT
THEREIN OR TO ANY OTHER MATERIAL FURNISHED OR PROVIDED TO YOU PURSUANT TO
THIS AGREEMENT OR OTHERWISE, AND TPS SPECIFICALLY DISCLAIMS ALL IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR
PURPOSE WITH RESPECT TO SAID MATERIALS OR THE USE THEREOF. TO THE MAXIMUM
EXTENT ALLOWABLE BY LAW, THE UNIFORM COMMERCIAL CODE OR OTHER UNIFORM LAWS
SHALL NOT APPLY TO THIS AGREEMENT.

Trademarks. The TPS name, the TPS logo, and the product names associated with the Service are trademarks of
TPS and no right or license is granted to use them. Product and company names mentioned herein may be trade-
marks of their respective owners.

Microsoft® Bing™ maps is used in Magnet™. Microsoft® Terms of Use for Bing™ maps can be found at:
http://www.microsoft.com/maps/assets/docs/terms.aspx#11. © 2011 Microsoft Corporation. All rights reserved.

RealDWG ™ and Autodesk® RealDWG by Autodesk, Inc are used in Magnet™. Copyright © 1998-2011
Autodesk, Inc. All rights reserved. Information can be found at www.autodesk.com/autodeskrealdwg

Limitation of Liability. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED IN THE SOFTWARE OR ITS DOCUMENTATION.
TO THE MAXIMUM EXTENT ALLOWABLE BY LAW, IN NO EVENT SHALL TPS OR ITS PERSONNEL
BE LIABLE UNDER ANY CLAIM, DEMAND OR ACTION ARISING OUT OF OR RELATING TO THE
SOFTWARE, ITS USE, INSTALLATION OR TPS'S PERFORMANCE OR LACK THEREOF UNDER THIS
AGREEMENT FOR ANY SPECIAL, INDIRECT, INCIDENTAL, EXEMPLARY OR CONSEQUENTIAL
DAMAGES, WHETHER OR NOT TPS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH CLAIM,
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DEMAND OR ACTION. UNDER NO CIRCUMSTANCES, INCLUDING BUT NOT LIMITED TO A
NEGLIGENT ACT, WILL TPS OR ITS AFFILIATES, AGENTS, EMPLOYEES, OR LICENSORS BE
LIABLE FOR ANY DAMAGES OF ANY KIND THAT RESULT FROM (i) THE USE OR THE INABILITY
TO USE THE SOFTWARE; (ii) THE TIMELINESS, DELETION, MISDELIVERY, OR FAILURE TO
STORE ANY DATA, COMMUNICATIONS OR SETTINGS; (iii) THE COST OF GETTING SUBSTITUTE
GOODS AND SERVICES; OR (iv) UNAUTHORIZED ACCESS TO OR ALTERATION OF YOUR
TRANSMISSIONS OR DATA EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ADDITION, WITHOUT LIMITING THE FOREGOING, IN ALL EVENTS THE
REMEDIES AVAILABLE TO YOU SHALL BE LIMITED TO THE GREATER OF THE AMOUNT PAID
BY YOU TO TPS FOR THE RIGHT TO USE THE SOFTWARE OR $100.

Indemnification. YOU SHALL INDEMNIFY AND HOLD TPS AND ITS AGENTS, OFFICERS,
MANAGERS, EMPLOYEES AND MEMBERS HARMLESS FROM AND AGAINST ANY AND ALL
CLAIMS, DEMANDS, SUITS, JUDGMENTS AND EXPENSES (INCLUDING REASONABLE LEGAL
FEES AND EXPENSES) ARISING OUT OF OR RELATING TO THE BREACH BY YOU OF YOUR
OBLIGATIONS UNDER THIS AGREEMENT OR TO INTELLECTUAL PROPERTY
MISAPPROPRIATION OR INFRINGEMENT CLAIMS BY ANY THIRD PARTY BASED ON OR
RELATING TO YOUR USE OF THE SOFTWARE. YOU AGREE TO GIVE TPS PROMPT NOTICE OF
SUCH CLAIMS AND TO PERMIT TPS TO CONTROL THE DEFENSE OR SETTLEMENT THEREOF.

Export Restrictions. You agree with all international and national laws that apply to the Software, including the
U.S. Export Administration Regulations, as well as end-user, end use and country destination restrictions issued
by U.S. and other governments.

Website; Other Statements. No statement contained at the TPS Website (or any other web site) or in any other
advertisements or TPS literature or made by an employee or independent contractor of TPS modifies these Terms
and Conditions (including the Software License Agreement, Disclaimer of Warranty and limitation of liability).

General. The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by
TPS. The Agreement shall be governed by and construed and enforced in accordance with the laws of the state of
California, without regard to conflicts of laws provisions. Any action concerning this Agreement shall take place
in the state or federal courts located in San Francisco, California. If for any reason any provision of this Agree-
ment, or a portion thereof, shall be unenforceable, that provision shall be enforced to the maximum extent per-
missible so as to effect the intent of this Agreement, and the remainder of this Agreement shall continue in full
force and effect. This Agreement constitutes the entire agreement between us and you with respect to the Soft-
ware and it supersedes all prior or contemporaneous communications, agreements and understandings between
TPS and you with respect to the subject matter hereof. No joint venture, partnership, employment, or agency rela-
tionship exists between you and TPS as a result of this agreement or use of the Service. The failure of TPS to
enforce any right or provision in this Agreement shall not constitute a waiver of such right or provision unless
acknowledged and agreed to by TPS in writing. A printed version of this Agreement shall be admissible in judi-
cial or administrative proceedings.

BY CLICKING ON THE “ACCEPT” BUTTON BELOW YOU ACKNOWLEDGE THAT YOU HAVE
READ AND UNDERSTOOD THIS AGREEMENT AND AGREE TO BE BOUND BY ITS TERMS. YOU
FURTHER AGREE THAT THIS AGREEMENT SUPERSEDES ANY PREVIOUS AGREEMENT,
WHETHER WRITTEN OR ORAL, RELATING TO THE SOFTWARE BETWEEN YOU AND TPS.

4



Introduction

Introduction
MAGNET Office is a module based system that utilizes a full featured CAD environment for the processing, edit-
ing, adjustment and graphical representation of survey data, reconstruction of road and site designs, initial road-
way and site design, and the creation of 3D models for use with Topcon's 3DMC systems.

Available modules for MAGNET Office are:
l MAGNET Tools — Provides calculation and adjustment of coordinates based on observations created with
the family of Topcon and Sokkia instruments. This product is included in the MAGNET Office Topo and
Site Modules.

l MAGNET Topo — Provides a CAD environment that includes survey specific functionality for the import,
review, processing and adjustment of survey data. Contains specific functionality for the graphical rep-
resentation of the survey with scaled plotting for the preparation of the survey plat deliverable.

l MAGNET Site — Provides design functionality in a CAD environment for the import/export, editing and
graphic representation of design data. Includes specific 3D Modeling functionality to quickly elevate design
data imported without elevation. Generates standard Topcon TP3 files for use with 3DMC hardware sys-
tems.

l MAGNET Resurface — Provides paving specific routines to generate optimal paving designs based on
smoothness and ride-ability in a CAD environment. Utilizes specific and unique functionality to allow ver-
satile designs based on profile and/or cross section requirements.

Surveyors, Engineers, Geodesists, 3D Model specialists, and draftsman can use MAGNET Office for:
l Processing TS, DL, and/or RTK and GPS observations,
l Least Squares Network adjustment,
l Instant reporting of unadjusted traverse closures,
l Compass rule, including angle balance, adjustments,
l Importing files on a computer or from a device
l Exporting data to files on a computer or device
l Upload/Download data to a project on MAGNET Enterprise
l Creating, viewing and editing a digital terrain model (surface),
l Raising/lowering surfaces for subgrade creation,
l Generating subgrade volumes,
l Generating cut/fill volumes and maps,
l Elevating lines, arcs, strings for 3D model creation,
l Upload/Download data to SiteLink,
l Remotely access construction machines using SiteLink,
l Creating pad designs,
l Creating, viewing and editing road and X-section templates
l Creating, viewing and editing of roadway horizontal and vertical alignment data.
l Creating, viewing and editing profile data generated from surfaces and/or points, strings,
l Creating, viewing and editing cross section data generated from surfaces and/or points, strings,
l Creating Sub-Division designs,
l Adding text and multiline text to drawings,
l Adding symbols, legends, borders and title blocks to drawings,
l Plotting "to scale" drawings.
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MAGNET Office makes use of "Views" and "Editors" for surveying and design related tasks.
l Use the Survey View for all CAD related functionality as well as all Cogo functionality.
l Use the Road View for design functionality when using vertical/horizontal alignments and templates for
design creation or recreation.

l Use the Spreadsheet Entry/Editor for manual point entry or modifications in a spreadsheet environment,
l Use the Raw Data Editor to review, process and modify Total Station measurements.
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File Tab
The File tab of the MAGNET Office ribbon contains control icons for basic operations. It is separated to five
groups, described in the corresponding sections:

l "Standard group" section on the next page
l "Import/Export group" section on page 39
l "Plot Window group" section on page 52
l "Editor group" section on page 54
l "Print group" section on page 56
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Standard group
The Standard group from the File tab of the MAGNET Office ribbon, allows you to perform basic operations
with projects.

New icon
Click it to start a new project.

Open icon
Click it to open an existing project.

Save icon
Click it to save the current project.

Save As icon
Click it to save the current project with the new name, and/or in another location.

Close icon
Click it to close the current project.

Project Manager icon
Click it to open the project file manager dialog.

Exit icon
Click it to close the MAGNET Office application.

New icon
The New icon of the Standard group allows you to create a new project. Its shortcut key is Ctrl+N.

To create a new project:
1. In the Standard group of the File tab, click the New icon.

The Project details dialog is displayed.
2. Type required information in the appropriate editboxes and click Next.

The Unit Settings dialog is displayed.
3. In the Unit Settings dialog select the required measurement units and click Finish.

The new project is created.

NOTE
These settingsmay be changed at any time at theUnit Settings tab of theProject Settings dialog.
See "Project unit settings" section on page 583 for details.
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Open icon
The Open icon of the Standard group allows you to open an existing project. Its shortcut key is Ctrl+O.

To open an existing project:
1. In the Standard group of the File tab, click the Open icon.

The Open dialog is displayed.
2. From the Files of type drop-down list, select the required file format.
3. Navigate to the project location, select project file to be opened, and click Open.

The existing project is opened.

TIP

To open a recent project, click and elect the required project from the list of the recent projects .

Save icon
The Save icon of the Standard group allows you to save the current project to its directory. Its shortcut key is
Ctrl+S.

Click the icon to save all the changes in the project, made since last saving.

NOTE
If you saving the project for a first time, theSave As dialog will appear.

Save As icon
The Save As icon of the Standard group allows you to save the current project to a new location and/or with a new
name.

To save the project:
1. In the Standard group of the File tab, click the Save As icon.

The Save As dialog is displayed.
2. Navigate to the required folder.
3. In the File name editbox, type the new project name
4. If needed, from the Save as type drop-down list, select the required file type.
5. Click Save.

The project is saved.

Close icon
The Close icon of the Standard group allows you to close the current project without closing the MAGNET Office
application.

Click the icon to close the current project. If current project contains unsaved changes, a dialog will prompt you to
save the project. Click Yes to save changes and close the project. Click No to discard changes and close the pro-
ject.

NOTE
Closing project with uncompleted actions is not allowed. If you click the during uncompleted action, a dia-
log will prompt you to complete the action first.
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Project Manager icon
The Project Manager icon of the Standard group allows you to store additional files inside a single
MAGNET Office project file, and simplifies the management of the project-related files.

To open the Project File Manager, click the icon. The Project File Manager dialog will appear. It contains the
list of the attached files and controlling buttons. Double clicking on the file name in the list opens it in the stand-
ard application associated with its file type. The buttons are described in the table below.

Buttons of the Project File Manager dialog
Button Description

New

Click it to add a new document of the *.doc or *.xls type to the project.
1. Click New.

The New Document dialog is displayed.
2. In the Document Name editbox, type the name of the document and

select its type from the Document Type drop-down list.
3. Click OK.

The file is added to the project.

Add
Click it to add an existing file of any type from the computer's file system to
the project. After clicking, the Open dialog is displayed. Navigate to the file
to be added and click Open.

Delete Click it to delete the selected file from the project.

Save As Click it to save an attached file in the computer's files ystem.

Open Click it to open an attached file via the default system application for this file
type.

Open With Click it to open an attached file via the specific application.

OK Click it to save changes and close the Project File Manager dialog.

Cancel Click it to close the Project File Manager dialog without saving any
changes. After clicking a message window prompts to save changes.

Exit icon
Click it to close the MAGNET Office application.
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Import/Export group
The Import/Export group from the File tab of the MAGNET Office ribbon, allows you to import data to a
MAGNET Office project from various external sources, and to export data from a current project for external
usage.

Import icon
Click it to start an import session.

Export icon
Click it to start an export session.

Data Transfer icon
Click it to start a data transfer session.

Export to Pocket 3D
Click it to export a project data to a mobile device.

Sync Utility icon
Click it to open the synchronization utility.

Translation Tables icon
This icon contains the list of the second level icons for con-
figuring translation tables. Click to expand the list of the

second level icons.
Genio Translation Table icon

Click it to configure settings for the data export to a Moss
Genio file.

Autocad Layer Translation Table icon
Click it to configure the AutoCAD layer to be used for trans-

lation.

Import icon
The Import icon of the Import/Export group allows you to import measurement files of different types from the
computer or a connected device to your project.

To import the measurement file to the project:
1. In the Import/Export group of the File tab, click the Import icon.

The Open dialog is displayed.
2. From the Files of Type drop-down list, select the required file type.
3. Navigate to the file to be imported and click Open.
4. If needed, configure additional settings. They may be found in corresponding sections, listed below:

l "Importing MAGNET Field jobs" section on the next page
l "Importing TopSURV jobs" section on the next page
l "Importing AutoCAD files" section on the next page
l "Importing GENIO files" section on page 41
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l "Importing 3DMC files" section on the facing page
l "Importing ASCII points files" section on the facing page

NOTE
Imported datamay not display as it appears in other applications because data structures are often dif-
ferent. MAGNETOffice can read the data from a range of formats. However, some of these formats
may not be fully supported. For example, AutoCAD (*.dwg) filesmay have complex entities com-
pressed into blocks. These blocksmust be exploded in AutoCAD prior to reading the data in MAGNET
Office.

Some files contain embedded point numbers. If the current project contains existing data, then you
may prefer to import these files into a new project, and then copy and paste the data into the open pro-
ject, to renumber the points.

Importing MAGNET Field jobs
When importing a MAGNET Field job (*.mjf) file, the Point Code and Attributes dialog appears after clicking
Open.

To configure the import settings:
1. In the Point Code group box, select whether to import point code, according to user selections or with the

library description.
2. In the Transfer group box, select entities to be transferred.
3. In the MJF and TSJ files group box, select whether to import lines or not.
4. In the Attributes group box, configure the attribute displaying.
5. Tick the Locked checkbox to define, whether imported points will be locked or not.
6. Click OK.

Importing TopSURV jobs
When importing a TopSURV job (*.tsj or *.tlsv) file, the Point Code and Attributes dialog appears after clicking
Open.

To configure the import settings:
1. In the Point Code group box, select whether to import point code, according to user selections or with the

library description.
2. In the Transfer group box, select entities to be transferred.
3. In the MJF and TSJ files group box, select whether to import lines or not.
4. In the Attributes group box, configure the attribute displaying.
5. Tick the Locked checkbox to define, whether imported points will be locked or not.
6. Click OK.

Importing AutoCAD files
When exporting AutoCAD (*.dwg or *.dxf) files, the Convert AutoCAD dialog appears after clicking Open.

To configure the import settings:
1. In the Distance Unit Conversion group box, make the required selection:

l No Conversion — select it to import the geometry into the units specified in the project settings.
l From Inches — select it when you are inserting a drawing that was prepared in architectural units.
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NOTE
If the units in the source drawing are set to metric, the dialog will contain FromMillimeters
radiobutton.

2. In the Point Creation group box, select required options for point's creation.
3. In the Blocks group box, select if needed to explode boxes, and if yes – select boxes to be exploded.
4. Click OK.

Importing GENIO files
When importing a GENIO (*.gen or *.crd) file, the Import GENIO dialog appears after clicking Open.

To configure the import settings:
1. Select whether layer creation will be based on the survey code or model.
2. Select whether data will be coded with two characters or four.
3. Select whether to remove duplicated points or not. If yes, specify the tolerance for duplication detecting.
4. Click OK.

Importing 3DMC files
When importing 3DMC (*.rd3, *.tn3, *.pt3, *.ln3), the 3DMC Import Files dialog appears after clicking Open.

To configure the import settings, select entities to be imported and click OK.

Importing ASCII points files
When importing ASCII points (*.pts, *.asc, *.xyz, *.csv, *.txt, *.ctf) file , the ASCII File Format dialog appears
after clicking Open.

To configure the import settings:
1. In the Field Order group box, specify the order of information in the source file.
2. In the Input Mode group box, make the required selection:

l Direct Input – select it to simply import the point coordinates.
l Projection – select it to project the point to the coordinate system projection of the project. For more
information about coordinate system refer to "Project coordinate system" section on page 586.

l Localization – select it to convert point coordinates to the project coordinate system.
3. In the Data above is in and Project Settings fields select appropriate values for the imported file and current

project respectively.
4. If needed, in the Coordinate System group box, select coordinate systems for imported file and current pro-

ject.
5. Click OK.

Export icon
The Export icon of the Import/Export group allows you to export your project to specified file type or to a Top-
con/Sokkia device.

To export the current job:
1. In the Import/Export group of the File tab, click the Export icon.

The Save As dialog is displayed.
2. Navigate to the required folder for file storing.
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3. From the Save as type drop-down list, select the required file type, and type the file name in the File Name
editbox.

4. Click Save.
5. If needed, configure additional export settings. Their description may be found in corresponding sections,

listed below:
l "Exporting to MAGNET Field Jobs" section below
l "Exporting to 3DMC Project File" section below
l "Exporting to AutoCAD files" section on the facing page
l "Exporting to Land XML Files" section on the facing page
l "Exporting to Genio Moss String" section on page 44
l "Exporting to 3DMC Files" section on page 44
l "Exporting to ASCII point files" section on page 45
l "Exporting to Leica Road Runner Files" section on page 45
l "Exporting to 3D View Files" section on page 45

TIP
To export raw data, click the Data Transfer icon.

Exporting to MAGNET Field Jobs
When exporting to a MAGNET Field job (*.mjf) file, the Export dialog appears after clicking Save.

To configure the export settings:
1. In the Select From group box, select one of the following radiobuttons:

l All— to export all the supported data from the project, regardless visible it or not. Data from inact-
ive layers will be available for transferring.

l Active — to export only the supported visible data from the survey view.
l Selection— to export only the supported data within a selection set.

2. If needed, in the Export Options group box, select the types of project entities to export.
3. If needed, at the Points, Lines, Alignment, Profile and DTM tabs, select objects to export.
4. Click OK.

Exporting to 3DMC Project File
When exporting to a 3DMC project (*.tp3), the Export dialog appears after clicking Save.

To configure the export settings:
1. In the Select From group box, select the appropriate option. Options described in the table below.
2. If needed, in the Export Options group box, select the types of project entities to export.
3. If needed, at the Points, Lines, Alignment, Profile and DTM tabs, select objects to export.
4. Click OK.
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Selection options
Option Description

All Select it to export all the supported data from the project, regardless visible it or
not. Data from inactive layers will be available for transferring.

Active Select it to export only the supported visible data from the main survey view.

Selection Select it to export only data, which support transferring, within a selection set.

Exporting to AutoCAD files
This section describes how to export to an Autodesk RealDWG Files (*.dwg or *.dxf) files. For information about
AutoCAD Layer Translation Table configuration, refer to "Autocad Layer Translation Table icon" section on
page 50.

When exporting Autodesk RealDWG file, the "Export AutoCAD DWS Options" dialog is displayed after clicking
Save.

To configure export:
1. Configure the parameters of the Export AutoCAD DWS Options dialog as needed. Fields are described in

the table below.
2. Click OK.

The data is exported.

Fields of the Export AutoCAD DWGOptions dialog.
Parameter Description

Select From Selects either to export all existing layers or only the active ones.

Point Heights Selects either to export point heights or not. If yes, select either to export non-
Use in Surface points with zero heights or not.

Distance Unit Con-
version

Selects either No Conversion to export data without conversion if it will be pro-
cessed as ground units, or To Millimeters, to convert it to metric system, if it
will be processed as plan units.

Unit Settings Selects either to retain unit settings or not.

Export Triangles
as Defines how triangles, the current DTM and contours will be exported.

Export Stings as Defines either to export strings as 2D polylines or as 3D polylines.

Annotation and
Symbols

Defines the way of creating layer for the annotations and symbols, and the way
for exporting annotations.

Exporting to Land XML Files
When exporting to a Land XML (*.xml) file, the XML Export Selection dialog appears after clicking Save.

To configure export settings:
1. In the Select from group box, select the required radiobutton:

l All— to export all project data.
l Selection— to export only data from the current selection.
l Active — to export only data from the active layers.
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2. Tick checkboxes for the project entities to be imported.
3. Click OK.

Exporting to Genio Moss String
This section describes how to export to a Genio Moss String (*.gen) files. For information about Genio Trans-
lation Table configuration, refer to "Genio Translation Table icon" section on page 49.

When exporting to a Genio Moss String, the Moss Export Selection dialog is displayed after clicking Save.

To configure export:
1. Configure the parameters in the Moss Export Selection dialog as you need. Fields are described in the

table below.
2. Click OK.

Fields of the Moss Export Selection dialog.
Parameter Description

Select From

Defines the selection of data for export. Select the required radiobutton:
l All— to export all of the design data available for transfer within the
project. Visibility of this data is not a prerequisite. Design data from lay-
ers which are turned off will be available for selection to be transferred.

l Selection— to select only data, which supports transferring, within a
selection set for inclusion within the exported *.tp3 file.

l Active — to select only supported visible data from the main survey
view for inclusion within the exported *.tp3 file.

Model Name Defines the file name for the exported model.

Use Translation
Table

Defines the usage of the translation tables. Tick the checkbox to use translation
tables, and select the required radiobutton:

l Translate Code — to use translation table for codes.
l Translate Layer— to use translation table for layers.

Points Tick it to export points.

Lines Tick it to export lines.

Strings Tick it to export strings.

Alignments Tick it to export alignments.

Text Tick it to export breaks.

New String at
Breaks Tick it to enable exporting strings with breaks in between.

Alignment Format Select either 6D, 12D or Both.

Cross Sections
Surface

Tick it to export surface as cross sections. Select the required surface from the
drop-down list.

Exporting to 3DMC Files
When exporting to a 3DMC file (*.rd3, *.tn3, *.pt3, *.ln3), the Export dialog appears after clicking Save.

To configure the export settings:
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1. In the Select From group box, select one of the following radiobuttons:
l All— to export all the supported data from the project, regardless visible it or not. Data from inact-
ive layers will be available for transferring.

l Active — to export only the supported visible data from the survey view.
l Selection— to export only the supported data within a selection set.

2. If needed, in the Export Options group box, select the types of project entities to export.
3. If needed, at the Points, Lines, Alignment, Profile and DTM tabs, select objects to export.
4. Click OK.

Exporting to ASCII point files
When exporting to an ASCII point (*.pts, *.xyz, *.asc, *.txt, *.csv) file, the Export Points dialog appears after
clicking Save.

To configure the export settings:
1. In the Select From group box, select one of the following radiobuttons:

l All— to export all the supported data from the project, regardless visible it or not. Data from inact-
ive layers will be available for transferring.

l Active — to export only the supported visible data from the survey view.
l Selection— to export only the supported data within a selection set.

2. In the Delimiter group box, select how points will be delimited in the exported file.
3. In the Field Order group box, select the order of information in the exported file.
4. In the Decimal Places editbox, type the quantity of decimal places to export.
5. Click OK.

Exporting to Leica Road Runner Files
When exporting to a Leica Road Runner (*.dbx) file, the Road Runner Export Selection dialog appears after
clicking Save.

To configure export settings:
1. In the Select From group box, select one of the following radiobuttons:

l All— to export all the supported data from the project, regardless visible it or not. Data from inact-
ive layers will be available for transferring.

l Active — to export only the supported visible data from the survey view.
l Selection— to export only the supported data within a selection set.

2. Select project entities to export.
3. Click OK.

Exporting to 3D View Files
3D viewer is included in the MAGNET Office. Is allows you to view the DTM surface in 3D view. If an align-
ment exists in the project, you can virtually 'drive' along the road.

When exporting to a 3D View (*.w3d) file, the Export W3D dialog is displayed after clicking Save.

To configure export:
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1. In the Select From group box, select one of the following radiobuttons:
l All Data— to export all existing data.
l Active Layers— to export only entities, that belong to the active layers.
l Current Selection— to export only selected entities.

2. In the Driver Offset group box, specify the amount and direction of the offset form the required alignment,
for virtual 'driving', by using the Offset editbox, and Left and Right radiobuttons.

3. In the Driver Offset group box, specify the speed of virtual 'driving', by using the Alignment Spacing edit-
box.

4. Select surfaces to export into 3D view from the list.
5. Tick the Transfer Linework checkbox, to define whether to export lines, strings, arcs, circles and polylines

or not.
6. Tick the Drape Lines checkbox, to define whether to drape all selected lines onto the selected surface or

not.
7. Tick the Transfer Points checkbox, to define whether to transfer points into the 3D view or not.
8. Click OK.

Data Transfer icon
The Data Transfer icon of the Import/Export group allows you to transfer data from your project to file to a
device.

To transfer data:
1. In the Import/Export group of the File tab, click the Data Transfer icon.

The Transfer Data dialog is displayed.
2. From the Instrument drop-down list, select your device.
3. Configure the adjustments as your need. Parameters are described in the table below.
4. Do one of the following:

l Click Upload button to upload data to a mobile device
l Click Export to export data to a file.
l Click Load File to upload a previously saved ASCII Points (*.pts) or Upload (*.upl) file.
NOTE
To terminate the data transfer, click Abort.
To check the current instrument driver, click Driver Detail.

5. Click Finish to finish the data transferring.

Parameters of the Transfer Data dialog
Parameter Description

Instrument Defines instrument manufacturer and data format.

Data Type Defines data type to be transferred.

Com Port Defines serial port of the computer to which a mobile device is connected.

Baud Rate Defines data transfer speed between instruments, which use serial com-
munication. This rate must be the same on both the device and the computer.
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Parameter Description

Data Bit Defines the order of transmission from the least to the most significant bit. The
value of this parameter must be the same on both the device and the computer.

Stop Bit
Defines the last part of a character frame consists of either 1, or 1.5 or 2 stop
bits. The value of this parameter must be the same on both the device and the
computer.

Parity Detects errors and supervises data transfer accuracy. The value of this para-
meter must be the same on both the device and the computer.

Flow Control Defines the way to control data transfer and stop signals. The value of this
parameter must be the same on both the device and the computer.

Points with No
Height - Output Defines the height value for points with undefined points.

Export to Pocket 3D
The Export to Pocket 3D icon of the Import/Export group allows you to export a 3DMC project file (*.tp3) to
your mobile device. Data to be transferred are selected during the export process.

To export a 3DMC project file to a mobile device:
1. Connect your mobile device to the computer.
2. In the Import/Export group of the File tab, click the Export to Pocket 3D icon.

The Select Pocket 3D Data Path dialog is displayed.
3. Select destination folder for export.
4. Click OK.

The Export dialog is displayed.
5. In the Select From group box, select one of the following radiobuttons:

l All— to export all the supported data from the project, regardless visible it or not. Data from inact-
ive layers will be available for transferring.

l Active — to export only the supported visible data from the survey view.
l Selection— to export only the supported data within a selection set.

6. If needed, in the Export Options panel, select the types of project entities to export.
7. If needed, in the Points, Lines, Alignment, Profile and DTM tabs, select certain objects to export.
8. Click OK.

Selected data is exported to the mobile device.

Sync Utility icon
The Sync Utility icon of the Import/Export group allows you to keep your mobile device synchronized with the
MAGNET Office.

To synchronize a mobile devise with the PC:
1. Connect your mobile device to the computer.
2. In the Import/Export group of the File tab, click the Sync Utility icon.

The Desktop-CE Device Synchronization dialog is displayed.
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3. If needed, click File View to manually select files for synchronization. For more information refer to "File
Transfer - Copy From dialog" section below.

4. Click Settings to configure synchronization. Options described in the table below.
5. Click Synchronize to synchronize files at the mobile device and the PC.

Synchronization options
Field Description

Desktop directory Defines the files location on the PC.

CE device dir-
ectory Defines the files location on the mobile device.

Sync Files Defines the file types for synchronization.

Overwrite old
files

Tick it to replace older files with the newer ones with the same name and type
during synchronization.

Preview Files Select it to preview files before saving.

Warn on over-
write Select it to give a warning before overwriting files.

Create backup Select it to create backup copy before synchronization.

Startup auto-
matically when
connected.

Select it to automatically launch the synch utility when mobile device is con-
nected.

File Transfer - Copy From dialog
The File Transfer - Copy From dialog allows you to manually select files for synchronization between a mobile
device and the PC.

To synchronize a mobile devise with the PC:
1. Connect your mobile device to the computer.
2. In the Import/Export group of the File tab, click the Sync Utility icon.

The Desktop-CE Device Synchronization dialog is displayed.
3. Click File View.

The File Transfer - Copy From dialog is displayed.
4. Do one of the following:

l Click the Device CE tab to copy files from the mobile device to the PC.
l Click the PC tab to copy files from the PC to the mobile device.

5. Click Settings to configure synchronization. Options described in the table below.
6. If needed, click Refresh to reload the list of the files.
7. Select files to be copied.
8. Do one of the following:

l On the Device CE tab, click Copy Selected File(s) from Device to PC to copy the selected files
from the mobile device to the PC.

l On the PC tab, click Copy Selected File(s) from PC to Device to copy the selected files from the
PC to the mobile device.
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l Click Copy All Selected File(s) to copy selected files from the PC to the mobile device and from
the mobile device to the PC.

l Click Synchronize to synchronize files on the mobile device and the PC.

Synchronization options
Field Description

Desktop directory Defines the files location on the PC.

CE device dir-
ectory Defines the files location on the mobile device.

Sync Files Defines the file types for synchronization.

Overwrite old
files

Tick it to replace older files with the newer ones with the same name and type
during synchronization.

Preview Files Tick it to preview files before saving.

Warn on over-
write Tick it to give a warning before overwriting files.

Create backup Tick it to create backup copy before synchronization.

Startup auto-
matically when
connected.

Tick it to automatically launch the synch utility when mobile device is con-
nected to the PC.

Genio Translation Table icon
The Genio Translation Table icon of the Import/Export group allows you to define settings for the data export to
a Moss Genio file.

To configure a Genio table:
1. Set the active layers, contours and annotations as required for your Moss Genio file.
2. In the Import/Export group of the File tab, click the Genio Translation Table icon.

The Moss Export LookUp Table dialog is displayed. This table converts MAGNET Office entities to spe-
cified Moss Strings.

3. Configure Genio table parameters as you need. Parameters are described in the table below.
4. Click OK.

The Genio table is configured.

Parameters of the Genio table.
Parameter Description

Entity

Defines the entity for export. Possible values are:
l Alignment
l Line
l Point
l String

Code/Name Used if you have already crated MAGNET Office strings or alignments, which
will be converted to the specified Moss String.
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Parameter Description

Layer Defines layer from to be converted into the specified Moss string name.

Moss String Defines the name for a Moss String.

Buttons of the Moss Export LookUp Table dialog.
Button Description

Save To Lib Click it to copy the current table to the library. Type the name of the library in
the dialog and click OK.

Copy From Lib Click it to load saved table from an existing library. Select the source library
and click OK.

Insert Click it to inserts additional row in the table above the active row.

Delete Click it to delete active row from the table.

Restore Click it to discard all unsaved changes.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving any changes.

Autocad Layer Translation Table icon
The Autocad Layer Translation Table icon of the Import/Export group allows you to specify the AutoCAD
layer to be used for translation to the MAGNET Office.

After clicking, the Layer Translation Table dialog appears, the table is automatically filled with the active layers
from the project. If the AutoCAD layer name used in the table does not exist in the definition table, then the cor-
responding MAGNET Office layer name will be marked with a 0 setting.

TIP
The Autocad default layer 0 cannot be deleted or renamed. All exported filesmust have a 0 layer.

To configure the layer translation table:
1. In the Import/Export group of the File tab, click the Autocad Layer Translation Table icon.

The Layer Translation Table dialog is displayed. The Layer column of the table contains active layers
from the MAGNET Office project. The Acad Layer column contains the corresponding layer to which the
MANGET Office layer will be translated.

2. Configure the table as you need. Table fields and dialog buttons are described below.
3. Click OK to save changes and close the dialog.

The translation table is configured.

Fields of the layer translation table
Parameter Description

Acad Layer Table Lists definition tables from the library.
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Parameter Description

Annotation Layer
Defines the layer, where annotations will be placed. By default, they are
placed in $LYR$_Annotation, where $LYR$ is the layer name. All line/arc
annotation tables are placed into the default layer 0.

Contours Layer
Defines the layer where all contours will be placed. By default, they are
placed in $DTM$_Contours, where $DTM$ is the DTM name from which the
contours are determined.

Triangles Layer
Defines the layer where all triangles will be placed. By default, they are
placed in $DTM$_Triangles, where $DTM$ is the DTM name from which the
triangles are determined.

Slope Layer
Defines the layer where all slope arrows will be placed. By default, they are
placed in $DTM$_SlopeArrow, where $DTM$ is the DTM name from which
the slope arrows are determined.

Undefined Layer Defaults to layer 0. All entities in non-specified Autocad layers in the table are
put into this layer.

Buttons of the Layer Translation Table dialog
Button Description

Copy From Lib
Click it to copy the current table to the library. A dialog prompts you to retain
current autocad layer names Click Yes or No for your choice. Select the
source library and click OK.

Save To Lib Click it to copy the current table to the library. Type the name of the library in
the dialog box and click OK.

Insert Click it to insert additional row in the table above the active row.

Delete Click it to delete active row from the table.

Update Click ti to update the table to include all layers from the current project.

Settings Click it to open the layer definition table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving any changes.
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Plot Window group
The Plot Window group from the File tab of the MAGNET Office ribbon, allows you to create and manage plot
windows. Plot windows are linked drawings, displayed in the drawing view. They are defined with a specified
plot scale, title block and orientation. Plot window displays all data from currently active layers within its bor-
ders.

Drawing dynamically represents the selected area of the survey view. You may turn on or off layers displaying in
the drawing. If you add a new layer to the project where the drawing is already exists, you may turn this layer on
for displaying in the drawing. Any annotation, which was unavailable at the moment of drawing creation, may be
activated later. If entities are added, removed or edited on the active layer, they will be automatically updated in
the drawing.

You may create several drawing in one project and save them using unique names.

The group contains five icons, described in the table below.

Create icon
Click it to create a new plot window.

Reposition icon
Click it to edit an existing plot window.

Show icon
Click it to show the plot windows positions in the survey view.

Delete icon
Click it to delete an existing plot window.

List icon
Click it to display the list of the plot windows.

Create icon
The Create icon of the Plot Window group allows you to create a new drawing in the project.

To create a new drawing:
1. In the Plot Window group of the File tab, click the Create icon.

The Open dialog is displayed.
2. Select the required title block, and click Open.

The title block is displayed in the survey view. Its bottom-left corner is in the center of the survey view.
3. Modify the size and position of the drawing, by using the mouse:

l Drag the plot window through the survey view by using the bottom left corner.
l Re-size the plot window by using the top right corner.
l Rotate the plot window around the bottom left corner, by using the bottom-right handle.
l To change the title block, click Title Block and select a new one.

4. On the bottom panel, click OK.

The drawing of the selected area is displayed in the new window.
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Reposition icon
The Reposition icon of the Plot Window group allows you to relocate or/and resize or/and rotate an existing plot
window.

To edit an existing plot window:
1. In the Plot Window group of the File tab, click the Reposition icon.

The Select Drawing dialog is displayed.
2. Select the required drawing from the drop-down list, and click OK.

The selected drawing is highlighted.
3. Modify the size and position of the drawing, by using the mouse:

l Drag the plot window through the survey view by using the bottom left corner.
l Resize the plot window by using the top right corner.
l Rotate the plot window around the bottom left corner, by using the bottom-right handle.
l To change the title block, click Title Block and select a new one.

4. On the bottom panel, click OK.

The drawing of the selected area is displayed in the new window.

Show icon
The Show icon of the Plot Window group allows you to see all existing drawings in the project. Its shortcut key is
F10.

Click this icon to highlight all existing drawings in the project.

Delete icon
The Delete icon of the Plot Window group allows you to delete an existing drawing.

TIP
This icon is active only when at least one drawing exists in the project, and the Show icon is active.

To delete an existing icon:
1. Make sure that the Show icon is active.
2. In the Plot Window group of the File tab, click the Delete icon.
3. Click within borders the required drawing.

The dialog asks your confirmation for deleting.
4. Click Yes.

The drawing is deleted.

List icon
The List icon of the Plot Window group allows you to list all existing plot windows in the project.

To list existing plot windows, click the icon. The list with detailed information for all existing plot windows is dis-
played.
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Editor group
The Editor group from the File tab of the MAGNET Office ribbon allows you to manage the drawings, symbols
and line styles in the project.

Drawing icon
Click it to open the drawing manager window.

Symbol icon
Click it to open the symbol manager window.

Line Style icon
Click it to open the line styles manager window.

Drawing icon
The Drawing icon of the Plot Window group allows you to manage drawings in the project.

After clicking, the Drawings dialog appears. It contains list of all drawings, existing in the project. Buttons are
described below.

Buttons of the Drawings dialog
Button Description

New Click it to add a new drawing.

Open Click it to open the selected drawing for editing.

Rename Click it to rename the selected drawing.

Delete Click it to delete the selected drawing.

Close Click it to close the dialog.

The drawing editor allows you to add supplementary information, such as points, lines, arrows and text.

NOTE
All supplementary information exists at the drawing only. The survey view remains unchanged.

Symbol icon
The Symbol icon of the Editor group allows you to manage symbols in the project.

After clicking, the Symbol Manager dialog appears. It contains list of all symbols, existing in the project. Buttons
are described below.

Buttons of the Symbol Manager dialog
Button Description

New Click it to add a new symbol.

Open Click it to open the selected symbol for editing.

Rename Click it to rename the selected symbol.

Delete Click it to delete the selected symbol from the project.
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Button Description

Save to Library Click it to save the selected symbol to the MAGNET Office symbol lib-
rary.

Copy from Library Click it to add a symbol from the MAGNET Office symbol library to the
project.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Line Style icon
The Line Style icon of the Editor group allows you to manage line styles in the project.

After clicking, the Line Style Manager dialog appears. It contains list of all symbols, existing in the project. But-
tons are described below.

Buttons of the Line Style Manager dialog
Button Description

New Click it to add a new line style.

Open Click it to open the selected line style for editing.

Rename Click it to rename the selected line style.

Delete Click it to delete the selected line style from the project.

Save to Library Click it to save the selected line style to the MAGNET Office line styles
library.

Copy from Library Click it to add a line style from the MAGNET Office line styles library to
the project.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Print group
The Print group from the File tab of the MAGNET Office ribbon allows you to prepare you project for printing
and to print it.

Print Setup icon
Click it to configure the print settings.

Print icon
Click it to print drawing from the survey view window.

Print Setup icon
The Print Setup icon of the Print group allows you to configure the print settings for the project.

To configure print settings:
1. In the Print group of the File tab, click the Print Setup icon.

The Print Setup dialog is displayed.
2. In the Printer group box, select and configure the printer.
3. In the Paper group box, configure the paper settings.
4. In the Orientation group box, select either the portrait or the landscape paper orientation.
5. Click OK.

Print icon
The Print icon of the Print group allows you to print your project. Its shortcut key is Ctrl+P.

To print your project:
1. In the Print group of the File tab, click the Print icon.

The Print dialog is displayed.
2. In the Print Format group box, specify the scale for printing.
3. In the Orientation group box, select either the portrait or the landscape orientation, and if needed specify

the rotation.
4. In the Print Color group box, select either the color or the black-and-white print.
5. In the Page Range group box, specify the pages to be printed.
6. Click OK.

TIP
ThePrint Setup button of thePrint dialog has the same functionality as the Print Setup icon.
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Edit Tab
The Edit tab of the MAGNET Office ribbon contains control icon for work flow operations. It is separated to six
groups, described in the corresponding sections:

l "Undo/Redo group" section on the next page
l "Clipboard group" section on page 60
l "Properties group" section on page 62
l "Selection group" section on page 83
l "Select By group" section on page 85
l "Edit group" section on page 95
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Undo/Redo group
The Undo/Redo group from the Edit tab of the MAGNET Office ribbon allows you to manage actions, performed
in the MAGNET Office. It contains five icons, described in the table below.

Undo icon
Click it to cancel the last action. This icon also contains second level

icon. Click to see it.

Undo History icon
Click it to cancel several actions at once.

Redo icon
Click it to restore the last canceled action. This icon also contains second

level icon. Click to see it.

Redo History icon
Click it to restore several actions at once.

Repeat icon
Click it to repeat the last action.

Undo icon
The Undo icon of the Undo/Redo group allows you to cancel the last performed action. Its shortcut key is
Ctrl+Z.

TIP

To cancel several actions at once, click and select Undo History icon.

Undo History icon
The Undo History of the Undo/Redo group allows you to cancel several actions at once.

To cancel actions:
1. In the Undo/Redo group of the Edit tab, click the Undo History icon.

The Undo History dialog is displayed.
2. Select actions to be canceled.
3. Click OK.

Actions are canceled.

Redo icon
The Redo icon of the Undo/Redo group allows you to restore recently canceled action. Its shortcut key is Ctrl+Y.

TIP
To restore several actions at once, click Redo History icon.
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Redo History icon
The Redo History icon of the Undo/Redo group allows you to restore several canceled actions at once.

To restore actions:
1. In the Undo/Redo group of the Edit tab, click the Redo History icon.

The Redo History dialog is displayed.
2. Select actions to be restored.
3. Click OK.

Actions are restored.

Repeat icon
Click it to repeat the last performed action.
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Clipboard group
The Clipboard group from the Edit tab of the MAGNET Office ribbon allows you to use the system's clipboard. It
contains five icons, described in the table below.

Cut icon
Click it to cut the selected object to the clipboard.

Copy icon
Click it to copy the selected object to the clipboard.

Paste icon
Click it to paste an object from the clipboard.

Paste Special icon
Click it to paste an object to the specified place in the survey view.

Delete icon
Click it to delete the selected object.

Cut icon
Click it to cut the selected objects to the clipboard. Its shortcut key is Ctrl+X.

Copy icon
Click it to copy the selected objects to the clipboard. Its shortcut key is Ctrl+C.

Paste icon
Click it to insert objects from the clipboard to your project. Its hotkey is Ctrl+V.

The "Paste" command inserts new objects exactly to the same coordinates, as the original objects. For pasting to
different location, use the Paste Special icon.

After pasting it is possible to:
l Drag the object through the survey view by using the bottom left corner of its frame, while holding the Shift
key.

l Resize the object by using the top right or top left corner of its frame, while holding the Shift key.
l Rotate the object around the bottom left corner of its frame, by using the bottom-right handle, while holding
the Shift key.

The Duplicated Point Name Detected dialog may appears after insertion. Define the way to rename new points
and click OK.
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Paste Special icon
The Paste Special icon allows you to inset object to the different coordinates from the original one.

To perform a special paste:
1. In the Clipboard group of the Edit tab, click the Paste Special icon.
2. If needed, specify the way to rename duplicated points.
3. In the survey view, click the place to be base point for insertion (bottom right corner of the frame).
4. On the bottom panel, specify the offset from the original coordinates by X and Y axises, rotation and scale

of the new object.
5. Press Enter.

Delete icon
Click it to delete the selected objects. Its shortcut key is Del.
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Properties group
The Properties group from the Edit tab of the MAGNET Office ribbon allows you to edit the parameters of the
selected object or the group of objects. It contains one icon, described in the table below.

Properties icon
Click it to edit the parameters of the selected object.

Properties icon
The Properties icon of the Properties group allows you to edit the properties of the selected object or group of
objects. Its shortcut key is Alt+Enter.

To edit object's properties:
1. In the survey view, select the required object.
2. In the Properties group of the Edit tab, click the Properties icon.

The Edit Properties dialog is displayed.
3. Make the required configurations. For more information refer to "MAGNET Office entities properties" sec-

tion on page 545.
4. Click OK.

NOTE
This icon has the same functionality as the Properties icon from theModify group of theModify tab.

Point properties
A point is a two- or three-dimensional in space and it is the main entity in MAGNET Office, on which all other
entities are derived.

The Editing Points dialog allows you to edit properties of the selected point. Buttons and fields of the dialog are
described in the tables below.

The non-editable fields of the Edit Point dialog
Field Description

Point No.

A unique point identifier in the project database. One project cannot con-
tain two points with the same numbers. Point numbers or names may be
numeric or alphanumeric. The number or name is allocated when the point
is created automatically by the MAGNET Office or manually by user,
and cannot be changed after that.

Easting The east or X component of a point position.

Northing The north or Y component of a point position.

No of Linkages The point is the basic entity, from which all other entities are derived.
This field indicates how many entities are depending on this point.
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The editable fields of the Edit Point dialog
Field Description

Code

An additional alphanumeric description, attached to the point. Point codes
are usually used for automatically assigning properties to points and for
controlling line string between points during the reduction process. The
feature codes and the properties are stored in the Survey Codes Library.

Elevation

The height, reduced level, or Z component of a point position.
MAGNET Office allows creating points with or without height. Tick
checkbox near the elevation's editbox to activate it. An unticked checkbox
means that the point has no height.

Use in Surface Defines whether the point with the defined elevation may be included in a
digital terrain model (DTM).

Layer Defines a layer to which the point belongs to.

Color Defines a color for point displaying.

Mark Defines displaying of the point on the screen.

Description Short description of the point.

Symbol
Defines appearance of the point both on the screen and in the printed
copy. You may choose symbol from the symbol library. For more inform-
ation about symbols, refer to "Symbol icon" section on page 54.

X/Y Scale

Defines the symbol scale for displaying. Some symbols are too small; oth-
ers are too big for correct displaying. To display them right, make sure to
select the appropriate scale. Note that some symbols are unscalable and
plot at the size they were designed.

Rotation
Defines the rotation of the symbol. Rotation value is degrees. Rotations
are absolute a value of the DDD.MMSS format will rotate the symbol by
specified angle.

Locked Tick it to lock the point, so its properties cannot be edited, and the point
cannot be moved with a mouse.

Annotation Defines attributes to be displayed as the point annotation.

The buttons of the Edit Point dialog
Button Description

Annotation Settings
Click it to configure the annotation displaying. This button is active only
when at least one checkbox from the Annotation group box is ticked. For
more information refer to "Point annotation settings" section on page 604.

Set Properties Click it to set current properties as the default for points. New points will
be created with these properties.

Get Properties Click it to apply existing default properties to the point.

Attributes Click it to add new attributes to the point.
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Button Description

Images/Pdfs
Click it to attach an image or a PDF file to the point. The picture will be
displayed near the point. For more information about configuring images,
refer to "Image Viewer" section on page 573.

Delete Click it to delete the point and close the dialog.

Apply Click it to apply changes.

Notes Click it to add a short note.

Symbols... Click it to manage extra symbols for the point.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Line properties
A line is a connection between two points, and defined by a start point and an end point. The bearing and distance
of the line are defined by the start and end points positions.

The Edit Line dialog allows you to edit properties of the selected line. Buttons and fields of the dialog are
described in the tables below.

The non-editable fields of the Edit Line dialog
Field Description

Start Point Displays the start point number.

End Point Displays the end point number.

Bearing Displays the line bearing. A number to the left of the field displays ori-
ginal bearing.

Distance Display the line length.

The editable fields of the Edit Line dialog
Field Description

Layer Defines layer to which the line belongs to. Note that the line and its points
may belong to the different layers.

Color Defines a color for line displaying.

Line Style
Defines appearance of the line both on the screen and on the printed copy.
You may choose them from the line styles library. For more information
about line styles, refer to Line Style icon.

Thickness Defines the width of the line in millimeters when plotted.

Break Line
A line may be defined as a breakline. Line must join two Use in Surface
points with heights for that. MAGNET Office treats a breakline as a line
or arc across which you cannot form a triangle.

Annotation Tick it to turn on line annotation with its bearing, distance or both.
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Field Description

In Line Annotation
Table

Tick it to display the line annotation in the Line Annotation Table. If this
table is plotted, the line is marked with a number, which is listed in the
table with the appropriate bearing and distance. See "Line Annotation
Table icon" section on page 214 for details.

Buttons of the Edit Line dialog
Button Description

Set Properties Click it to set current properties as the default for lines. New lines will be
created with these properties.

Get Properties Click it to load existing default properties for lines.

Reverse Click it to swap the start and end points of the line.

Attributes Click it to add new attributes to the line.

Image/Pdfs
Click it to attach an image or a PDF to the line. The picture will be dis-
played near the line. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the line and close the dialog.

Apply Click it to apply changes.

Annotation Settings Click it to configure the annotation displaying. For more information refer
to "Line annotation settings" section on page 605.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Arc properties
An arc is a part of a circumference, defined by three points. It may be either a start point, an end point and the cen-
ter point of circumference, or three points, belongs to one circumference.

The Edit Arc dialog allows you to edit properties of the selected arc. Buttons and fields of the dialog are
described in the table below.

NOTE
Dialog for the arc, defined by the three points, belongs to one circumference, calledEdit 3-Point Arc.

The non-editable fields of the Edit Arc dialog
Field Description

Start Point Displays the number of the start point.

End Point Displays the number of the end point.

Center Point Displays the number of the center point. This field exists in the Edit Arc
dialog only.

Third Point Displays the number of the third point. This field exists in the Edit 3-Point
Arc dialog only.

Radius Displays the radius of the arc.
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Field Description

Arc Length Displays the length of the arc.

Internal Angle Displays the internal angle of the arc. It is marked as "IA" at figure 1
below.

Start Bearing Displays the start bearing of the arc. It is marked as "SB" at figure 1
below.

End Bearing Displays the end bearing of the arc. It is marked as "EB" at figure 1
below.

Segment Area Displays the area of the arc segment. It is filled with purple at figure 2
below.

Sector Area Displays the area of the arc sector. It is filled with purple at figure 3
below.

Chord Length Displays the length of the arc main chord. It is marked as "CH" at figure
1 below.

Chord Bearing Displays the bearing of the arc main chord. It is marked as "HB" at figure
1 below.

Figure 1. Arc parameters
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Figure 2. Segment

Figure 3. Sector

The editable fields of the Edit Arc dialog
Field Description

Layer Defines layer to which the arc belongs to. Note that the arc and its points
may belong to the different layers.

Color Defines a color for arc displaying.

Line Style
Defines appearance of the arc both on the screen and on the printed copy.
You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the arc in millimeters when plotted.
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Field Description

Break Line
An arc may be defined as breakline. The arc must be defined by three
Use in Surface points for that. If ticked, MAGNET Office treats a break-
line as an arc across which you cannot form a triangle.

Annotation

Tick it to turn on arc annotation. Possible values for annotation are:
l Radius
l Arc length
l Internal angle
l Chord length
l Chord bearing

In Arc Annotation
Table

Tick it to display the arc annotation in the Arc Annotation Table. If this
table is plotted, the arc is marked with a number, which is listed in the
table with the appropriate attributes.

Buttons of the Edit Arc dialog
Button Description

Set Properties Click it to set current properties as the default for arcs. New arcs will be
created with these properties.

Get Properties Click it to apply existing default properties to the arcs.

Reverse Click it to swap start and end points of the arc.

Attributes Click it to add new attributes to the arc.

Images/Pdfs
Click it to attach an image or a PDF to the arc. The picture will be dis-
played near the arc. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the arc and close the dialog.

Apply Click it to apply changes.

Annotation Settings Click it to configure the annotation displaying. For more information refer
to "Arc annotation settings" section on page 607.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Circle properties
A circle is defined by its center point and radius.

The Edit Circle dialog allows you to edit properties of the selected circle. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit Circle dialog
Field Description

Center Point Displays the number of the center point.

Easting Displays the east or X component of the center point position.
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Field Description

Northing Displays the north or Y component of the center point position.

Circumference Displays the length of the circumference.

Area Displays the area of the circle.

The editable fields of the Edit Circle dialog
Field Description

Radius Defines the radius of the circle.

Layer Defines layer to which the circle belongs to. Note that the circle and its center
point may belong to the different layers.

Color Defines a color for circle displaying.

Line Type
Defines appearance of the circle both on the screen and on the printed copy. You
may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the circle in millimeters when plotted.

Buttons of the Edit Circle dialog
Button Description

Set Properties Click it to set current properties as the default for circles. New circles will be
created with these properties.

Get Properties Click it to load existing default properties for circles.

Attributes Click it to add new attributes to the circle.

Images/Pdfs
Click it to attach an image or a PDF to the circle. The picture will be displayed
near the circle. For more information refer to "Image Viewer" section on
page 573.

Delete Click it to delete the circle and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

String properties
A string defined by several points, joined by lines and/or arcs to become one entity. The string may be a 3D
object, if all points that define it have elevation values. A smoothing algorithm may be applied to the string for plot-
ting purposes; it has no influence on any computations.

The Edit String dialog allows you to edit properties of the selected string. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit String dialog
Field Description

Start Point Displays the number of the string start point.

End Point Displays the number of the string end point.
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Field Description

Num Points Display quantity of the points in the string.

Length Display the length of the string.

The editable fields of the Edit String dialog
Field Description

Name Defines the name of the string.

Layer Defines layer to which the string belongs to. Note that the string and its points
may belong to the different layers.

Color Defines a color for string displaying.

Line Style
Defines appearance of the string both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the string in millimeters when plotted.

is Smoothed Select it to apply a smoothing spline algorithm to the string. It is used for plot-
ting purposes and has no influence on any computations.

Service Select is to make the string a service for use in obstruction definition.

Break Line
A string may be defined as breakline. The string must be defined by Use in Sur-
face points for that. If ticked, MAGNET Office treats a breakline as a line or
arc across which you cannot form a triangle.

Annotation Tick it to turn on the string annotation.

Buttons of the Edit String dialog
Button Description

Set Properties Click it to set current properties as the default for strings. New strings will be
created with these properties.

Get Properties Click it to load existing default properties for strings.

Reverse Click it to swap the start and end points of the string.

Images/Pdfs
Click it to attach an image or a PDF to the string. The picture will be displayed
near the string. For more information refer to "Image Viewer" section on
page 573.

Delete Click it to delete the string and close the dialog.

Service Detail Click it to configure a service.

Annotation Set-
tings

Click it to configure the annotation displaying. For more information refer to
"String annotation settings" section on page 612.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Polyline properties
A polyline defined by several lines, joined to become one entity. Note that polyline does not have start, end or
node points as independent entities.

The Edit Polyline dialog allows you to edit properties of the selected polyline. Buttons and fields of the dialog are
described below.

The editable fields of the Edit Polyline dialog
Field Description

Layer Defines layer to which the polyline belongs to.

Color Defines a color for polyline displaying.

Thickness Defines the width of the polyline in millimeters when plotted.

Line Style
Defines appearance of the polyline both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Elevation
The height, reduced level, or Z component of the polyline. MAGNET Office
allows to create polylines with or without height. Tick near the elevation edit-
box to activate it. Unticked checkbox means that polyline has no height.

Break Line A polyline may be defined as a breakline. If ticked, MAGNET Office treats a
breakline as a line or arc across which you cannot form a triangle.

Buttons of the Edit Polyline dialog
Button Description

Set Properties Click it to set current properties as the default for polylines. New polylines will
be created with these properties.

Get Properties Click it to load existing default properties for polylines.

Delete Click it to delete the polyline and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Polygon properties
A polygon is a closed shape, defined by several points, joined by lines and/or arcs to become one entity. A poly-
gon may be selected by its centroid point.

You can move the polygon nodes to change its shape, by holding the Shift key and moving the node with a mouse.
You can also move the entire polygon in the same way, by using its centroid point.

A polygon may be filled with a pattern, hatching, or shading.

A polygon is the base entity for a lot, boundary or pad.

The Edit Polygon Area dialog allows you to edit properties of the selected polygon. Buttons and fields of the dia-
log are described below.

The non-editable fields of the Edit Polygon Area dialog
Field Description

Area Displays the area of the polygon.
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Field Description

Perimeter Displays the length of the polygon perimeter.

Start Point Displays the number of the polygon start point.

End Point Displays the number of the polygon end point.

Num Points Displays the quantity of the points (excluding centroid point) in the polygon.

Num Lines Displays the quantity of the lines in the polygon.

Num Arcs Displays the quantity of the arcs in the polygon.

CentroidX Displays the X or north component of the polygon centroid point position.

CentroidY Displays the Y or east component of the polygon centroid point position.

The editable fields of the Edit Polygon Area dialog
Field Description

Layer Defines layer to which the polygon belongs to. Note that the polygon and its
points, lines and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the polygon, will not be displayed when
plotted.

Break Line
A polygon may be defined as breakline. The polygon must be defined by Use in
Surface points for that. If ticked, MAGNET Office treats a breakline as a line
or arc across which you cannot form a triangle.

Line Color Defines a color for polygon edges displaying.

Line Style
Defines appearance of the polygon edges both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the polygon edge in millimeters when plotted.

Filling Color Defines the color for polygon area filling and strength of the pattern.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for polygon area filling.

Symbol Defines the symbol for polygon area filling.

Line Style

Defines the line style for polygon area hatching. You may choose them from
the line styles library. For more information about line styles, refer to "Line
Style icon" section on page 55. You may specify the slope of the line in the edit-
box below.

Cross Defines whether to activate the cross-hatching of the polygon area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Defines whether to draw the edge line around the polygon or not.
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Buttons of the Edit Polygon Area dialog
Button Description

Set Properties Click it to set current properties as the default for polygons. New polygons will
be created with these properties.

Get Properties Click it to apply existing default properties to the polygon.

Attributes Click it to add new attributes to the polygon.

Images/Pdfs
Click it to attach an image or a PDF to the polygon. The picture will be dis-
played near the polygon centroid point. For more information about configuring
images, refer to "Image Viewer" section on page 573.

Delete Click it to delete the polygon and close the dialog.

Apply Click it to apply changes.

Save File Click it to save the polygon as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the polygon to a boundary, lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the polygon.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Lot properties
A lot is a closed figure, created by lines and/or arcs. A lot is a type of polygon with the additional attributes to
define it as an allotment in a subdivision. Lots can be automatically annotated with bearing, distance, area, lot
numbers, and angles

You can move the lot nodes to change its shape, by holding the Shift key and moving the node with a mouse. You
can also move the entire lot in the same way, by using its centroid point.

The Edit Lot dialog allows you to edit properties of the selected lot. Buttons and fields of the dialog are described
below.

The non-editable fields of the Edit Lot dialog
Field Description

Area Displays the area of the lot.

Perimeter Displays the length of the lot perimeter.

Start Point Displays the number of the lot start point.

End Point Displays the number of the lot end point.

Num Points Displays the quantity of the points (excluding centroid point) in the lot.

Num Lines Displays the quantity of the lines in the lot.

Num Arcs Displays the quantity of the arcs in the lot.

CentroidX Displays the X or north component of the lot centroid point position.

CentroidY Displays the Y or east component of the lot centroid point position.
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The editable fields of the Edit Lot dialog
Field Description

Name Defines the name of the lot.

Layer Defines layer to which the lot belongs to. Note that the lot and its points, lines
and arcs may belong to the different layers.

Line Color Defines a color for lot edges displaying.

Line Style
Defines appearance of the lot edges both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the lot edge in millimeters when plotted.

Filling Color Defines the color for lot area filling.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for lot area filling.

Symbol Defines the symbol for lot area filling.

Line Style
Defines the line style for lot area hatching. You may choose them from the line
styles library. For more information about line styles, refer to "Line Style icon"
section on page 55. You may specify the slope of the line in the editbox below.

Cross Select it to activate the cross-hatching of the lot area.

Opaque When ticked, the lot is places in front of any entities, and cut them at a certain
distance around the lot.

DP Number Defines a deposited plan — previous survey plan with reference number

Code Defines a code for the lot area.

House No Defines a number of the house, located at the lot.

Street Defines a name of the street, going through the lot.

Clipping Boundary When ticked, contours, going through the lot, will not be displayed when plot-
ted.

Break Line
A lot may be defined as breakline. The lot must be defined by Use in Surface
points for that. If selected, MAGNET Office treats a breakline as a line or arc
across which you cannot form a triangle.

Annotation

Select it to turn on lot annotation. Possible values for annotation are:
l Lot Name
l Lot Area
l Lot Angle
l Lot Lines
l Lot Arcs
l Back Boundary

Draw Edge Tick it to draw the lot edge.
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Buttons of the Edit Lot dialog
Button Description

Set Properties Click it to set current properties as the default for lots. New lots will be cre-
ated with these properties.

Get Properties Click it to apply existing default properties to the lot.

Attributes Click it to add new attributes to the lot.

Images/Pdfs
Click it to attach an image or a PDF to the lot. The picture will be displayed
near the lot. For more information about configuring images, refer to "Image
Viewer" section on page 573.

Delete Click it to delete the lot and close the dialog.

Convert Click it to convert the lot to boundary, pad or string.

Apply Click it to apply changes.

Surface Area Click it to compute the area of DTM, crossing with the lot.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Boundary properties
A boundary is a series of connected lines and/or arcs, formed into a closed figure. In fact, a boundary is a named
polygon. It is used for various routines, such as:

l Compute volumes within the boundary
l Delete triangles inside or outside the boundary
l Select entities inside the boundary for other options

A boundary may be selected by its centroid point.

You can move the boundary nodes to change its shape, by holding the Shift key and moving the node with a mouse.
You can also move the entire boundary in the same way, by using its centroid point.

A boundary may be filled with a pattern, hatching, or shading.

The Edit Boundary dialog allows you to edit properties of the selected boundary. Buttons and fields of the dialog
are described below.

The non-editable fields of the Edit Boundary dialog
Field Description

Area Displays the area of the boundary.

Perimeter Displays the length of the boundary perimeter.

Start Point Displays the number of the boundary start point.

End Point Displays the number of the boundary end point.

Num Points Displays the quantity of the points (excluding centroid point) in the boundary.

Num Lines Displays the quantity of the lines in the boundary.

Num Arcs Displays the quantity of the arcs in the boundary.

CentroidX Displays the X or north component of the boundary centroid point position.

75



Edit tab

Field Description

CentroidY Displays the Y or east component of the boundary centroid point position.

The editable fields of the Edit Boundary dialog
Field Description

Name Defines the name of the boundary.

Layer Defines layer to which the boundary belongs to. Note that the boundary and its
points, lines, and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the boundary, will not be displayed when
plotted.

Break Line
A boundary may be defined as breakline. The boundary must be defined by
Use in Surface points for that. If ticked, MAGNET Office treats a breakline as
a line or arc across which you cannot form a triangle.

Line Color Defines a color for boundary edge displaying.

Line Style
Defines appearance of the boundary edge both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the boundary edge in millimeters when plotted.

Filling Color Defines the color for boundary area filling and strength of the pattern.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for boundary area filling.

Symbol Defines the symbol for boundary area filling.

Line Style

Defines the line style for boundary area hatching. You may choose them from
the line styles library. For more information about line styles, refer to "Line
Style icon" section on page 55. You may specify the slope of the line in the edit-
box below.

Cross Tick it to activate the cross-hatching of the boundary area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Tick it to draw the boundary edge.

Buttons of the Edit Boundary dialog
Button Description

Set Properties Click it to set current properties as the default for boundaries. New boundaries
will be created with these properties.

Get Properties Click it to apply existing default properties to the boundary.

Attributes Click it to add new attributes to the boundary.
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Button Description

Images/Pdfs
Click it to attach an image or a PDF to the boundary. The picture will be dis-
played near the boundary centroid point. For more information about configuring
images, refer to "Image Viewer" section on page 573.

Delete Click it to delete the boundary and close the dialog.

Apply Click it to apply changes.

Save File Click it to save the boundary as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the boundary to lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the boundary.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Pad properties
A pad is a series of connected lines and/or arcs, formed into a closed figure around the extents of the buildings or
other pad. In fact, a pad is a named polygon. It is used for identification of a pad and side slopes suitable for the
placement of buildings.

A pad may be selected by its centroid point.

You can move the pad nodes to change its shape, by holding the Shift key and moving the node with a mouse. You
can also move the entire pad in the same way, by using its centroid point.

A pad may be filled with a pattern, hatching, or shading.

The Edit Pad dialog allows you to edit properties of the selected pad. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit Pad dialog
Field Description

Area Displays the area of the pad.

Perimeter Displays the length of the pad edge.

Start Point Displays the number of the pad start point.

End Point Displays the number of the pad end point.

Num Points Displays the quantity of the points (excluding centroid point) in the pad.

Num Lines Displays the quantity of the lines in the pad.

Num Arcs Displays the quantity of the arcs in the pad.

CentroidX Displays the X or north component of the pad centroid point position.

CentroidY Displays the Y or east component of the pad centroid point position.

The editable fields of the Edit Pad dialog
Field Description

Name Defines the name of the pad.

77



Edit tab

Field Description

Layer Defines layer to which the pad belongs to. Note that the pad and its points,
lines, and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the pad, will not be displayed when plot-
ted.

Break Line
A pad may be defined as breakline. The pad must be defined by Use in Surface
points for that. If ticked, MAGNET Office treats a breakline as a line or arc
across which you cannot form a triangle.

Line Color Defines a color for pad edge displaying.

Line Style
Defines appearance of the pad edge both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the pad edge in millimeters when plotted.

Filling Color Defines the color for pad area filling and strength of the pattern.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for pad area filling.

Symbol Defines the symbol for pad area filling.

Line Style

Defines the line style for pad area hatching. You may choose them from the
line styles library. For more information about line styles, refer to "Line Style
icon" section on page 55. You may specify the slope of the line in the editbox
below.

Cross Tick it to activate the cross-hatching of the pad area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Tick it to draw the pad edge.

Buttons of the Edit Pad dialog
Button Description

Set Properties Click it to set current properties as the default for pads. New pads will be cre-
ated with these properties.

Get Properties Click it to apply existing default properties to the pad.

Attributes Click it to add new attributes to the pad.

Images/Pdfs
Click it to attach an image or a PDF to the pad. The picture will be displayed
near the pad centroid point. For more information about configuring images,
refer to "Image Viewer" section on page 573.

Delete Click it to delete the pad and close the dialog.

Apply Click it to apply changes.
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Button Description

Save File Click it to save the pad as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the boundary to lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the pad.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Text properties
A text is a group of alpha, numeric or alphanumeric characters, located in the survey view. It is displayed on one
or multiple lines. Text entities are non-scalable, defined text height remains the same, regardless of the plotting
scale.

The Edit Text dialog allows you to edit properties of the selected text. Buttons and fields of the dialog are
described in the tables below.

Fields of the Edit Text dialog
Field Description

Easting Defines the east or Y component of the text position.

Northing Defines the north or X component of the text position.

Layer Defines the layer to which the text belongs to.

Bearing Defines the bearing of the text. Bearing is measured clockwise from north.

Color Defines a color for text displaying.

Font Defines a font for text displaying.

Char Height Defines the height of the text char

Text Style Defines the pre-configured text style. For information about configuring text
styles, refer to "Text Styles icon" section on page 122.

Char Style Defines the usage bold/italic/underline formatting or not.

Insertion Style Defines the position of the insertion point relative to the text string. Refer to pic-
tures below for details.

Use Text Style Tick it to use the pre-configured text style, selected in the Text Style drop-down
list.

Draw Box Tick it to draw a frame around the text.

Opaque Select it to place the text in front of any entities, and cut them at a certain distance
around the text.

Main editbox Defines the text string to be displayed.

Buttons of the Edit Text dialog
Button Description

Parallel To Click it to set the text to be parallel to an existing entity.

Set Properties Click it to set current properties as the default for text. New text will be cre-
ated with these properties.
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Button Description

Get Properties Click it to load existing default properties for text.

Delete Click it to delete the text and close the dialog.

Upper Convert all chars of the text to uppercase.

Lower Convert all chars of the text to lowercase.

Invert Invert the current upper/lowercase condition.

Capitalize Convert the first char of each word to uppercase.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Dimension properties
A dimension entity measures the distance between two existing points and displays it as annotation for line
between these points with arrows on each end.

The Edit Dimension dialog allows you to edit properties of the selected dimension. Buttons and fields of the dia-
log are described below.

Fields of the Edit Dimension dialog
Field Description

Layer Defines the layer to which the dimension belongs to.

Color Defines a color for dimension displaying.

Thickness Defines the width of the dimension line in millimeters when plotted.

Line Style
Defines appearance of the dimension line both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Arrow Head Defines the style of the arrow head.

Head Angle Defines the angle of the arrow head.

Head Length Defines the length of the arrow head.

Buttons of the Edit Dimension dialog
Button Description

Set Properties Click it to set current properties as the default for dimensions. New dimensions
will be created with these properties.

Get Properties Click it to apply existing default properties to the dimension.

Delete Click it to delete the dimension and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

80



Properties icon

Arrow properties
An arrow is a special line or series of lines with an arrow head at one or both ends. The arrow can be used as an
indicator on a plan. Various arrow head styles are available with user-defined dimensions for the arrow head.
Arrow heads are non-scalable, defined arrow head remains the same, regardless of the plotting scale.

The Edit Arrow dialog allows you to edit properties of the selected arrow. Buttons and fields of the dialog are
described below.

Fields of the Edit Arrow dialog
Field Description

Layer Defines the layer to which the arrow belongs to.

Color Defines a color for arrow displaying.

Thickness Defines the width of the arrow line in millimeters when plotted.

Line Style
Defines appearance of the arrow line both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Arrow Head Defines the style of the arrow head.

Head Angle Defines the angle of the arrow head.

Head Length Defines the length of the arrow head.

Buttons of the Edit Arrow dialog
Button Description

Set Properties Click it to set current properties as the default for arrows. New arrows will be
created with these properties.

Get Properties Click it to apply existing default properties to the arrow.

Delete Click it to delete the arrow and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Image Viewer
The image viewer allows you to attach images or/and PDF files to the MAGNET Office entities.

To open the image viewer, click Images/Pdfs in the properties dialog of the appropriate entity. Left panel contains
the list of the attached images and/or PDF files. Right panel displays the preview of the currently selected
image/PDF file. Buttons are described in the table below.

Buttons of the image viewer
Button Description

View Pdf
Click it to open the selected PDF file in the default system PDF reader.

NOTE
This button is displayed only when a PDF file is selected.

Attach Image Click it to attach a new image or PDF file to the entity.

Delete Click it to delete the selected image/PDF file.
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Button Description

OK Click it to save the changes and close the image viewer.

Cancel Click it to close the image viewer without saving changes.

To display an image or/and a PDF file in the survey view, tick the checkbox near the required image/PDF file in
the left panel, and click OK.
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Selection group
The Selection group allows from the Edit tab of the MAGNET Office ribbon you to perform operations with object
selections. It contains five icons, described in the table below.

Select All icon
Click it to select all active objects in the survey view.

Select Point icon
Click it to turn on the point selection mode.

Linked Point icon
Click it to select points, linked with the selected object.

Invert icon
Click it to invert the object selection in the project.

Deselect All icon
Click it to remove all current selections.

Select All icon
The Select All icon of the Selection group allows you to select all active data of your project. Its shortcut is
Ctrl+A.

Click the icon to select all active objects in the survey view.

Select Point icon
The Select Point icon of the Selection group allows you to select one point in your project.

To select a point:
1. In the Selection group of the Edit tab, click the Select Point icon.

The input bar is displayed at the bottom panel.
2. In the Number editbox, type the number of the required point.
3. Do one of the following:

l Press Enter.
l Left click on the survey view.

The point is selected.

Linked Point icon
The Linked Point icon of the Selection group allows you to add points of the currently select object to the selec-
tion.

To use the functionality of the icon:
1. Select the required object, which is based on points.
2. In the Selection group of the Edit tab, click the Linked Points icon.

The selection is expanded, and includes the selected object itself, and also points, on which it is based.
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Invert icon
The Invert icon of the Selection group allows you to invert current selection.

Click the icon to deselect all currently selected objects, and select all other objects.

Deselect All icon
The Deselect All icon of the Selection group allows you to deselect all currently selected objects.

TIP
Other way to cancel any selection is to do the left click outside of the selection area.
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Select By group
The Select By group from the Edit tab of the MAGNET Office ribbon allows you to perform objects selections by
criteria. It contains five icons, described in the table below.

Select By icon
Click it to perform the selection by criteria.

By Region icon
Click it to perform the selection within a specified area.

De-Select By icon
Click it to perform deselection by criteria.

By Name icon
Click it to perform the selection by specified object name.

By DTM icon
Click it to perform the selection within the defined digital terrain model.

Select By icon
The Select By icon of the Select By group allows you to select objects by a certain criteria.

To perform a configured selection:
1. In the Select By group of the Edit tab, click the Select By icon.

The Select by: dialog is displayed.

NOTE
If any objects has been already selected when clicked, dialog will be namedSelect From Cur-
rent Selection by: and the selection will be performed only within the current selection.

2. Configure the filters for each entity at the respective tab. Detailed description may be found in cor-
responding sections:

l "Layers tab" section on the next page
l "Points tab" section on the next page
l "Lines tab" section on page 87
l "Arcs tab" section on page 88
l "Circles tab" section on page 88
l "Strings tab" section on page 89
l "Polylines tab" section on page 89
l "Polygons tab" section on page 90
l "Lots tab" section on page 91
l "Text tab" section on page 91

3. Make sure, that in the Results group box of the Layer tab, you have selected the required action to be per-
formed after selection:

l View— to simply select required objects.
l List— to select required objects and list them in the data listing.
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l Edit Properties— to select required objects and edit their properties.
4. Click OK

The objects are selected.

Buttons of the Select by: dialog
Button Description

Save Click it to save the current configuration. For more information refer to "Saving
selections" section on page 92.

Restore Click to discard changes and load the currently selected configuration.

Reset Click it to reset the layers to how they appeared at the fist icon clicking.

Delete Click it to delete the currently selected configuration.

OK Click it to select objects by as configured.

Cancel Click it to close the dialog.

Layers tab
The Layers tab of the Select by: dialog allows you to configure the selection by layer. For more information about
the Select by: dialog, refer to "Select By icon" section on the previous page.

To configure the filter by layer :
1. In the layer list, select the layers for objects selection. You may use either Select All, or Select None but-

tons from the Layers group box.
2. If needed in the Layers group box, tick the Apply Layers to All Entities checkbox to perform selection

though all the existing entities.
3. In the Results group box, select the action to be performed after selection:

l View— to simply select required objects.
l List— to select required objects and list them in the data listing.
l Edit Properties— to select required objects and edit their properties.

4. Do one of the following:
l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Points tab
The Points tab of the Select by: dialog allows configuring the selection of points. For more information about the
Select by: dialog, refer to "Select By icon" section on the previous page. You may filter points by name, code,
mark, etc. Points, matching each of the specified criteria will be selected.

To configure the filter by points:
1. Tick the Select Points checkbox to include points into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:
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l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Points tab
Field Description

Name
Type point name (point number) to select points by name. Separate names by
commas, or use a hyphen to specify the name range.

Example: 50-53, 95 will select points 50, 51, 52, 53, and 95.

Code

Type point code to select points by code. Separate codes by commas, or use a
hyphen to specify an alphabetical code range. This range can contain only first
character of the code range.

Example: R-T will select points with any code starting with R or S but none of
those starting with T unless a code of the single character T is available.

Elevation From
To

Type the lowest elevation in the range in the From editbox, followed by the
highest elevation in the range in the To editbox, to select points by height.

All Set Tick it to select all points, matching specified range, with the active elevation.

All Unset Tick it to select all points with the inactive elevation.

Use in Surface Tick it to select all points, matching specified range, and marked as Use in Sur-
face.

Attributes Name Tick it to select points by attribute name, specified in the drop-down list below.

Attributes Name
with Values Tick it to select points by attribute value, specified in the editbox below.

Mark Select a required mark, or set of marks to select points by mark.

Symbol Select a required symbol, or set of symbols to select points by symbol.

Color Select required color, or set of colors to select points by color.

Lines tab
The Lines tab of the Select by: dialog allows configuring the selection of lines. For more information about the
Select by: dialog, refer to "Select By icon" section on page 85. You may filter lines by style, thickness, color, etc.
Lines, matching each of the specified criteria will be selected.

To configure the filter by lines:
1. Tick the Select Lines checkbox to include lines into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.
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Fields of the Lines tab
Field Description

Select Lines Tick it to include lines into selection.

Breaklines Tick it to select only breaklines.

Style Select a required line style, or set of line styles to select lines by style.

Thickness Select a required thickness, or set of thicknesses to select lines by thicknesses.

Color Select required color, or set of colors to select lines by color.

Arcs tab
The Arcs tab of the Select by: dialog allows configuring the selection of arcs. For more information about the
Select by: dialog, refer to "Select By icon" section on page 85. You may filter arcs by style, thickness, color, etc.
Arcs, matching each of the specified criteria will be selected.

To configure the filter by arcs:
1. Tick the Select Arcs checkbox to include arcs into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Arcs tab
Field Description

Select Arcs Tick it to include arcs into selection

Breaklines Tick it to select only the breaklines in entities.

Style Select a required line style, or set of line styles to select arcs by line style.

Thickness Select a required thickness, or set of thicknesses to select arcs by thicknesses.

Color Select required color, or set of colors to select arcs by color.

Circles tab
The Circles tab of the Select by: dialog allows configuring the selection of circles. For more information about
the Select by: dialog, refer to "Select By icon" section on page 85. You may filter circles by style, thickness,
color, etc. Circles, matching each of the specified criteria will be selected.

To configure the filter by circles:
1. Tick the Select Circles checkbox to include circles into selection.
2. Set up the required parameters. Description of the fields may be found below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.
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l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Circles tab
Field Description

Select Circles Tick it to include circles into selection.

Breaklines Tick it to select only breaklines.

Style Select a required line style, or set of line styles to select circles by line style.

Thickness Select a required thickness, or set of thicknesses to select circles by thick-
nesses.

Color Select required color or set of colors to select circles by color.

Strings tab
The Strings tab of the Select by: dialog allows configuring the selection of strings. For more information about the
Select by: dialog, refer to "Select By icon" section on page 85. You may filter strings by style, thickness, color,
etc. Strings, matching each of the specified criteria will be selected.

To configure the filter by strings:
1. Tick the Select Strings checkbox to include strings into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Strings tab
Field Description

Select Strings Tick it to include strings into selection.

Breaklines Tick it to select only breaklines.

Name Type string name, to select strings by names.

Style Select a required line style, or set of line styles to select strings by line style.

Thickness Select a required thickness, or set of thicknesses to select strings by thick-
nesses.

Color Select required color, or set of colors to select strings by color.

Polylines tab
The Polylines tab of the Select by: dialog allows configuring the selection of polylines. For more information
about the Select by: dialog, refer to "Select By icon" section on page 85. You may filter polylines by style, thick-
ness, color, etc. Polylines, matching each of the specified criteria will be selected.

To configure the filter by polylines:
1. Tick the Select Polylines checkbox to include polylines into selection.
2. Set up the required parameters. Description of the fields may be found below.
3. Do one of the following:
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l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Polylines tab
Field Description

Select Polylines Tick it to include polylines into selection.

Breaklines Tick it to select only breaklines.

Elevation From
To

Type the lowest elevation in the range in the "From" editbox, followed by the
highest elevation in the range in the "To" editbox, to select polylines by height.

All Set Tick it to select all polylines, matching specified range, with the active elev-
ation.

All Unset Tick it to select all polylines with the inactive elevation.

Style Select a required line style, or set of line styles to select polylines by line style.

Thickness Select a required thickness, or set of thicknesses to select polylines by thick-
nesses.

Color Select required color, or set of colors to select polylines by color.

Polygons tab
The Polygons tab of the Select by: dialog allows configuring the selection of polygons. For more information
about the Select by: dialog, refer to "Select By icon" section on page 85. You may filter polygons by line style,
thickness, color, etc. Polygons, matching each of the specified criteria will be selected.

To configure the filter by polygons:
1. Tick the Select Polygons checkbox to include polygons into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on
page 92.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Polygons tab
Field Description

Select Polygons Tick it to include polygons into selection

Breaklines Tick it to select only breaklines.

All Tick it to select all polygons and boundaries.

Exclude Bound-
aries Tick it to exclude boundaries from the selection.

Boundaries Only Tick it to select only boundaries.
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Field Description

Style Select a required line style, or set of line styles to select polygons by line style.

Thickness Select a required thickness, or set of thicknesses to select polygons by thick-
nesses.

Color Select required color, or set of colors to select polygons by color.

Lots tab
The Lots tab of the Select by: dialog allows configuring the selection by lot. For more information about the Select
by: dialog, refer to "Select By icon" section on page 85. You may filter lots by line style, thickness, color, etc.
Lots, matching each of the specified criteria will be selected.

To configure the filter by lots:
1. Tick the Select Lots checkbox to include lots into selection.
2. Set up the required parameters. Fields are described in the table below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on the
next page.

l Click another tab to set more filters.
l Click OK to select the objects.

Fields of the Lots tab
Field Description

Select Lots Tick it to include lots into selection.

Breaklines Tick it to select only breaklines.

Code Type a code, to select lots by code.

DP Number Type a DP number or numbers range, to select lots by DP number.

Style Select a required line style, or set of line styles to select lots by line style.

Thickness Select a required thickness, or set of thicknesses to select lots by thicknesses.

Color Select required color, or set of colors to select lots by color.

Text tab
The Text tab of the Select by: dialog allows configuring the selection by text. For more information about the
Select by: dialog, refer to "Select By icon" section on page 85. You may filter text by style, size, color, etc. Text,
matching each of the specified criteria will be selected.

To configure the filter by text:
1. Tick the Select Text checkbox to include lines into selection.
2. Set up the required parameters. Description of the fields may be found below.
3. Do one of the following:

l Click Save to save your selection. For more information refer to "Saving selections" section on the
next page.

l Click another tab to set more filters.
l Click OK to select the objects.
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Fields of the Text tab
Field Description

Select Text Tick it to include lines into selection.

Font Select a required font, or set of fonts to select text by font.

Size Select a required font size, or set of font sizes to select text by font style.

Style Select a required text style, or set of text styles to select text by style.

Color Select required color, or set of colors to select texts by color.

Saving selections
It is possible to save the configuration for selection. To save the current configuration:

1. At the bottom toolbar, click Save.

The Select By - Name dialog is displayed.
2. In the Name editbox, type the name for the selection.
3. If needed, in the Comment editbox, type the short description.
4. Click OK.

The configuration is saved.

To load the previously save configuration, select it from the drop-down list at the bottom toolbar.

By Region icon
The By Region icon of the Select By group allows you to perform selection by criteria within the specified
region.

To perform selection in specified region:
1. In the Select By group of the Edit tab, click the By Region icon.

The Select By Region dialog is displayed.
2. In the Selection group box, specify the way to define the region for selection:

l Select by Points— to define the region by drawing its border with points.
l Select By Window— to define the region by drawing its border with a rectangle.
l Select by Boundary — to define the region by an existing boundary. If so, select the required bound-
ary from the drop-down list, located to the right of the radiobutton.

3. In the Entities group box, specify the entities to be selected.
4. In the Results group box, select the action to be performed after selection:

l View— to simply select required objects.
l List— to select required objects and list them in the data listing.
l Edit Properties— to select required objects and edit their properties.

5. Click OK

The objects are selected.

De-Select By icon
The De-Select By icon of the Select By group allows you to deselect objects by a certain criteria.
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To perform a configured deselection:
1. In the Select By group of the Edit tab, click the De-Select By icon.

The De-Select by: dialog is displayed.
2. Configure the filters for each entity at the respective tab. Detailed description may be found in cor-

responding sections:
l "Layers tab" section on page 86
l "Points tab" section on page 86
l "Lines tab" section on page 87
l "Arcs tab" section on page 88
l "Circles tab" section on page 88
l "Strings tab" section on page 89
l "Polylines tab" section on page 89
l "Polygons tab" section on page 90
l "Lots tab" section on page 91
l "Text tab" section on page 91

3. Make sure, that in the Results group box of the Layers tab, you have selected the required action to be per-
formed after selection:

l View— to simply deselect required objects.
l List— to deselect required objects and list them in the data listing.
l Edit Properties— to deselect required objects and edit properties of the rest objects.

4. Click OK

The objects are deselected.

Buttons of the De-Select by: dialog
Button Description

Save Click it to save the current configuration. For more information refer to "Saving
selections" section on the previous page.

Restore Click to discard changes and load the currently selected configuration.

Reset Click it to reset the layers to how they appeared at the first icon clicking.

Delete Click it to delete the currently selected configuration.

OK Click it to select objects by as configured.

Cancel Click it to close the dialog.

By Name icon
The By Name icon of the Select By group allows you to select entities by their names.

To perform the selection by name:
1. In the Select by group of the Edit tab, click the By Name icon.

The Select by Name dialog is displayed.
2. In the Selection group box, specify the required entity and its name.
3. In the Results group box, select the action to be performed after selection:
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l View— to simply select required objects.
l List— to select required objects and list them in the data listing.
l Edit Properties— to select required objects and edit their properties.

4. Click OK

The objects are selected.

By DTM icon
The By DTM icon of the Select By group allows you to perform the selection by criteria within the defined
digital terrain model (DTM).

To perform the selection within DTM:
1. In the Select By group of the Edit tab, click the By DTM icon.

The Select By DTM dialog is displayed.
2. In the Select From field, specify the area for selection:

l All Layers— to select objects, belong to all existing layers
l Active Layers— to select objects, belongs only to active layers
l Selection— to select objects only from the current selection

3. From the Reference DTM drop-down list, select the DTM within which the selection will be performed.
4. In the Depth Range From DTM field specify the depth range around the DTM for selection.
5. Click OK.

Objects are selected.
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Edit group
The Edit group from the Edit tab of the MAGNET Office ribbon allows you to edit project survey codes. It con-
tains one icon, described in the table below.

Codes icon
Click it to configure the project survey codes.

Codes icon
The Codes icon of the Edit group allows you to edit project survey codes.

The Project Survey Codes dialog, opened at Project Survey Codes tab appears after clicking. For more inform-
ation, refer to "Project survey codes editor" section on page 543.
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View Tab
The View tab of the MAGNET Office ribbon contains control icons for layout configuring. It is separated to
seven groups, described in the corresponding sections:

l "Edit Layers group" section on the facing page
l "Layer Control group" section on page 102
l "Refresh group" section on page 109
l "Navigate group" section on page 110
l "Features group" section on page 114
l "Options group" section on page 116
l "Display group" section on page 119
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Edit Layers group
The Edit Layers group from the View tab of the MAGNET Office ribbon allows you to perform operations with
layers.

A layer may be described as a sheet of transparent film, which may be viewed one in a time, or several layers at
once, combined to a "sandwich." Each entity belongs to one layer only, and will be invisible, if its layer is inact-
ive.

Newly created project usually has only one layer with the $$DEFAULT name, unless other is configured.

Only one layer may be current at once. It is marked with the asterisk in the Layer Settings dialog. More inform-
ation about Layer Settings dialog may be found in "Layers icon" section below. All data, added to project, by
using Insert tab functions, will be located on the current layer. 

The group contains four icons, described in the table below.

Layers icon
Click it to configure layers.

Add icon
Click it to add a new layer.

Order icon
Click it to change the layers order.

Delete icon
Click it to delete an existing layer.

Layers icon
The Layers icon of the Edit Layers group allows you to manage layers in the current project. Its keyboard shortcut
is Ctrl+L.

To open the layer manager, click the icon. The Layer Settings dialog appears. It displays the list of the layers in
the project with the following properties for each layer:

l Layer Name
l Active flag
l Lock flag
l Overlay flag
l Color
l Mark
l Symbol
l Line Type
l Line Width
l Text Style

The current layer is marked with the asterisk. Properties are described in the table below.

Layer properties
Property Description

Layer Name Defines the name of the layer.
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Property Description

Active Defines whether the layer is active or inactive. Objects from inactive layers
will not be displayed in the survey view.

Lock Defines whether the layer is locked (i.e. cannot be changed) or not.

Overlay When ticked, entities which belong to the layer will be darkened, and not avail-
able for editing, i.e. all entities will be look like a background image.

Color Defines the default color for the layer. All entities, which belong to this layer
and have By Layer value of the Color parameter will be painted with it.

Point Mark Defines the default point mark for the layer. All points, which belong to this
layer and have By Layer value of the Mark parameter will have such mark.

Line Type
Defines the default line style for the layer. All lines, arcs, circles, strings, poly-
lines, polygon, lots, pads and boundaries, which belong to this layer and have
By Layer value of the Line Style parameter will have such line style.

Line Width
Defines the default line thickness for the layer. All lines, arcs, circles, strings,
polylines, polygon, lots, pads and boundaries, which belong to this layer and
have By Layer value of the Thickness parameter will have such line thickness.

Point Symbol Defines the default point symbol for the layer. All points, which belong to this
layer and have By Layer value of the Symbol parameter will have such symbol.

Text Style Defines the default text style for the layer.

Buttons of the Layer Settings dialog
Button Description

OK Click it to save the changes and close the dialog.

Cancel Click it to discard the changes and close the dialog.

New Click it to create a new layer. For more information refer to "Add icon" section
on the facing page.

Edit Click it to edit the selected layers. For more information, refer to Layer prop-
erties.

Delete Click it to delete the selected layers. If the current layer is deleted, the
$$DEFAULT layer becomes the current one.

Delete Empty Click to delete layers which don't contain any entities.

Merge Click it to transfer objects from selected layers to another existing layer.

Set Current
Click it to set selected layer as the current. The current layer is marked with
the asterisk. All new objects will be created at the current layer, unless other
is configured.

Invert On/Off Click it to turn on inactive layer and turn off active ones. The current layer can-
not be turned off.

Off Click it to turn off selected layers. The current layer cannot be turned off.
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Button Description

On Click it to turn on selected layers.

Select All Click it to select all existing layers in the dialog.

Invert Selection Click it to invert the selection of the layers in the dialog.

Prefix/Suffix Click it to add a prefix or a suffix to the layer name.

List Layers Click it to generate a layers report.

Add Group Click it to create a new layer group. For more information, refer to "Groups
icon" section on page 104.

Select Group Click it to select all layers belongs to the defined group.

Group Settings Click it to configure the layer group settings.

Avoidance Click it to configure the avoidance settings. See "Avoidance" section on
page 575 for details.

Add icon
The Add icon of the Edit Layers group allows you to create a new layer.

To create a new layer:
1. In the Edit Layers group of the View tab, click the Add icon.

The Add New Layer dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The new layer is created.

Layer properties
Property Description

Layer Name Defines the name of the layer.

Active Defines whether the layer is active or inactive. Objects from inactive layers
will not be displayed in the survey view.

Lock Defines whether the layer is locked (i.e. cannot be changed) or not.

Overlay When ticked, entities which belong to the layer will be darkened, and not avail-
able for editing, i.e. all entities will be look like a background image.

Color Defines the default color for the layer. All entities, which belong to this layer
and have By Layer value of the Color parameter will be painted with it.

Point Mark Defines the default point mark for the layer. All points, which belong to this
layer and have By Layer value of the Mark parameter will have such mark.

Line Type
Defines the default line style for the layer. All lines, arcs, circles, strings, poly-
lines, polygon, lots, pads and boundaries, which belong to this layer and have
By Layer value of the Line Style parameter will have such line style.
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Property Description

Line Width
Defines the default line thickness for the layer. All lines, arcs, circles, strings,
polylines, polygon, lots, pads and boundaries, which belong to this layer and
have By Layer value of the Thickness parameter will have such line thickness.

Point Symbol Defines the default point symbol for the layer. All points, which belong to this
layer and have By Layer value of the Symbol parameter will have such symbol.

Text Style Defines the default text style for the layer.

Avoidance To activate avoidance data, tick the checkbox and click Avoidance. See
"Avoidance" section on page 575 for details.

Order icon
The Order icon of the Edit Layers group allows you to change the order of layer appearance in the Survey view.

To change the layers order:
1. In the Edit Layers group of the View tab, click the Order icon.

The Layer Display Order dialog is displayed. Buttons of the dialog are described in the table below.
2. Select the layers to be moved.
3. Move them as you need.
4. Click OK.

Buttons of the Layer Display Order dialog
Button Description

Move to Top Click it to move the selected layers to the top position. Order of layers within
the selection remains the same.

Move to Bottom Click it to move the selected layers to the bottom position. Order of layers
within the selection remains the same.

Move Up Click it to move each of the selected layers to one position upward.

Move Down Click it to move each of the selected layers to one position downward.

Clear Click it to clear the selection of the layers.

Invert Click it to invert the selection of the layers.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving the changes.

Delete icon
The Delete icon of the Edit Layers group allows you to delete existing layers.

NOTES
The $$DEFAULT layer cannot be deleted.
If the current layer was deleted, the $$DEFAULT layer becomes the current.

To delete a layer:
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1. In the Edit Layers of the View tab, click the Delete icon.

The Delete Layer dialog is displayed.
2. Select layers to be deleted.

TIP

To select all layers, tick the checkbox in the bottom left corner of the dialog.

3. Click OK.

101



View tab

Layer Control group
The Layer Control group from the View tab of the MAGNET Office ribbon allows you to manage existing layers.
It contains eighteen icons.

Layer Off icon
Click it to turn off an existing layer.

Isolate icon
Click it to isolate a layer.

Restore icon
Click it to restore layer settings.

Set Layer icon
Click it to set a layer as the current one.

All On icon
Click it to activate all layers.

All Off icon
Click it to deactivate all layers.

Groups icon
Click it to configure layer groups. This icon also contains the list

of the second level icons. Click to see it.

Add to Group icon
Click it to add layers to the group by selecting entities in the sur-

vey view.
Display/Hide Group icon

Click it to turn on/off layers from the defined groups.
Add to Group - Design icon

Click it to add layers to the pre-defined "Design" group.
Add to Group - Existing icon

Click it to add layers to the pre-defined "Existing" group.
Add to Group - Misc icon

Click it to add layers to the pre-defined "Misc" group.
Display Group - Design icon

Click it to turn on all layers, belong to the "Design" group.
Display Group - Existing icon

Click it to turn on all layers, belong to the "Existing" group.
Display Group - Misc icon

Click it to turn on all layers, belong to the "Misc" group.
Hide Group - Design icon

Click it to turn off all layers, belong to the "Design" group.
Hide Group - Existing icon

Click it to turn off all layers, belong to the "Existing" group.
Hide Group - Misc icon

Click it to turn off all layers, belong to the "Misc" group.
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Layer Off icon
The Layer Off icon of the Layer Control group allows you to turn off an existing layer, by selecting an object
from this layer.

To turn the layer off:
1. In the Layer Control group of the View tab, click the Layer Off icon.
2. In the survey view, click an object, which belongs to the layer to be turned off.

The layer is turned off. All entities, which belong to it are not displayed.

Isolate icon
The Isolate icon of the Layer Control group allows you to isolate a layer, by selecting an object, which belongs to
this layer. Isolating means that all layers will be turned off; except for the selected one.

To isolate a layer:
1. In the Layer Control group of the View tab, click the Isolate icon.
2. In the survey view, click an object, which belongs to the layer to be isolated.

The layer is isolated, and set as the current. Only entities, which belong to it are displayed. All other layers
are turned off.

Restore icon
The Restore icon of the Layer Control group allows you to restore the layers activity settings since the last usage
of the Layer Off icon or the Isolate icon.

Click it to restore the values of the on/off layers parameter, as in was before the last usage of the Layer Off icon
or the Isolate icon.

Set Layer icon
The Set Layer icon of the Layer Control group allows you to set a layer as the current one, by selecting an object,
which belongs to this layer.

To set layer as a current:
1. In the Layer Control group of the View tab, click the Set Layer icon.
2. In the survey view, click an object, which belongs to the layer to be set as the current.

The layer is set as the current.

All On icon
Click the All On icon of the Layer Control group to turn on all existing layers in the project.

All Off icon
Click the All Off icon of the Layer Control group to turn off all existing layers in the project, except for the cur-
rent one.
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Groups icon
The Groups icon of the Layer Control group allows you to configure sets of layers.

The Layer Group Settings dialog appears after clicking the icon. Buttons and fields of the dialog are described in
the table below. The main field displays the list of the layers of the currently selected group with their On/Off
flags.

Fields of the Layer Group Settings dialog
Field Description

Group Name
Contains the name of the currently selected layer group. The drop-down list of

all available groups may be seen by clicking .

Description Contains the short description of the selected group.

Buttons of the Layer Group Settings dialog
Button Description

Add Layer

Click it to add an existing layer to the currently selected group.

The Layer List dialog appears after clicking. Select layers to be added to the
group and click OK.

You may also type the name of the new layer in the New Layer editbox. The
new layer will be created and added to the group after clicking OK.

Remove Layer Click it to remove the selected layers from the group.

Invert Selection Click it to invert the selection of the layers in the dialog.

Select All Click it to select all layers in the dialog.

Invert On/Off Click it to turn on inactive layer and turn off active ones.

On Click it to activate a selected layer in the group. Note that this property is
internal for the group, and does not affect to the global layer activity settings.

Off Click it to deactivate a selected layer in the group. Note that this property is
internal for the group, and does not affect to the global layer activity settings.

New Click it to create a new group.

Reset Click it to discard all resent unsaved changes.

Rename Click it to rename the currently selected group.

Delete Click it to delete the currently selected group.

Copy From Lib Click it to apply previously saved group settings from the MAGNET Office lib-
rary.

Save to Lib Click it to save current group settings to the MAGNET Office library.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Add to Group icon
The Add to Group icon of the Layer Control group allows you to add layers to group by selecting objects in the
survey view, which belong to the required layers.

To add layers to a group:
1. In the Layer Control group of the View tab, click the Add to Group icon.

The Add Layer To Group dialog is displayed.
2. From the Group Name drop-down list, select the group to which layers will be added.
3. If needed, in the Description editbox, edit short description of the group.
4. If needed, tick the Remove layers from other groups checkbox. If ticked, the selected layers will be

excluded from all other groups.
5. Click OK.
6. In the survey view, click objects, which belong to the required layers. An information string on the bottom

panel displays the name of the last added layer.
7. When finished, press ESC.

The layers are added to the group.

Display/Hide Group icon
The Display/Hide Group icon of the Layer Control group allows you to turn on/off layers, which belongs to a spe-
cific group.

To turn on/off a group:
1. In the Layer Control group of the View tab, click the Display/Hide Group icon.

The Layer Group Selection dialog is displayed.
2. Select layers to be turned on/off.
3. Do one of the following:

l Tick the Activate all layers in the selected groups checkbox to turn on layers from the selected
group.

l Untick the Activate all layers in the selected groups checkbox to turn off layers from the selected
group.

4. Tick the Other Layers checkbox to change visibility of layers, which don't belong to the selected groups. If
this checkbox is unticked, the visibility of other layers will not change. If ticked, do one of the following:

l Select the Off radiobutton to turn off other layers.
l Select the On radiobutton to turn on other layers.

5. Click OK.

NOTE
If the current layer is among layers to be turned off, themessage window will warn about it after clicking
OK and the $$DEFAULT layer will be set as the current.

Fields of the Layer Group Selection dialog
Field Description

Activate all layers in
the selected groups Tick it to turn on all layers from the selected group.
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Field Description

Other Layers
Tick it to define whether to change visibility of layers, which don't belong
to the selected groups or not. If ticked, select either On or Off radiobutton
below to turn on or turn off layers respectively.

Buttons of the Layer Group Selection dialog
Button Description

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Invert Selection Click it to deselect currently selected groups and select the other groups.

Select All Click it to select all existing groups.

Add to Group - Design icon
The Add to Group - Design icon of the Layer Control group allows you to add layers to the pre-defined
"Design" group by selecting objects in the survey view, which belong to required layers.

The "Design" group is created to simplify group managing in the project, and reserved for newly created entities
in the working area.

To add layers to the "Design" group:
1. In the Layer Control group of the View tab, click the Add to Group - Design icon.
2. In the survey view, select objects, which belongs to the required layers. An information string on the bot-

tom panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Design" group.

Add to Group - Existing icon
The Add to Group - Existing icon of the Layer Control group allows you to add layers to the pre-defined "Exis-
itng" group by selecting objects in the survey view, which belong to required layers.

The "Existing" group is created to simplify group managing in the project, and reserved for entities, which are
already exists in the working area.

To add layers to the "Existing" group:
1. In the Layer Control group of the View tab, click the Add to Group - Existing icon.
2. In the survey view, select objects, which belongs to the required layers. An information string on the bot-

tom panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Existing" group.

106



Add to Group - Misc icon

Add to Group - Misc icon
The Add to Group - Misc icon of the Layer Control group allows you to add layers to the pre-defined "Misc"
group by selecting object in the survey view, which belong to required layers.

The "Misc" group is created to simplify group managing in the project, and reserved for various entities, which are
don't belong to the "Design" of "Existing" groups.

To add layers to the "Misc" group:
1. In the Layer Control group of the View tab, click the Add to Group - Misc icon.
2. In the survey view, select objects, which belongs to the required layers. An information string on the bottom

panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Misc" group.

Display Group - Design icon
The Display Group - Design icon of the Layer Control group allows you to turn on all layers, which belong to the
"Design" group and turn off all other layers.

NOTE
If the "Design" group does not contain any layer, this icon is inactive.

Display Group - Existing icon
The Display Group - Existing icon of the Layer Control group allows you to turn on all layers, which belong to
the "Existing" group and turn off all other layers.

NOTE
If the "Existing" group does not contain any layer, this icon is inactive.

Display Group - Misc icon
The Display Group - Misc icon of the Layer Control group allows you to turn on all layers, which belong to the
"Misc" group and turn off all other layers.

NOTE
If the "Misc" group does not contain any layer, this icon is inactive.

Hide Group - Design icon
The Hide Group - Design icon of the Layer Control group allows you to turn off all layers, which belong to the
"Design" group. Visibility of other layers will not change.

NOTE
If the "Design" group does not contain any layer, this icon is inactive.

Hide Group - Existing icon
The Hide Group - Existing icon of the Layer Control group allows you to turn off all layers, which belong to the
"Existing" group. Visibility of other layers will not change.

NOTE
If the "Existing" group does not contain any layer, this icon is inactive.
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Hide Group - Misc icon
The Hide Group - Misc icon of the Layer Control group allows you to turn off all layers, which belong to the
"Misc" group. Visibility of other layers will not change.

NOTE
If the "Misc" group does not contain any layer, this icon is inactive.
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Refresh group
The Refresh group from the View tab of the MAGNET Office ribbon, allows you to renew lookout of the project.
It contains two icons, described in the table below.

Redraw icon
Click it to refresh the displaying of the current view.

Regen icon
Click it to regenerate the current view.

Redraw icon
Click the Redraw icon of the Refresh group to refresh the entities displaying in the current window.

Regen icon
Click the Regen icon of the Refresh group to regenerate the data displaying by reading data from the project data-
base.
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Navigate group
The Navigate group from the View tab of the MAGNET Office ribbon allows you to manage the scale of the sur-
vey view. It contains five icons, and five second level icons, described in the table below.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

All icon
Click it to fit all data in the view. This icon also contains the list of the

second level icons. Click to see it.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom out the center area of the survey view.

Box icon
Click it to make the specified area fits the screen.

Point icon
Click it to view a point with the defined scale.

Pan icon
Click it to scroll the view.

Save View icon
Click it to save the current view. This icon also contains the list of the

second level icons. Click to see it.

Named View icon
Click it to manage saved views.

Window icon
The Window icon of the Navigate group allows you to draw a rectangle area, which will be zoomed to fit the
screen.

To zoom an area:
1. In the Navigate group of the View tab, click the Window icon.
2. In the survey view draw a required rectangle area, by defining its opposite points.

The selected area is zoomed to fit the screen.

There is also a second way to zoom an area:
1. In the survey view, draw a required rectangle area, as for mass entities selection.

The rectangle is displayed as the dashed yellow border.
2. In the Navigate group of the View tab, click the Window icon.

The selected area is zoomed to fit the screen.
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NOTE
The Zoom Window item of the context menu for survey view has the same functionality.

Previous icon
Click the Previous icon of the Navigate group to return to the previous scale and position settings of the survey
view.

NOTE
The Zoom Prev item of the context menu for the survey view has the same functionality.

All icon
Click the All icon of the Navigate group to fit all the data to the screen.

NOTE
The Zoom Extents item of the context menu for the survey view has the same functionality.

In icon
Click the In icon of the Navigate group to zoom in the center of the survey view.

NOTES
Youmay zoom in the current pointer position by scrolling up themouse wheel.

The Zoom In item of the context menu for survey view has the same functionality.

Out icon
Click the Out icon of the Navigate group to zoom out the center of the survey view.

NOTES
Youmay zoom out the current pointer position by scrolling down themouse wheel.

The Zoom Out item of the context menu for survey view has the same functionality.

Box icon
The Box icon of the Navigate group allows you to zoom in an area of the survey view, defined by the rectangle.

To zoom in a survey view area:
1. In the Navigate group of the View tab, click the Box icon.

The yellow rectangle is displayed around the mouse pointer.
2. Point to the area to be zoomed, and do the left click.

The selected area is zoomed.
3. If needed, select required area again and do the left click.
4. When finished, press ESC.

NOTE
The Zoom Box item of the context menu for the survey view has the same functionality.

Point icon
The Point icon of the Navigate group allows you to display the selected point with the defined scale.

To zoom the point:
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1. In the Navigate group of the View tab, click the Point icon.

The control panel is displayed at the bottom of the MAGNET Office window.
2. In the Scale editbox, specify the required scale.
3. Do one of the following:

l In the Number editbox, specify the number of the required point and press Enter.
l Click the required point in the survey view.

The point is zoomed.

NOTE
The Zoom Point item of the context menu for the survey view has the same functionality.

Pan icon
The Pan icon of the Navigate group allows you to scroll the survey view by dragging it.

To scroll the survey view:
1. In the Navigate group of the View tab, click the Pan icon.
2. Drag and move survey view as you need.
3. When finished, do one of the following:

l Press ESC.
l Do the right click and select Cancel from the context menu.

NOTE
ThePan item of the context menu for the survey view has the same functionality.

Save View icon
The Save View icon of the Navigate group allows you to save the current scale and position of the survey view
for future usage.

To save the current view:
1. In the Navigate group of the View tab, click the Save View icon.

The New View Name dialog is displayed.
2. Type the name of the view in the editbox.
3. Click OK.

The current view is saved.

NOTE
TheSave View item of the context menu for the survey view has the same functionality.

Named View icon
The Named Views icon of the Navigate group allows you to manage the saved views.

The Named Views dialog appears after clicking. It contains the list of the saved views. Buttons of the dialog
described in the table below. You may sort the list of the views by selecting the appropriate radiobutton:

l Name — to sort views by their names.
l Last Used— to sort views by their usage.
l Both— to display two lists, separated by dotted line — sorted by name and by usage.
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Buttons of the Named View dialog
Button Description

Set Current Click it to display the selected view.

Delete Click it to delete the selected view.

Details Click it to display detailed information about the selected view.

Print Click it to generate report with the views information.

OK Click it to close the dialog.

NOTE
TheSaved Views item of the context menu for the survey view contains the list of the saved views and
Named Views item, which opens theNamed Views dialog.
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Features group
The Features group from the View tab of the MAGNET Office ribbon allows you to use the additional features of
the view. It contains four icons, described in the table below.

3D View icon
Click it to open the current project in the 3D viewer.

Tables icon
Click it to manage existing tables.

B/G Images icon
Click it to manage background images.

Google Earth/Map icon
Click it to view the current project in Google Earth or Google Maps.

3D View icon
The 3D View icon of the Features group allows you to view your project in three dimensions.

To view project in 3D:
1. In the Features group of the View tab, click the 3D View icon.

The 3D View dialog is displayed.
2. In the Select From group box, select one of the following:

l All Data – to display all existing data.
l Active Layers – to display only entities, which belong to the active layers.
l All Data – to display only selected entities.

3. In the Driver Offset group box, specify the amount and direction of the offset form the required alignment,
for virtual "driving", by using the Offset editbox, and Left and Right radiobuttons.

4. In the Driver Offset group box, specify the speed of virtual "driving", by using the Alignment Spacing edit-
box.

5. Select surfaces to export into 3D view from the list.
6. Tick the Transfer Linework checkbox, to define whether to export lines or not.
7. Tick the Drape Lines checkbox, to define whether to drape all selected lines onto the selected surface or

not.
8. Tick the Transfer Points checkbox, to define whether to transfer points into the 3D view or not.
9. Click OK.

The selected data is displayed in the 3DView in the new window.

Tables icon
The Tables icon of the Features group allows you to manage exiting tables in the project.

The Status dialog appears after clicking. It contains the list of the exiting tables and information about their on/off
status.

To turn on/off displaying of a table, tick/untick in the appropriate row of the table.
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Click Switch All On to turn on displayed of all existing tables.

Click Switch All Off to turn off displayed of all existing tables.

B/G Images icon
The B/G Images of the Features group allows you to manage background images in the project.

The Background Images dialog appears after clicking. For more information refer to "Background Images dialog"
section on page 620.

NOTE
This icon has the same functionality as the Recalibrate icon of the Raster/Vector group at theModel tab.

Google Earth/Map icon
The Google Earth/Map icon of the Features group allows you to view objects from your project on the Google
Map, or in the Google Earth application.

NOTE
A coordinate system projectionmust be defined to use this feature. For more information about coordin-
ate system projection, refer to "Project coordinate system" section on page 586.

To view the project data on the Google Map or in the Google Earth:
1. In the Features group of the View tab, click the Google Earth/Map icon.

The Google Earth/Map dialog is displayed.
2. In the Select From group box, select one of the following radiobuttons:

l All— to display all existing entities.
l Selection— to display currently selected entities.
l Active — to display entities, which belong to the active layers.

3. Select objects types to be displayed.
4. Select DTMs to be displayed.
5. In the Output group box, select one of the following:

l Google Earth— to display data in the Google Earth application.
l Export to KML— to export data to a Google Map (*.kml) file.

6. Click OK.
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Options group
The Options group from the View tab of the MAGNET Office ribbon, allows you to configure the view options. It
contains five icons, described in the table below.

Toolbar icon
Click it to configure toolbar.

Status Bar icon
Click it to switch on/off the status bar.

Ruler icon
Click it to switch on/off the ruler.

Grid icon
Click it to switch on/off the grid lines.

Scale Bar icon
Click it to turn on/off displaying of the scale bar in the survey view.

Toolbar icon
The Toolbar icon of the Options group allows you to configure the MAGNET Office toolbar. Toolbar buttons
duplicate functions of the ribbon icons, to provide a quicker access to these functions, without switching ribbon
tabs. MAGNET Office toolbar is user configurable. You may add or remove toolbars, move them and configure
buttons on them.

To configure toolbars:
1. In the Options group of the View tab, click the Toolbar icon.

The Configure Toolbars dialog is displayed. The buttons of the dialog is described in the table below.
2. Select required toolbars for displaying.
3. Click OK.
4. If needed, move the toolbars, by dragging them with the mouse.

Buttons of the Configure Toolbars dialog
Button Description

New Click it to create a new toolbar.

Customize
Click it to customize the selected toolbar. For more information refer to "Cus-
tomizing toolbars" section on the facing page. The Properties and Text toolbars
cannot be customized.

Delete Click it to delete the selected toolbar from the list. The Properties and Text
toolbars cannot be deleted.

Save Layout Click it to save the current toolbar settings in an initialization (*.ini) file.

Restore Layout Click it to load previously saved toolbar settings from an initialization (*.ini)
file.

Restore Default Click it to restore the default toolbar settings.

Import Click it to import the current toolbar settings in an initialization (*.ini) file.
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Button Description

Export Click it to export toolbar settings from an initialization (*.ini) file.

Close Click it to close the dialog.

TIP
To quickly open theConfigure Toolbars dialog, do the right click at any toolbar.

Customizing toolbars
The Customize toolbar dialog allows you to add new or remove buttons from the toolbar, insert separators and
change button position in the toolbar.

To add a button to the toolbar:
1. In the Options group of the View tab, click the Toolbar icon.

The Configure Toolbars dialog is displayed.
2. Select the required toolbar and click Customize.

The Customize toolbar dialog is displayed.
3. From the Category drop-down list, select the required button category.
4. In the Available toolbar buttons list, select the required button.
5. Click >>.

The button is added to the bottom position.

To remove a button, select it and click <<.

Buttons of the Customize Toolbar dialog
Button Description

>> Click it to add the selected button to the toolbar.

<< Click it to remove the selected button or separator from the toolbar.

Move Up Click it to move the selected button or separator to the left on the toolbar.

Move Down Click it to move the selected button or separator to the right on the toolbar.

Sep After Click it to insert a separator to the right from the selected button or separator.

Restore Click it to restore the default settings.

Close Click it to close the dialog.

Ruler icon
Click the Ruler icon of the Options group to turn on/off displaying of the ruler on the screen.

Status Bar icon
The Status Bar icon of the Options group allows you to turn on/off status bar on the bottom of MAGNET Office
window.

The status bar
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1 The SiteLINK 3D Inbox icon.

2 The SiteLINK 3D Chat icon.

3 The SiteLINK 3D Connect icon.

4 The DTM Settings icon.

5 The Display icon

6 Displays the current pointer coordinates and quantity of selected objects.

7 Displays the units, used in the project.

8 Displays whether the caps lock activated.

9 Displays whether the num lock activated.

10 Displays whether the scroll lock activated.

Grid icon
Click the Grid icon of the Options group to turn on/off displaying of the grid.

The grid may be configured on the Grid/Snap tab of the Display Settings dialog. For more information, refer to
"Grid/Snap displaying settings" section on page 601.

Scale Bar icon
Click the Scale Bar icon of the Options group to turn on/off displaying of the scale bar in the top right corner of
the survey view.

Scale bar
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Display group
The Display group from the View tab of the MAGNET Office ribbon allows you to configure point's annotation in
the survey view. It contains three icons, described in the table below.

Point Number icon
Click it to switch on/off displaying of the point numbers.

Point Height icon
Click it to switch on/off displaying of the point heights.

Point Code icon
Click it to switch on/off displaying of the point codes.

Point Notes icon
Click it to switch on/off displaying of the point notes.

Point Number icon
Click the Point Number icon of the Display group to turn on/off displaying of the point numbers in the survey
view.

Point Height icon
Click the Point Height icon of the Display group to turn on/off displaying of the point elevations in the survey
view.

Point Code icon
Click the Point Code icon of the Display group to turn on/off displaying of the point codes in the survey view.

Point Notes icon
Click the Point Notes icon of the Display group to turn on/off displaying of the point notes in the survey view.
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Settings Tab
The Settings tab of the MAGNET Office ribbon contains control icons for editing various project and
MAGNET Office settings. It is separated to five groups, described in the corresponding sections:

l "Settings group" section on the facing page
l "Customization group" section on page 127
l "Create Modes group" section on page 129
l "Defaults group" section on page 131
l "Snap Modes group" section on page 132
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Settings group
The Settings group from the Settings tab of the MAGNET Office ribbon allows you to configure various settings.
It contains nine icons, described in the table below.

Project Settings icon
Click it to edit the project settings.

Program Settings icon
Click to edit the MAGNET Office settings.

Display icon
Click it to edit the display general settings.

Grid/Snap icon
Click it to edit the grid settings.

Default Properties icon
Click it to edit display default settings.

Text Styles icon
Click it to manage the text styles.

Justification icon
Click it to edit the number justification settings.

Annotation icon
Click it to edit the automatic annotation settings.

Contour icon
Click it to edit the contour settings.

Project Settings icon
The Project Settings icon of the Settings group allows you to configure the settings of the current project. Note
that these settings will apply only to the current project. Default program settings will not change. You may con-
figure them by using the Program Settings icon.

The Project Settings dialog appears after clicking. For more information, refer to "Project Settings dialog" section
on page 580.

Program Settings icon
The Program Settings icon of the Settings group allows you to configure the MAGNET Office settings. Note that
these settings are global and will apply to all new projects. You may change these settings for a particular project
by using the Project Settings icon.

The Program Settings dialog appears after clicking. For more information, refer to "Program Settings dialog" sec-
tion on page 589.
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Display icon
The Display icon of the Settings group allows you to configure general display settings. Its shortcut key is
Ctrl+G. You may also use the hot key at the bottom panel.

The Display tab of the Display Settings dialog appears after clicking. For more information refer to "General dis-
play settings" section on page 598

Grid/Snap icon
The Grind/Snap icon of the Settings group allows you to configure grid settings and snap modes.

The Grind/Snap tab of the Display Settings dialog appears after clicking. For more information refer to
"Grid/Snap displaying settings" section on page 601

Default Properties icon
The Default Properties icon of the Settings group allows you to configure defaults of the display settings.

The Default Properties tab of the Display Settings dialog appears after clicking. For more information refer to
"Defaults of the display settings" section on page 599

Text Styles icon
The Text Styles icon of the Settings group allows you to manage text styles. Text styles define layout of all tex-
tual data in the MAGNET Office — point numbers, entities annotations, etc.

The TEXT STYLE dialog appears after clicking. It contains the list of the existing text styles and font, size, color
and formatting for each style. Buttons of the dialog are described in the table below.

Buttons of the Text Style dialog
Button Description

New Click it to create a new text style. For more information refer to "Creating text
styles" section on the facing page.

Modify Click it to edit an existing text style. For more information refer to "Editing text
styles" section on the facing page.

Rename
Click it to rename an existing text style.

NOTE
The $$DEFAULT text style cannot be renamed.

Delete
Click it to delete an existing text style.

NOTE
The $$DEFAULT text style cannot be deleted.

Copy From Lib Click it to load a text style from the library. For more information refer to
"Text styles library" section on page 631.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Creating text styles
To create a new text style:

1. In the Settings group of the Settings tab, click the Text Styles icon.

The Text Style dialog is displayed.
2. Click New.

The Text Style dialog is displayed.
3. In the Name editbox, type the name of the new text style.
4. From the Font drop-down list, select the font.
5. From the Size drop-down list, select the font size, or type your own value.
6. From the Color drop-down list, select the font color, or create a custom color for font. For more inform-

ation, refer to "Custom Colors icon" section on page 127.
7. In the Style group box define the bold, italic and underscore formatting.
8. Review your font style in the Preview field. If needed, change the font parameters.
9. Click OK.

The text style is created.

NOTE
The newly created style exists only in the current project. It is not added to the Text styles library.

Editing text styles
To edit an existing text style:

1. In the Settings group of the Settings tab, click the Text Styles icon.

The Text Style dialog is displayed.
2. Select text style to be edited.
3. ClickModify.

The Text Style dialog is displayed.
NOTE
You cannot change the name of the text style in this dialog. To rename a text style, use theRename but-
ton of themain dialog.

4. From the Font drop-down list, select the font.
5. From the Size drop-down list, select the font size, or type your own value.
6. From the Color drop-down list, select the font color, or create a custom color for font. For more inform-

ation, refer to "Custom Colors icon" section on page 127.
7. In the Style group box define the bold, italic and underscore formatting.
8. Review your font style in the Preview field. If needed, change the font parameters.
9. Click OK.

The parameters of the text style are changed.

NOTE
These changeswill apply only to text styles in the current project, and don't affect to the styles in the
Text styles library.

Justification icon
The Justification icon of the Settings group allows you to manage the number justification styles.
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Justification style defines the format of the number and its decimal precision. It controls the appearance of the
numerical values used in such text items as height annotation, grid values, chainage, and levels in road drawings.

The Number Justification Style dialog appears after clicking. Buttons of the dialog are described in the table
below.

Buttons of the Number Justification Style dialog
Button Description

New Click it to create a new justification style. For more information refer to "Creat-
ing justification styles" section below.

Modify Click it to edit an existing justification style. For more information refer to
"Editing justification styles" section on the facing page.

Rename
Click it to rename an existing justification style.

NOTE
The $$DEFAULT justification style cannot be renamed.

Delete
Click it to delete an existing justification style.

NOTE
The $$DEFAULT justification style cannot be deleted.

Copy From Lib Click it to load a justification style from the library. For more information refer
to "Justification styles library" section on page 632.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Creating justification styles
To create a new justification style:

1. In the Settings group of the Settings tab, click the Justification icon.

The Number Justification Style dialog is displayed.
2. Click New.

The Number Style dialog is displayed.
3. In the Name editbox, type the name of the new justification style.
4. In the Width editbox, type the number of digits, used in the style. Note, that it includes the characters used

for the decimal point and decimal figures
5. In the Precision editbox, type the number of decimal places.
6. Select either left of right justified position.
7. Configure the following parameters:

l Zero Padding— tick it to fill the empty character spaces with zeroes.
l Space Fill— tick it to make a number right-justified with prefixed spaces to make up the number of
characters in the width.

l Display Decimal— tick it to display the decimal point.
l Rounding— tick it to round a number to the precision setting.
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8. Click OK.

The new justification style is created.

NOTE
The newly created style exists only in the current project. It is not added to the Justification styles library.

Editing justification styles
To edit an existing justification style:

1. In the Settings group of the Settings tab, click the Justification icon.

The Number Justification Style dialog is displayed.
2. Select justification style to be edited.
3. ClickModify.

The Number Style dialog is displayed.
NOTE
You cannot change the name of the justification style in this dialog. To rename a justification style, use the
Rename button of theNumber Justification Style dialog.

4. In the Width editbox, type the number of digits, used in the style. Note that it includes the characters used
for the decimal point and decimal figures

5. In the Precision editbox, type the number of decimal places.
6. Select either left of right justified position.
7. Configure the following parameters:

l Zero Padding – tick it to fill the empty character spaces with zeroes.
l Space Fill – tick it to make a number right-justified with prefixed spaces to make up the number of
characters in the width.

l Display Decimal – tick it to display the decimal point.
l Rounding – tick it to round a number to the precision setting.

8. Click OK.

The parameters of the justification style are changed.

NOTE
These changeswill apply only to justification styles in the current project, and don't affect to the styles in
the Justification styles library.

Annotation icon
Many entities in MAGNET Office have attributes, which can be annotated for displaying on the screen, or for plot-
ting on a printed plan. Several of annotation styles are available to set appropriate annotation formats to suit inter-
national and national schemes. To display the annotation for the entities, the individual entity must have its
annotation option turned on. The current annotation setting for the entity is applied when its annotation option is
turned on.

The Annotation icon of the Settings group allows you to manage annotation styles.

The Annotation Styles dialog appears after clicking. For more information refer to "Annotation Styles dialog" sec-
tion on page 604.

NOTE
These annotation settingswill be applied to the current project only. Settings from the annotation styles
library will not change. For more information about annotation styles library, refer to "Annotation styles
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library" section on page 635.

Contour icon
The Contour icon of the Settings group allows you to configure contour settings.

The Contour Settings dialog appears after clicking. For more information refer to "Contour Settings dialog" sec-
tion on page 617.

NOTE
These contour settingswill be applied to the current project only. Settings from the contour settings lib-
rary will not change. For more information about contour settings library, refer to Contour settings lib-
rary.
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Customization group
The Customization group from the Settings tab of the MAGNET Office ribbon allows you to configure colors,
shortcut keys and command aliases. It contains three icons, described in the table below.

Custom Colors icon
Click it to create custom colors.

Shortcut Keys icon
Click it to assign MAGNET Office hot keys.

Command Aliases icon
Click it to edit command aliases.

Custom Colors icon
The Custom Colors icon of the Customization group allows you to manage the MAGNET Office color palette.

To create a new color:
1. In the Customization group of the Settings tab, click the Custom Colors icon.

The Create Custom Colors dialog is displayed.
2. In the Custom Colors palette select a cell for the new color.
3. Do one of the following:

l Configure the new color by using the color palette and shade bar.
l Manually enter the required data in the Hue, Sat, Lum, Red, Green and Blue editboxes.

4. Click Add to Custom Colors.

The configured color is added to the selected cell.
5. Click OK.

To save the current palette to the library, click Save to Lib.

To load previously saved configuration, click Load from Lib.

Shortcut Keys icon
The Shortcut Keys icon of the Customization group allows you to configure the shortcut keys for the
MAGNET Office.

The Shortcut Keys dialog appears after clicking. Buttons are described in the table below.

Buttons of the Shortcut Keys dialog
Button Description

Define Click it to define a command for the selected key.

Delete Click it to delete the command from the selected key.

Reset Click it to restore the default command for the selected key.

Save Layout Click it to save the current shortcut keys configuration in an initialization
(*.ini) file.

Restore Layout Click it to load previously saved configuration from an initialization (*.ini) file.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Defining shortcut keys
To define a shortcut key:

1. In the Customization group of the Settings tab, click the Shortcut Keys icon.

The Shortcut Keys dialog is displayed.
2. Select the required key and Click Define.

The Shortcut Key dialog is displayed. Commands in the list are presented by their aliases. For more
information refer to "Command Aliases icon" section below.

3. Select the required command from the Command drop-down list and click OK.

The command is displayed near the key name.
4. Click OK.

Command Aliases icon
The Command Aliases icon of the Customization group allows you to manage the aliases of the
MAGNET Office commands. An alias is the command nickname which is used, for example, when defining
shortcut keys.

To define a command alias:
1. In the Customization group of the Settings tab, click the Command Aliases icon.

The Command Aliases dialog is displayed.
2. From the Module drop-down list, select the required module.
3. Select the required command and click Define.

The Edit dialog is displayed.
4. Type the command alias in the editbox and click OK.
5. If needed, click Save to save the current configuration as the default one.
6. Click OK.
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Create Modes group
The position of a point is defined by its coordinates. The defaults for the MAGNET Office are North and East
coordinates from the original, defined by the coordinate system projection. Besides, there are two more ways to
define the position of a point – the Sideshot mode, when point position defined by the distance and bearing from
the reference point, and the Latitude/Longitude mode, when point position is defined by the geographic latitude
and longitude coordinates. However, regardless of the point creation mode, MAGNET Office will use the North
and East coordinates for further work with points and other entities. Scaling will be performed automatically.

These creating modes may be automatically set by several commands. For example, Add Line icon automatically
switches to the sideshot point creation mode, assuming that the end point will be created by a bearing and distance
from the start point.

The Create Modes group from the Settings tab of the MAGNET Office ribbon allows you to select point creation
mode. It contains four icons, described in the table below.

Coordinate icon
Click it to activate the "Coordinate" point creation mode.

Latitude Longitude icon
Click it to activate the "Latitude/Longitude" point creation mode.

Direction icon
Click it to activate "Sideshot" point creation mode.

Create Points icon
Click it to turn on/off creating points in entities.

NOTE
The "Coordinate", "Latitude/Longitude" and "Sideshot" modes aremutually exclusive. When onemode
is active, other is disabled.

Coordinate icon
The Coordinate icon of the Create Modes group allows you to use the "Coordinate" point creation mode.

In this mode the grid coordinates are used. Point position is defined by the East (or X) and North (or Y) distance
from the origin. The origin is defined by the coordinate system projection and datum. Each point is located inde-
pendently of the rest points.

When creating points in this mode, you may specify the Northing and Easting coordinates in the appropriate edit-
boxes at the bottom toolbar, or click the required place in the survey view.

When moving point to a new position a pop-up box displays the North and East offsets.

Latitude Longitude icon
The Latitude Longitude icon of the Create Modes group allows you to use the "Latitude/Longitude" point cre-
ation mode.
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In this mode the geographic latitude and longitude coordinates are used. Point position is defined by the latitude
and longitude. The geographical coordinate system is defined by coordinate system projection and datum. Each
point is located independently of the rest points.

When creating points in this mode, you may specify the Latitude and Longitude coordinates in the appropriate edit-
boxes at the bottom toolbar, or click the required place in the survey view.

Calculation from the geographic to the grid coordinates will be performed automatically. MAGNET Office will
use the grid coordinates for further work with the point.

CAUTION
A coordinate system projection must be defined to use this mode.

Direction icon
The Direction icon of the Create Modes group allows you to use the "Sideshot" point creation mode.

In this mode polar coordinates are used. Point position is defined by bearing and distance from the reference
point.

When creating points in this mode, you may specify the bearing and distance from the reference point in the
appropriate editboxes at the bottom toolbar, or click the required place in the survey view.

Calculation from the polar to the grid coordinates will be performed automatically. MAGNET Office will use the
grid coordinates for further work with the point.

Create Points icon
The Create Points icon of the Create Modes group allows you to turn on/off "Create Points" mode of creating
lines, arcs, circles and polygons.

When this mode is turned on, the entities are created as usual, i.e. points are created at each node of line, arc,
polygon and circle center.

When this mode is turned off, all lines, arcs, circles and polygons are created without creating any points.

NOTES
String always created with points at nodes, regardless to thismode.

Youmay use the polyline to create a line without creating points.

130



Defaults group

Defaults group
The Defaults group from the Settings tab of the MAGNET Office ribbon allows you to configure some of point
and line creation settings. It contains three icons, described in the table below.

Elevation icon
Click it to create points with elevation.

Use in Surface icon
Click it to make next created point a Use in Surface point.

Breakline icon
Click it to make next created line to be a breakline.

Elevation icon
The Elevation icon of the Defaults group allows you to turn on/off creating point with the elevation turned on by
default.

When this mode is turned off, new points will be created with the inactive elevation. However, you may tick Elev-
ation checkbox to activate elevation while creating a point, or do it later in the Point properties dialog.

When this mode is turned on, new points will be created with the active elevation. You may specify the value in
the Elevation editbox while creating a point, or do it later in the Point properties dialog.

Use in Surface icon
The Use in Surface icon of the Defaults group allows you to turn on/off creating points set as Use in Surface by
default.

When this mode is turned off, new points will be created as usual. However, you may tick Use in
Surface checkbox while creating a point to make it possible to use this point in surfaces, or do it later in the Point
properties dialog.

When this mode is turned on, new points will be created as Use in Surface points.

Breakline icon
The Breakline icon of the Defaults group allows you to turn on/off creating lines set as the breaklines by default.

When this mode is turned off, new lines will be created as usual. However, you may tick Break Line checkbox
while creating a line to make it a breakline, or do it later in the Line properties dialog.

When this mode is turned on, new lines will be created as the breaklines.
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Snap Modes group
When creating entities in the survey view, they supposed to be on their right places. For example, you might need
to place the end point of a line exactly to the start point of another line. It might be easy to do at the small scale,
but at large scales it is easy to miss the required point, and place your entity near it. Snap modes are created to
help you to place points exactly to the required locations.

The Snap Modes group from the Settings tab of the MAGNET Office ribbon gives you quick access to the snap
modes. It contains nine icons, described in the table below.

Pt icon
Click it to turn on/off the "Point" snap mode.

EndPt icon
Click it to turn on/off the "End Point" snap mode.

IntPt icon
Click it to turn on/off the"Intersection Point" snap mode.

MidPt icon
Click it to turn on/off the "Middle Point" snap mode.

ArcCen icon
Click it to turn on/off the "Arc Center" snap mode.

Line icon
Click it to turn on/off the "Line" snap mode.

Perpern icon
Click it to turn on/off the "Perpendicular" snap mode.

GridPt icon
Click it to turn on/off the "Grid" snap mode.

PtElev icon
Click it to turn on/off the "3D" snap mode.

NOTE
Snapmodes aremutually exclusive— when onemode is selected; others are disabled, except for the
"Point" and "3D"modes, which can be combined with any other snapmode.

Pt icon
The Pt icon of the Snap Modes group allows you to turn on/off the nearest point snap mode.

The tolerance area is located around a point, and will be treated as the point itself. It means the following:
l If you try to create a new point within the snap tolerance of the existing one, MAGNET Office will treat it
like the duplicate point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line,
within the snap tolerance of the existing point, MAGNET Office will automatically use this point instead.

l If you click within the snap tolerance of a point, it will be selected. If the wrong entity is selected, do the
right-click, and select Next Selection in the shortcut menu.
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EndPt icon
The EndPt icon of the Snap Modes group allows you to turn on/off the end point snap mode.

The tolerance area is located around the start and end points of lines, arcs and strings. It means the following:
l If you try to create a new point within the snap tolerance of the existing start or end point of a line, an arc
or a string, MAGNET Office will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line within
the snap tolerance of the existing start or end point of a line, an arc, MAGNET Office will automatically
use this point of a line, an arc or a string instead.

l If you click within the snap tolerance of an start or end point of a line, an arc or a string, it will be selected.
If the wrong entity is selected, do the right-click, and select Next Selection in the shortcut menu.

IntPt icon
The IntPt icon of the Snap Modes group allows you to turn on/off the intersect snap mode. The tolerance area is
located around the intersection points of two crossing entities. It means the following:

l If you try to create a new point within the snap tolerance of the existing intersection point,
MAGNET Office will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line within
the snap tolerance of the existing intersection point, MAGNET Office will automatically use this inter-
section point instead.

l If you click within the snap tolerance of an intersection point, it will be selected. If the wrong entity is
selected, do the right-click, and select Next Selection in the shortcut menu.

MidPt icon
The MidPt icon of the Snap Modes group allows you to turn on/off the middle point snap mode. The tolerance
area is located around the middle points of lines, arc or strings. It means the following:

l If you try to create a new point within the snap tolerance of the existing middle point of a line, an arc or a
string, MAGNET Office will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line within
the snap tolerance of the existing middle point of a line, an arc or a string, MAGNET Office will auto-
matically use this middle point instead.

l If you click within the snap tolerance of a middle point of a line, an arc or a string, it will be selected. If the
wrong entity is selected, do the right-click, and select Next Selection in the shortcut menu.

ArcCen icon
The ArcCen icon of the Snap Modes group allows you to turn on/off the arc center snap mode. The tolerance area
is located around the arc center points. It means the following:

l If you try to create a new point within the snap tolerance of the existing arc center point, MAGNET Office
will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line within
the snap tolerance of the existing arc center point, MAGNET Office will automatically use this arc center
point instead.

l If you click within the snap tolerance of an arc center point, it will be selected. If the wrong entity is selec-
ted, do the right-click, and select Next Selection in the shortcut menu.
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Line icon
The Line icon of the Snap Modes group allows you to turn on/off the line snap mode. The tolerance area is loc-
ated near the lines. It means the following:

l If you try to create a new point within the snap tolerance of the existing line or string, MAGNET Office
will place this point on the line, or include in into the string.

l If you try to create the end point of a line, an arc of a string, within the snap tolerance of the existing line
or string, MAGNET Office will automatically this point on the line or the string.

Perpern icon
The Perpen icon of the Snap Modes group allows you to turn on/off the perpendicular snap mode. It means that if
you try to locate the end point of a line within the snap tolerance of the existing line of string, the new line will be
created as perpendicular to this line or string.

GridPt icon
The GridPt icon of the Snap Modes group allows you to turn on/off the grid point snap mode. The tolerance area
is located near the grin lines intersections. It means the following:

l If you try to create a new point within the snap tolerance, it will be located exactly at the grid intersection
point.

l If you try to create a point, which is the part of entity, for example the start or the end point of a line with-
ing the snap tolerance, MAGNET Office will place exactly at the grid intersection point.

PtElev icon
The PtElev icon of the Snap Modes group allows you to turn on/off the 3D snap mode. If you try to create a new
point, located on an object its elevation will be calculated, basing on the slope of the line/sting segment/etc.
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Insert Tab
The Insert tab of the MAGNET Office ribbon contains control icons for adding various entities to the project. It is
separated to nine groups, described in corresponding sections:

l "Points group" section on the next page
l "Line group" section on page 148
l "Arc group" section on page 160
l "Circle group" section on page 176
l "Text group" section on page 179
l "Polyline/Polygon group" section on page 198
l "String group" section on page 202
l "Feature group" section on page 206
l "Arrow group" section on page 220
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Points group
A point is the main entity of the MAGNET Office. It is a two- or three-dimensional in space, on which all other
entities are derived. A point represent a unique position in space, defined by its coordinates — Northing and East-
ing (or X and Y respectively). A point also may have an elevation. Besides, a point may be defined by its geo-
graphical latitude and longitude coordinates. Each point has a unique alphanumeric ID (it is usually a number) to
identify it in the project database.

The Points group from the Insert tab of the MAGNET Office ribbon allows you to add new points to the survey
view. It contains four icons and four second level icons, described in the table below.

Add Point icon
Click it to add a new point to the survey view. This icon also contains

the list of the second level icons. Click to see it.

Latitude/Longitude icon
Click it to add a new point to the survey view by using the Lat-

itude/Longitude method.
Offset/Distance icon

Click it to add a new point to the survey view by using the Off-
set/Distance method.
Offset/Angle icon

Click it to add a new point to the survey view by using the Offset/Angle
method.

Brg/Dist Intersection icon
Click it to add a new point to the survey view by using the Bear-

ing/Distance Intersection method
Multiple Intersection icon

Click it to add points at intersections of existing objects.
Sideshot icon

Click it to add new points by using the Sideshot method.
Intersection icon

Click it to add a new point to the survey view by using the Intersection
method.

Spreadsheet Entry icon
Click it to manually add new points to the survey view.

Add Point icon
The Add Point icon of the Points group allows you to add a new point to the survey view by using the current cre-
ation mode. For more information about creation modes, refer to "Create Modes group" section on page 129.

To create a point:
1. In the Points group of the Insert tab, click the Add Point icon.

The input panel is displayed at the bottom toolbar.
2. If needed, configure parameters at the bottom toolbar. Fields are described in the table below.
3. Locate the point position. Do one of the following:
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l Fill in appropriate fields at the input panel and press Enter.
l Click the point position in the survey view.

4. If needed, repeat steps 2 and 3 to create more points.
5. When finished, press Esc.

Fields of the input panel, when creating points
Field Description

Number Defines the number of the next new point.

East

Defines the East (X) coordinate of the next new point.
NOTE
This field available only in "Coordinate" point creationmode. For more inform-
ation, refer to "Coordinate icon" section on page 129.

North

Defines the North (Y) coordinate of the next new point.
NOTE
This field available only in "Coordinate" point creationmode. For more inform-
ation, refer to "Coordinate icon" section on page 129.

Elev Defines the elevation of the next new point.

Latitude

Defines the latitude coordinate of the next new point.
NOTE
This field available only in "Latitude/Longitude" point creationmode. For
more information, refer to "Latitude Longitude icon" section on page 129.

Longitude

Defines the longitude coordinate of the next new point.
NOTE
This field available only in "Latitude/Longitude" point creationmode. For
more information, refer to "Latitude Longitude icon" section on page 129.

Bearing

Defines the bearing of the next new point from the reference point.
NOTE
This field available only in "Sideshot" point creationmode. For more inform-
ation, refer to "Direction icon" section on page 130.

Distance

Defines the distance from the reference point to the next new point.
NOTE
This field available only in "Sideshot" point creationmode. For more inform-
ation, refer to "Direction icon" section on page 130.

Code Defines the code of the next new point.

Use in Surface Defines whither the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the next new point will be interpolated.

Latitude/Longitude icon
The Latitude/Longitude icon of the Points group allows you to add a new point to the survey view by using the
"Latitude/Longitude" creation mode. For more information about creation modes, refer to "Create Modes group"
section on page 129.

To add a new point by using the latitude and longitude coordinates:
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1. In the Points group of the Insert tab, click the Latitude/Longitude icon.

The input panel is displayed at the bottom toolbar.
2. If needed, configure parameters at the bottom panel. Fields are described in the table below.
3. Locate the point position. Do one of the following:

l Fill in the Latitude and Longitude editboxes at the input panel and press Enter.
l Click the point position in the survey view.

4. If needed, repeat steps 2 and 3 to create more points.
5. When finished, press Esc.

Fields of the input panel, when creating points in the "Latitude/Longitude" mode
Field Description

Number Defines the number of the next new point.

Elev Defines the elevation of the next new point.

Latitude Defines the latitude coordinate of the next new point.

Longitude Defines the longitude coordinate of the next new point.

Code Defines the code of the next new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the next new point will be interpolated.

Offset/Distance icon
The Offset/Distance icon of the Points group allows you to add a new point to the survey view at a distance
along a reference line, arc, string or alignment or/and at a perpendicular offset from a reference line, arc, string
or alignment. See picture below for details.

To add a new point by using the offset/distance method:
1. In the Points group of the Insert tab, click the Offset/Distance icon.

The input panel is displayed at the bottom toolbar.
2. If needed, configure parameters at the bottom panel. Fields are described in the table below
3. Select the reference point, line, arc, string or alignment.

NOTE
If you select a point as the reference entity, MAGNET Office prompts you to select a second point to
define the reference line between them.

4. Locate the point position. Do one of the following:
l Fill in the Offset and Distance fields at the input panel and press Enter.
l Click the point position in the survey view.

5. If needed, repeat steps 2 and 3 to create more points.
6. When finished, press Esc.
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Fields of the input panel, when creating points in the "Offset/Distance" mode
Field Description

Number Defines the number of the next new point.

Offset Defines the offset from the reference entity. See picture below for details.

Dist Defines the distance at the reference entity. See picture below for details.

Length Display the length of the reference entity.

Elev Defines the elevation of the next new point.

Code Defines the code of the next new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Write Offset If ticked, the new point will be annotated with dimension from the reference
entity.

Distance along the reference line and offset from the reference line

Offset/Angle icon
The Offset/Angle icon of the Points group allows you to add a new point to the survey view as a radiation from a
start point. The angle of a radiation is measured from the reference line clockwise, distance is measured from the
start point.

To add a new point by using the offset/angle method:
1. In the Points group of the Insert tab, click the Offset/Angle icon.

The input panel is displayed at the bottom toolbar.
2. If needed, configure parameters at the bottom panel. Fields are described in the table below
3. Select the reference point, line, arc, string or alignment.

NOTE
If you select a point as the reference entity, MAGNET Office prompts you to select a second point to
define the reference line between them.

4. Locate the point position. Do one of the following:
l Fill in the Angle and Dist fields at the input panel and press Enter.
l Click the point position in the survey view.
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5. If needed, repeat step 4 to create more points.
6. When finished, press Esc.

Fields of the input panel, when creating points in the "Offset/Distance" mode
Field Description

Number Defines the number of the next new point.

Angle Defines the angle from the reference entity. See picture below for details.

Dist Defines the offset from the start point. See picture below for details.

Elev Defines the elevation of the next new point.

Code Defines the code of the next new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Angle from the reference line and offset the start point

Brg/Dist Intersection icon
The Brg/Dist Intersection icon of the Points group allows you to add a new point to the survey view at the spe-
cified bearings and distances from two existing points.

To add a new point by using the offset/angle method:
1. In the Points group of the Insert tab, click the Brg/Dist Intersection icon.
2. Select the first point.

The input panel is displayed at the bottom toolbar.
3. Define the first reference line. Do one of the following:
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l Type the bearing and distance in the appropriate checkboxes at bottom toolbar and press Enter.
l Click the required position in the survey view.

The input panel is displayed at the bottom toolbar.
4. Specify the offset of the reference line from the point and press Enter.
5. Repeat steps from 2 to 4 to define second point and reference line.

The new point is located at the intersection of two reference lines.
6. Review the parameters of the new point at the bottom toolbar, and press Enter to confirm it.

The point is created.

Fields of the input panel, when creating points in the "Bearing/Distance Intersection" mode
Field Description

Bearing Defines bearing of the reference line.

Distance Defines distance from the existing point.

Offset Defines offset of the reference line from the existing point.

Number Defines the number of the next new point.

East Displays the East (X) coordinate of the new point.

North Displays the North (Y) coordinate of the new point.

Elev Defines the elevation of the next new point.

Code Defines the code of the next new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the next new point will be interpolated.
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Angle from the reference line and offset the start point

Multiple Intersection icon
The Multiple Intersection icon of the Points group allows you to add a new point or points at the intersection of
lines, arcs and circles. Newly created points will not be a part of existing entities. You may pre-select objects, or
select them while running the option.

To create a point, with pre-selecting objects:
1. In the survey view, select the required objects.
2. In the Points group of the Insert tab, click the Multiple Intersection icon.
3. If needed, at the bottom toolbar tick the Interpolate Elevation checkbox to calculate heights of the new

points.
4. Press Enter.

The points are created.

To create a point, without pre-selection:
1. In the Points group of the Insert tab, click the Multiple Intersection icon.
2. If needed, at the bottom toolbar tick the Interpolate Elevation checkbox to calculate heights of the new

points.
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3. Continuously select the required objects.
4. Points are created at all intersections of the selected objects.

Sideshot icon
The Sideshot icon of the Points group allows you to add a new point to the survey view by using the "Sideshot"
creation mode. For more information about "Sideshot" creation mode, refer to "Direction icon" section on
page 130.

To create a point:
1. In the Points group of the Insert tab, click the Sideshot icon.

The input panel is displayed at the bottom toolbar.
2. Define a reference point. Select an existing point, or create a new one.
3. Locate the point position. Do one of the following:

l Fill in the Bearing and Distance fields at the input panel and press Enter.
l Click the point position in the survey view.

4. If needed, repeat step 3 to create more points.
5. When finished, press Esc.

Fields of the input panel, when creating points
Field Description

Number Defines the number of the next new point.

East
Defines the East (X) coordinate of a reference point.

NOTE
This field available only when creating a reference point.

North
Defines the North (Y) coordinate of a reference point.

NOTE
This field available only when creating a reference point

Bearing Defines the bearing of the next new point from the reference point.

Distance Defines the distance from the reference point to the next new point.

Elev Defines the elevation of the next new point.

Code Defines the code of the next new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the next new point will be interpolated.

Intersection icon
The Intersection icon of the Points group allows you to add a new point or points at the intersection of lines, arcs
and circles. The entity for intersection may have an offset from the reference entity. See pictures below for
details.
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Intersection of two arcs
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Intersection of two lines
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Intersection of line and arc

To create a point:
1. In the Points group of the Insert tab, click the Intersection icon.
2. Select the required point, line, arc or circle.

TIP

If you need to select a point, you may type its number in the From Point editbox at the bottom toolbar and press
Enter.

3. If you have selected a reference point, you need to select second point, or specify the bearing from the
first point to define the line. Do one of the following:

l Select the required point in the survey view.
l In the To Point editbox at the bottom panel type the number of the required and press Enter.
l Click the required position in the survey view.
l In the Bearing editbox at the bottom panel type the required bearing and press Enter.

4. In the Offset editbox at the bottom panel, type the required offset from the reference entity and press
Enter.

5. Repeat steps from 2 to 4 do select second reference entity.

The Intersection Point Height dialog is displayed.
6. If needed, in the Required Height editbox, define the elevation of the new point.
7. Click OK.
8. At the bottom toolbar, review the properties of the new point. Fields are described in the table below. Do

one of the following:
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l Press Enter to create a new point.
l Click Esc to discard creation of a new point.

9. If the intersection contains two new points, repeat steps form 6 to 8 for the second point.

Fields of the bottom toolbar, when reviewing a point
Field Description

Number Defines the number of the new point.

East Displays the East (X) coordinate of the new point.

North Defines the North (Y) coordinate of the new point.

Elev Defines the elevation of the new point.

Code Defines the code of the t new point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the new point will be interpolated.

Spreadsheet Entry icon
The Spreadsheet Entry icon of the Points group allows you to manually add new points to the survey view, by
using the point entry table.

The Point editor window appears after clicking. For more information, refer to "Point editor" section on page 510.
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Line group
A line is a connection between two points, and defined by a start point and an end point. The bearing and distance
of the line are defined by the start and end points positions. If both points have elevations, than the line will be a
3D line. A line may be defined as a breakline for using in a surface model.

The Line group from the Insert tab of the MAGNET Office ribbon allows you to add new lines to the survey
view. It contains four icons and eight second level icons, described in the table below.

Add Line icon
Click it to add a new line to the survey view. This icon also contains the

list of the second level icons. Click to see it.

Coordinates icon
Click it to add a line by defining the coordinates of its points.

Join Two Points icon
Click it to add a new line by joining two existing points.

Join Multiple Points icon
Click it to connect all existing point one by one.

Tangent icon
Click it to add a new line as the tangent to an existing arc or a circle.

External Tangent icon
Click it to add a new line as the tangent between two existing arc-

s/circles.
Splay Corner icon

Click it to add a new line as the splay corner between two existing
lines.

Fit Line icon
Click it to add a new line as the best fit to the suggested points.

Rectangle As Lines icon
Click it to add a new rectangle, consists of the four lines.

Join Points icon
Click it to add a new line by connecting existing points.

Parallel icon
Click it to add a new line as a parallel to an existing one.

Perpendicular icon
Click it to add a new line as a perpendicular to an existing one.

Add Line icon
The Add Line icon of the Line group allows you to add a new line to the survey view. In this mode the position
of the end point is defined as the bearing and distance from the start point.

To create a line:
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1. In the Line group of the Insert tab, click the Add Line icon.

The input panel for point creation is displayed at the bottom toolbar. Description of the fields may be found
in the table below.

2. Locate the start point of the line, by using the "Coordinate" or "Latitude/Longitude" method. For more
information about adding points refer to "Add Point icon" section on page 136.

NOTE
If a point was selected, when clicking the "Add Line" icon, it automatically become the start point of the
new line.

3. Locate the end point of the line, by using the "Sideshot" method. For more information refer to "Sideshot
icon" section on page 143.

The line is created.
4. If needed, create more lines. The end point of the last line will automatically set as the start point of the

next line.
5. When finished, press Esc.

Fields of the input panel, when creating lines
Field Description

Number Defines the number of the next new point.

East
Defines the East (X) coordinate of the line start point.

NOTE
This field available only when creating the start point.

North
Defines the North (Y) coordinate of the line start point.

NOTE
This field available only when creating the start point.

Elev Defines the elevation of the line point.

Bearing
Defines the bearing of the line.

NOTE
This field available only when creating the end point.

Distance
Defines the line length.

NOTE
This field available only when creating the end point.

Code Defines the code of the line start/end point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the line start/end point will be interpolated.

BreakLine Defines whether the new line will be a breakline.

Coordinates icon
The Coordinates icon of the Line group allows you to add a new line to the survey view by specifying coordinates
of its start and end points. In this mode the end point is defined by its East and North coordinates, independently
from the start point.
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To create a line, by using the coordinates method:
1. In the Line group of the Insert tab, click the Coordinates icon.

The input panel for point is displayed at the bottom toolbar. For more information about adding points refer
to "Add Point icon" section on page 136.

2. Locate the start point of the line, by using the "Coordinate" method.
NOTE
If a point was selected, when clicking the "Add line" icon, it automatically become the start point of the
new line.

3. Locate the end point of the line, by using the "Coordinates" method.

The line is created.
4. If needed, create more lines. The end point of the last line will automatically set as the start point of the

next line.
5. When finished, press Esc.

Join Two Points icon
The Join Two Points icon of the Line group allows you to add a new line to the survey view by joining two exist-
ing points in the survey view.

To create a line, by joining existing points:
1. In the Line group of the Insert tab, click the Join Two Points icon.

The input panel for point number is displayed at the bottom toolbar.
2. Define the start point of the line. Do one of the following:

l Click the required point in the survey view.
l Type the required point number in the Start Point editbox at the bottom toolbar and press Enter.
NOTE
If a point was selected, when clicking theAdd Line icon, it automatically become the start point of the
new line.

3. Define the end point of the line. Do one of the following:
l Click the required point in the survey view.
l Type the required point number in the End Point editbox at the bottom toolbar and press Enter.

The line is created.
4. If needed, repeat steps 2 and 3 to create more lines.
5. When finished, press Esc.

NOTE
When using thismode, the end point of the last line will not be automatically assigned as the start point
of the next line. You have to define start point manually for each new line. To continuously join more
than two points, use the Join Points icon. For more information, refer to "Join Points icon" section on
page 155.

Join Multiple Points icon
The Join Multiple Points icon of the Line group allows you to add new lines to the survey view by joining exist-
ing points one after one in order of point numbers. After clicking, point number 1 will be connected with point
number 2, point number 2 with point number 3 and so on.
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Tangent icon
The Tangent icon of the Line group allows you to add a new line to the survey view as the tangent to an existing
arc or circle.

A tangent may be defined by an arc, by a point and an arc or by a point and a circle.

To create a tangent line, defined by an arc:
1. In the Line group of the Insert tab, click the Tangent icon.
2. In the survey view select an existing arc.

The start or the end point of the arc, depending which is closer to the place of clicking, is defined as the
start point of the new tangent line.

The input panel is displayed at the bottom toolbar as for "Sideshot" point creation mode, but with the
defined bearing.

3. Locate the end point of the line. Do one of the following:
l Click the required place in the survey view.
l Specify the distance in the Distance editbox at the bottom toolbar. For more information refer to
"Sideshot icon" section on page 143.

The tangent line is created.

To create a tangent line, defined by a point and an arc/circle:
1. In the Line group of the Insert tab, click the Tangent icon.
2. In the survey view select an existing point.

The point is defined as the start point of the new tangent line.
3. In the survey view, select an existing arc or a circle.

The input panel is displayed at the bottom toolbar as for "Sideshot" point creation mode, but with the
defined bearing.

4. If needed, specify the length of the new line and other parameters. By default the end point is located at the
tangency point.

5. To accept the newly created line, do one of the following:
l Press Enter.
l Left click in the survey view.

The tangent line is created.

External Tangent icon
The External Tangent icon of the Line group allows you to add a new line to the survey view as the tangent to
two existing arcs or circles with the start and end points at the tangency points.

To create a tangent line to two arcs/circles:
1. In the Line group of the Insert tab, click the External Tangent icon.
2. In the survey view, select the first arc or circle.
3. In the survey view, select the second arc or circle.

The input panel for the first point is displayed at the bottom toolbar with the defined East and North coordin-
ates for the start point of the new line.

4. If needed, configure point properties. Description may be found in the table below.
5. Confirm the start point. Do one of the following:
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l Press Enter.
l Left click in the survey view.

The input panel for the first point is displayed at the bottom toolbar with the defined East and North
coordinates for the end point.

6. Repeat steps 4 and 5 for the end point of the new line.

The new tangent line is created.

Fields of the input panel, when confirming points
Field Description

Number Defines the number of the new tangency point.

East Displays the East (X) coordinate of the new tangency point.

North Displays the North (Y) coordinate of the new tangency point.

Elev Defines the elevation of the new tangency point.

Code Defines the code of the new tangency point.

Use in Surface Defines whether the next new point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the new tangency point will be interpolated.

Splay Corner icon
The Splay Corner icon of the Line group allows you to add a new line to the survey view as a splay corner
between two lines. See pictures below for details.

To create a line as a splay corner:
1. In the Line group of the Insert tab, click the Splay Corner icon.
2. In the survey view, select the first line.
3. In the survey view, select the second line.

The input panel is displayed at the bottom toolbar.
4. Define the position of the new line. Do one of the following:

l Locate it in the survey view.
l Configure the parameters at the bottom toolbar. Description of the fields may be found in the table
below.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the start
point of the new line.

5. Review the parameters of the start point, if needed change them. For more information about point para-
meters refer to "Add Point icon" section on page 136.

6. To confirm the start point do one of the following:
l Press Enter.
l Left click in the survey view.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the end
point of the new line.
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7. Repeat steps 5 and 6 for the end point of the new line.

The splay corner line is created.

Fields of the input panel when defining splay corner line position
Field Description

Chord Distance Defines the length of the splay corner line. See pictures below for details.

Tangent Distance Defines the distance from the intersection point to the splay corner line. See
pictures below for details.

Truncate Lines Defines whether the parts of the line between intersection point and splay
corner lines will be deleted. See pictures below for details.

Splay corner without truncating lines

Splay corner with truncated lines
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Splay corner when line doesn't actually intersect

Fit Line icon
The Fit Line icon of the Line group allows you to add a new line to the survey view as the best fit through the
suggested points.

To add a fitted line:
1. In the Line group of the Insert tab, click the Fit Line icon.
2. Suggest the points for the line. Do one of the following:

l Select the required points in the survey view.
l Type the number of the required point in the Point Number editbox at the bottom toolbar and press
Enter.

3. When finished suggesting points, press Ecs.

The Fit a Line dialog is displayed.
4. In the Maximum Offset editbox, specify the required tolerance.
5. Tick the Fixed Point checkbox, to define whether to use exactly the specify points, or it is allowed to cre-

ate new ones.
6. Click OK.

The new line is created, and a report, containing information about points used, points excluded and points
created, is displayed.

Rectangle As Lines icon
The Rectangle As Lines icon of the Line group allows you to add to the survey view a rectangle, consisting of
four lines.

To create a rectangle:
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1. In the Line group of the Insert tab, click the Rectangle As Lines icon.

The input panel for creating point in the "Coordinates" mode is displayed. For more information, refer to
"Add Point icon" section on page 136.

2. Locate the first point of the rectangle.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
3. Define the size of the rectangle. Do one of the following:

l Locate the opposite point in the survey view.
l Specify the width and height of the rectangle in the appropriate editboxes at the bottom toolbar and
press Enter.

The rectangle is created.

Fields of the bottom toolbar, when creating a rectangle
Field Description

Number Defines the number of the second rectangle point.

Width Defines the width of the rectangle.

Height Defines the height of the rectangle.

Elev Defines the elevation of all rectangle points, except for the first point.

Code Defines the code of all rectangle points, except for the first point.

Use in Surface Defines whether the rectangle points may be used for DTM creation or not.

Interpolate Elev-
ation

Defines whether the elevation of the rectangle points, except for the first point
will be interpolated.

Breakline Defines whether the lines of the rectangle may be used for DTM creation.

Join Points icon
The Join Points icon of the Line group allows you to add a new line to the survey view by joining existing points
in the survey view.

To create a line, by joining existing points:
1. In the Line group of the Insert tab, click the Join Points icon.

The input panel for point number is displayed at the bottom toolbar.
2. Define the start point of the line. Do one of the following:

l Click the required point in the survey view.
l Type the required point number in the Start Point editbox at the bottom toolbar and press Enter.
NOTE
If a point was selected, when clicking the "Add line" icon, it automatically become the start point of the
new line.

3. Define the end point of the line. Do one of the following:
l Click the required point in the survey view.
l Type the required point number in the Next Point editbox at the bottom toolbar and press Enter.

The line is created.
4. If needed, continue creating lines. The end point of the last line will automatically set as the start point of
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the next line.
5. When finished, press Esc.

Parallel icon
The Parallel icon of the Line group allows you to add a new line to the survey view as a parallel to an existing
one, with the same length.

To create a parallel line:
1. In the Line group of the Insert tab, click the Parallel icon.
2. In the survey view, select a line or a point.

NOTE
If you have selected a point, you need to select the second point, to define a line between them.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
3. Specify the position of the new line. Do one of the following:

l Locate it in the survey view.
l Define the position by specifying the offset and distance in the appropriate editboxes at the bottom
toolbar. See picture below for details.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the start
point of the new line.

4. Review the parameters of the start point, if needed change them. For more information about point para-
meters refer to "Add Point icon" section on page 136.

5. To confirm the start point do one of the following:
l Press Enter.
l Left click in the survey view.

The line is created.

Fields of the bottom toolbar, when creating a parallel line
Field Description

Number Defines the number of the new line start point.

Offset Defines the offset from the reference line. See picture below for details.

Dist Defines the offset along the reference line position. See picture below for
details.

Length Displays the length of the new line, which is the same as the reference line
length.

Count Defines quantity of the new parallels line. If the quantity is more than one,
lines will be located with the same offset from each other.

Elev Defines the elevation of the new line start point.

Code Defines the code of the new line start point.

Use in Surface Defines whether the start point of the new line may be used for DTM creation
or not.
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Creating a parallel line

Perpendicular icon
The Perpendicular icon of the Line group allows you to add a new line to the survey view as a perpendicular to
an existing line, an arc, a string or an alignment.

To create a parallel line:
1. In the Line group of the Insert tab, click the Perpendicular icon.
2. In the survey view, select a line, an arc, a string, an alignment or a point.

NOTE
If you have selected a point, you need to select the second point, to define a line between them.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
3. Specify the position of the new line. Do one of the following:

l Locate it in the survey view.
l Define the position by specifying the offset and distance in the appropriate editboxes at the bottom
toolbar. See picture below for details.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the end
point of the new line.
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4. Review the parameters of the end point, if needed change them. For more information about point para-
meters refer to "Add Point icon" section on page 136.

5. To confirm the end point do one of the following:
l Press Enter.
l Left click in the survey view.

The line is created. The end point of the new line is located at the existing entity.

Fields of the bottom toolbar, when creating a perpendicular line
Field Description

Number Defines the number of the new line point.

Offset Defines the offset from the reference entity. See picture below for details.

Dist Defines the offset distance from the reference entity start point. See picture
below for details.

Length Displays the length of the reference entity.

Elev Defines the elevation of the new line point.

Code Defines the code of the new line point.

Use in Surface Defines whether the point of the new line may be used for DTM creation or
not.

Interpolate Elev-
ation Defines whether the elevation of the line point will be interpolated.
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Creating a parallel line
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Arc group
An arc is the curve between two points, which is the segment of the circumference. It is defined by the position
of the start and the end points, and the center point. Besides, MAGNET Office has an arc entity, which defined
by the three points, which belongs to one circumference, and does not have the center point. Such arcs are called
"Three point arc".

If all points in arc have elevations, than the arc will be a 3D arc. An arc may be defined as a breakline for using
in a surface model.

The Arc group from the Insert tab of the MAGNET Office ribbon allows you to add new arcs to the project. It
contains four icons, and six second level icons, described in the table below.

Add Arc icon
Click it to add a new arc to the project. This icon also contains the list of

the second level icons. Click to see it.

Two Points icon
Click it to add a new arc, defined by two points.

Tangent from Line icon
Click it to add a new arc, in such way, that an existing line, a string or an

arc will be the tangent to the newly created arc.
Fillet icon

Click it to add an arc as a fillet between two existing entities.
Chords icon

Click it to replace an existing arc or circle with the set of chords.
Parallel icon

Click it to create a new arc as the parallel to an existing one.
Fit Arc icon

Click it to add a new arc as the best fit to the suggested points
Three Points icon

Click to add a new arc, defined by three points, belongs to the one cir-
cumference.
Angle icon

Click it to add a new arc by using the angle method.
TP-IP icon

Click it to add a new arc at intersection points of two existing
lines/strings.

Add Arc icon
The Add Arc icon of the Arc group allows you to add a new arc to the survey view. This icon creates an arc,
defined by two points and the center point.

To create an arc:
1. In the Arc group of the Insert tab, click the Add Arc icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
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2. Locate the start point of the arc. For more information about adding points refer to "Add Point icon" section
on page 136.

NOTE
If a point was selected, when clicking theAdd Arc icon, it automatically become the start point of the new
line.

3. Locate the end point of the arc, by using the "Sideshot" method. For more information, refer to Sideshot
icon.

The input panel for defining arc center point is displayed at the bottom toolbar.
4. Locate the center point of the arc. You may also define arc radius, by using the Radius editbox at bottom

toolbar.

The input panel is displayed at the bottom toolbar, with the defined East and North coordinates for the cen-
ter point of the arc.

5. If needed, configure additional parameters. See table below for details.
6. To accept the arc center point, do one of the following:

l Press Enter.
l Left click in the survey view.

The arc is created.
7. When finished, press Esc.

Fields of the input panel, when creating arcs
Field Description

Number Defines the number of the arc point.

East
Defines the East (X) coordinate of the arc start point.

NOTE
This field available only when creating the start point of the arc.

North
Defines the North (Y) coordinate of arc start point.

NOTE
This field available only when creating the start point of the arc.

Elev Defines the elevation of the arc point.

Code Defines the code of the arc point.

Bearing
Defines the bearing of the arc end point from the arc start point.

NOTE
This field available only in when creating the end point of the arc.

Distance

Defines the distance from the arc start point to the arc end point. I.e. arc chord
length.

NOTE
This field available only in when creating the end point of the arc.

Use in Surface Defines whether the arc point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the arc point will be interpolated.

BreakLine Defines whether the new arc will be a breakline.
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Field Description

Radius
Defines the radius of the new arc.

NOTE
This field available only when creating the center point of the arc.

Clockwise
Defines the direction from the arc start point to the arc end point.

NOTE
This field available only when creating the center point of the arc.

Major

Defines which part of the circumference will be used for the arc. See picture
below for details.

NOTE
This field available only when creating the center point of the arc.

Major and minor arcs

Two Points icon
The Two Points icon of the Add Arc icon allows you to add a new arc to the survey view, defined by the start
point, end point and radius, without creation of the center point.

To create a two-point arc:
1. In the Arc group of the Insert tab, click the Two Points icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the start point of the arc. For more information about adding points refer to "Add Point icon" sec-

tion on page 136.
NOTE
If a point was selected, when clicking theAdd Arc icon, it automatically become the start point of the
new line.

3. Locate the end point of the arc, by using the "Sideshot" method. For more information, refer to Sideshot
icon.
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The input panel for defining arc radius is displayed at the bottom toolbar. Fields are described in the table
below.

4. Define the arc radius. Do one of the following:
l In the Radius editbox at bottom toolbar, type the required radius and press Enter.
l Click the required place in the survey view.

The arc is created.
5. If needed, create more arcs. The end point of each previous arc will be automatically used as the start point

of the next arc.
6. When finished, press Esc.

Fields of the input panel, when creating arcs
Field Description

Number Defines the number of the arc point.

East
Defines the East (X) coordinate of the arc start point.

NOTE
This field available only when creating the start point of the arc.

North
Defines the North (Y) coordinate of arc start point.

NOTE
This field available only when creating the start point of the arc.

Elev Defines the elevation of the arc point.

Code Defines the code of the arc point.

Bearing
Defines the bearing of the arc end point from the arc start point.

NOTE
This field available only in when creating the end point of the arc.

Distance

Defines the distance from the arc start point to the arc end point. I.e. arc chord
length.

NOTE
This field available only in when creating the end point of the arc.

Use in Surface Defines whether the arc point may be used for DTM creation or not.

Interpolate Elev-
ation Defines whether the elevation of the arc point will be interpolated.

BreakLine Defines whether the new arc will be a breakline.

Radius
Defines the radius of the new arc.

NOTE
This field available only when defining the radius of the arc.

Clockwise
Defines the direction from the arc start point to the arc end point.

NOTE
This field available only when defining the radius of the arc.

Major

Defines which part of the circumference will be used for the arc. See picture
below for details.

NOTE
This field available only when defining the radius of the arc.
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Major and minor arcs

Tangent from Line icon
The Tangent from Line icon of the Arc group allows you to add a new arc to the survey view, in such way, that
an existing line, a string or an arc will be the tangent to the newly created arc.

To create a tangent arc:
1. In the Arc group of the Insert tab, click the Tangent from Line icon.
2. In the survey view, select an existing line, string or arc.

The start or end point of the existing line, the string or the arc, is automatically defined as the start point of
the new arc. The Radius editbox is displayed at the bottom toolbar.

3. Locate the radius of the new arc. Do one of the following:
l Click the required place in the survey view.
l In the Radius editbox at the bottom toolbar, type the required radius of the new arc and press Enter.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the arc
center point.

4. Review the parameters of the arc center point, if needed change them. For more information about point
parameters refer to "Add Point icon" section on page 136.

5. To confirm the arc center point do one of the following:
l Press Enter.
l Left click in the survey view.

The input panel for defining the arc length is displayed at the bottom toolbar. Fields are described in the
table below.

6. Define the end point of the arc. Do one of the following:
l Click the required place in the survey view.
l In the Angle editbox at the bottom toolbar, type the required angle of the new arc and press Enter.
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l In the Chord editbox at the bottom toolbar, type the required chord length of the new arc and press
Enter.

l In the Length editbox at the bottom toolbar, type the required length of the arc and press Enter.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the arc
end point.

7. Review the parameters of the arc end point, if needed change them. For more information about point para-
meters refer to "Add Point icon" section on page 136.

8. To confirm the arc end point do one of the following:
l Press Enter.
l Left click in the survey view.

The arc is created.

Fields of the bottom toolbar, when creating tangent arc
Field Description

Radius
Defines the radius of the new arc.

NOTE
This field available only when creating arc center point.

Angle

Defines the angle of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Chord" and "Length" para-
meters are calculating automatically.

Chord

Defines the chord length of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Angle" and "Length" para-
meters are calculating automatically.

Length

Defines the length of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Angle" and "Chord" para-
meters are calculating automatically.

Clockwise
Defines the direction of the arc from the start to the end point.

NOTE
This field available only when creating arc end point.
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Parameters of the arc

Fillet icon
The Fillet icon of the Arc group allows you to add a new arc to the survey view as a fillet between two existing
lines, strings, arcs or circles.

To create a fillet arc:
1. In the Arc group of the Insert tab, click the Fillet icon.
2. In survey view, select the first line, arc, string or circle. The start point of the new arc will be located on

it.
3. In survey view, select the second line, arc, string or circle. The end point of the new arc will be located on

it.

The input panel is displayed at the bottom toolbar.
4. Tick the Truncate checbox, to trim the original entities to the new tangent points. If unticked, all existing

entities will remain unchanged.
5. Define the radius of the new arc. Do one of the following:

l Click the required place in the survey view.
l In the Radius editbox at the bottom toolbar, type the required radius of the new arc and press Enter.

The new arc is created.

Fields of the bottom panel, when creating the fillet arc
Field Description

Radius Defines the radius of the new arc.
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Field Description

Truncate Defines whether the existing entities will be trimmed to the new tangent points
or will remain unchanged.

Chords icon
The Chords icon of the Arc group allows you to replace an existing arc or a circle with the set of chords inside or
outside of the arc or the circle. Chords inside the arc or the circle will have the same length. Chords outside of the
arc will contain the defines quantity of tangents with the same length, plus two half-length chords. See picture
below for details. Each chord will be an independent line.

Chords inside the arc

Chords outside of the arc

To divide an arc to chords:
1. In the Arc group of the Insert tab, click the Chords icon.
2. In the survey view, select the required arc or circle.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
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3. Define the quantity of chords and their position.
4. Do one of the following:

l Left click in the survey view.
l Press Enter.

The arc or the circle is replaced with its chords.

Fields of the bottom toolbar, when configuring replacement of an arc or a circle with chords
Field Description

Number Defines the quantity of chords to be created.

Inside arc Select to place the cords inside the arc or the circles.

Outside Select to place the cords outside of the arc or the circles.

Parallel to inside
chord Tick to make outside chord to be parallel to the inside chords.

Parallel icon
The Parallel icon of the Arc group allows you to create a new arc as the parallel to an existing one.

To create a parallel arc:
1. In the Arc group of the Insert tab, click the Parallel icon.
2. In the survey view, select the required arc.

The input panel is displayed at the bottom toolbar. Field description may be found in the table below.
3. Define the position of the new parallel arc. Do one of the following:

l Click the required place in the survey view.
l In the Offset editbox, at the bottom toolbar, type the required offset from the reference arc and press
Enter. See picture below for details.

The arc is created.

Field of the bottom toolbar, when creating parallel arc
Field Description

Offset Defines the offset from the reference arc. See picture below for details.
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The parallel arc

Fit Arc icon
The Fit Arc icon of the Arc group allows you to add a new arc to the survey view as the best fit through the sug-
gested points.

To add a fitted line:
1. In the Arc group of the Insert tab, click the Fit Arc icon.
2. Suggest the points for the arc. Do one of the following:

l Select the required points in the survey view.
l Type the number of the required point in the Point Number editbox at the bottom toolbar and press
Enter.

3. When finished suggesting points, press Ecs.

The Fit an Arc dialog is displayed.
4. In the Maximum Offset editbox, specify the required tolerance.
5. Tick the Tangent checkbox, to define the new as the tangent to two existing lines.
6. Tick the Delete points checkbox, to delete the arc center point after arc creation or not.
7. Click OK.

The new arc is created, and a report, containing information about points used, points excluded and points
created, is displayed.
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Three Points icon
The Three Points icon of the Arc group allows you to add a new arc to the survey view, defined by three points
from one circumference.

To create an arc, defined by three points:
1. In the Arc group of the Insert tab, click the Three Points icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the start point of the arc. For more information about adding points refer to "Add Point icon" sec-

tion on page 136.
NOTE
If a point was selected, when clicking the Three Points icon, it automatically become the start point of
the new line.

3. Locate the second point of the arc, by using the "Sideshot" method. For more information, refer to
"Sideshot icon" section on page 143.

4. Locate the third point of the arc, by using the "Sideshot" method.

The arc is created.
5. When finished, press Esc.

Fields of the input panel, when creating arcs
Field Description

Number Defines the number of the arc point.

East
Defines the East (X) coordinate of the arc start point.

NOTE
This field available only when creating the start point of the arc.

North
Defines the North (Y) coordinate of arc start point.

NOTE
This field available only when creating the start point of the arc.

Elev Defines the elevation of the arc point.

Code Defines the code of the arc point.

Bearing

Defines the bearing of the arc second/end point from the arc start point.
NOTE
This field available only in when creating the second and the end point of the
arc.

Distance

Defines the distance from the arc start point to the arc second/end point.
NOTE
This field available only in when creating the second and the end point of the
arc.

Use in Surface Defines whether the arc point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the arc point will be interpolated.

BreakLine Defines whether the new arc will be a breakline.
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Angle icon
The Angle icon of the Arc group allows you to add a new arc to the survey view, defined by its angle.

To create an arc, defined by angle:
1. In the Arc group of the Insert tab, click the Angle icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the start point of the new arc. For more information about adding points refer to "Add Point icon"

section on page 136.
NOTE
If a point was selected, when clicking theAdd Arc icon, it automatically become the start point of the new
line.

3. Locate the end point of the arc, by using the "Sideshot" method. For more information, refer to Sideshot
icon.

The input pane is displayed at the bottom toolbar. Fields are described in the table below.
4. Locate the end point of the arc. Do one of the following:

l Click the required place in the survey view.
l In the Angle editbox at the bottom toolbar, type the required angle of the new arc and press Enter.
l In the Chord editbox at the bottom toolbar, type the required chord length of the new arc and press
Enter.

l In the Length editbox at the bottom toolbar, type the required length of the arc and press Enter.

The input panel is displayed at the bottom toolbar with the defined East and North coordinates for the arc
end point.

5. Review the parameters of the arc end point, if needed change them. For more information about point para-
meters refer to "Add Point icon" section on page 136.

6. To confirm the arc end point do one of the following:
l Press Enter.
l Left click in the survey view.

The arc is created.

Fields of the bottom toolbar, when creating an arc, defined by its angle
Field Description

Number Defines the number of the arc point.

East
Defines the East (X) coordinate of the arc start point.

NOTE
This field available only when creating the start point of the arc

North
Defines the North (Y) coordinate of arc start point.

NOTE
This field available only when creating the start point of the arc.

Elev Defines the elevation of the arc point.

Code Defines the code of the arc point.
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Field Description

Bearing
Defines the bearing of the arc center point from the arc start point.

NOTE
This field available only in when creating the center point of the arc.

Distance

Defines the distance from the arc start point to the arc center point. I.e. the arc
radius.

NOTE
This field available only in when creating the end point of the arc.

Use in Surface Defines whether the arc point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the arc point will be interpolated.

BreakLine Defines whether the new arc will be a breakline.

Angle

Defines the angle of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Chord" and "Length" para-
meters are calculating automatically.

Chord

Defines the chord length of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Angle" and "Length" para-
meters are calculating automatically.

Length

Defines the length of the new arc. See picture below for details.
NOTES
This field available only when creating arc end point.
When specifying this parameter, the values of the "Angle" and "Chord" para-
meters are calculating automatically.

Clockwise
Defines the direction of the arc from the start to the end point.

NOTE
This field available only when creating arc end point.

TP-IP icon
The TP-IP icon of the Arc group allows you to add a new arc to the survey view, tangential to two existing lines
or strings.

To create a new arc, tangential to two existing lines or strings:
1. In the Arc group of the Insert tab, click the TP-IP icon.
2. In the survey view, select two reference lines or strings.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
3. By using the Truncate Lines checkbox, define whether the reference lines will be truncated or not. See pic-

ture below for details.
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4. Locate the arc. Do one of the following:
l Click the required place in the survey view.
l In the Radius editbox at the bottom toolbar, type the required radius of the arc and press Enter. See
picture below for details.

l In the Tangent Distance editbox at the bottom toolbar, type the required distance between existing
lines or strings intersection point and tangency points with the arc and press Enter. See picture below
for details.

The arc is created.
Fields of the bottom toolbar, when creating arc, tangential to two existing lines

Field Description

Radius Defines the radius of the new arc. See picture below for details.

Tangent Distance Defines the distance between intersection point of existing lines or strings and
the tangency point. See picture below for details.

Truncate Lines Tick to cut/continue existing lines or strings to the tangency point. If unticked,
existing lines or strings will remain unchanged.
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Creating a new arc, tangent to two existing lines
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Circle group
A circle may be described as an arc, which has the full circumference, without start and end points on it.

The Circle group from the Insert tab of the MAGNET Office ribbon allows you to add a new circle to the pro-
ject. It contains three icons, described in the table below.

Radius icon
Click it to add a new circle by specifying its center and radius.

Diameter icon
Click it to add a new circle by specifying its center and diameter.

Two Points icon
Click it to add a new circle by specifying two points on its circumference.

Radius icon
The Radius icon of the Circle group allows you to add a new circle to the survey view by specifying its center
point and radius.

To create a new circle:
1. In the Circle group of the Insert tab, click the Radius icon.

The input panel for point creation is displayed at the bottom toolbar. For more information refer to "Add
Point icon" section on page 136.

2. Locate the center point of the circle, by using the "Coordinate" method.

The input panel is displayed at the bottom toolbar.
3. Define the radius of the circle. Do one of the following:

l Click the required place in the survey view.
l In the Radius editbox at the bottom toolbar, type the required radius of the circle and press Enter.

The circle is created.
4. When finished, press Esc.

Fields of the input panel, when creating circles
Field Description

Number Defines the number of the next new point.

East Defines the East (X) coordinate of the circle center point.

North Defines the North (Y) coordinate of the circle first point.

Elev Defines the elevation of the next new point.

Code Defines the code of the circle center point.

Use in Surface Defines whether the circle center point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the circle center point will be interpolated.

BreakLine Defines whether the new circle will be a breakline.

Radius Defines the radius of the new circle.
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Diameter icon
The Diameter icon of the Circle group allows you to add a new circle to the survey view by specifying its center
point and diameter.

To create a new circle:
1. In the Circle group of the Insert tab, click the Diameter icon.

The input panel for point creation is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the center point of the circle, by using the "Coordinate" method. For more information refer to "Add

Point icon" section on page 136.

The input panel is displayed at the bottom toolbar.
3. Define the diameter of the circle. Do one of the following:

l Click the required place in the survey view.
l In the Diameter editbox at the bottom toolbar, type the required diameter of the circle and press
Enter.

The circle is created.
4. When finished, press Esc.

Fields of the input panel, when creating circles
Field Description

Number Defines the number of the next new point.

East Defines the East (X) coordinate of the circle center point.

North Defines the North (Y) coordinate of the circle first point.

Elev Defines the elevation of the next new point.

Code Defines the code of the circle center point.

Use in Surface Defines whether the circle center point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the circle center point will be interpolated.

BreakLine Defines whether the new circle will be a breakline.

Diameter Defines the diameter of the new circle.

Two Points icon
The Two Points icon of the Circle group allows you to add a new circle to the survey view, defined by two points,
belong to its circumference, at the same diameter.

To create a circle, defined by two points:
1. In the Circle group of the Insert tab, click the Two Points icon.

The input panel for point creation is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the first point of the circle, by using the "Coordinate" method. For more information refer to "Add

Point icon" section on page 136.
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The input panel for point creation in "Sideshot" method is displayed at the bottom toolbar.
3. Locate the second point of the circle, by using the "Sideshot" method. For more information refer to

"Sideshot icon" section on page 143.

The circle is created.
4. When finished, press Esc.

Fields of the input panel, when creating circles
Field Description

Number Defines the number of the next new point.

East
Defines the East (X) coordinate of the circle first point.

NOTE
This field available only when creating the first point.

North
Defines the North (Y) coordinate of the circle first point.

NOTE
This field available only when creating the first point.

Elev Defines the elevation of the next new point.

Bearing
Defines the bearing from the first circle point to the second.

NOTE
This field available only when creating the second point.

Distance
Defines the distance between the first and second circle points.

NOTE
This field available only when creating the second point.

Code Defines the code of the circle center point.

Use in Surface Defines whether the circle center point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the circle center point will be interpolated.

BreakLine Defines whether the new circle will be a breakline.
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Text group
The Text group from the Insert tab of the MAGNET Office ribbon allows you to add textual entities to the project.
Note that the text entities are just "labels", which is used for annotation, and other informational properties. They
are not used in data processing.

The group contains three icons, and twelve second level icons, described in the table below.

Text icon
Click it to add a simple text to the project.

Text Box icon
Click it to add a new text box to the project.

Text icon
This icon contains the list of the second level icons. Click to see it.

Keyword icon
Click it to add a keyword to the survey view.

Bearing/Distance icon
Click it to add text information about bearing and length of an existing

line.
Slope/Grade icon

Click it to add text information about slope of the existing line.
Point Coordinate icon

Click it to add text information about coordinates of an existing point.
Point Elevation icon

Click it to add text information about height of an existing point.
Point Notes icon

Click it to add point note as text information.
Point Offset icon

Click it to add text information about distance form an existing point to
another entity.
Arc Length icon

Click it to add text information about length of an existing arc.
Arc Radius icon

Click it to add text information about radius of an existing arc.
Stacked Arc Labels icon

Click it to add an existing arc annotation as the text entity.
Angle icon

Click it to add text information about angle between two existing lines.
Label Total Distance icon

Click it to add text information about total length of the string.

Text icon
The Text icon of the Text group allows you to add text entities to the survey view.

To create a text:
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1. In the Text group of the Insert tab, click the Text icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the insertion point of the text. Do one of the following:

l Click the required place in the survey view.
l Type the required East and North coordinates in the appropriate editboxes at the bottom toolbar and
press Enter.

3. Type the required text.
4. If needed, in the Bearing editbox at the bottom toolbar, type the required bearing for the text.
5. If needed, define the insertion style of the text. See pictures below for details.
6. Press Enter.

The text is created.

Fields of the bottom toolbar, when creating text
Field Description

East Defines the East (X) coordinate of the text insertion point.

North Defines the North (Y) coordinate of the text insertion point.

Bearing Defines the bearing of the text.

Insertion Defines the insertion style. See pictures below for details.

Bottom left text insertion style

Bottom center text insertion style
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Bottom right text insertion style

Center left text insertion style

Center center text insertion style
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Center right text insertion style

Top left text insertion style

Top center text insertion style
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Top right text insertion style

Text Box icon
The Text Box icon of the Text group allows you to add a boxed text to the survey view. All the text will stay
inside the box.

To create a boxed text:
1. In the Text group of the Insert tab, click the Text Box icon.

The input panel is displayed at the bottom toolbar for point creation.
2. Locate the first point of the box, by using the "Coordinate" method. For more information, refer to "Add

Point icon" section on page 136.
3. Locate the second point of the box, by using the "Sideshot" method. For more information, refer to

"Sideshot icon" section on page 143.

The yellow box for the text is displayed in the survey view. The input panel for text is displayed at the bot-
tom toolbar.

4. Type the required text.
5. If needed, in the Bearing editbox at the bottom toolbar, type the required bearing for the text.
6. If needed, define the insertion style of the text. See pictures below for details.
7. Press Enter.

The boxed text is created.

Fields of the bottom toolbar, when creating text
Field Description

East Defines the East (X) coordinate of the text insertion point.

North Defines the North (Y) coordinate of the text insertion point.

Bearing Defines the bearing of the text.

Insertion Defines the insertion style. See pictures below for details.
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Bottom left text insertion style

Bottom center text insertion style

Bottom right text insertion style
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Center left text insertion style

Center center text insertion style

Center right text insertion style
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Top left text insertion style

Top center text insertion style

Top right text insertion style

Keyword icon
The Keyword icon of the Text group allows you to simplify creating of the title block. A keyword is a value,
which will be automatically replaced with the required data when plotting.
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To add a keyword:
1. In the Text group of the Insert tab, click the Keyword icon.

The Keyword dialog is displayed.
2. Select the required keyword and Click OK.

The input panel for text creation is displayed at the bottom toolbar.
3. Locate the insert point of the text. Do one of the following:

l Click the required place in the survey view.
l Type the required East and North coordinates in the appropriate editboxes at the bottom toolbar and
press Enter.

4. If needed, in the Bearing editbox at the bottom toolbar, type the required bearing for the text.
5. If needed, define the insertion style of the text. See pictures below for details.
6. Press Enter.

The keyword is added.

Bottom left text insertion style

Bottom center text insertion style

187



Insert tab

Bottom right text insertion style

Center left text insertion style

Center center text insertion style
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Center right text insertion style

Top left text insertion style

Top center text insertion style
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Top right text insertion style

Bearing/Distance icon
The Bearing/Distance icon of the Text group allows you to add information about bearing and distance of the
existing line as two text entities. Note that this is not the line annotation, but automatically generated text entity.
Unlike the annotation, it remains on its place if the line will be moved or deleted, and will not change, even if the
line bearing and distance will change.

To add a bearing/distance text:
1. In the Text group of the Insert tab, click the Bearing/Distance icon.
2. In the survey view, select the required line or a pair of points.

The bearing and distance of the line are displayed as defined by the Line annotation settings. You may edit
them as a usual text.

Slope/Grade icon
The Slope/Grade icon of the Text group allows you to add information about the slope of the existing line as the
text entity. Note that this is not the line annotation, but automatically generated text entity. Unlike the annotation,
it remains on its place if the line will be moved or deleted, and will not change, even if the line parameters will
change.

To add a slope/grade text:
1. In the Text group of the Insert tab, click the Slope/Grade icon.
2. In the survey view, select the required line or a pair of points.

The slope of the line is displayed as defined by the Line annotation settings. You may edit them as a usual
text.

3. If needed, configure the slope text. Right click, and select the Slope Text Settings item from the context
menu.

The Slope Text Settings dialog is displayed. Fields are described in the table below.
4. Make the required configurations and click OK.
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Fields of the Slope Text Settings dialog
Fields Description

Text Style
Defines the text style for the slope text. Select the required style from the drop-
down list. ClickModify to edit the current style. See "Text Styles icon" section
on page 122 for details.

Justification Style Defines the justification style for the slope text. Select the required style from
the drop-down list.

Percentage Select to display the line slope in percent.

Degree Select it to display the line slope in degrees.

Ratio Select it to display the line slope as the ratio between the length of the line and
the height of the end point.

Point Coordinate icon
The Point Coordinate icon of the Text group allows you to add information about coordinates of the existing point
as the text entity. Note that this is not the point annotation, but automatically generated text entity. Unlike the
annotation, it remains on its place if the point will be moved or deleted, and will not change, even if the point pos-
ition will change.

To add a point coordinates text:
1. In the Text group of the Insert tab, click the Point Coordinate icon.

The Text From Point Coordinates dialog is displayed. Fields are described in the table below.
2. Configure the parameters as you need, and Click OK.
3. In the survey view, select the required point.

The point coordinate text is added. The input panel is displayed at the bottom toolbar.
4. If needed, change the insertion point position. Do one of the following:

l Drag the insertion point in the survey view, by using the mouse.
l Type the required East and North coordinates in the appropriate editboxes at the bottom toolbar and
press Enter.

5. If needed, in the Bearing editbox at the bottom toolbar, type the required bearing for the text.
6. If needed, define the insertion style of the text. See pictures below for details.
7. Press Enter.

The point coordinate text is created.

Fields of the Text From Point Coordinates dialog
Field Description

Layer Defines the layer at which the point coordinate text will be located.

Text Style Defines the text style for the point coordinate text. For more information about
text styles, refer to "Text Styles icon" section on page 122.

Justification Defines the justification style for the point coordinate text. For more inform-
ation about justification styles, refer to "Justification icon" section on page 123.

Position Defines the insertion style for the point coordinate text. For more information,
refer to "Text icon" section on page 179.
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Field Description

Text Before Nor-
thing Defines the text to be placed before the North coordinate.

Text Before East-
ing Defines the text to be placed before the East coordinate.

Text After Nor-
thing Defines the text to be placed after the North coordinate.

Text After Easting Defines the text to be placed after the East coordinate.

Radiobuttons Defines the order and relative position of the North and East coordinates.

Bottom left text insertion style

Bottom center text insertion style
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Bottom right text insertion style

Center left text insertion style

Center center text insertion style
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Center right text insertion style

Top left text insertion style

Top center text insertion style
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Top right text insertion style

Point Elevation icon
The Point Elevation icon of the Text group allows you to add information about elevation of the existing point as
the text entity. Note that this is not the point annotation, but automatically generated text entity. Unlike the annota-
tion, it remains on its place if the point will be moved or deleted, and will not change, even if the point elevation
will change.

To add a point elevation text:
1. In the Text group of the Insert tab, click the Point Elevation icon.
2. In the survey view, select the required points.

The point elevation text is displayed as defined by the Point annotation settings. You may edit them as a
usual text.

Point Notes icon
The Point Notes icon of the Text group allows you to add point notes to the Survey view. Note that this is not the
point annotation, but automatically generated text entity. Unlike the annotation, it remains on its place if the point
will be moved or deleted, and will not change, even if the point elevation will change.

To add a point offset text:
1. In the Text group of the Insert tab, click the Point Notes icon.
2. In the survey view, select the required point.

The point offset text with the dimension line is displayed as defined by the Dimension settings. You may
edit them as a usual text.

Point Offset icon
The Point Offset icon of the Text group allows you to add information about distance from the existing point to
another entity as the dimension line text entity. Note that this is not the point annotation, but automatically gen-
erated text entity. Unlike the annotation, it remains on its place if the point will be moved or deleted, and will not
change, even if the point elevation will change.

To add a point offset text:

195



Insert tab

1. In the Text group of the Insert tab, click the Point Offset icon.
2. In the survey view, select the required point.
3. In the survey view, select the second entity.

The point offset text with the dimension line is displayed as defined by the Dimension settings. You may
edit them as a usual text.

Arc Length icon
The Arc Length icon of the Text group allows you to add information about length of the existing arc as the text
entity. Note that this is not the arc annotation, but automatically generated text entity. Unlike the annotation, it
remains on its place if the arc will be moved or deleted, and will not change, even if the arc length will change.

To add an arc length text:
1. In the Text group of the Insert tab, click the Arc Length icon.
2. In the survey view, select the required arc.

The arc length text is displayed as defined by the Arc annotation settings. You may edit them as a usual
text.

Arc Radius icon
The Arc Radius icon of the Text group allows you to add information about radius of the existing arc as the text
entity. Note that this is not the arc annotation, but automatically generated text entity. Unlike the annotation, it
remains on its place if the arc will be moved or deleted, and will not change, even if the arc radius will change.

To add an arc radius text:
1. In the Text group of the Insert tab, click the Arc Radius icon.
2. In the survey view, select the required arc.

The arc radius text is displayed as defined by the Arc annotation settings. You may edit them as a usual
text.

Stacked Arc Labels icon
The Stacked Arc Labels icon of the Text group allows you to add all annotation information about the existing
arc as the text entity. Note that this is not the arc annotation, but automatically generated text entity. Unlike the
annotation, it remains on its place if the arc will be moved or deleted, and will not change, even if the arc para-
meter will change.

To add an arc labels text:
1. In the Text group of the Insert tab, click the Stacked Arc Labels icon.
2. In the survey view, select the required arc.

The arc labels text is displayed as defined by the Arc annotation settings. You may edit them as a usual
text.

Angle icon
The Angle icon of the Text group allows you to add information about angle between two existing lines as the
text entity. Note that this is not the angle annotation, but automatically generated text entity. Unlike the annota-
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tion, it remains on its place if the lines will be moved or deleted, and will not change, even if the angle will
change.

To add angle information as text:
1. In the Text group of the Insert tab, click the Angle icon.

The Internal Angle editbox is displayed at the bottom toolbar.
2. If needed, tick the Internal Angle checkbox. Internal angle defines as the smallest angle between entities.
3. In the survey view, select the required entities.

The angle is displayed as defined by the Angle annotation settings. You may edit them as a usual text.

Label Total Distance icon
The Label Total Distance icon of the Text group allows you to add information about total length of the string,
alignment or polyline as the text entity. Note that this is not the annotation, but automatically generated text entity.
Unlike the annotation, it remains on its place if the string will be moved or deleted, and will not change, even if
the string length will change.

To add distance information as text:
1. In the Text group of the Insert tab, click the Label Total Distance icon.

The Label Total Distance dialog is displayed.
2. From the Layer drop-down list, select the layer where distance text will be placed.
3. From the Text drop-down list, select the text style for distance text.
4. From the Justification drop-down list, select the justification style for distance text.
5. If needed, in the Prefix and Suffix specify prefix and suffix of the distance text.
6. Click OK.

The distance text is displayed as defined by the Distance annotation settings. You may edit them as a usual
text.
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Polyline/Polygon group
A polyline is a continuous line consists of a set of connected segments. A polyline has not points at nodes.
A polyline may be described as the set of connected lines, without points at their nodes, combined in one entity.

A polygon is a closed shape, defined by several points, joined by lines and/or arcs to become one entity.

You can move the polygon nodes to change its shape, by holding the Shift key and moving the node with a mouse.
You can also move the entire polygon in the same way, by using its centroid point. A polygon is the base entity
for a lot, boundary or pad.

The Polyline/Polygon group from the Insert tab of the MAGNET Office ribbon allows you to add a polyline or
polygon to the project. It contains three icons, described in the table below.

Polilyne icon
Click it to add a polyline to the survey view.

Polygon Area icon
Click it to add a polygon to the survey view.

Rectangle icon
Click it to add a rectangle shape polygon to the survey view.

Polilyne icon
The Polyline icon of the Polyline/Polygon group allows you to add a new polyline to the survey view.

To create a polyline:
1. In the Polyline/Polygon group of the Insert tab, click the Polyline icon.

The input panel for point creation is displayed at the bottom toolbar. Description of the fields may be found
in the table below.

2. Locate the start point of the polyline, by using the "Coordinate" method. For more information about adding
points refer to "Add Point icon" section on page 136.

NOTE
The point entity will not be created. This coordinates defines only the start position of
the polyline.

3. Locate the other points of the polyline, by using the "Sideshot" method. For more information refer to
"Sideshot icon" section on page 143.

4. When finished, press Esc.

The polyline is created.

Fields of the input panel, when creating polylines
Field Description

Number

East
Defines the East (X) coordinate of the polyline start point.

NOTE
This field available only when creating the start point.
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Field Description

North
Defines the North (Y) coordinate of the polyline start point.

NOTE
This field available only when creating the start point.

Elev Defines the elevation of the polyline.

Bearing
Defines the bearing of the further polyline node from the previous one.

NOTE
This field available only when creating the second and further points.

Distance
Defines the distance from the previous polyline node to further one.

NOTE
This field available only when creating the second and further points.

Interpolate Elev-
ation

Defines whether the elevation of the polyline start/end point will be inter-
polated.

BreakLine Defines whether the new polyline will be a breakline.

Polygon Area icon
The Polygon Area icon of the Polyline/Polygon group allows you to add a new polygon to the survey view.

To create a new polygon:
1. In the Polyline/Polygon group of the Insert tab, click the Polygon Area icon.

The input panel for point creation is displayed at the bottom toolbar. Description of the fields may be found
in the table below.

2. Locate the nodes of the polygon.
3. To close the polygon area do one of the following:

l Locate the last point at the same place as the first point.
l Press Esc. The message window prompts to save the polygon. Click OK. The last created point will
be connected with the first point with the shortest line possible.

The Edit Polygon Area dialog is displayed.
4. Review the properties of the newly created polygon, if needed change them. For more information refer to

"Polygon properties" section on page 558.
NOTE
Youmay convert a polygon to a lot, boundary or a pad. For more information refer to "Polygon conversion"
section on the next page.

5. Click OK.

The polygon is created.

Fields of the input panel, when creating polygons
Field Description

Number Defines the number of the next new point.

East Defines the East (X) coordinate of the polygon point.
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Field Description

North Defines the North (Y) coordinate of the polygon point.

Elev Defines the elevation of the polygon point.

Code Defines the code of the polygon point.

Use in Surface Defines whether the polygon point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the polygon point will be interpolated.

BreakLine Defines whether the lines of the new polygon be a breakline.

Polygon conversion
A polygon is the base entity for a lot, boundary or pad. It means, that for creating these entities, you have to cre-
ate a polygon, and then convert it.

To convert a polygon:
1. Create a polygon. For more information refer to "Polygon Area icon" section on the previous page.
2. In the Edit Polygon Area dialog, click Convert.

The Polygon Conversion dialog is displayed.
3. From the Convert To list, select the target entity.
4. In the Name editbox, type the name of the new entity.
5. Click OK.

Rectangle icon
The Rectangle icon of the Polyline/Polygon group allows you to add a rectangle shape polygon to the survey
view.

To create a rectangle shape polygon:
1. In the Polyline/Polygon group of the Insert tab, click the Rectangle icon.

The input panel for creating point in the "Coordinates" mode is displayed. For more information, refer to
"Add Point icon" section on page 136.

2. Locate the first point of the rectangle.

The input panel is displayed at the bottom toolbar.
3. Define the parameters of the rectangle. Do one of the following:

l Locate the opposite point in the survey view.
l Specify the parameters at the bottom toolbar. Fields are described in the table below.

The rectangle is created.

Fields of the bottom toolbar, when creating a rectangle polygon
Field Description

Number Defines the number of the second rectangle point.
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Field Description

Width Defines the width of the rectangle.

Height Defines the height of the rectangle.

Elev Defines the elevation of all rectangle points, except for the first point.

Code Defines the code of all rectangle points, except for the first point.

Use in Surface Defines whether the rectangle points may be used in surface or not.

Interpolate Elevation Defines whether the elevation of the rectangle points, except for the first point
will be interpolated.

Breakline Defines whether the lines of the rectangle may be used for DTM creation
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String group
A string is the series of point (which are called nodes), connected by lines and/or arc, to become one entity.
A string may be marked with the user-defined code. If all points in a string have elevations, than the string will
be a 3D string. A string may be defined as a breakline for using in a surface model.

The String group from the Insert tab of the MAGNET Office ribbon allows you to add string entities to the survey
view. It contains three icons, described in the table below.

String icon
Click it to add a string to the project.

Parallel String icon
Click it to add a new string as a parallel to an existing one.

Parallel Figure icon
Click it to add a new figure as a parallel to an existing one.

String icon
The String icon of the String group allows you to add a new string to the survey view.

To create a string:
1. In the String group of the Insert tab, click the String icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
NOTE
If a point was selected, when clicking theString icon, it automatically become the start point of the new
string.

2. Locate the first point of the string by using the "Coordinate" method. For more information refer to "Add
Point icon" section on page 136.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
3. Locate the second and further points of the string, by using the "Sideshot" or "Coordinate" method. For

more information about "Sideshot" method, refer to "Sideshot icon" section on page 143.

TIP

To switch the creation mode use the Coordinate icon and the Direction icon from the Create Modes group of
the Settings tab, or corresponding icons at the toolbar.

4. When finished, press Esc.

The Create String dialog is displayed.
5. Review the properties of the newly created string, if needed change them. For more information, refer to

"String properties" section on page 555.
6. Click OK.

The string is created.

Fields of the input panel, when creating strings
Field Description

Number Defines the number of the next new point.
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Field Description

East Defines the East (X) coordinate of the string point.

North Defines the North (Y) coordinate of the string point.

Elev Defines the elevation of the string point.

Bearing
Defines the bearing of the string point from the previous one.

NOTE
This field available only when creating second or further points.

Distance
Defines the distance from the previous string node to further one.

NOTE
This field available only when creating second or further points..

Code Defines the code of the string point.

Use in Surface Defines whether the string point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the string point will be interpolated.

BreakLine Defines whether the new string will be a breakline.

Parallel String icon
The Parallel String icon of the String group allows you to add a new string to the survey view, based on an exist-
ing string.

To create a parallel sting:
1. In the String group of the Insert tab, click the Parallel String icon.
2. In the survey view, select the required source string.

NOTE
If a string was selected, when clicking the icon, it will be used as the source string.

The Parallel String dialog is displayed. Fields are described in the table below.
3. In the Offset editbox, specify the required offset from the original entity.
4. Define the required height option for the parallel string.
5. Click OK.
6. In the survey view, select from which side of the existing string the new one will be placed.

The new string is created and the Edit String dialog is displayed.
7. Review the parameters of the newly created string, and click OK to accept it. For more information about

the string parameters refer to "String properties" section on page 555.
8. Do one of the following:

l Press Enter to add more strings with the same parameters.
l Press Ecs to finish the parallel string creation.

Fields of the Parallel String dialog
Field Description

Offset Defines the offset of the new parallel string from the original one.
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Field Description

Constant Height
Select this radiobutton to create the new string with the same elevation for all
nodes. If selected, specify the height of the new string in the appropriate edit-
box.

Fixed CrossFall

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope in percents from the original string nodes elevations.
If selected, specify the slope percentage of the new string in the appropriate
editbox. Positive slope means that the new string will be higher than the ori-
ginal one. Negative slope means that the new string will be lower than the ori-
ginal one.

Fixed Difference

Select this radiobutton to create the new string with the node elevation, defined
by the fixed difference from the original string nodes elevations. If selected,
specify the required difference in the appropriate editbox. It will be subtracted
or added to the original string nodes elevations.

Ratio

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope, defined as ratio, from the original string nodes elev-
ations. If selected, specify the slope ratio of the new string in the appropriate
editbox. Note that you are defining the denominator of the ratio. Positive slope
means that the new string will be higher than the original one. Negative slope
means that the new string will be lower than the original one.

No Height Select this radiobutton to create the new string without elevetaion.

Parallel Figure icon
The Parallel Figure icon of the String group allows you to add two new strings to the survey view as the parallel
to an existing line, arc, string or alignment.

To create a parallel figure:
1. In the String group of the Inset tab, click the Parallel Figure icon.
2. In the survey view, select the required source string.

NOTE
If a string was selected, when clicking the icon, it will be used as the source string.

The Parallel Figure dialog is displayed. Fields are described in the table below.
3. Do one of the following:

l In the Road Template group box, tick the checkbox and select the required road template from the
drop-down list.

l In the "Offset Strings" panel, configure the offsets of the new strings from the original string and the
height of the new string.

4. Click OK.

The new string is created and the Edit String dialog is displayed.
5. Review the parameters of the newly created string, and click OK to accept it. For more information about

the string parameters refer to "String properties" section on page 555. Repeat for the second string.

The parallel strings are created.
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Fields of the Parallel String dialog
Field Description

Template
Defines the road template for the parallel strings. Click Edit Templates to edit
the currently selected template. See "Templates icon" section on page 702 for
details.

Left Offset Defines the offset of the new parallel string, located to the left from the ori-
ginal one.

Right Offset Defines the offset of the new parallel string, located to the right from the ori-
ginal one.

Constant Height
Select this radiobutton to create the new string with the same elevation for all
nodes. If selected, specify the height of the new string in the appropriate edit-
box.

Fixed CrossFall

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope in percents from the original string nodes elevations.
If selected, specify the slope percentage of the new string in the appropriate
editbox. Positive slope means that the new string will be higher than the ori-
ginal one. Negative slope means that the new string will be lower than the ori-
ginal one.

Fixed Difference

Select this radiobutton to create the new string with the node elevation, defined
by the fixed difference from the original string nodes elevations. If selected,
specify the required difference in the appropriate editbox. It will be subtracted
or added to the original string nodes elevations.

No Height Select this radiobutton to create the new string without eleveraion.
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Feature group
The Feature group from the Insert tab of the MAGNET Office ribbon allows you to insert additional table and
picture entities to the project. It contains two icons and nine second level icons, describe in the table below.

Table icon
Click it to add a table to the project. This icon also contains the list

of the second level icons. Click to see it.

Coordinate Table icon
Click it to add a table, containing information about existing points,

lines or arcs.
Symbol Table icon

Click it to add a table, containing information about how the symbols
are used in the project.
Line Style Table icon

Click it to add a table, containing information about how the symbols
are used in the project.

Line Annotation Table icon
Click it to add the line annotation table to the survey view.

Arc Annotation Table icon
Click it to add the arc annotation table to the survey view.

Image/Pdf icon
Click it to add an image or a PDF file to the project. This icon also

contains the list of the second level icons. Click to see it.

Attach icon
Click it to attach a picture to an existing entity.

Background Image icon
Click it to add a background image to the survey view.

Link/Unlink icon
Click it to link/unlink an image to an existing entity.

View Attached/Linked icon
Click it to view the list of the images, attached/linked to an existing

entity.

Table icon
The Table icon of the Feature group allows you to add an empty table to the survey view.

To create an empty table:
1. In the Feature group of the Insert tab, click the Table icon.

The Table Properties dialog is displayed.
2. In the Name editbox, type the name of the new table.
3. In the Rows editbox, define the quantity of rows in the new table.
4. In the Columns editbox, define the quantity of columns in the new table.
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5. Review other properties, if needed change them. Fields are described in the table below.
6. Click OK.
7. Locate the top left corner of the table. Do one of the following:

l Click the required place in the survey view.
l Specify the East and North coordinates in the appropriate editboxes at the bottom toolbar.

The table is created.

Fields of the Table Properties dialog
Field Description

Name Defines the name of the table.

Rows Defines the quantity of rows in the table.

Columns Defines the quantity of columns in the table.

Min Height Defines the minimum height of the table rows.

Min Width Defines the minimum width of the table columns.

Color Defines the color of the table borders.

Font Defines the font of the text in the table.

Char Height Defines the font size of the text in the table.

Text Style Defines the text style, used in the table.

Char Style Defines whether the text formatting in the table.

Insertion Style Defines the justification style, used in table cells. See pictures below for
details.

Use Text Style Tick to use the font settings from the text style, instead of mentioned above.

Opaque Tick to place the table in front of any entities, and cut them at a certain dis-
tance around the text.

Draw Box Tick to draw external border of the table.

Table justification styles

Bottom left justification style
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Bottom middle justification style

Bottom right justification style

Center left justification style
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Center middle justification style

Center right justification style

Top left justification style

Top middle justification style
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Top right justification style

Coordinate Table icon
The Coordinate Table icon of the Feature group allows you to add a table, containing information about the exist-
ing points, lines or arcs to the survey view.

To create a coordinate table:
1. Select entities to be included to the table.
2. In the Feature group of the Insert tab, click the Coordinate Table icon.

The Coordinate Table dialog is displayed. Fields and buttons of the dialog are described in the tables
below.

3. Configure the table as you need.
4. Click OK.
5. Locate the top left corner of the table. Do one of the following:

l Click the required place in the survey view.
l Specify the East and North coordinates in the appropriate editboxes at the bottom toolbar.

The table is created.

Fields of the Coordinate Table toolbar
Field Description

Column

Category Defines the entity type for the table. Select either points, or lines or arcs from
the drop-down list.

Available Contains the list of the available values for current selection entity type.

Current Contains the list of the values to be included into table.

Table

Name Defines the name of the table.

Current Selection Tick to include currently selected entities into the table. The appropriate
"Rows" editbox displayed the quantity of the selected entities.

210



Symbol Table icon

Field Description

Additional Empty
Rows

Tick to add empty rows to the table. If ticked, type the quantity of empty rows
in the appropriate "Rows" editbox.

Uppercase If ticked, all text in the table will be in uppercase.

Fit Text Tick to make table sizes automatically fit the text.

Buttons of the Coordinate Table dialog
Button Description

>> Click it to add the currently selected available value to the table.

<< Click it to remove currently selected value from the table.

Move Up Click it to move currently selected value up in the list. It means that the cor-
responding column of the table will be moved to the left.

Move Down Click it to move currently selected value down in the list. It means that the cor-
responding column of the table will be moved to the right.

Comment Click it to add the empty "Comments" column.

Restore Click it to restore the default values set.

Properties Click it to edit the properties of the table. For more information, refer to "Table
properties" section on page 571.

OK Click it to save changes and place the coordinate table in the survey view.

Cancel Click it to close the dialog without adding the coordinate tablet to the survey
view.

Symbol Table icon
The Symbol Table icon of the Feature group allows you to add a table, containing information about how the sym-
bols are used in the project.

To create a symbol table:
1. In the Feature group of the Insert tab, click the Symbol Table icon.

The Symbol Table dialog is displayed. Fields and buttons of the dialog are described below.
2. Fill in the table. Do the following:

1. In the Symbol column, select the required symbol from the drop-down list.
2. In the Description column type the description of the symbol usage.

3. If needed, configure the additional parameters of the table.
4. Click OK.
5. Locate the top left corner of the table. Do one of the following:

l Click the required place in the survey view.
l Specify the East and North coordinates in the appropriate editboxes at the bottom toolbar.

The table is created.
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Fields of the Symbol Table dialog
Field Description

Symbol Defines the symbols to be placed into the table.

Description Defines the description of the symbols in the table.

Table

Name Defines the name of the table.

Rows The first Rows editbox displayed the quantity of the selected entities.

Additional Empty
Rows

Tick to add empty rows to the table. If ticked, type the quantity of empty rows
in the second Rows editbox.

Uppercase If ticked, all text in the table will be in uppercase.

Fit Text Tick to make table sizes automatically fit the text.

Center Symbol Tick to place symbols in the center of the cell, regardless of the defined inser-
tion style.

Buttons of the Symbol Table dialog
Field Description

From Job Click it to insert all symbols, used in the current project.

From Library Click it to insert all symbols from the library.

Current Selec-
tion Click it to insert all symbols, used in the current selection.

Insert Click it to insert a new row above the currently selected one.

Restore Click it to discard all changes.

Delete
Click it to delete a row.

TIP

Click the number of the required row to activate this button.

Append
LineStyles

Click it to switch to the Line Style Table dialog. For more information, refer to
"Line Style Table icon" section below.

Properties Click it to edit the properties of the table. For more information, refer to "Table
properties" section on page 571.

OK Click it to save changes and place the symbol table in the survey view.

Cancel Click it to close the dialog without adding the symbol tablet to the survey view.

Line Style Table icon
The Line Style Table icon of the Feature group allows you to add a table, containing information about how the
line styles are used in the project.

To create a line style table:
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1. In the Feature group of the Insert tab, click the Line Style Table icon.

The Line Style Table dialog is displayed. Fields and buttons of the dialog are described below.
2. Fill in the table. Do the following:

1. In the LineStyle column, select the required line style from the drop-down list.
2. In the Description column type the description of the line style usage.

3. If needed, configure the additional parameters of the table.
4. Click OK.
5. Locate the top left corner of the table. Do one of the following:

l Click the required place in the survey view.
l Specify the East and North coordinates in the appropriate editboxes at the bottom toolbar.

The table is created.

Fields of the Line Style Table dialog
Field Description

Symbol Defines the line styles to be placed into the table.

Description Defines the description of the line styles in the table.

Table

Name Defines the name of the table.

Rows The first Rows editbox displayed the quantity of the selected entities.

Additional Empty
Rows

Tick to add empty rows to the table. If ticked, type the quantity of empty rows
in the second Rows editbox.

Uppercase If ticked, all text in the table will be in uppercade.

Fit Text Tick to make table sizes automatically fit the text.

Center LineStyle Tick to place line styles in the center of the cell, regardless of the defined inser-
tion style.

Buttons of the "Symbol Table" dialog
Field Description

From Job Click it to insert all line styles, used in the current project.

From Library Click it to insert all line styles from the library.

Current Selec-
tion Click it to insert all line styles, used in the current selection.

Insert Click it to insert a new row above the currently selected one.

Restore Click it to discard all changes.

Delete
Click it to delete a row.

TIP

Click the number of the required row to activate this button.

Append Symbols Click it to switch to the "Symbol Table" dialog. For more information, refer to
"Symbol Table icon" section on page 211.
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Field Description

Properties Click it to edit the properties of the table. For more information, refer to "Table
properties" section on page 571.

OK Click it to save changes and place the line style table in the survey view.

Cancel Click it to close the dialog without adding the line styles table to the survey
view.

Line Annotation Table icon
The Line Annotation Table icon of the Feature group allows you to add the line annotation table to the survey
view.

When you tick Annotation and In Line Annotation Table checkboxes in the Line properties, the line is marked with
number, which is corresponds with the row in the line annotation table, which contains information about lines
lengths and bearings.

To create the line annotation table, in the Feature group of the Insert tab, click the Line Annotation Table icon.

To move the line annotation table, select it and grad to the required place by using the handles at the table
corners.

To configure the parameters of the line annotation table:
1. Do the double click inside the table.

The Annotation Table Settings dialog is displayed.
2. Make the required configurations in the Line Table group box of the dialog. Fields are described in the

table below.
3. Click OK.

Fields of the Line Table group box from the Annotation Table Settings dialog
Field Description

Insertion Point Defines the X (East) and Y (North) coordinates of the table bottom left corner.

Columns Defines the quantity of column sets.

Text Style Defines the text style, used in the table.

ID Text Style Defines the text style, used for line marks.

Sorted by Select the parameter for table data sorting.

Ascending Tick to sort the table data in the ascending order. If unticked, data will be sor-
ted in the descending order.

Display Tick to display the line annotation table in the survey view. If unticked, the line
annotation table will be invisible.

Buttons of the Annotation Table Settings dialog
Button Description

Reset Click it to restore the default settings.
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Button Description

Renumber Click it to renumber the line marks, starting from 1.

Refresh Click it to refresh the line annotation table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Arc Annotation Table icon
The Arc Annotation Table icon of the Feature group allows you to add the arc annotation table to the survey
view.

When you tick Annotation and In Arc Annotation Table checkboxes in the Arc properties, the arc is marked with
number, which is corresponds with the row in the line annotation table, which contains information about arc.

To create the arc annotation table, in the Feature group of the Insert tab, click the Arc Annotation Table icon.

To move the arc annotation table, select it and grad to the required place by using the handles at the table corners.

To configure the parameters of the arc annotation table:
1. Do the double click inside the table.

The Annotation Table Settings dialog is displayed.
2. Make the required configurations in the Arc Table group box of the dialog. Fields are described in the table

below.
3. Click OK.

Fields of the Arc Table group box from the Annotation Table Settings dialog
Field Description

Insertion Point Defines the X (East) and Y (North) coordinates of the table bottom left corner.

Columns Defines the quantity of column sets.

Text Style Defines the text style, used in the table.

ID Text Style Defines the text style, used for line marks.

Sorted by Select the parameter for table data sorting.

Ascending Tick to sort the table data in the ascending order. If unticked, data will be sor-
ted in the descending order.

Display Tick to display the arc annotation table in the survey view. If unticked, the arc
annotation table will be invisible.

Buttons of the Annotation Table Settings dialog
Button Description

Reset Click it to restore the default settings.

Renumber Click it to renumber the arc marks, starting from 1.

Refresh Click it to refresh the arc annotation table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Image/Pdf icon
The Image/Pdf icon of the Feature group allows you to add a picture from an image (*.bmp, *.jpeg, *.jpg, *.jp2,
*.tiff, *.tif, *.png, *.sid) or PDF (*.pdf) file to the survey view.

To add a picture to the survey view:
1. In the Feature group of the Insert tab, click the Image/Pdf icon.

The Open dialog is displayed.
2. Select the required file and click OK.
3. If you have selected a PDF (*.pdf) file, define the required page in the Extract Image dialog.

The picture is displayed in the center of the survey view.
4. To confirm insertion do one of the following:

l Left click in the survey view.
l Press Enter.

The picture is added.

You may move, resize and rotate the picture. To do that:
1. Click the required picture.

The picture is bordered with the yellow rectangle.
2. Use the following handles:

l Handle in the bottom left corner to move the picture.
l Handle in the bottom right corner to rotate the picture around the bottom left corner.
l Handle in the top right corner to resize the picture.

Double click on the picture opens the "Image" dialog. Fields are described in the table below.

Fields of the Image dialog
Field Description

Opaque Tick to place the picture in front of any entities.

Insertion Point Displays the East and North coordinates

Dimension Displays the height and width of the picture.

Rotation Displays the rotation angle of the picture. The positive direction in clockwise.

Attach icon
The Attach icon of the Feature group allows you to attach a picture from an image (*.bmp, *.jpeg, *.jpg, *.jp2,
*.tiff, *.tif, *.png, *.sid) or PDF (*.pdf) file to an existing entity in the survey view.

To attach a picture to an entity:
1. In the Feature group of the Insert tab, click the Attach icon.
2. Select the required entity in the survey view.

NOTE
If an entity was selected, when clicking the icon, the picture will be attached to it.

The Open dialog is displayed.
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3. Select the required file and Click OK.

The picture is attached to an entity.

To manage the attached pictures, use the Image Viewer. You may open it from the Edit Properties dialog for the
entity. For more information, refer to "Image Viewer" section on page 573.

Background Image icon
The Background Image icon of the Feature group allows you to add the background images to the survey view.

A background image is a picture, which is placed behind all entities in the project. Its aim is to help the user in the
design of the project – to simplify the creation of the existing objects and understanding of how new object will
interact with them. It may be satellite photo of the area, its map, etc. A background image may be calibrated,
which means that the area of the image will be matched to the entities in the survey view.

To add a background image to the survey view:
1. In the Feature group of the Insert tab, click the Background Image icon.

The Open dialog is displayed.
2. Select the required file and click OK.

The Insert Background Image dialog is displayed.
3. In the Background image name editbox, type the name of the background image.
4. From the Transparency drop-down list, select the required transparency of the background picture. 100% is

fully transparent (i.e. invisible) picture, 0% is fully opaque picture.
5. In the Position/Scale Image group box, select the required option for image positioning:

l From geo-reference file – select it to load the positioning data from the georeference ESRI World
File.

l By plotting scale – select it to define the position of the background by defining the scale between
the actual picture size and its size in the survey view and rotation of the image. See "Positioning by
plotting scale" section below for details.

l By Matching Points – select it to define the position of the background image by matching the point
entities in the survey view with the points at the image. See "Positioning by matching points" section
on the next page for details.

l Position by image – select it to define the position of the background image by picking the line on the
image and defining its length and bearing. See "Positioning by known line" section on the next page
for details.

6. Click OK.

The background image is added.

Positioning by plotting scale
When position a background image by known line, you need to specify the scale between the actual picture size
and its size in the survey view and rotation of the image

If you have selected the By plotting scale option in the Insert Background Image dialog, do the following:
1. In the Scale editbox, define the scale of the background image.
2. In the North Orientation editbox, define the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.
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3. Click OK.

The background image is added.

Positioning by matching points
If you have selected the By Matching Points option in the Insert Background Image dialog, do the following:

1. Pick the matching point entity. Do one of the following:
l Click the required point in the survey view.
l Type the required point number in the Number editbox at the bottom toolbar, and press Enter.

2. Click the corresponding point on the image.
3. Repeat steps 1 and 2 for all required points.
4. When finished, do the right click, and select Accept the image in the context menu.

The background image is added.

Positioning by known line
When position a background image by known line, you need to pick the known line and define its length and bear-
ing.

If you have selected the Position by image option in the Insert Background Image dialog, do the following:
1. In the Scale and Rotation group box, click Pick >>.
2. Pick the known line on the picture.
3. In the Actual Distance editbox, type the length of the known line.
4. Define the bearing of the known line. Do one of the following:

l In the Rotation editbox, define the bearing of the known line.
l In the North Orientation editbox, define the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.

5. Click OK.

The background image is added.

Link/Unlink icon
The Link/Unlink icon of the Feature group allows you to set/remove the connection between an existing entity in
the survey view and an image. If the entity to which the image is linked is selected, the image will be selected
too. If the linked entity is deleted, the image will also be removed. If the entity will be moved, scaled, etc., the
relative position of the image will be maintained. The image will also be displayed on drawings, along with the
entity.

To link/unlink an image:
1. In the Features group of the Insert tab, click the Link/Unlink icon.
2. In the survey view, select the required entity.
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NOTE
If an entity was selected, when clicking the icon, images will be linked to it.

3. In the survey view, select the image to be linked/unlinked.
4. When finished, press Esc.

The image is linked/unlinked to the entity.

View Attached/Linked icon
The View Attached/Linked icon of the g allows you to view the list of the images, which is attached or linked to
an entity in the survey view.

To view the attached/linked images:
1. In the Features group of the Insert tab, click the View Attached/Linked icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, theMAGNET Office will display the linked/attached
images for it.

The Image Viewer dialog is displayed, with the list of the attached images. For more information about the
image viewer, refer to "Image Viewer" section on page 573.
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Arrow group
The Arrow group from the Insert tab of the MAGNET Office ribbon allows you to draw arrows and dimensions.
It contains three icons, described in the table below.

Dimension icon
Click it to add a dimension to the survey view.

Arrow icon
Click it to add a simple arrow to the survey view.

Curved Arrow icon
Click it to add a curved arrow to the survey view.

Dimension icon
The Dimension icon of the Arrow group allows you to add a dimension entity to the survey view. A dimension is
the line with arrows on both ends, containing annotation of the dimension length, so it may be used for measuring
the distance between two points.

To create a dimension:
1. In the Arrow group of the Insert tab, click the Dimension icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. At the bottom toolbar, in the Offset editbox, specify the offset from the entities.
3. At the bottom toolbar, from the Style drop-down list, select the dimension style.
4. In the survey view, click the start point.
5. In the survey view, click the end point.

The dimension is added.

Fields of the bottom toolbar, when creating dimensions
Field Description

Offset Defines the offset of the dimension line from the entities.

Style Defines the style of the dimension.

Arrow icon
The Arrow icon of the Arrow group allows you to add arrows to the survey view.

To create an arrow:
1. In the Arrows group of the Insert tab, click the Arrow icon.
2. Click the required places in the survey view, to create segments of the arrow. Note that only the last seg-

ment will have the arrow head.
3. When finished, press Esc.

The message window prompts to save the arrow.
4. Click Yes.

The arrow is created.
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Curved Arrow icon
The Curved Arrow icon of the Arrow group allows you to add curved arrows to the survey view.

To create a curved arrow:
1. In the Arrows group of the Insert tab, click the Curved Arrow icon.
2. In the survey view, click the start and end points of the arrow.

The arrow is added to the survey view.
3. By using the handles, while holding the Shift key, configure the required shape of the arrow.

The arrow is created.
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Modify Tab
The Modify tab of the MAGNET Office ribbon contains control icons, which allows you to perform various modi-
fications of the existing entities in the survey view. It is separated to eight groups:

l "Point group" section on the facing page
l "Line group" section on page 230
l "Arc group" section on page 237
l "String group" section on page 247
l "Text group" section on page 261
l "Polygon Area group" section on page 268
l "Polyline group" section on page 273
l "Modify group" section on page 274
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Point group
The Point group from the Modify tab of the MAGNET Office ribbon allows you to modify the existing points in
the project. It contains five icons and one second level icons, described in the table below.

Edit Points icon
Click it to edit the existing points.

Renumber Points icon
Click it to renumber the existing points. This icon also contains the

second level icon. Click to see it.

Renumber String Points icon
Click it to renumber points from an existing string.

Create from Entity icon
Click it to create new points from the existing pointless entities in

the project.
Delete Points icon

Click it to delete points from the existing entities.

Edit Points icon
The Edit Points icon of the Point group allows you to edit several existing points at once.

To edit existing points:
1. In the Point group of the Modify tab, click the Edit Points icon.

The Multiple Point Edit dialog is displayed. Buttons of the dialog are described in the table below.
2. In the Selection Criteria group box, specify the required criteria for points selection. Fields are described in

the table below.
3. Click Find.
4. The list of the points, matching the defined search criteria is displayed at the right side of the dialog. If

needed, select the required points in it. If nothing selected, changes will be applied to all the points from the
list.

5. In the Properties to Change group box, make the required configurations. Fields are described in the table
below.

6. When finished, do one of the following:
l Click OK to apply the changes and close the dialog.
l Click Apply to apply changes without closing the dialog. Use this, if you need to perform more con-
figurations.

The properties of the points are changed.

Fields of the Multiple Point Edit dialog
Field Description

Selection Criteria
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Field Description

Select From

Defines the search space. Select one of the following values:
l All Layers— to search among points, located on all existing layers
l Active Layers— to search among points, located on the currently active
layers

l Selection— to search among points from the current selection.

Point Range
Defines the point alphanumerical range for search, from the lowest point num-
ber of the range to the highest one. Specify the lower and upper bounds of the
range in the appropriate editboxes.

Layer Range Defines the layer depth range for search, from the most bottom layer to the top
one. Select the required bound layers from the appropriate drop-down lists.

Code Range

Defines the code alphanumerical range for search.

To perform search by code range, tick the Has Code checkbox, and select the
required bound codes from the appropriate drop-down lists. If the Has Code
checkbox is not ticked, only points, which have not code will be selected.

Elevation Range

Defines the numerical elevation range for search.

To perform the search by elevation range, tick the Has Ele checkbox and spe-
cify the required bound elevations in the appropriate editboxes. If the Has Ele
editbox is not ticked, only points, which have not elevations, will be selected.

Use in Surface

Defines whether Use in Surface points will be included to selection, or not.
Use the following algorithm:

l If both Use in Surface and Yes/No checkboxes are ticked, only Use in
Surface points will be included into selection.

l If Use in Surface checkbox is ticked, and the Yes/No checkbox is not
ticked, all Use in Surface points will be excluded from selection.

Locked

Defines whether locked points will be included to selection, or not. Use the fol-
lowing algorithm:

l If both Locked and Yes/No checkboxes are ticked, only locked points
will be included into selection.

l If Locked checkbox is ticked, and the Yes/No checkbox is not ticked, all
locked points will be excluded from selection.

Color
Defines the color of the points to be included to selection. Select the required
color from the drop-down menu. Only points of the defined color will be
included to selection.

Properties to Change

Layer Defines layer to which the selected points will be moved.

Color Defines a color for the selected points displaying.

Point Mark Defines the mark for the selected points displaying.

Code Defines the code for the selected points.
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Field Description

Has Elev
Defines whether elevation of the selected points will be active.

Tick the On/Off checkbox to turn point elevations on. If On/Off checkbox is not
ticked, elevations will be deactivated.

Elevation
Defines the elevation of the selected points.

NOTE
The elevationmust be active for using this option.

Use in Surface
Defines whether the selected points may be used for DTM creation.

Tick the Yes/No checkbox to mark the points as Use in Surface. If the Yes/No
checkbox is not ticked, the point will may not be used for DTM creation.

Locked
Defines whether the selected points will be locked.

Tick the Yes/No checkbox to lock the points. If Yes/No checkbox is not ticked,
the point will not be locked.

Symbol Defines the symbol for the selected points. For more information about sym-
bols, refer to "Symbol icon" section on page 54.

X/Y Scale

Defines the selected points symbols scale for displaying. Some symbols are too
small; others are too big for correct displaying. To display them right, make
sure to select the appropriate scale. Note that some symbols are unscalable and
plot at the size they were designed.

Rotation
Defines the rotation of the selected point's symbols. Rotation value is
degrees. Rotations are absolute a value of the DDD.MMSS format will rotate
the symbol by specified angle.

Annotation Defines attributes to be displayed as the selected point's annotations.

Buttons of the Multiple Point Edit dialog
Button Description

Find Click it to find the points, matching specified search criteria.

Set Properties Click it to set current properties as the default for points. New points will be
created with these properties.

Get Properties Click it to load existing default properties for points

Annotations Set-
tings

Click it to configure the points annotation displaying. This button is active only
when at least one checkbox from the Annotation group box is ticked. For more
information refer to "Annotation icon" section on page 125.

Apply Click it to apply the changes without closing the dialog.

OK Click it to apply the changes and close the dialog.

Cancel Click it to close the dialog without applying changes.

Invert Click it to invert the points selection.

Clear Click it to remove the points selection.
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Renumber Points icon
The Renumber Points icon of the Point group allows you to automatically redefine the point numbers.

To renumber the points:
1. In the survey view select the required objects.

CAUTION
If no objects are selected, than all points in the project will be renumbered.

2. In the Point group of the Modify tab, click the Renumber Points icon.

The Renumber Points dialog is displayed.
3. Configure the renumbering as you need. Fields are described in the table below.
4. Click OK.

The points are renumbered and the report, containing information about the old and new names of the
points is displayed.

Non-editable fields of the "Renumber Points" dialog
Field Description

Points Selected Displays the quantity of the selected points. If no points selected, displays the
quantity of the points in the entire job.

Sel Lowest Pt No Displays the lowest point number in the current selection.

Sel Highest Pt No Displays the highest point number in the current selection.

Job Lowest Pt No Displays the lowest point number in the entire job.

Job Highest Pt No Displays the highest point number in the entire job.

Editable fields of the "Renumber Points" dialog
Field Description

Renumber All Select to renumber all points in the selection, with the new numbers starting
from the value, specified in the "Start Number" editbox.

Value to Add

Tick to add a specific value to all selected point numbers. Specify the value in
the appropriate editbox. It will be added to all selected points.

For example, if the value is 100, than the point 7 becomes 107 and the point
485 becomes 585.

An alphanumeric value may be used here as well. It will be added as the prefix
to the current point numbers.

For example, if the value is AA, than the point 7 becomes AA7 and the point
485 becomes AA485.

Range Tick to renumber only the points from the specific range. Specify the range in
the appropriate editbox.

Alphanumeric
numbers only

Select to renumber only the point with the alphanumeric numbers, with the new
numbers starting from the value, specified in the Start Number editbox.
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Field Description

Retain Num Part

Tick to remove the letters from the point numbers. If the point with the remain-
ing number already exists, the next from the job highest point number will be
used.

For example, the point AA7 becomes 7. If the 7 point already exists among
with the AA7, and the highest point number in the job is 485, the AA7 point
becomes 486.

Strip Underscore
Suffix/Prefix

Removes the underscore suffix and/or prefix, depending on the selected options
from the point number.

Start Number Defines the start value for point renumbering. By default it is the next from the
job highest point number.

By Number Order Select to arrange the renumbering in order of the existing numbers.

By Creation
Order Select to arrange the renumbering in order of the points creation.

Obey Layer
Order

Tick to arrange the renumbering in order of layers, starting from the bottom one
to the top one. Within one layer the selected arrangement method will be used.

Renumber String Points icon
The Renumber Sting Points icon of the Point group allows you to automatically redefine the numbers of points in
a particular string.

To renumber the string points:
1. In the survey view select the required string.
2. In the Point group of the Modify tab, click the Renumber String Points icon.

The Renumber Points dialog is displayed.
3. Configure the renumbering as you need. Fields are described in the table below.
4. Click OK.

The points are renumbered and the report, containing information about the old and new names of the points
is displayed.

Non-editable fields of the Renumber Points dialog
Field Description

Points Selected Displays the quantity of the selected points. If no points selected, displays the
quantity of the points in the entire job.

Sel Lowest Pt No Displays the lowest point number in the current selection.

Sel Highest Pt No Displays the highest point number in the current selection.

Job Lowest Pt No Displays the lowest point number in the entire job.

Job Highest Pt No Displays the highest point number in the entire job.
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Editable fields of the Renumber Points dialog
Field Description

Renumber All Select to renumber all points in the selection, with the new numbers starting
from the value, specified in the "Start Number" editbox.

Value to Add

Tick to add a specific value to all selected point numbers. Specify the value in
the appropriate editbox. It will be added to all selected points.

For example, if the value is 100, than the point 7 becomes 107 and the point
485 becomes 585.

An alphanumeric value may be used here as well. It will be added as the prefix
to the current point numbers.

For example, if the value is AA, than the point 7 becomes AA7 and the point
485 becomes AA485.

Range Tick to renumber only the points from the specific range. Specify the range in
the appropriate editbox.

Alphanumeric
numbers only

Select to renumber only the point with the alphanumeric numbers, with the new
numbers starting from the value, specified in the "Start Number" editbox.

Retain Num Part

Tick to remove the letters from the point numbers. If the point with the remain-
ing number already exists, the next from the job highest point number will be
used.

For example, the point AA7 becomes 7. If the 7 point already exists among
with the AA7, and the highest point number in the job is 485, the AA7 point
becomes 486.

Strip Underscore
Suffix/Prefix

Removes the underscore suffix and/or prefix, depending on the selected options
from the point number.

Start Number Defines the start value for point renumbering. By default it is the next from the
job highest point number.

Create from Entity icon
The Create from Entity icon of the Point group allows you to create points at pointless entities. New points will
be created at the same layer with the entity and with the same height.

To create points at the pointless entity:
1. In the survey view, select the required pointless entity.
2. In the Point group of the Modify tab, click the Create from Entity icon.

The message prompts you to display a report.
3. Click Yes or No as you need.

The points are created.

228



Delete Points icon

Delete Points icon
The Delete Points icon of the Point group allows you to delete points from entities. Strings after that become the
polylines.

To remove points from the entity:
1. In the survey view, select the required entity.
2. In the Point group of the Modify tab, click the Delete Points icon.

The message prompts you to display a report.
3. Click Yes or No as you need.

The points are deleted.

CAUTION
Properties of the deleted points cannot be restored. If you run this function accidentally, use
the Undo icon, or Ctrl+Z shortcut.
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Line group
The Line group from the Modify tab of the MAGNET Office ribbon allows you to edit the existing lines in the pro-
ject. It contains three icons and three second level icons, described in the table below.

Segment Line icon
Click it to divide a line to segments by adding points to it.

Move Point/Line icon
Click it to move an existing point or line.

Modify Line icon
This icon contains the list of the second level icons. Click to see it.

Insert Point into Line icon
Click it to move an existing point to an existing line/string.

Delete Point on Line
Click it to remove points from a collinear line

Flip Line icon
Click it to flip the start and end points of the line.

Segment Line icon
The Segment Line icon of the Line group allows you to divide an existing line or string into several segments,
either by defined segments length from the start point of the entity or by equal parts. See pictures below for
details.

Single distance line segmenting

Multiple distance line segmenting
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Equal distances line segmenting

Single distance string segmenting
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Multiple distance string segmenting

Equal distances string segmenting

The required segmentation may be configured at the input panel for this option, located at the bottom toolbar.
Fields are described in the table below.
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Fields of the input panel, when segmenting a line
Field Description

Distance
Defines the length of each segment. Measured from the start/end point of the
entity and from each new node in case of multiple segments. See pictures
above for details.

Divide by
Distance

Tick to divide the line/string to as many segments of length, specified in the
Distance editbox, as possible.

Segments Defines the quantity of segments for division.

Divide Equally Tick to divide the line/string to the segments of the same length.

Interpolate Z Tick to automatically calculate the elevations of the newly created nodes.

Fix Start Point

When ticked, the distance will always be measured from the start point of the
string, regardless of the segmenting.

NOTE
This field available only when segmenting strings.

TIP
The first field of the input panel displays the length of the selected entity.

Single distance segmenting
To divide a line or string:

1. In the Line group of the Modify tab, click the Segment Line icon.
2. In the survey view, click the required line or string. Note that the distance will be measured from the

start/end point, depending which is nearest to the place of clicking.
NOTE
If a line/string was selected, when clicking theSegment Line icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. Make sure, that the Segments editbox at the bottom toolbar has the value of "1".
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. Locate the new node. Do one of the following:

l Click the required place in the survey view.
l In the Distance editbox at the bottom toolbar, specify the required segment length.

The line/string is divided; the last created segment is selected for further division.
6. If needed, repeat the division.
7. When finished, press Esc.

Multiple distance segmenting
To divide a line or string to several segments:

1. In the Line group of the Modify tab, click the Segment Line icon.
2. In the survey view, click the required line or string. Note that the distance will be measured from the

start/end point, depending which is nearest to the place of clicking.
NOTE
If a line/string was selected, when clicking theSegment Line icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
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3. In the Distance editbox at the bottom toolbar, specify the required segment length.
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. Do one of the following:

l At the bottom toolbar, tick the Divide by Distance checkbox, to create as many segments of the
defined length as possible.

l In the Segments editbox at the bottom toolbar, specify the quantity of segments.
6. Confirm the segmentation. Do one of the following:

l Press Enter.
l Left click in the survey view.

The line/string is divided.

Equal distance segmenting
To divide a line or string to several segments:

1. In the Line group of the Modify tab, click the Segment Line icon.
2. In the survey view, click the required line or string. Note that the distance will be measured from the

start/end point, depending which is nearest to the place of clicking.
NOTE
If a line/string was selected, when clicking theSegment Line icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. In the Segments editbox at the bottom toolbar, specify the quantity of segments.
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. At the bottom toolbar, tick the Divide Equally checkbox.
6. Confirm the segmentation. Do one of the following:

l Press Enter.
l Left click in the survey view.

The line/string is divided.

Move Point/Line icon
The Move Point/Line icon of the Line group allows you to move an existing point or line to a new place, defined
as the bearing and distance from the original location.

To move a point/line:
1. In the Line group of the Modify tab, click the Move Point/Line icon.
2. In the survey view, select the required point/line. Note that the new position of the line will be defined

from the start/end point, depending which is nearest to the place of clicking.
3. Locate the new point/line position. Do one of the following:

l Click the required place in the survey view.
l At the bottom toolbar, specify the bearing and distance to the new position in the appropriate edit-
boxes.

The point/line is moved.
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Insert Point into Line icon
The Insert Point into Line icon of the Line group allows you to perpendicularly move an existing point to an exist-
ing line/string. After that, a line splits into two. A point moved to a string becomes a string node.

Insertion point into the line

To insert a point into a line/string:
1. In the Line group of the Modify tab, click the Insert Point into Line icon.
2. In the survey view, select the required line/string.
3. In the survey view, select the required point.

The point is moved to the line/string.
4. If needed, select more points.
5. When finished, press Esc.

Delete Point on Line
The Delete Point on Line icon of the Line group allows you to remove points from a multi segment collinear line.
The line segments will be converted to one line.
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Delete point on line

CAUTION
The start and end points cannot be deleted.

To delete a point from a line:
1. In the Line group of the Modify tab, click the Delete Point on Line icon.
2. If needed, in the Tolerance Angle editbox at the bottom toolbar, specify the required tolerance for line seg-

ments collinear.
3. In the survey view, select the required point.

The point is deleted.
4. If needed, delete more points.
5. When finished, press Esc.

Flip Line icon
The Flip Line icon of the Line group allows you to switch the start and end points of a line. The start point
becomes the end point, and the end point becomes the start point.

To flip a line:
1. In the Line group of the Modify tab, click the Flip Line icon.
2. In the survey view, select the required line.

The start and end points of the line is switched.
3. If needed, select more lines.
4. When finished, press Esc.
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Arc group
The Arc group from the Modify tab of the MAGNET Office ribbon allows you to edit the existing arcs. It contains
three icons and three second-level icons, described in the table below.

Segment Arc icon
Click it to divide an arc to segments by adding points on it.

Convert Arc icon
Click it to convert an arc from existing arc format to another.

Modify Arc icon
Click it to modify an existing arc. Click to see it.

Insert Point into Arc icon
Click it to move an existing point to an existing arc.

Delete Point on Arc
Click it to t to remove points from an existing arc.

Mirror Arc icon
Click it to "mirror" an existing arc.

Segment Arc icon
The Segment Arc icon of the Arc group allows you to divide an existing arc into several segments, either by
defined segments length from the start point of the entity or by equal parts. See pictures below for details.

Single distance arc segmenting
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Multiple distance arc segmenting

Equal distances arc segmenting

The required segmentation may be configured at the input panel for this option. It located at the bottom toolbar.
Fields are described in the table below.

Fields of the input panel, when segmenting an arc
Field Description

Distance
Defines the length of each segment. Measured from the start/end point of the
entity and from each new node in case of multiple segments. See pictures
above for details.

Divide by
Distance

Tick to divide the arc to as many segments of length, specified in the Distance
editbox, as possible.

Segments Defines the quantity of segments for division.

Divide Equally Tick to divide the arc to the segments of the same length.

Interpolate Z Tick to automatically calculate the elevations of the newly created nodes.
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Field Description

Fix Start Point When ticked, the distance will always be measured from the start point of the
arc, regardless of the segmenting.

TIP
The first field of the input panel displays the length of the selected entity.

Single distance segmenting
To divide an arc:

1. In the Arc group of the Modify tab, click the Segment Arc icon.
2. In the survey view, click the required arc. Note that the distance will be measured from the start/end point,

depending which is nearest to the place of clicking.
NOTE
If an arc was selected, when clicking theSegment Arc icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. Make sure, that the Segments editbox at the bottom toolbar has the value of "1".
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. Locate the new node. Do one of the following:

l Click the required place in the survey view.
l At the bottom toolbar, in the Distance editbox, specify the required segment length.

The arc is divided; the last created segment is selected for further division.
6. If needed, repeat the division.
7. When finished, press Esc.

Multiple distance segmenting
To divide an arc to several segments:

1. In the Arc group of the Modify tab, click the Segment Arc icon.
2. In the survey view, click the required arc. Note that the distance will be measured from the start/end point,

depending which is nearest to the place of clicking.
NOTE
If an arc was selected, when clicking theSegment Arc icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. In the Distance editbox at the bottom toolbar, specify the required segment length.
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. Do one of the following:

l At the bottom toolbar, tick the Divide by Distance checkbox, to create as many segments of the
defined length as possible.

l In the Segments editbox at the bottom toolbar, specify the quantity of segments.
6. Confirm the segmentation. Do one of the following:

l Press Enter.
l Left click in the survey view.

The arc is divided.
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Equal distance segmenting
To divide an arc to several segments:

1. In the Arc group of the Modify tab, click the Segment Arc icon.
2. In the survey view, click the required arc. Note that the distance will be measured from the start/end point,

depending which is nearest to the place of clicking.
NOTE
If an arc was selected, when clicking theSegment Arc icon, it will be used for division.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. In the Segments editbox at the bottom toolbar, specify the quantity of segments.
4. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elevation of the

new node.
5. At the bottom toolbar, tick the Divide Equally checkbox.
6. Confirm the segmentation. Do one of the following:

l Press Enter.
l Left click in the survey view.

The arc is divided.

Convert Arc icon
The Convert Arc icon of the Arc group allows you to convert an existing arc from the one arc type to another.

TIP
A 3-Point arc – an arc defined by the three points, which belong to one circumference.

A 2-Point arc – an arc defined by the two points, which belong to one circumference and the center
point. The center point is not saved as theMAGNETOffice point entity.

A centre point arc – an arc defined by the two points which belong to one circumference and the center
point. The center point is saved as theMAGNETOffice point entity.

To convert an arc:
1. In the Arc group of the Modify tab, click the Convert Arc icon.

The Convert Arc dialog is displayed. Fields are described in the table below.
2. In the Convert Arc dialog, make the required Convert From and Convert To configurations.
3. Click OK.
4. In the survey view, select the arc for conversion.

The arc is converted.
5. If needed, select more arcs.
6. When finished, press Esc.

Fields of the Convert Arc dialog
Field Description

Convert From
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Field Description

3 Point Arc When ticked, 3 point arcs will be used for conversion. Otherwise, 3 point arcs
will be unable for conversion.

2 Point Arc When ticked, 2 point arcs will be used for conversion. Otherwise, 2 point arcs
will be unable for conversion.

Center Point Arc When ticked, center point arcs will be used for conversion. Otherwise, center
point arcs will be unable for conversion.

Convert To

Defines the target arc type for conversion. Select the required type from the
drop-down list.

NOTE
The currently selected arc type is not available for selection at the Convert
From group box.

Delete Unused
Points

When ticked, the unused point will be deleted after conversion.

For example, when converting the center point arc to the 2 point arc, the cen-
ter point will be deleted.

Interpolate Elev-
ation

When ticked, the elevation of the newly created points will be interpolated
from the elevations of the existing points.

NOTE
This field available only when converting to the 3 point arc.

Use in Surface
Defines whether the newly created point may be used in surface or not.

NOTE
This field available only when converting to the 3 point arc.

Modify Arc icon
The Modify Arc icon of the Arc group allows you to modify an existing arc by changing its radius or tangent dis-
tance. See picture below for details.
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Arc radius and tangent distance

Fields of the input panel when modifying arcs
Field Description

Radius Defines the radius of the arc. See picture above for details.

Tangent Distance Defines the tangent distance of the arc. See picture above for details.

Modify Tangent
Lines

When ticked, the tangent lines of the arc will be modified along with the arc to
fit new parameters. Otherwise, tangent lines remain unchanged.

Orig. Radius Displays the original radius of the arc. See picture above for details.

Orig. Tan. Dist. Displays the original tangent distance of the arc. See picture above for details.

To modify an arc:
1. In the Arc group of the Modify tab, click the Modify Arc icon.
2. In the survey view, select the required arc.

NOTE
If an arc was selected, when clicking theModify Arc icon, it will be used.

The input panel is displayed at the bottom toolbar. Fields are described in the table above.
3. Do one of the following:

l In the survey view, move the points of the selected arc by using the mouse.
l In the Radius editbox at the input panel, type the required arc radius.
l In the Tangent Distance editbox at the input panel, type the required length of the tangent line.

4. Press Enter.
5. If needed, repeat for another arc.
6. When finished, press Esc.
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Insert Point into Arc icon
The Insert Point into Arc icon of the Arc group allows you to perpendicularly move an existing point to an exist-
ing arc. After that, an arc splits into two.

Insertion point into the arc
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To insert a point into an arc:
1. In the Arc group of the Modify tab, click the Insert Point into Arc icon.
2. In the survey view, select the required arc.

NOTE
If an arc was selected, when clicking the Insert Point into Arc icon, it will be used for point insertion.

3. In the survey view, select the required point.

The point is moved to the arc.
4. If needed, select more points.
5. When finished, press Esc.

Delete Point on Arc
The Delete Point on Arc icon of the Arc group allows you to remove points from a multi segment arc. The arc
segments will be converted to one arc.
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Delete point on arc

CAUTION
The start and end points cannot be deleted.

To delete a point from a line:
1. In the Arc group of the Modify tab, click the Delete Point on Arc icon.
2. In the survey view, select the required point.

The point is deleted.
3. If needed, delete more points.
4. When finished, press Esc.
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Mirror Arc icon
The Mirror Arc icon of the Arc group allows you to "mirror" an existing arc. See picture below for details. The
start and end points of the arc will be switched. The start point becomes the end point, and the end point becomes
the start point.

Mirroring arc

To mirror an arc:
1. In the Arc group of the Modify tab, click the Mirror Arc icon.
2. In the survey view, select the required arc.

The arc is mirrored. The start and end points of the arc is switched.
3. If needed, select more arcs.
4. When finished, press Esc.
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String group
The String group from the Modify tab of the MAGNET Office ribbon allows you to edit the existing strings. It con-
tains three icons and twelve second level icons, described in the table below.

Explode icon
Click it to convert string or polyline into points and individual lines.

Filter Points icon
Click it to reduce the number of points at a string.

Modify String icon
This icon contains the list of the second level icons. Click to see it.

Add Point icon
Click it to add existing points to an existing string/polygon.

Delete Point icon
Click it to remove points from an existing string/polygon.

Swap Points icon
Click it to flip the start and end points of the string segment.

Reverse icon
Click it to flip the start and end points of the string/polygon.

Join/Create icon
Click it to join existing strings in one entity.

Break String icon
Click it to divide one string to two connected strings.

Delete Segment icon
Click it to remove a segment from a string.

Intersect icon
Click it to add the intersection point for two crossing strings.

Convert to Polyline icon
Click it to convert an existing string to a polyline.

Create from Lines icon
Click it to create a string from the set of existing lines/arcs.

Densify Points icon
Click it to add more points to an existing string.

Edit String icon
Click it to edit an existing string.

Explode icon
The Explode icon of the String group allows you to convert an existing string/polyline/polygon/ to individual
lines/arcs/points.

To explode a string/polyline/polygon:
1. In the String group of the Modify tab, click the Explode icon.
2. In the survey view, select the required string/polyline/polygon.

NOTE
If a string/polyline/polygon was selected, when clicking the icon, it will be exploded.
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3. If you trying to explode a boundary, the confirmation message box appears. Click Yes.

The entity is exploded.

NOTE
Polylines don't have points. When exploding a polyline, the result will be lineswithout points. To create
points on them, use theCreate Points icon from the Point group of theModify tab. See "Create from
Entity icon" section on page 228 for details.

You may configure additional properties of explosion. To do so:
1. In the String group of the Modify tab, click the Explode icon.
2. Press O.

The Explode String dialog is displayed.
3. Select one of the following:

l Create 2 Point Arc— to explode an entity into 2 point arcs.
l Create 3 Point Arc — to explode an entity into 3 point arcs.
l Create Arc With Center Point— to explode an entity into arcs with center points.

4. If needed, tick the Set as Default Setting to use the configures settings as defaults.
5. Click OK.
6. In the survey view, select the required entity for explosion.

Filter Points icon
The Filter Points icon of the String group allows you to reduce the quantity of points on an existing string. This
option removes points from strings within the specified tolerance. See pictures below for details.

Tolerance
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Horizontal reducing

Vertical reducing

To filter points of an existing string:
1. In the String group of the Modify tab, click the Filter Points icon.

The Filter Tolerance dialog is displayed. Fields are described in the table below.
2. In the Filter Tolerance dialog, make the required configurations and click OK.
3. In the survey view, select the required string.

NOTE
If a string was selected, when clicking the icon, it will be used as the source string.

Points, matching the specified tolerance, are removed from the string.
4. If needed, select more strings.
5. When finished, press Esc.

Fields of the Filter Tolerance dialog
Field Description

Horizontal tol-
erance Defines the horizontal tolerance for point filtering.
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Field Description

Vertical tolerance

Defines the vertical tolerance for point filtering. To activate the vertical tol-
erance, tick the appropriate checkbox.

NOTE
When vertical filtering is not applied, points within the specified horizontal tol-
erance will be filtered regardless of the elevation. When vertical filtering is
applied, only points whichmatching both the horizontal and vertical tol-
erances will be filtered.

Filtered points

Retain
When selected, filtered points will be removed from the string, but not deleted
from the survey view. Tick the Set non-Use in Surface checkbox, to set them
non-use in surface.

Delete When selected, filtered points will be deleted from the line and the survey
view.

Add Point icon
The Add Point icon of the String group allows you to add an existing point to an existing string/polygon. A point
moved to a string becomes a string node. See picture below for details.
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Adding points to the string

To add a point to a string/polygon:
1. In the String group of the Modify tab, click the Add Point icon.
2. In the survey view, select the required string/polygon.

NOTE
If a string was selected, when clicking the icon, it will be used for points adding.

3. In the survey view, select the required point.

The point is added to the string/polygon.
4. If needed, select more points.
5. When finished, press Esc.

Delete Point icon
The Delete Point icon of the String group allows you to remove nodes from an existing string/polygon. See picture
below for details.
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Removing points from the string

To remove a point from a string/polygon:
1. In the String group of the Modify tab, click the Delete Point icon.
2. In the survey view, select the required string/polygon.

NOTE
If a string was selected, when clicking the icon, it will be used for points removing.

3. Select the required point.

The point is removed from the string/polygon.
4. If needed, select more points.
5. When finished, press Esc.

Swap Points icon
The Swap Points icon of the String group allows you to switch the start and end points of a string segment. The
start point becomes the end point, and the end point becomes the start point. See picture below for details.
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Swapping string segment

To swap a string segment:
1. In the String group of the Modify tab, click the Swap Points icon.
2. In the survey view, select the required string.
3. Select the required segment.

The start and end points of the segment is switched.
4. If needed, select more segments.
5. When finished, press Esc.

Reverse icon
The Reverse icon of the String group allows you to switch the start and end points of an existing string/polygon.
The start point becomes the end point, and the end point becomes the start point.

To reverse a string/polygon:
1. In the String group of the Modify tab, click the Reverse icon.
2. In the survey view, select the required string/polygon.

The start and end points of the string/polygon is switched.
3. If needed, select more strings/polygons.
4. When finished, press Esc.

Join/Create icon
The Join/Create icon of the String group allows you to join existing strings/lines and combine them in one entity.
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To join existing strings/lines:
1. In the String group of the Modify tab, click the Join/Create icon.

The Join/Create Strings with Common Point dialog is displayed. Fields are described in the table below.
2. In the Connection Method group box, select the required method. See pictures below for details.
3. If needed, configure more parameters.
4. Click OK.
5. In the survey view, continuously select the two required strings.

The strings are joined.
6. If needed, select more pairs of strings.
7. When finished, press Esc.

Fields of the Join/Create Strings with Common Point dialog
Field Description

Join gaps between

Define the range of gaps between line end points, which may be joined.
Strings, gaps between which are less or more than defined will not be joined.

Specify the gaps range in the appropriate editboxes, or click Pick and pick it in
the survey view.

Connection Meth-
ods Defines the way to connect two strings. See pictures below for details.

Join only in the
same layers When ticked only strings, which belong to the same layer may be joined.

Join only at the
same elevations

When ticked only strings, which endpoints have the same elevations may be
joined.
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Average endpoints connection method

Directly connect endpoint connection method
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Fillet with zero radius connection method

Break String icon
The Break String icon of the String group allows you to divide a solid string to two connected strings. Each of
the new strings becomes independent entity.

To break a string:
1. In the String group of the Modify tab, click the Break String icon.
2. In the survey view, select the required string.
3. Select the break point.

The string is divided.

Delete Segment icon
The Delete Segment icon of the String group allows you to remove a segment from an existing solid string. If this
segment is located in the middle of the string, the string will be divided to two strings. Each of the new strings
becomes independent entity.

To delete a segment from a string:
1. In the String group of the Modify tab, click the Delete Segment icon.
2. In the survey view, select the required string.
3. Select the required segment.

The segment is deleted.

Intersect icon
The Intersect icon of the String group allows you to add a point to the intersection of two strings. The stings must
physically cross each other. Each existing string will be divided by this point into two. After all two strings turns
into four strings with one common point, each of them is independent entity.

To intersect strings:
1. In the String group of the Modify tab, click the Intersect icon.
2. In the survey view, select the required strings.

The input panel is displayed at the bottom toolbar, with the prompted properties for the intersection point.
3. Review the properties of the intersection point, if needed, change them.
4. To confirm the intersection point do one of the following:

l Left click in the survey view.
l Press Enter.

The intersection point is created.

Fields of the input panel for the intersection point, when creating points
Field Description

Number Defines the number of the intersection point.
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Field Description

East Displays the East (X) coordinate of the intersection point.

North Displays the North (Y) coordinate of the intersection point.

Elev Defines the elevation of the intersection point.

Code Defines the code of the intersection point.

Use in Surface Defines whether the intersection point may be used in surface or not.

Interpolate Elev-
ation Defines whether the elevation of the intersection point will be interpolated.

Convert to Polyline icon
The Convert to Polyline icon of the String group allows you to convert an existing string to a polyline. All points
from the string will be deleted.

To create a polyline from a string:
1. In the String group of the Modify tab, click the Convert to Polyline icon.
2. In the survey view, select the required string.

NOTE
If a string was selected, when clicking the icon, it will be converted to polyline.

The string is converted to a polyline.

Create from Lines icon
The Create from Lines icon of the String group allows you to convert the set of the connected independent
lines/arcs to a one solid string.

NOTE
Linesmust have common points.

To create a string from existing lines/arc:
1. In the survey view, select the required lines/arcs.
2. In the String group of the Modify tab, click the Create from Lines icon.

The string is created.

TIP
If not all selected lines/arcs are included into a new string, check for overlapping lines/arc and
verify that all selected entities are lines/arcs. Strings cannot be used in this function.

Densify Points icon
The Densify Points icon of the String group allows you to increase the quantity of points on an existing string.

To add more points to a string:
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1. In the String group of the Modify tab, click the Densify Points icon.
2. In the survey view, select the required string.

NOTE
If a string was selected, when clicking the icon, it will be used for points insertion.

The Densify Points dialog id displayed. Fields are described in the table below.
3. In the Densify Points dialog, specify the spacing for the new points in the appropriate editboxes.
4. If needed, configure more settings.
5. Click OK.
6. The new points are created on the string.

Fields of the Densify Points dialog
Field Description

Spacing
on Straight Seg-

ments
Defines the spacing for the new points at the straight segments of the string.

Spacing
on Curved Seg-

ments

Defines the spacing for the new points at the curved (created from arcs) seg-
ments of the string.

Interpolate Elev-
ations

When ticked, elevations of the newly created points will be interpolated from
existing values.

Use in Surface Defines whether the newly created point may be used in surface or not.

Edit String icon
The Edit String icon of the String group allows you to edit an existing string.

To edit a string:
1. In the String group of the Modify tab, click the Edit String icon.
2. In the survey view, select the required string.

NOTE
If a string was selected, when clicking the icon, it will be used for editing.

The String Editor panel is displayed at the left side of the MAGNET Office window.
3. At the String Editor panel, make the required configurations. For more information, refer to "String Editor"

section on page 513.
4. When finished, click Close.

The string is edited.
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Text group
The Text group from the Modify tab of the MAGNET Office ribbon allows you to edit the existing text entities in
the project. It contains five icons and eight second level icons, described in the table below.

Convert icon
Click it to convert annotations to text.

Link icon
Click it to link the text to a project entity. This icon also contains the second-

level icon. Click to see it.

Unlink icon
Click it to unlink a text from an entity.

Rotate icon
Click it to rotate an existing text.

Annotation icon
This icon contains the list of the second level icons. Click to see it.

Create/Edit icon
Click it to create annotations for the existing entities.

Delete icon
Click it to delete existing annotations.

Table Settings icon
Click it to configure the annotation tables.

Align icon
This icon contains the list of the second level icons. Click to see it.

Left icon
Click it to set the alignment of the left edge of the text.

Right icon
Click it to set the alignment of the right edge of the text.

Top icon
Click it to set the alignment of the top edge of the text.

Bottom icon
Click it to set the alignment of the bottom edge of the text.

Convert icon
The Convert icon of the Text group allows you to convert entities annotations to the regular text entities.

To convert an annotation to text:
1. In the survey view, select the required entities.
2. In the Text group of the Modify tab, click the Convert icon.

The Annotation Conversion dialog is displayed.
3. In the Annotation Conversion dialog, make the required configurations and click OK.

The annotations are converted.
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Fields of the Annotation Conversion dialog
Field Description

To Text When selected, an annotation will be converted to a regular text entity.

To Linked Text When selected, an annotation will be converted to the text entity, linked to the
parent entity.

Created in
parent Layer

Defines whether the new text will be created in the same layer as the parent
entity, or in the current layer.

Link icon
The Link icon of the Text group allows you to set the connection between an existing entity in the survey view
and a text. If the entity to which the text is linked is selected, the text will be selected too. If the linked entity is
deleted, the text will also be removed. If the entity will be moved, scaled, etc., the relative position of the text
will be maintained. The text will also be displayed on drawings, along with the entity.

To link a text:
1. In the Text group of the Modify tab, click the Link icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, text will be linked to it.

3. In the survey view, select the required text entities to be linked.
4. When finished, press Esc.

The text is linked to the entity.

Unlink icon
The Unlink icon of the Text group allows you to remove the connection between an existing entity in the survey
view and a text.

To unlink a text:
1. In the Text group of the Modify tab, click the Unink icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, text will be linked to it.

3. In the survey view, select the required text entities to be unlinked.
4. When finished, press Esc.

The text is unlinked from the entity.

Rotate icon
The Rotate icon of the Text group allows you to rotate an existing text.

To rotate a text:
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1. In the Text group of the Modify tab, click the Rotate icon.
2. In the survey view, select the required text.

NOTE
If a text was selected, when clicking the icon, the text will be used for rotation.

The input panel is displayed at the bottom toolbar.
3. Define the rotation angle. Do one of the following:

l In the Angle editbox at the bottom panel, specify the required rotation angle.
l In the From Point and To Point editboxes at the bottom toolbar, specify the numbers of the points
which forms a line, to which the text will be set parallel.

l In the survey view, draw a line, to which the text will be set parallel.

The text is rotated.

Fields of the bottom toolbar when rotating text
Field Description

Angle Defines the text rotation angle.

From Point Defines the start point of a line, to which the text will be set parallel.

To Point Defines the end point of a line, to which the text will be set parallel.

Create/Edit icon
The Create/Edit icon of the Text group allows you to create annotation for existing entities.

To create annotations:
1. If needed, in the survey view, select the required entities.
2. In the Text group of the Modify tab, click the Create/Edit icon.

The Create Annotation dialog is displayed.
3. In the Create Annotation dialog, make the required configurations. Fields are described in the table below.
4. Click OK.

The annotations are created.

Fields of the Create Annotation dialog
Fields Description

Apply To Defines whether the annotations will be created for all existing entities or cur-
rently selected entities.

Create Defines the entities types for which annotations will be created.

Existing Annota-
tion When ticked, the existing annotations will be regenerated and refreshed.

Non-existing
Annotation

When ticked, the annotation for non-annotated entities will be created. Other-
wise, only existing annotations will be regenerated and refreshed.

Delete icon
The Delete icon of the Text group allows you to delete existing annotations.
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To delete annotations:
1. In the survey view, select the required entities.
2. In the Text group of the Modify tab, click the Delete icon.

The annotations are deleted.

Table Settings icon
The Table Settings icon of the Text group allows you to configure the parameters of the line/arc annotation
tables.

To configure the annotation table parameters:
1. In the Text group of the Modify tab, click the Table Settings icon.

The Annotation Table Settings dialog is displayed.
2. In the Line Table group box, make the required configurations.
3. In the Arc Table group box, make the required configurations.
4. Click OK.

The annotation tables are configured.

Fields of the Annotation Table Settings dialog
Field Description

Insertion Point Defines the X (East) and Y (North) coordinates of the table bottom left corner.

Columns Defines the quantity of column sets.

Text Style Defines the text style, used in the table.

ID Text Style Defines the text style, used for line marks.

Sorted by Select the parameter for table data sorting.

Ascending Tick to sort the table data in the ascending order. If unticked, data will be sor-
ted in the descending order.

Display Tick to display the line/arc annotation table in the survey view. If unticked, the
line/arc annotation table will be invisible.

Buttons of the Annotation Table Settings dialog
Button Description

Reset Click it to restore the default settings.

Renumber Click it to renumber the line/arc marks, starting from 1.

Refresh Click it to refresh the line/arc annotation table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Left icon
The Left icon of the Text group allows you to define the alignment of the left edge of the text.
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To align a text:
1. In the Text group of the Modify tab, click the Left icon.

The input panel is displayed at the bottom toolbar.
2. Define the alignment. Do one of the following:

l In the From Point and To Point editboxes at the bottom toolbar, specify the numbers of the points
which forms a line, to which the text will be aligned.

l In the survey view, draw a line, to which the text will be aligned.
l In the survey view, select the required line to which the text will be aligned.

3. In the survey view, select the required text.
NOTE
If a text was selected, when clicking the icon, the text will be used for alignment.

The text is rotated.

Fields of the bottom toolbar when rotating text
Field Description

From Point Defines the start point of a line, to which the text will be set parallel.

To Point Defines the end point of a line, to which the text will be set parallel.

Rotate text When ticked the text will be rotated to fits the alignment.

Perpendicular When ticked the text will rotated to be perpendicular to the alignment.

Invert Text When ticked the text will be flipped to fits the alignment.

Right icon
The Right icon of the Text group allows you to define the alignment of the right edge of the text.

To align a text:
1. In the Text group of the Modify tab, click the Right icon.

The input panel is displayed at the bottom toolbar.
2. Define the alignment. Do one of the following:

l In the From Point and To Point editboxes at the bottom toolbar, specify the numbers of the points
which forms a line, to which the text will be aligned.

l In the survey view, draw a line, to which the text will be aligned.
l In the survey view, select the required line to which the text will be aligned.

3. In the survey view, select the required text.
NOTE
If a text was selected, when clicking the icon, the text will be used for rotation.

The text is rotated.

Fields of the bottom toolbar when rotating text
Field Description

From Point Defines the start point of a line, to which the text will be set parallel.

To Point Defines the end point of a line, to which the text will be set parallel.
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Field Description

Rotate text When ticked the text will be rotated to fits the alignment.

Perpendicular When ticked the text will rotated to be perpendicular to the alignment.

Invert Text When ticked the text will be flipped to fits the alignment.

Top icon
The Top icon of the Text group allows you to define the alignment of the top edge of the text.

To align a text:
1. In the Text group of the Modify tab, click the Top icon.

The input panel is displayed at the bottom toolbar.
2. Define the alignment. Do one of the following:

l In the From Point and To Point editboxes at the bottom toolbar, specify the numbers of the points
which forms a line, to which the text will be set parallel.

l In the survey view, draw a line, to which the text will be set parallel.
l In the survey view, select the required line.

3. In the survey view, select the required text.
NOTE
If a text was selected, when clicking the icon, the text will be used for rotation.

The text is rotated.

Fields of the bottom toolbar when rotating text
Field Description

From Point Defines the start point of a line, to which the text will be set parallel.

To Point Defines the end point of a line, to which the text will be set parallel.

Rotate text When ticked the text will be rotated to fits the alignment.

Perpendicular When ticked the text will rotated to be perpendicular to the alignment.

Invert Text When ticked the text will be flipped to fits the alignment.

Bottom icon
The Bottom icon of the Text group allows you to define the alignment of the bottom edge of the text.

To align a text:
1. In the Text group of the Modify tab, click the Bottom icon.

The input panel is displayed at the bottom toolbar.
2. Define the alignment. Do one of the following:

l In the From Point and To Point editboxes at the bottom toolbar, specify the numbers of the points
which forms a line, to which the text will be set parallel.
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l In the survey view, draw a line, to which the text will be set parallel.
l In the survey view, select the required line.

3. In the survey view, select the required text.
NOTE
If a text was selected, when clicking the icon, the text will be used for rotation.

The text is rotated.

Fields of the bottom toolbar when rotating text
Field Description

From Point Defines the start point of a line, to which the text will be set parallel.

To Point Defines the end point of a line, to which the text will be set parallel.

Rotate text When ticked the text will be rotated to fits the alignment.

Perpendicular When ticked the text will rotated to be perpendicular to the alignment.

Invert Text When ticked the text will be flipped to fits the alignment.

267



Modify tab

Polygon Area group
The Polygon Area group from the Modify tab of the MAGNET Office ribbon allows you to edit existing polygons.
It contains three icons and one second level icon, described in the table below.

Convert to String icon
Click it to convert an existing polygon to the closed string.

Bring to Front icon
Click it to display polygon in front of all other entities.

Add Point icon
Click it to add new points to a polygon. This icon also contains the second-

level icon. Click to see it.

Delete Point icon
Click it to remove points from the polygon.

Convert to String icon
The Convert to String icon of the Polygon Area group allows you to replace an existing polygon with the closed
string.

To convert a polygon to a string:
1. In the Polygon Area group of the Modify tab, click the Convert to String icon.
2. In the survey view, select the required polygon.

NOTE
If a polygon was selected, when clicking the icon, it will be converted to string.

The polygon is converted to the closed string.

NOTE
This function works also for the polygon based entities— lot, pad, and boundary.

Bring to Front icon
The Bring to Front icon of the Polygon Area group allows you to display an existing polygon in front of another
existing polygon and other entities.

To display a polygon in front:
1. In the Polygon Area group of the Modify tab, click the Bring to Front icon.
2. In the survey view, select the required polygon.

NOTE
If a polygon was selected, when clicking the icon, it will be displayed in front.

The polygon is converted to the closed string.

NOTE
This function works also for the polygon based entities— lot, pad, and boundary.
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Add Point icon
The Add Point icon of the Polygon Area group allows you to add an existing point to an existing polygon/string. A
point moved to a polygon becomes a polygon node. See picture below for details.

Adding points to the polygon
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To add a point to a polygon/string:
1. In the Polygon Area group of the Modify tab, click the Add Point icon.
2. In the survey view, select the required polygon/string.

NOTE
If a polygon/string was selected, when clicking the icon, it will be used for points adding.

3. In the survey view, select the required point.

The point is added to the polygon/string.
4. If needed, select more points.
5. When finished, press Esc.

NOTE
This function works also for the polygon based entities— lot, pad, and boundary.

Delete Point icon
The Delete Point icon of the Polygon Area group allows you to remove nodes from an existing polygon/string.
See picture below for details.

270



Delete Point icon

Removing points from the polygon

To remove a point from a polygon/string:
1. In the Polygon Area group of the Modify tab, click the Delete Point icon.
2. In the survey view, select the required polygon/string.
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NOTE
If a polygon was selected, when clicking the icon, it will be used for points removing.

3. Select the required point.

The point is removed from the polygon/string.
4. If needed, select more points.
5. When finished, press Esc.

NOTE
This function works also for the polygon based entities— lot, pad, and boundary.
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Polyline group
The Polyline group from the Modify tab of the MAGNET Office ribbon allows you to edit existing polylines. It
contains three icons, described in the table below.

To String icon
Click it to convert an existing polyline to the string.

Close String/Polyline icon
Click it to close an existing string/polyline.

Open String/Polyline icon
Click it to open an existing closed string/polyline.

To String icon
The To String icon of the Polyline group allows you to replace an existing polyline with the string.

To convert a polyline to a string:
1. In the Polyline group of the Modify tab, click the To String icon.
2. In the survey view, select the required polyline.

NOTE
If a polyline was selected, when clicking the icon, it will be converted to string.

New points are created at polyline nodes. The message window prompts to set new points as Use in Sur-
face.

3. Click Yes or No as you need.

The polyline is converted to the string.

Close String/Polyline icon
The Close String/Polyline icon of the Polyline group allows you to close an existing polyline or string by inserting
additional segment, connecting the last and the first nodes of the polyline or string.

To close a polyline/string:
1. In the Polyline group of the Modify tab, click the Close String/Polyline icon.
2. In the Survey view, select the required polylines/strings.
3. When finished, press Esc.

Open String/Polyline icon
The Open String/Polyline icon of the Polyline group allows you to close an existing polyline or string by inserting
additional segment, connecting the last and the first nodes of the polyline or string.

To close a polyline/string:
1. In the Polyline group of the Modify tab, click the Close String/Polyline icon.
2. In the Survey view, select the required polylines/strings.
3. When finished, press Esc.

273



Modify tab

Modify group
The Modify group from the Modify tab of the MAGNET Office ribbon allows you to perform various basic con-
figurations of the existing entities. It contains nine icons, described in the table below.

Copy icon
Click it to copy an existing entity.

Move icon
Click it to move an existing entity.

Rotate icon
Click it to rotate an existing entity.

Rotate by direction icon
Click it to rotate an entity by direction.

Align icon
Click it to align an existing entity to another.

Scale icon
Click it to scale an existing entity.

Offset icon
Click it to move an existing line, arc or circle.

Properties icon
Click it to manually edit properties of an existing entity.

Match icon
Click it to copy properties from one existing entity to another.

Extend/Trim Line icon
Click it to edit length of an existing line. This icon also contains the

second-level icons. Click to see them.

Multiple Trim icon
Click it to trim several lines/arc at once

Extend All icon
Click it to extend an existing entity to the nearest line.

Trim All icon
Click it to trim an existing entity to the nearest line.

To Boundary icon
Click it to trim an existing line/arc/string to an existing boundary.

Delete by Bdy icon
Click it to trim an existing line/arc/string to an existing boundary.

Copy icon
The Copy icon of the Modify group allows you to copy an existing entity.

When creating a copy, you have to define the base and destination points for new copy. The position of the new
copy will be in the same correlation with the original entity, as the correlation of the base and the destination
point. For example, if the destination point has the 78 degrees bearing and 100 meters distance from the base
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point, each point of the copy will have the 78 degrees bearing and 100 meters distance from the corresponding
point of the original entity.

CAUTION
The base and destination points only define the correlation between the original entity and
copy position. The copy will not be placed to them.

To copy an entity:
1. In the Modify group of the Modify tab, click the Copy icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, it will be copied.

The input panel is displayed at the bottom toolbar.
3. Select the base for new copy. Do one of the following:

l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

4. Select the destination point for new copy. Do one of the following:
l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

The copy of the selected entity is added.

Move icon
The Move icon of the Modify group allows you to move an existing entity to the new place.

When moving an entity, you have to define the base and destination points for new copy. The new position will be
in the same correlation with the original position, as the correlation of the base and the destination point. For
example, if the destination point has the 78 degrees bearing and 100 meters distance from the base point, the new
position of each point of the entity will have the 78 degrees bearing and 100 meters distance from the cor-
responding point of the original position.

CAUTION
The base and destination points only define the correlation between the original and new
positions. The new position will not be at them.

To move an entity:
1. In the Modify group of the Modify tab, click the Move icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, it will bemoved.

The input panel is displayed at the bottom toolbar.
3. Select the base for new position. Do one of the following:

l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
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l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

4. Select the destination point for new position. Do one of the following:
l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

The entity is moved.

Rotate icon
The Rotate icon of the Modify group allows you to rotate an existing entity.

When rotating an entity, you have to define the base point for the rotation. The entity will be rotated around it. It
may be the node of the rotated entity, any existing point, or any place in the survey view. The positive direction of
rotation is clockwise.

To rotate an entity:
1. In the Modify group of the Modify tab, click the Rotate icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, it will be rotated.

The input panel is displayed at the bottom toolbar.
3. Select the base point for the rotation. Do one of the following:

l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

4. In the Rotation editbox at the bottom toolbar, specify the required rotation angle.

The Rotate Confirmation dialog is displayed. It contains information about the base point coordinates and
the defined rotation agnle.

5. If needed, in the Rotation editbox, change the rotation angle.
6. Click OK.

The entity is rotated.

Rotate by direction icon
The Rotate by direction icon of the Modify group allows you to define the rotation of an entity by two directions.
The angle between them is the angle of direction. The positive direction of rotation is counter clockwise.

When rotating an entity, you have to define the base point for the rotation. The entity will be rotated around it. It
may be the node of the rotated entity, any existing point, or any place in the survey view.

To rotate an entity:
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1. In the Modify group of the Modify tab, click the Rotate by direction icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, it will be rotated.

The input panel is displayed at the bottom toolbar.
3. Select the base point for the rotation. Do one of the following:

l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

4. Define the reference direction. Do one of the following:
l Set existing points as the start and end points of the direction. You may either specify their names in
the From Point and To Point editboxes at the bottom toolbar, or click required points in the survey
view.

l Click the required places in the survey view.
5. Define the new direction. Do one of the following:

l Set existing points as the start and end points of the direction. You may either specify their names in
the From Point and To Point editboxes at the bottom toolbar, or click required points in the survey
view.

l Click the required places in the survey view.

The entity is rotated.

Align icon
The Align icon of the Modify group allows you to align and scale an existing entity to another entity or set of
points. Points may be both MAGNET Office point entities and any places in the survey view. See picture below
for details.
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Align

To align an entity:
1. In the Modify group of the Modify tab, click the Align icon.
2. In the survey view, select the required entity.

The input toolbar is displayed at the bottom toolbar. Fields are described in the table below.
3. Define the first source point. Do one of the following:

l Click the required point/place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the exiting point.
l In the East and North editboxes at the bottom toolbar, specify the required coordinates.

4. Define the first destination point in the same way.

The yellow arrow is displayed in the survey view, from the source to the destination point.
5. Define the second source and destination points.

The message window prompts to apply the scale.
6. Click Yes.

The entity is aligned.

Fields of the bottom toolbar, when aligning an entity
Field Description

Number Defines the number of the source/destination point.

East Defines the East (X) coordinate of the source/destination point.

North Defines the North (Y) coordinate of the source/destination point.

Scale icon
The Scale icon of the Modify group allows you to rotate an existing entity.

To scale an entity:
1. In the Modify group of the Modify tab, click the Scale icon.
2. In the survey view, select the required entity.

NOTE
If an entity was selected, when clicking the icon, it will be scaled.

The input panel is displayed at the bottom toolbar.
3. Select the base point. Do one of the following:

l Click the required place in the survey view.
l In the Number editbox at the bottom toolbar, specify the number of the existing point.
l In the East and North editboxes at the bottom toolbar, specify the appropriate coordinates of the
required place.

4. In the Rotation editbox at the bottom toolbar, specify the required rotation angle.

The Rotate Confirmation dialog is displayed. It contains information about the base point coordinates and
the defined rotation agnle.

5. If needed, in the Rotation editbox, change the rotation angle.
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6. Click OK.

The entity is rotated.

Offset icon
The Offset icon of the Modify group allows you to move an existing entity to the defined distance.

To move an entity:
1. In the Modify group of the Modify tab, click the Offset icon.
2. In the survey view, select the required entity.
3. In the Offset editbox at the bottom toolbar, specify the required distance for moving.
4. If you want to create a copy, and save the original entity, tick the Keep the original checkbox.
5. Press Enter.
6. In the survey view, select from which side of the existing string the new one will be placed.

The entity is moved/copied.

Properties icon
The Properties icon of the Modify group allows you to edit the properties of the selected object or group of
objects. Its shortcut key is Alt+Enter.

To edit object's properties:
1. In the survey view, select the required entity.
2. In the Modify group of the Modify tab, click the Properties icon.

The "Edit Properties" dialog is displayed.
3. Make the required configuration. For more information refer to "MAGNET Office entities properties" sec-

tion on page 545.
4. Click OK.

NOTE
This icon has the same functionality as the Properties icon from the Properties group of the Edit tab.

Match icon
The Match icon of the Modify group allows you to copy the properties from one exiting entity to another.

To copy the properties:
1. In the Modify group of the Modify tab, click the Match icon.
2. In the survey view, select the source entity.
3. In the survey view, select the target entity.

The properties are copied.
4. If needed, select more target entities.
5. When finished, press Esc.
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Extend/Trim Line icon
The Extend/Trim Line icon of the Modify group allows you to change the length of an existing line/arc/string.

To change the length of a line/arc/string
1. In the Modify group of the Modify tab, click the Extend/Trim Line icon.
2. In the survey view, select the required line/arc/string.

The input panel is displayed at the bottom toolbar.
3. In the Length editbox at the bottom toolbar, specify the required length of the entity.

The length of the line/arc/string is changed.

Multiple Trim icon
The Multiple Trim icon of the Modify group allows you to change the length of several existing lines/arcs at
once.

The reference line/arc is used for this option, to define the trim. See picture below for details.
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Multiple trim

To trim several lines/arc at once:
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1. In the Modify group of the Modify tab, click the Multiple Trim icon.
2. In the survey view, select the reference line/arc.
3. In the Offset editbox at the bottom toolbar, specify the required offset of the cutting line.
4. In the survey view select the required lines/arcs to be trimmed.

Extend All icon
The Extend All icon of the Modify group allows you to extend an existing line/arc/string to the nearest line/ar-
c/string.

To extend lines/arcs/strings:
1. In the Modify group of the Modify tab, click the Extend All icon.
2. In the survey view, continuously select the required lines/arcs/strings.
3. When finished, press Esc.

Trim All icon
The Trim All icon of the Modify group allows you to trim an existing line/arc/string to the nearest line/arc/string.

To trim lines/arcs/strings:
1. In the Modify group of the Modify tab, click the Trim All icon.
2. In the survey view, continuously select the required lines/arcs/strings.
3. When finished, press Esc.

To Boundary icon
The To Boundary icon of the Modify group allows you to trim an existing line/arc/string to an existing boundary.

To trim a line/arc/string to a boundary:
1. In the Modify group of the Modify tab, click the To Boundary icon.
2. In the survey view, select the required line/arc/string.
3. Select the required boundary. Do one of the following:

l In the survey view, click the required boundary.
l From the Boundary drop-down list at the bottom toolbar, select the required boundary.

4. At the bottom toolbar, click Trim.
5. The Extend/Trim Options dialog is displayed.
6. In the Extend/Trim Options dialog, make the required configurations. Fields are described in the table

below.
7. Click OK.

The line/arc/string is trimmed.
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Fields of the Extend/Trim Options dialog
Field Description

Extend to Bound-
ary

When ticked, the selected line will be moved to fits the boundary. See pictures
below for details.

Trim When ticked, the selected line will be trimmed, according to the selected
option. See pictures below for details.

Trim Outside When selected, the line part outside of the boundary will be trimmed. Inside
part remains the same. See pictures below for details.

Trim Inside When selected, the line part inside of the boundary will be trimmed. Outside
part remains the same. See pictures below for details.

Segment at Inter-
section

When selected the new point will be created at the intersection with the bound-
ary, dividing line into two. See pictures below for details.

Calculate Inter-
section Point Elev-

ation
When ticked, the elevated of the newly created point will be interpolated.

The original entities
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Extend to Boundary

Trim Outside
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Trim Inside

Segment at Intersection

Delete by Bdy icon
The Delete by Bdy icon of the Modify group allows you to delete all entities inside/outside of an existing bound-
ary.

To delete entities by a boundary:
1. In the Modify group of the Modify tab, click the Delete by Bdy icon.

The Delete By Boundary dialog is displayed.
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2. Define whether to delete objects inside, or outside of the boundary, by selecting appropriate radiobutton.
3. In the Layer group box, define from which layers objects will be deleted. Select one of the following radi-

obuttons:
l Active Layers— to delete objects from currently active layers only.
l All Layers— to delete objects from all layers.

4. In the Boundary group box, define the reference boundary. Select one of the options:
l By drawing the boundary of free shape. To do so:

1. Select the Freenand radiobutton.
2. Click OK.
3. In the survey view, draw the required boundary point by point.

Objects are deleted when you close the boundary.
l By drawing the rectangle boundary. To do so:

1. Select the By Window radiobutton.
2. Click OK.
3. In the survey view, draw the required boundary by defining its opposite corners position.

Objects are deleted.
l By using an existing boundary entity. To do so:

1. Select the By Boundary radiobutton.
2. From the drop-down list, select the required boundary.
3. Click OK.

Objects are deleted.

Fields of the Extend/Trim Options dialog
Field Description

Delete Inside Select to delete objects inside of boundary.

Delete Outside Select to delete objects outside of boundary.

Layer

Defines from which layers objects will be deleted. Select the required radi-
obutton:

l Active Layers— to delete objects from currently active layers only.
l All Layers— to delete objects from all layers.

Boundary

Defines the reference boundary. Select the required radiobutton:

Freehand— to draw the reference boundary of free shape.

By Window— to draw the rectangle reference boundary.
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Inquiry Tab
The Inquiry tab of the MAGNET Office ribbon contains control icons, which allows you to get information about
project entities. It is separated to three groups:

l "Inquiry group" section on the facing page
l "Report group" section on page 295
l "Calculate group" section on page 298
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Inquiry group
The Inquiry group from the Inquiry tab of the MAGNET Office ribbon allows you to get geodesic information
about project objects. It contains eight icons, described in the table below.

Point icon
Click it to view and edit point properties.

Bearing Distance icon
Click it to get information about distance and bearing between any two points.

Offset Distance icon
Click it to get the offset and distance between a point and a line/circle/arc/string.

Linear Distance icon
Click it to measure the linear distance of several objects.

Area icon
Click it to display information about an existing area.

Multiple Areas icon
Click it to display information about several existing enclosed areas.

Angle icon
Click it to calculate angle between two lines, defined by three points.

Mean Elevation icon
Click it to calculate the mean elevation for the selection of points.

Point icon
The Point icon of the Inquiry group allows you to view and edit information about an existing point.

To view the point information:
1. In the Inquiry group of the Inquiry tab, click the Point icon.
2. Select the required point. Do one of the following:

l In the survey view, click the required point.
l In the Point Name editbox at the bottom toolbar, specify the required point number.

The Edit Point dialog is displayed. Fields and buttons are described in the tables below.
3. Review the point properties. If needed, change them.
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The non-editable fields of the Edit Point dialog
Field Description

Point No.

A unique point identifier in the project database. One project cannot con-
tain two points with the same numbers. Point numbers or names may be
numeric or alphanumeric. The number or name is allocated when the point
is created automatically by the MAGNET Office or manually by user,
and cannot be changed after that.

Easting The east or X component of a point position.

Northing The north or Y component of a point position.

No of Linkages
The point is the basic entity, from which all other entities are derived. The
No of Linkages field indicates how many entities are depends on this
point.

The editable fields of the Edit Point dialog
Field Description

Code

An additional alphanumeric description, attached to the point. Point codes
are usually used for automatically assigning properties to points and for
controlling line string between points during the reduction process. The
feature codes and the properties are stored in the Survey Codes Library.

Elevation

The height, reduced level, or Z component of a point position.
MAGNET Office allows creating points with or without height. Tick near
the elevation editbox to activate it. An unticked mark means that the point
has no height.

Use in Surface Defines whether the point with the defined elevation may be included in a
digital terrain model.

Layer Defines layer to which the point belongs to.

Color Defines a color for point displaying.

Mark Defines displaying of each point on the screen.

Description Short description of the point.

Symbol
Defines appearance of the point both on the screen and on the printed
copy. You may choose symbol from the symbol library. For more inform-
ation about symbols, refer to "Symbol icon" section on page 54.

X/Y Scale

Defines the symbol scale for displaying. Some symbols are too small; oth-
ers are too big for correct displaying. To display them right, make sure to
select the appropriate scale. Note that some symbols are non-scalable and
plot at the size they were designed.

Rotation
Defines the rotation of the symbol. Rotation value is degrees. Rotations
are absolute a value of the DDD.MMSS format will rotate the symbol by
specified angle.
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Field Description

Locked Select it to lock the point, so its properties cannot be edited, and the point
cannot be moved with a mouse.

Annotation Defines attributes to be displayed as the point annotation.

The buttons of the Edit Point dialog
Button Description

Annotation Settings
Click it to configure the annotation displaying. This button is active only
when at least one checkbox from the Annotation group box is selected. For
more information refer to "Annotation icon" section on page 125.

Set Properties Click it to set current properties as the default for points. New points will
be created with these properties.

Get Properties Click it to load existing default properties for points.

Attributes Click it to add new attributes to the point.

Images/Pdfs
Click it to attach an image or a PDF to the point. The picture will be dis-
played near the point. For more information about configuring images,
refer to "Image Viewer" section on page 573.

Delete Click it to delete the point and close the dialog.

Apply Click it to apply changes.

Notes Click it to add a short note.

Symbols... Click it to manage extra symbols for the point.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Bearing Distance icon
The Bearing Distance icon of the Inquiry group allows you to measure bearing, distance and slope between two
existing points or any places in the survey view.

To measure the bearing/distance:
1. In the Inquiry group of the Inquiry tab, click the Bearing Distance icon.
2. Select the start point of the inquiry. Do one of the following:

l In the From Point editbox at the bottom toolbar, specify the required point number.
l Click the required point in the survey view.

3. Select the end point of the inquiry. Do one of the following:
l In the To Point editbox at the bottom toolbar, specify the required point number.
l Click the required point in the survey view.

The Inquire Bearing & distance window is displayed. It contains information about the start and end point;
plus bearing, distance, and slope between them.
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Offset Distance icon
The Offset Distance icon of the Inquiry group allows you to measure offset and distance between an existing
point and line/arc/string.

To measure the bearing/distance:
1. In the Inquiry group of the Inquiry tab, click the Bearing Distance icon.
2. In the survey view, select the line/arc/string, or two points to define a line.
3. Select the required point. Do one of the following:

l In the Point Name editbox at the bottom toolbar, specify the required point number.
l Click the required point in the survey view.

The Inquire Offset Distance window is displayed. It contains information about the offset and distance of
the selected point from the selected line/arc/string.

4. If needed, tick Label checkbox, to annotate the offset.
5. Click OK.

Linear Distance icon
The Linear Distance icon of the Inquiry group allows you to measure distance of existing lines, arcs, strings and
polylines.

To measure the distance:
1. In the survey view select the required objects.
2. In the Inquiry group of the Inquiry tab, click the Linear Distance icon.

The Inquire Linear Distance dialog is displayed. The Total Linear Distance field displays the total linear
distance of all selected entities.

3. From the Units drop-down list, select the required linear units.
4. If needed, tick the Generate Report checkbox. If so, select the information to be listed, by ticking the

appropriate checkboxes.
5. Click OK.

The linear distance report is displayed.

Area icon
The Area icon of the Inquiry group allows you to measure the area and perimeter of an existing polygon or poly-
gon based entity.

To measure the polygon area:
1. In the Inquiry group of the Inquiry tab, click the Area icon.
2. In the survey view, select the required polygon; or draw an enclosed area, by using existing points, lines,

arcs and stings.

The Area Calculation dialog is displayed. It contains information about the area, perimeter, centroid point
coordinates and quantity of nodes.

3. If needed, from the drop-down list to the right of the Area field, select the area units.
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4. If needed, tick the Label Area checkbox, to annotate the polygon with the text.
5. If needed, tick the Position Label checkbox, to manually locate the annotation text.
6. Click OK.
7. Locate annotation text as you need. See "Text icon" section on page 179 for details.

Multiple Areas icon
The Multiple Areas icon of the Inquiry group allows you to measure the area and perimeter of several existing
polygon based entities or enclosed strings.

NOTE
Enclosed areas, consists of lines/arcs cannot bemeasured by this function.

To measure the polygon area:
1. In the survey view, select the required objects.
2. In the Inquiry group of the Inquiry tab, click the Multiple Areas icon.

The Inquire Multiple Area dialog is displayed.
3. If needed, tick the Label Area checkbox, to annotate the polygon with the text.
4. If needed, tick the Position Total Area Label checkbox, to manually locate the annotation text of the sum-

mary area.
5. If needed, tick the Generate Report checkbox, to generate detailed report about selected areas.
6. Click OK.

Angle icon
The Angle icon of the Inquiry group allows you to measure angle between two lines/string segments or three
points.

To measure an angle:
1. In the Inquiry group of the Inquiry tab, click the Angle icon.
2. In the survey view select the required lines/string segments/points.

TIP

You may specify the numbers of the required points in the Point Name editbox at the bottom toolbar.

The Inquire Angle dialog is displayed. It contains information about points, defining the angle; internal and
external angles.

3. If needed, tick the Label checkbox, to annotate the internal or external angle with the text.
4. Click OK.

Mean Elevation icon
The Mean Elevation icon of the Inquiry group allows you to calculate mean elevation for the selection of points.

To measure a mean elevation:
1. In the survey view select the required set of points.
2. In the Inquiry group of the Inquiry tab, click the Mean Elevation icon.

The Inquire Mean Elevation dialog is displayed. It contains information about lowest, highest, and average
elevations; and quantity of the selected points.

3. Click OK to close the dialog.
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Report group
The Report group from the Inquiry tab of the MAGNET Office ribbon allows you to get the project information. It
contains five icons, described in the table below.

List Data icon
Click it to list the data of selected entities.

Duplicate Points icon
Click it to check the project for duplicated points.

Project Details icon
Click it to list the project details.

Compare Jobs icon
Click it to compare the current job with another job.

Images icon
Click it to list images in the project.

List Data icon
The List Data icon of the Report group allows you to list the information about all existing data in the project. It
has various filters to help you get the required information.

To list project data:
1. In the Report group of the Inquiry tab, click the List Data icon.

The List Data Selection dialog is displayed.
2. In the Select From group box, define the required selection range:

l All Data – select it to include to the listing all existing data.
l Active Layers – select it to include to the listing only data from the currently active layers.
l Current Selection – select it to include to the listing only currently selected objects.

3. Select the entities for listing, by checking the appropriate editboxes.

TIP

To select all possible entities, click All Entities.

4. If needed, define additional point filtering by point numbers, codes or heights. To do so:
1. Tick the appropriate editboxes.
2. Specify the range in the appropriate From and To editboxes.

5. If needed, define additional filtering by layer range. To do so:
1. Tick the Layer Range editbox.
2. Specify the range by selection the appropriate layers from the drop-down lists.

6. Click OK.

The report is displayed, containing information about the project data, according to user selections.
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Duplicate Points icon
The Duplicate Points icon of the Report group allows you to detect and delete duplicated points.

To detect duplicated points:
1. In the Report group of the Inquiry tab, click the Duplicate Points icon.

The Duplicated Points dialog is displayed.
2. In the Check Points group box define the area for duplicate searching. Select one of the following options:

l XY – select it to search horizontal duplicate points.
l XYZ – select it to search 3D duplicate points.

3. In the XY Tolerance editbox, specify the horizontal tolerance for duplicate points.
4. In the Z Tolerance editbox, specify the vertical tolerance for duplicate points.
5. Click OK.

The duplicated points are highlighted in the survey view.
6. Right click the survey view, and select the Delete item from the context menu.

The Delete Duplicated Points dialog is displayed.
7. Select the required option for duplicate points.
8. Click OK.

The selected option is performed, and the report for duplicated points is generated.

Project Details icon
The Project Details icon of the Report group allows you to generate a report with the information about the pro-
ject.

To display information about the project:
1. In the Report group of the Inquiry tab, click the Project Details icon.

The List Job Details dialog is displayed.
2. In the List Job Details dialog, make the required configurations. Fields are described in the table below.
3. Click OK.

The report with the project information is displayed.

Fields of the List Job Details dialog
Field Description

Current Job When selected, the information about the current project will be included into
report.

All Jobs When selected, the information about all projects from the defined directory
will be included into report.

Include Job
Description

When ticked, the project parameters, such as company, name, comment, etc.
will be included into report. See "Project details" section on page 580 for
details.

296



Compare Jobs icon

Compare Jobs icon
The Compare Jobs icon of the Report group allows you to compare the points from the current job with points
from another existing job.

To compare the jobs:
1. In the Report tab of the Inquiry tab, click the Compare Jobs icon.

The Points Comparison dialog is displayed.
2. In the Select From group box, define the source points area. Select one of the following radiobuttons:

l All Data – to include all existing point into comparison.
l Active Layers – to include to comparison only points from the currently active layers. Points from
inactive layers will not be included.

l Current Selection – to include to comparison only currently selected points. Unselected points will
not be included.

3. In the Comparison Job field, select the job for comparison.
4. In the XY Tolerance editbox, specify the horizontal tolerance for comparison. Points, distance between

which is more than specified tolerance will not be compared.
5. In the XY Minumum editbox, specify the minimum distance for comparison. Points, distance between which

is less than specified minimum will not be compared.
6. If needed to include the vertical part into comparing, in the Height group box, tick the Compare Z checbox,

and specify vertical tolerance and minimum in the appropriate editboxes.
7. Click OK.

The report, containing information about compared point's differences is displayed.

Images icon
The Images icon of the Report group allows you to search for the entities, which has the attached images.

To search for the images in the project:
1. In the Report group of the Inquiry tab, click the Images icon.

The Entities Selection dialog is displayed.
2. In the Select From group box, define the required selection range:

l Active Layers – select it to search for images in entities from the currently active layers.
l Current Selection – select it to search for images in entities only currently selected objects.

3. In the Select Entities groupbox, select the entities for search, by checking the appropriate editboxes.

TIP

To select all possible entities, click All Entities.

4. If needed, tick the Generate Report checkbox.
5. Click OK.

The entities, containing the attached images are highlighted.
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Calculate group
The Calculate group from the Inquiry tab of the MAGNET Office ribbon allows you to get the information so that
the surveyors can set out their job in the field. It contains two icons, described in the table below.

Inverse icon
Click it to generate an inverse report.

Stakeout icon
Click it to generate a stakeout point report.

Inverse icon
The Inverse icon of the Calculate group allows you to generate the inverse report. It contains information about
the bearing and distance between points with known coordinates.

It has three report options:
l Radiations – one point is defined as occupied point and the MAGNET Office calculate bearings and dis-
tances from this point to the specified points. See "Radiations inverse" section below for details.

l Traverse – the occupied is defined, the MAGNET Office calculates bearing and distance between this
point and the specified point, and them moves the occupied point to the specified point. See "Traverse
inverse" section on the facing page for details.

l Two Points – MAGNET Office calculate bearing and distance between specified pair if points. The first
selected point is used as the occupation point. See "Two points inverse" section on page 300 for details.

Radiations inverse
In the radiations inverse mode, one point is occupied and all the inverse come from the occupation point to the
specified points.

To generate the inverse report by using the radiation method:
1. In the Calculate group of the Inquiry tab, click the Inverse icon.

The Inverse Report Options dialog is displayed.
2. In the Options group box, select the Radiations radiobutton.
3. In the Modes group box, select one of the following:

l Bearing— to use the current bearing mode for direction defining. Zero angle will be defined as the
direction strict to the north from the occupied point. Positive direction is clockwise.

l Angle — in this mode the backsight point is required. Zero angle will be defined as the direction
from the occupied point to the backsight point. Positive direction is clockwise.

4. Click OK.
5. In the survey view, select the occupied point.
6. If you have selected the Angle option at the step 3, in the survey view, select the backsight point.

The report preview is displayed at the bottom toolbar.
7. In the survey view, select point for the report.
8. Repeat step 7 to add more points.
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9. When finished, press Esc.
10. At the bottom toolbar, click one of the following buttons:

l Save — to save the newly created report.
l Edit— to edit the newly created report in the report editor or the defined external editor.

NOTE
For external editor usage, it must be defined at the Preferences tab of theProgram Settings dia-
log. See "Program preferences" section on page 596 for details.

l Print— to print the newly created report.
l Close — to close the report panel without saving changes.

Traverse inverse
In the traverse inverse mode, inverse is performed between specified pair if points. The first selected point is used
as the occupation point

To generate the inverse report by using the traverse method:
1. In the Calculate group of the Inquiry tab, click the Inverse icon.

The Inverse Report Options dialog is displayed.
2. In the Options group box, select the Traverse radiobutton.
3. In the Modes group box, select one of the following:

l Bearing – to use the current bearing mode for direction defining. Zero angle will be defined as the
direction strict to the north from the occupied point. Positive direction is clockwise.

l Angle – in this mode the backsight point is required. Zero angle will be defined as the direction from
the occupied point to the backsight point. Positive direction is clockwise.

4. Click OK.
5. In the survey view, select the first occupied point.
6. If you have selected the Angle option at the step 3, in the survey view, select the first backsight point.

The report preview is displayed at the bottom toolbar.
7. In the survey view, select the point for report.

The selected point is defined as the new occupied point.
8. If you have selected the Angle option at the step 3, in the survey view, select the backsight point.
9. Repeat steps 7 and 8 to add more points.
10. When finished, press Esc.
11. At the bottom toolbar, click one of the following buttons:

l Save – to save the newly created report.
l Edit – to edit the newly created report in the report editor or the defined external editor.

NOTE
For external editor usage, it must be defined at the Preferences tab of theProgram Settings dia-
log. See "Program preferences" section on page 596 for details.

l Print – to print the newly created report.
l Close – to close the report panel without saving changes.
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Two points inverse
In the two points inverse mode, occupation point continuously moves as the inverses are specified to each new
specified inverse point. Inversing around a property description is an example of a traverse inverse

To generate the inverse report by using the traverse method:
1. In the Calculate group of the Inquiry tab, click the Inverse icon.

The Inverse Report Options dialog is displayed.
2. In the Options group box, select the Two Points radiobutton.
3. In the Modes group box, select one of the following:

l Bearing – to use the current bearing mode for direction defining. Zero angle will be defined as the
direction strict to the north from the occupied point. Positive direction is clockwise.

l Angle – in this mode the backsight point is required. Zero angle will be defined as the direction from
the occupied point to the backsight point. Positive direction is clockwise.

4. Click OK.
5. In the survey view, select the occupied point.
6. If you have selected the Angle option at the step 3, in the survey view, select the first backsight point.

The report preview is displayed at the bottom toolbar.
7. In the survey view, select the point for report.
8. Repeat steps through 8 to 10 to add more points.
9. When finished, press Esc.
10. At the bottom toolbar, click one of the following buttons:

l Save — to save the newly created report.
l Edit— to edit the newly created report in the report editor or the defined external editor.

NOTE
For external editor usage, it must be defined at the Preferences tab of theProgram Settings dia-
log. See "Program preferences" section on page 596 for details.

l Print— to print the newly created report.
l Close — to close the report panel without saving changes.

Stakeout icon
The Stakeout icon of the Calculate group allows you to generate the stakeout report. It contains information
about the bearing and distance between the defined occupied point and other existing points with known coordin-
ates.

To generate the stakeout report:
1. In the Calculate group of the Inquiry tab, click the Stakeout icon.

The Setout Selection dialog is displayed.
2. In the Setout Selection dialog, make the required configurations. Fields of the dialog are described in the

table below.
3. Click OK.
4. In the survey view, select the occupied point.
5. If needed, in the survey view, select the backsight point.
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The report preview is displayed at the bottom toolbar.
6. If needed, select more occupied points.
7. When finished, press Esc.
8. At the bottom toolbar, click one of the following buttons:

l Save — to save the newly created report.
l Edit— to edit the newly created report in the report editor or the defined external editor.

NOTE
For external editor usage, it must be defined at the Preferences tab of theProgram Settings dia-
log. See "Program preferences" section on page 596 for details.

l Print— to print the newly created report.
l Close — to close the report panel without saving changes.

Fields of the Stakeout Selection dialog
Field Description

Select from

Defines the source points for stakeout report. Select one of the following
options:

l All – to use all existing points
l Selection – to use points from the current selection

Sort By

Defines the way of sorting the report. Select one of the following options:
l Number – to sort by point numbers.
l Bearing – to sort by bearings from the occupied point.
l Distance – to sort by distance from the occupied point.

Use Turned Angle
When ticked, the bearing is measured by using the backsight point. Zero angle
will be defined as the direction from the occupied point to the backsight point.
Positive direction is clockwise.

Maximum Radial
Distance

Defines maximum distance to points, which may be included to stakeout report.
Points, distance to which exceeds the specified value will not be included to
report.
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Survey Tab
The Survey tab of the MAGNET Office ribbon contains control icons, which allows you to work with the survey
instruments of the MAGNET Office. It is separated to five groups, described in the corresponding sections:

l "Survey group" section on the facing page
l "Adjustment group" section on page 304
l "Manual Entry group" section on page 309
l "Calculator group" section on page 312
l "Structure group" section on page 314
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Survey group
The Survey group from the Survey tab of the MAGNET Office ribbon allows you to work with the survey meas-
urements. It contains two icons, described in the table below.

Raw Data Editor icon
Click it to edit the raw data from the hardware.

Tools View icon
Click it to open the MAGNET Tools application.

Raw Data Editor icon
The Raw Data Editor icon of the Survey group allows you to edit raw measurements of various survey instru-
ments.

To edit a raw data:
1. In the Survey group of the Survey tab, click the Raw Data Editor icon.

The Raw Data Editor dialog id displayed. It contains the list of the existing raw data containers.
2. Do one of the following:

l Click New to create the new raw data container.
l Select an existing raw data container and click Open.

The raw data editor is opened. For more information, refer to "Raw data editor" section on page 528.

Buttons of the Raw Data Editor dialog
Button Description

New Click it to create the new raw data container.

Open Click it to open an existing raw data container for editing.

Rename Click it to rename an existing raw data container.

Delete Click it to delete an existing raw data container.

OK Click it to close the dialog.

Tools View icon
Click the Tools View icon of the Survey group to open the MAGNET Tools application.
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Adjustment group
The Adjustment group from the Survey tab of the MAGNET Office ribbon allows you to adjust an existing data in
the project. It contains three icons, described in the table below.

Control Points icon
Click it to create or edit control points.

Translate Rotate icon
Click it to translate, rotate or scale project entities.

LS Transformation icon
Click it to transform data from one coordinate system to another using a least

square transformation.

Traverse Adjustment icon
Click it to apply a traverse adjustment to a series of lines.

Control Points icon
The Control Points icon of the Point group allows you to manage the control points.

Control points are reference points at or near the project sight that provide access to the project coordinate sys-
tem. Control files contain coordinate data for the control points. In the case of GPS applications, they also
provide a mathematical link between the GPS and project coordinate systems.

To define existing points as the control points:
1. In the Adjustment group of the Survey tab, click the Control Points icon.

The Control Points dialog opened at the Control Points tab is displayed.
2. Click Pick.
3. Do one of the following:

l In the survey view, select the required.
l At the bottom toolbar, in the Number editbox, continuously specify the numbers of the required
points.

4. When finished, press Esc.
5. Double click point in the list.

The Control Point dialog is displayed.
6. Define the usage of this point for horizontal and vertical localization, by ticking the appropriate check-

boxes.
7. Specify the WGS84 coordinates in the appropriate editboxes.
8. Click OK.
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Translate Rotate icon
The Translate Rotate icon of the Adjustment group allows you to translate, rotate or scale project data. You may
also move the data to a new coordinate position, or rotate it around a nominated point.

To transform a data:
1. In the Adjustment group of the Survey tab, click the Translate Rotate icon.

The Translate/Rotate dialog is displayed.
2. In the Translate/Rotate dialog, make the required configurations. Fields are described in the table below.
3. Click OK.

The data is transformed.

Fields of the Translate/Rotate dialog
Field Description

Database

Defines the data for transformation. Select one of the following radiobuttons:
l All – all data in the project will be transformed.
l Active – only data from the currently active layers will be transformed.
l Selection – only currently selected data will be transformed.

DTM

Defines the surface for transformation. Select one of the following radi-
obuttons:

l All – all surfaces in the project will be transformed.
l None – no surfaces will be transformed.
l Current DTM – only current surface will be transformed.

Origin

Defines the reference point for transformation. All other entities will be trans-
formed relative to this point. It will be the start point of movement, it will
remain on its place when scaling. Rotation will be performed around this point.

You may define it in two ways:
l Specify the point number in the Point Name editbox. The Easting and
Notrhing editboxes will be filled in automatically with the coordinates of
the specified point.

l Specify the point coordinates in the Easting and Northing editboxes.

Destination Fields of this groupbox defines the destination point for data moving.

Point Name

Defines the destination point as the place in the survey view. It will be the
place, where origin point is moved. All other entities will be moved relative to
the origin point.

You may define it in two ways:
l Specify the point number in the Point Name editbox. The Easting and
Notrhing editboxes will be filled in automatically with the coordinates of
the specified point.

l Specify the point coordinates in the Easting and Northing editboxes.
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Field Description

Offset

Defines the destination point as the offset from the origin point. It will be the
place, where origin point is moved. All other entities will be moved relative to
the origin point.

You may define it two ways:
l Specify the bearing and distance of the offset in the appropriate edit-
boxes.

l Specify the coordinates increment/decrement. To do so:
1. Tick the Coordinate checkbox.

The Bearing and Distance editboxes are replaced with the East-
ing and Northing editboxes.

2. Specify the East and North coordinates increment/decrement in
the appropriate editboxes. For decrement defying use the negative
values.

Rotation Defines the rotation angle in degrees. Positive direction is clockwise.

Scale Defines the scale for transformation.

LS Transformation icon
The LS Transformation icon of the Adjustment group allows you to transform selected data from one coordinate
system or datum to another using a Least Squares Transformation. Ensure that at least three corresponding points
exist in each coordinate system within the project data.

To perform the LS transformation:
1. In the survey view, select the object to be transformed.
2. In the Adjustment group of the Survey tab, click the LS Transformation icon.

The LS Transformation dialog is displayed.
3. Click Add.
4. In the survey view, select the point to be transformed.
5. In the survey view, select the corresponded fixed point.

The points are connected with the yellow arrow.
6. If needed, repeat steps 4 and 5 to add more points.
7. When all required points are defined, press Esc.

The LS Transformation dialog is displayed, containing coordinate information.

TIP

To transform data without scaling it, tick the Scale Factor checkbox, and specify the value "1".

8. Click Compute to calculate the transformation parameters.
9. Review and analyze the result. Note any discrepancies, which may cause unacceptable errors.
10. Do one of the following:
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l To delete a line, select it and click Delete.
l To edit a line:

1. Select the required line and click Edit.

The LS Edit dialog is displayed.
2. Redefine the fixed and/or matching points and click OK.

11. Click Update DB to apply changes.

The data is transformed and moved. The transformation report is displayed.

Fields of the LS Transformation dialog
Field Description

Use When ticked, the appropriate line will be used in transformation.

Match Pt Displays the number of the matching point.

Easting Displays the East coordinate of the matching/fixed point.

Northing Displays the North coordinate of the matching/fixed point.

Fix Pt Displays the number of the fixed point.

E Residual Displays easting residuals.

N Residual Displays northing residuals.

Scale Factor
Displays the calculated transformation scale factor.

If checkbox is ticked, defines the used-specified scale factor.

Swing Displays the calculated transformation swing.

E Shift Displays the calculated transformation easting shift.

N Shift Displays the calculated transformation northing shift.

Traverse Adjustment icon
The Traverse Adjustment icon of the Adjustment group allows you to apply a traverse adjustment to a series of
selected points or lines.

To perform the traverse adjustment:
1. In the Adjustment group of the Survey tab, click the Traverse Adjustment icon.
2. In the survey view, continuously select the required points of the lines.
3. When finished, right click and select Adjust Traverse from the context menu.

The Traverse Adjustment dialog is displayed.
4. In the Traverse Type group box, select the required traverse type:

l Loop – starts and ends at the same point.
l Non-loop – starts and ends at different points. Requires a fixed coordinate for the traverse end point.

5. In the Adjustment group box, select the required method.
6. If you have selected Non-loop traverse type, specify the fixed point. Do one of the following:

l In the Fixed Pt editbox, specify the point number.
l Specify the required East, North and Height coordinates in the appropriate editboxes.

7. If needed, tick the Adjust Elevations checkbox.
8. Click Adjust.
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The adjustment is performed.
9. If needed, click Report to generate the adjustment report.
10. Click Finish to close the Traverse Adjustment dialog.

Fields of the Traverse Adjustment dialog
Field Description

Start Displays the number and the coordinates of the start point.

End Pt Displays the number and the coordinates of the end point.

Fixed Pt
In the loop mode, displays the number and coordinates of the fixed point.

In the non-loop mode, defines the number and coordinates of the fixed point for
the traverse end point.

E-Misclosure Displays the easting misclosure.

D-Misclosure Displays the distance misclosure.

N-Misclosure Displays the northing misclosure.

Total-Dist Displays the perimeter of the traverse.

H-Misclose Displays the height misclosure.

Miscl-Ratio Displays the misclosure accuracy as a ratio.
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Manual Entry group
The Manual Entry group from the Survey tab of the MAGNET Office ribbon allows you to manually enter data to
the project. It contains four icons, described in the table below.

Traverse Editor icon
Click it to manually add traverse data to the project.

LS Network Adjustment icon
Click it to perform a least square network adjustment.

Deed Entry icon
Click it to create or edit a deed entry.

Legal Description icon
Click it to add a legal description to the project.

Traverse Editor icon
The Traverse Editor icon of the Manual Entry group allows you to input traverse data for reduction and adjust-
ment. The traverse may be specified as observed angles, observed angles, quadrant bearings, bearings in units of
degrees, minutes and seconds, or decimal degrees or grads. Distances may be entered as slope or horizontal in
meters, feet, decimal feet, or links.

To edit traverses:
1. In the Manual Entry group of the Survey tab, click the Traverse Editor icon.

The Traverse Data Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new traverse.
l Select an existing traverse and click Open to edit it.

The Traverse Editor is displayed.
3. Make the required configurations. For more information refer to "Traverse editor" section on page 516.

LS Network Adjustment icon
The LS Network Adjustment icon of the Manual Entry group allows you to configure the LS network.

To manage a LS Network:
1. In the Manual Entry group of the Survey tab, click the LS Network Adjustment icon.

The Network Data Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new traverse.
l Select an existing traverse and click Open to edit it.

The LS Network Editor is displayed.
3. Make the required configurations.

Deed Entry icon
The Deed Entry icon of the Manual Entry group allows you to enter line and curve data that comprise deed
descriptions. You may:
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l Customize the data type and order displayed.
l Add or hide data columns using the right-click shortcut menu.
l Save deeds for future reference and drawing.
l Edit the order of the data entry by dragging the columns to place them in the required order.

To manage deed entries:
1. In the Manual Entry group of the Survey tab, click the Deed Entry icon.

The Deed Entry Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new deed entry.
l Select an existing deed entry and click Open to edit it.

The Deed Entries Editor is displayed.
3. Make the required configurations. For more information refer to "Deed Entry editor" section on page 538.

Legal Description icon
The Legal Description icon of the Manual Entry group allows you to generate the legal description of a land par-
cel and save it to the file or in the survey view.

To create a legal description:
1. In the Manual Entry group of the Survey tab, click the Legal Description icon.
2. In the survey view, select the required enclosed area.
3. MAGNET Office assumes a start point, indicated by a solid red circle. Do one of the following:

l Press Esc to accept the start point.
l In the survey view, select the required point.

4. Define the commencement path. Select the required point, line or string.
5. Select additional reference points. When finished, press Esc.

The Legal Description Settings dialog is displayed.
6. Review the parameters. If needed, change them.
7. Click OK.

The property description is displayed in the internal editor

Fields of the Legal Description Settings dialog
Field Description

Template Name

Defines the description template for the legal description creation.

Select an existing template from the drop down list, or create new, by clicking
Template. See "Legal description templates library" section on page 646 for
details.

Direction Defines the direction of the land parcel description.

Coordinate Prefix Defines the prefix for coordinate listing in the description.

Arc Description Defines terminology for curves description.

Area Unit Text Defines terminology for areas description.
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Field Description

Distance Unit
Text Defines terminology for distances description.

Major Cardinal
Direction Defines terminology for major cardinal directions description.

Minor Cardinal
Direction Defines terminology for minor cardinal directions description.

Decimal Place

Defines the decimal place settings for angular, linear and area values.

Tick the Number Words checkbox to replace numeric data with text.

For example the distance of 134.50 would be displayed as one hundred thirty-
four point five zero.

The Add field allows you to add a comma to area values greater than specified
in the appropriate editbox.

For example if 1000 is specified resulting in an area value of 1,000 when dis-
played.

Insert Text in Job Tick to inserts the description text into the active project as multiline text.
Select the layer for text insertion from the drop down list.

311



Survey tab

Calculator group
The Calculator group from the Survey tab of the MAGNET Office ribbon allows you to perform calculations. It
contains two icons, described in the table below.

Geodetic Calculator icon
Click it to open the coordinate calculator.

Calculator icon
Click it to open the default system calculator.

Geodetic Calculator icon
The Geodetic Calculator icon of the Calculator group allows you to calculate map projection (grid) coordinates
using geodetic coordinates and vice versa.

If you are applying a geoid model to the elevation computations, a geoid file (*.gff or *.jff) must be available. A
geoid file provides information about the separation between the purely geometric, ellipsoidal representation of
the earth and the physical model of the earth that closely approximates mean sea level (the geoid). For example,
use a geoid model to obtain approximate mean sea level heights from GPS measured ellipsoidal heights.

Transforming geodetic coordinates to the grid coordinates
To transform geodetic coordinates to the grid coordinates:

1. In the Calculator group of the Survey tab, click the Geodetic Calculator icon.

The Coordinate Calculator dialog is displayed.
2. In the Select projection list, select the required projection.
3. If needed, in the Projection ellipsoid group box, define the ellipsoid.
4. In the Datum group box, select the source and destination datums from the appropriate drop-down lists.
5. If needed, in the Geoid file group box, click ... and define the external geoid file.
6. In the Conversion group box, select the Geodetic -> Projection (direct) radiobutton.
7. In the Geodetic coordinates group box, specify the required latitude, longitude and ellipsoidal height in the

appropriate editboxes.
8. Click Calc.

The following calculated coordinates are displayed:
l Geocentric coordinates (X, Y, Z) in the appropriate editboxes of the Geodetic coordinates group
box.

l Grid coordinates (Easting, Northing, Elevation) in the appropriate editboxes of the Projection
coordinates group box.

9. If needed, you may add the point with the calculated coordinates to the survey view. To do so:
1. In the Projection coordinates group box, in the Point No. editbox, specify the point number.
2. If needed, in the Projection coordinates group box, in the Code editbox, specify the point code.
3. In the Projection coordinates group box, click Save.

10. Click Close to close the dialog.
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Transforming grid coordinates to the geodetic coordinates
To transform grid coordinates to the geodetic coordinates:

1. In the Calculator group of the Survey tab, click the Geodetic Calculator icon.

The Coordinate Calculator dialog is displayed.
2. In the Select projection list, select the required projection.
3. If needed, in the Projection ellipsoid group box, define the ellipsoid.
4. In the Datum group box, select the source and destination datums from the appropriate drop-down lists.
5. If needed, in the Geoid file group box, click ... and define the external geoid file.
6. In the Conversion group box, select the Projection-> Geodetic(iverse) radiobutton.
7. In the Geodetic coordinates group box, specify the required latitude, longitude and ellipsoidal height in the

appropriate editboxes.
8. Click Calc.

The following calculated coordinates are displayed:
l Geodetic coordinates (Lat, Lot, ellipsoidal height) in the appropriate editboxes of the Geodetic
coordinates group box.

l Geocentric coordinates (X, Y, Z) in the appropriate editboxes of the Geodetic coordinates group
box.

9. Click Close to close the dialog.

Calculator icon
Click the Calculator icon of the Calculator group to open the default system calculator.
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Structure group
The Structure group from the Survey tab of the MAGNET Office ribbon allows you to work with structures. A
structure is a series of interconnected lines and/or arcs that form a closed figure around the extents of a structure.
It can be inserted into any job and then moved, located, and rotated using several tools. Finally, the structure is
saved to an exact position, where the points are coordinated and fixed. A structure may represent a house outline
or other features such as a dam, a cul-de-sac, a traffic island, or a roundabout.

The group contains two icons, described in the table below.

Define icon
Click it to define and save a structure.

Locate icon
Click it to place an existing structure to the project.

Define icon
The Define icon of the Structure group allows you to outline a structure and save the selected points, lines, and
arcs to a nominated file name. The data may represent a structure outline or other feature, such as a dam, cul-de-
sac head, traffic island, or roundabout.

To define a structure:
1. In the Structure group of the Survey tab, click the Define icon.
2. Click in the survey view to locate the first corner of the window which will select all of the data in the win-

dow of the structure.
3. Locate the second corner of the window.
4. Define the insertion point. Do one of the following:

l Click the required place in the survey view.
l Specify the required East and North coordinates in the appropriate editboxes at the bottom toolbar.

The Save As dialog is displayed.
5. Navigate to the required folder, type the name of the structure in the File name editbox and click Save.

The structure is defined

Locate icon
The Locate icon of the Structure group allows you to to create points, lines, and arcs representing a structure or
other object previously saved as the *.hse file. The object may be moved and manipulated so it is positioned
exactly at the required rotation and offset correctly from boundaries using a range of functions.

To locate a structure:
1. In the Structure group of the Survey tab, click the Locate icon.

The Open dialog is displayed.
2. Select the required structure file and click Open.
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The structure is displayed on the screen with the pointer attached to the insertion point.
3. Define the position of the insertion point.
4. If needed, configure the options by using the toolbar. Buttons are described in the table below.
5. Click Save.

Buttons of the structure toolbar
Field Description

Display Off-
sets

Displays the lines or arcs from which

Direction Rotates the structure around the insertion point to a nominated bearing.

Swing Rotates the structure around the insertion point to a nominated angle.

Parallel
Rotates the structure with a line of the structure parallel to a nominated line in
the project with an optional offset setting between the lines.

Offset to
Line

Offsets the insertion point from a line or if offsets are displayed to several
boundary lines, it sets the offsets of the closest point from a boundary.

Y Mirror Creates a mirror image of the structure around the Y-axis of the structure.

X Mirror Creates a mirror image of the structure around the X-axis of the structure.

Corner
Snaps the insertion point to a selected point in the project. Any current rotation
applied to the structure is held.

Save
Saves the structure in the current position, creating the points, lines, and arcs
on the current layer with properties as set on the property bar.
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Design Tab
The Design tab of the MAGNET Office ribbon contains control icons, which allows you to create various new
entities at your projects location. It separated to nine groups:

l "Roads group" section on the facing page
l "Cross Section group" section on page 336
l "Profile group" section on page 348
l "Intersection group" section on page 352
l "Subdivision group" section on page 362
l "Pad group" section on page 378
l "Sewer group" section on page 382
l "Drainage group" section on page 387
l "Design Views group" section on page 392
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Roads group
The Roads group from the Design tab of the MAGNET Office ribbon allows you to create and manage alignments
and roads in the project. It contains four icons, and nineteen second level icons, described in the table below.

Create Alignment by IPs icon
Click it to create an alignment. This icon also contains the list of

the second level icons. Click to see them.

icon
Click it to

Alignment from Lines icon
Click it to convert existing strings or lines to an alignment.

Manual Road Entry icon
Click it to manually create a road.
Manual Alignment Entry icon

Click it to manually create a new alignment.
Level Book icon

Click it to define the cross sectional survey data.
Edit Alignment icon

This icon contains the list of the second level icons for editing
existing alignments. Click to see them.

Edit IP icon
Click it to edit an existing horizontal intersection point.

Add IP icon
Click it to add a new horizontal intersection point.

Insert IP icon
Click it to insert a new horizontal intersection point to an existing

alignment.
Delete IP icon

Click it to delete an existing intersection point.
Alignment Text icon

Click it to add a chainage text along an alignment.
Delete Alignment Text icon

Click it to delete an existing chainge text along an alignment.
Station Equation icon

Click it to add station equation information to a existing road.
Alignments icon

This icon contains list of the second level icons for creating new
alignments, described below. Click to see it.

H/V Alignment from String icon
Click it to create a horizontal/vertical alignment from an existing

string.
Convert Alignment to String

Click it to convert an alignment to a string.
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Create Center Line Points icon
Click it to create points on an existing alignment.

Catch Points icon
Click it to compute catch points from points on an alignment.

Create Offset Strings icon
Click it to create string, parallel to an existing alignment.

Multi Sheet Plot Window icon
Click it to create a linked drawing.

Reports icon

This icon contains list of the second level icons for generating
reports. Click to expand the list of the second level icons.

Alignment icon
Click it to generate the alignment report.

Offset icon
Click it to list points within the defined offset from the alignment.

Pavement Check icon
Click it to generate a report, detailing Station/Chainage and offset

of points along a nominated alignment.

Create Alignment by IPs icon
The Create Alignment by IPs icon of the Roads group allows you to create a new alignment.

To create an alignment:
1. In the Roads group of the Design tab, click the Create Alignment by IPs icon.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
2. Locate the intersection points of the alignment by using the "Coordinate" method. For more information

refer to "Add Point icon" section on page 136.
3. When finished, press Esc.

The Create Alignment dialog is displayed.
4. Review the properties of the newly created alignment, if needed change them. Fields are described in the

table below.
5. Click OK.

The alignment is created.

Fields of the input panel, when creating alignments
Field Description

Number Defines the number of the next intersection point.

East Defines the East (X) coordinate of the alignment intersection point.

North Defines the North (Y) coordinate of the alignment intersection point.

Elev Defines the elevation of the alignment intersection point.
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Field Description

Code Defines the code of the alignment intersection point.

Use in Surface Defines whether the alignment intersection point may be used in surface or not.

Interpolate Elev-
ation

Defines whether the elevation of the alignment intersection point will be inter-
polated.

BreakLine Defines whether the new alignment will be a breakline.

The non-editable fields of the Edit Alignment dialog
Field Description

Start IP Displays the number of the alignment start intersection point.

End IP Displays the number of the alignment end intersection point.

Num Points Display quantity of the intersection points in the alignment.

End Chain Displays the chainage or running distance at the end of the alignment.

Length Display the length of the alignment.

The editable fields of the Edit Alignment dialog
Field Description

Name Defines the name of the alignment.

Start Chain Defines the chainage or the running distance of the alignment start intersection
point.

Layer Defines layer to which the alignment belongs to. Note that the alignment and its
points may belong to the different layers.

Color Defines a color for alignment displaying.

Line Style
Defines appearance of the alignment both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the alignment in millimeters when plotted.

Buttons of the Edit Alignment dialog
Button Description

Set Properties Click it to set current properties as the default for alignments. New alignments
will be created with these properties.

Get Properties Click it to load existing default properties for alignments.

Reverse Click it to swap the start and end points of the alignment.

Images/Pdfs
Click it to attach an image or a PDF to the alignment. The picture will be dis-
played near the alignment. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the alignment and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Alignment from Lines icon
The Alignment from Lines icon of the Roads group allows you to create a new alignment from existing
lines/arcs.

To create an alignment:
1. In the survey view, select the required lines/arc.
2. In the Roads group of the Design tab, click the Alignment from Lines icon.

The selected entities are converted into alignment segments. The input panel is displayed at the bottom tool-
bar. Fields are described in the table below.

3. In needed, locate the further intersection points of the alignment by using the "Coordinate" and/or
"Sideshot" methods. For more information refer to "Add Point icon" section on page 136 or "Sideshot icon"
section on page 143.

TIP

To switch the creation mode use the Coordinate icon and the Direction icon from the Create Modes group of
the Settings tab, or corresponding icons at the toolbar.

4. When finished, press Esc.

The Create Alignment dialog is displayed.
5. Review the properties of the newly created alignment, if needed change them. For more information, refer

to "Alignment properties" section on page 572.
6. Click OK.

The alignment is created.

Fields of the input panel, when creating alignments
Field Description

Number Defines the number of the next new intersection point.

East Defines the East (X) coordinate of the alignment intersection point.

North Defines the North (Y) coordinate of the alignment intersection point.

Bearing
Defines the bearing of the alignment intersection point from the previous one.

NOTE
This field available only when creating second or further intersection points.

Distance

Defines the distance from the previous alignment intersection point to further
one.

NOTE
This field available only when creating second or further intersection points.

Elev Defines the elevation of the alignment intersection point.

Code Defines the code of the alignment intersection point.

Use in Surface Defines whether the alignment intersection point may be used in surface or not.
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Field Description

Interpolate Elev-
ation

Defines whether the elevation of the alignment intersection point will be inter-
polated.

BreakLine Defines whether the new alignment will be a breakline.

Manual Road Entry icon
The Manual Road Entry icon of the Roads group allows you to manually create a road or edit an existing one.

To create/edit a road:
1. In the Roads group of the Design tab, click the Manual Road Entry icon.

The Manual Road Entry Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new alignment.
l Select an existing traverse and click Open to edit it.

The Road Editor is displayed.
3. Make the required configurations. For more information refer to "Road editor" section on page 523.

Manual Alignment Entry icon
The Manual Alignment Entry icon of the Roads group allows you to manually create an alignment or edit an
existing one.

To create/edit an alignment:
1. In the Roads group of the Design tab, click the Manual Alignment Entry icon.

The Traverse Data Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new alignment.
l Select an existing traverse and click Open to edit it.

The Alignment Editor is displayed.
3. Make the required configurations. For more information refer to "Alignment editor" section on page 520.

Level Book icon
The Level Book icon of the Roads group allows you to specify the cross sectional survey data in the form of staff
reading, chainage, and offset to be used in road design. You may also specify reduced levels here.

To define the cross sectional data:
1. In the Roads group of the Design tab, click the Level Book icon.

The Level Book Manager dialog is displayed.
2. Do one of the following:

l Click New to create a new cross sectional entry.
l Select an existing entry and click Open to edit it.

The Level Book dialog is displayed.
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3. Make the required configurations. Fields are described in the table below.
4. Click OK.

Fields of the Level Book dialog
Field Description

Back Sight Defines the observed reading to the backsight.

Inter Sight Defines observed reading to the intermediate sight.

Fore Sight Defines the observed reading to the fore sight.

Level Defines the known reduced levels only at the appropriate back sights.

Chainage Defines the chainage or distance for the observation. This field only needs to
be specified when the chainage changes.

Offset
Defines the offset of the observation point form the centerline. Negative values
are taken as being to the left of the centerline in the direction of increasing
chainage.

Code Defines an alpha-numerical code for the observation. This field is optional.

Buttons of the Level Book dialog
Button Description

Insert Click it to insert an additional row in the level book table.

Delete Click it to delete an existing row in the level book table.

Restore Click it to discard changes, and return the last saved configuration.

OK Click it to apply the changes and close the dialog.

Cancel Click it to close the dialog.

Edit IP icon
The Edit IP icon of the Roads group allows you to edit details for the curve geometry at a Horizontal Intersection
Point (HIP), by using the curve calculators based on the speed environment and other factors or to update and edit
the existing curve geometry.

To edit an intersection point:
1. In the Roads group of the Design tab, click the Edit IP icon.
2. In the survey view, select the required alignment.
3. At the alignment, select the required intersection point.

The Edit Alignment HIP dialog is displayed.
4. Do one of the following:

l Make the required configurations and click OK. Fields are described in the table below.
l Click Delete to delete an intersection point.
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Fields of the Edit Alignment HIP dialog
Field Description

IP Name Displays the number of the intersection point (IP).

Align Name Displays the name of the alignment to which the IP belongs to.

Easting Defines the East coordinate of the IP.

Northing Defines the North coordinate of the IP.

Speed
Defines the speed environment for the curve. You may select the value from
the drop-down list, or specify your own value. It is used to define the minimum
curve radius and other curve values.

Radius Defines the curve radius.

Rate of Rotation Defines the distance, required to rotate the road crossfall from the normal
crossfall of the standard road template leg to full super-elevation

Required Super Defines the super-elevation value in percent.

Entry Spiral
Length

Defines the length of the entry spiral. Specify 0.000 for a circular curve with
no transition.

Exit Spiral Length Defines the length of the exit spiral. Specify 0.000 for a circular curve with no
transition.

Curve Radius
Table

Defines the curve radius table. It is used to set up local standards for the min-
imum curve radius for a defined speed environment. You may select the
required table from the drop-down list.

Friction Factor
Table

Defines the curve radius table. It is used to set up local standards for the fric-
tion factor for a defined speed environment. You may select the required table
from the drop-down list.

Minimum Radius Displays the friction factor radius for the alignment curves, defined by the
speed environment, specified in the Speed field.

Maximum Radius

Displays the maximum radius that can be used for curves within the existing
geometry. It depends on the design of the previous curve and/or following
curve and their definition, including the position of their IPs and tangent spiral
points or tangent arc points.

Arc Length Calculated from the radius entered, the geometry of the arc at thee curve, and
the tangent point positions

Calculated Super Defines the maximum recommended super-elevation for the curve.

Spiral Length Displays the recommended spiral length for designing a transitional curve,
comprising a spiral–arc–spiral.

Max Spiral Length

Displays the maximum spiral length that can be used for the curve within the
existing geometry. It depends on the design of the previous curve and/or the fol-
lowing curve and their definitions, including the position of their IPs and tan-
gent spiral points or tangent arc points.
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Add IP icon
The Add IP icon of the Roads group allows you to add extra intersection point (IP) to the end of an existing align-
ment.

To add an IP to an existing alignment:
1. In the Roads group of the Design tab, click the Add IP icon.
2. In the survey view, select the required alignment.
3. Locate the additional points, by using the "Coordinate" method. For more information, refer to "Add Point

icon" section on page 136.
4. When finished, press Esc.

Insert IP icon
The Insert IP icon of the Roads group allows you to insert new intersection point (IP) at the beginning of the
existing alignment or in between two existing IPs.

To insert an IP:
1. In the Roads group of the Design tab, click the Insert IP icon.
2. In the survey view, select the required alignment.
3. Click the existing IP, which is the nearest to the location of the new point.
4. Locate the additional points, by using the "Coordinate" method. For more information, refer to "Add Point

icon" section on page 136.
5. When finished, press Esc.

Delete IP icon
The Delete IP icon of the Roads group allows you to delete an intersection point (IP) to the end of an existing
alignment.

To delete an IP from an alignment:
1. In the Roads group of the Design tab, click the Delete IP icon.
2. In the survey view, select the required alignment.
3. Select the IP to be deleted.

The IP is deleted from the alignment. Note that it still exists as the point entity, independent from the align-
ment.

4. If needed, delete more points.
5. When finished, press Esc.

Alignment Text icon
The Alignment Text icon of the Roads group allows you to add the chainage or running distance labels along an
existing alignment.

To add labels to an alignment:
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1. In the Roads group of the Design tab, click the Alignment Text icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

The Alignment Text dialog is displayed.

Each row of table represents an alignment segment. You can fill in one row – in this case this settings will
apply for the full length of the alignment; or several rows to apply different settings to different alignment
sections. This may be necessary due to the way the alignment changes direction, and the need to show the
alignment text in different positions to avoid confusion with other data.

3. Specify the labeling details. Fields are described in the table below.
4. Click OK.

The Additional Chainages dialog is displayed. You may specify an additional chainages here.

For example: the default chainages spacing is 100 meters, but you may configure creating labels at each 10
meters at the segment from 500 to 630 meters.

5. If needed, configure the additional chainages and click OK.

The alignment is labeled.

Fields of the Alignment Text dialog's table
Field Description

Chainage

Start Defines the start chainage for the text.

End Defines the end chainage for the text.

Offset Defines the offset of the text from the alignment.

Position Defines the position of the text relative to the alignment.

Reverse When ticked, the text will be turned around by 180 degrees.

Table

Text Defines the text style for the alignment labels.

Justification Defines the justification style for the alignment labels.

Fields of the Alignment Text dialog
Field Description

Text Orientation Defines the orientation of the alignment labels.

Show Tick Marks Tick to display tick marks on the alignment at the cross section position

Align text to page Tick to assist with layout, depending on the shape and position of the align-
ment.

Size Defines the size of the tick marks.

Layer Defines the layer to which the alignment labels and ticks belongs to.

Cross Section Spa-
cing

Select this radiobutton to use the cross section spacing for the alignment label
chainages.
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Field Description

Specify Spacing Select this radiobutton to manually define the spacing for straight and curved
segments of the alignment.

None Select this radiobutton to place the alignment labels only at the IPs of the align-
ment.

Label TP's Tick to label the tangent point (TP) points of the alignment. Define the label
position in the TP Label Position group box.

Format Defines the layout of the spacing.

Fields of the Additional Chainages dialog's table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.

Fields of the Additional Chainages dialog
Field Description

Start Chainage Displays the start chainage of the alignment.

End Chainage Defines the end chainage of the alignment.

Delete Alignment Text icon
The Delete Alignment Text icon of the Roads group allows you to delete the text labels from an existing align-
ment.

To delete labels from the alignment:
1. In the Roads group of the Design tab, click the Delete Alignment Text icon.

The Select Alignment dialog in displayed.
2. Select the required alignment and click OK.

The labels are deleted.

Station Equation icon
While designing a road there may be a situation when the original stationing does not fit to the actual alignment,
and a new center line stationing may be needed. Station Equations are a method to link an old and a new roadway
stationing. Station equations are used to change the stationing forward or back from some spot along the align-
ment. Approaching stationing, behind the spot, where station equation applied is called Back Station, departing
stationing, which is after this spot is called Ahead Station.
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Original stationing — second segment is 5 meters long, the third station is 0+15.00, and the end station is 0+19.00.

The second segment has been prolonged to 7 meters. Third station became 0+17.00, and the end station became
0+21.00.

The Station Equation is applied to the third station. Its formula is Back = 0+17.00, Ahead = 0+15.00. The end sta-
tion is 0+19.00 again.

The Station Equation icon of the Roads group allows you to add station equations to existing alignments.

To add station equations to an alignment:
1. In the Roads tab of the Design tab, click the Station Equation icon.

The Station Equations dialog is displayed.
2. From the Alignment drop-down list, select the alignment, to which station equations will be assigned.
3. In the Name column of the table, specify the name of the station equation.
4. In the Back column of the table, specify the stationing for the approaching segment.
5. In the Ahead column of the table, specify the stationing for the departing segment.
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6. If needed, fill in more rows of the table.
7. Click OK.

Fields of the Station Equations dialog
Field Description

Alignment Defines the alignment to which the station equations will be assigned. Select
the required alignment from the drop-down list.

Start Chainage Displays the start chainage of the selected alignment.

End Chainage Displays the end chainage of the selected alignment.

Name Define the name of the station equation.

Back Defines stationing of the approaching segment, behind the spot, where station
equation is applied

Ahead Defines stationing of the departing segment, after the spot, where station equa-
tion is applied

H/V Alignment from String icon
The H/V Alignment from String icon of the Roads group allows you to create an horizontal/vertical alignment
from an existing elevated string.

To create an alignment from a string:
1. In the Roads group of the Design tab, click the H/V Alignment from String icon.
2. In the survey view, select the required sting.

The Create H/V Alignment from String dialog is displayed.
3. Review the properties, if needed, change them. Fields are described in the table below.
4. Click OK.

The alignment is created.

Fields of the Create H/V Alignment from String dialog
Field Description

Name Defines the name of the alignment.

Start IP Displays the number of the alignment start intersection point.

End IP Displays the number of the alignment end intersection point.

Num Points Display quantity of the intersection points in the alignment.

Start Chain Defines the chainage or the running distance of the alignment start intersection
point.

End Chain Displays the chainage or running distance at the end of the alignment.

Length Displays the length of the alignment.
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Field Description

Layer Defines layer to which the alignment belongs to. Note that the alignment and
its points may belong to the different layers.

Color Defines a color for alignment displaying.

Line Style
Defines appearance of the alignment both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the alignment in millimeters when plotted.

Cross Section Spa-
cing

Defines the chainage spacing for the straight and curved segments of the align-
ment.

Convert Alignment to String
The Convert Alignment to String icon of the Roads group allows you to covert an existing alignment to a simple
string.

WARNING
This conversation cannot be canceled. Save the project before using it.

To convert an alignment to a string:
1. In the Roads group of the Design tab, click the Convert Alignment to String icon.
2. In the survey view, select the required alignment.

The warning dialog is displayed.
3. Click Yes.

The dialog prompts you to keep the intersection points of the alignment.
4. Click Yes or No as you need.

The alignment is converted to a string.

Create Center Line Points icon
The Create Center Line Points icon of the Roads group allows you to create points on the center line at nom-
inated spacing on a selected layer.

To create center line points:
1. In the Roads group of the Design tab, click the Create Center Line Points icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

The Center Line Points dialog is displayed.
3. Review the properties, if needed, change them. Fields are described in the table below.
4. Click OK.

If you have ticked the Additional Chainages checkbox, the Additional Chainages dialog is displayed. You
may specify an additional chainages here.
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For example if the default chainages spacing is 100 meters, but you may configure creating center line
points at each 10 meters at the segment from 500 to 630 meters.

5. Configure additional chainages as you need and click OK.

Fields of the Center Line Points dialog
Field Description

Alignment Name Displays the name of the alignment.

Layer Name Defines the layer, where center line points will be created.

Start Chainage Defines the start chainage for point creation.

End Chainage Defines the end chainage for point creation.

Default Spacing Defines the chainage spacing for the straight and curved segments of the align-
ment.

Include TP's Tick to include tangent point (TP) points from the string or alignment in the
computation.

Duplicate Points Tick to create a duplicate point if a point already exists at the center line.

Additional Chain-
ages Tick to create the additional chainages for point's creation.

Fields of the Additional Chainages dialog's table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.

Fields of the Additional Chainages dialog
Field Description

Start Chainage Displays the start chainage of the alignment.

End Chainage Defines the end chainage of the alignment.

Catch Points icon
The Catch Points icon of the Roads group allows you to compute catch points on a DTM surface from points on
an alignment or string at a defined grade. The points on the alignment or string must have valid elevations.

To create catch points:
1. In the Roads group of the Design tab, click the Catch Points icon.
2. In the survey view, select the required sting.

The Catch Points dialog is displayed.
3. Review the properties, if needed, change them. Fields are described in the table below.
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4. Click OK.

The Preferred Chainages dialog is displayed.
5. If needed, specify the required chainages, and click OK.

The MAGNET Office prompts the first point.
6. Review the properties, and confirm the point.
7. Repeat for the rest of the points.

Fields of the Catch Points dialog
Field Description

String Name Displays the name of the selected string or alignment.

String Layer Displays the layer of the selected string or alignment.

DTM Name Defines the DTM for the computation. Select the required DTM from the drop-
down list.

Default Spacing Defines the default spacing for straight and curved segments of the alignment.

Cut Slope Grade 1
in

Defines the grade to be used for computing cut slopes and a color for the cut
slope string and points.

Fill Slope Grade 1
in

Defines the grade to be used for computing fill slopes and a color for the fill
slope string and points.

Start Station Defines the start chainage of the alignment.

End Station Defines the end chainage of the alignment.

Intercept Layer Defines the layer for the new slope entities or enter a new layer name.

Include TP's Tick to include tangent point (TP) points from the string or alignment in the
computation.

Points At

Slope Left Select to compute the slope to the left or right of the selected string or align-
ment.Slope Right

Create Offset Strings icon
The Create Offset Strings icon of the Roads group allows you to create strings, parallel to an existing string,
with nodes, referenced to an existing alignment.

To create offset strings:
1. In the Roads group of the Design tab, click the Create Offset Strings icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

The Offset Strings dialog is displayed.
3. In the Start Chainage and End Chainage editboxes, specify the start and end stations of the alignment,

between which the offset sting will be created.
4. Tick the Offset String 1 editbox.
5. From the String drop-down list, select the existingstring to which the new string will be parallel.
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6. In the Name editbox, type the name of the new string.
7. In the Offset editbox, specify the required offset of the new string.
8. If needed, tick the Offset String 2 editbox, and repeat steps 5 to 7 create second offset string.
9. Click OK.

The offset string is created.

Multi Sheet Plot Window icon
The Multi Sheet Plot Window icon of the Roads group allows you to create a linked drawing. The drawing is
defined with a nominated plot scale, title block, and orientation. The drawing displays all of the data currently on
active layers in the survey view.

You can turn layers on/off in the drawing. Any layer added to the project after the drawing was created may be
turned on in the drawing. Any annotation that was not available at the time the drawing was created may be activ-
ated.

To create a multi sheet plot window:
1. In the Roads group of the Design tab, click the Multi Sheet Plot Window icon.
2. In the survey view, select the required alignment or string.

The Open dialog is displayed.
3. Select the required title block, and click Open.

The title block is displayed in the survey view. Its bottom-left corner is in the center of the survey view.
4. Modify the size and position of the drawing, by using the mouse:

l Drag the plot window through the survey view by using the bottom left corner.
l Resize the plot window by using the top right corner.
l Rotate the plot window around the bottom left corner, by using the bottom-right handle.
l To change the title block, Click Title Block and select a new one.

The additional plot windows automatically appear in the survey view, as you configure the first one to
make the entire alignment fits the plot windows.

5. On the bottom panel, click OK.

The drawing of the selected area is displayed in the new window.

Alignment icon
The Alignments icon of the Roads group allows you to generate the alignment report, listing all of the alignment
details.

To create an alignment report:
1. In the Roads group of the Design tab, click the Alignment icon.

The Alignment List Selection dialog in displayed.
2. Select the required alignment and click OK.

The Center Line Points dialog is displayed.
3. Review the properties, if needed, change them. Fields are described in the table below.
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4. Click OK.

If you have ticked the Additional Chainages checkbox, the Additional Chainages dialog is displayed. You
may specify an additional chainages here.

5. Configure additional chainages as you need and click OK.

The report is generated and displayed.

Fields of the Alignment List Selection dialog
Field Description

Alignment Name Displays the name of the alignment.

Start Chainage Defines the start chainage for the report.

End Chainage Defines the end chainage for the report.

Default Spacing Defines the chainage spacing for the straight and curved segments of the align-
ment.

Include TPs Tick to include tangent point (TP) points from the string or alignment to the
report.

Moss Format Defines whether the moss format will be used.

Additional Chain-
ages When ticked, the additional chainages may be added to the report.

Fields of the Additional Chainages dialog's table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.

Fields of the Additional Chainages dialog
Field Description

Start Chainage Displays the start chainage of the alignment.

End Chainage Defines the end chainage of the alignment.

Offset icon
The Offset icon of the Roads group allows you to generate the offset report, listing all of the points within a spe-
cified offset of an alignment. The list will display the chainage and offset for each of these points.

To generate the offset report:
1. In the Roads group of the Design tab, click the Offset icon.

The Offset Report dialog is displayed.
2. Review the properties, if needed, change them. Fields are described in the table below.
3. Click OK.

The report is generated and displayed.
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Fields of the Offset Report dialog
Field Description

Select From Defines the points range for report.

Offset Symbol Defines the offset symbol for report layout.

Format Defines the chainage format.

Alignment Defines the alignment, around which the points will be searched.

Start Chainage Defines the start chainage to be used in the report.

End Chainage Defines the end chainage to be used in the report.

Left Offset Defines offset area to the left of the alignment.

Right Offset Defines offset area to the right of the alignment.

Print If Height >
(m)

Defines the minimum height for points in report. Point, with elevation less, than
defined won't be included into report.

Pavement Check icon
The Pavement Check icon of the Roads group allows you to generate a report detailing Station/Chainage and off-
set of points selected with reference to a selected alignment. Height difference to a nominated design DTM is
also computed with points outside the tolerance marked with an asterisk in the report produced.

A DTM should be selected to compare the height difference with. Upper and lower tolerances are nominated
which are then used in the report and checked against the selected data

To generate the pavement report:
1. In the Roads group of the Design tab, click the Pavement Check icon.

The Pavement Check Report dialog is displayed.
2. Review the properties, if needed, change them. Fields are described in the table below.
3. Click OK.

The report is generated and displayed.

Fields of the Pavement Check Report dialog
Field Description

Select From

Defines the data for the report. Select one of the following:
l All Data – to display all existing data.
l Active Layers – to display only entities, which belong to the active lay-
ers.

l All Data – to display only selected entities.

Alignment Defines the alignment to be used in the report.

Start Chainage Defines the start chainage of the alignment segment to be used in the report.

End Chainage Defines the end chainage of the alignment segment to be used in the report.
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Field Description

Left Offset Defines the left offset from the alignment.

Right Offset Defines the right offset from the alignment.

DTM Defines the DTM to compare the height difference with.

Upper Tolerance Defines the tolerance of comparison above DTM.

Lower Tolerance Defines the tolerance of comparison below DTM.

Depth Defines the tolerance of comparison inside DTM.

Excel format Tick to generate the report in MS Excel format.
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Cross Section group
The Cross Section group from the Design tab of the MAGNET Office ribbon allows you to work with the cross
sections. It contains three icons and five second level icons, described in the table below.

XS from DTM icon
Click it to extract a cross section from an existing digital terrain model.

XS From Strings icon
Click it to extract a cross section from strings.

Cross Section icon
This icon contains the list of the second order icons for various cross section oper-

ations. Click to expand the list of the second level icons.

XS from Points icon
Click it to create cross sections from points.

Quick XSection icon
Click it to generate cross section for previewing.

XSection Volumes icon
Click it to calculate cross section volumes.

Import XSection icon
Click it to export an external cross section files.

Report XSection icon
Click it to list cross sections from the current surface.

XS from DTM icon
The XS from DTM icon of the Cross Section group allows you to extract cross sections for a selected alignment
from a triangular mesh, for use in road design and plotting. The mesh represents a surface, which is usually the
existing or natural surface. Points are added to the cross section where the cross section intersects triangle sides,
providing offset and level data.

You may specify the spacing between these sections and nominate additional chainages as required. Cross sec-
tions will be generated at these spacing with a point extracted for the offset where the cross section line inter-
sects the side of a triangle. The level allocated to this offset point is calculated from the triangle intercept.

To extract the cross sections:
1. In the Cross Section group of the Design tab, click the XS from DTM icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

NOTE
If data has previously been extracted for the same alignment, the cross sections will be overwritten and
updated.

The Extract Cross Sections from DTM dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.
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The Additional Chainages dialog is displayed.
5. If needed, configure the additional chainages. Fields are described in the table below.
6. Click OK.

The cross sections are extracted and marked with yellow lines in the survey view. You may review and
them in the road view under the name of the alignment used. See "Roads icon" section on page 392 for
details.

Fields of the Extract Cross Sections from DTM dialog
Field Description

Alignment Name Displays the name of the selected alignment.

Surface Name

The first surface is set to NATURAL. The cross sections will be held as a nat-
ural surface in the roads view with this name. Other names may be used for fur-
ther surfaces.

TIP

Do not use DESIGN, BOXING, or a SUBGRADE names.

DTM Name Select the required DTM from the drop-down list.

Filter Tolerance
Defines the tolerance of the cross sectional data. See "Cross section filter tol-
erance" section on the next page for details.

The default value is 0.00 which means no filtering will be applied.

Start Chainage
The start chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

End Chainage
The end chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

Left Offset Defines the left offset at which the cross section will be extracted to the left of
the alignment.

Right Offset Defines the right offset at which the cross section will be extracted to the right
of the alignment.

Compute Obstruc-
tions

Tick to nominate an obstruction string. See "Compute obstructions" section on
page 339 for details.

Additional Offsets
Defines a specified offset, if all the cross sections must have a point and level
computed at this offset. Several new offsets may be entered. All offsets to the
left of the alignment should be entered as a negative offset

Include TPs
Tick to extract cross sections at each tangent (TP) point. A cross section will
be created at each point between HIPs on straights, at tangent arc points, tan-
gent spiral points and arc spiral points

Cross Sections At
The default is to extract cross sections at the half angle from the alignment.
You may choose to extract cross sections at right angles before the TP, or at
right angles after the TP.
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Field Description

Default Spacing

This setting defaults to a spacing of 20m between each cross section extracted
along the alignment. Different spacing may be set for straights and curves,
such as straights set to 10.00m spacing and curves to 5.00m spacing. If cross
sections are only required at the TP points set the default spacing to 0.00

Cross Sections at
Breaklines

A cross section will be extracted wherever the alignment crosses a breakline
in the Survey View.

Create CL Points
at DTM

Tick to display the change in elevation along the profile/alignment based on
every DTM triangle intersection.

NOTE
Additional cross sections will not be extracted. This feature is only used for
graphical representation.

Fields of the Additional Chainages dialog's table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.

Fields of the Additional Chainages dialog
Field Description

Start Chainage Displays the start chainage of the alignment.

End Chainage Defines the end chainage of the alignment.

Cross section filter tolerance
The filtering of the cross sections points are used to filter out unnecessary points.

The tolerance value is compared to height differences between the points in each cross section. Adjacent points
in the cross section are tested. If the tolerance is greater than the actual height difference between adjacent
points then some points will not be included in the cross sections as shown below. The centre line level will not
be affected by filter tolerance.

For example, the filter tolerance may be set to 0.010m to filter out points from a close triangular model over a
fairly flat terrain. See picture below.
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Cross section filtering procedure

Points c, b, d and e are points in the cross section, while point a is on the line cd, which is perpendicular to the
point b. If the ab distance is smaller or equal to the specified Filter Tolerance value then the point b will be
deleted from the cross section. If point b is deleted from the cross section then the line ce would be tested with
point d. If point b is not deleted from the cross section then the line eb will be tested with point d and so on across
the cross section. You may see example of filtering result on the picture below.

Cross section filtering result

Compute obstructions
Obstructions such as existing underground services may be displayed in the cross section and long section win-
dows in the roads view.

An obstruction is created as a string in the survey view, with the node points defining the level of the obstruction
in or above the ground surface. The string is saved and named and set as a service.

To configure this option:
1. Tick the Compute Obstructions checkbox.
2. Click Set Obstructions.

The Select Obstructions dialog is displayed.
3. Select the required service strings from the Valid Service String list and click >>.
4. The selected strings are displayed in the Selected Obstructions list. If needed to remove a string, select it

and click <<.
5. Click OK.
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XS From Strings icon
The XS from Strings icon of the Cross Section group allows you to extract cross sectional data along a designed
alignment from a surface defined by 3D stringlines.

You may specify the spacing between these sections and nominate additional chainages as required. Cross sec-
tions will be generated at these spacing with a point extracted for the offset where the cross section line inter-
sects each stringline. The level allocated to this offset point is calculated from the grade line between adjacent
points on each stringline.

A string may be a string entity, a series of lines or lines and arcs. Any lines and arcs must be defined as break-
lines. The points defining these entities must have elevations.

To extract the cross sections:
1. In the Cross Section group of the Design tab, click the XS from Strings icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

NOTE
If data has previously been extracted for the same alignment, the cross sections will be overwritten and
updated.

The Extract Cross Sections from Strings dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The Additional Chainages dialog is displayed.
5. If needed, configure the additional chainages. Fields are described in the table below.
6. Click OK.

The cross sections are extracted and marked with yellow lines in the survey view. You may review and
them in the road view under the name of the alignment used. See "Roads icon" section on page 392 for
details.

Fields of the Extract Cross Sections from Strings dialog
Field Description

Alignment Name Displays the name of the selected alignment.

Surface Name

The first surface is set to NATURAL. The cross sections will be held as a nat-
ural surface in the roads view with this name. Other names may be used for fur-
ther surfaces.

TIP

Do not use DESIGN, BOXING, or a SUBGRADE names.

Filter Tolerance
Defines the tolerance of the cross sectional data. See "Cross section filter tol-
erance" section on page 338 for details.

The default value is 0.00 which means no filtering will be applied.
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Field Description

Start Chainage
The start chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

End Chainage
The end chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

Left Offset Defines the left offset at which the cross section will be extracted to the left of
the alignment.

Right Offset Defines the right offset at which the cross section will be extracted to the right
of the alignment.

Compute Obstruc-
tions

Tick to nominate an obstruction string. See "Compute obstructions" section on
page 339 for details.

Additional Offsets
Defines a specified offset, if all the cross sections must have a point and level
computed at this offset. Several new offsets may be entered. All offsets to the
left of the alignment should be entered as a negative offset

Include TPs
Tick to extract cross sections at each tangent (TP) point. A cross section will
be created at each point between HIPs on straights, at tangent arc points, tan-
gent spiral points and arc spiral points

Cross Sections At
The default is to extract cross sections at the half angle from the alignment.
You may choose to extract cross sections at right angles before the TP, or at
right angles after the TP.

Default Spacing

This setting defaults to a spacing of 20m between each cross section extracted
along the alignment. Different spacing may be set for straights and curves,
such as straights set to 10.00m spacing and curves to 5.00m spacing. If cross
sections are only required at the TP points set the default spacing to 0.00

Create CL Points
at DTM

Tick to display the change in elevation along the profile/alignment based on
every DTM triangle intersection.

NOTE
Additional cross sections will not be extracted. This feature is only used for
graphical representation.

Intersect Break-
lines

Tick to ensure that stringlines defined by lines or arcs are intercepted to pro-
duce the correct cross section data.

Generate Road
Strings

Tick to create any stringlines, defined as string entities, as road strings for use
in the roads view.

Fields of the Additional Chainages dialog's table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.
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Fields of the Additional Chainages dialog
Field Description

Start Chainage Displays the start chainage of the alignment.

End Chainage Defines the end chainage of the alignment.

XS from Points icon
The XS from Points icon of the Cross Section group allows you to extract cross sectional data along a designed
alignment from points surveyed at cross section positions perpendicular to the alignment. It is used when the
centreline or a traverse line has been marked in the field and the surveyor has observed data in the form of cross
sections from this centreline or traverse line.

No DTM is required as this routine simply extracts the points on the active layers that are within the user-defined
envelope. No interpolation occurs in this method. The detail picked up in the field can be manipulated so that it is
shifted on to a design centreline.

The tolerance parameters define an envelope around each centreline point. Any point that lies within this envel-
ope will be assigned to the cross section at the chainage of the centreline point. Make sure points can only be
assigned to one cross section.

Cross sections will be generated where there is a suitable point at or near the centreline with further points offset
at this position.

The points must have elevations.

To extract the cross sections:
1. In the Cross Section group of the Design tab, click the XS from Points icon.

The Select Alignment dialog is displayed.
2. Select the required alignment and click OK.

NOTE
If data has previously been extracted for the same alignment, the cross sections will be overwritten and
updated.

The Extract Cross Sections from XYZ dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The cross sections are extracted and the report is displayed. You may review and cross sections in the
road view under the name of the alignment used. See "Roads icon" section on page 392 for details.

Fields of the Extract Cross Sections from XYZ dialog
Field Description

Alignment Name Displays the name of the selected alignment. Extracted cross sections will be
stored under this name.
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Field Description

Surface Name

The first surface is set to NATURAL. The cross sections will be held as a nat-
ural surface in the roads view with this name. Other names may be used for fur-
ther surfaces.

TIP

Do not use DESIGN, BOXING, or a SUBGRADE names.

Start Chainage
The start chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

End Chainage
The end chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

Tolerance
Distance

Defines the offset from the alignment where points within the Tolerance
Required will be included in the cross section.

As the offset increases beyond this tolerance distance value, the Tolerance
Required value is doubled as the Tolerance Distance value is doubled and so
on to create a cone of tolerance beyond this initial Tolerance Distance.

Tolerance
Required

This is the Tolerance used for the above Tolerance Distance. If the per-
pendicular from the point to the line of the cross section is measured, and the
distance is less than the Tolerance Required, the point is included in the cross
section.

If the perpendicular from the point to the line of the cross section is measured,
and the distance is more than the Tolerance Required, the point is rejected and
is not included in the cross section.

The Tolerance value is doubled as the Tolerance Distance is doubled and so on

Maximum Offset This is the maximum distance from the alignment. Points with an offset greater
than this distance are ignored and will not be included in a cross section.

Chainage Tol-
erance

This value allows observations at the alignment to be assigned a preferred
chainage rather than the actual running chainage.

For example, if the observed point is 0.01m from the preferred chainage of
20.00, the actual chainage would be 20.01. If the tolerance is set to 0.05, the
point will be assigned a chainage of 20.00 instead of 20.01. This is normally the
preferred chainage and this feature compensates for slight observation errors.

Zero
Offset Tolerance

Any point within this distance of the alignment will be assumed to be a centre
line point. A cross section will be extracted at this point and the point will be
given an offset of 0.00.

Cross Sections By
Code CHMARK

Tick to extract a cross section at points on the alignment that are coded with
CHMARK or 555

Force Offset of
CL point to 0.0

Tick to force any point within the zero offset tolerance from the alignment to
be assumed to lie on the centre line. It is allocated an offset of 0.00. A cross
section will be extracted at this position
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Field Description

Cross Sections At
The default is to extract cross sections at the half angle from the alignment.
You may choose to extract cross sections at right angles before the TP, or at
right angles after the TP.

Quick XSection icon
The Quick XSection icon of the Cross Section group allows you to generate cross sections for previewing
without having to create an alignment and to extract the cross sections. The cross sections are defined by spe-
cifying spacing along a centerline that is defined by two or more points in sequence, by a line or series of lines,
or by a string. An existing alignment may also be used.

IMPORTANT
Cross section created by this function is only available for preview. It will not be saved after
finishing the function. To create the cross section use any appropriate option from the
Cross Section group of the Design tab.

The Cross Section View displays the cross sections at a specified spacing with specified offsets to the left and to
the right of the defined centerline. A centerline profile also displays.

To create a quick cross section:
1. In the Cross Section group of the Design tab, click the Quick XSection icon.
2. Do one of the following:

l In the survey view, select an existing string/line along which the cross section will be created.
l In the survey view, draw a string along which the cross section will be created. When finished,
right click and select View Section item from the context menu.

The Display Settings dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The cross section is created and displayed in the cross section view. Refer to the section below for details.

Fields of the Display Settings dialog
Field Description

Create profile points

At specified stations Tick to display sections a the stations defined below by the start and end
station values using intermediate spacing.

At the intersection with
DTM triangles

Tick to display sections at every point where the centerline intersects with
a DTM's triangle edge.

At the points of the line,
string, or alignment.

Tick to display sections at every point clicked when defining the center-
line or at each point used to define the line, string, or alignment.

Add profile point on fly Tick to enable the adding of a cross section at a new position in the cross
section view.

Station
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Field Description

Start Defines the starting position for the station.

Spacing Defines the spacing between stations.

End Defines the final station position of the selected centerline.

Cross Section

Left offset Defines the offset to the left of the centerline.

Right offset Defines the offset to the right of the centerline.

Cross section view
The cross section view of three panels:

l The top left panel displays the data from the survey view.
l The top right panel displays the cross section for the station selected, with the offset elevation values for
each leg of the section.

l The bottom panel displays the profile along the centerline, with the station chainage and elevation at the
centerline for each cross section.

Each panel has a context menu that displays zoom options; alternatively, use the scroll wheel of the mouse. The
cross section (top right) and profile (bottom) panels have options to exaggerate the vertical scale of the display.

The input panel at the bottom toolbar displays the current station position and the spacing and offset previously
entered, together with arrow buttons to move through the sections. Fields of the input panel are described in the
table below.

Fields of the input panel in the cross section view
Field Description

Chainage Displays the chainage of the selected cross section.

Spacing Displays the spacing between cross sections.

Left Offset Displays the offset to the left of the centerline at the selected cross section.

Right Offset Displays the offset to the right of the centerline at the selected cross section.

XSection Volumes icon
The XSection Volumes icon of the Cross Section group allows you to calculate the volume between any two sur-
faces available in the roads view. The feature uses the volumes from cross-section algorithms that take account of
any curvature in the alignment.

Multiple surfaces must be available in the Roads View to compute volumes using this option. One surface may be
defined at a datum level.

To calculate the cross section volume:
1. In the Cross Section group of the Design tab, click the XSection Volumes icon.

The Cross Section Volumes dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The volume report is displayed.
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Fields of the Cross Section Volumes dialog
Field Description

Alignment Defines the alignment and road data for the volume computation. Select the
required alignment from the drop-down list.

Design Surface Defines the surface which will be used as the design one in the volume com-
putation. Select the required surface from the drop-down list.

Level If needed, datum level may be used instead of the design surface. Specify the
required level in the editbox.

Natural Surface Defines the surface which will be used as the natural one in the volume com-
putation. Select the required surface from the drop-down list.

Level If needed, datum level may be used instead of the natural surface. Specify the
required level in the editbox.

Start Chainage
The start chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

End Chainage
The end chainage of the selected alignment is displayed. This value can be
modified if cross sections are only required within a specified range of chain-
ages.

Import XSection icon
The Import XSection icon of the Cross Section group allows you to load cross section data from an external file.

The following file types are supported:
l Cross Section (*.xxx, *.txt, *.csv) file
l GENIO (*.gen) file
l Standard Survey (*.rd) file
l CLIP (*.trv) file
l ISPOL (*.sc1) file
l InRoads (*.soe) file
l GeoPAK (*.gen, *.soe) file

To import a cross section data:
1. In the Cross Section group of the Design tab, click the Import XSection icon.

The Open dialog is displayed.
2. Select the required file type.
3. Navigate to the required file and open it.

The Import Cross Section dialog is displayed.
4. Configure the parameters. Fields are described in the table below.
5. Click OK.
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Fields of the Import Cross Section dialog
Field Description

Alignment Defines the base alignment for the cross sections.

Surface Defines the base surface for the cross sections.

Surface Type Defines the type of the base surface.

Create Points Tick to create points at cross sections.

Layer Defines to which layer will belong points.

Report XSection icon
The Report XSection icon of the Cross Section group allows you to generate a report, listing the cross section for
the defined surface.

To generate the cross section report:
1. In the Cross Section group of the Design tab, click the Report XSection icon.

The List Cross Sections dialog is displayed.
2. From the Road Name drop-down list, select the required road.
3. From the Surface Name drop-down list, select the required DTM.
4. If needed, tickMoss Format checkbox to generate report in the moss format.
5. If needed, tickMirror Cross Section Output checkbox to "mirror" the cross section representation in the

report.
6. Click OK.

The report is generated and displayed.
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Profile group
The Profile group from the Design tab of the MAGNET Office ribbon allows you to work with the surface’s pro-
files. Profiles represent the existing, design, and final configurations of a surface. The group contains three icons
and five second level icons, described in the tables below.

Profile DTM icon
Click it to create a profile from an existing digital terrain model and a string.

Profile String icon
Click it to create a profile form points along a string.

Profiles icon
This icon contains the list of the second level icons for various profiles oper-

ations. Click to expand the list of the second level icons.

Profile Points icon
Click it to create a profile from points along the string, or point within defined

offset distance from the string.
Quick Profile icon

Click it to create a profile from an existing string of alignment.
Profile Editor icon

Click it to edit an existing profile.
Profile Report icon

Click it to generate a report about existing profiles.
VC Report icon

Click it to calculate levels for the different strings involved in a profile.

Profile DTM icon
The Profile DTM icon of the Profile group allows you to create profiles from an existing DTM and a string/-
alignment. The profile created from a string can be edited to design a final configuration, including vertical
curves. The surface does not need to be displayed in order to create the profile from the DTM; however, a sur-
face must exist in the project.

To create a profile from DTM:
1. In the Profile group of the Design tab, click the Profile DTM icon.
2. In the survey view, select the required string/alignment.

The Create Profile from DTM dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The profile is created and opened in the profile view. See "Profile design view" section on page 741 for
details.

Fields of the Create Profile from DTM dialog
Field Description

Name Defines the name of the profile.
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Field Description

Start Chainage Defines the start chainage for the profile.

Create NS from
DTM

Tick to create a profile from a specified DTM.

When creating vertical intersection points from the string, the DTM will reflect
the natural surface (NS) profile. To specify a DTM, select it from the drop-
down list.

Create VIPs

Tick to create vertical intersection points (VIP) from the selected string. Usu-
ally, the string would represent a design grade. String VIPs can be added,
deleted, and modified in the profile editor.

If this check box is not ticked, then there will be not a profile created for the
highlighted string. When using this option, the color of the selected string will
be used to represent the string profile in the profile view.

Additional leaders
for NS points

Tick to draw leaders to each break point encountered in the DTM along the pro-
file alignment.

Profile String icon
The Profile String icon of the Profile group allows you create a profile from points along a string or alignment.

To create a profile:
1. In the Profile group of the Design tab, click the Profile String icon.
2. In the survey view, select the required string/alignment.

The Profile from String dialog is displayed.
3. In the Name editbox, specify the name of the profile.

NOTE
You cannot specify a name, when using an alignment.

4. If needed, tick the Open Profile View checkbox, to open the profile after creation. See "Profile design
view" section on page 741 for details.

Profile Points icon
The Profile Points icon of the Profile group allows you to Use the Profile from Points command to create a profile
from points along a string or an alignments as well as points within a specified offset distance from the selected
string/alignment.

To create a profile form points:
1. In the Profile group of the Design tab, click the Profile Points icon.
2. In the survey view, select the required string/alignment.

The Profile from Points dialog is displayed.
3. In the Name editbox, specify the name of the profile.

NOTE
You cannot specify a name, when using an alignment.

4. Configure the rest of the settings. Fields are described in the table below.
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5. Click OK.

The profile is created.

Fields of the Profile from Points dialog
Field Description

Name Defines the name of the profile.

Left Offset Defines the distance to the left for points from the selected string. Points within
this distance will be included in the profile.

Right Offset Defines the distance to the right for points from the selected string. Points
within this distance will be included in the profile.

Use String Points

In Profile Select to include the string points in the profile. String points must have elev-
ation when using this option.

To create VIPs

Select to create vertical intersection points (VIP) from the string points. Typ-
ically, the string represents a design grade. String VIPs can be added, deleted,
and modified in the profile editor. When using this option, the selected string
color is used to represent the string profile in the profile editor.

Neither Select to exclude string points from the profile creation.

Open Profile View Tick to open the profile after creation. See "Profile design view" section on
page 741 for details.

Quick Profile icon
The Quick Profile icon of the Profile group allows you to create a profile from selecting a line or alignment. A
surface (DTM) is required for using this option.

This feature provides a quick analysis of a surface for planning purposes. You cannot edit the profile, but you can
plot the profile if necessary.

To create a quick profile:
1. In the Profile group of the Design tab, click the Quick Profile icon.
2. Create the first point of the profile string. See "Add Point icon" section on page 136 for details.
3. Create second and further point of the profile strings.
4. When finished, right click and select View Profile item from the context menu.

The newly created profile is opened in the profile view. See "Profile design view" section on page 741 for
details.

Profile Editor icon
The Profile Editor icon of the Profile group allows you to view and edit existing profiles.

To edit a profile:

350



Profile Report icon

1. In the Profile group of the Design tab, click the Profile Editor icon.

The Profiles dialog is displayed.
2. Select the required profile from the list and click Open.

The profile is opened in the profile view. See "Profile design view" section on page 741 for details.

To rename a profile:
1. In the Profile group of the Design tab, click the Profile Editor icon.

The Profiles dialog is displayed.
2. Select the required profile from the list and click Rename.
3. Type the new name and press Enter.

The profile is renamed.

To rename a profile:
1. In the Profile group of the Design tab, click the Profile Editor icon.

The Profiles dialog is displayed.
2. Select the required profile from the list and click Delete.

The profile is deleted.

Profile Report icon
The Profile Report icon of the Profile group allows you to view the report listing information about existing pro-
files.

To generate a profile report:
1. In the Profile group of the Design tab, click the Profile Report icon.

The Profiles dialog is displayed.
2. Select the required profiles from the list and click Open.

The report, listing selected profile details is displayed.

VC Report icon
The VC Report icon of the Profile group allows you to generate a report, listing levels for the different strings
involved in a design, such as the addition of a curb and channel to an existing road or widening a lane of a road
using the existing pavement grading.

To generate a VC Report:
1. In the Profile group of the Design tab, click the VC Report icon.

The Profiles dialog is displayed.
2. Select the required profiles from the list and click Open.

The VC Details dialog is displayed.
3. Configure the parameters as you need and click OK.

The report, listing selected profile details is displayed.
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Intersection group
The Intersection group from the Design tab of the MAGNET Office ribbon allows you to build up the component
curbs (stringlines) through an intersection. These curbs (curb returns) need to be defined before an intersection
can be created. Curbs are particular strings defined through intersections between one road and another. The
group contains three icons and seven second level icons, described in the table below.

Fillet Curb Return icon
Click it to create a fillet curb return.

Cul-de-Sac icon
Click it to create a culdesac.

Intersection icon
This icon contains the list of the sub-icons for various intersections

operations. Click to expand the list of the sub-icons.

Trim Strings icon
Click it to merge overlapping strings with road.

Create Curb from String icon
Click it to convert a string, a polygon, an arc or a line into a curb.

Create Island Curb icon
Click it to create an island curb around an existing polygon or a

enclosed area.
Create Intersection icon

Click it to create an intersection from existing curb or strings.
View Intersection icon

Click it to review/update an existing intersection.
View Curb icon

Click it to review an existing curb.
Update Curb icon

Click it to update an existing curb.

Fillet Curb Return icon
The Fillet Curb Return icon of the Intersection group allows you to create a filleted arc between any two entit-
ies that are strings, lines, or arcs to define a curb return. The end result is a graded curb line between the curb of
one road and that of an intersecting road.

To create the fillet curb return:
1. In the Intersection group of the Design tab, click the Fillet Curb Return icon.
2. In the survey view, select the first string/line/arc.
3. In the survey view, select the second string/line/arc.
4. Define the radius of the fillet. Do on of the following:

l Click the required place in the survey view.
l In the Radius editbox at the bottom toolbar, specify the fillet radius.

5. Select the starting tangent point for the fillet.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.

352



Fillet Curb Return icon

6. Define the segmentation of the fillet. You may define it in two ways:
l Divide the curb by distance. To do so:

1. At the bottom toolbar, tick the checkbox near the Distance edtibox.
2. At the bottom toolbar, in the Distance editbox, specify the length of each segment. Note that

the last segment may be shorter, than previous ones, if the segment length is not multiple to
the curb length. See picture below for details.

3. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elev-
ation of the new node.

l Divide the curb to equal segments. To do so:
1. At the bottom toolbar, tick the Divide Equally checkbox.
2. At the bottom toolbar, in the Segments editbox, specify the quantity of segments. See picture

below for details.
3. If needed, at the bottom toolbar tick the Interpolate Z checkbox to automatically calculate elev-

ation of the new node.
7. Confirm the segmentation. Do one of the following:

l Press Enter.
l Left click in the survey view.

8. Define the From and To point, by clicking them in the survey view.

The Create Fillet Curb Return dialog is displayed.
9. Review the parameters, if needed, change them. Fields are described in the table below.
10. Click OK.

The curb is created.

Fields of the input panel, when creating a fillet curb
Field Description

Distance
Defines the length of each segment. Measured from the start/end point of the
entity and from each new node in case of multiple segments. See pictures
above for details.

Divide by
Distance

Tick to divide the arc to as many segments of length, specified in the
"Distance" editbox, as possible.

Segments Defines the quantity of segments for division.

Divide Equally Tick to divide the arc to the segments of the same length.

Interpolate Z Tick to automatically calculate the elevations of the newly created nodes.

Fix Start Point When ticked, the distance will always be measured from the start point of the
arc, regardless of the segmenting.

TIP
The first field of the input panel displays the length of the selected entity.

Fields of the Create a Fillet Curb Return dialog
Field Description

Name Defines the name of the fillet curb. This name will be used in the fillet curb
string and profile.
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Field Description

Start Chainage Defines the start chainage for the fillet curb.

Template Defines the template for fillet curb profile.

Create NS from
DTM

Tick to extract natural surface of the fillet curb profile from an existing DTM.
Select the required DTM from the drop-down list.

Create VIPs
Tick to define the “design surface” that displays in the profile view as a best-
fit curve through the nodes. If the note points on the string have elevations,
these may be defined as the VIPs of the Design surface on the profile.

Additional leaders
for NS points

Tick to create additional leader lines for each change in level on the natural sur-
face.

Open Curb View Tick to display the curb view after creating. See "Profile design view" section
on page 741 for details.

Distance curb segmenting
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Equal segments curb segmenting

Cul-de-Sac icon
The Cul-de-Sac icon of the Intersection group allows you to create cul-de-sac between any two entities that are
strings, lines, or arcs. In the end they will be connected with a smooth cul-de-sac curb.

To create a cul-de-sac:
1. In the Intersection group of the Design tab, click the Cul-de-Sac icon.
2. In the survey view, continuously select two curbs to be connected.
3. In the survey view, select the center point for cul-de-sac.

The Create a Culdesac dialog is displayed.
4. In the Culdesac Radius editbox, specify the radius of the culdesac.
5. In the left and right Radius editboxes, specify the radius for the fillet curbs, which will connect culdesac

with the existing curbs.
6. Select Preview Only radiobutton to preview the culdesac with the defined parameters.

TIP

You may skip the culdesac previewing, by selecting the Create radiobutton.

7. Click OK.

The culdesac is previewed. The message prompts you to return to culdesac design.
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8. Click Yes.

The Create a Culdesac dialog is displayed.
9. Select Create radiobutton.
10. If needed, configure the additional options, by ticking the Create Curb, Segment and Trim checkboxes.
11. Click OK.
12. In the survey view, select the start and end points.

The Create a Culdesac dialog is displayed.
13. Review the parameters, if needed, change them. Fields are described in the table below.
14. Click OK.

Fields of the Create a Culdesac dialog
Field Description

Name Defines the name of the culdesac. This name will be used in the culdesac
string and profile.

Start Chainage Defines the start chainage for the culdesac.

Template Defines the template for culdesac profile.

Create NS from
DTM

Tick to extract natural surface of the culdesac profile from an existing DTM.
Select the required DTM from the drop-down list.

Create VIPs
Tick to define the “design surface” that displays in the profile view as a best-
fit curve through the nodes. If the note points on the string have elevations,
these may be defined as the VIPs of the Design surface on the profile.

Additional leaders
for NS points

Tick to create additional leader lines for each change in level on the natural sur-
face.

Open Curb View Tick to display the curb view after creating. See "Profile design view" section
on page 741 for details.

Trim Strings icon
The road design generates several strings for the gutters on each side of the intersecting roads. After completing
the design of the curb returns, a template is applied to those strings, creating additional overlapping strings for
each curb.

The Trim Strings icon of the Intersection group allows you to locate overlapping strings and merge them with
the road strings to finish the design.

To merge overlapping strings with road strings:
1. In the survey view, draw a rectangle selecting the strings you want to merge.
2. In the Intersection group of the Design tab, click the Trim Strings icon.

The confirmation message is displayed.
3. Click Yes.
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Create Curb from String icon
The Create Curb from String icon of the Intersection group allows you to convert a string, a polygon, an arc, or
a line into a curb. Source entity must have defined start and end points. The result is a curb line that can be formed
with profile data from a DTM or from the position and levels of the string notes, as long as these points have elev-
ations.

To convert a string/polygon/arc/line into a curb:
1. In the Intersection group of the Design tab, click the Create Curb from String icon.
2. In the survey view, select the required string/polygon/arc/line.
3. Select the node, which will become the start point of the curb.
4. Select the node, which will become the end point of the curb.

These two tangent point positions need to define the entire length of an existing string, if only part of a
string will be used for the curb. The first TP point will become the start chainage on the profile of the curb.

The Create Curb from String dialog is displayed.
5. Review the parameters, if needed, change them. Fields are described in the table below.
6. Click OK.

The curb is created.

Fields of the Create Curb from String dialog
Field Description

Name Defines the name of the curb. This name will be used in the curb string and pro-
file.

Start Chainage Defines the start chainage for the curb.

Template Defines the template for curb profile.

Create NS from
DTM

Tick to extract natural surface of the curb profile from an existing DTM.
Select the required DTM from the drop-down list.

Create VIPs
Tick to define the “design surface” that displays in the profile view as a best-
fit curve through the nodes. If the note points on the string have elevations,
these may be defined as the VIPs of the Design surface on the profile.

Additional leaders
for NS points

Tick to create additional leader lines for each change in level on the natural sur-
face.

Open Curb View Tick to display the curb view after creating. See "Profile design view" section
on page 741 for details.

Create Island Curb icon
The Create Island Curb icon of the Intersection group allows you to a curb around the extents of a polygon or of
an enclosed area, formed by lines/strings/arcs. One node of the polygon or shape will be the starting point of the
curb. The polygon or shape will usually represent a traffic island. A circular roundabout can be defined as a
circle.

To create an island curb:
1. In the Intersection group of the Design tab, click the Create Island Curb icon.
2. In the survey view, select the required polygon or enclosed area.
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NOTE
To select an enclosed area, click its border, not the inside area.

3. Select the start point of the curb.

The Curb Point Level dialog is displayed.
4. Select the option for defining curb level and number of IPs. Fields are described in the table below.
5. Click OK.

The Create Island Curb dialog is displayed.
6. Review the properties, if needed change them. Fields are described in the table below.
7. Click OK.

The island curb is created.

Fields of the Curb Point Level dialog
Field Description

Set Levels From
DTM

Select to get the curb point level from an existing DTM. Select the
required DTM from the drop-down list.

Set from Existing
Levels and Inter-
polate Levels for
Points Without

Levels

Select to use get the curb point level from elevations of existing
points. Elevation for points without it will be calculated.

Set Uniform
Levels

Select to manually set curb point level. Specify the required elev-
ation in the editbox.

Number of IP Defines the number of intersection points to display on the main
screen.

Fields of the Create Island Curb dialog
Field Description

Name Defines the name of the island curb. This name will be used in the island curb
string and profile.

Start Chainage Defines the start chainage for the island curb.

Template Defines the template for island curb profile.

Create NS from
DTM

Tick to extract natural surface of the island curb profile from an existing DTM.
Select the required DTM from the drop-down list.

Create VIPs
Tick to define the “design surface” that displays in the profile view as a best-
fit curve through the nodes. If the note points on the string have elevations,
these may be defined as the VIPs of the Design surface on the profile.

Additional leaders
for NS points

Tick to create additional leader lines for each change in level on the natural sur-
face.

Open Curb View Tick to display the curb view after creating. See "Profile design view" section
on page 741 for details.
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Create Intersection icon
The Create Intersection icon of the Intersection group allows you to create an intersection from existing curbs
and profile strings.

Be sure that all unneeded layers are turned OFF. An intersection should be created only from the Curb Returns
and the CL strings of the road. You may also need other strings between the CL and curb returns if these string
impact on the final surface through the intersection.

To create an intersection:
1. In the Intersection group of the Design tab, click the Create Intersection icon.
2. In the survey view, draw a rectangle to define the intersection.

The Create Intersection dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.
5. The intersection is created and opened in the intersection view. See "Intersection design view" section on

page 756 for details.

Fields of the Create Intersection dialog
Field Description

Intersection Name Defines the name of the intersection.

Curb

Selected Curbs Lists all selected curbs. To add curbs to the intersection, select them and click
=>

Curbs in Inter-
section Lists all curbs, which will be used in intersection. To remove curbs from

DTM

Design Surface
DTM

Click Settings to configure the design DTM. See "DTM Settings dialog" sec-
tion on page 626 for details.

Natural Surface
DTM Select the DTM which will be used as natural surface from the drop-down list.

View Intersection icon
The View Intersection icon of the Intersection group allows you to view and edit existing intersections.

To view an intersection:
1. In the Intersection group of the Design tab, click the View Intersection icon.

The Intersections dialog is displayed.
2. Select the required intersection from the list and click Open.

The intersection is opened in the Intersection view. See "Intersection design view" section on page 756 for
details.

To rename an intersection:
1. In the Intersection group of the Design tab, click the View Intersection icon.

The Intersections dialog is displayed.
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2. Select the required intersection from the list and click Rename.
3. Type the new name and press Enter.

The intersection is renamed.

To rename an intersection:
1. In the Intersection group of the Design tab, click the View Intersection icon.

The Intersections dialog is displayed.
2. Select the required intersection from the list and click Delete.

The intersection is deleted.

View Curb icon
The View Curb icon of the Intersection group allows you to open an existing curb in the profile view.

To view a curb:
1. In the Intersection group of the Design tab, click the View Curb icon.
2. In the survey view, select the required curb.

Selected curb is opened in the profile design view. See "Profile design view" section on page 741 for
details.

Update Curb icon
The Update Curb icon of the g allows you to update the parameters of an existing curb.

To update a curb:
1. In the Intersection group of the Design tab, click the Update Curb icon.
2. In the survey view, select the required curb.

The Update Curb Return dialog is displayed.
3. Review the parameters, if needed, change them. Fields are described in the table below.
4. Click OK.

The curb is updated.

Fields of the Update Curb Return dialog
Field Description

Name Defines the name of the curb. This name will be used in the curb string and pro-
file.

Start Chainage Defines the start chainage for the curb.

Template Defines the template for curb profile.

Create NS from
DTM

Tick to extract natural surface of the curb profile from an existing DTM.
Select the required DTM from the drop-down list.
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Field Description

Create VIPs
Tick to define the “design surface” that displays in the profile view as a best-
fit curve through the nodes. If the note points on the string have elevations,
these may be defined as the VIPs of the Design surface on the profile.

Additional leaders
for NS points

Tick to create additional leader lines for each change in level on the natural sur-
face.

Open Curb View Tick to display the curb view after updating. See "Profile design view" section
on page 741 for details.
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Subdivision group
The Subdivision group from the Design tab of the MAGNET Office ribbon allows you to create and manage land
lots. It contains three icons, and nine second level icons, described in the table below.

Lot Layout (min area) icon
Click it to create a lot within a specified area.

Lot by Interior Point icon
Click it to create a lot from closed areas or polygons.

Subdivision icon
This icon contains the list of the second level icons for various
lots operations. Click to expand the list of the second level

icons.
Show Lots icon

Click it to highlight all visible lots in the survey view.
Lot Report icon

Click it to list all lots on the active layers or in the current selec-
tion.

Annotate Lots icon
Click it to annotate a lot.

Annotate Lots Back Boundary icon
Click it to annotate the collinear back boundary of the lot with

bearing distance.
Annotate Lots Sides by Brg/Dist icon

Click it to annotate nominated boundaries of the lot with a bear-
ing and distance.

Annotate Lots Sides by Dist icon
Click it to annotate nominated boundaries of the lot with a dis-

tance.
Delete Lot Annotation icon

Click it to remove all annotations from the lot.
Create ePlan icon

Click it to create a new ePlan.
Edit ePlan icon

Click it to edit an existing ePlan.

Lot Layout (min area) icon
The Lot Layout (min area) icon of the Subdivision group allows you to create one or several lots within spe-
cified closed area composed of lines/strings/arcs. It computes the position of the last boundary line to complete a
lot of a known area.

There are two ways to create a line, which close the area of a new lot:
l "Bearing" method. Creates closing line with the defined bearing.
l "Pivot" method. Creates closing line, pivoted about an existing point.
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Each of these methods may be combined with the "Frontage" method. Frontage method allows you to specify
boundary width at the edge of the lot.

Bearing method
To create a lot, closed by line with the defined bearing:

1. In the Subdivision group of the Design tab, click the Lot Layout (min area) icon.
2. In the survey view, select the required enclosed area.

The message window prompts to accept the selected area.
3. Click Yes.
4. Select the starting edge of the new lot.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
5. Select the Bearing radiobutton and specify the required bearing of the lot boundary in the editbox.
6. In the Area editbox, specify the area of the new lot.
7. Do one of the following:

l Press Enter.
l Right click and select Create from the context menu.

The new lot is created.
8. If needed, create more lots, by using the most suitable method.
9. When finished, press Esc.

The message window prompts to convert the remaining area to lot.
10. Click Yes or No as you need.

Pivot method
To create a lot, closed by line pivoted about an vertex point:

1. In the Subdivision group of the Design tab, click the Lot Layout (min area) icon.
2. In the survey view, select the required enclosed area.

The message window prompts to accept the selected area.
3. Click Yes.
4. Select the starting edge of the new lot.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
5. Select the Pivot radiobutton.
6. Select the required vertex point.
7. In the Area editbox, specify the area of the new lot.
8. Do one of the following:

l Press Enter.
l Right click and select Create from the context menu.

The new lot is created.
9. If needed, create more lots, by using the most suitable method.
10. When finished, press Esc.

The message window prompts to convert the remaining area to lot.
11. Click Yes or No as you need.

Frontage method
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To create a lot, closed by using the "Frontage" method:
1. In the Subdivision group of the Design tab, click the Lot Layout (min area) icon.
2. In the survey view, select the required enclosed area.

The message window prompts to accept the selected area.
3. Click Yes.
4. Select the starting edge of the new lot.

The input panel is displayed at the bottom toolbar. Fields are described in the table below.
5. Select either "Bearing" or "Pivot" method. See sections above for details.
6. Tick the Frontage checkbox.
7. In the survey view, select the frontage edge.
8. The Front Distance dialog is displayed.
9. Specify the frontage distance and click OK.

The new lot is created.
10. If needed, create more lots, by using the most suitable method.
11. When finished, press Esc.

The message window prompts to convert the remaining area to lot.
12. Click Yes or No as you need.

Fields of the bottom toolbar, when creating lots
Field Description

Lot No Defines the number of the next new lot.

Bearing Defines the using of the "Bearing" method and the bearing of the closing line.

Pivot Defines the using of the "Pivot" method.

Frontage Defines the using of the "Frontage" method and frontage distance.

Area Defines the area of the next new lot.

Remaining Area Displays the remaining area within the closed lines.

Lot by Interior Point icon
The Lot by Interior Point icon of the Subdivision group allows you to convert existing polygon/boundary/pad or
enclosed area formed by lines/arcs/strings to a lot.

NOTE
This function does not work with polylines.

To convert polygon or enclosed area to a lot:
1. In the Subdivision group of the Design tab, click the Lot by Interior Point icon.
2. In the survey view, select the required polygon/enclosed area.

The message window prompts you to accept the polygon/enclosed area.
3. Click Yes.

The Edit Lot dialog is displayed. Fields are described in the table below.
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4. Make the required configurations and click OK.
5. If needed, select more polygons/enclosed areas.
6. When finished, press Esc.

The non-editable fields of the Edit Lot dialog
Field Description

Area Displays the area of the lot.

Perimeter Displays the length of the lot perimeter.

Start Point Displays the number of the lot start point.

End Point Displays the number of the lot end point.

Num Points Displays the quantity of the points (excluding centroid point) in the lot.

Num Lines Displays the quantity of the lines in the lot.

Num Arcs Displays the quantity of the arcs in the lot.

CentroidX Displays the X or east component of the lot centroid point position.

CentroidY Displays the Y or north component of the lot centroid point position.

The editable fields of the Edit Lot dialog
Field Description

Name Defines the name of the lot.

Layer Defines layer to which the lot belongs to. Note that the lot and its points may
belong to the different layers.

Line Color Defines a color for lot border displaying.

Line Style
Defines appearance of the lot border both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the lot boundary in millimeters when plotted.

Filling Color Defines the color for lot area filling.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for lot area filling.

Symbol Defines the symbol for lot area filling.

Line Style
Defines the line style for lot area hatching. You may choose them from the line
styles library. For more information about line styles, refer to "Line Style icon"
section on page 55. You may specify the slope of the line in the editbox below.

Cross Select it to activate the cross-hatching of the lot area.

Opaque When ticked, the lot is places in front of any entities, and cut them at a certain dis-
tance around the lot.

DP Number Defines a deposited plan – previous survey plan with reference number

Code Defines a code for the lot area.
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Field Description

House No Defines a number of the house, located at the lot.

Street Defines a name of the street, going through the lot.

Clipping Bound-
ary When ticked, contours, going through the lot, will not be displayed when plotted.

Break Line
A lot may be defined as breakline. The lot must be defined by Use in Surface
points for that. If selected, MAGNET Office treats a breakline as a line or arc
across which you cannot form a triangle.

Annotation

Select it to turn on lot annotation. Possible values for annotation are:
l Lot Name
l Lot Area
l Lot Angle
l Lot Lines
l Lot Arcs
l Back Boundary

Draw Edge Tick to define whether to draw the border line around the lot or not.

Skip Tick to apply the settings made for the first lot to additional lots in this session.

Buttons of the Edit Lot dialog
Button Description

Set Properties Click it to set current properties as the default for lots. New lots will be created
with these properties.

Get Properties Click it to load existing default properties for lots.

Attributes Click it to add new attributes to the lot.

Images/Pdfs
Click it to attach an image or a PDF to the lot. The picture will be displayed
near the lot. For more information about configuring images, refer to "Image
Viewer" section on page 573.

Delete Click it to delete the lot and close the dialog.

Convert Click it to convert the lot to boundary, pad or string.

Apply Click it to apply changes.

Surface Area Click it to compute the area of DTM, crossing with the lot.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Show Lots icon
Click the Show Lots icon of the Subdivision group to highlight existing lots in the survey view.
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Lot Report icon
The Lot Report icon of the Subdivision group allows you to list all lots or lots in the current selection.

To generate a lot report:
1. In the Subdivision group of the Design tab, click the Lot Report icon.

The List Lots dialog is displayed.
2. In the Select From group box, define which lots will be included into report.
3. If needed, configure additional parameters. Fields are described in the table below.
4. Click OK.

The lot report is displayed.

Fields of the List Lots dialog
Field Description

Select From
Defines the lot selection for the report.

l All Lots – all existing lots will be listed.
l Current Selection – only lots from current selection will be listed.

Code Defines the code or codes range for filtering the lot selection.

DP Number Defines the DP number or DP numbers range for filtering the lot selection.

House Number Defines the house number or house numbers range for filtering the lot selec-
tion.

Annotate Lots icon
The Annotate Lots icon of the Subdivision group allows you to annotate lots by using the default annotations set-
tings. See "Lot annotation settings" section on page 613 for details.

To annotate a lot:
1. In the Subdivision group of the Design group, click the Annotate Lots icon.
2. In the survey select the required lot.

The lot is annotated.
3. To annotate more lots, click the Annotate Lots icon once again.

Annotate Lots Back Boundary icon
The Annotate Lots Back Boundary icon of the Subdivision group allows you to annotate collinear back boundary
of the selected lots as defined in the lot annotation settings. See "Lot annotation settings" section on page 613 for
details.

NOTE
TheBack Boundary option of the lot annotation settingsmust be turned on to use this feature.

To annotate lot back boundary:
1. In the Subdivision group of the Design tab, click the Annotate Lots Back Boundary icon.
2. In the survey view, select the required lots, by dragging a rectangle around them.
3. Select the boundary of one lot from the selection.
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The selected boundary is highlighted with red.
4. Continuously select the adjacent collinear boundaries of other lots.
5. Right click and select Annotate from the context menu.

The selected boundaries are annotated.

NOTE
Boundary heremeans the edge of the lot, not the polygon basedMAGNETOffice entity.

Annotate Lots Sides by Brg/Dist icon
The Annotate Lots Sides by Brg/Dist icon of the Subdivision group allows you to annotate the boundaries of the
lot with its bearing and distance, as defined by the annotation settings. See "Bearing annotation settings" section
on page 614 and "Distance annotation settings" section on page 615 for details.

To annotate lot edges:
1. In the Subdivision group of the Design tab, click the Annotate Lots Sides by Brg/Dist icon.
2. In the survey view, select the required lot, by dragging a rectangle around it
3. Select the required boundaries of the lot.

The selected boundaries are highlighted with red.
4. Right click and select Annotate from the context menu.

The selected boundaries are annotated.
5. When finished, press Esc.

NOTE
Boundary heremeans the edge of the lot, not the polygon basedMAGNETOffice entity.

Annotate Lots Sides by Dist icon
The Annotate Lots Sides by Dist icon of the Subdivision group allows you to annotate the boundaries of the lot
with its distance, as defined by the annotation settings. See "Distance annotation settings" section on page 615 for
details.

To annotate lot edges:
1. In the Subdivision group of the Design tab, click the Annotate Lots Sides by Dist icon.
2. In the survey view, select the required lot, by dragging a rectangle around it
3. Select the required boundaries of the lot.

The selected boundaries are highlighted with red.
4. Right click and select Annotate from the context menu.

The selected boundaries are annotated.
5. When finished, press Esc.

NOTE
Boundary heremeans the edge of the lot, not the polygon basedMAGNETOffice entity.
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Delete Lot Annotation icon
The Delete Lot Annotation icon of the Subdivision group allows you to remove annotations from the boundaries
of a lot.

To delete lot edges annotations:
1. In the Subdivision group of the Design tab, click the Delete Lot Annotation icon.
2. In the survey view, select the required lot, by dragging a rectangle around it
3. Select the required boundaries of the lot.

The selected boundaries are highlighted with red.
4. Right click and select the required option from the context menu.

The selected annotations are deleted.
5. When finished, press Esc.

NOTE
Boundary heremeans the edge of the lot, not the polygon basedMAGNETOffice entity.

Create ePlan icon
The Create ePlan icon of the Subdivision group allows you to create a new ePlan.

ePlan is an edit/export feature, which helps you to prepare your data from MAGNET Office job for creation of the
appropriate LandXML file for electronic lodgement to the lands department. It is designed specifically for New
South Wales State in Australia.

Please carefully read ePlan notes before creating your own ePlan.

To create an ePlan:
1. In the Subdivision group of the Design tab, click the Create ePlan icon.

The Create ePlan dialog is displayed.
2. In the Create ePlan dialog, make the required configurations and click OK. Fields are described in the

table below.

The ePlan editor dialog is displayed.
3. If needed, change the properties of newly created ePlan. See "Edit ePlan icon" section on page 372 for

details.
4. Click Exit to close the dialog and return to the survey view.

Fields of the Create ePlan dialog
Field Description

ePlan Name Defines the name of the ePlan.

Description Defines the short description of the ePlan.

Jurisdiction Defines the jurisdiction of the land – New South Wales

MGA Zone Defines the MGA zone. Set automatically, if the coordinate system is defined
in the Project Settings dialog.
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Field Description

Monuments for
Survey Marks

Defines which monument types will be used as the survey marks.
NOTE
Themonument type is defined by the value of the Code field in the point prop-
erties.

Survey Marks Defines which points of the types, defined by the Monuments for Survey Marks
list will be used as the survey marks.

Datum Line Select the start and end points from the appropriate dropdown list to define the
ePlan orientation.

Proposed Parcels
and Points

Define layers where proposed parcels, proposed roads, proposed easements
and any associated new points are located.

CAUTION
Do not tick any layer holding existing parcels

Survey Obser-
vations Define layers where surveyed observations are located.

ePlan notes
There are some specific rules for project, which will be converted to ePlan.

The data for ePlan uses the existing entities from your project. Basically this data will consist of points (some
will represent Monuments for Survey Control Marks or Reference marks), lines (measured, adopted and cal-
culated observations), and lots (new and adjoining parcels and their boundaries). Various entities may need fur-
ther data (or elements) defined.

For example, State Survey Marks will require the "oID" element to be added and existing Monuments will
require the Original Survey number – the plan number that placed the mark. Various other details are required for
observations and parcels.

ePlan naming conventions

Naming and layer conventions are critical to achieving good results. They are described in the table below:

ePlan naming conventions
State Survey Marks Point codes for such marks must be SSM or PM.

Monument Marks Point codes for such marks must use a valid monument type.

New Parcel Name Lot name for new parcels is the new Lot number, for example 10.

Adjoining Parcel
Name Lot name comprises lot number/plan number, for example 5/87410.

Easement Parcel
Name Prefix easement number with "e", for example "e3", "e6".

Road Parcel Name Prefix road number with "R", for example "R1", "R2".

370



Create ePlan icon

Data preparation

To achieve the correct dataset for the creation of an ePlan, it is essential that the civilcad data is prepared appro-
priately using the rules, described in the table below.

ePlan Data Entity Field Description

State Survey Mark Point
Code

Must be SSM or PM.

Each plan must have at least three survey control
marks – two for plan orientation and one for check-
ing.

Layer Use the "Observation" or the "Points" layer or a sep-
arate "SM" layer.

Reference Marks Point
Code Use valid monument name such as DH&W, GIP,

Peg.

Layer Use the "Observation" layer or a suitable "Refer-
ence" layer.

Boundary Points Point

Code No code required.

Layer

New boundary points created by this plan must be
on the relevant layer for new parcels.

Existing boundary points should be on another layer,
such as "Adjoining Parcels" layer or on their own
layer.

New Parcels Lot

Code Use the new lot number – no other characters
should be specified.

Layer

Create new allotment parcels on their own layer, for
example "Parcels_Proposed".

New points created by these parcels should be loc-
ated on the same layer.

Easement Parcels Lot

Name Prefix easement number with ‘e’ – no other char-
acters should be specified.

Layer

Create new easement parcels on their own layer for
example "Parcels_Easement" or "Easement".

New easement parcels points should be located on
the same layer.

Any existing easement parcels should be located on
a separate layer
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ePlan Data Entity Field Description

Road Parcels Lot

Name Prefix easement number with ‘R’ – no other char-
acters should be specified.

Layer

Create new road parcels on their own layer for
example "Parcels_Roads" or "Roads".

New road parcels points should be located on the
same layer.

Any existing road parcels should be located on a sep-
arate layer.

Adjoining Parcels Lot

Name Use lot number/DP number, for example 5/87410.

Layer

Create new adjoining parcels on their own layer for
example "Parcels_Lots" or "Parcels_Adjoining".

New adjoining parcels points should be located on
the same layer.

NOTE
Parcels included for adjoining information, may
abut or be remote from the subject land.

Observations
Line

Surveyed observations to position and check Survey
Marks and any other Monumented Marks.

Boundary observations are taken from the proposed
parcel definition.

Layer Keep observation data on separate "Observation"
layers.

Curved Boundary
Arc

Any curved boundary of a parcel must be created as
a 2-point arc with a centre point. Do not use 3 point
arcs.

Layer Should be created on appropriate parcel layer.

Attributes

The database structure designed by the Department of Lands requires a surveyor to include additional data for
some of the entities that are written into the LandXML file.

These include identification number, currency date, class, and order of State Survey Control Marks, original sur-
vey plan for monumented Survey Marks and the state and condition of such marks.

Many of these additional elements have a list of defined values to select from, while others will require the sur-
veyor to enter a text string or numeric value.

You may configure this by using the Attribute property for each particular entity. See "MAGNET Office entities
properties" section on page 545 for details.

Edit ePlan icon
The Edit ePlan icon of the Subdivision group allows you to edit an existing ePlan LandXML file.
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ePlan is an edit/export feature, which helps you to prepare your data from MAGNET Office job for creation of the
appropriate LandXML file for electronic lodgement to the lands department. It is designed specifically for New
South Wales state in Australia.

Please carefully read ePlan notes before editing ePlans.

To edit an ePlan:
1. In the Subdivision group of the Design tab, click the Edit ePlan icon.

The Open dialog is displayed.
2. Open the required ePlan file.

The ePlan editor dialog is displayed. If errors are found, the will be listed in the bottom right panel of the
dialog (marked as 3 at the picture below).

3. Make the required configurations. Refer to descriptions below for details.
4. Click Save.
5. Click Exit to close the dialog.

ePlan editor dialog
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Fields of the ePlan editor dialog
Field Description

Jurisdiction Displays the jurisdiction of the land – New South Wales

MGA Zone Displays the MGA zone.

Datum Line Displays the start and end points of the datum line, which defines the ePlan ori-
entation.

Project Displays the project, from which the ePlan is created.

Created Displays the ePlan creation time and date.

Buttons of the ePlan editor dialog
Button Description

Open Click it to open an ePlan for editing.

Validate Click it to validate currently opened ePlan. Found errors will be displayed in
the bottom right panel of the dialog (marked as 3 at the picture above).

Save As Click it to save the ePlan with the new name, and/or in the another location.

Report Click it to generate a report, listed errors in the ePlan.

Copy From Click it to load settings from another ePlan file.

Exit Click it to close the dialog.

The data in the file comprises groups of data for Points, Parcels, Survey (including Observations) and Survey
Marks. These are listed at the left panel of the dialog (marked as 1 at the picture below). The data in this panel is
defined from the naming conventions, layers and other rules.

Points group
Click the plus sign to extend the list of the points. Click to a point to display its details on the top right panel
(marked as 2 at the picture above).

Each point in the dataset has a point number (name), coordinates and elevation (if available) The points represent
boundary points, traverse points, reference marks, permanent survey marks and various administrative points.

The fields marked in red may be edited but their value must be chosen from the pre-configured lists.

Fields of Point record
Field Description

state

May have Existing or Proposed value. No further settings required.

TIP

Values for new points from the Proposed layers are automatically set to Pro-
posed.
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Field Description

pntSurv

Depending on the type of the point may have one of the following values:
l Control for State Survey Marks.
l Reference for Monumented Reference Marks.
l Boundary for parcel boundary points.
l Sideshot for centre points of arcs, centre points of parcels and any other
undefined points.

TIP

If the point needs an alternative definition, you may define its pntSurv attribute
and select the required value.

oID Required for Survey Control Points. Its value is the Mark Number from
SCIMS.

Parcels group
Click the plus sign to extend the list of the parcels. Click to a parcel to display its details on the top right panel
(marked as 2 at the picture above).

Each parcel in the dataset has its name and its area displayed. The parcels list represents adjoining parcels, pro-
posed parcels for new lots, easement parcels and road parcels.

The fields marked in red may be edited but their value must be chosen from the pre-configured lists.

Fields of Parcel record
Field Description

state

May have Existing or Proposed value. No further settings required.

TIP

Values for new points from the Proposed layers are automatically set to Pro-
posed.

class

May have one of the following values:
l Lot.
l Road.
l Restriction on use of land.

TIP

Set other parcel classes with the ‘class’ Attribute for the parcel and select a suit-
able value, such as "Easement".

desc

Road parcels and easement parcels must have the desc field set. For road par-
cel it should contain the name of the road. For easement parcel it should
describes the easement such as easement for drainage 1 wide or restriction on
use of land.

Survey group
Click the plus sign to extend the list of the parcels. Click to a parcel to display its details on the top right panel
(marked as 2 at the picture above).

The Survey Headersection holds the Name and desc properties for the dataset. Check the other settings to ensure
they are appropriate
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The Instrument Setups list the point number used for an observation to another point; no further input required

The Observation Group lists all the reduced observations in the dataset. These are:
l ReducedObservation— point to point line observation that represents a surveyed, adopted or calculated
observation including.

l ReducedArcObservation— point to point arc observation.
l RedHorizontalPosition— details of horizontal position of a survey control mark.
l RedVerticalPosition— details of vertical position of a survey control mark (only mandatory for plans defin-
ing stratum boundaries that use a survey control mark as one of the required bench marks).

Fields of ReducedObservation record
Field Description

desc The value is set to Boundary (parcel boundaries) or Road (parcel boundaries
adjacent to a Road parcel). All other observations are set to Connection.

distanceType The value does not need to be set for Measured as it is assumed by ePlan for
the observation. This element only needs to be defined if the observation has
not been measured in the surveyazimuthType

Fields of ReducedArcObservation record
Field Description

arcType
Only set this if the arc has not been measured in the survey.

TIP

You may define the Arc Type attribute with the value Adopted or Calculate.

adoptedSurvey If the observation is adopted, use the adoptedSurvey attribute for the arc to set
the required plan number.

Fields of RedHorizontalPosition record
Field Description

RedHorPos.class Set the class for the State Survey Mark.

RedHorPos.order Set the order for the State Survey Mark.

RedHorPos.currencyDate Specify the date in the format YYYY-MM-DD.

NOTE
This data relates to the State SurveyMarks; use Attributes for the point representing the State Survey
Mark. The Horizontal Fix is set to SCIMS and the Datum toMGA.

Fields of RedVerticalPosition record
Field Description

RedHorPos.class Set the class for the State Survey Mark.

RedHorPos.order Set the order for the State Survey Mark.

RedVerObs.verticalDatum This is usually set to AHD.
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NOTE
This data relates to the State SurveyMarks and is entered as Attributes for the point used to define the
State SurveyMark. Onlymandatory for Strata surveyswhere the SSM is used for a benchmark.

Survey Marks group
Click the plus sign to extend the list of the survey marks. Click to a survey mark to display its details on the top
right panel (marked as 2 at the picture above).

The survey marks are monumented points in the dataset. Each Survey Mark has its point number and its monument
type displayed in the details.

Fields of Survey Mark record
Field Description

state By default existing Survey Marks are set to Found – proposed survey marks
are set to Placed. Other values may relevant.

originSurvey All existing Survey Marks require the origin survey. The value entered is the
plan number that placed the mark or last changed the mark.

condition If needed, select the appropriate value from the drop-down list.
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Pad group
The Pad group from the Design tab of the MAGNET Office ribbon allows you to work with buildings pads. It con-
tains two icons, described in the table below.

Create Pad icon
Click it to create a new pad.

Pad Design icon
Click it to compute the elevation of a building pad and slope positions at a defined

grade from the pad to a nominated existing surface.

Create Pad icon
The Create Pad icon of the Pad group allows you to create a new pad. The pad can be created from existing
points, lines, strings, or polygon, or from new points.

The pad is saved with a unique name. You can create the pad with no elevation or with elevations that are rel-
ative to each other to define a surface. A complex pad may also include points with elevations in the body of the
polygon, so that a surface model of the pad can be created.

To create a pad:
1. In the Pad group of the Design tab, click the Create Pad icon.

The input panel for point creation is displayed at the bottom toolbar. Description of the fields may be found
in the table below.

2. Locate the nodes of the pad.
3. To close the pad area do one of the following:

l Locate the last point at the same place as the first point.
l Press Esc. The message window prompts to save the pad. Click OK. The last created point will be
connected with the first point with the shortest line possible.

The Edit Pad dialog is displayed.
4. In the Name editbox, type the name of the newly created pad.
5. Review the rest of the pad properties of the newly created polygon, if needed change them. For more

information refer to "Pad properties" section on page 565.
6. Click OK.

The pad is created.

Fields of the input panel, when creating pads
Field Description

Number Defines the number of the next new point.

East Defines the East (X) coordinate of the pad point.

North Defines the North (Y) coordinate of the pad point.

Elev Defines the elevation of the pad point.

Code Defines the code of the pad point.

Use in Surface Defines whether the line start/end point may be used in surface or not.
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Field Description

Interpolate Elev-
ation Defines whether the elevation of the pad point will be interpolated.

BreakLine Defines whether the lines of the new pad be a breakline.

Pad Design icon
The Pad Design icon of the Pad group allows you to compute the elevation of a building pad and slope positions at
a defined grade from the pad to a nominated existing surface. A new surface is created for the pad and slopes.
This surface may be merged with the existing surface to create an overall finished surface. A volumes com-
putation for cut and fill volumes is displayed during the design process with the option to position the pad at a level
where the cut volume equals the fill volume.

The pad may have its own surface model to represent the grade changes across the pad.

To design a pad surface:
1. In the Pad group of the Design tab, click the Pad Design icon.

The Pad Design dialog, opened at Settings tab is displayed.
2. Define the pad for design. Do one of the following:

l Select it from the Pad drop down list.
l Click Load File to load pad from an external Civilcad bld (*.bld) file.

3. Configure the other properties. Fields are described in the table below.
4. Click OK.

The Pad Design dialog, opened at Design Parameters tab is displayed.

The various fields on this tab allow you to set a range of properties to compute and to test a suitable final
layout for the pad. MAGNET Office calculates the volumes for the defined side slopes, the height of the
pad, and its surface if used, relative to the levels on the natural surface.

5. Configure the parameters as you need. Fields are described in the table below.
6. Do one of the following:

l Click Compute to calculate initial cut and fill volumes.

Be aware that the slopes may only be computed as long as the side slopes and levels chosen allow
for the slope to be inside the extents of the available natural surface. Error messages will appear if a
computation cannot be made.

The maximum distance defined my not relate to the slopes and pad level. You may need to modify
the angular setting, especially on complex shaped pads. You may need to adjust the spacing between
the slope intercept (cross section) calculations.

l Click Cut = Fill. The Cut=Fill computation is an interactive procedure and may take some time to
achieve a result if complex surfaces are involved. The iteration limit on the Settings tab may need to
be increased.

7. Once the pad position and volumes suit the project design, the pad position levels, surface, and slopes
should be saved to the survey view by clicking Save.

8. When the data has been saved to the survey view, click OK to close the Pad Design dialog.
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Fields of the Settings tab of the PadDesign dialogs
Field Description

Design Name Defines the name of the pad design.

Pad Defines the pad for design. You may select pad existing in the current project
from the drop-down list, or load it from an external Civilcad bld (*.bld) file.

Natural Surface
Defines an existing surface to be used for the slope intercepts. Tick the Dis-
play NS checkbox to display the natural surface mesh in the design process win-
dow.

Pad Surface
(Optional)

Defines an existing surface that represents the grades across the pad
(optional). If no surface exists, then a plane surface is computed from the rel-
ative levels of the points defining the pad edges. Tick the Display Pad check-
box to display the natural surface mesh in the design process window.

Movable Enables movement of the pad to another position. This is useful when pos-
itioning a standard pad to different locations.

Insert Point Defines one of the pad nodes as insertion point.

Index
Defines the number of the pad node, which will be used as insertion point. Pad
node index numbers are annotated in the Pad Preview window. The current
insertion point is highlighted with red.

X, Y, Z Defines the coordinates of the pad insertion point.

Rotation Defines the rotation of the pad around insertion point.

Scale Changes pad scale.

Iteration Limit

Defines the quantity of iteration, when computing the pad surface. The default
value is 30. It may need to be increased for complex pads, where more cal-
culations are needed to position the pad and compute the slop intercepts and
volumes. This is important when computing equal cut/fill volumes.

Fields of the Design Parameters tab of the PadDesign dialogs
Field Description

Color Defines the color for displaying cut, fill, natural surface and pad surface
respectively.

Spacing
Tick the Approximate Arc checkbox to approximate arc with chord lines and
specify the arc to chord distance for curved breaklines in the Arc-to-chord
Distance editbox.

Slope

Cut 1 Defines horizontal component of the slope in a cut situation.

Fill 1 Defines horizontal component of the slope in a fill situation.

Max Distance Defines the maximum distance in meters from the pad perimeters that the
routine will search for a slope intercept within the existing surface.
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Field Description

Factor Defines the swelling or shrinking factor, which leads to increasing or decreas-
ing volume by specified ratio.

Bench

Depth Defines how often a bench will be calculated in the side slope.

Width Defines the width of the bench.

Level
Start with an approximate level for the insert point on the pad. Click Compute
to check the volumes at this level and display the slope lines and cut/fill sec-
tions.

Increment Defines the increment to which the pad will be raised or loved after clicking
Raise or Lower.

Fill Displays the computed fill volume.

Cut Displays the computed cut volume.

Control Line
Layer

The data on this layer is displayed in the preview window as a guide to the pos-
ition on the pad and the extents of the computed slopes. Data on a specific
layer may be critical to these computations. Any layer that is in the project
may be displayed.

Batter Layer This layer holds the cut and fill batter lines and points when the computation is
complete, and the data is saved in the Survey View.
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Sewer group
The Sewer group from the Design tab of the MAGNET Office ribbon allows you to:

l Specify sufficient data to describe an urban sewerage network with one outfall per pipe network.
l Interactively design the pipes to obtain optimum combination of pipe slope and depth, and to avoid any
obstructions.

Before you start you sewer design, configure a new layer for the sewer line you are about to create as well as set-
ting its colour, line style and the symbol for the pits. All sewer lines will be created as strings. The points defin-
ing the string represent the pits.

You should also have valid sewer library configuration. See "Sewer library" section on page 666 for details.

Sewer design requires a design of a network of pits and pipes. The pits, points, and pipes, strings, are initially
defined in the survey view. After the network is created it may be opened for reviewing and editing in the sewer
view.

The group contains three icons and three second level icons, described in the table below.

Create Sewer icon
Click it to create a sewer string. This icon also contains the list of the

second-level icons. Click to see them.

Create BCIL icon
Click it to define the BCIL data.
Create Sewer Network icon

Click it to create a sewer network from existing sewer channels.
Add Pit icon

Click it to add an existing point as the pit to the sewer pipeline.
Delete Pit icon

Click it to remove an existing pit point from the sewer pipeline.

Create Sewer icon
The Create Sewer icon of the Sewer group allows you to create sewer strings.

Note, that all sewer lines will be created as strings. The points defining the string represent the pits. Each man-
hole (pit) point must be given an initial elevation which becomes the lid level for the pit. The string defines the
order of pits (manholes) in a line and should start from the Upstream pit (manhole).

To create a sewer string:
1. In the Sewer group of the Design tab, click the Create Sewer icon.
2. In the survey view, locate the pit point.

The Pit Data at Point dialog is displayed.
3. Configure the parameters. Fields are described in the table below.
4. Click OK.
5. Locate the second and further pits in a same way. When finished, press Esc.

The message prompts to save the string.
6. Click Yes.
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The Create Sewer String dialog is displayed.
7. Review the properties, if needed, change them. Fields are described in the tables below.
8. Click OK.

The sewer string is created.

Fields of the Pit Data at Point dialog
Field Description

Elevation Defines the lid level for the pit.

Pit name Defines the pit name.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Non-editable fields of the Create Sewer String dialog
Field Description

Start Point Displays the number of the sewer string start point.

End Point Displays the number of the sewer string end point.

Num Points Display quantity of the points in the sewer string.

Length Display the length of the sewer string.

Editable fields of the Create Sewer String dialog
Field Description

Name Defines the name of the sewer string.

Layer Defines layer to which the sewer string belongs to.

Color Defines a color for sewer string displaying.

Line Style
Defines appearance of the sewer string both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the sewer string in millimeters when plotted.

is Smoothed Select it to apply a smoothing spline algorithm to the sewer string. It is used for
plotting purposes and has no influence on any computations.

Break Line
A sewer string may be defined as breakline. The string must be defined by Use
in Surface points for that. If ticked, MAGNET Office treats a breakline as a
line or arc across which you cannot form a triangle.
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Create BCIL icon
The BCIL (Block Control Invert Level) is a tool will ensure that Magnet Office designs the sewer pipe low
enough to carter for a specified minimum slope from the drain point at the house so the house may be connected
to the sewer line properly.

NOTE
The BCIL is an optional feature.

BCIL data are defined in the survey view by the point entities, with the special point code. There are three types
of the BCIL points:

l House Connection (HC) — this point should have @HCxxxx code.
l Sewer Connection (SC) — this point should have @SCxxxx code.
l Intermediate Connection (IC) — this point should have @ICxxxx code.

The xxxx parts in the point codes represent any alphanumeric string. Usually it defined by the lot name. BCIL
points from the same lots should have the same alphanumeric parts.

All BCIL point must have defined elevations and must be located at the same layer with the sewer line to which
they are must be connected.

The Create BCIL icon of the Sewer group allows you to associate the BCIL points with the sewer design or
update the BCIL information, if any changes were made with the BCIL points or sewer.

To add the BCIL data to a sewer design:
1. In the survey view, create the BCIL points matching requirements, described above.
2. In the Sewer group of the Design tab, click the Create BCIL icon.

The points are added to the sewer design, and the report is displayed.

Create Sewer Network icon
The Create Sewer Network icon of the Sewer group allows you to create sewer network from existing sewer
strings.

To create a sewer network:
1. In the Sewer group of the Design tab, click the Create Sewer Network icon.
2. In the survey view, select the main sewer string. All sewer strings, which are connected to it, will be used

in design.

The Create Sewer Network dialog is displayed.
3. In the Network Name editbox, specify the name of the new network.
4. From the Network Settings drop-down list, select the required library settings set. See "Sewer library" sec-

tion on page 666 for details.
5. If needed, define the primary and secondary DTMs by ticking the appropriate checkboxes and selecting

DTMs from the drop-down lists to generate surfaces.
6. Nominate obstruction strings. See "Compute obstructions" section on the facing page for details.
7. In the Pit Name group box, define the pit name creation method.
8. Click OK.
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Fields of the Create Sewer Network dialog
Field Description

Network Name Defines the name of the new sewer network.

Network Settings Defines the used set of the library settings. See "Sewer library" section on
page 666 for details.

Primary DTM Defines the primary DTM for generating surface.

Secondary DTM Defines the secondary DTM for generating surface.

Compute Obstruc-
tions

Defines obstruction strings. See "Compute obstructions" section below for
details.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Compute obstructions
MAGNET Office allows you to specify obstructions along a given pipe reach at certain depths and to specify the
clearances required. All obstruction points created in the survey view must be given heights and be joined into a
string.

An obstruction is created as a string in the survey view, with the node points defining the level of the obstruction
in or above the ground surface. The string is saved and named and set as a service.

Other networks such as Drainage networks are automatically identified as an obstruction if the other network
crosses a sewer line. Drainage network pipe sizes are extracted directly from Drainage Design.

To configure this option:
1. Tick the Compute Obstructions checkbox.
2. Click Set Obstructions.

The Select Obstructions dialog is displayed.
3. Select the required service strings from the Valid Service String list and click >>.
4. The selected strings are displayed in the Selected Obstructions list. If needed to remove a string, select it

and click <<.
5. Click OK.

Add Pit icon
The Add Pit icon of the Sewer group allows you to add an existing point as the pit to the sewer pipeline.

To add a point as a pit:
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1. In the Sewer group of the Design tab, click the Add Pit icon.
2. In the survey view, select the required point.
3. In the survey view, select the pipe section of a sewer string to which pit will be added.

The pit is added.

Delete Pit icon
The Delete Pit icon of the Sewer group allows you to remove an existing pit point from the sewer pipeline.

To remove a pit from a sewer pipeline:
1. In the Sewer group of the Design tab, click the Delete Pit icon.
2. In the survey view, select the required p.

The pit is deleted.
3. Update level and obstruction data in the sewer view. See "Sewer design view" section on page 835 for

details.
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Drainage group
The Drainage from the Design tab of the MAGNET Office ribbon group allows you to:

l Define sufficient data to describe an urban drainage network with one outfall per pipe network.
l Perform hydrological calculations to calculate surface runoff, channel flow and pipe flow.
l Interactively design the pipes to obtain the optimum combination of pipe diameter/slope/depth and to avoid
any obstructions.

l Perform a back-water check to ensure satisfactory hydraulic performance.
l Produce printed or plotted reports of the calculations, as well as plots of the longitudinal sections.

Before you start you drainage design, configure a new layer for the drainage line you are about to create as well
as setting its colour, line style and the symbol for the pits. All drainage lines will be created as strings. The points
defining the string represent the pits.

You should also have valid drainage library configuration. See "Drainage library" section on page 668 for details.

Drainage design requires a design of a network of pits and pipes. The pits, points, and pipes, strings, are initially
defined in the survey view. After the network is created it may be opened for reviewing and editing in the drain-
age view.

Each manhole (pit) point must be given an initial elevation; this becomes the lid level for the pit. The string
defines the order of pits (manholes) in a line and should start from the Upstream pit (manhole).

The group contains three icons, described in the table below.

Create Drainage icon
Click it to create a single drainage channel.

Create Drainage Network icon
Click it to create a drainage network from existing drainage

strings.
Update Drainage Network icon

Click it to edit an existing drainage network.

Create Drainage icon
The Create Drainage icon of the Drainage group allows you to create drainage strings.

Note, that all drainage lines will be created as strings. The points defining the string represent the pits. Each man-
hole (pit) point must be given an initial elevation which becomes the lid level for the pit. The string defines the
order of pits (manholes) in a line and should start from the Upstream pit (manhole).

To create a drainage string:
1. In the Drainage group of the Design tab, click the Create Drainage icon.
2. In the survey view, locate the pit point.

The Pit Data at Point dialog is displayed.
3. Configure the parameters. Fields are described in the table below.
4. Click OK.
5. Locate the second and further pits in a same way. When finished, press Esc.

The message prompts to save the string.
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6. Click Yes.

The Create Drainage String dialog is displayed.
7. Review the properties, if needed, change them. Fields are described in the tables below.
8. Click OK.

The sewer string is created.

Fields of the Pit Data at Point dialog
Field Description

Elevation Defines the lid level for the pit.

Pit name Defines the pit name.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Non-editable fields of the Create Drainage String dialog
Field Description

Start Point Displays the number of the drainage string start point.

End Point Displays the number of the drainage string end point.

Num Points Display quantity of the points in the drainage string.

Length Display the length of the drainage string.

Editable fields of the Create Drainage String dialog
Field Description

Name Defines the name of the drainage string.

Layer Defines layer to which the drainage string belongs to.

Color Defines a color for drainage string displaying.

Line Style
Defines appearance of the drainage string both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the drainage string in millimeters when plotted.

is Smoothed Select it to apply a smoothing spline algorithm to the drainage string. It is used
for plotting purposes and has no influence on any computations.
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Field Description

Break Line
A drainage string may be defined as breakline. The string must be defined by
Use in Surface points for that. If ticked, MAGNET Office treats a breakline as
a line or arc across which you cannot form a triangle.

Compute obstructions
MAGNET Office allows you to specify obstructions along a given pipe reach at certain depths and to specify the
clearances required. All obstruction points created in the survey view must be given heights and be joined into a
string.

An obstruction is created as a string in the survey view, with the node points defining the level of the obstruction
in or above the ground surface. The string is saved and named and set as a service.

Other networks such as Sewer networks are automatically identified as an obstruction if the other network crosses
a sewer line. Sewer network pipe sizes are extracted directly from Sewer Design.

To configure this option:
1. Tick the Compute Obstructions checkbox.
2. Click Set Obstructions.

The Select Obstructions dialog is displayed.
3. Select the required service strings from the Valid Service String list and click >>.
4. The selected strings are displayed in the Selected Obstructions list. If needed to remove a string, select it

and click <<.
5. Click OK.

Create Drainage Network icon
The Create Drainage Network icon of the Drainage group allows you to create drainage network from existing
drainage strings.

To create a drainage network:
1. In the survey view, select the main drainage string. All drainage strings, which are connected to it will be

used in design.
2. In the Drainage group of the Design tab, click the Create Drainage Network icon.

The Create Drainage Network dialog is displayed.
3. In the Network Name editbox, specify the name of the new network.
4. From the Network Settings drop-down list, select the required library settings set. See "Drainage library"

section on page 668 for details.
5. If needed, define the primary and secondary DTMs by ticking the appropriate checkboxes and selecting

DTMs from the drop-down lists to generate surfaces.
6. Nominate obstruction strings. See "Compute obstructions" section above for details.
7. In the Pit Name group box, define the pit name creation method.
8. From the Main Line drop-down list, select the main drainage string.
9. Click OK.
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Fields of the Create Drainage Network dialog
Field Description

Network Name Defines the name of the new drainage network.

Network Settings Defines the used set of the library settings. See "Drainage library" section on
page 668 for details.

Primary DTM Defines the primary DTM for generating surface.

Secondary DTM Defines the secondary DTM for generating surface.

Compute Obstruc-
tions

Defines obstruction strings. See "Compute obstructions" section on page 385
for details.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Main Line Defines the main drainage string in the network.

Update Drainage Network icon
The Update Drainage Network icon of the Drainage group allows you to update an existing drainage network if
any changes were made with network entities from the survey view.

To update a drainage network:
1. In the survey view, select the main drainage string of the existing network.
2. In the Drainage group of the Design tab, click the Update Drainage Network icon.

The Update Drainage Network dialog is displayed.
3. From the Network Name drop-down list, select the network for editing.
4. If needed, define the primary and secondary DTMs by ticking the appropriate checkboxes and selecting

DTMs from the drop-down lists to generate surfaces.
5. Nominate obstruction strings. See "Compute obstructions" section on the previous page for details.
6. In the Pit Name group box, define the pit name creation method.
7. From the Main Line dropdown list, select the main drainage string.
8. Click OK.

Fields of the Update Drainage Network dialog
Field Description

Network Name Defines drainage network for editing.

Primary DTM Defines the primary DTM for generating surface.
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Field Description

Secondary DTM Defines the secondary DTM for generating surface.

Compute Obstruc-
tions

Defines obstruction strings. See "Compute obstructions" section on page 385
for details.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Main Line Defines the main drainage string in the network.
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Design Views group
The Design Views group from the Design tab of the MAGNET Office ribbon allows you to view and edit project
design data. It contains seven icons, described in the table below.

Roads icon
Click it to review/update an existing road.

Profile icon
Click it to review/update an existing profile.

Intersection icon
Click it to review/update an existing intersection.

Resurface icon
Click it to manage roads resurfacing.

Drainage icon
Click it to review/update an existing drainage.

Sewer icon
Click it to review/update an existing sewer.

Cut/Fill icon
Click it to review/update an existing cut/fill color map.

Roads icon
The Roads icon of the Design Views group allows you to create new or view and edit an existing road.

Click the icon to open the Roads dialog, listing all existing roads.

To edit a road:
1. Select the required road from the list and click Open.

The road is opened in the road view. See "Road design view" section on page 671 for details.

To rename a road:
1. Select the required profile from the list and click Rename.
2. Type the new name and press Enter.

The road is renamed.

To delete a road:
1. Select the required road from the list and click Delete.

The road is deleted.

To create a new road:
1. Click New.

The Create Road Design dialog is displayed.
2. From the Alignment drop-down list, select the base alignment for a road.
3. Configure the natural surface and cross section parameters as you need. Fields are described in the table

below.
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Fields of the Create Road Design dialog
Field Description

Alignment Defines the base alignment for the road.

Natural Surface

Name Defines the name of the road natural surface.

From DTM Select to extract road natural surface from an existing DTM.

From Level Select to define a natural surface from the specified level.

Left Limit Defines the road width to the left from the base alignment.

Right Limit Defines the road width to the right from the base alignment.

Cross Section

Include TPs and IPs Tick to create cross sections at TPs and IPs.

Cross Section at IPs Defines the cross section position at the IPs.

Spacing Defines the base spacing between cross sections for straight and curved seg-
ments of the alignment.

Profile icon
The Profile icon of the Design Views group allows you to view and edit existing profiles.

Click the icon to open the Profiles dialog, listing all existing profiles.

To edit a profile:
1. Select the required profile from the list and click Open.

The profile is opened in the profile view. See "Profile design view" section on page 741 for details.

To rename a profile:
1. Select the required profile from the list and click Rename.
2. Type the new name and press Enter.

The profile is renamed.

To delete a profile:
1. Select the required profile from the list and click Delete.

The profile is deleted.

Intersection icon
The Intersection icon of the Design Views group allows you to view and edit existing intersections.

Click the icon to open the Intersections dialog, listing all existing intersections.

To view an intersection:
1. Select the required intersection from the list and click Open.

The intersection is opened in the Intersection view. See "Intersection design view" section on page 756 for
details.

To rename an intersection:
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1. Select the required intersection from the list and click Rename.
2. Type the new name and press Enter.

The intersection is renamed.

To delete an intersection:
1. Select the required intersection from the list and click Delete.

The intersection is deleted.

Resurface icon
The Resurface icon of the Design Views group allows you to renew the asphalt surface of an existing road.

Click the icon to open the Resurface dialog, listing all existing roads.

To edit a road:
1. Select the required road from the list and click Open.

The road is opened in the resurface view. See "Resurface design view" section on page 774 for details.

To rename a road:
1. Select the required profile from the list and click Rename.
2. Type the new name and press Enter.

The road is renamed.

To delete a road:
1. Select the required road from the list and click Delete.

The road is deleted.

To create a new surface for road:
1. Click New.
2. In the survey view, select the base strings for resurfacing. Press Esc when finished.

The Create New Resurface Data dialog is displayed.
3. From the Select Center Line list, select the required base string. If the required string is not in the list,

click Pick>> and select it the survey view.
4. If needed, define the profile elevation file in the appropriate field.
5. Click OK.
6. The Create Alignment dialog is displayed.
7. Configure the parameters as you need. Fields are described in the table below.
8. Click OK.

The road is opened in the resurface view. See "Resurface design view" section on page 774 for details.

Fields of the Edit Alignment dialog
Field Description

Name Defines the name of the alignment.

Start IP Displays the number of the alignment start intersection point.

End IP Displays the number of the alignment end intersection point.
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Field Description

Num IPs Display quantity of the intersection points in the alignment.

Start Chain Defines the chainage or the running distance of the alignment start intersection
point.

End Chain Displays the chainage or running distance at the end of the alignment.

Length Display the length of the alignment.

Layer Defines layer to which the alignment belongs to. Note that the alignment and
its points may belong to the different layers.

Color Defines a color for alignment displaying.

Line Style
Defines appearance of the alignment both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the alignment in millimeters when plotted.

Buttons of the Edit Alignment dialog
Button Description

Set Properties Click it to set current properties as the default for alignments. New alignments
will be created with these properties.

Get Properties Click it to load existing default properties for alignments.

Images/Pdfs
Click it to attach an image or a PDF to the alignment. The picture will be dis-
played near the alignment. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the alignment and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Drainage icon
The Drainage icon of the Design Views group allows you to view and edit existing drainage networks.

Click the icon to open the Drains dialog, listing all existing drainage networks.

To edit a drainage network:
1. Select the required network from the list and click Open.

The road is opened in the road view. See "Drainage design view" section on page 818 for details.

To rename a drainage network:
1. Select the required network from the list and click Rename.
2. Type the new name and press Enter.

The drainage network is renamed.

To delete a drainage network:
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1. Select the required network from the list and click Delete.

The drainage network is deleted.

Sewer icon
The Sewer icon of the Design Views group allows you to view and edit existing sewer networks.

Click the icon to open the Sewers dialog, listing all existing sewer networks.

To edit a sewer network:
1. Select the required network from the list and click Open.

The road is opened in the road view. See "Sewer design view" section on page 835 for details.

To rename a sewer network:
1. Select the required network from the list and click Rename.
2. Type the new name and press Enter.

The sewer network is renamed.

To delete a sewer network:
1. Select the required network from the list and click Delete.

The sewer network is deleted.

Cut/Fill icon
The Cut/Fill icon of the Design Views group allows you to view and edit existing cut/fill color maps.

Click the icon to open the Cut/Fills dialog, listing all existing cut/fill color maps.

To view a cut/fill map:
1. Select the required cut/fill map from the list and click Open.

The color map is opened in the Cut/Fill view. See "Cut/Fill design view" section on page 853 for details.

To rename a cut/fill color map:
1. Select the required cut/fill map from the list and click Rename.
2. Type the new name and press Enter.

The color map is renamed.

To delete a cut/fill map:
1. Select the required cut/fill color map from the list and click Delete.

The color map is deleted.

To create a new cut/fill map:
1. Click New.

The Create Cut/Fill DTM dialog is displayed.
2. From the First DTM drop-down list, select the DTM for a calculation of height difference.
3. Specify one of the following:

l From the Second DTM drop-down list, select the DTM for a calculation of depth difference.
l Tick the From Levelcheckbox, and specify an elevation from which the elevation difference will be
calculated in the editbox.
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4. In the Output DTM editbox, specify the name of the resulting DTM.
5. Define the colors for cut and fill in the appropriate drop-down lists.
6. Click OK.
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Model Tab
The Model tab of the MAGNET Office ribbon contains control icons, which allows you to recreate existing loc-
ation of your project, and create new objects here. It is separated to six groups:

l "Layer Group group" section on the facing page
l "Cleanup group" section on page 406
l "Raster/Vector group" section on page 408
l "Strings group" section on page 412
l "Elevate group" section on page 418
l "DTM group" section on page 424
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Layer Group group
The Layer Group group from the Model tab of the MAGNET Office ribbon allows you to configure project's lay-
ers. It contains four icons and ten second level icons, described in the table below.

Add to Group icon
Click it to add layer to the layer group. This icon also contains

the list of the second-level icons. Click to see them.

Add to Group - Design icon
Click it to add layer to the 'Design' layer group.

Add to group - Existing icon
Click it to add layer to the 'Existing' layer group

Add to Group - Misc icon
Click it to add layer to the 'Miscellaneous' layer group.

Assign Layer to Group icon
Click it to add layers to a layer group.

Color Settings icon
Click it to configure colors layout in the project.

Display/Hide Group icon
Click it to configure layer groups visibility. This icon also con-
tains the list of the second-level icons. Click to see them.

Display Group - Design icon
Click it turn on displaying of the 'Design' layer group.

Group Settings icon
Click it to configure layer groups.
Display Group - Existing icon

Click it to turn on displaying of the 'Existing' layer group.
Display Group - Misc icon

Click it to turn on displaying of the 'Miscellaneous' layer group.

Hide Group - Design icon
Click it to turn off displaying of the 'Design' layer group.

Hide Group - Existing icon
Click it to turn off displaying of the 'Existing' layer group.

Hide Group - Misc icon
Click it to turn off displaying of the 'Miscellaneous' layer group.

Add to Group icon
The Add to Group icon of the Layer Group group allows you to add layers to group by selecting entities in the sur-
vey view, which belong to required layers.

To add layers to a group:
1. In the Layer Group group of the Model tab, click the Add to Group icon.

The Add Layer To Group dialog is displayed.
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2. From the Group Name drop-down list, select the group to which layers will be added.
3. If needed, in the Description editbox, edit short description of the group.
4. If needed, tick the Remove layers from other groups checkbox. If it is selected, the selected layers will be

excluded from all other groups.
5. Click OK.
6. In the survey view, select entities which belong to the required layers. An information string on the bottom

panel displays the name of the last added layer.
7. When finished adding layers, press ESC.

The layers are added to the group.

Add to Group - Design icon
The Add to Group - Design icon of the Layer Group group allows you to add layers to the pre-defined "Design"
group by selecting entities in the survey view, which belong to required layers.

The "Design" group is created to simplify group managing in the project, and reserved for newly created entities
in the working area.

To add layers to the "Design" group:
1. In the Layer Group group of the Model tab, click the Add to Group - Design icon.
2. In the survey view, select entities, which belong to the required layers. An information string on the bottom

panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Design" group.

Add to group - Existing icon
The Add to Group - Existing icon of the Layer Group group allows you to add layers to the pre-defined "Exist-
ing" group by selecting entities in the survey view, which belong to required layers.

The "Existing" group is created to simplify group managing in the project, and reserved for newly created entities
in the working area.

To add layers to the "Existing" group:
1. In the Layer Group group of the Model tab, click the Add to Group - Existing icon.
2. In the survey view, select entities, which belong to the required layers. An information string on the bottom

panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Existing" group.

Add to Group - Misc icon
The Add to Group - Misc icon of the Layer Group group allows you to add layers to the pre-defined "Misc"
group by selecting entities in the survey view, which belong to required layers.
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The "Misc" group is created to simplify group managing in the project, and reserved for newly created entities in
the working area.

To add layers to the "Misc" group:
1. In the Layer Group group of the Model tab, click the Add to Group - Misc icon.
2. In the survey view, select entities, which belong to the required layers. An information string on the bottom

panel displays the name of the last added layer.
3. When finished adding layers, press ESC.

The layers are added to the "Misc" group.

Assign Layer to Group icon
The Assign Layer to Group icon of the Layer Group group allows you to assign layers to layer groups.

To assign layer to a group:
1. In the Layer Group group of the Model tab, click the Assign Layer to Group icon.

The control panel is displayed at the left part of the screen.
2. Select the required layers.

NOTE
Youmay quickly add layers to pre-configured groups — "Design", "Existing" or "Misc", by clicking the
appropriate button.

3. Click Layer group.

The Layer group dialog is displayed.
4. From the Layer group drop-down list, select the required group.
5. Click OK.

The layers are added to the group.

Buttons of the panel
Button Description

Select All Click it to select all layers in the list.

On Click it to turn selected layers on.

Off Click it to turn selected layers off.

Layer Group Click it to assign selected layers to a group.

Add to Design Click it to assign selected layers to the pre-configured group "Design".

Add to Existing Click it to assign selected layers to the pre-configured group "Existing".

Add to Misc Click it to assign selected layers to the pre-configured group "Misc".

Close Click it to close the control panel.

Color Settings icon
The Color Settings icon of the Layer Group group allows you to assign colors to entities which belong to a pre-
configured layer groups — Design, Existing and Miscellaneous.

To assign colors:
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1. In the Layer Group group of the Model tab, click the Color Settings icon.

The Surface Settings dialog is displayed.
2. Specify the required colors, by using the appropriate drop-down list for each layer group.
3. Click OK.

Display/Hide Group icon
The Display/Hide Group icon of the Layer Group group allows you to turn on/off layers, which belongs to the
specific groups.

To turn on/off a group:
1. In the Layer Group group of the Model tab, click the Display/Hide Group icon.

The Layer Group Selection dialog is displayed.
2. Select layers to be turned on/off.
3. Do one of the following:

l Tick the Activate all layers in the selected groups checkbox to turn on layers from the selected
group.

l Untick the Activate all layers in the selected groups checkbox to turn off layers from the selected
group.

4. Tick the Other Layers checkbox to change visibility of layers, which don't belong to the selected groups. If
this checkbox is unticked, the visibility of other layers will not change. If ticked, do one of the following:

l Select the Off radiobutton to turn off other layers.
l Select the On radiobutton to turn on other layers.

5. Click OK.

NOTE
If the current layer is among layers to be turned off, themessage window will warn about it after clicking
OK and the $$DEFAULT layer will be set as the current.

Fields of the Layer Group Selection dialog
Field Description

Activate all layers in
the selected groups Tick it to turn on all layers from the selected group.

Other Layers
Tick it to define whether to change visibility of layers, which don't belong
to the selected groups or not. If ticked, select On or Off radiobutton below
to turn on or turn off layers respectively.

Buttons of the Layer Group Selection dialog
Button Description

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Invert Selection Click it to deselect currently selected groups and select the other groups.
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Button Description

Select All Click it to select all existing groups.

Group Settings icon
The Group Settings icon of the Layer Group group allows you to configure sets of layers.

The Layer Group Settings dialog appears after clicking the icon. Buttons and fields of the dialog are described in
the table below. The main field displays the list of the layers of the currently selected group with their On/Off
flags.

Fields of the Layer Group Settings dialog
Field Description

Group Name
Contains the name of the currently selected layer group. The drop-down list of

all available group may be seen by clicking .

Description Contains the short description of the selected group.

Buttons of the Layer Group Settings dialog
Button Description

Add Layer

Click it to add an existing layer to the currently selected group. The Layer List
dialog appears after clicking. Select layers to be added to the group and Click
OK. You may also type the name of the new layer in the New Layer editbox.
The new layer will be created and added to the group after clicking OK.

Remove Layer Click it to remove the selected layers from the group.

Invert Selection Click it to invert the selection of the layers in the dialog.

Select All Click it to select all layers in the dialog.

Invert On/Off Click it to turn on inactive layer and turn off active ones.

On Click it to activate a selected layer in the group. Note that this property is
internal for the group, and does not affect to the global layer activity settings.

Off Click it to deactivate a selected layer in the group. Note that this property is
internal for the group, and does not affect to the global layer activity settings.

New Click it to create a new group.

Reset Click it to discard all resent unsaved changes.

Rename Click it to rename the currently selected group.

Delete Click it to delete the currently selected group.

Copy From Lib Click it to load previously saved group settings from the MAGNET Office lib-
rary.

Save to Lib Click it to save current group settings to the MAGNET Office library.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Display Group - Design icon
The Display Group - Design icon of the Layer Group group allows you to turn on all layers, which belong to the
"Design" group. Visibility of other layers will not change.

NOTE
If the "Design" group does not contain any layer, this icon is inactive.

Display Group - Existing icon
The Display Group - Existing icon of the Layer Group group allows you to turn on all layers, which belong to
the "Existing" group. Visibility of other layers will not change.

NOTE
If the "Existing" group does not contain any layer, this icon is inactive.

Display Group - Misc icon
The Display Group - Misc icon of the Layer Group group allows you to turn on all layers, which belong to the
"Misc" group. Visibility of other layers will not change.

NOTE
If the "Misc" group does not contain any layer, this icon is inactive.

Hide Group - Design icon
The Hide Group - Design icon of the Layer Group group allows you to turn off all layers, which belong to the
"Design" group. Visibility of other layers will not change.

NOTE
If the "Design" group does not contain any layer, this icon is inactive.

Hide Group - Existing icon
The Hide Group - Existing icon of the Layer Group group allows you to turn off all layers, which belong to the
"Existing" group. Visibility of other layers will not change.

NOTE
If the "Existing" group does not contain any layer, this icon is inactive.

Hide Group - Misc icon
The Hide Group - Misc icon of the Layer Group group allows you to turn off all layers, which belong to the
"Misc" group. Visibility of other layers will not change.

NOTE
If the "Misc" group does not contain any layer, this icon is inactive.
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Cleanup group
The Cleanup group from the Model tab of the MAGNET Office ribbon allows you to remove unused and duplic-
ated data. It contains two icons, described in the table below.

Data Cleanup icon
Click it to remove unused, unrequited and duplicated data.

Point by Elev TX
Click it to convert crossing lines into symbols and set points elevations from the

text labels.

Data Cleanup icon
The Data Cleanup icon of the Cleanup group allows you to remove unused, unrequited and duplicated data, and
reduce the size of the project database.

To clean up the project:
1. In the Cleanup group of the Model tab, click the Data Cleanup icon.

The Data Cleanup dialog is displayed.
2. In the Select From group box, specify which data will be used – either all existing or only currently selec-

ted – by selecting the appropriate radiobutton.
3. Configure the cleanup by ticking the required checkboxes.
4. Click OK.

The message prompts you to view the report.
5. Click Yes or No as you need.

Point by Elev TX
The Point by Elev TX of the Cleanup group allows you to convert crossing lines into symbols and set points elev-
ations from the text labels.

This feature is useful for imported jobs with cross point marks, which was imported as two crossing lines.

To convert lines and set points elevations:
1. In the Cleanup group of the Model tab, click the Point by Elev TX icon.

The Create Points by Elevation Text dialog is displayed.
2. Define which actions will be performed – converting crossing lines to symbols, setting elevations by text

labels or both, by ticking the appropriate checkboxes.
3. Click OK.
4. If needed, in the survey view select the sample crossing lines.
5. If needed, in the survey view select the sample elevation text.

If there are some points with unassigned elevations left, the message window prompts to manually assign
elevations to them.
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6. Do one of the following:
l Click No to keep these points without elevations.
l Click Yes to manually pick elevations for them. The un-elevated points are highlighted. Do the fol-
lowing:

1. In the survey view, select the point to which elevation will be assigned.
2. In the survey view, select the corresponding text label.
3. Repeat for all un-elevated points.
4. When finished, press Esc.
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Raster/Vector group
The Raster/Vector group from the Model tab of the MAGNET Office ribbon allows you to work with the addi-
tional pictures in the project. It contains four icons, described in the table below.

Insert PDF/Image icon
Click it to add an image to the project.

Recalibrate icon
Click it to edit an existing image.

Trace icon
Click it to trace data from an existing background image.

Extract Vectors icon
Click it to extract vectors from an existing background image.

Insert PDF/Image icon
The Insert PDF/Image icon of the Raster/Vector group allows you to add the background images to the survey
view.

A background image is a picture, which is placed behind all entities in the project. Its aim is to help the user in
the design of the project – to simplify the creation of the existing objects and understanding of how new object
will interact with them. It may be satellite photo of the area, its map, etc. A background image may be calibrated,
which means that the area of the image will be matched to the entities in the survey view.

To add a background image to the survey view:
1. In the Raster/Vector group of the Model tab, click the Insert PDF/Image icon.

The Open dialog is displayed.
2. Select the required file and click OK.

The Insert PDF/Raster Image dialog is displayed. Fields are described in the table below.
3. In the Background image name editbox, type the name of the background image.
4. From the Transparency drop-down list, select the required transparency of the background picture. 100% is

fully transparent (i.e. invisible) picture, 0% is fully opaque picture.
5. In the Position/Scale Image group box, select the required option for image positioning:

l From geo-reference file – select it to load the positioning data from the georeference ESRI World
File.

l By plotting scale – select it to define the position of the background by defining the scale between
the actual picture size and its size in the survey view and rotation of the image. See "Positioning by
plotting scale" section on the facing page for details.

l By Matching Points – select it to define the position of the background image by matching the point
entities in the survey view with the points at the image. See "Positioning by matching points" section
on the facing page for details.

l Position by image – select it to define the position of the background image by picking the line on
the image and defining its length and bearing. See "Positioning by known line" section on the facing
page for details.
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6. Click OK.

The background image is added.

Positioning by plotting scale
When position a background image by known line, you need to specify the scale between the actual picture size
and its size in the survey view and rotation of the image

If you have selected the By plotting scale option in the Insert PDF/Raster Image dialog, do the following:
1. In the Scale editbox, specify the scale of the background image.
2. In the North Orientation editbox, specify the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.

3. Click OK.

The background image is added.

Positioning by matching points
If you have selected the By Matching Points option in the Insert PDF/Raster Image dialog, do the following:

1. Pick the matching point entity. Do one of the following:
l Click the required point in the survey view.
l Type the required point number in the Number editbox at the bottom toolbar, and press Enter.

2. Click the corresponding point on the image.
3. Repeat steps 1 and 2 for all required points.
4. When finished, do the right click, and select Accept the image in the context menu.

The background image is added.

Positioning by known line
When position a background image by known line, you need to pick the known line and define its length and bear-
ing.

If you have selected the "Position by image" option in the "Insert Background Image" dialog, do the following:
1. In the Scale and Rotation group box, click Pick >>.
2. Pick the known line on the picture.
3. In the Actual Distance editbox, specify the length of the known line.
4. Define the bearing of the known line. Do one of the following:

l In the Rotation editbox, specify the bearing of the known line.
l In the North Orientation editbox, specify the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.

5. Click OK.

The background image is added.
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Recalibrate icon
The Recalibrate icon of the Raster/Vector group allows you to manage background images in the project.

The Background Images dialog appears after clicking. For more information refer to "Background Images dia-
log" section on page 620.

NOTE
This icon has the same functionality as the B/G Images icon of the Features group at the View tab.

Trace icon
The Trace icon of the Raster/Vector group allows you to extract polylines from an attached picture, which con-
tains dashed lines.

To extract polylines:
1. In the Raster/Vector group of the Model tab, click the Trace icon.

The Trace dialog is displayed.
2. Configure the parameters as you need and click OK.
3. At the required picture, click on the segment of the target dashed line.
4. At the required picture, click the adjacent segment of the target dashed line.

The polyline segment is traced.
5. If needed, press + or - to change the elevation of the line.
6. Do one of the following:

l If needed, to continue, repeat steps from 4 to 6.
l Press Enter to save the traced polyline.
l Press Backspace to undo tracing.
l Press Esc to abort tracing.

The message window prompts you to save the traced line.
2. Click Yes or No as you need.

7. When finished, press Esc.

Extract Vectors icon
The Extract Vectors icon of the Raster/Vector group allows you to create polylines, based on the vectors of the
background image.

To extract vectors:
1. In the Raster/Vector group of the Model tab, click the Extract Vector icon.

The Extract Vectors dialog is displayed.
2. From the Background Image drop-down list, select the required background image.

The quantity of vectors in the selected image is displayed in the Number of Vectors field.
3. Select one of the following radiobuttons:

l All vectors— to extract all possible vectors from the image.
l Window selection— to extract vectors only from the selected area.
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4. From the To Layer drop-down list, select the layer to which the extracted vectors will be added.

TIP

Tick the Layers by Color checkbox to automatically define layers by the colors of the original image.

5. Click OK.
6. If you have selected the Window selection option in step 3, draw an area for vector exacting and press

Enter.
7. If needed, repeat previous step.
8. When finished, press Esc.
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Strings group
The Strings group from the Model tab of the MAGNET Office ribbon allows you to edit existing strings. It con-
tains six icons, described in the table below.

Filter Points icon
Click it to reduce the number of points at a string.

Densify Strings icon
Click it to make strings denser.

From Linework icon
Click it to create strings from existing lines and arcs.

Parallel String icon
Click it to add a new string as a parallel to an existing one.

Parallel Figure icon
Click it to create a new figure as a parallel to an existing one.

Edit Strings icon
Click it to edit an existing string.

Filter Points icon
The Filter Points icon of the Strings group allows you to reduce the quantity of points on an existing string. This
option removes points from strings within the specified tolerance. See pictures below for details.

Tolerance
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Horizontal reducing

Vertical reducing

To filter points of an existing string:
1. In the Strings group of the Model tab, click the Filter Points icon.

The Filter Tolerance dialog is displayed. Fields are described in the table below.
2. In the Filter Tolerance dialog, make the required configurations and click OK.
3. In the survey view, select the required string.

NOTE
If a string was selected, when clicking the icon, it will be used as the source string.

Points, matching the specified tolerance, are removed from the string.
4. If needed, select more strings.
5. When finished, press Esc.

Fields of the Filter Tolerance dialog
Field Description

Horizontal tol-
erance Defines the horizontal tolerance for point filtering.
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Field Description

Vertical tolerance

Defines the vertical tolerance for point filtering. To activate the vertical tol-
erance, tick the appropriate checkbox.

NOTE
When vertical filtering is not applied, points within the specified horizontal tol-
erance will be filtered regardless of the elevation. When vertical filtering is
applied, only points whichmatching both the horizontal and vertical tol-
erances will be filtered.

Filtered points

Retain
When selected, filtered points will be removed from the string, but not deleted
from the survey view. Tick the Set non-Use in Surface checkbox, to block
usage the point for DTM creation.

Delete When selected, filtered points will be deleted from the line and the survey
view.

Densify Strings icon
The Densify Strings icon of the Strings group allows you to increase the quantity of points on an existing string.

To add more points to a string:
1. In the survey view, select the required string.

NOTE
If no string was selected, when clicking the icon, all existing strings will be used.

2. In the Strings group of the Model tab, click the Densify Strings icon.

The Densify Strings dialog id displayed. Fields are described in the table below.
3. In the Densify Strings dialog, specify the spacing for the new points in the appropriate editboxes.
4. If needed, configure more parameters.
5. Click OK.
6. The new points are created on the string.

Fields of the Densify Strings dialog
Field Description

Spacing
on Straight Seg-

ments
Defines the spacing for the new points at the straight segments of the string.

Spacing
on Curved Seg-

ments

Defines the spacing for the new points at the curved (created from arcs) seg-
ments of the string.

Interpolate Elev-
ations

When ticked, elevations of the newly created points will be interpolated from
existing values.

Use in Surface When ticked, the newly created points may be used for DTM creation.
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From Linework icon
The From Linework icon of the Strings group allows you to convert existing lines and arcs to strings.

To perform the conversion, click the icon. All existing lines and arcs will be converted to strings. Entities, which
have common points, will be converted to a single string.

Parallel String icon
The Parallel String icon of the Strings group allows you to add a new string to the survey view, based on an exist-
ing string.

To create a parallel sting:
1. In the Strings group of the Model tab, click the Parallel String icon.
2. In the survey view, select the required source string.

The Parallel String dialog is displayed. Fields are described in the table below.
3. In the Offset editbox, specify the required offset from the original entity.
4. Define the required height option for the parallel string.
5. Click OK.
6. In the survey view, select from which side of the existing string the new one will be placed.

The new string is created and the Edit String dialog is displayed.
7. Review the parameters of the newly created string, and click OK to accept it. For more information about

the string parameters refer to "String properties" section on page 555.
8. Do one of the following:

l Press Enter to add more strings with the same parameters.
l Press Ecs to finish the parallel string creation.

Fields of the Parallel String dialog
Field Description

Offset Defines the offset of the new parallel string from the original one.

Constant Height
Select this radiobutton to create the new string with the same elevation for all
nodes. If selected, specify the height of the new string in the appropriate edit-
box.

Fixed CrossFall

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope in percent from the original string nodes elevations.
If selected, specify the slope percentage of the new string in the appropriate
editbox. Positive slope means that the new string will be higher than the ori-
ginal one. Negative slope means that the new string will be lower than the ori-
ginal one.

Fixed Difference

Select this radiobutton to create the new string with the node elevation, defined
by the fixed difference from the original string nodes elevations. If selected,
specify the required difference in the appropriate editbox. It will be subtracted
or added to the original string nodes elevations.
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Field Description

Ratio

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope, defined as ratio, from the original string nodes elev-
ations. If selected, specify the slope ratio of the new string in the appropriate
editbox. Note that you are defining the denominator of the ratio. Positive slope
means that the new string will be higher than the original one. Negative slope
means that the new string will be lower than the original one.

No Height Select this radiobutton to create the new string without elevetaion.

Parallel Figure icon
The Parallel Figure icon of the Strings group allows you to add two new strings to the survey view as the par-
allel to an existing line, arc, string or alignment.

To create a parallel figure:
1. In the Strings group of the Model tab, click the Parallel Figure icon.
2. In the survey view, select the required source string.

The Parallel Figure dialog is displayed. Fields are described in the table below.
3. Do one of the following:

l In the Road Template group box, tick the checkbox and select the required road template from the
drop-down list.

l In the Offset Strings group box, configure the offsets of the new strings from the original string and
the height of the new string.

4. Click OK.

The new string is created and the Edit String dialog is displayed.
5. Review the parameters of the newly created string, and click OK to accept it. For more information about

the string parameters refer to "String properties" section on page 555. Repeat for the second string.

The parallel strings are created.

Fields of the Parallel String dialog
Field Description

Template
Defines the road template for the parallel strings. Click Edit Templates to edit
the currently selected template. See "Templates icon" section on page 702 for
details.

Left Offset Defines the offset of the new parallel string, located to the left from the ori-
ginal one.

Right Offset Defines the offset of the new parallel string, located to the right from the ori-
ginal one.

Constant Height
Select this radiobutton to create the new string with the same elevation for all
nodes. If selected, specify the height of the new string in the appropriate edit-
box.
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Field Description

Fixed CrossFall

Select this radiobutton to create the new string with the nodes elevations
defined by the fixed slope in percents from the original string nodes elevations.
If selected, specify the slope percentage of the new string in the appropriate
editbox. Positive slope means that the new string will be higher than the ori-
ginal one. Negative slope means that the new string will be lower than the ori-
ginal one.

Fixed Difference

Select this radiobutton to create the new string with the node elevation, defined
by the fixed difference from the original string nodes elevations. If selected,
specify the required difference in the appropriate editbox. It will be subtracted
or added to the original string nodes elevations.

No Height Select this radiobutton to create the new string without elevation.

Edit Strings icon
The Edit String icon of the Strings group allows you to edit an existing string.

To edit a string:
1. In the Strings group of the Model tab, click the Edit String icon.
2. In the survey view, select the required string.

The String Editor panel id displayed at the left side of the MAGNET Office window.
3. At the String Editor panel, make the required configurations. For more information, refer to "String Editor"

section on page 513.
4. When finished, click Close.

The string is edited.
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Elevate group
The Elevate group from the Model tab of the MAGNET Office ribbon allows you to work with the objects elev-
ation. It contains six icons and four second level icons, described in the table below.

From Leader Text icon
Click it to set elevations from leader text.

From Contour Labels icon
Click it to set contour strings elevations from contour labels.

From Text icon
Click it to set elevation from a numerical text.

By Intersection icon
Click it to set elevation by intersection from other entities.

Drape Object icon
Click it to set elevation by draping object on surface.

Elevate icon
This icon contains the list of the second level icons for various
operations with elevation. Click to expand the list of the

second level icons.
Set Elevation by Increment icon

Click it to set elevation by specifying a base elevation and its
increment.

Set Start and End Elevation icon
Click it to set start and end elevation for a string or a polyline.

Set String Point Elevation icon
Click it to set one elevation for all string points.

Interpolate Elev along String icon
Click it set string points elevations by interpolating elevation

between two points with valid elevations.

From Leader Text icon
The From Leader Text icon of the Elevate group allows you to set the elevation for points, labeled with the
leader text with the value, taken from the label.

This feature is useful for imported drawing, which does not have elevation, but elevation written in text labels,
with leaders pointing to the point. Leader may be represented by a polyline or a string. See picture below for
details.
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Elevation from leader text

To set the elevation from leader text:
1. In the Elevate group of the Model tab, click the From Leader Text icon.
2. In the survey view, select the required text label.
3. In the survey view, select the required leader.

The elevation is set.

From Contour Labels icon
Click From Contour Labels icon of the Elevate group to set elevation along the string points based on the text in
between the strings. See picture below for details.
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From Text icon
The From Text icon of the Elevate group allows you to set elevation of the target entities from an existing
numeric text.

NOTE
If the reference text contains any alpha characters, theywill be ignored. For example, text "100G" will
be read as "100".

For line, the same elevation, based on the defined text, will be assigned to both start and end points of the line.

For line/arc, the same elevation, based on the defined text, will be assigned to start, end and center points of the
arc.

For string, the same elevation, based on the defined text, will be assigned to all string nodes.

For polyline, the elevation, based on the defined text, will be assigned to the polyline.

To calculate elevation from text:
1. In the Elevate group of the Model tab, click the From Text icon.
2. If needed, define the base elevation. To do so:

1. Right click in the survey view.
2. In the context menu, click the Set a Base Elevation item.

The SiteMaster dialog is displayed.
3. Specify the base elevation.
4. Click OK.
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3. In the survey view, select the required target entity.
4. In the survey view, select the required text.

The elevation is assigned.
5. If needed, repeat steps 3 and 4.
6. When finished, press Esc.

By Intersection icon
The By Intersection icon of the Elevate group allows you to set the elevation of the selected entities by using
their intersections with entities with the defined elevation.

For line or arc the same elevation, based on the existing elevations of the reference entity, will be assigned to both
start and end points of the line/arc.

For string, the new point will be created at the intersection, with the calculated elevation assigned. The rest of the
string nodes remain unchanged.

For polyline, the new point will be created at the intersection, with the calculated elevation assigned. Points with
zero elevation will be created at the rest of the polyline nodes.

To set elevations:
1. In the Elevate group of the Model tab, click the By Intersection icon.
2. In the survey view, select the target object, for which elevation will be set.

The elevation is calculated. The new point with the calculated elevation is created at the target object.
3. If needed, select more entities.
4. When finished, press Esc.

Drape Object icon
The Drape Object icon of the Elevate group allows you to interpolate heights from a defined reference DTM to
an existing string or polyline.

To interpolate heights:
1. In the Elevate group of the Model tab, click the Drape Object icon.
2. In the survey view, select the required string/polyline.

The DTM and Layer Selection dialog is displayed.
3. From the DTM drop-down list, select the required reference DTM.
4. From the Layer drop-down list, select the layer to which the new points will be placed.
5. Click OK.

The heights are interpolated.
6. If needed, repeat steps from 2 to 5 to interpolate heights for more strings/polylines.
7. When finished, press Esc.
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Set Elevation by Increment icon
The Set Elevation by Increment icon of the Elevate group allows you to set the elevation of selected entities by
specifying a base elevation and then an increment to change each object’s elevation.

In this function you need to draw a line, which continuously cross required target entities. The base elevation will
be assigned to the first intersected entity; elevation of each further entity will be changed to the increment value.

For line, the calculated elevation will be assigned to both start and end points of the line.

For line/arc, the calculated elevation will be assigned to start, end and center points of the arc.

For string, the calculated elevation will be assigned to all string nodes.

For polyline, the calculated elevation will be assigned to the polyline.

TIP
The increment valuemay be negative.

To set elevation by increment:
1. In the Elevate group of the Model tab, click the Set Elevation by Increment icon.
2. The input panel is displayed at the bottom toolbar.
3. Draw a line, which continuously cross required target entities. You may create nodes in one of the fol-

lowing ways:
l Click the required place in the survey view.
l Specify the number of the required points in the Number editbox of the bottom toolbar.
l Specify the East and North coordinates of the required placed in the appropriate editboxes at the bot-
tom toolbar.

4. When finished drawing line, press Esc.
5. The Assign Elevations dialog is displayed.
6. In the Start Elevation editbox, specify the base elevation. Note that it will be assigned to the first target

entity.
7. In the Increment editbox, specify the increment value.
8. Click OK.

The elevations are assigned.

Set Start and End Elevation icon
The Set Start and End Elevation icon of the Elevate group allows you to calculate the elevation of points along
a polyline or string by specifying an elevation for the starting and ending point elevations. Polylines will be con-
verted to strings after using this option.

To assign elevations:
1. In the Elevate group of the Model tab, click the Set Start and End Elevation icon.
2. In the survey view, select the required string or polyline.

The Assign Elevations dialog is displayed.
3. Specify the start and end elevations in the appropriate editboxes.
4. Click OK.
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5. If needed, repeat steps from 2 to 4.
6. When finished, press Esc.

Set String Point Elevation icon
The Set String Point Elevation icon of the Elevate group allows you to set the same elevations to all points of the
defined string.

To set elevations to string points:
1. In the Elevate group of the Model tab, click the Set String Point Elevation icon.
2. In the survey view, select the required string.

The String Point Height dialog is displayed.
3. In the Point Height editbox, specify the required elevation.
4. If needed, tick the Use in Surface checkbox, to allow usage of all the string points in DTM creation.
5. If needed, tick the Active Layer Only checkbox, to assign elevation only to points, which belong to cur-

rently active layers.
6. Click OK.

The elevations are assigned.
7. In needed, repeat steps from 2 to 6.
8. When finished, press Esc.

Interpolate Elev along String icon
The Interpolate Elev along String icon of the Elevate group allows you to automatically calculate elevation for
string nodes, which are located between two nodes with valid non-zero elevation.

To calculate elevation of string nodes:
1. In the Elevate group of the Model tab, click the Interpolate Elev along String icon.
2. In the survey view, select the required string.

The Interpolate Elevation for String dialog is displayed.
3. Tick the required checkboxes and click OK.

The elevations are calculated.
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DTM group
The DTM group from the Model tab of the MAGNET Office ribbon allows you to create and view digital terrain
models (surface models). It contains three icons, described in the table below.

Create DTM icon
Click it to create a new surface model.

Display Contours icon
Click it to turn on/off displaying of the DTM contours.

Display Zero Contour icon
Click it to turn on/off displaying of the contour at the current DTM

zero elevations.
Display Mesh icon

Click it to turn on/off displaying of the DTM meshes.
Display Color Fill icon

Click it to turn on/off displaying of the DTM filling.

Create DTM icon
The Create DTM icon of the DTM group allows you to create a new digital terrain model, by using existing entit-
ies from the survey view.

You may create a DTM in two following ways:
l Create a DTM from any existing entities in the survey view.
l Trim a DTM to an existing boundary.

NOTE
Only Use in Surface points and entities based on themmay be included to a DTM.

To create a DTM from any existing entities:
1. In the Create/Edit DTM group of the Surface tab, click the Create DTM icon.

The Create DTM - Selection dialog is displayed.
2. In the Selection group box, select one of the following options:

l All— to include all existing entities to a DTM.
l Active — to include entities from the currently active layers.
l Current Selection— to include the currently selected entities.
l Layer Group— to include entities, which belongs to the layers of the defined group. Select the
required group from the drop-down list.

3. Click OK.

The Create DTM dialog is displayed.
4. Make the required configurations. See "Create DTM dialog" section on the facing page for details.
5. Click OK.

The DTM is created.
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To trim a DTM to an existing boundary:
1. In the Create/Edit DTM group of the Surface tab, click the Create DTM icon.

The Create DTM - Selection dialog is displayed.
2. In the Boundary group box, tick the Trim DTM to Boundary checkbox.
3. Select the appropriate option in the Delete Triangle group box.
4. If needed, tick the Approximate arc checkbox, and specify the arc to chord distance for curved breaklines

in the Arc-to-chord distance editbox.
5. In the Boundary Name list, select the required boundary. Do one of the following:

l Click the boundary name in the list.
l Click Pick Boundary and select the boundary in the survey view.
l Click New Boundary and create a new boundary in the survey view.

6. Click OK.

The Create DTM dialog is displayed.
7. Make the required configurations. See "Create DTM dialog" section below for details.
8. Click OK.

The DTM is created.

Create DTM dialog
The Create DTM dialog allows you to configure the creation of a new DTM. It appears during the creation of a
new DTM. For more information about creating DTMs, refer to "Create DTM icon" section on the previous page.

To configure the DTM, set up the required properties at each tab of the dialog. Fields are described in the tables
below.

You may use the contour settings library to load the pre-configured contour settings.

To load contour library settings:
1. At the Contour tab of the Create DTM dialog, click Load Library Settings.

The selection dialog is displayed.
2. Select the required library settings, and click OK.

To save current contour settings to the library:
1. At the Contour tab of the Create DTM dialog, click Save Library Settings.

The selection dialog is displayed.
2. Select existing library settings from the drop-down list, or type the name of a new library.
3. Click OK.

Fields of the General tab of the Create DTM dialog
Field Description

Name Defines the name of the DTM.

Num Points Displays the quantity of the Use in Surface points in the DTM.

Highest Displays the highest elevation in the DTM.

Lowest Displays the lowest elevation in the DTM.
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Field Description

Ave. Elev Displays the average elevation in the DTM.

Plan Area Displays the horizontal area of the DTM.

Surface Area Displays the full surface area, including slopes.

Description Defines short DTM description.

Display

Mesh When ticked, the created triangular mesh will be displayed in the survey
view. Select the required color form the drop-down list.

Contour When ticked, the contours will be displayed in the survey view.

Color Fill
When ticked, the shadings and patterning will be colored. Click Settings to
define the required colors. See "Color Fill Settings dialog" section on page 428
for details.

Slope When ticked, the slopes will be colored. Click Settings to configure it. See
"Slope dialog" section on the facing page for details.

Breaklines

Insert Breaklines
Tick to create additional triangles, so the triangle edges are formed along each
breakline. If a breakline exists in the project, then this checkbox is auto-
matically ticked.

Approximate
curved breaklines

Tick to create additional triangles, so the triangle edges are formed along
chords of the curved breaklines.

Check Crossing
Breaklines Tick to insure the intersection is correct.

Arc-to-chord
Distance

Defines the arc to chord distance for curved breaklines. The default is 0.200 m
and is suitable for most models.

Fields of the Contour tab of the Create DTM dialog
Field Description

Display

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.
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Field Description

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Color

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it. See "Color Range Settings dialog" section on the next page for details.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

Fields of the Contour Label tab of the Create DTM dialog
Field Description

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Slope dialog

The Slope dialog allows you allows to analyze the slopes of the individual triangles. You can allocate different col-
ors to the slope ranges with the option to set the shape of the arrows that display the slopes.

To configure the slope:
1. In the Slope group box, from the General tab of the Create DTM dialog, click Settings.

The Slope dialog is displayed.
2. From the Arrow Head drop-down list, select the required arrow head shape.
3. From the Arrow Angle drop-down list, select the required angle of the arrow head, or specify custom value.
4. From the Arrow Length drop-down list, select the required length of the arrow, or specify custom value.
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5. If needed, tick the Drawing Units checkbox, to plot the slope units.
6. In the table, specify consecutive steps for the slope range with an appropriate color for each slope
7. Click OK.

Color Range Settings dialog

The Color Range Settings dialog allows you to configure gradual change in color for each minor contour interval
from the highest to the lowest contour.

To configure the color range:
1. In the Color group box, from the Contour tab of the Create DTM dialog, click Define.

The Color Range Settings dialog is displayed.
2. In the High Value editbox, specify the highest value of the height range.
3. In the Low Value editbox, specify the lowest value of the height range.
4. In the Interval editbox, specify the interval of color changing.
5. Click OK.

Color Fill Settings dialog

The Color Fill Settings dialog allows you to configure gradual change in color for filling boundaries from the
highest to the lowest elevation.

To configure the color range:
1. In the Color Fill group box, from the General tab of the DTM Settings dialog, click Settings.

The Fill Color dialog is displayed.
2. In the High Level editbox, specify the highest value of the height range.
3. In the Low Level editbox, specify the lowest value of the height range.
4. In the Datum Level editbox, specify the level of the datum.
5. Select the required colors from the appropriate drop-down lists.
6. Click OK.

Display Contours icon
Click the Display Contours icon of the DTM group to turn on/off displaying of the current DTM contours.

Display Zero Contour icon
Click the Display Zero Contour icon of the DTM group to turn on/off displaying of the contour at the current
DTM zero elevations.

Display Mesh icon
Click the Display Mesh icon of the DTM group to turn on/off displaying of the current DTM mesh.
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Display Color Fill icon
Click the Display Color Fill icon of the DTM group to turn on/off displaying of the current DTM filling.
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Surface Tab
The Surface tab of the MAGNET Office ribbon contains control icons, which allows you to create and edit sur-
faces in your project. It is separated to seven groups:

l "DTM Settings group" section on the facing page
l "Compute Elevations group" section on page 433
l "Elevate by DTM group" section on page 435
l "Create/Edit DTM group" section on page 439
l "Edit Mesh group" section on page 456
l "Boundary group" section on page 463
l "Volume group" section on page 469
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DTM Settings group
The DTM Settings group from the Surface tab of the MAGNET Office ribbon allows you to edit existing digital ter-
rain models. It contains three icons, described in the table below.

Display Contours icon
Click it to turn on/off displaying of the DTM contours.

Display Zero Contour icon
Click it to turn on/off displaying of the contour at the current DTM zero elev-

ations.

Display Mesh icon
Click it to turn on/off displaying of the DTM meshes.

Display Color Fill icon
Click it to turn on/off displaying of the DTM filling.

DTM Settings icon
Click it to edit an existing digital terrain model.

Display Contours icon
Click the Display Contours icon of the DTM Settings group to turn on/off displaying of the current DTM con-
tours.

Display Zero Contour icon
Click the Display Zero Contour icon of the DTM Settings group to turn on/off displaying of the contour at the cur-
rent DTM zero elevations.

Display Mesh icon
Click the Display Mesh icon of the DTM Settings group to turn on/off displaying of the current DTM mesh.

Display Color Fill icon
Click the Display Color Fill icon of the DTM Settings group to turn on/off displaying of the current DTM filling.

DTM Settings icon
The DTM Settings icon of the DTM Settings group allows you to manage DTMs in the current project.

To open the DTM dialog, click the icon. It displays the list of the layers in the project with their properties,
described in the table below.
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Fields of the DTM dialog
Field Description

Name Displays the name of the DTM.

Mesh Flags whether the displaying of the DTM mesh turned on/off.

Contours Flags whether the displaying of the DTM contours turned on/off.

Color Fill Displays the filing color of the DTM.

Color Displays the mesh color of the DTM.

Description Displays the description of the DTM.

Num Pts Displays the quantity of points in the DTM.

Highest Displays the elevation of the highest point of the DTM.

Lowest Displays the elevation of the lowest point of the DTM.

The current DTM is marked with the asterisk.

Buttons of the DTM dialog
Button Description

New Click it to create a new DTM. For more information refer to "Create DTM
icon" section on page 440.

Edit Click it to edit the selected layers. For more information, refer to
"DTM Settings dialog" section on page 626.

Delete Click it to delete the selected DTM.

Set Current
Click it to set the selected DTM as the current. The current DTM is marked
with the asterisk. All new objects will be created at the current layer, unless
other is configured.

Rename Click it to rename the selected DTM.

OK Click it to save the changes and close the dialog.

Cancel Click it to discard the changes and close the dialog.
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Compute Elevations group
The Compute Elevation group from the Surface tab of the MAGNET Office ribbon allows you to create points,
which position is based on the existing points position and height and calculate elevations of entities, based on the
reference elevations. It contains three icons and one second level icon, described in the table below.

Point on Grade icon
Click it to create a new point on the grid line between two

existing points at the required elevation.
Set Elev by Grade icon

Click it to set elevations on points by the grade of a nominated
line.

Intersect Grades icon
Click it to create a new point between two existing points at a
nominated elevation. This icon also contains the second level

icon. Click to see it.

Set Point Elev by Reference Elev icon
Click it to set the point elevation by using slope from a ref-

erence point.

Point on Grade icon
The Point on Grade icon of the Compute Elevations group allows you to create a new point on the grade line
between two existing points at a defined elevation.

NOTE
Both reference point must have defined elevation.

To create a point on grade:
1. In the Elevate by DTM group of the Surface tab, click the Point on Grade icon.
2. In the survey view, select the reference line, or two reference points.
3. In the Height editbox at the bottom toolbar, specify the height of the new point.

The new point is created.

Set Elev by Grade icon
The Set Elev by Grade icon of Compute Elevations group allows you to set points elevations by the grade of a
defined line that is used to define the slope. Select additional points to be shifted vertically onto this defined plane.
The grade of the plane is defined by two existing points with elevations or an existing line joining points with elev-
ations.

NOTE
The snap to the nearest point mode should be active for proper work of this function. See "Pt icon" sec-
tion on page 132 for details.

To set point elevations by grade:
1. In the Compute Elevations group of the Surface tab, click the Set Elev by Grade icon.
2. In the survey view, select a line or two points to define a slope.
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3. In the survey view, select points to set heights.
4. When finished, press Ecs.

Intersect Grades icon
The Intersect Grades icon of the Compute Elevations group allows you to create a new point, based on the
grade between two existing points. The new point will be located on the grade line, and its elevation will be cal-
culated automatically.

To create a new point at the grade lines intersection:
1. In the Compute Elevations group of the Surface tab, click the Intersect Grades icon.
2. In the survey view, select the first reference point, or specify its number in the Point Name editbox at the

bottom toolbar.
3. In the Slope editbox at the bottom toolbar, specify the slope of the grade line in percent.
4. In the survey view, select the second reference point, or specify its number in the Point Name editbox at

the bottom toolbar.
5. In the Slope editbox at the bottom toolbar, specify the slope of the grade line in percent.
6. The point is created at the grade lines intersection.

Set Point Elev by Reference Elev icon
The Set Point Elev by Reference Elev icon of the Compute Elevations group allows you to set the point elev-
ation based on the slope from the reference point.

To set elevations:
1. In the Compute Elevations group of the Surface tab, click the Set Point Elev by Reference Elev icon.
2. In the survey view, select the point to which the elevation will be set.
3. In the survey view, select the reference point.

The input panel is displayed at the bottom toolbar. The Reference Height field displays the elevation of the
reference point.

4. In the Slope editbox, specify the slope from the reference point in percent.

The elevation is set.
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Elevate by DTM group
The Elevate by DTM group from the Surface tab of the MAGNET Office ribbon allows you to configure elev-
ations across an existing DTM. It contains four icons, described in the table below.

Grid Points icon
Click it to create a grid of points with elevations across a project.

Interpolate DTM icon
Click it to interpolate elevations for a selection of points.

Elev Difference icon
Click it to compare elevation of two surfaces.

Points from DTM icon
Click it to create points at DTM nodes.

Grid Points icon
The Grid Points icon of the Elevate by DTM group allows you to create a set of points, which imitate grid lines.

To create grid points:
1. In the Elevate by DTM group of the Surface tab, click the Grid Points icon.
2. Create the origin (bottom left) point of the grid by using the "Coordinate" method. See "Add Point icon" sec-

tion on page 136 for details.

The Create Grid Points dialog is displayed.
3. Make the required configurations and click OK. Fields are described in the table below.

The grid points are created.

Fields of the Create Grid Points dialog
Field Description

Origin Defines the X (East) and Y (North) coordinates of the grid origin (bottom left)
point.

Spacing Defines the spacing between grid lines.

No. of steps Defines the quantity of grid lines.

Rotation Defines the rotation of grid lines.

Layer Defines the layer to which the grid point will belong to.

Point numbering Defines the numbering format.

Interpolate DTM icon
The Interpolate DTM icon of the Elevate by DTM group allows you to interpolate elevations for either a selec-
tion of points, located within the urrent DTM or for the points that define a boundary within the current DTM. The
new elevations will be based on the elevations of the current DTM.

To interpolate heights:
1. If needed, in the survey view, select the required points.
2. In the Elevate by DTM group of the Surface tab, click the Interpolate DTM icon.
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The Interpolate Point Heights dialog is displayed.
3. Define which elevations will be calculated. Select one of the following:

l Boundary – to interpolate elevations for boundary nodes. Select the required boundary from the
drop-down list.

l Current Selection – to interpolate elevations for currently selected points.
4. Click OK.

The points elevations are interpolated, and the report is displayed.

Elev Difference icon
The Elev Difference icon of the Elevate by DTM group allows you to vertically compare two surfaces. Using
the East (X) and North (Y) positions of points in either or both surfaces, new points are generated with levels that
equal the difference in elevation between the surfaces.

If a new layer is not used for the elevation difference points, then the points in the selected layer will have the
existing elevations replaced with the height difference levels, so it is recommended to create a new layer for the
computed points.

To compare the elevations:
1. In the Elevate by DTM group of the Surface tab, click the Elev Difference icon.

The Elevation Difference dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. Click OK.

Fields of the Elevation Difference dialog
Field Description

DTM 1

Defines the reference surface, from which the height differences are cal-
culated.

Select the required project from the Job 1 drop-down list, and the DTM from
the second drop-down list.

DTM 2
Defines the surface for points height comparison.

Select the required project from the Job 2 drop-down list, and the DTM from
the second drop-down list.

Start Point Defines the number of the first calculated point.

Layer
Defines the layer, to which the calculated points will be added.

If an existing layer is used, the elevations values of the existing points will be
set to the elevation difference.

Elev. Tolerance Defines the elevation tolerance for comparing. If the elevation difference is
less than the tolerance, the average elevation can be used.

Average Elevation Defines the average point heights if the elevation difference is less than the tol-
erance specified.

436



Points from DTM icon

Field Description

Use Point Coordin-
ates From

Defines which points will be used in comparison. Select one of the following:
l Job 1 – New points are created at the same East (X) and North (Y)
coordinates as those in Job 1. Each point will have an elevation which is
the difference between the surfaces at this point position.

l Job 2 – New points are created at the same East (X) and North (Y)
coordinates as those in Job 2. Each point will have an elevation, which
is the difference between the surfaces at this point position.

l Job 1 and Job 2 – New points are created with the same East (X) and
North (Y) coordinates as those in both Job 1 and Job 2. Each point will
have an elevation, which is the difference between the surfaces at this
point position.

Activated Layers
Only Tick to use only points, which belong to active layers.

Report Tick to generate a comparison report.

Points from DTM icon
The Points from DTM icon of the Elevate by DTM group allows you to create points, basing on existing DTM.

There are four methods of points creation, each is described in the appropriate section below.
l Create point at all nodes of the DTM mesh.
l Create points only at selected nodes of the DTM mesh.
l Create points only at nodes, located within a "box", defined by a rectangle selection.
l Create points only at nodes, located within an existing boundary.

Creating points at all nodes
To create points:

1. In the Elevate by DTM group of the Surface tab, click the Points from DTM icon.

The Create Points from DTM dialog is displayed.
2. From the From DTM drop-down list, select the reference DTM.
3. From the Create Points in Layer drop-down list, select the layer to which the new points will be added, or

type the name of a new layer.
4. In the Create Method group box, select the Create All radiobutton.
5. Click OK.

The points are created.

Creating points at selected nodes
To create points:

1. In the Elevate by DTM group of the Surface tab, click the Points from DTM icon.

The Create Points from DTM dialog is displayed.
2. From the From DTM drop-down list, select the reference DTM.
3. From the Create Points in Layer drop-down list, select the layer to which the new points will be added, or

type the name of a new layer.
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4. In the Create Method group box, select the By Picked Points radiobutton.
5. Click OK.
6. In the survey view, click the required nodes of the DTM mesh.
7. When finished, press Esc.

The points are created.

Creating points within a box
To create points:

1. In the Elevate by DTM group of the Surface tab, click the Points from DTM icon.

The Create Points from DTM dialog is displayed.
2. From the From DTM drop-down list, select the reference DTM.
3. From the Create Points in Layer drop-down list, select the layer to which the new points will be added, or

type the name of a new layer.
4. In the Create Method group box, select the By Window Selection radiobutton.
5. Click OK.
6. In the survey view, draw the required rectangle area.

The points are created.

Creating points within a boundary
To create points:

1. In the Elevate by DTM group of the Surface tab, click the Points from DTM icon.

The Create Points from DTM dialog is displayed.
2. From the From DTM drop-down list, select the reference DTM.
3. From the Create Points in Layer drop-down list, select the layer to which the new points will be added, or

type the name of a new layer.
4. In the Create Method group box, select the By Boundary radiobutton.
5. Do one of the following:

l Select the required boundary from the drop-down list and click OK.
l Click Pick Polygon, and select the required boundary in the survey view.

The points are created.
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Create/Edit DTM group
The Create/Edit DTM group from the Surface tab of the MAGNET Office ribbon allows you to work with the
digital terrain models. It contains five icons and eleven second level icons, described in the table below.

Create DTM icon
Click it to create a new surface model (DTM). This icon also con-
tains the list of the second level icons, for various creation modes.

Click to see them.

By Depth Range icon
Click it to create a new DTM form a points, selected within a spe-

cified height from an existing DTM.
Create Elev Diff DTM icon

Click it to create a DTM, representing elevation difference of two
existing DTMs.

Create Cut/Fill DTM icon
Click it to create a cut/fill map.

Merge DTM icon
Click it to create a new DTM by merging existing DTM surfaces
into one. This icon also contains second level icon. Click to see

them.
Merge by Elevation icon

Click it to create a new DTM by comparing heights of two existing
DTMs.

Raise/Lower DTM icon
Click it to raise or lower an existing surface vertically.

Modify DTM icon
Click it to add vertices or remove point from existing DTM.

DTM Tools icon
This icon contains the list of the second level icons for various

operations with surfaces. Click to expand the list of the second
level icons.

Import DTM icon
Click it to import an existing DTM from another project.

Export DTM icon
Click it to export an existing DTM from current project.

Adjust DTM Slope
Click it to edit an existing DTM.

Update DTM icon
Click it to an existing DTM it its base points have changed.

Check DTM icon
Click it to check the connectivity of triangles in a DTM.

3D View icon
Click it to open current project in the 3D viewer.

Convert Contour to String icon
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Click it to create an existing contour as a string.
Create DTM Boundary icon

Click it to create a DTM boundary inside or outside of an existing
DTM.

Create DTM icon
The Create DTM icon of the Create/Edit DTM group allows you to create a new digital terrain model, by using
existing entities from the survey view.

You may create a DTM in two following ways:
l Create a DTM from any existing entities in the survey view.
l Trim an existing boundary to a DTM.

NOTE
Only Use in Surface points and entities based on themmay be included to a DTM.

To create a DTM from any existing entities:
1. In the Create/Edit DTM group of the Surface tab, click the Create DTM icon.

The Create DTM - Selection dialog is displayed.
2. In the Selection group box, select one of the following options:

l All— to include all existing entities to a DTM.
l Active — to include entities from the currently active layers.
l Current Selection— to include the currently selected entities.
l Layer Group— to include entities, which belongs to the layers of the defined group. Select the
required group from the drop-down list.

3. Click OK.

The Create DTM dialog is displayed.
4. Make the required configurations. See "Create DTM dialog" section on the facing page for details.
5. Click OK.

The DTM is created.

To trim a DTM to an existing boundary:
1. In the Create/Edit DTM group of the Surface tab, click the Create DTM icon.

The Create DTM - Selection dialog is displayed.
2. In the Boundary group box, tick the Trim DTM to Boundary checkbox.
3. Select the appropriate option in the Delete Triangle group box.
4. If needed, tick the Approximate arc checkbox, and specify the arc to chord distance for curved breaklines

in the Arc-to-chord distance editbox.
5. In the Boundary Name list, select the required boundary. Do one of the following:

l Click the boundary name in the list.
l Click Pick Boundary and select the boundary in the survey view.
l Click New Boundary and create a new boundary in the survey view.

6. Click OK.

The Create DTM dialog is displayed.
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7. Make the required configurations. See "Create DTM dialog" section below for details.
8. Click OK.

The DTM is created.

Create DTM dialog
The Create DTM dialog allows you to configure the creation of a new DTM. It appears during the creation of a
new DTM. For more information about creating DTMs, refer to "Create DTM icon" section on the previous page.

To configure the DTM, set up the required properties at each tab of the dialog. Fields are described in the tables
below.

Fields of the General tab of the Create DTM dialog
Field Description

Name Defines the name of the DTM.

Num Points Displays the quantity of the points in the DTM.

Highest Displays the highest elevation in the DTM.

Lowest Displays the lowest elevation in the DTM.

Ave. Elev Displays the average elevation in the DTM.

Plan Area Displays the horizontal area of the DTM.

Surface Area Displays the full surface area, including slopes.

Description Defines short DTM description.

Display

Mesh When ticked, the created triangular mesh will be displayed in the survey
view. Select the required color form the drop-down list.

Contour When ticked, the contours will be displayed in the survey view.

Color Fill
When ticked, the shadings and patterning will be colored. Click Settings to
define the required colors. See "Color Fill Settings dialog" section on page 443
for details.

Slope When ticked, the slopes will be colored. Click Settings to configure it. See
"Slope dialog" section on page 443 for details.

Breaklines

Insert Breaklines
Tick to create additional triangles, so the triangle edges are formed along each
breakline. If a breakline exists in the project, then this checkbox is auto-
matically ticked.

Approximate
curved breaklines

Tick to create additional triangles, so the triangle edges are formed along
chords of the curved breaklines.

Check Crossing
Breaklines Tick to insure the intersection is correct.

Arc-to-chord
Distance

Defines the arc to chord distance for curved breaklines. The default is 0.200 m
and is suitable for most models.
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Fields of the Contour tab of the Create DTM dialog
Field Description

Display

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Color

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it. See "Color Range Settings dialog" section on page 444 for details.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

You may use the contour settings library to load the pre-configured contour settings.

To load contour library settings:
1. At the Contour tab of the Create DTM dialog, click Load Library Settings.

The selection dialog is displayed.
2. Select the required library settings, and click OK.

To save current contour settings to the library:
1. At the Contour tab of the Create DTM dialog, click Save Library Settings.

The selection dialog is displayed.
2. Select existing library settings from the drop-down list, or type the name of a new library.
3. Click OK.
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Fields of the Contour Label tab of the Create DTM dialog
Field Description

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Color Fill Settings dialog

The Color Fill Settings dialog allows you to configure gradual change in color for filling boundaries from the
highest to the lowest elevation.

To configure the color range:
1. In the Color Fill group box, from the General tab of the DTM Settings dialog, click Settings.

The Fill Color dialog is displayed.
2. In the High Level editbox, specify the highest value of the height range.
3. In the Low Level editbox, specify the lowest value of the height range.
4. In the Datum Level editbox, specify the level of the datum.
5. Select the required colors from the appropriate drop-down lists.
6. Click OK.

Slope dialog

The Slope dialog allows you allows to analyze the slopes of the individual triangles. You can allocate different col-
ors to the slope ranges with the option to set the shape of the arrows that display the slopes.

To configure the slope:
1. In the Slope group box, from the General tab of the Create DTM dialog, click Settings.

The Slope dialog is displayed.
2. From the Arrow Head drop-down list, select the required arrow head shape.
3. From the Arrow Angle drop-down list, select the required angle of the arrow head, or specify custom value.
4. From the Arrow Length drop-down list, select the required length of the arrow, or specify custom value.
5. If needed, tick the Drawing Units checkbox, to plot the slope units.
6. In the table, specify consecutive steps for the slope range with an appropriate color for each slope
7. Click OK.
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Color Range Settings dialog

The Color Range Settings dialog allows you to configure gradual change in color for each minor contour interval
from the highest to the lowest contour.

To configure the color range:
1. In the Color group box, from the Contour tab of the Create DTM dialog, click Define.

The Color Range Settings dialog is displayed.
2. In the High Value editbox, specify the highest value of the height range.
3. In the Low Value editbox, specify the lowest value of the height range.
4. In the Interval editbox, specify the interval of color changing.
5. Click OK.

By Depth Range icon
The By Depth Range icon of the Create/Edit DTM group allows you to create DTM, based on points, located
within the specified depth range from the reference DTM.

To create DTM by depth range:
1. In the Create/Edit DTM group of the Surface tab, click the By Depth Range icon.

The Create DTM by Depth Range dialog is displayed.
2. In the Point Selection Criteria group box, configure the selection for points for DTM. Do the following:

1. In the Select From field, define the search area.
2. From the Reference DTM drop-down list, select the DTM to be reference.
3. In the Depth Range From DTM field, specify the required depth range.
4. Click OK.

The list of the selected points is displayed
3. Review the list of the points. If needed, change the criteria and repeat the search.
4. In the Create/Edit Options group box, configure the DTM creation. Do the following:

1. In the DTM Name editbox, specify the name for the new DTM.
2. In the Layer field, select the layer where new DTM will be placed from drop-down list or type the

name of the new layer.
3. In the Code field, select the code for the new DTM from the drop-down list, or type the name of the

new code.
4. Click Process to create DTM on the selected points.

The DTM is created.
5. If needed, repeat to create more DTMs.
6. When finished, click OK.

Create Elev Diff DTM icon
The Create Elev Diff DTM icon of the Create/Edit DTM group allows you to create a cut/fill DTM, rep-
resenting elevation difference between two existing DTMs.
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To create a color map:
1. In the Create/Edit DTM group of the Surface tab, click the Create Elev Diff DTM icon.

The Create elevation Difference DTM dialog is displayed.
2. From the First DTM drop-down list, select the DTM for a calculation of height difference.
3. Specify one of the following:

l Tick the From Level checkbox, and in the editbox, specify an elevation from which the elevation dif-
ference will be calculated.

l From the Second DTM drop-down list, select the DTM for a calculation of depth difference.
l Select Second DTM from File radiobutton, and click Browse to open the second DTM from an
external TN3 (*.tn3) file.

4. In the Output DTM editbox, specify the name of the resulting cut/fill color map.
5. Click OK.

Create Cut/Fill DTM icon
The Create Cut/Fill DTM icon of the Create/Edit DTM group allows you to a cut/fill color map.

To create a color map:
1. In the Create/Edit DTM group of the Surface tab, click the Create Cut/Fill DTM icon.

The Create Cut/Fill DTM dialog is displayed.
2. From the First DTM drop-down list, select the DTM for a calculation of height difference.
3. Specify one of the following:

l From the Second DTM drop-down list, select the DTM for a calculation of depth difference.
l Tick the From Level checkbox, and specify an elevation from which the elevation difference will be
calculated in the editbox.

4. In the Output DTM editbox, specify the name of the resulting DTM.
5. Define the colors for cut and fill in the appropriate drop-down lists.
6. Click OK.

Merge DTM icon
The Merge DTM icon of the Create/Edit DTM group allows you to create a new DTM surface by merging one or
more DTM surfaces into one. It also allows you to merge surface models from other projects into the existing pro-
ject. The other project must be open in MAGNET Office to allow access to the DTM surfaces.

To merge DTMs:
1. In the Create/Edit DTM group of the Surface tab, click the Merge DTM icon.

The Merge DTM dialog is displayed.
2. From the Merge (Design) drop-down menu, select the DTMs to be merged, and the projects, to which the

DTMs belongs to.
3. From the With (Existing) drop-down menu, select the DTM the others to be merged into.

This DTM should be the largest of all the DTMs to be merged. This DTM will be the Base, and all other
DTMs will be used to create a new base. This DTM can also be select from another project. A prerequisite
to this is for each project containing a DTM to be merged to be open.

445



Surface tab

4. In the To Create editbox, type the name of the new DTM.
5. Click OK.

The DTMs are merged.

To select a DTM from another project, open the project so it is available on the drop-down menu. A DTM cannot
be used unless the project containing it is open in MAGNET Office.

The triangles displayed in the first or “design” DTM will replace the triangles in the equivalent coordinate pos-
itions in the second or existing DTM, using the outside edge of the first DTM as a slope line.

If the edge of the first DTM does not create a slope line on the surface with the second DTM, there will be an
interpolation of heights between the two surfaces, which may not be what you expect.

Merge by Elevation icon
The Merge by Elevation icon of the Create/Edit DTM group allows you to create a new project by comparing
heights of points in two currently open projects where the heights for each point in the new project will be the
lower of the heights in comparison. The two projects should cover approx. the same plan area. The current pro-
ject is copied into the new project and the heights are edited as necessary. The result of this option will be a ter-
rain model that contains the lowest heights from each project.

This feature is designed for mining sites where comparison of surface levels over time is needed.

NOTE
At least two projects need to be opened before running the option. Each of the projectsmust have a
DTM for interpolating the height of the points from the other project.

To perform merge by elevation:
1. In the Create/Edit DTM group of the Surface tab, click the Merge by Elevation icon.

The Merge by Elevation dialog is displayed.
2. In the Reference row, select the required project and DTM in it for comparison.
3. In the With Base row, select the required DTM from the current project for comparison,
4. In the New row, specify the names for the resulting DTM and project, where it will be stored.
5. Click OK.

Fields of the Merge by Elevation dialog
Field Description

Reference Defines the project and DTM in it, which will be used in comparison with
DTM form the current project.

With Base Defines the DTM from the current project, which will be used with com-
parison.

New Defines the name for the DTM and project, where results of the comparison
will be stored.
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Raise/Lower DTM icon
The Raise/Lower DTM icon of the Create/Edit DTM group allows you to change the elevation of an existing
DTM.

To lift or drop an existing DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Raise/Lower DTM icon.

The Raise/Lower DTM dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. Click OK.

Fields of the Raise/Lower DTM dialog
Field Description

DTM

Defines the DTMs to be vertically adjusted. Select one of the following:
l Current DTM— to adjust only current DTM.
l All DTM— to adjust all DTMs in the project.
l Selected DTM— to adjust DTMs, selected from the list below.

Boundary

Within DTM Select to adjust the selected DTMs within the boundary, defined in the DTM
properties.

Within Boundary
Select to adjust the selected DTMs within a selected boundary.

Select the boundary from the drop-down list, or click Pick Boundary and
select it in the survey view.

Approximate Arc Tick to approximate the boundary's arcs when adjusting DTMs. Define the min-
imum distance between arc and chord in the Arc-to-chord dist editbox.

Snap tolerance Define the tolerance of adjusting.

Operation

Raise DTM Select to lift the selected DTMs by the value, specified in the By editbox
below.

Lower DTM Select to lower the selected DTMs by the value, specified in the By editbox
below.

Treat boundary as
breakline

Tick to assist in crating vertical walls resulting from the elevation change of
the surface when creating a new DTM or when updating an existing DTM.

Output

Defines the output format. Select one of the following:
l Update existing DTM— to update existing DTMs with the new para-
meters.

l Create new DTM— to create new DTMs with the new parameters.
Existing DTMs will not change.

Tick Trim to Boundary checkbox to trim the modified DTM to the specified
boundary
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Modify DTM icon
The Modify DTM icon of the Create/Edit DTM group allows you to modify current DTM by adding vertices or
removing points.

To add a vertex:
1. In the Create/Edit DTM group of the Surface tab, click the Modify DTM icon.
2. In the survey view, select the required point. The point should be located inside the DTM.

The Edit Surface point dialog is displayed.
3. In the Elevation editbox, specify the height of the new vertex.
4. If needed, in the Code editbox, specify the code of the new vertex.
5. Click OK.

The vertex is added.
6. Repeat steps from 2 to 5 to add more vertices.
7. When finished, press Esc.

The message prompts you to save the changes in DTM.
8. Click Yes.

To remove a point from DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Modify DTM icon.
2. Right click and select Remove Points from the context menu.
3. In the survey view, click the required point.

The point is removed from the DTM.
4. Repeat step 3 to remove more points.
5. When finished, twice press Esc.

The message prompts you to save the changes in DTM.
6. Click Yes.

Import DTM icon
The Import DTM icon of the Create/Edit DTM group allows you to load a DTM to the current project from an
external file or another project.

To import a DTM from another project:
1. In the Create/Edit DTM group of the Surface tab, click the Import DTM icon.

The Import DTM dialog is displayed.
2. Select the From Project radiobutton and click OK.

The Import DTM dialog is displayed.
3. From the Project drop-down list, select the source project.
4. From the DTM To Import drop-down list, select the DTM to import.
5. In the DTM Name editbox, specify the name for the DTM in current project.
6. Click OK.

The DTM is imported.
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To import a DTM from an external file:
1. In the Create/Edit DTM group of the Surface tab, click the Import DTM icon.

The Import DTM dialog is displayed.
2. Select the From File radiobutton and click OK.

The Open dialog is displayed.
3. Select the required file and click Open.

The DTM is imported.

Export DTM icon
The Export DTM icon of the Create/Edit DTM group allows you to save a DTM from the current project to an
external file.

To export a DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Export DTM icon.

The Export DTM dialog is displayed.
2. From the DTM drop-down list, select the DTM to export.
3. Click OK.

The Save As dialog is displayed.
4. Save the DTM file as you need.

Adjust DTM Slope
The Adjust DTM Slope icon of the Create/Edit DTM group allows you to edit nodes of an existing DTM.

To modify a DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Adjust DTM Slope icon.

The control panel is displayed in the left side of the survey view. Preview area is displayed in the right side
of the survey view.

2. From the Design Surface drop-down list, select DTM to be edited.
3. From the Natural Surface drop-down list, select DTM which will be used as the natural surface.
4. If needed, in the Slope Range group box, configure the displaying of the DTM slope.
5. In the preview area, click the DTM node to be edited. Clicked points are listed in the Surface Points list at

the control panel. You may edit them by using one of the following ways:
l Drag it to the new position by mouse.
l Double click the node in the preview, and specify the required coordinates in the Edit Surface
Points dialog.

l Double click point in the list, and specify the required coordinates in the Edit Surface Points dialog.
6. If needed, in the Volume group box, click Calculate, to calculate the new volume.

Fields of the control panel
Field Description

Design Surface Defines the design DTM which will be edited.
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Field Description

Natural Surface Defines the DTM, which will represent natural surface.

Slope Range Defines the layout of the preview. You may configure slope ranges and color
for each of them.

Shade Slope Zone Tick to fill the DTM segments with the color, defined for its slope.

Display Slope Tick to display slope of the DTM segments.

Position Displays the current coordinates of the pointer in the preview area.

Slope Displays the slope of the DTM segment under pointer in the preview area.

Volume Displays the volumes of the selected DTMs. After making changes, click Cal-
culate to update the values.

Surface Points Displays the list of the clicked DTM nodes.

Update DTM icon
The Update DTM icon of the Create/Edit DTM group allows you to update the DTM surface after editing the
elevation values of a point or points that are already used for the DTM.

To update a DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Update DTM icon.

The Update DTM dialog is displayed.
2. In the Point Data group box, define which points will be used for DTM updating.
3. In the DTM group box, define which DTMs will be updated.
4. In the Breakline group box, define the breaklines updating.
5. Click OK.

The DTM is updated.

Check DTM icon
The Check DTM icon of the Create/Edit DTM group allows you to check the connectivity of the triangles in the
current DTM. It will highlight where the overlapping triangles (if any) are located and save them in the layer you
selected. You can also check the boundaries (exterior and interior) of the DTM and report a self-intersecting
boundary. Use this feature to check an imported DTM before using it in a project.

To check a DTM:
1. In the Create/Edit DTM group of the Surface tab, click the Check DTM icon.

The DTM Check dialog is displayed.
2. In the Boundary Check List, define which boundaries will be checked.
3. Click OK.

450



3D View icon

3D View icon
The 3D View icon of the Create/Edit DTM group allows you to view your project in three dimensions.

To view project in 3D:
1. In the Create/Edit DTM group of the Surface tab, click the 3D View icon.

The 3D View dialog is displayed.
2. In the Select From group box, select one of the following radiobuttons:

l All Data – to display all existing data.
l Active Layers – to display only entities, which belong to the active layers.
l All Data – to display only selected entities.

3. In the Driver Offset panel specify the amount and direction of the offset form the required alignment, for
virtual "driving", by using the Offset editbox, and Left and Right radiobuttons.

4. In the Driver Offset panel specify the speed of virtual "driving", by using the Alignment Spacing editbox.
5. Select surfaces to export into 3D view from the list.
6. Tick the Transfer Linework checkbox, to define whether to export lines or not.
7. Tick the Drape Lines checkbox, to define whether to drape all selected lines onto the selected surface or

not.
8. Tick the Transfer Points checkbox, to define whether to transfer points into the 3D view or not.
9. Click OK.

The selected data is displayed in the 3DView in the new window.

NOTE
This icon has the same functionality as the 3D View icon of the Features group at the View tab.

Convert Contour to String icon
The Convert Contour to String icon of the Create/Edit DTM group allows you to create a selected contour as a
string. A series of points with the elevation of the contour line are created as nodes on the string. A range of con-
tour lines may also be converted to strings. The contour strings are useful for defining slope lines or boundaries for
such routines as landfill calculations.

NOTE
Displaying of the contoursmust be turned on to use this feature.

To convert contour to string:
1. In the Create/Edit DTM group of the Surface tab, click the Convert Contour to String icon.
2. In the survey view select the required contour.

The Create String dialog is displayed.
3. Review the properties, if needed, change them. Fields are described in the table below.
4. Click OK.

If you defined non-existing layer for string or its points, the Add New Layer dialog is displayed.
5. Review the properties, if needed, change them. Fields are described in the table below.
6. Click OK.

The string is created.
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The non-editable fields of the Create String dialog
Field Description

Num Points Displays quantity of the points in the string.

Length Displays the length of the string.

Slope Length Displays the length of the slopped segments.

The editable fields of the Create String dialog
Field Description

Name Defines the name of the string.

Layer

Defines layer to which the string will belong to. Note that the string and its
points may belong to the different layers.

Default format is CONSxx_xx. The xx_xx represents the elevation level of the
contour string to two decimal places.

Point Layer

Defines layer to which the points of the string will belong to. Note that the
string and its points may belong to the different layers.

Default format is CONSxx_xx. The xx_xx represents the elevation level of the
contour string to two decimal places.

Color
Defines a color for string displaying.

Default value is the same with the source contour.

Line Style
Defines appearance of the string both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the string in millimeters when plotted.

is Smoothed Select it to apply a smoothing spline algorithm to the string. It is used for plot-
ting purposes and has no influence on any computations.

Break Line
A string may be defined as breakline. The string must be defined by Use in Sur-
face points for that. If ticked, MAGNET Office treats a breakline as a line or
arc across which you cannot form a triangle.

Use String Layer Tick to use the same layer for string and its nodes.

Filter Points Implements a filter to reduce the number of nodes created for the string.

Distance Defines the linear filter tolerance.

Angle Defines the angular filter tolerance.

Buttons of the Create String dialog
Button Description

Get Properties Click it to load existing default properties for strings.
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Button Description

Images/Pdfs
Click it to attach an image or a PDF to the string. The picture will be displayed
near the string. For more information refer to "Image Viewer" section on
page 573.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Fields of the Add New Layer dialog
Property Description

Layer Name Defines the name of the layer.

Active Defines whether the layer is active or turned off.

Lock Defines whether the layer is locked (i.e. cannot be changed) or not.

Overlay When ticked, entities which belong to the layer will be darkened, and not avail-
able for editing, i.e. all entities will be look like a background image.

Color Defines the default color for the layer. All entities, which belongs to this layer
and have By Layer value of the Color parameter will be painted with it.

Point Mark Defines the default point mark for the layer. All points, which belong to this
layer and have By Layer value of the Mark parameter will have such mark.

Line Type
Defines the default line style for the layer. All lines, arcs, circles, strings, poly-
lines, polygon, lots, pads and boundaries, which belong to this layer and have
By Layer value of the Line Style parameter will have such line style.

Line Width
Defines the default line thickness for the layer. All lines, arcs, circles, strings,
polylines, polygon, lots, pads and boundaries, which belong to this layer and
have By Layer value of the Thickness parameter will have such line thickness.

Point Symbol Defines the default point symbol for the layer. All points, which belong to this
layer and have By Layer value of the Symbol parameter will have such symbol.

Text Style Defines the default text style for the layer.

Create DTM Boundary icon
The Create DTM Boundary icon of the Create/Edit DTM group allows you to create a DTM boundary inside or
outside of a DTM.

To create a boundary:
1. In the Create/Edit DTM group of the Surface tab, click the Create DTM Boundary icon.

The Create DTM Boundary dialog is displayed.
2. Review the parameters, if needed, change them. Fields are described in the table below.
3. Click OK.

The DTM Boundary Created dialog is displayed, containing list of the newly created boundaries.
4. Click OK.
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Fields of the Create DTM Boundary dialog
Field Description

From DTM Defines the source DTM for boundary creation.

Create Boundary
in Layer Defines layer in which the boundary will be created.

Prefix Boundary
Name By

Defines the prefix of boundary name.

By default it is the name of the source DTM.

Create Exterior
Boundary

Tick to create boundary at the exterior edge of the DTM. See pictures
below for details.

Create Interior
Boundary

Tick to create boundary at the interior edge of the DTM. See pictures
below for details.

Save Boundary in
DTM Settings Tick to assign the boundary to the DTM.

Delete Boundary
Created Pre-

viously From the
DTM

Tick to delete the previously created boundaries. Note that only bound-
aries of the same type (interior/exterior) as the newly creating will be
deleted.

Source DTM
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Interior Boundary

Exterior Boundary
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Edit Mesh group
The Edit Mesh group from the Surface tab of the MAGNET Office ribbon allows you to edit existing
DTM meshes. It contains two icons and nine second level icons, described in the table below.

Add Triangle icon
Click it to add a new triangle to the surface. This icon

also contains the list of the second level icons for various
operations with triangles. Click to expand the list of

the second level icons.
Swap Triangles icon

Click it to swap two triangles between each other.
Show Triangles Properties icon

Click it to display properties of the existing triangle.
Check/Edit Breaklines icon

Click it to check existing breaklines and edit invalid
ones.

Insert Breakline icon
Click it to insert breaklines to the surface.
Nightlight Points set to Use in Surface icon

Click it to highlight points which may be used in
DTM creation.

Decompose Triangle icon
Click it to decompose triangles in the current DTM.

Delete Triangles icon
Click it to delete triangles from the DTM. This icon also
contains the list of the second level icons for various

deleting modes. Click to expand the list of the second
level icons.
By Line icon

Click it to delete triangles by drawing a line across tri-
angles to be deleted.
By Boundary icon

Click it to delete triangles by selecting points around the
triangle to be deleted.
By Length or Angle icon

Click it to delete triangles by nominating the maximum
side length.

Add Triangle icon
The Add Triangle icon of the Edit Mesh group allows you to current DTM mesh.

To manually add triangles:
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1. In the Edit Mesh group of the Surface tab, click the Add Triangle icon.
2. Continuously select the points for triangle. Preferably, they should be at the vertex of an existing triangle

that is adjacent to the area where the new triangle will be formed.

The triangle is formed.
3. If needed, add more triangles.
4. When finished, press Esc.

Swap Triangles icon
The Swap Triangles icon of the Edit Mesh group allows you to swap two adjacent triangles so that the triangles
are defined to their opposite diagonals. See picture below for details.

Swap two triangles

To swap triangles:
1. In the Edit Mesh group of the Surface tab, click the Swap Triangles icon.
2. Continuously select two triangles for swapping.
3. The common edge of triangles are changed to the opposite diagonal.
4. In needed, select more triangles.
5. When finished, press Esc.

Show Triangles Properties icon
Click the Show Triangles Properties icon to display the properties of the selected triangle.
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Check/Edit Breaklines icon
The Check/Edit Breaklines icon of the Edit Mesh group allows you to scan all existing breaklines for any cross-
ing breaklines, point which don't have the Use in Surface flag turned on; highlight the results and generate the
report.

Crossing breaklines can cause an error in the surface model and produce inaccurate contours. Any crossing break-
line is ignored by the breakline insertion routines.

Crossing breaklines are usually errors caused by incorrect stringing, field procedure, or mistakes in the code lib-
rary. Check all crossing breaklines and modify, segment, or delete the lines to ensure the formation of an accur-
ate surface model.

Crossing breaklines may occur in following cases:
l When the wrong string number is entered for a survey point in the field, so points are allocated to the
wrong stringline.

l When the point is allocated the wrong feature code.
l When surveying the top and base of a vertical or near vertical feature. Make sure that shots at the top and
base are in a similar position so the lines do not overlap.

To check breaklines:
1. In the Edit Mesh group of the Surface tab, click the Check/Edit Breaklines icon.

The Check/Edit Breaklines dialog is displayed.
2. Select whether to highlight all breaklines, or only invalid breaklines, by selecting the appropriate radi-

obutton.
3. If needed, tick the Show report checkbox, to generate the report, listing the breaklines errors.
4. Click OK.

The breaklines are highlighted.
5. The message window prompts whether to edit breaklines or not. Click Yes or Not as you need.

If you have ticked the Show report checkbox, the report is displayed.
6. Click the highlighted breakline to edit it.
7. When finished, press Esc.
8. The message window prompts you to update the DTM. Click Yes or Not as you need.

Insert Breakline icon
The Insert Breakline icon of the Edit Mesh group allows you to insert existing breaklines — a line, string or arc,
which defined as a breakline, but has not already been used — to the current DTM. It helps you to make sure that
all breaklines have been inserted in the DTM after you have completed editing lines and arcs.

To insert breaklines to the DTM:
1. If needed, select the breaklines to be added to the DTM.
2. In the Edit Mesh group of the Surface tab, click the Insert Breakline icon.

The Insert Breaklines Into DTM dialog is displayed.
3. In the Selection group box, define which breaklines will be used for insertion.
4. Configure the additional parameters as you need. Fields are described in the table below.
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5. Click OK.
6. If you have selected Select a breakline option at step 3, continuously select the breaklines to be added to

the DTM, when finished, press Esc.

Fields of the Insert Breaklines Into DTM dialog
Field Description

Check Crossing
Breaklines Tick to prevent creation of self-crossing DTM.

Approximate Arcs Tick to create breaklines around curves.

Arc-to-Chord
Distance

Defines the distance between curve and the approximation chord. More tri-
angles are formed around the curve when a smaller value is used.

Use breaklines
from the selected

data
Only selected breaklines will be used.

Breaklines in act-
ive layers Only breaklines from the currently active layers will be used.

Select a breakline Only breaklines, selected by user will be used.

Nightlight Points set to Use in Surface icon
The Nightlight Points set to Use in Surface icon of the Edit Mesh group allows you to check for points that have
the Use in Surface flag turned on.

To check which points may be used for DTM creation:
1. In the Edit Mesh group of the Surface tab, click the Nightlight Points set to Use in Surface icon.
2. The message prompts you to generate the report, listing all Use in Surface points. Click Yes or No as you

need.

The Use in Surface points are highlighted.

Decompose Triangle icon
The Decompose Triangle icon of the Edit Mesh group allows you to decompose triangles in the current digital ter-
rain model. When a line, arc, polygon, or string is selected, additional triangles are created along the entity as if
the entity is a breakline. The purpose is to insert additional triangles that do not alter the existing contours.

The points defining the entity do not need to have levels or be set as Use in Surface. Heights may be allocated to
these points at a later date to modify the DTM.

To decompose triangles:
1. If needed, select the entities to be added to the DTM.
2. In the Edit Mesh group of the Surface tab, click the Decompose Triangle icon.

The Decompose Triangles dialog is displayed.
3. In the Selection group box, define which entities will be used for insertion.
4. Configure the additional parameters as you need. Fields are described in the table below.
5. Click OK.
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6. If you have selected Select a breakline option at step 3, continuously select the entities to be added to the
DTM, when finished, press Esc.

Fields of the Decompose Triangles dialog
Field Description

Check Crossing
Breaklines Tick to prevent creation of self-crossing DTM.

Approximate Arcs Tick to create lines around curves.

Arc-to-Chord
Distance

Defines the distance between curve and the approximation chord. More tri-
angles are formed around the curve when a smaller value is used.

Lines in the selec-
ted data Only selected entities will be used.

Breaklines in act-
ive layers Only breaklines from the currently active layers will be used.

Select a line Only entities, selected by user will be used.

Delete Triangles icon
The Delete Triangles icon of the Edit Mesh group allows you to delete triangles from the DTM mesh.

NOTE
Displaying of themeshmust be turned on, when using this option.

To delete triangles:
1. In the Edit Mesh group of the Surface tab, click the Delete Triangle icon.
2. Continuously select triangles to be deleted from the DTM.
3. When finished, press Esc.

By Line icon
The By Line icon of the Edit Mesh group allows you to draw a string, comprising one or more segments, across
triangles that you want to delete from the current DTM.

To delete triangles by line:
1. In the Edit Mesh group of the Surface tab, click the By Line icon.
2. In the survey view, draw a string across triangles you want to delete.
3. When finished drawing a string, press Esc.

The confirmation message is displayed.
4. Click Yes.

The triangles are deleted.
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By Boundary icon
The By Boundary icon of the Edit Mesh group allows you to delete triangles, located inside or outside of a
defined boundary.

To delete triangles by boundary:
1. In the Edit Mesh group of the Surface tab, click the By Boundary icon.

The Delete Triangles By Boundary dialog is displayed.
2. In the Delete Triangles group box, select which triangles will be deleted – either inside or outside of the

boundary.
3. In the Criteria for Deleting Triangles By Boundary group box, configure the deleting criteria. Fields are

described in the table below.
4. Define the boundary. Do one of the following:

l Select an existing boundary from the list.
l Click Pick Boundary to select the boundary in the survey view.
l Click New Boundary to create a new boundary.

5. Click OK.

The confirmation message is displayed.
6. Click Yes.

The triangles are deleted.

Fields of the Delete Triangles by Boundary dialog
Field Description

Delete Triangles

Clip Triangle Tick to delete only the triangles that are totally enclosed in the boundary.

Approximate Arc Tick to create additional triangles so triangle edges are formed along
chords of the curved breaklines.

Delete

Deletes triangles crossing the boundary. If this option is selected, then
choose one of the following:

l At least 1 vertex inside/outside the boundary – to delete all tri-
angles that cross the boundary and have at least 1 vertex outside
the boundary.

l At least 2 vertex inside/outside the boundary – to delete all tri-
angles that cross the boundary and have at least 2 vertex outside
the boundary.

l Centroid inside/outside the boundary – to delete all triangles that
cross the boundary and have the centroid inside/outside the bound-
ary.

Boundary Name Lists the existing boundaries.

By Length or Angle icon
The By Length or Angle icon of the Edit Mesh group allows you to delete triangles by nominating the maximum
side length or angle of triangles for the DTM. All triangles with a side length or angle more than the maximum
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will be deleted.

To delete triangles by side length:
1. In the Edit Mesh group of the Surface tab, click the By Length or Angle icon.

The Delete Triangles dialog is displayed.
2. In the By Length group box, select the radiobutton and specify the maximum side length.
3. Click OK.

The confirmation message is displayed.
4. Click Yes.

The triangles are deleted.

To delete triangles by angle:
1. In the Edit Mesh group of the Surface tab, click the By Length or Angle icon.

The Delete Triangles dialog is displayed.
2. In the By Angle group box, select the radiobutton and specify the maximum side length.
3. Select whether triangles with 1 or 2 vertexes with smaller angle will remain.
4. Click OK.

The confirmation message is displayed.
5. Click Yes.

The triangles are deleted.
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Boundary group
The Boundary group from the Surface tab of the MAGNET Office ribbon allows you to create and manage bound-
aries in the project. It contains five icons, described in the table below.

Create Boundary icon
Click it to create a new boundary.

Create Enclosing icon
Click it to create the enclosing boundary from existing points.

From Polygons icon
Click it to create the boundary from two or more existing polygons.

Create List icon
Click it to create a list of existing enclosed areas/boundaries.

Edit Lists icon
Click it to delete a boundary list or remove individual boundary from the list.

Create Boundary icon
The Create Boundary icon of the Boundary group allows you to add a new boundary to the survey view.

To create a new boundary:
1. In the Boundary group of the Surface tab, click the Create Boundary icon.

The input panel for point creation is displayed at the bottom toolbar. Description of the fields may be found
in the table below.

2. Locate the nodes of the boundary.
3. To enclose the boundary do one of the following:

l Locate the last point at the same place as the first point.
l Press Esc. The message window prompts to save the boundary. Click OK. The last created point
will be connected with the first point with the shortest line possible.

The Edit Boundary dialog is displayed.
4. Review the properties of the newly created boundary, if needed change them. For more information refer to

"Boundary properties" section on page 563.
5. Click OK.

The polygon is created.

Fields of the input panel, when creating boundaries
Field Description

Number Defines the number of the next new point.

East Defines the East (X) coordinate of the boundary point.

North Defines the North (Y) coordinate of the boundary point.

Elev Defines the elevation of the boundary point.

Code Defines the code of the boundary point.

Use in Surface Defines whether the boundary point may be used for DTM creation.
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Field Description

Interpolate Elev-
ation

Defines whether the elevation of the boundary point will be automatically cal-
culated by interpolation.

BreakLine Defines whether the lines of the new boundary be a breakline.

Create Enclosing icon
The Create Enclosing icon of the Boundary group allows you to create a boundary which encloses a defined set
of points.

There are three methods for enclosing boundary creation:
l Convex Boundary — creates a convex boundary around the extent of the selected points. The boundary
will enclose all of the selected data.

l Tight Boundary — creates a boundary passing through each of the outer points selected, thus forming a
shrink wrap of the points.

l Closed — shrink wraps the selected points and entities to form a continuous boundary along the outer
edges of the selection.
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Convex and tight boundaries

Close boundary

To create an enclosing boundary:
1. If needed, select the required entities.
2. In the Boundary group of the Surface tab, click the Create Enclosing icon.
3. The Create Enclosed Polygon dialog is displayed.
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4. In the Selection group box, define the base points and entities for boundary creation. Select one of the fol-
lowing rudiobuttons:

l All— to use all existing points and entities.
l Current Selection— to use only currently selected points and entities.

5. If needed, tick the Ignore points without elevation checkbox. Points with undefined elevations won't be
used.

6. In the Method group box, select the appropriate creation method. See description above for details.
7. Click OK.

The boundary is created.

From Polygons icon
The From Polygons icon of the Boundary group allows you to create a boundary from two or more existing con-
nected polygons, i.e. polygons, which have common edge. Note that the original polygons won't be deleted.

Boundary from the connected polygons

To create a boundary from existing polygons:
1. In the Boundary group of the Surface tab, click the From Polygons icon.
2. In the survey view, continuously select the required polygons.
3. When finished, press Esc.

The boundary is created.

Create List icon
The Create List icon of the Boundary group allows you to create lists of existing boundaries and enclosed areas.
This function defines a boundary for each closed area on the active layers displayed in the project.
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To create a list of boundaries and enclosed areas:
1. In the Boundary group of the Surface tab, click the Create List icon.

The Edit Boundary List Name dialog is displayed.
2. In the Name editbox, type the name of the boundary list.
3. If needed, tick the Include Existing Boundaries checkbox.
4. Click OK.

The enclosed areas are converted to boundaries. The message window appears, displaying the boundaries,
included to the list.

Edit Lists icon
The Edit Lists icon of the Boundary group allows you to manage boundary lists.

To delete a boundary list:
1. In the Boundary group of the Surface tab, click the Edit List icon.

The Edit Boundary Lists dialog is displayed.
2. Select the required list and click Delete.

The message prompts you to delete included boundaries.
3. Click Yes or No as you need.

The boundary list is deleted.

To delete a boundary from a list:
1. In the Boundary group of the Surface tab, click the Edit List icon.

The Edit Boundary Lists dialog is displayed.
2. Select the required list and click Edit.

The boundary list dialog is displayed.
3. Select the required boundary and click Delete.
4. If needed, delete more boundaries.
5. Click OK.
6. Click OK to close the Edit Boundary Lists dialog.

The boundary is deleted from the list.
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Volume group
The Volume group from the Surface tab of the MAGNET Office ribbon allows you to calculate volumes in your
project. It contains three icons, described in the table below.

Compute icon
Click it to compute volume between two surfaces and a boundary.

Batch icon
Click it to calculate volumes for several stockpiles in project.

Quick icon
Click it to automatically calculate volume between an existing DTM and auto-

matically created design DTM.

Compute icon
The Compute icon of the Volume group allows you to calculate the volumes between two surface models within
a defined boundary. The surface models may be in the same project or two projects.

One of the surfaces may be a defined datum level to represent a surface as a horizontal plane. In this case, no
DTM is required for this surface.

Volume computation methods
When computing volumes, keep in mind that:

l DTMs must exist for both surfaces unless a datum height is being used for one surface.
l If the DTMs are in different projects, both projects must be opened in the MAGNET Office and the design
surface project should be the current project.

l A boundary must be defined for the computation. If two projects are used, the boundary should be in the cur-
rent project.

l DTMs for both surfaces should fully cover the boundary area. If the triangular mesh does not cover the full
extent of the boundary, the results will be unreliable. You should check the boundary areas specified in the
output report. The areas for the natural and design surfaces should match the boundary area.

l For precise results, consider how well the mesh fits the actual terrain. If it is a good fit, then good results
will be obtained.

l Make sure that all breaklines have been defined and inserted into the DTM; otherwise, the volumes com-
puted may be inaccurate. Make sure there are no crossing breaklines.

Prismmethod

This method calculates exact volumes, as it uses of the DTM triangles to calculate the volumes. The mesh has
been computed from the exact data, so no interpolation is used in the computation.

The triangular mesh for one project is subdivided until each triangle for that project fits entirely inside a triangle
for the other project and is all cut or all fill. For each triangle, a mean height and area are computed. Because the
triangles in both projects are coincident, individual cut and fill volumes can be built up over the entire model. Pic-
ture below illustrates the subdivision of triangles. The original triangulation is not altered by this subdivision; the
subdivided triangles are only used in the computation and are then discarded.
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Individual cut and fill volumes are then tabulated to produce total cut and total fill for the entire area within the
boundary

Prism method

The prism method is the most accurate method of determining volumes in the MAGNET Office. The surveyed
points are used for the triangular model, so there is no interpolation of data giving the closest result for the project
data.

Slicesmethod

This method computes volumes between specified contour intervals using the prismoidal method.

The surface area of the two models is in the form of 3-dimensional triangles. The slices method subdivides this
existing triangular mesh until each triangle for the project fits entirely inside a triangle for the other project, is all
cut or all fill, and is within the defined boundary. The volume for each subdivided triangle is bounded by up to
seven planes; the three vertical sides, the natural surface, the design surface, and the two contour intervals
defined by the slice interval, as shown on picture below.

MAGNET Office uses these subtriangle prisms to calculate volumes for each subtriangle prism and for each rel-
evant slice. The results for each slice are accumulated.
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Slices method

The final report includes volumes between contours at the nominated interval and is suited to stockpiles, excav-
ations, storm water ponds, dams, and reservoir computations. In the case of an excavation, the result will include
cut and fill volumes, but the required answer will be either the total cut or total fill, depending on which surface is
entered as the design surface.

Gridmethod

In this method, a rectangular grid is overlaid onto the data. At each grid node (intersection) a height is computed
for each surface by interpolation from the triangular mesh. The grid spacing in both X and Y directions may be
chosen. The accuracy of the answer will increase with a decrease in the grid spacing. The grid interval chosen
should be relevant to the terrain involved. For example, for an open pit, it is recommended that the grid interval
should be 1/5th the size of the smallest triangle.

This method can only give approximate results because the computation is made from interpolated points. The grid
square is subdivided into two triangles for each surface.
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The delta z’s for each vertex of the triangles are calculated and the following formula is used to calculate the
volume.

Grid method

If the grid triangles are not all cut or all fill, then these triangles are further subdivided and the interpolation of the
heights for these triangles is extracted from the grid levels, not the triangular mesh. The same formula is applied
to these triangular prisms.

Subdivision of triangles also occurs if one of the grid points is outside the boundary. Triangles are formed to scis-
sor against the boundary as shown below. If the height of the point outside the boundary is known or interpolated
from the triangular mesh; then heights along the boundary will be a linear interpolation from the existing grid
points. If the point outside the boundary is unknown, then heights along the boundary will be interpolated from the
triangular mesh.

Computing volumes
To compute volume:

1. In the Volume group of the Surface tab, click the Compute icon.

The Standard Volumes dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.
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Fields of the Standard Volumes dialog
Field Description

Design Surface Defines the design surface for the computation. Select whether an existing
DTM or a known datum level.

Natural Surface Defines the natural surface for the computation. Select whether an existing
DTM or a known datum level. DTM from another project may be used.

Boundary Defines the boundary for the computation.

Cut and Fill DTM Tick to shade the output DTM. If ticked, select the cut and fill colors and
define the name of the output DTM.

Factor Defines the swelling or shrinking factor, which leads to increasing or decreas-
ing volume by specified ratio.

Prismoidal Tick to compute volumes by using the prismoidal method.

Slices Tick to compute volumes by using the slices method. If ticked, defines the
slices interval.

Grid

Tick to compute volumes by using the grid method. If ticked, configure the fol-
lowing parameters:

l Rotation angle — defines the rotation of the grid over the surface model.
l Spacing X and Spacing Y— defines the spacing between grid nodes.

Tonnage Tick to calculate also the weight of the volume. If ticked, define the density of
the volume.

Batch icon
The Batch icon of the Volume group allows you to monitor progressive volumes on site or calculate volumes for
numerous stockpiles within one project. It calculates volumes, using the prism method, between two surfaces
within the same project or between two projects for each boundary in a defined boundary list.

Keep in mind following:
l DTMs must exist for both surfaces unless a datum height is being used for one surface.
l If the DTMs are in different projects, both projects must be opened in the MAGNET Office and the design
surface project should be the current project.

l A boundary must be defined for the computation. If two projects are used, the boundary should be in the cur-
rent project.

l DTMs for both surfaces should fully cover the boundary area. If the triangular mesh does not cover the full
extent of the boundary, the results will be unreliable.You should check the boundary areas specified in the
output report. The areas for the natural and design surfaces should match the boundary area.

l For precise results, consider how well the mesh fits the actual terrain. If it is a good fit, then good results
will be obtained.

l Make sure that all breaklines have been defined and inserted into the DTM; otherwise, the volumes com-
puted may be inaccurate. Make sure there are no crossing breaklines.

To compute volume:
1. In the Volume group of the Surface tab, click the Batch icon.

The Batch Volume s dialog is displayed.
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2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Batch Volume s dialog
Field Description

Calculate Tick to include the line to calculation.

Surface Defines the design surface.

Jobs Defines the project, containing natural surface.

Surface 2 (Ref) Defines the natural surface.

Boundary List Defines the boundary for volume computation.

Comments Defines any additional comments to be used in the report.

Quick icon
The Quick icon of the Volume group allows you to automatically create an existing DTM and a design DTM,
then calculates a volume between the two surfaces. You must have data that defines, for example, both the toe of
a stockpile and the stock pile itself.

To calculate volume:
1. In the Volume group of the Surface tab, click the Quick icon.
2. The Quick Volume dialog is displayed.
3. In the Selection group box, define the base points and entities for boundary creation. Select one of the fol-

lowing rudiobuttons:
l All – to use all existing points and entities.
l Current Selection – to use only currently selected points and entities.

4. In the Boundary group box, define whether to use an existing boundary, or define a method for creating a
new boundary. See "Create Enclosing icon" section on page 464 for details.

5. In the Base group box, define whether to use an existing DTM, or create a new one.
6. Tick the Retain Created Boundary checkbox, to save the boundary and place it on the current layer.
7. Tick the Retain Created DTMs checkbox, to save the DTMs created during the volume calculation.
8. If needed, tick the Tonnage to calculate the weight of the volume. If so, specify the density in the appro-

priate editbox.
9. Click OK.
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Library Tab
The Library tab of the MAGNET Office ribbon contains control icons, which allows you to work with various lib-
raries, used in the project. It is separated to four groups:

l "Code group" section on the next page
l "Library group" section on page 483
l "Output group" section on page 487
l "Create group" section on page 491
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Code group
The Code group from the Library tab of the MAGNET Office ribbon allows you to work with the survey codes.
It contains three icons and three second level icons, described in the table below.

Global Codes icon
Click it to open the library of global survey codes.

Code Settings icon
Click it to configure the survey codes.

Attributes icon
This icon contains the list of the second level icons for various operations
with entities attributes. Click to expand the list of the second level

icons.
Points icon

Click it to edit points attributes.
Lines icon

Click it to edit lines attributes.
Polygon Area icon

Click it to edit polygon area attributes.

Global Codes icon
The Global Codes icon of the Code group allows you to edit global survey codes.

The Survey Codes dialog, opened at Global Survey Codes tab appears after clicking. For more information, refer
to "Global survey codes editor" section on page 540.

Code Settings icon
The Code Settings icon of the Code group allows you to define the various settings for controlling the stringing
together of feature codes. It has other settings for command codes and delimiters used to extend the functions
available when survey codes are used in the field.

To set up the survey codes:
1. In the Code group of the Library tab, click the Code Settings icon.

The Survey Code Settings dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. Verify your settings:

1. Click Test.

The Feature Code Test dialog is displayed.
2. Type the required feature code and click OK.
3. Review the result in the message window.

4. If needed, change the settings and verify them.
5. Click OK.
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Fields of the Survey Code Settings dialog
Field Description

Survey Code
Format

Fields from this group box define the order in which the code, string numbers,
and contour flags are entered in the instrument. The Preview box displays the
settings.

Number of digits
for stringing

Defines the number of different strings available using the same descriptive sur-
vey code. Using two digits for the string would provide as many as 99 different
strings using the same survey code. A threedigit string provides 999 different
strings using the same survey code.

Prefix String Num-
ber

Tick if the string number prefixes the feature code. This is the usual setting -
SScode such as: 03TB. Clear this check box if the string number is a suffix to
the feature code — codeSS such as: TB03 or TB3.

Contour Flag

Tick if the contour flag is entered with the string number. This is essential
when numeric feature codes are used.

This check box may be selected although the contour digit is not entered with
the alpha feature codes. In this case, the contour flag is assumed to be set at 2
which is "read the contour flag from the library" for this feature code. Other
contour flags used are 0 which is "contour flag not set" and 1 which is "contour
flag set."

Clear the check box if no contour flags are used. If no flag is used, then the
default setting for the Survey Code is applied to the point.

Prefix Contour
Flag

Tick if the contour digit is a suffix to the string number. This is the usual set-
ting. SSCcode such as: 031TB or 030TB.

Clear this check box if the contour digit prefixes the string number CSScode
such as 103TB or 003TB.

Survey Code Commands

Delimiter

The default is the asterisk. Another character should be chosen if the asterisk
is not available on the data logger, such as + or #. The delimiter is used after
the feature code to extend the survey code with further commands. The delim-
iter can indicate a second string and feature code to enable more than one
string to be attached to a point, such as: 02FL*04FL point at the intersection of
two fence lines 02FL*06TB point on a fence line and a bank.

Comment

The default is the forward slash (/). The space character may also be used.

The comment character is used after the feature code to indicate that all char-
acters that follow it are optional comments, such as Tree species, manhole
number or a note - TR RIMU or TR/RIMU or SWMH 5A or SWMH/ 5A

Start of Arc
The default is AS, but may be modified as necessary.

The character is used after the delimiter character to indicate the point is the
start of an arc, such as: 03TK*AS
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Field Description

End of Arc

The default is AE, but may be modified as necessary.

The character is used after the delimiter character to indicate the point is the
end of an arc, such as: 03TK*AE.

When the data is reduced then a two- or three-point arc is created between the
start and end points using another point on the string in between these points if
available for the three-point arc.

Close String
The default is C but may be modified as necessary.

The character is used after the delimiter character to indicate this point on the
string in between these points if available for the three-point arc.

Circle Radius
The default is CR, but may be modified as necessary.

The character is used after the delimiter character to indicate the radius of the
circle, based on this point, such as: 03TK*CR5.

Circle Cir-
cumference

The default is CE, but may be modified as necessary.

The character is used after the delimiter character to indicate the cir-
cumference length of the circle, based on this point, such as: 03TK*CE5.

Rectangle

The default is R but may be modified as necessary.

The character is used after the delimiter character on the third point of a rect-
angle. A new point is computed to form a rectangle with the other points, such
as: 01BLD*R A new point will be computed at the fourth corner of the building
and lines will join the first point on the string to the new point and from the
labelled point to the new point. No level is computed for this new point.

When three points are used, the rectangle is automatically squared off.

You can also use two points and an offset such as: BLD*R3.5 A rectangle is
created between these two points and a parallel line at the specified offset.

Scale

The default is S but may be modified as necessary.

The character is used after the delimiter character to set the symbol scale on
the point. It is followed by a number representing the radial size of the point
feature, such as: TRE*S3

When the data is reduced, the point will have the symbol scale set to X scale =
3 and Y scale = 3.

The symbol should usually be a scalable symbol.

Check Meas-
urement

The default is CHK but may be modified as necessary.

The character is used after the delimiter character to label a check shot to a
back sight or other point with known coordinates, using the same point number
already in the dataset.

This usage only creates a check shot. It does not include the shot in the aver-
aged calculations when more than one shot is made to one point, such as two
shots on left and right face.

478



Points icon

Field Description

Contour

The default is Z but may be modified as necessary.

The character is used after the delimiter character to turn off the contour flag
for this point, such as: 01FCE*Z

This is useful if the level shot in the field is not reliable and should not be used
in a DTM.

Plot Height

The default is Y but may be modified as necessary.

The character is used after the delimiter character to turn off the height annota-
tion flag for this point, such as: 01FCE*Y.

This can be used with the contour flag as 01FCE*YZ.

Offset String

These are used when it is not possible to observe the required point directly,
but it is possible to offset the target by a known amount. Many instruments
have these features on board, but these options can be used in the coding if the
instrument does not compute offsets.

Offsets

Radial

The default is R and is used after a decimal point, which directly follows the
feature code with a positive or negative distance for the offset.

Example: Code.R0.5 computes the point 0.5m further away from the observer
than the target position and Code.R-1.00 computes the point 1m closer to the
observer.

Tangential

The default is T and is used after a decimal point, which directly follows the
feature code with a positive or negative distance for the offset.

Example: Code.T0.5 computes the point 0.5m to the right of the observation at
the target position and Code.T- 1.00 computes the point 1m to the left of the
observation.

Height

The default is H and is used after a decimal point which directly follows the
feature code with a positive or negative distance for the offset.

Example: Code.H0.3 computes the point 0.3m above the observation at the tar-
get position and Code.H-0.5 computes the point 0.5m below the observation.

Points icon
The Points icon of the Code group allows you to manage the custom attributes for points.

The Attributes - Points dialog appears after clicking. It allows you to create new, edit or delete an existing attrib-
utes. See sections below for details.

Fields of the Attributes - Points dialog

Field Description

Name Defines the name of the custom attribute.

Value Type Defines the type of the custom attribute's value.
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Field Description

Max Num Char-
acters Defines the maximum length of the custom attribute's value.

Default Value Defines the default value of the custom attribute.

Creating new attributes
To create a new attribute:

1. In the Code group of the Library tab, click the Points icon.

The Attributes - Points dialog is displayed.
2. In the Name editbox, type the name of the new attribute.
3. From the Value Type drop-down list, select the type of the new attribute's value.
4. In the Max Num Characters editbox, specify the maximum length of the custom attribute's value.
5. In the Default Value editbox, specify the default value of the custom attribute.
6. Click New.

The attribute is created.

Editing attributes
To edit an existing attribute:

1. In the Code group of the Library tab, click the Points icon.

The Attributes - Points dialog is displayed.
2. Select the required attribute from the list.
3. Make the required configurations. Fields are described in the table above.
4. Click Apply.

The attribute is edited.

Deleting attributes
To delete an existing attribute:

1. In the Code group of the Library tab, click the Points icon.

The Attributes - Points dialog is displayed.
2. Select the required attribute from the list.
3. Click Delete.

The attribute is deleted.

Lines icon
The Lines icon of the Code group allows you to manage the custom attributes for lines.

The Attributes - Lines dialog appears after clicking. It allows you to create new, edit or delete an existing attrib-
utes. See sections below for details.

Fields of the Attributes - Lines dialog
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Field Description

Name Defines the name of the custom attribute.

Value Type Defines the type of the custom attribute's value.

Max Num Char-
acters Defines the maximum length of the custom attribute's value.

Default Value Defines the default value of the custom attribute.

Creating new attributes
To create a new attribute:

1. In the Code group of the Library tab, click the Lines icon.

The Attributes - Lines dialog is displayed.
2. In the Name editbox, type the name of the new attribute.
3. From the Value Type drop-down list, select the type of the new attribute's value.
4. In the Max Num Characters editbox, specify the maximum length of the custom attribute's value.
5. In the Default Value editbox, specify the default value of the custom attribute.
6. Click New.

The attribute is created.

Editing attributes
To edit an existing attribute:

1. In the Code group of the Library tab, click the Lines icon.

The Attributes - Lines dialog is displayed.
2. Select the required attribute from the list.
3. Make the required configurations. Fields are described in the table above.
4. Click Apply.

The attribute is edited.

Deleting attributes
To delete an existing attribute:

1. In the Code group of the Library tab, click the Lines icon.

The Attributes - Lines dialog is displayed.
2. Select the required attribute from the list.
3. Click Delete.

The attribute is deleted.

Polygon Area icon
The Polygon Areas icon of the Code group allows you to manage the custom attributes for polygons.

The Attributes - Polygon Areas dialog appears after clicking. It allows you to create new, edit or delete an exist-
ing attributes. See sections below for details.

Fields of the Attributes - Polygon Areas dialog
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Field Description

Name Defines the name of the custom attribute.

Value Type Defines the type of the custom attribute's value.

Max Num Char-
acters Defines the maximum length of the custom attribute's value.

Default Value Defines the default value of the custom attribute.

Creating new attributes
To create a new attribute:

1. In the Code group of the Library tab, click the Polygon Areas icon.

The Attributes - Polygon Areas dialog is displayed.
2. In the Name editbox, type the name of the new attribute.
3. From the Value Type drop-down list, select the type of the new attribute's value.
4. In the Max Num Characters editbox, specify the maximum length of the custom attribute's value.
5. In the Default Value editbox, specify the default value of the custom attribute.
6. Click New.

The attribute is created.

Editing attributes
To edit an existing attribute:

1. In the Code group of the Library tab, click the Polygon Areas icon.

The Attributes - Polygon Areas dialog is displayed.
2. Select the required attribute from the list.
3. Make the required configurations. Fields are described in the table above.
4. Click Apply.

The attribute is edited.

Deleting attributes
To delete an existing attribute:

1. In the Code group of the Library tab, click the Polygon Areas icon.

The Attributes - Polygon Areas dialog is displayed.
2. Select the required attribute from the list.
3. Click Delete.

The attribute is deleted.
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Library group
The Library group from the Library tab of the MAGNET Office ribbon allows you to edit various
MAGNET Office layout libraries. It contains seven icons, described in the table below.

Colors icon
Click it to manage the custom colors library.

Text Styles icon
Click it to modify text styles, used in MAGNET Office.

Justification icon
Click it to modify justification styles used in MAGNET Office.

Annotation icon
Click it to modify annotation styles used in MAGNET Office.

Legal Description icon
Click it to create or modify legal description template.

Symbols icon
Click it to create or modify symbols in the library.

Line Styles icon
Click it to create or modify line styles in the library.

Colors icon
The Colors icon of the Library group allows you to manage the MAGNET Office color palette. This palette is
global, and available for all projects.

To create a new color:
1. In the Library group of the Library tab, click the Colors icon.

The Create Custom Colors dialog is displayed.
2. In the Custom Colors palette select a cell for the new color.
3. Do one of the following:

l Configure the new color by using the color palette and shade bar.
l Manually enter the required data in the "Hue", "Sat", "Lum", "Red", "Green" and "Blue" editboxes.

4. Click Add to Custom Colors.

The configured color is added to the selected cell.
5. Click OK.

To import the current palette to the color file, click Import.

To load previously configuration from the external file, click Export.

Text Styles icon
The Text Styles icon of the Library group allows you to manage the text styles library. Text styles define layout of
all textual data in the MAGNET Office – point numbers, entities annotations, etc. The settings, configured in the
library are global, and available for all projects. See "Text styles library" section on page 631 for details.

The Text styles dialog appears after clicking. It contains the list of the existing text styles and font, size, color and
formatting for each style. Buttons of the dialog are described in the table below.
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Buttons of the Text Style dialog
Button Description

New Click it to create a new text style. For more information refer to "Creating text
styles" section on page 631.

Modify Click it to edit an existing text style. For more information refer to "Editing text
styles" section on page 631.

Rename
Click it to rename an existing text style.

NOTE
The $$DEFAULT text style cannot be renamed.

Delete
Click it to delete an existing text style.

NOTE
The $$DEFAULT text style cannot be deleted.

Import Click it to load a text style from an external file.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Justification icon
The Justification icon of the Library group allows you to manage the number justification styles library. The set-
tings, configured in the library are global, and available for all projects. See "Justification styles library" section
on page 632 for details.

Justification style defines the format of the number and its decimal precision. It controls the appearance of the
numerical values used in such text items as height annotation, grid values, chainage, and levels in road drawings.

The Justification Style dialog appears after clicking. Buttons of the dialog are described in the table below.

Buttons of the Justification Style dialog
Button Description

New Click it to create a new justification style. For more information refer to "Creat-
ing justification styles" section on page 633.

Modify Click it to edit an existing justification style. For more information refer to
"Editing justification styles" section on page 633.

Rename
Click it to rename an existing justification style.

NOTE
The $$DEFAULT justification style cannot be renamed.

Delete
Click it to delete an existing justification style.

NOTE
The $$DEFAULT justification style cannot be deleted.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Annotation icon
Many entities in MAGNET Office have attributes, which can be annotated for displaying on the screen, or for plot-
ting on a printed plan. Several annotation styles are available to set appropriate annotation formats to suit inter-
national and national schemes. To display the annotation for the entities, the individual entity must have its
annotation option turned on. The current annotation setting for the entity is applied when its annotation option is
turned on.

The Annotation icon of the Library group allows you to manage annotation styles. See "Annotation styles library"
section on page 635 for details.

Legal Description icon
The Legal Description icon of the Library group allows you to manage the legal descriptions templates library.
These templates are global, and available in all projects. See "Legal description templates library" section on
page 646 for details.

The legal description templates define the automatically generated text, based on the entities from the survey
view, which describes these entities.

The Legal Description Templates Library dialog appears after clicking. Buttons of the dialog are described in the
table below.

Buttons of the Legal Description Templates Library dialog
Button Description

New Click it to create a new legal description template. For more information refer
to "Creating legal description templates" section on page 646.

Modify Click it to edit an existing legal description template. For more information
refer to "Editing legal description templates" section on page 647.

Rename
Click it to rename an existing legal description template.

NOTE
The $$DEFAULT template cannot be renamed.

Delete
Click it to delete an existing legal description template.

NOTE
The $$DEFAULT template cannot be deleted.

Import Click it to load the legal description template from an external XML (*.xml)
file.

Export Click it to save the legal description template to an external XML (*.xml) file.

Cancel Click it to close the dialog.

Symbols icon
The Symbols icon of the Library group allows you to manage the symbols library. These symbols are global and
may be used in all projects.

Symbols are used for marking out points, which represent various entities in the survey view.

The Symbols dialog appears after clicking. Buttons of the dialog are described in the table below.
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Buttons of the Symbols dialog
Button Description

New Click it to create a symbol.

Modify Click it to edit an existing symbol.

Rename Click it to rename an existing symbol.

Delete Click it to delete an existing symbol.

Import Click it to load the symbol from an external AutoCAD drawing (*.dwg) or
CivilCAD Symbol (*.bcd) file.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog.

Line Styles icon
The Line Styles icon of the Library group allows you to manage the line styles library. These line styles are
global and may be used in all projects.

Line styles are used for marking the lines, which represent various entities in the survey view, by varying the lay-
out of different lines.

The Line Styles dialog appears after clicking. Buttons of the dialog are described in the table below.

Buttons of the Line Styles dialog
Button Description

New Click it to create a line style.

Modify Click it to edit an existing line style.

Rename Click it to rename an existing line style.

Delete Click it to delete an existing line style.

Import Click it to load the line style from an external CivilCAD line style (*.blm) file.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog.
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Output group
The Output group from the Library tab of the MAGNET Office ribbon allows you to modify output layout of the
project. It contains six icons, described in the table below.

Plot Settings icon
Click it to create or modify plot settings.

Contour Settings icon
Click it to create or modify contour settings.

Genio Translation icon
Click it to create or modify Genio Translation Table.

ACAD Layer Definition icon
Click it to setup a table of layer names and settings to be used on the

AutoCAD Layer Translation table.
ACAD Layer Translation icon

Click it to define which AutoCAD layer to translate in place of
MAGNET Office layer.

Page Setup icon
Click it to configure paper size for plotting.

Plot Settings icon
The Plot Settings icon of the Output group allows you to configure plot settings library.

To manage the plot settings library:
1. In the Output group of the Library tab, click the Plot Settings icon.

The Library Plot Settings dialog is displayed.
2. Make the required configurations. For more information, refer to "Plot settings library" section on page 650.
3. When finished, click OK.

Buttons of the Library Plot Settings dialog
Button Description

New Click it to create a new contour settings set.

Modify Click it to modify an existing contour settings set.

Rename
Click it to rename an existing contour settings set.

NOTE
The $$DEFAULT set cannot be renamed.

Delete
Click it to delete an existing contour settings set.

NOTE
The $$DEFAULT set cannot be deleted.

OK Click it to close the dialog.

Contour Settings icon
The Contour Settings icon of the Output group allows you to configure contour settings library.
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To manage the contour settings library:
1. In the Output group of the Library tab, click the Contour Settings icon.

The Library Contour Settings dialog is displayed.
2. Make the required configurations. For more information, refer to "Contour settings library" section on

page 655.
3. When finished, click OK.

Buttons of the Library Contour Settings dialog
Button Description

New Click it to create a new contour settings set. For more information, refer to
"Creating library contour settings sets" section on page 655.

Modify Click it to modify an existing contour settings set. For more information, refer
to "Editing library contour settings sets" section on page 656.

Rename
Click it to rename an existing contour settings set.

NOTE
The $$DEFAULT set cannot be renamed.

Delete
Click it to delete an existing contour settings set.

NOTE
The $$DEFAULT set cannot be deleted.

OK Click it to close the dialog.

Genio Translation icon
The Genio Translation icon of the Output group allows you to manage genio translation tables.

To manage the genio tables library:
1. In the Output group of the Library tab, click the Genio Translation icon.

The Genio Translation Tables dialog is displayed.
2. Make the required configurations. For more information, refer to "Genio translation tables library" section

on page 658.
3. When finished, click OK.

Buttons of the Genio Translation Tables dialog
Button Description

New Click it to create a new genio translation table. For more information, refer to
"Creating genio translation tables" section on page 658.

Modify Click it to modify an existing genio translation table. For more information,
refer to "Editing genio translation tables" section on page 659.

Rename
Click it to rename an existing genio translation table.

NOTE
The $$DEFAULT table cannot be renamed.
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Button Description

Delete
Click it to delete an existing genio translation tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

ACAD Layer Definition icon
The ACAD Layer Definition icon of the Output group allows you to manage tables of layer names and layer set-
tings to use in the Autocad Layer Translation table for Aoutodesk RealDWG (*.dxf or *.dwg) files export.

To manage the layer definition tables library:
1. In the Output group of the Library tab, click the ACAD Layer Definition icon.

The Layer Definition Table dialog is displayed.
2. Make the required configurations. For more information, refer to "AutoCAD layer definition tables library"

section on page 660.
3. When finished, click OK.

Buttons of the Layer Definition Table dialog
Button Description

New Click it to create a new layer definition table. For more information, refer to
"Creating AutoCAD layer definition tables" section on page 660.

Modify Click it to modify an existing layer definition table. For more information, refer
to "Editing AutoCAD layer definition tables" section on page 661.

Rename
Click it to rename an existing layer definition table.

NOTE
The $$DEFAULT table cannot be renamed.

Delete
Click it to delete an existing layer definition tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

ACAD Layer Translation icon
The ACAD Layer Translation icon of the Output group allows you to specify which AutoCAD layer to translate
in place of the MAGNET Office layer used in the project.

To manage the layer translation tables library:
1. In the Output group of the Library tab, click the ACAD Layer Translation icon.

The Layer translation Table dialog is displayed.
2. Make the required configurations. For more information, refer to t.
3. When finished, click OK.
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Buttons of the Layer translation Table dialog
Button Description

New Click it to create a new layer translation table. For more information, refer to
"Creating AutoCAD layer translation tables" section on page 663.

Modify Click it to modify an existing layer translation table. For more information,
refer to "Editing AutoCAD layer translation tables" section on page 664.

Rename
Click it to rename an existing layer translation table.

NOTE
The $$DEFAULT table cannot be renamed.

Delete
Click it to delete an existing layer translation tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

Page Setup icon
The Page Setup icon of the Output group allows you to o fine-tune the drawing margins to ensure the project will
plot on the chosen printer/plotter or to modify the sheet size. It configure the paper setup which is based on the
paper size used in the title block used in drawing editor.

NOTES
This icon available only if a drawing from the drawing editor is saved as a project.

The title block, which was used for the original drawing will not change after using this feature.

To configure the drawing margins:
1. In the Output group of the Library tab, click the Page Setup icon.

The Page Setup dialog is displayed.
2. Make the required configurations and click OK.
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Create group
The Create group from the Library tab of the MAGNET Office ribbon allows you to add new entities to the lib-
rary. It contains three icons, described in the table below.

Symbol icon
Click it to add a new symbol to the library.

Line Style icon
Click it to add new, or modify an existing line style in the library.

Title Block icon
Click it to save a designed plan form as a title block.

Symbol icon
The Symbol icon of the Create group allows you to save the figure, you have drawn in the survey view as the sym-
bol.

To define the symbol:
1. In the survey view, draw the required symbol, by using MAGNET Office entities.
2. In the Create group of the Library tab, click the Symbol icon.
3. Select the insertion point, by clicking on it.

The Symbol Name dialog is displayed.
4. Define the name of the symbol. Do one of the following:

l In the Name editbox, type the name for the symbol.
l Select an existing line style from the Existing Symbol list to overwrite it.

The Overwrite Job Symbol checkbox will be ticked automatically.
5. If needed, tick the Add to Symbol Library checkbox to make the newly created symbol available in all pro-

jects.
6. Click OK.

The Definition dialog is displayed.
7. Make the required configurations and click OK.

The symbol is created.

Fields of the Definition dialog
Field Description

Insertion Point Defines the start point of the symbol.

Clipping Defines the symbol clipping.

Scalable Defines whether the symbol will be scalable, when plotting.

North Point Defines whether the symbol will be used to mark the north point.

Description Defines the short description of the style.

Line Style icon
The Line Style icon of the Create group allows you to save the line, you have drawn in the survey view.
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To define the line style:
1. In the survey view, draw the required line style, by using MAGNET Office entities.
2. In the Create group of the Library tab, click the Line Style icon.
3. Select the insertion point, by clicking on it.

TIP

It is recommended to use the left end point of the line style as the insertion one.

The Line Style Name dialog is displayed.
4. Define the name of the line style. Do one of the following:

l In the Name editbox, type the name for the line style.
l Select an existing line style from the Existing Line Style list to overwrite it.

The Overwrite Job Line Style checkbox will be ticked automatically.
5. If needed, tick the Add to Line Style Library checkbox to make the newly created style available in all pro-

jects.
6. Click OK.

The Definition dialog is displayed.
7. Make the required configurations and click OK.

The line style is created.

Fields of the Definition dialog
Field Description

Start Point Defines the start point of the line style segment.

Length Defines the length of the line style segment.

Repeat Defines whether the style will be repeatable.

Scalable Defines whether the style will be scalable, when plotting.

Description Defines the short description of the style.

Title Block icon
The Title Block icon of the Create group allows you to save a designed plan form as a MAGNET Office title
block. The title block defines a drawing, at a specified scale, position, and rotation. You may use it in the Plot
Window group.

Design the title block in a project in the Survey View using the units as millimeters for all of the lines. Any text
style can be used in the title block at the sizes currently defined in the Text styles library.

The title block should includ the border on the sheet and any title information, which is standard to all drawings.
Points with symbols, lines with line types, arcs, circles, strings, and text may be used to build up the frame of the
plan form and insert detail in the title areas of the plan form.

You can insert keywords with the correct text style and their position defined, by using the Keyword icon. These
keywords display as $keyword and are replaced by the appropriate text string set in the Project details tab of the
Project Settings dialog when the project is created.
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Make sure the extents of the plan form will print on the specified sheet size on the printer/plotter. Each print-
er/plotter model has its own minimum margins between the edge of the paper and the plotted extents of data.
When the design is completed, save the project for future reference or editing of the title block.

To create a title block:
1. In the Create group of Library tab, click the Title Block icon.

The Page Setup dialog is displayed.
2. In the Paper group box, define the size of the paper.
3. In the Orientation group box, define the paper orientation.
4. In the Margins group box, define the margins of the plotting in millimeters.
5. Click OK.

A rectangular window (solid yellow line with inner dashed green lines) displays attached to the mouse in
the upper left corner of the plot or drawing area of the plan form.

6. Define the position of the origin point. Do one of the following:
l Click the required place in the survey view.
l At the bottom toolbar, specify the East and North coordinates in the appropriate editboxes.

7. Define the position of the first point to define the drawing area.
8. Define the position of the second point to define the drawing area, creating a yellow rectangle.

The Save As dialog is displayed.
9. Save the created title block.
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Cloud Connections Tab
The Cloud Connections tab of the MAGNET Office ribbon contains control icons, which allows you to manage
your SiteLINK 3D and MAGNET Enterprise services. It contains two groups:

l "SiteLINK 3D group" section on the facing page
l "Enterprise group" section on page 497

494



SiteLINK 3D group

SiteLINK 3D group
The SiteLINK 3D group from the Cloud Connections tab of the MAGNET Office ribbon allows you to manage
your SiteLINK 3D service.

Site-Link provides connection to projects in the field by allowing office personnel to see location of equipment and
information it. In addition data can be sent to and received from the equipment in the field.

The group contains six icons, described in the table below.

Settings icon
Click it to configure SiteLINK 3D server settings.

Connect icon
Click it to connect to the SiteLINK 3D server.

Send Files icon
Click it to send files to SiteLINK 3D clients.

Chat icon
Click it to chat with SiteLINK 3D clients.

Inbox icon
Click it to open SiteLINK 3D inbox.

Clients icon
Click it to show SiteLINK 3D clients list.

Settings icon
The Settings icon of the SiteLINK 3D group allows you to configure the SiteLINK 3D server settings.

Click the icon to open the SiteLINK 3D Server tab of the Project Settings dialog. See "Project SiteLINK 3D
server" section on page 586 for details.

Connect icon
Click the Connect icon of the SiteLINK 3D group to connect to the SiteLINK3D server.

Send Files icon
The Send Files icon of the SiteLINK 3D group allows you to send job files to other SiteLINK3D clients.

To send files:
1. In the SiteLINK 3D group of the SiteLINK 3D tab, click the Send Files icon.

The Send to SiteLINK 3D clients dialog is displayed. The table in the left side of the dialog lists all
SiteLINK clients project details.

2. In the right side of the dialog on the File transfer tab, configure the transmission and click Send.
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Chat icon
The Chat icon of the SiteLINK 3D group allows you to send instant messages to other SiteLINK3D clients.

To send files:
1. In the SiteLINK 3D group of the SiteLINK 3D tab, click the Chat icon.

The Send to SiteLINK 3D clients dialog is displayed. The table in the left side of the dialog lists all
SiteLINK clients project details.

2. In the left side of the dialog, select the message receiver.
3. In the right side of the dialog, on the Messaging tab, type your message and click Send.

Inbox icon
Click the Inbox icon of the SiteLINK 3D group to view your Inbox folder with received files and messages.

Clients icon
Click the Clients icon of the SiteLINK 3D group to open the SiteLINK3D clients list.

Buttons of the SiteLINK3D clients list
Fields Description

Click it to connect or disconnect to the server

Click it to view selected SiteLINK clients at their current position.

Click it to send a data file to a selected SiteLINK client

Click it to send a message to a selected SiteLINK client

Click it to view all SiteLINK clients’ information.

Click it to list data files transferred from SiteLINK clients
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Enterprise group
The Enterprise group from the Cloud Connections tab of the MAGNET Office ribbon allows you to use the
MAGNET Enterprise service. It contains nine icons, described in the table below.

Logon icon
Click it to connect with the Enterprise server.

Chat icon
Click it to send a message to a user or a group of users from your company.

Connect to Project icon
Click it to manage Enterprise projects.

Options icon
Click it to edit Enterprise account and connecting settings.

Upload Files icon
Click it to upload your files to the Enterprise server.

Download Files icon
Click it to download your files from the Enterprise server.

Upload Current Job icon
Click it to upload files of the current job to the Enterprise server.

Upload Current Job for Magnet Field
Click it to convert current job to MAGNET Field job format and upload it to the

Enterprise server.

Upload Current Job for 3DMC
Click it to convert current job to 3DMC format and upload it to the Enterprise

server.

Logon icon
The Logon icon of the Enterprise group allows you to connect to the MAGNET Enterprise server.

To connect to the server:
1. In the Enterprise group of the Cloud Connections tab, click the Logon icon.

The Logon dialog is displayed. Fields are described in the table below.
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2. In the Logon dialog, make the required configurations.
3. Click Logon.

Fields of the Logon dialog
Field Description

Login Defines the Enterprise login (an e-mail address), provided by the Enterprise
administrator of your company or by dealer

Save login Tick to save the specified Enterprise login.

Password Defines the Enterprise password, provided by the Enterprise administrator of
your company or by dealer

Save password Tick to save the specified Enterprise password.

Auto logon on star-
tup

Tick to automatically logon to MAGNET Enterprise each time you launch the
MAGNET Office.

Chat icon
The Chat icon of the Enterprise group allows you to communicate via the text messages with the
MAGNET users in your company.

To communicate with other users:
1. In the Enterprise group of the Cloud Connections tab, click the Chat icon.

The Chat window is displayed.
2. In the Users tab, select the required user or group of users.
3. Click Start Chat.

The Chats tab is open.
4. Type your message and click Send.

Connect to Project icon
The Connect to Project icon of the Enterprise group allows you to upload/download data of your project to the
Enterprise server.

You can create a project on the Enterprise server. After creating a project you can upload/download data to the
project. You can create unlimited number of projects.

To create a project:
1. In the Enterprise group of the Cloud Connections tab, click the Connect to Project icon.

The Project dialog is displayed.
2. In the New Project editbox, type the name of the project.
3. Click Create.

The project is created.

To connect to an existing project:
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1. In the Enterprise group of the Cloud Connections tab, click the Connect to Project icon.

The Project dialog is displayed.
2. From the Available Projects list, select the required project.
3. Click Connect.

Options icon
Click the Options icon of the Enterprise group allows you to edit your account (e-mail and password) and options
of connection to the Enterprise server.

Upload Files icon
The Upload Files icon of the Enterprise group allows you to upload your files to the Enterprise server.

To upload files to the Enterprise server:
1. If needed, connect to the Enterprise server. See "Logon icon" section on page 497 for details.
2. In the Files group of the Enterprise tab, click the Upload Files icon.

The Upload files dialog is displayed.
3. In the Files group box, click Add.

The Open dialog is displayed.
4. From the Files of type drop-down list, select the required file format.
5. Navigate to the location of the required file, select project it, and click Open.
6. In the Recipients group box, select the Enterprise project to which the files will be uploaded.
7. Click Upload.

Download Files icon
The Download Files icon of the Enterprise group allows you to download files from the Enterprise server.

To download files:
1. If needed, connect to the Enterprise server. See "Logon icon" section on page 497 for details.
2. In the Files group of the Enterprise tab, click the Download Files icon.

The Download files dialog is displayed.
3. In the Files group box, select the required inbox at the Enterprise server.
4. In the right panel, select the required files.
5. In the Target group box, do one of the following:

l Tick the Local directory checkbox, to save the files on your computer. If so, click Select and define
the directory for files.

l Tick the Import into current project checkbox, to import files into current project.
6. Click Download.
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Upload Current Job icon
The Upload Current Job icon of the Enterprise group allows you to upload your current project to the Enterprise
server.

To upload files to the Enterprise server:
1. If needed, connect to the Enterprise server. See "Logon icon" section on page 497 for details.
2. In the Files group of the Enterprise tab, click the Upload Current Job icon.

The Upload Current Job dialog is displayed.
3. In the Files group box, click Add.
4. In the Recipients group box, select the Enterprise project to which the files will be uploaded.
5. Click Upload.

Upload Current Job for Magnet Field
The Upload Current Job for Magnet Field icon of the Enterprise group allows you to convert your current pro-
ject to the Magnet Field format and upload it to the Enterprise server.

To upload files to the Enterprise server:
1. If needed, connect to the Enterprise server. See "Logon icon" section on page 497 for details.
2. In the Files group of the Enterprise tab, click the Upload Current Job for Magnet Field icon.

The Enter a file name dialog is displayed.
3. In the editbox, type the name for the job.
4. Click OK.

The Export dialog is displayed.
5. In the Select From group box, define which data will be uploaded, by selecting the appropriate radiobutton.
6. In the Export Options group box, define entities to be uploaded, by ticking the appropriate checkboxes.
7. You may select the exact points, lines, alignments, profiles and DTMs to be uploaded. To do so, select the

required entities at the appropriate tabs at the right side of the Export dialog.
8. Click OK.

The Upload Current Job dialog is displayed.
9. In the Recipients group box, select the Enterprise project to which the files will be uploaded.
10. Click Upload.

Upload Current Job for 3DMC
The Upload Current Job for 3DMC icon of the Enterprise group allows you to convert your current project to
the 3DMC format and upload it to the Enterprise server.

To upload files to the Enterprise server:
1. If needed, connect to the Enterprise server. See "Logon icon" section on page 497 for details.
2. In the Files group of the Enterprise tab, click the Upload Current Job for 3DMC icon.

The Upload Current Job dialog is displayed.
3. In the Recipients group box, select the Enterprise project to which the files will be uploaded.
4. Click Upload.
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The Export dialog is displayed.
5. In the Select From group box, define which data will be uploaded, by selecting the appropriate radiobutton.
6. In the Export Options group box, define entities to be uploaded, by ticking the appropriate checkboxes.
7. You may select the exact points, lines, alignments, profiles and DTMs to be uploaded. To do so, select the

required entities at the appropriate tabs at the right side of the Export dialog.
8. Click OK.
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Tasks group
The Tasks group from the Cloud Connections tab of the MAGNET Office ribbon allows you to use the working
time tracking feature of MAGNET Enterprise. The group contains two icons:

Tasks icon
Click it to view Enterprise tasks.

Timecards icon
Click it to submit a timesheet card.

Tasks icon
The Tasks icon of the Tasks group allows you to view the tasks for Enterprise project.

After clicking the icon the Tasks dialog is displayed. To view tasks, from the Project drop-down list, select the
required project and click Connect. Tasks from the project will be displayed in the table from Tasks group box.
For each task its name, start date, end date, and completed percentage are displayed.

Timecards icon
The Timecards icon of the Tasks group allows you to track the time spent for tasks from an Enterprise project.

To submit a timesheet:
1. In the Tasks group of the Enterprise tab, click the Timecards icon.

The Timecards dialog is displayed.
2. From the Project drop-down list, select the required project and click Connect.

Tasks are displayed in the table from the Tasks group box.
3. Select the required week, using the Prev and Next buttons.

NOTE

To return to the current week, click Current.

4. Select the required task and specify daily working hours spent for it.
5. Click Submit.

NOTES
If you specify only working hours, the Completed percentage will be calculated by Enterprise service
after submitting timecard. If you specify the Completed percentagemanually, Enterprise will set this
value for task and automatic calculations for this taskwill stop.

The task has a completed status, when completion percentage reaches 100%. You can submit work-
ing hours for completed task.
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Redlines group
Redlines are small sketches generated by a manager to communicate with field engineers and to use in processing
data in MAGNET Office. They are stored in projects at the Enterprise server, and may only be displayed in the
Survey View, when connected to the Enterprise project.

To display redlines connect to the Enterprise project. All existing redlines will be displayed in Survey View auto-
matically. You may fit to screen any of them, by selecting the required redline from the drop-down list in the Red-
lines group. The group also contains two icons, described in the table below.

Redlines Settings icon
Click it to configure the visibility of redlines.

Draw Redlines icon
Click it to show redlines in empty project.

Redlines Settings icon
The Redlines Settings icon of the Redlines group allows you to manage visibility of redlines.

To open the manager, click the icon. The Redline Settings dialog appears. It displays the list of the redlines in the
Enterprise project with the visibility flags.

Buttons of the Redlines Settings dialog
Button Description

OK Click it to save the changes and close the dialog.

Cancel Click it to discard the changes and close the dialog.

Invert On/Off Click it to turn on inactive redlines and turn off active ones.

Off Click it to turn off selected redlines.

On Click it to turn on selected redlines.

Select All Click it to select all existing layers in the dialog.

Invert Selection Click it to invert the selection of the layers in the dialog.

Draw Redlines icon
The Draw Redlines icon of the Redlines group allows you to view redlines in newly created project.

Redlines don't display redlines in newly created project. To view them, click the icon.
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Window Tab
The Window tab of the MAGNET Office ribbon contains controls icon, which allows you to configure
MAGNET Office window layout. It contains one group:

l "Window group" section on the facing page
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Window group
The Window group from the Window tab of the MAGNET Office ribbon contains control icon, which allows you
to configure MAGNET Office window layout. It contains four icons, described in the table below.

New Window icon
Click it to create a new window in the work area.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

New Window icon
Click the New Window icon of the Window group you to open the current project once again in the new window.

Cascade icon
Click the Cascade icon of the Window group to cascade opened in the MAGNET Office windows.

Tile Horizontally icon
Click the Tile Horizontally icon of the Window group to tile opened in the MAGNET Office windows hori-
zontally.

Tile Vertically icon
Click the Tile Vertically icon of the Window group to tile opened in the MAGNET Office windows vertically.
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Help Tab
The Help tab of the MAGNET Office ribbon contains control icons, which allows you to display help and
licenses information. It is separated to two groups:

l "Help group" section on the facing page
l "Licensing and Version group" section on page 508

506



Help group

Help group
The Help group from the Help tab of the MAGNET Office ribbon allows you to read product help and hints. It con-
tains two icons, described in the table below.

Help icon
Click it to open product help.

Display Hints icon
Click it to display product hints.

Help icon
Click the Help icon of the Help group to open the title page of the MAGNET Office help.

Display Hints icon
Click the Display Hints icon of the Help group to display the application hints.
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Licensing and Version group
The Licensing and Version group from the Help tab of the MAGNET Office ribbon allows you to view inform-
ation about MAGNET Office application and available licenses. It contains two icons, described in the table
below.

Licenses icon
Click it to display licenses information.

Check for Updates icon
Click it to check for available updates.

About icon
Click it to display information about MAGNET Office application.

Licenses icon
The Licenses icon of the Licensing and Version group allows you to get the licensing information.

To view the license information, click the icon. The Product Activation window is displayed. It contains inform-
ation about the activated modules and expiration date for each module.

To re-activate the software, click Re-Activate. See "MAGNET Office activation" section on page 856 for
details.

Check for Updates icon
The Check for Update icon of the Licensing and Version group allows you to to check whether any updates are
available for your MAGNET Office application.

About icon
Click the About icon of the Licensing and Version group to get the information about MAGNET Office version,
activated modules, serial number and device ID to which the serial number is assigned.
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Editors
Except for the survey view, MAGNET Office contains several editors for other needs. You may find their descrip-
tion in the corresponding sections:

l "Point editor" section on the next page
l "String Editor" section on page 513
l "Traverse editor" section on page 516
l "Alignment editor" section on page 520
l "Road editor" section on page 523
l "Raw data editor" section on page 528
l "LS Network editor" section on page 537
l "Deed Entry editor" section on page 538
l "Project survey codes editor" section on page 543
l "Global survey codes editor" section on page 540
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Point editor
The point editor allows you to manually input point data, and place this points in the survey view.

To add points, by using the point editor:
1. In the Points group of the Insert tab, click the Speadsheet Entry icon.

The point editor is displayed. Table in the left side is for data entry and the right side displays the survey
view.

2. Fill in required fields in the table. Description may be found below.
3. In the View group of the File tab from the point editor ribbon, click the Save to Survey icon.

The data is added to the survey view.
4. To return to the survey view do one of the following:

l In the Standard group of the File tab, click the Close icon – to close the point editor and return to
the survey view.

l In the View group of the File tab, click the Survey View icon – to return to the survey view without
closing the point editor.

NOTE
By default the table contains 40 rows. To addmore rows, do the right click on the table, and select
"Insert Record" from the context menu.

Fields of the point editor table
Field Description

PtNo

Defines the number of the point.

TIP

If you leave this field empty, MAGNET Office will automatically fill it in with the
next available point number.

Easting Defines the required Easting coordinate of the point.

Northing Defines the required Northing coordinate of the point.

Elevation Defines the required elevation of the point.

Code Defines the required point code.

Latitude
Defines the required Latitude coordinate of the point.

CAUTION
A coordinate system projection must be defined.

Longitude
Defines the required Longitude coordinate of the point.

CAUTION
A coordinate system projection must be defined.

The point editor has its own ribbon, which is differ from the MAGNET Office default ribbon.
l The File tab is divided to three groups. For more information refer to corresponding section:

l "Standard group" section on the facing page
l "Import/Export group" section on the facing page
l "View group" section on page 512
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l The Edit tab contains only the Codes icon. It has the same functionality as the "Codes icon" section on
page 95 from the MAGNET Office default ribbon.

l The Settings tab contains only the Configure icon. For more information refer to "Configure icon" section
on the next page from the MAGNET Office default ribbon.

l The Library tab contains two icons:
l The Global Codes icon. It has the same functionality as the "Global Codes icon" section on
page 476 from the MAGNET Office default ribbon.

l The Code Settings icon. It has the same functionality as the "Code Settings icon" section on
page 476 from the MAGNET Office default ribbon.

l The Window tab contains three icons:
l The Cascade icon. It has the same functionality as the "Cascade icon" section on page 505 from the
MAGNET Office default ribbon.

l The Tile Horizontally icon. It has the same functionality as the "Tile Horizontally icon" section on
page 505 from the MAGNET Office default ribbon.

l The Tile Vertically icon. It has the same functionality as the "Tile Vertically icon" section on
page 505 from the MAGNET Office default ribbon.

Standard group
The Standard group of the File tab of the point editor ribbon allows you to perform basic file operations. It con-
tains two icons, described in the table below.

Save icon
Click it to save the current point editor document.

Close icon
Click it to close the point editor.

Import/Export group
The Import/Export group of the File tab of the point editor ribbon allows you to import and/or export data to the
point editor. It contains three icons, described in the table below.

Import ASCII Point File
Click it to import points from a ASCII point ((*.pts, *.asc, *.xyz, *.csv,
*.txt) file to the point editor. For more information about importing ASCII
files refer to "Import icon" section on page 39 and "Importing ASCII points

files" section on page 41.
Import ASCII Point File

Click it to import points from the currently selected in the survey view
objects.

Import ASCII Point File
Click it to import points from the point editor to an ASCII point (*.pts) file.
For more information about importing ASCII files refer to "Export icon" sec-
tion on page 41 and "Exporting to ASCII point files" section on page 45.
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View group
The View group of the File tab of the point editor ribbon contains four icons, described in the table below.

Save to Survey icon
Click it to upload changes from the point editor to the survey view.

Regen icon
Click it to recalculate points coordinates. The message window prompts to do one

of the following:
lRecalculate points latitude and longitude coordinates from easting and

northing coordinates.
lRecalculate points easting and northing coordinates from latitude and lon-

gitude coordinates.

CAUTION
A coordinate system projection must be defined to use this
mode.

Report icon
Click it to generate a report for manually created points.

Survey View icon
Click it to switch to the survey view.

Configure icon
The Configure icon of the Point editor allows you to configure its settings.

To configure the point editor:
1. At the Settings tab of the point editor ribbon, click the Configure icon

The Configuration dialog is displayed.
2. To configure the point editor table layout, type the codes for the available data, displayed at the right panel

of the dialog in the required order, separated with spaces.
3. To configure an edit sequence, click the "Edit Sequence" field and type the codes for the available data,

displayed at the right panel of the dialog in the required order, separated with spaces.
4. Click OK.

To set the default configuration, click Load Default.

To set the current configuration as the default, click Save Default.

NOTE
TheConfigure item of the context menu for the point editor has the same functionality.
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String Editor
The string editor allows you to edit an existing string, by changing the parameters of its points. It has three tabs,
described in the corresponding sections:

l "Elevation tab" section below
l "Position tab" section on the next page
l "Settings tab" section on page 515

Make the required configurations on each tab, and then click Close.

To open the string editor, in the String group of the Modify tab from the MAGNET Office ribbon, click the Edit
String icon.

Elevation tab
The Elevation tab of the string editor allows you to configure the elevations of the string nodes. It contains the list
of the string points, with its point numbers, elevations and slopes of the appropriate segments.

To edit the point's elevation:
1. Select the required point from the list.
2. Do one of the following:

l In the Elevation editbox, specify the required point elevation.
l In the Slope editbox, specify the required string segment slope.

3. If needed, in the Base Elevation editbox, specify the required base elevation.

Fields of the Elevation tab
Field Description

Elevation

Defines the elevation from the base of the selected point.
NOTE
When specifying this parameter, the value of the Slope parameter is cal-
culating automatically.

Slope

Defines the slope of the string segment between the previous point and the cur-
rently selected point.

NOTE
When specifying this parameter, the value of the Elevation parameter is cal-
culating automatically.

Base Elevation Defines the base elevation of the string. It will be added to elevation of each
point of the string.

Point list

Point ID Displays the point number.

Elevation Displays the point elevation, including the base elevation.

Slope Displays the slope of the string segment between the previous point and the cur-
rently selected point.
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Buttons of the Elevation tab
Button Description

Insert

Click it to add a new string point.

TIP

Before editing the elevation of the newly created point, you must define its loc-
ation at the Position tab first. See "Position tab" section below for details.

Delete Click it to delete the currently selected string point.

Position tab
The Position tab of the string editor allows you to configure the locations of the string nodes. It contains the list of
the string points, with its point numbers, East and North coordinates.

To edit the point's position:
1. Select the required point from the list.
2. In the Northing editbox, specify the required North coordinate.
3. In the Easting editbox, specify the required East coordinate.

To add a new point:
1. Click Insert.

The new row is added to the point list.
2. In the Northing editbox, type the required North coordinate of the new point.
3. In the Easting editbox, type the required East coordinate of the new point.
4. Press Enter.

The point is added to the sting. The point number is assigned automatically.
5. To configure the elevation of the new point, use the Elevation tab. See "Elevation tab" section on the pre-

vious page for details.

Fields of the Position tab
Field Description

Northing Defines the North coordinate of the selected point.

Easting Defines the slope of the East coordinate of the selected point.

Point list

Point ID Displays the point number.

Northing Displays the point North coordinate.

Easting Displays the point East coordinate.

Buttons of the Position tab
Button Description

Insert Click it to add a new string point.

Delete Click it to delete the currently selected string point.
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Settings tab
The Settings tab of the string editor allows you to configure its parameters. Fields of the tab are described in the
table below.

Fields of the Settings tab
Field Description

Auto-Advance If ticked, the string point, selected in the survey view, will be highlighted in the
point list.

Auto-Center If ticked, the string point, highlighted in the point list, will be placed to the cen-
ter of the survey view.

Remove from data-
base

If ticked, the points, deleted by using the Delete button will be excluded from
the string and deleted from the survey view. Otherwise, they will be removed
from the string, but stay in the survey view.

Slope mode Defines the slope units.
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Traverse editor
The traverse editor allows you to manually input traverse data. To access traverse editor, in the Manual Entry
group of the Survey tab, click the Traverse Editor icon.

Traverse may be defined as one of the following:
l A loop, where the traverse closes on the start station. The start and end stations are the same point with
known coordinates.

l Open ended, where the start and end stations are different, but the coordinates of both points are known.

Traverses may also include side shots or radiations. These are calculated from the closed and adjusted traverse
points.

The traverse editor contains ribbon with control icons and table for traverse data. Description of fields may be
found in the table below. The right side of the editor has the preview screen.

Fields of the traverse editor table
Field Description

RecType

Defines the current type of the Total Station observation. You may select one
of the following:

l BKB – backsight bearing point – the start measurement used as a ref-
erence line for orientation of next measurements from the station. This
measurements contain the horizontal angle data

l BS – backsight – the measurement to the previous occupation point in tra-
verse survey. These measurements can contain the horizontal and ver-
tical angles and slope distance data.

l FS – foresight – the measurement to the next occupation point in tra-
verse survey. These measurements can contain the horizontal and ver-
tical angle and slope distance data.

l PT – point – the point with the known East and North coordinates.
l SS – side shot – the measurement from the station to the reflector. This
measurement contains the horizontal and vertical angles and slope dis-
tance data.

From Defines the number of the point at which the total station was set.

To Defines the number of the point at which the reflector was set.

H-Angle Defines the horizontal angle for the set up station to the observed point.

Azimuth Defines the azimuth angle from the set up station to the observed point.

V-Angle Defines the vertical angle from the set up station to the observed point.

Slp Dist
Defines the slope distance from the set up station to the observed point. If hori-
zontal distances are being entered, this will be the horizontal distance if the ver-
tical angle field is left empty.

Inst. Ht.
Defines the instrument height at the set up point. The height is carried forward
from one row to the next during reduction, so only changed heights need to be
entered.
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Field Description

Target Ht.
Defines the height of the target at the observed point. The target height is car-
ried forward from one row to the next during reduction, so only changed target
heights need to be entered.

Easting Defines the known East coordinate of the point.

Northing Defines the known North coordinate of the point.

Elevation Defines the known height of the point.

Code Defines the code for the observed point.

The traverse editor has its own ribbon, which is differ from the MAGNET Office default ribbon.
l The File tab is divided to two groups. For more information refer to "File tab" section below.
ll The Edit tab contains only the Codes icon. It has the same functionality as the "Codes icon" section on
page 95 from the MAGNET Office default ribbon.

l The Adjustment tab contains only the Traverse icon. For more information refer to "Traverse icon" section
on the next page.

l The Settings tab contains two icons:
l The Azimuth icon. It allows you to turn on/off the azimuth mode.
l The Configure icon. It allows you to configure the traverse editor table. See "Configure icon" sec-
tion on page 519 for details.

l The Library tab contains two icons:
l The Global Codes icon. It has the same functionality as the "Global Codes icon" section on
page 476 from the MAGNET Office default ribbon.

l The Code Settings icon. It has the same functionality as the "Code Settings icon" section on
page 476 from the MAGNET Office default ribbon.

l The Window tab contains three icons:
l The Cascade icon. It has the same functionality as the "Cascade icon" section on page 505 from the
MAGNET Office default ribbon.

l The Tile Horizontally icon. It has the same functionality as the "Tile Horizontally icon" section on
page 505 from the MAGNET Office default ribbon.

l The Tile Vertically icon. It has the same functionality as the "Tile Vertically icon" section on
page 505 from the MAGNET Office default ribbon.

File tab
The File tab of the traverse editor ribbon allows you to perform the basic operations. It divided to two groups,
described below

Standard group
The Standard group of the File tab of the traverse editor ribbon allows you to perform basic file operations. It con-
tains three icons, described in the table below.

Save icon
Click it to save the current traverse document.
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Open icon
Click it to open an existing traverse for editing.

Close icon
Click it to close the traverse editor.

View group
The View group of the File tab of the traverse editor ribbon contains four icons, described in the table below.

Save to Survey icon
Click it to upload changes from the traverse editor to the survey view.

Regen icon
Click it to recalculate point's coordinates. The message window prompts to do one

of the following:
lUse the point coordinates from the project database.
lManually input the coordinates of the control point.

CAUTION
A coordinate system projection must be defined to use this
mode.

Report icon
Click it to generate a traverse report.

Survey View icon
Click it to switch to the survey view.

Traverse icon
The Traverse icon of the Traverse editor allows you to adjust the traverse.

Do the following:
1. In the Adjustment tab of the traverse editor ribbon, click the Traverse icon.

The Control Point Coordinates dialog is displayed.
2. Do one of the following:

l Select an existing point.
l Specify the required coordinates.

3. Click OK

The Traverse Adjustment dialog is displayed.
4. Select the required traverse from the list at the bottom-right of the dialog.
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5. In the Start Station group box, define the traverse start point.
6. In the End Station group box, define the traverse end point.
7. In the Adjustment group box, select the adjustment method.
8. Click Compute.

The Unadjusted traverse dialog is displayed.
9. Review the properties, and click Coordinates to adjust the traverse.
10. Click OK to close the dialog.

Configure icon
The Configure icon of the Traverse editor allows you to configure the traverse editor table.

To configure the traverse editor table:

In the Settings tab of the traverse editor ribbon, click the Configure icon.
2. The Configuration dialog is displayed.
3. In the Display Sequence editbox, configure the table appearance, by using the variables from the right panel

of the dialog. The columns of the table will be displayed in order, which you define.
4. In the Edit Sequence editbox, configure the editing sequence for each observation point type. The

MAGNET Office will automatically move the cursor to the defined columns.
5. Click OK.

To save the configuration as default, click Save Default.

To load the default configuration, click Load Default.
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Alignment editor
The alignment editor allows you to manually create a new alignment or edit an existing one. It uses data that
defines the full geometry of the alignment in terms of the lines and arcs that make up the horizontal alignment.
The manual alignment entry includes the entities directly into the alignment so the IPs are simply points at which
there is a tangential connection between one entity and the next.

The alignment editor contains ribbon with control icons and two tabs with tables for alignment data. The Align-
ment tab contains table for horizontal alignment (centerline), the Profile tab contains table for vertical alignment
(profile). The right side of the editor has the preview screen.

Description of fields may be found in the table below.

Fields of the Alignment tab table of the alignment editor
Field Description

RecType

Defines the current type of the Total Station observation. You may select one
of the following:

l ARC – arc, defined by its radius and arc length. Positive radius creates
curve to the right, negative – curve to the left.

l IP – intersection point, defined by its East and North coordinates.
l PT – point, defined by its East and North coordinates.
l SPIRAL – spiral, defined by its length, radius and if needed, spiral L1
and L2.

l START – start point, defined by its East and North coordinates and the
running distance.

l STRAIGHT – straight line, defined by its bearing and length.

Station Defines the station distance from the start chain.

Bearing Defines the bearing of the alignment segment.

Azimuth Defines the bearing of the alignment segment.

Length Defines the length of the alignment segment.

Radius Defines the radius of the alignment segment.

Easting Defines the East coordinate of the alignment point.

Northing Defines the North coordinate of the alignment point.

Spiral L1 Defines the length of the first spiral of the compound curve.

Spiral L2 Defines the length of the second spiral of the compound curve.

Fields of the Profile tab of the alignment editor
Field Description

Station Defines the start station of the vertical alignment segment.

Level Defines the difference between the elevations of the start and end stations. See
picture below for details.
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Field Description

Length Defines the length of the vertical alignment segment. See picture below for
details.

Vertical alignment

The alignment editor has its own ribbon, which is differ from the MAGNET Office default ribbon.
l The File tab is divided to two groups. For more information refer to "File tab" section below.
l The Window tab contains three icons:

l The Cascade icon. It has the same functionality as the "Cascade icon" section on page 505 from the
MAGNET Office default ribbon.

l The Tile Horizontally icon. It has the same functionality as the "Tile Horizontally icon" section on
page 505 from the MAGNET Office default ribbon.

l The Tile Vertically icon. It has the same functionality as the "Tile Vertically icon" section on
page 505 from the MAGNET Office default ribbon.

File tab
The File tab of the alignment editor ribbon allows you to perform the basic operations. It divided to two groups,
described below.

Standard group
The Standard group of the File tab of the alignment editor ribbon allows you to perform basic file operations. It
contains three icons, described in the table below.

Save Entry icon
Click it to save the current alignment document.

Save Alignment icon
Click it to save the current alignment to update it in the survey view.
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Close icon
Click it to close the alignment editor.

View group
The View group of the File tab of the alignment editor ribbon contains four icons, described in the table below.

Report icon
Click it to generate a traverse report.

Configure icon
Click it to configure the alignment editor table.

Survey View icon
Click it to switch to the survey view.

Configure icon
The Configure icon of the Alignment editor allows you to configure the traverse editor table.

To configure the alignment editor table:
1. In the View group from the File tab of the alignment editor ribbon, click the Configure icon.
2. The Configuration dialog is displayed.
3. In the Display Sequence editbox, configure the table appearance, by using the variables from the right

panel of the dialog. The columns of the table will be displayed in order, which you define.
4. In the Edit Sequence editbox, configure the editing sequence for each observation point type. The

MAGNET Office will automatically move the cursor to the defined columns.
5. Click OK.

To save the configuration as default, click Save Default.

To load the default configuration, click Load Default.
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Road editor
The road editor allows you to manually create a new alignment or edit an existing one. You can create roads data
consisting of a horizontal alignment, profiles and offset strings, or from a horizontal alignment and cross sectional
data.

The alignment editor contains ribbon with control icons and four tabs with tables for road data. See "Road editor
ribbon" section on the next page for details. The right side of the editor has the preview screen.

l The Alignment tab contains table for horizontal alignment.
l The Offset String tab contains table for
l The Profile tab contains table for vertical alignment.

Description of fields may be found in the table below.

Fields of the Alignment tab table of the road editor
Field Description

RecType

Defines the current type of the Total Station observation. You may select one
of the following:

l ARC – arc, defined by its radius and arc length. Positive radius creates
curve to the right, negative – curve to the left.

l IP – intersection point, defined by its East and North coordinates.
l PT – point, defined by its East and North coordinates.
l SPIRAL – spiral, defined by its length, radius and if needed, spiral L1
and L2.

l START – start point, defined by its East and North coordinates and the
running distance.

l STRAIGHT – straight line, defined by its bearing and length.

Station Defines the station distance from the start chain.

Bearing Defines the bearing of the alignment segment.

Azimuth Defines the bearing of the alignment segment.

Length Defines the length of the alignment segment.

Radius Defines the radius of the alignment segment.

Easting Defines the East coordinate of the alignment point.

Northing Defines the North coordinate of the alignment point.

Spiral L1 Defines the length of the first spiral of the compound curve.

Spiral L2 Defines the length of the second spiral of the compound curve.

Fields of the Offset String tab of the road editor
Field Description

Station Defines the start station of the vertical alignment segment.

Offset Defines the difference between the elevations of the start and end stations. See
picture below for details.

Cross Fall Defines the length of the vertical alignment segment. See picture below for
details.
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Fields of the Profile tab of the road editor
Field Description

Station Defines the start station of the vertical alignment segment.

Level Defines the difference between the elevations of the start and end stations. See
picture below for details.

Length Defines the length of the vertical alignment segment. See picture below for
details.

Vertical alignment

Fields of the Cross Section tab of the road editor
Field Description

Station Defines the start station of the vertical alignment segment.

Offset Defines the offset from the offset from the center line.

Level Defines the difference between the elevations of the start and end stations. See
picture below for details.

Road editor ribbon
The road editor has its own ribbon, which is differ from the MAGNET Office default ribbon.

l The File tab is divided to three groups. For more information refer to "File tab" section on the facing page.
l The Window tab contains three icons:

l The Cascade icon. It has the same functionality as the "Cascade icon" section on page 505 from the
MAGNET Office default ribbon.

l The Tile Horizontally icon. It has the same functionality as the "Tile Horizontally icon" section on
page 505 from the MAGNET Office default ribbon.

l The Tile Vertically icon. It has the same functionality as the "Tile Vertically icon" section on
page 505 from the MAGNET Office default ribbon.
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File tab
The File tab of the road editor ribbon allows you to perform the basic operations. It divided to two groups,
described below.

Standard group

Save Entry icon
Click it to save the current alignment document.

Save Alignment icon
Click it to save the current alignment to update it in the survey view.

Close icon
Click it to close the alignment editor.

Create group

Create Surface icon
Click it to create a surface.

Create Road icon
Click it to create a road.

View group

Report icon
Click it to generate a traverse report.

Configure icon
Click it to configure the alignment editor table.

Survey View icon
Click it to switch to the survey view.

Create Surface icon

The Create Surface icon of the Road editor allows you to create a surface for road.

To create a surface:
1. At the File tab of the Road editor, click the Create Surface icon.

The Create Surface dialog is displayed.
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2. Configure the parameters at the Save Options tab as you need. Fields are described in the table below.
3. Click OK.

Fields of the Save Options tab of the Create Surface dialog
Field Description

Station Displays the start and end station of the base alignment.

Default Spacing Defines the base spacing for straight and curved sections of the alignment.

Cross Section Defines the creation of cross section for the alignment.

Calculated From Defines the base information for the cross section. It may be specified at the
Cross Section or Offset String tab of the road editor table.

Include TPs and
IPs Tick to create cross sections at TPs and IPs.

Cross Section at
IPs Defines the cross section position at the IPs.

DTM Defines the saving options for the calculated surface.

Strings Defines the saving options for the calculated strings.

Create Road icon

The Create Road icon of the Road editor allows you to create a surface for road.

To create a road:
1. At the File tab of the Road editor, click the Create Road icon.

The Create Cross Section dialog is displayed.
2. Configure the parameters at the Save Options tab as you need. Fields are described in the table below.
3. If needed, at the Additional Stations tab, specify the additional chainages for the road.
4. Click OK.

Fields of the Save Options tab of the Create Cross Section dialog
Field Description

Layer Defines the layer to which the base alignment belongs to.

Design Surface Defines the name of the design surface.

Extract natural
surface data Tick to extract natural surface for road.

Natural Surface Defines the name of the natural surface. Select the appropriate DTM from the
drop-down list below.

Left Limit Defines the width of the natural surface to the left from the base alignment.

Right Limit Defines the width of the natural surface to the right from the base alignment.

Station Displays the start and end station of the base alignment.

Default Spacing Defines the base spacing for straight and curved sections of the alignment.
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Field Description

Cross Section Defines the creation of cross section for the alignment.

Calculated From Defines the base information for the cross section. It may be specified at the
Cross Section or Offset String tab of the road editor table.

Include TPs and
IPs Tick to create cross sections at TPs and IPs.

Cross Section at
IPs Defines the cross section position at the IPs.

Strings Defines the saving options for the calculated strings.

Fields of Additional Stations tab of the Create Cross Station dialog table
Field Description

Start Chainage Defines the start of the additional chainage.

End Chainage Defines the end of the additional chainage.

Spacing Defines the spacing of the additional chainage.

Omit Tick to omit the additional chainage row.

Configure icon

The Configure icon of the Road editor allows you to configure the traverse editor table.

To configure the alignment editor table:
1. In the View group from the File tab of the road editor ribbon, click the Configure icon.
2. The Configuration dialog is displayed.
3. In the Display Sequence editbox, configure the table appearance, by using the variables from the right panel

of the dialog. The columns of the table will be displayed in order, which you define.
4. In the Edit Sequence editbox, configure the editing sequence for each observation point type. The

MAGNET Office will automatically move the cursor to the defined columns.
5. Click OK.

To save the configuration as default, click Save Default.

To load the default configuration, click Load Default.
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Raw data editor
The raw data editor allows you to process data from survey instruments and data loggers. You can download raw
survey data from the instrument directly into the computer. Data from this file is displayed in the left side of the
editor. The graphical preview is displayed in the right side of the editor.

Data may be edited and regenerated to ensure the correct results are saved the job database and displayed in the
survey view.

Raw data editor has its own ribbon, different from the MAGNET Office default one. It has eight tabs:
l "File tab" section on the facing page
l "Edit tab" section on page 530
l "View tab" section on page 531
l "Insert tab" section on page 532
l "Tools tab" section on page 533
l "Library tab" section on page 534
l "Window tab" section on page 535
l "Help tab" section on page 536

To view/edit raw data:
1. In the raw data editor do one of the following:

l Download data from the survey instrument, by clicking the Download Raw Data icon.
l Import raw data file, by using the Import Raw Data File icon.
l Import neutral file, by using the Import Neutral File icon.

The records are listed in the left side of the raw data editor. The preview is displayed at the right.
2. To edit a record, double click it and make the required changes in a dialog.
3. To edit several records at once, select them and in the Edit group of the Edit tab, click the Edit Selected

Records icon.
4. To delete a record, select it and press Delete.
5. To manually add a new record, click the appropriate icon from the Insert tab.
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File tab
The File tab of the raw data editor contains control icons which allow you to perform general operations in editor
and export/import data files.

Standard group
The Standard group allows you to perform general operations with raw data files. It contains six icons, described
in the table below.

New icon
Click it to create a new raw data entry

Open icon
Click it to open an existing raw data entry

Save icon
Click it to save current raw data entry.

Save Data As icon
Click it to save raw data in a new entry

Save To Survey icon
Click it to upload current entry to the survey view.

Close icon
Click it to close the raw data editor.

Import/Export group
The Import/Export group allows you to import various measurement data to the raw data editor and save it as
external file.

Download Raw Data icon
Click it to download measurements directly from the survey instrument.

Import Raw Data File icon
Click it to import a file, containing raw survey measurements to the current

raw data entry.
Import Neutral File icon

Click it to import a civilcad neutral (*.neu) file, to the current raw data entry.
Export Neutral File icon

Click it to export current raw data entry to a civilcad neutral (*.neu) file.
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Edit tab
The Edit tab of the raw data editor contains control icons which allow you to edit the measurements in the raw
data entry.

Clipboard group
The Clipboard group allows you to cut, copy and paste measurements.

Cut icon
Click it to cut the selected object to the clipboard.

Copy icon
Click it to copy the selected object to the clipboard.

Paste icon
Click it to paste an object from the clipboard.

Find group
The Find group allows you to search for the measurement by certain criteria.

Find icon
Click it to search for the measurement by certain criteria.

Next icon
Click it to navigate to the next measurement, which match search criteria.

Previous icon

Click it to navigate to the previous measurement, which match search criteria.

Edit group
The Edit group allows you to edit measurements in the data raw entry.

Codes icon
Click it to edit project survey codes. Set "Project survey codes editor" section

on page 543 for details.

Comment icon
Click it to mark selected records as comments, i.e. they will be displayed in

the list, but will not be used.
Edit Selected Records icon

Click it to edit several selected records at once.
Report Parameters icon

Click it to configure the parameters of the raw data report.
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View tab
The View tab of the raw data editor contains control icons which allow you to configure preview of the data layout
of the editor.

Navigate group
The Navigate group allows you to manage the scale of the preview area. It contains five icons, and five second
level icons, described in the table below.

All icon
Click it to fit all data in the view. This icon also contains the list of the

second level icons. Click to see it.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return previous view.

In icon
Click it to zoom in the center area of the preview area.

Out icon
Click it to zoom out the center area of the preview area.

Point icon
Click it to view a point with the defined scale.

Pan icon
Click it to scroll the view.

Save View icon
Click it to save the current view.

View group
The View group allows you to switch between views and configure the toolbar layout.

All icon
Click it to fit all data in the view.

Window icon
Click it to switch to the report.

Previous icon
Click it to configure the layout of the toolbar.
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Survey icon
Click to switch to the survey view.

Insert tab
The Insert tab of the raw data editor contains control icons which allow you to insert various records in the raw
data entry. It has only one Insert group.

Comment icon
Click it to insert the comment record to the raw data entry.

Header Record icon
Allows you to insert the header record to the raw data entry. Click to

select the specific type of the header.
Station Record icon

Allows you to insert the station record to the raw data entry. Click to
select the specific type of the station.

Point Record icon
Click it to insert the point record to the raw data entry.

Measurement Record icon
Allows you to insert the measurement record to the raw data entry. Click

to select the specific type of the measurement.
Miscellaneous icon

Allows you to insert the various record to the raw data entry. Click to
select the specific type of the record.
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Tools tab
The Tools tab of the raw data editor contains control icons which allow you to perform traverse adjustment. It has
only one Tools group.

Traverse Adjustment icon
Click it to apply a traverse adjustment to the raw data. See "Traverse

Adjustment icon" section on page 307 for details.
Delete Adjusted Pts icon

Click it to delete unnecessary points after traverse adjustment.
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Library tab
The Library tab of the raw data editor contains control icons which allow you to configure survey codes. It has
only one Library group.

Global Codes icon
Click it to manage global survey codes. See Global Codes icon for

details.
Code Settings icon

Click it to configure survey code settings. See "Code Settings icon" sec-
tion on page 476 for details.
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Window tab
The Window tab contains control icons, which allow you to configure raw data editor window layout. It has only
one Window group.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.
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Help tab
The Help tab contain control icons which allow you to read product help. It has only one Help group.

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.
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LS Network editor
The LS network editor allows you to manually input traverse data.
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Deed Entry editor
The deed entry editor allows you to manually create/edit line and curve data that comprise deed descriptions.

The deed entry editor contains ribbon with control icons and table for deed data. Description of fields may be
found in the table below. The right side of the editor has the preview screen, which displays the deed, as you
filling in the table.

Fields of the traverse editor table
Field Description

Point Defines the number of a point in the deed.

Easting Defines the easting coordinate of a point in the deed.

Northing Defines the northing coordinate of a point in the deed.

Elevation Defines the height of a point in the deed.

Code Defines the code of a point in the deed.

Azimuth Defines the azimuth of the line which connects previous and current points in
the deed table.

Bearing Defines the bearing of the line which connects previous and current points in
the deed table.

Horz Dist Defines the horizontal distance of the line which connects previous and current
points in the deed table.

Radius Defines the radius of the arc which connects previous and current points in the
deed table.

Arc Length Defines the length of the arc which connects previous and current points in the
deed table.

Tangent Length Defines the length of the tangent to the arc which connect previous and current
points in the deed table.

The deed entry editor has its own ribbon, which is differ from the MAGNET Office default ribbon.
l The File tab is divided to three groups. For more information refer to "File tab" section on the facing page.
l The Edit tab contains only the Codes icon. It has the same functionality as the "Codes icon" section on
page 95 from the MAGNET Office default ribbon.

l The Library tab contains two icons:
l The Global Codes icon. It has the same functionality as the "Global Codes icon" section on
page 476 from the MAGNET Office default ribbon.

l The Code Settings icon. It has the same functionality as the "Code Settings icon" section on
page 476 from the MAGNET Office default ribbon.

l The Window tab contains three icons:
l The Cascade icon. It has the same functionality as the "Cascade icon" section on page 505 from the
MAGNET Office default ribbon.

l The Tile Horizontally icon. It has the same functionality as the "Tile Horizontally icon" section on
page 505 from the MAGNET Office default ribbon.
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l The Tile Vertically icon. It has the same functionality as the "Tile Vertically icon" section on
page 505 from the MAGNET Office default ribbon.

File tab
The File tab of the deed entry editor ribbon allows you to perform the basic operations. It divided to two groups,
described below

Standard group
The Standard group of the File tab of the deed entry editor ribbon allows you to perform basic file operations. It
contains three icons, described in the table below.

Save icon
Click it to save the current deed entry document.

Open icon
Click it to open an existing deed entry for editing.

Close icon
Click it to close the deed entry editor.

View group
The View group of the File tab of the deed entry editor ribbon contains four icons, described in the table below.

Save to Survey icon
Click it to upload changes from the deed entry editor to the survey view.

Regen icon
Click it to recalculate points coordinates. The report will be displayed.

CAUTION
A coordinate system projection must be defined to use this
mode.

Report icon
Click it to generate a deed report.

Survey View icon
Click it to switch to the survey view.

Settings group
The Settings group of the File tab of the deed entry editor ribbon contains two icons, described in the table below.

Configure icon
Click it to configure the layout of the deed entry editor table.
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Header Details icon
Click it to edit details of the deed entry.

Configure icon
The Configure icon of the Deed Entry editor allows you to configure the traverse editor table.

To configure the traverse editor table:
1. In the Settings group of the File tab of the deed entry editor ribbon, click the Configure icon.

The Configuration dialog is displayed.
2. In the Display Sequence editbox, configure the table appearance, by using the variables from the right

panel of the dialog. The columns of the table will be displayed in order, which you define.
3. In the Edit Sequence editbox, configure the editing sequence for each observation point type. The

MAGNET Office will automatically move the cursor to the defined columns.
4. Click OK.

To save the configuration as default, click Save Default.

To load the default configuration, click Load Default.

Global survey codes editor
The global survey codes editor allows you to edit survey codes, which may be used in any project, created in the
MAGNET Office.

The editor contains the list of the global survey codes, with their properties and attributes. If column header is
clicked, the survey code will be sorted by this column.

Fields and buttons of the editor are described in the tables below.

Fields of the global survey codes editor
Field Description

Survey Code Displays the name of the survey code.

Type Defines the type of the survey code.

Description Defines the short description of the survey code.

Layer Defines the layer for the survey code.

Point Options

Use in Surface Defines whether the points with the selected survey code may be used for
DTM creation.

Point Color Defines the point color for points with the selected survey code.

Marker Defines the point marker for points with the selected survey code.

Symbol Defines the point symbol for points with the selected survey code.

Annotation Defines the point annotation settings for points with the selected survey code.
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Field Description

Line Options

Auto String When ticked, points with this code will be automatically connected with a line.
It is useful for points on line features, such as fence lines, banks, and curbs.

Breakline

When ticked, lines strung from points with this code will be set as breaklines.
It is useful for points on the surface of the survey, which are joined by lines
that indicate a break in the surface grade. This can be applied to banks, curbs,
drains, streams, and walls.

Line Color Defines the color for lines strung from points with this code.

Line Style Defines the line style for lines strung from points with this code.

Line Width Defines the line thickness for lines strung from points with this code.

Area Options

Draw Edge Defines, whether to draw the border line around the polygons, based on points
with this code.

Area Fill Color Defines the filling colors for the polygons, based on points with this code.

Area Fill Style Defines the filling style for the polygons, based on points with this code.

Transparency Defines the filling transparency for the polygons, based on points with this
code.

Has Attributes When ticked, additional custom attributes will be assigned to points with this
code.

Prompt at each
node When ticked, assigning of custom attributes will be prompted at each node.

Attributes Options

Max Num Char-
acters Defines the maximum length of the custom attribute's value.

Default Value Defines the default value of the custom attribute.

Name Defines the name of the custom attribute.

Value Type Defines the type of the custom attribute's value.

Required Defines whether the custom attribute will be required.

Buttons of the project survey codes editor
Button Description

New Click it to create a new survey code.

Apply Click it to save the changes.

Delete Click it to delete the selected survey code.

Export Click it to save survey codes to an external MAGNET Field (*.xml),
TopSURV code (*.xml) or GTS-700 Code (*.kod) file.

Import Click it to load survey codes from an external MAGNET Field (*.xml),
TopSURV code (*.xml) or CivilCAD Survey Code (*.lcd, *.bed, *.out) file.
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Button Description

Report Click it to generate the survey code report.

Set Properties Click it to set the properties of the selected code as the default for new entity
creation.

Transfer to Pro-
ject Click it to save the selected code in the project survey codes.
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Project survey codes editor
The project survey codes editor allows you to edit survey codes, which will be used in the current project only.

The editor contains the list of the survey codes in project, with their properties and attributes. If column header is
clicked, the survey code will be sorted by this column.

Fields and buttons of the editor are described in the tables below.

Fields of the project survey codes editor
Field Description

Survey Code Displays the name of the survey code.

Type Defines the type of the survey code.

Description Defines the short description of the survey code.

Layer Defines the layer for the survey code.

Point Options

Use in Surface Defines whether the points with the selected survey code may be used for
DTM creation.

Point Color Defines the point color for points with the selected survey code.

Marker Defines the point marker for points with the selected survey code.

Symbol Defines the point symbol for points with the selected survey code.

Annotation Defines the point annotation settings for points with the selected survey code.

Line Options

Auto String When ticked, points with this code will be automatically connected with a line.
It is useful for points on line features, such as fence lines, banks, and curbs.

Breakline

When ticked, lines strung from points with this code will be set as breaklines.
It is useful for points on the surface of the survey, which are joined by lines
that indicate a break in the surface grade. This can be applied to banks, curbs,
drains, streams, and walls.

Line Color Defines the color for lines strung from points with this code.

Line Style Defines the line style for lines strung from points with this code.

Line Width Defines the line thickness for lines strung from points with this code.

Area Options

Draw Edge Tick it to draw the edge line of the polygons, based on points with this code.

Area Fill Color Defines the filling colors for the polygons, based on points with this code.

Area Fill Style Defines the filling style for the polygons, based on points with this code.

Transparency Defines the filling transparency for the polygons, based on points with this
code.

Has Attributes When ticked, additional custom attributes will be assigned to points with this
code.
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Field Description

Prompt at each
node When ticked, assigning of custom attributes will be prompted at each node.

Attributes Options

Max Num Char-
acters Defines the maximum length of the custom attribute's value.

Default Value Defines the default value of the custom attribute.

Name Defines the name of the custom attribute.

Value Type Defines the type of the custom attribute's value.

Required Tick it to make the custom attribute required.

Buttons of the project survey codes editor
Button Description

Apply Click it to save the changes.

Report Click it to generate the survey code report.

Set Properties Click it to set the properties of the selected code as the default for new entity
creation.

Transfer to
Global Click it to save the selected code in the survey codes library.
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MAGNET Office Entities Properties
Each entity, used in the MAGNET Office projects, has a set of properties, which allows you to configure them to
fits your needs. You may edit properties of any object at any time, using by the Edit Properties dialog.

The Edit Properties dialog allows you to view and edit properties of the MAGNET Office entities, which are
used in the survey view.

To edit properties of an object, or a group of objects, select them and click the Properties icon of the Edit tab.
More information about properties of the particular entity type may be found in the corresponding sections:

l "Point properties" section on the next page
l "Line properties" section on page 548
l "Arc properties" section on page 550
l "Circle properties" section on page 554
l "String properties" section on page 555
l "Polyline properties" section on page 557
l "Polygon properties" section on page 558
l "Lot properties" section on page 560
l "Boundary properties" section on page 563
l "Pad properties" section on page 565
l "Text properties" section on page 567
l "Dimension properties" section on page 569
l "Arrow properties" section on page 570
l "Table properties" section on page 571
l "Alignment properties" section on page 572
l "Image Viewer" section on page 573
l "Layer properties" section on page 574

When editing several objects at once, the dialog has separate tabs for each object type. Fields are remains the
same as for standalone editing. Make the required configurations on each tab, and click OK.

To apply some property to all selected objects, regardless of their type, click Apply To All.
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Point properties
A point is a two- or three-dimensional in space and it is the main entity in MAGNET Office, on which all other
entities are derived.

The Editing Points dialog allows you to edit properties of the selected point. Buttons and fields of the dialog are
described in the tables below.

The non-editable fields of the Edit Point dialog
Field Description

Point No.

A unique point identifier in the project database. One project cannot con-
tain two points with the same numbers. Point numbers or names may be
numeric or alphanumeric. The number or name is allocated when the point
is created automatically by the MAGNET Office or manually by user,
and cannot be changed after that.

Easting The east or X component of a point position.

Northing The north or Y component of a point position.

No of Linkages The point is the basic entity, from which all other entities are derived.
This field indicates how many entities are depending on this point.

The editable fields of the Edit Point dialog
Field Description

Code

An additional alphanumeric description, attached to the point. Point codes
are usually used for automatically assigning properties to points and for
controlling line string between points during the reduction process. The
feature codes and the properties are stored in the Survey Codes Library.

Elevation

The height, reduced level, or Z component of a point position.
MAGNET Office allows creating points with or without height. Tick
checkbox near the elevation's editbox to activate it. An unticked checkbox
means that the point has no height.

Use in Surface Defines whether the point with the defined elevation may be included in a
digital terrain model (DTM).

Layer Defines a layer to which the point belongs to.

Color Defines a color for point displaying.

Mark Defines displaying of the point on the screen.

Description Short description of the point.

Symbol
Defines appearance of the point both on the screen and in the printed
copy. You may choose symbol from the symbol library. For more inform-
ation about symbols, refer to "Symbol icon" section on page 54.
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Field Description

X/Y Scale

Defines the symbol scale for displaying. Some symbols are too small; oth-
ers are too big for correct displaying. To display them right, make sure to
select the appropriate scale. Note that some symbols are unscalable and
plot at the size they were designed.

Rotation
Defines the rotation of the symbol. Rotation value is degrees. Rotations
are absolute a value of the DDD.MMSS format will rotate the symbol by
specified angle.

Locked Tick it to lock the point, so its properties cannot be edited, and the point
cannot be moved with a mouse.

Annotation Defines attributes to be displayed as the point annotation.

The buttons of the Edit Point dialog
Button Description

Annotation Settings
Click it to configure the annotation displaying. This button is active only
when at least one checkbox from the Annotation group box is ticked. For
more information refer to "Point annotation settings" section on page 604.

Set Properties Click it to set current properties as the default for points. New points will
be created with these properties.

Get Properties Click it to apply existing default properties to the point.

Attributes Click it to add new attributes to the point.

Images/Pdfs
Click it to attach an image or a PDF file to the point. The picture will be
displayed near the point. For more information about configuring images,
refer to "Image Viewer" section on page 573.

Delete Click it to delete the point and close the dialog.

Apply Click it to apply changes.

Notes Click it to add a short note.

Symbols... Click it to manage extra symbols for the point.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Line properties
A line is a connection between two points, and defined by a start point and an end point. The bearing and distance
of the line are defined by the start and end points positions.

The Edit Line dialog allows you to edit properties of the selected line. Buttons and fields of the dialog are
described in the tables below.

The non-editable fields of the Edit Line dialog
Field Description

Start Point Displays the start point number.

End Point Displays the end point number.

Bearing Displays the line bearing. A number to the left of the field displays ori-
ginal bearing.

Distance Display the line length.

The editable fields of the Edit Line dialog
Field Description

Layer Defines layer to which the line belongs to. Note that the line and its points
may belong to the different layers.

Color Defines a color for line displaying.

Line Style
Defines appearance of the line both on the screen and on the printed copy.
You may choose them from the line styles library. For more information
about line styles, refer to Line Style icon.

Thickness Defines the width of the line in millimeters when plotted.

Break Line
A line may be defined as a breakline. Line must join two Use in Surface
points with heights for that. MAGNET Office treats a breakline as a line
or arc across which you cannot form a triangle.

Annotation Tick it to turn on line annotation with its bearing, distance or both.

In Line Annotation
Table

Tick it to display the line annotation in the Line Annotation Table. If this
table is plotted, the line is marked with a number, which is listed in the
table with the appropriate bearing and distance. See "Line Annotation
Table icon" section on page 214 for details.

Buttons of the Edit Line dialog
Button Description

Set Properties Click it to set current properties as the default for lines. New lines will be
created with these properties.

Get Properties Click it to load existing default properties for lines.

Reverse Click it to swap the start and end points of the line.

Attributes Click it to add new attributes to the line.

548



Line properties

Button Description

Image/Pdfs
Click it to attach an image or a PDF to the line. The picture will be dis-
played near the line. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the line and close the dialog.

Apply Click it to apply changes.

Annotation Settings Click it to configure the annotation displaying. For more information refer
to "Line annotation settings" section on page 605.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Arc properties
An arc is a part of a circumference, defined by three points. It may be either a start point, an end point and the
center point of circumference, or three points, belongs to one circumference.

The Edit Arc dialog allows you to edit properties of the selected arc. Buttons and fields of the dialog are
described in the table below.

NOTE
Dialog for the arc, defined by the three points, belongs to one circumference, calledEdit 3-Point Arc.

The non-editable fields of the Edit Arc dialog
Field Description

Start Point Displays the number of the start point.

End Point Displays the number of the end point.

Center Point Displays the number of the center point. This field exists in the Edit Arc
dialog only.

Third Point Displays the number of the third point. This field exists in the Edit 3-Point
Arc dialog only.

Radius Displays the radius of the arc.

Arc Length Displays the length of the arc.

Internal Angle Displays the internal angle of the arc. It is marked as "IA" at figure 1
below.

Start Bearing Displays the start bearing of the arc. It is marked as "SB" at figure 1
below.

End Bearing Displays the end bearing of the arc. It is marked as "EB" at figure 1
below.

Segment Area Displays the area of the arc segment. It is filled with purple at figure 2
below.

Sector Area Displays the area of the arc sector. It is filled with purple at figure 3
below.

Chord Length Displays the length of the arc main chord. It is marked as "CH" at figure
1 below.

Chord Bearing Displays the bearing of the arc main chord. It is marked as "HB" at figure
1 below.
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Figure 1. Arc parameters

Figure 2. Segment
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Figure 3. Sector

The editable fields of the Edit Arc dialog
Field Description

Layer Defines layer to which the arc belongs to. Note that the arc and its points
may belong to the different layers.

Color Defines a color for arc displaying.

Line Style
Defines appearance of the arc both on the screen and on the printed copy.
You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the arc in millimeters when plotted.

Break Line
An arc may be defined as breakline. The arc must be defined by three
Use in Surface points for that. If ticked, MAGNET Office treats a break-
line as an arc across which you cannot form a triangle.

Annotation

Tick it to turn on arc annotation. Possible values for annotation are:
l Radius
l Arc length
l Internal angle
l Chord length
l Chord bearing

In Arc Annotation
Table

Tick it to display the arc annotation in the Arc Annotation Table. If this
table is plotted, the arc is marked with a number, which is listed in the
table with the appropriate attributes.
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Buttons of the Edit Arc dialog
Button Description

Set Properties Click it to set current properties as the default for arcs. New arcs will be
created with these properties.

Get Properties Click it to apply existing default properties to the arcs.

Reverse Click it to swap start and end points of the arc.

Attributes Click it to add new attributes to the arc.

Images/Pdfs
Click it to attach an image or a PDF to the arc. The picture will be dis-
played near the arc. For more information refer to "Image Viewer" sec-
tion on page 573.

Delete Click it to delete the arc and close the dialog.

Apply Click it to apply changes.

Annotation Settings Click it to configure the annotation displaying. For more information refer
to "Arc annotation settings" section on page 607.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Circle properties
A circle is defined by its center point and radius.

The Edit Circle dialog allows you to edit properties of the selected circle. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit Circle dialog
Field Description

Center Point Displays the number of the center point.

Easting Displays the east or X component of the center point position.

Northing Displays the north or Y component of the center point position.

Circumference Displays the length of the circumference.

Area Displays the area of the circle.

The editable fields of the Edit Circle dialog
Field Description

Radius Defines the radius of the circle.

Layer Defines layer to which the circle belongs to. Note that the circle and its center
point may belong to the different layers.

Color Defines a color for circle displaying.

Line Type
Defines appearance of the circle both on the screen and on the printed copy. You
may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the circle in millimeters when plotted.

Buttons of the Edit Circle dialog
Button Description

Set Properties Click it to set current properties as the default for circles. New circles will be
created with these properties.

Get Properties Click it to load existing default properties for circles.

Attributes Click it to add new attributes to the circle.

Images/Pdfs
Click it to attach an image or a PDF to the circle. The picture will be displayed
near the circle. For more information refer to "Image Viewer" section on
page 573.

Delete Click it to delete the circle and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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String properties
A string defined by several points, joined by lines and/or arcs to become one entity. The string may be a 3D
object, if all points that define it have elevation values. A smoothing algorithm may be applied to the string for plot-
ting purposes; it has no influence on any computations.

The Edit String dialog allows you to edit properties of the selected string. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit String dialog
Field Description

Start Point Displays the number of the string start point.

End Point Displays the number of the string end point.

Num Points Display quantity of the points in the string.

Length Display the length of the string.

The editable fields of the Edit String dialog
Field Description

Name Defines the name of the string.

Layer Defines layer to which the string belongs to. Note that the string and its points
may belong to the different layers.

Color Defines a color for string displaying.

Line Style
Defines appearance of the string both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the string in millimeters when plotted.

is Smoothed Select it to apply a smoothing spline algorithm to the string. It is used for plot-
ting purposes and has no influence on any computations.

Service Select is to make the string a service for use in obstruction definition.

Break Line
A string may be defined as breakline. The string must be defined by Use in Sur-
face points for that. If ticked, MAGNET Office treats a breakline as a line or
arc across which you cannot form a triangle.

Annotation Tick it to turn on the string annotation.

Buttons of the Edit String dialog
Button Description

Set Properties Click it to set current properties as the default for strings. New strings will be
created with these properties.

Get Properties Click it to load existing default properties for strings.

Reverse Click it to swap the start and end points of the string.
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Button Description

Images/Pdfs
Click it to attach an image or a PDF to the string. The picture will be displayed
near the string. For more information refer to "Image Viewer" section on
page 573.

Delete Click it to delete the string and close the dialog.

Service Detail Click it to configure a service.

Annotation Set-
tings

Click it to configure the annotation displaying. For more information refer to
"String annotation settings" section on page 612.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Polyline properties
A polyline defined by several lines, joined to become one entity. Note that polyline does not have start, end or
node points as independent entities.

The Edit Polyline dialog allows you to edit properties of the selected polyline. Buttons and fields of the dialog are
described below.

The editable fields of the Edit Polyline dialog
Field Description

Layer Defines layer to which the polyline belongs to.

Color Defines a color for polyline displaying.

Thickness Defines the width of the polyline in millimeters when plotted.

Line Style
Defines appearance of the polyline both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Elevation
The height, reduced level, or Z component of the polyline. MAGNET Office
allows to create polylines with or without height. Tick near the elevation edit-
box to activate it. Unticked checkbox means that polyline has no height.

Break Line A polyline may be defined as a breakline. If ticked, MAGNET Office treats a
breakline as a line or arc across which you cannot form a triangle.

Buttons of the Edit Polyline dialog
Button Description

Set Properties Click it to set current properties as the default for polylines. New polylines will
be created with these properties.

Get Properties Click it to load existing default properties for polylines.

Delete Click it to delete the polyline and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Polygon properties
A polygon is a closed shape, defined by several points, joined by lines and/or arcs to become one entity. A poly-
gon may be selected by its centroid point.

You can move the polygon nodes to change its shape, by holding the Shift key and moving the node with a mouse.
You can also move the entire polygon in the same way, by using its centroid point.

A polygon may be filled with a pattern, hatching, or shading.

A polygon is the base entity for a lot, boundary or pad.

The Edit Polygon Area dialog allows you to edit properties of the selected polygon. Buttons and fields of the dia-
log are described below.

The non-editable fields of the Edit Polygon Area dialog
Field Description

Area Displays the area of the polygon.

Perimeter Displays the length of the polygon perimeter.

Start Point Displays the number of the polygon start point.

End Point Displays the number of the polygon end point.

Num Points Displays the quantity of the points (excluding centroid point) in the polygon.

Num Lines Displays the quantity of the lines in the polygon.

Num Arcs Displays the quantity of the arcs in the polygon.

CentroidX Displays the X or north component of the polygon centroid point position.

CentroidY Displays the Y or east component of the polygon centroid point position.

The editable fields of the Edit Polygon Area dialog
Field Description

Layer Defines layer to which the polygon belongs to. Note that the polygon and its
points, lines and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the polygon, will not be displayed when
plotted.

Break Line
A polygon may be defined as breakline. The polygon must be defined by Use in
Surface points for that. If ticked, MAGNET Office treats a breakline as a line
or arc across which you cannot form a triangle.

Line Color Defines a color for polygon edges displaying.

Line Style
Defines appearance of the polygon edges both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the polygon edge in millimeters when plotted.

Filling Color Defines the color for polygon area filling and strength of the pattern.
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Field Description

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for polygon area filling.

Symbol Defines the symbol for polygon area filling.

Line Style

Defines the line style for polygon area hatching. You may choose them from
the line styles library. For more information about line styles, refer to "Line
Style icon" section on page 55. You may specify the slope of the line in the edit-
box below.

Cross Defines whether to activate the cross-hatching of the polygon area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Defines whether to draw the edge line around the polygon or not.

Buttons of the Edit Polygon Area dialog
Button Description

Set Properties Click it to set current properties as the default for polygons. New polygons will
be created with these properties.

Get Properties Click it to apply existing default properties to the polygon.

Attributes Click it to add new attributes to the polygon.

Images/Pdfs
Click it to attach an image or a PDF to the polygon. The picture will be dis-
played near the polygon centroid point. For more information about configuring
images, refer to "Image Viewer" section on page 573.

Delete Click it to delete the polygon and close the dialog.

Apply Click it to apply changes.

Save File Click it to save the polygon as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the polygon to a boundary, lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the polygon.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Lot properties
A lot is a closed figure, created by lines and/or arcs. A lot is a type of polygon with the additional attributes to
define it as an allotment in a subdivision. Lots can be automatically annotated with bearing, distance, area, lot
numbers, and angles

You can move the lot nodes to change its shape, by holding the Shift key and moving the node with a mouse. You
can also move the entire lot in the same way, by using its centroid point.

The Edit Lot dialog allows you to edit properties of the selected lot. Buttons and fields of the dialog are described
below.

The non-editable fields of the Edit Lot dialog
Field Description

Area Displays the area of the lot.

Perimeter Displays the length of the lot perimeter.

Start Point Displays the number of the lot start point.

End Point Displays the number of the lot end point.

Num Points Displays the quantity of the points (excluding centroid point) in the lot.

Num Lines Displays the quantity of the lines in the lot.

Num Arcs Displays the quantity of the arcs in the lot.

CentroidX Displays the X or north component of the lot centroid point position.

CentroidY Displays the Y or east component of the lot centroid point position.

The editable fields of the Edit Lot dialog
Field Description

Name Defines the name of the lot.

Layer Defines layer to which the lot belongs to. Note that the lot and its points, lines
and arcs may belong to the different layers.

Line Color Defines a color for lot edges displaying.

Line Style
Defines appearance of the lot edges both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the lot edge in millimeters when plotted.

Filling Color Defines the color for lot area filling.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for lot area filling.

Symbol Defines the symbol for lot area filling.
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Field Description

Line Style
Defines the line style for lot area hatching. You may choose them from the line
styles library. For more information about line styles, refer to "Line Style icon"
section on page 55. You may specify the slope of the line in the editbox below.

Cross Select it to activate the cross-hatching of the lot area.

Opaque When ticked, the lot is places in front of any entities, and cut them at a certain
distance around the lot.

DP Number Defines a deposited plan — previous survey plan with reference number

Code Defines a code for the lot area.

House No Defines a number of the house, located at the lot.

Street Defines a name of the street, going through the lot.

Clipping Boundary When ticked, contours, going through the lot, will not be displayed when plot-
ted.

Break Line
A lot may be defined as breakline. The lot must be defined by Use in Surface
points for that. If selected, MAGNET Office treats a breakline as a line or arc
across which you cannot form a triangle.

Annotation

Select it to turn on lot annotation. Possible values for annotation are:
l Lot Name
l Lot Area
l Lot Angle
l Lot Lines
l Lot Arcs
l Back Boundary

Draw Edge Tick it to draw the lot edge.

Buttons of the Edit Lot dialog
Button Description

Set Properties Click it to set current properties as the default for lots. New lots will be cre-
ated with these properties.

Get Properties Click it to apply existing default properties to the lot.

Attributes Click it to add new attributes to the lot.

Images/Pdfs
Click it to attach an image or a PDF to the lot. The picture will be displayed
near the lot. For more information about configuring images, refer to "Image
Viewer" section on page 573.

Delete Click it to delete the lot and close the dialog.

Convert Click it to convert the lot to boundary, pad or string.

Apply Click it to apply changes.

Surface Area Click it to compute the area of DTM, crossing with the lot.

OK Click it to apply changes and close the dialog.
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Button Description

Cancel Click it to close the dialog without saving changes.
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Boundary properties
A boundary is a series of connected lines and/or arcs, formed into a closed figure. In fact, a boundary is a named
polygon. It is used for various routines, such as:

l Compute volumes within the boundary
l Delete triangles inside or outside the boundary
l Select entities inside the boundary for other options

A boundary may be selected by its centroid point.

You can move the boundary nodes to change its shape, by holding the Shift key and moving the node with a mouse.
You can also move the entire boundary in the same way, by using its centroid point.

A boundary may be filled with a pattern, hatching, or shading.

The Edit Boundary dialog allows you to edit properties of the selected boundary. Buttons and fields of the dialog
are described below.

The non-editable fields of the Edit Boundary dialog
Field Description

Area Displays the area of the boundary.

Perimeter Displays the length of the boundary perimeter.

Start Point Displays the number of the boundary start point.

End Point Displays the number of the boundary end point.

Num Points Displays the quantity of the points (excluding centroid point) in the boundary.

Num Lines Displays the quantity of the lines in the boundary.

Num Arcs Displays the quantity of the arcs in the boundary.

CentroidX Displays the X or north component of the boundary centroid point position.

CentroidY Displays the Y or east component of the boundary centroid point position.

The editable fields of the Edit Boundary dialog
Field Description

Name Defines the name of the boundary.

Layer Defines layer to which the boundary belongs to. Note that the boundary and its
points, lines, and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the boundary, will not be displayed when
plotted.

Break Line
A boundary may be defined as breakline. The boundary must be defined by
Use in Surface points for that. If ticked, MAGNET Office treats a breakline as
a line or arc across which you cannot form a triangle.

Line Color Defines a color for boundary edge displaying.

Line Style
Defines appearance of the boundary edge both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.
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Field Description

Thickness Defines the width of the boundary edge in millimeters when plotted.

Filling Color Defines the color for boundary area filling and strength of the pattern.

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for boundary area filling.

Symbol Defines the symbol for boundary area filling.

Line Style

Defines the line style for boundary area hatching. You may choose them from
the line styles library. For more information about line styles, refer to "Line
Style icon" section on page 55. You may specify the slope of the line in the edit-
box below.

Cross Tick it to activate the cross-hatching of the boundary area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Tick it to draw the boundary edge.

Buttons of the Edit Boundary dialog
Button Description

Set Properties Click it to set current properties as the default for boundaries. New boundaries
will be created with these properties.

Get Properties Click it to apply existing default properties to the boundary.

Attributes Click it to add new attributes to the boundary.

Images/Pdfs
Click it to attach an image or a PDF to the boundary. The picture will be dis-
played near the boundary centroid point. For more information about configuring
images, refer to "Image Viewer" section on page 573.

Delete Click it to delete the boundary and close the dialog.

Apply Click it to apply changes.

Save File Click it to save the boundary as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the boundary to lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the boundary.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Pad properties
A pad is a series of connected lines and/or arcs, formed into a closed figure around the extents of the buildings or
other pad. In fact, a pad is a named polygon. It is used for identification of a pad and side slopes suitable for the
placement of buildings.

A pad may be selected by its centroid point.

You can move the pad nodes to change its shape, by holding the Shift key and moving the node with a mouse. You
can also move the entire pad in the same way, by using its centroid point.

A pad may be filled with a pattern, hatching, or shading.

The Edit Pad dialog allows you to edit properties of the selected pad. Buttons and fields of the dialog are
described below.

The non-editable fields of the Edit Pad dialog
Field Description

Area Displays the area of the pad.

Perimeter Displays the length of the pad edge.

Start Point Displays the number of the pad start point.

End Point Displays the number of the pad end point.

Num Points Displays the quantity of the points (excluding centroid point) in the pad.

Num Lines Displays the quantity of the lines in the pad.

Num Arcs Displays the quantity of the arcs in the pad.

CentroidX Displays the X or north component of the pad centroid point position.

CentroidY Displays the Y or east component of the pad centroid point position.

The editable fields of the Edit Pad dialog
Field Description

Name Defines the name of the pad.

Layer Defines layer to which the pad belongs to. Note that the pad and its points,
lines, and arcs may belong to the different layers.

Clipping Boundary When ticked, contours, going through the pad, will not be displayed when plot-
ted.

Break Line
A pad may be defined as breakline. The pad must be defined by Use in Surface
points for that. If ticked, MAGNET Office treats a breakline as a line or arc
across which you cannot form a triangle.

Line Color Defines a color for pad edge displaying.

Line Style
Defines appearance of the pad edge both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about
line styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the pad edge in millimeters when plotted.

Filling Color Defines the color for pad area filling and strength of the pattern.
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Field Description

Filling Space Defines the space between adjacent filling symbols and lines for X (horizontal)
and Y (vertical) axis.

Pattern Defines pattern style for pad area filling.

Symbol Defines the symbol for pad area filling.

Line Style

Defines the line style for pad area hatching. You may choose them from the
line styles library. For more information about line styles, refer to "Line Style
icon" section on page 55. You may specify the slope of the line in the editbox
below.

Cross Tick it to activate the cross-hatching of the pad area.

Opaque When ticked, the displaying of the filling is turned off.

Draw Edge Tick it to draw the pad edge.

Buttons of the Edit Pad dialog
Button Description

Set Properties Click it to set current properties as the default for pads. New pads will be cre-
ated with these properties.

Get Properties Click it to apply existing default properties to the pad.

Attributes Click it to add new attributes to the pad.

Images/Pdfs
Click it to attach an image or a PDF to the pad. The picture will be displayed
near the pad centroid point. For more information about configuring images,
refer to "Image Viewer" section on page 573.

Delete Click it to delete the pad and close the dialog.

Apply Click it to apply changes.

Save File Click it to save the pad as a platform (*.bld) or house (*.hse) file.

Convert Click it to convert the boundary to lot, pad or string.

Surface Area Click it to compute the area of DTM, crossing with the pad.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Text properties
A text is a group of alpha, numeric or alphanumeric characters, located in the survey view. It is displayed on one
or multiple lines. Text entities are non-scalable, defined text height remains the same, regardless of the plotting
scale.

The Edit Text dialog allows you to edit properties of the selected text. Buttons and fields of the dialog are
described in the tables below.

Fields of the Edit Text dialog
Field Description

Easting Defines the east or Y component of the text position.

Northing Defines the north or X component of the text position.

Layer Defines the layer to which the text belongs to.

Bearing Defines the bearing of the text. Bearing is measured clockwise from north.

Color Defines a color for text displaying.

Font Defines a font for text displaying.

Char Height Defines the height of the text char

Text Style Defines the pre-configured text style. For information about configuring text
styles, refer to "Text Styles icon" section on page 122.

Char Style Defines the usage bold/italic/underline formatting or not.

Insertion Style Defines the position of the insertion point relative to the text string. Refer to pic-
tures below for details.

Use Text Style Tick it to use the pre-configured text style, selected in the Text Style drop-down
list.

Draw Box Tick it to draw a frame around the text.

Opaque Select it to place the text in front of any entities, and cut them at a certain distance
around the text.

Main editbox Defines the text string to be displayed.

Buttons of the Edit Text dialog
Button Description

Parallel To Click it to set the text to be parallel to an existing entity.

Set Properties Click it to set current properties as the default for text. New text will be cre-
ated with these properties.

Get Properties Click it to load existing default properties for text.

Delete Click it to delete the text and close the dialog.

Upper Convert all chars of the text to uppercase.

Lower Convert all chars of the text to lowercase.

Invert Invert the current upper/lowercase condition.
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Button Description

Capitalize Convert the first char of each word to uppercase.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Dimension properties
A dimension entity measures the distance between two existing points and displays it as annotation for line
between these points with arrows on each end.

The Edit Dimension dialog allows you to edit properties of the selected dimension. Buttons and fields of the dia-
log are described below.

Fields of the Edit Dimension dialog
Field Description

Layer Defines the layer to which the dimension belongs to.

Color Defines a color for dimension displaying.

Thickness Defines the width of the dimension line in millimeters when plotted.

Line Style
Defines appearance of the dimension line both on the screen and on the printed
copy. You may choose them from the line styles library. For more information
about line styles, refer to "Line Style icon" section on page 55.

Arrow Head Defines the style of the arrow head.

Head Angle Defines the angle of the arrow head.

Head Length Defines the length of the arrow head.

Buttons of the Edit Dimension dialog
Button Description

Set Properties Click it to set current properties as the default for dimensions. New dimensions
will be created with these properties.

Get Properties Click it to apply existing default properties to the dimension.

Delete Click it to delete the dimension and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Arrow properties
An arrow is a special line or series of lines with an arrow head at one or both ends. The arrow can be used as an
indicator on a plan. Various arrow head styles are available with user-defined dimensions for the arrow head.
Arrow heads are non-scalable, defined arrow head remains the same, regardless of the plotting scale.

The Edit Arrow dialog allows you to edit properties of the selected arrow. Buttons and fields of the dialog are
described below.

Fields of the Edit Arrow dialog
Field Description

Layer Defines the layer to which the arrow belongs to.

Color Defines a color for arrow displaying.

Thickness Defines the width of the arrow line in millimeters when plotted.

Line Style
Defines appearance of the arrow line both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Arrow Head Defines the style of the arrow head.

Head Angle Defines the angle of the arrow head.

Head Length Defines the length of the arrow head.

Buttons of the Edit Arrow dialog
Button Description

Set Properties Click it to set current properties as the default for arrows. New arrows will be
created with these properties.

Get Properties Click it to apply existing default properties to the arrow.

Delete Click it to delete the arrow and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Table properties
The Table Properties dialog allows you to edit properties of the selected table. Fields of the dialog are described
in the table below.

Fields of the Table Properties dialog
Field Description

Name Defines the name of the table.

Rows Defines the quantity of rows in the table.

Columns Defines the quantity of columns in the table.

Min Height Defines the minimum height of the table rows.

Min Width Defines the minimum width of the table columns.

Color Defines the color of the table borders.

Font Defines the font of the text in the table.

Char Height Defines the font size of the text in the table.

Text Style Defines the text style, used in the table.

Char Style Defines the text formatting in the table.

Insertion Style Defines the position of the insertion point relative to the table.

Use Text Style Tick it to use the font settings from the text style, instead of mentioned above.

Opaque Tick it to place the table in front of any entities, and cut them at a certain dis-
tance around the text.

Draw Box Tick it to draw the outer borders of the table.
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Alignment properties
An alignment defined by several points, joined by lines to become one entity. The alignment may be a 3D object,
if all points that define it have elevation values.

The Edit Alignment dialog allows you to edit properties of the selected alignment. Buttons and fields of the dia-
log are described below.

The non-editable fields of the Edit Alignment dialog
Field Description

Start IP Displays the number of the alignment start intersection point.

End IP Displays the number of the alignment end intersection point.

Num Points Display quantity of the intersection points in the alignment.

End Chain Displays the chainage or running distance at the end of the alignment.

Length Display the length of the alignment.

The editable fields of the Edit Alignment dialog
Field Description

Name Defines the name of the alignment.

Start Chain Defines the chainage or the running distance of the alignment start intersection
point.

Layer Defines the layer, to which the alignment belongs to. Note that the alignment and
its points may belong to the different layers.

Color Defines a color for alignment displaying.

Line Style
Defines appearance of the alignment both on the screen and on the printed copy.
You may choose them from the line styles library. For more information about line
styles, refer to "Line Style icon" section on page 55.

Thickness Defines the width of the alignment in millimeters when plotted.

Buttons of the Edit Alignment dialog
Button Description

Set Properties Click it to set current properties as the default for alignments. New alignments
will be created with these properties.

Get Properties Click it to apply existing default properties to the alignment.

Reverse Click it to swap the start and end points of the alignment.

Images/Pdfs
Click it to attach an image or a PDF to the alignment. The picture will be dis-
played near the alignment. For more information refer to "Image Viewer" sec-
tion on the facing page.

Delete Click it to delete the alignment and close the dialog.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Image Viewer
The image viewer allows you to attach images or/and PDF files to the MAGNET Office entities.

To open the image viewer, click Images/Pdfs in the properties dialog of the appropriate entity. Left panel contains
the list of the attached images and/or PDF files. Right panel displays the preview of the currently selected
image/PDF file. Buttons are described in the table below.

Buttons of the image viewer
Button Description

View Pdf
Click it to open the selected PDF file in the default system PDF reader.

NOTE
This button is displayed only when a PDF file is selected.

Attach Image Click it to attach a new image or PDF file to the entity.

Delete Click it to delete the selected image/PDF file.

OK Click it to save the changes and close the image viewer.

Cancel Click it to close the image viewer without saving changes.

To display an image or/and a PDF file in the survey view, tick the checkbox near the required image/PDF file in
the left panel, and click OK.

573



MAGNET Office entities properties

Layer properties
A layer may be described as a sheet of transparent film, which may be viewed one in a time, or several layers at
once, combined to a "sandwich." Each entity belongs to one layer only, and will be invisible, if its layer is inact-
ive.

The Edit Survey Layer dialog allows you to edit properties of the selected layer. Buttons and fields of the dialog
are described in the tables below.

To edit layers properties:
1. In the Edit Layers group of the View tab, click the Layers icon.

The Layer Settings dialog is displayed.
2. Select layer to be edited.
3. Click Edit.

The Edit Survey Layer dialog is displayed.
4. Configure the layer parameters as you need.
5. Click OK.

Fields of the Edit Survey Layer dialog
Property Description

Layer Name Defines the name of the layer.

Active Defines whether the layer is active or inactive. Objects from inactive layers
will not be displayed in the survey view.

Lock Defines whether the layer is locked (i.e. cannot be changed) or not.

Overlay When ticked, entities which belong to the layer will be darkened, and not avail-
able for editing, i.e. all entities will be look like a background image.

Color Defines the default color for the layer. All entities, which belong to this layer
and have By Layer value of the Color parameter will be painted with it.

Point Mark Defines the default point mark for the layer. All points, which belong to this
layer and have By Layer value of the Mark parameter will have such mark.

Line Type
Defines the default line style for the layer. All lines, arcs, circles, strings, poly-
lines, polygon, lots, pads and boundaries, which belong to this layer and have
By Layer value of the Line Style parameter will have such line style.

Line Width
Defines the default line thickness for the layer. All lines, arcs, circles, strings,
polylines, polygon, lots, pads and boundaries, which belong to this layer and
have By Layer value of the Thickness parameter will have such line thickness.

Point Symbol Defines the default point symbol for the layer. All points, which belong to this
layer and have By Layer value of the Symbol parameter will have such symbol.

Avoidance To activate avoidance data, tick the checkbox and click Avoidance. See
"Avoidance" section on the facing page for details.

Editing multiple layer
To edit the properties of several layers at once:
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1. In the Edit Layers group of the View tab, click the Layers icon.

The Layer Settings dialog is displayed.
2. Select layers to be edited.
3. Click Edit.

The Edit Survey Layers dialog is displayed. The Name field contains MULTIPLE_EDIT value and cannot
be edited.

4. Configure the parameters as you need. These parameters will be applied to all selected layers.
5. Click OK.

Avoidance
The Avoidance feature is used in the machine control for alarming operator if the machine enter avoidance area;
and in the field software to avoid dangerous areas. Pictures below represent avoidance areas. MAGNET Office
support this feature for import/export purposes.

Avoidance area for a line

Avoidance area for polygon/surface in the horizontal plane

LEGEND
#1; #2; #3— points

4— proximity,

5— boundary and avoidance areas.

To configure avoidance zones:
1. In the Edit Layers group of the View tab, click the Layers icon.

The Layer Settings dialog is displayed.
2. Do one of the following:

575



MAGNET Office entities properties

l To edit an existing layer:
1. Select the required layer.
2. Click Edit.

The Edit Survey Layer dialog is displayed.
l To set avoidance in a new layer:

1. Click New.

The Add New Layer dialog is displayed.
2. Configure the layer parameters. For more information refer to "Add icon" section on page 99.

3. Tick checkbox to the left of Avoidance button.
4. Click Avoidance.

The Edit Avoidance Data dialog is displayed.
5. Tick the Avoidance checkbox.
6. In the Layer group box, define the avoidance area dimension, by selecting the appropriate radiobutton:

l 2D — to work in the horizontal plane only.
l 3D — to work in both horizontal and vertical planes.

7. In the Surface group box, define the avoidance mode, by selecting the appropriate radiobutton:
l Above — the avoidance boundary will be placed above the surface. The alarm will be displayed if a
measurement is performed within the avoidance boundary. See the "Above avoidance mode" picture
below.

l Below— the avoidance boundary will be placed below the surface. The alarm will be displayed if a
measurement is performed within the avoidance boundary. See the "Below avoidance mode" picture
below.

l Above/Below— the avoidance boundary will be placed both above and below the surface. The
alarm will be displayed if a measurement is performed within the avoidance boundary. See the
"Above/Below avoidance mode" picture below.

l Outside — the avoidance boundary will be placed both above and below the surface. The alarm will
be displayed if a measurement is performed outside of the avoidance boundary. See the "Outside
avoidance mode" picture below.

8. In the Proximity editbox, specify the size of the avoidance area.
9. Click OK.

Above avoidance mode

Below avoidance mode
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Above/Below avoidance mode

Outside avoidance mode

LEGEND
1— surface

2— proximity

3— boundary area

Fields of the Edit Avoidance Data dialog
Field Description

Layer Displays the name of the layer where avoidance will be set.

Avoidance Tick to activate avoidance for the layer.

Layer

2D Defines the work of the avoidance in the horizontal plane only

3D Defines the work of the avoidance in both horizontal and vertical planes

Surface

Above

Defines the Above avoidance mode. The avoidance boundary will be placed
above the surface. The alarm will be displayed if a measurement is performed
within the avoidance boundary. See the "Above avoidance mode" picture
above.

Below

Defines the Below avoidance mode. The avoidance boundary will be placed
above the surface. The alarm will be displayed if a measurement is performed
within the avoidance boundary. See the "Below avoidance mode" picture
above.
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Field Description

Above/Below

Defines the Above/Below avoidance mode. The avoidance boundary will be
placed both above and below the surface. The alarm will be displayed if a
measurement is performed within the avoidance boundary. See the
"Above/Below avoidance mode" picture above.

Outside

Defines the Outside avoidance mode. The avoidance boundary will be placed
both above and below the surface. The alarm will be displayed if a meas-
urement is performed outside of the avoidance boundary. See the "Outside
avoidance mode" picture above.

Proximity Defines the size of the avoidance area.
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MAGNET Office Settings
MAGNET Office allows user to configure various settings to more closely fit to your needs. You may find descrip-
tion of settings in the corresponding sections:

l "Project Settings dialog" section on the next page
l "Program Settings dialog" section on page 589
l "Display Settings dialog" section on page 598
l "Annotation Styles dialog" section on page 604
l "Contour Settings dialog" section on page 617
l "Annotation Table Settings dialog" section on page 625
l "Background Images dialog" section on page 620
l "DTM Settings dialog" section on page 626
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Project Settings dialog
The Project Settings dialog allows you to configure settings of the current project. These settings apply only to
the current project, and have no influence to other projects. Default settings for the MAGNET Office are con-
figured in the Program Settings dialog and applied to each new project.

To configure the project settings:
1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Configure the required settings at the appropriate tab. Description of each tab may be found in the cor-

responding sections:
l "Project details" section below
l "Project diary" section on the facing page
l "Project statistics" section on page 582
l "Project unit settings" section on page 583
l "Project symbols" section on page 585
l "Project coordinate system" section on page 586
l "Project SiteLINK 3D server" section on page 586

3. Click OK.

Click Print to generate report of current project settings. It will be displayed in a new window, and may be prin-
ted, or saved to a file.

Project details
The Project Details tab of the Project Settings dialog allows you to specify basic project information, such as
company, location, etc.

To edit project details:
1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Project Details tab.
3. Fill in required information. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Project Details tab
Field Description

Company Defines the name of the company. The field will be filled in automatically, if you
save this information in the program settings.

Name Defines the name of the user. The field will be filled in automatically, if you save
this information in the program settings.

Title Defines the name of the project.
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Field Description

Project Refer

Defines the project reference.
NOTE
This is the user-defined label. TheProject Ref is the default. Youmay change
this parameter it the Program user information

Stage

Defines the project stage.
NOTE
This is the user-defined label. TheStage is the default. Youmay change this
parameter it the Program user information

Location

Defines the location of the project.
NOTE
This is the user-defined label. The Location is the default. Youmay change this
parameter it the Program user information

Plan Number

Defines the project number in documentation.
NOTE
This is the user-defined label. ThePlan Number is the default. Youmay change
this parameter it the Program user information

Comments Type any relevant comments here.

Project diary
The Diary tab of the Project Settings dialog allows you to tracking work with the project. You may add notes
about performed procedures, and spent time.

The diary displays list of the entries, containing information about user, who had worked with the project, date,
and amount of time spent. It is also displays total time, spent on the project.

Creating new diary entries
To add a new entry to the project diary:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Diary tab.
3. Click Add.

The New Diary Entry dialog is displayed. The Date field contains current date.
4. In the Name editbox, type the name of the user. The field will be filled in automatically, if you save this

information in the program settings.
5. In the Time editbox, type the amount of time spent.
6. In the Comments editbox, type the appropriate description of tracked activity.
7. Click OK.

The new entry is added to the project diary.
8. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.
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Modifying existing diary entries
To modify an existing entry:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Diary tab.
3. ClickModify.

The Modify Diary Entry dialog is displayed. The "Date" field contains current date.
4. Change the required information.
5. Click OK.

The entry is modified.
6. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

NOTE
The "Total" entry cannot bemodified.

Deleting diary entries
To delete an entry:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Diary tab.
3. Select the required entry.
4. Click Delete.

The entry is deleted.
5. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

NOTE
The "Total" entry cannot be deleted.

Project statistics
The Statistics tab of the Project Settings dialog displays the following information about the project:

l Number of layers
l Number of points
l Number of lines
l Number of arcs
l Number of circles
l Number of texts
l Number of strings

To view the statistics:
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1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Statistics tab.
3. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Project unit settings
The Unit Settings tab of the Project Settings dialog allows you to configure measurement units in the project.

To configure unit settings:
1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Unit Settings tab.
3. Make the required configurations. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the project unit settings
Field Description

Units—Linear

Meters Select to define linear units as international standard unit of one meter.

Feet Select to define linear units as one foot, which is 0.3048 meters long.

US Feet Select to define linear units as one US foot, which is 0.3048006 meters long
or 39.37 inches to the meter.

Units—Angular

Deg Min Sec

Select to define angular units as degrees, minutes and seconds.

Data is entered and displayed in decimal format as DDD.MMSS. Seconds
can be taken with decimal values.

For example: 65.142645 is 65 degrees, 14 minutes and 26.45 seconds.

Degrees Select to define angular units as degrees only. Minutes and seconds are
decimal part of the degree.

Gon Select to define angular units as gons. The full circle is divided into 400
gons. 100 gons is equal to 90 degrees.

Units

Volume

Select unit for volumes calculation. Possible values are:
l Cubic Meters — if linear units are defined as meters.
l Cubic Feet — if linear units are defined as feet or US feet.
l Cubic Yards — if linear units are defined as feet or US feet.

Scale Factor and Mean Elevation
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Field Description

Base Scale Factor

Defines the projection scale factor.

It is applied to all distances when computing coordinate positions. The
ground distance will always be shown when computed lines or missing lines
are inquired.

Mean Elevation Defines the mean elevation for the project.

Rotation By

Mathematical Angle Defines the orientation in standard mode. East is 0 degrees and north is 90
degrees.

Survey Bearing Defines the orientation in bearing mode. North is 0 degrees and east is 90
degrees.

Format Station

Chainage

Defines the chainage format of stations distance displaying. The distance
from the start point will be displaying as the ordinary number.

For example: if the length is 2145.87, the end station number will be
2145.87.

Station

Defines the station format of stations distance displaying. The distance
from the start point will be displaying as the station number and distance
from it.

For example: if the length is 2145.87 and distance between stations is 100,
the end station number will be 21+45.87.

Base—Horizontal Angle

North Azimuth The horizontal angle is defined with zero degrees set to the north.

South Azimuth The horizontal angle is defined with zero degrees set to the south.

Base—Vertical Angle

Zenith The vertical angle is defined with zero degrees set to the zenith (directly
above). See figure 1 for details.

Vertical The vertical angle is defined with zero degrees set parallel to the ground.
See figure 1 for details.

Nadir The vertical angle is defined with zero degrees set to the nadir (directly
below). See figure 1 for details.

Display—Coordinates

East/North Coordinates is displayed as east value, followed by the north value.

North/East Coordinates is displayed as north value, followed by the east value.

Display—Directions

Azimuth The directions are displayed as azimuth angles. The North axis is zero and
angles are counted clockwise.
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Field Description

Quadrant
The directions are displayed as angles in quadrants. Quadrants are pictured
at figure 2. Angles are counted clockwise within each quadrant.

For example: azimuth angle of 130 degrees will be displayed as S 50° E.

Display

Elevation Tick to display elevations on the screen.

Decimal Places

Linear Defines the quantity of decimal places for linear units for displaying.

Angular Defines the quantity of decimal places for angular units for displaying.

Figure 1. Vertical angles zero axis

Figure 2. Quadrants

Project symbols
The Symbols tab of the Project Settings dialog allows you to configure symbols for project layout.

To configure the symbols layout:
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1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Symbols tab.
3. Make the required configurations. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Symbols tab
Field Description

North Point Sym-
bol

Defines the symbol of the north point. You may select it from the drop-down
list.

Point Mark Plot
Size Defines point marks size in millimeters for printing.

Annotation Sym-
bols

Define the symbols to be displayed in annotations for different units. To change
the default symbol, click and select the required font and symbol.

Project coordinate system
The Coordinate System tab of the Project Settings dialog allows you to define the coordinate system location for
the project.

To edit project coordinate system:
1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the Coordinate System tab.
3. From the Select projection list, select the required projection.

Projection details are displayed on the Selected Parameters pane.
4. If you need projection ellipsoid different from the projection default one, in the Projection ellipsoid field

untick the Use default checkbox, and select the required ellipsoid from the drop-down list.
5. If needed, select the datum from the Datum drop-down list.
6. If you need to use a geiod file in conjunction with the defined projection settings, in the Geoid file group

box, Click ... and select the required file.
7. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

To reset the coordinate system settings click Clear Projection.

Project SiteLINK 3D server
The SiteLINK 3D Server tab of the Project Settings dialog allows you to configure the project server for
SiteLINK 3D service.
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Creating SiteLINK 3D server profiles
To create a SiteLINK 3D server profile:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the SiteLINK 3D Server tab.
3. In the Server Profile field, type the name of the profile.
4. Specify the required parameters. Fields are described in the table below.

5. Click to save the profile.
6. Click Connect to connect to the server.
7. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Changing SiteLINK 3D server profiles
To change the server profile:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the SiteLINK 3D Server tab.
3. From the Server Profile drop-down list, select the required profile.

4. Change the required parameters. Fields are described in the table below. To discard changes, click .
5. Click to save changes.
6. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Deleting SiteLINK 3D server profiles
To delete a profile:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the SiteLINK 3D Server tab.
3. From the Server Profile drop-down list, select the required profile.

4. Click .
5. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Parameters of the SiteLINK 3D server profile
Fields of the SiteLINK 3D Server tab

Field Descriptoin

Server Profile Defines the name of the server profile. Also contains the list of the saved
profiles.
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Field Descriptoin

SiteLINK 3D Server

Primary address Defines the URL address and port for the primary SiteLINK 3D server.

Alternative address Define the URL address and port for alternate SiteLINK 3D servers.

Password Defines your SiteLINK 3D password.

Time-out Defines the connection timeout in seconds.

Auto connect to
SiteLINK 3D server
when the project is

opened

Tick to automatically connect to the server each time you open the pro-
ject.

Connecting to a SiteLINK 3D server
To connect to the server:

1. In the Settings group of the Settings tab, click the Project Settings icon.

The Project Settings dialog is displayed.
2. Click the SiteLINK 3D Server tab.
3. From the Server Profile drop-down list, select the required profile.
4. In the Status group box, click Connect.
5. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.
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Program Settings dialog
The Program Settings dialog allows you to configure the MAGNET Office settings. These settings are global and
will apply to all new projects. Settings for a particular project are configured in the Project Settings dialog and
applied only to this project.

To configure the MAGNET Office settings:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Project Settings dialog is displayed.
2. Configure the required settings at the appropriate tab. Description of each tab may be found in the cor-

responding sections:
l "Program user information" section below
l "Program folders" section on the next page
l "Program libraries" section on the next page
l "Program unit settings" section on page 592
l "Program symbols" section on page 595
l "Program coordinate system" section on page 595
l "Program preferences" section on page 596

3. Click OK.

Click Print to generate report of current project settings. It will be displayed in a new window, and may be prin-
ted, or saved to a file.

Click Save to save the current settings in an initialization (*.ini) file.

Click Load to load previously saved settings.

Program user information
The User Information tab of the Program Settings dialog allows you to configure identification information.

To edit user information:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Project Details tab.
3. Fill in required information in the appropriate fields. Description of the fields may be found in the table

below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the User Information tab
Field Description

Company Id Defines the company identification.

Company Defines the company name.

Name Defines the user name.

E-mail Defines the user e-mail address.
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Field Description

SiteLINK 3D Client
Name Defines username for the SiteLINK 3D service.

User defined labels

Defines four custom labels for the projects. Default values are:
l Project Ref
l Stage
l Location
l Plan Number

Program folders
The Folders tab of the Program Settings dialog allows you to define paths for MAGNET Office data, libraries,
temporary files and SiteLINK 3D inbox directories. You may store them on a file server or at a shared computer
for network access.

To redefine a directory:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Folders tab.
3. Select the required folder, and click Browse.

The Select Folder dialog is displayed.
4. Select the required folder, and click OK.
5. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Program libraries
The Libraries tab of the Program Settings dialog allows you to manage MAGNET Office libraries.

Libraries are files, which store regularly used information, like symbols, line styles, survey codes, etc. They are
automatically identified and mapped while MAGNET Office installation. However, it is possible redefine them if
you need to work with the library differ from the default one. List of libraries are displayed at the Libraries tab of
the Program Settings dialog. These libraries are opened when a job is started. The following libraries are needed
for proper MAGNET Office running:

l Global codes
l Symbols
l Line styles
l Text styles
l Roads
l Drain. See "Drainage library" section on page 668 for details.
l Sewer. See "Sewer library" section on page 666 for details.
l Survey
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You may also specify a default job for MAGNET Office. For more information refer to "MAGNET Office
default job" section below.

Redefining libraries
To redefine a library:

1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Libraries tab.
3. Select the required library, and click Browse.

The Open dialog is displayed.
4. Select the required file, and click Open.
5. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Editing libraries
To edit a library

1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Libraries tab.
3. Select the required library, and click Edit. For more information about editing libraries, refer to

"MAGNET Office libraries" section on page 630.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

MAGNET Office default job
Besides of managing libraries, the "Libraries" tab of the Program Settings dialog allows you to specify a default
job for the MAGNET Office.

If the "Create new job from the default job" checkbox is ticked, the default job will be used as a template. All the
settings from the Display Settings dialog dialog will be copied from the default job to a newly created one. All lay-
ers and the layers setting will be copied as well. User information will be automatically filled in, as in the default
job.

To define a default job:
1. In the "Settings" group of the "Settings" tab, click the "Program Settings" icon.

The "Project Settings" dialog is displayed.
2. Click the "Libraries" tab.
3. To the right of the "Default Job" field, Click Browse.

The "Default Job" dialog is displayed.
4. Select the required job, and Click Open.
5. Tick the "Create new job from the default job" checkbox.
6. When finished, do one of the following:
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l Click OK to close the dialog.
l Click another tab to configure more settings.

Program unit settings
The Unit Settings tab of the Program Settings dialog allows you to configure measurement units.

To configure unit settings:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Unit Settings tab.
3. Make the required configurations. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the project unit settings
Field Description

Units—Linear

Meters Select to define linear units as international standard unit of one meter.

Feet Select to define linear units as one foot, which is 0.3048 meters long.

US Feet Select to define linear units as one US foot, which is 0.3048006 meters long
or 39.37 inches to the meter.

Units—Angular

Deg Min Sec

Select to define angular units as degrees, minutes and seconds.

Data is entered and displayed in decimal format as DDD.MMSS. Seconds
can be taken with decimal values.

For example: 65.142645 is 65 degrees, 14 minutes and 26.45 seconds.

Degrees Select to define angular units as degrees only. Minutes and seconds are
decimal part of the degree.

Gon Select to define angular units as gons. The full circle is divided into 400
gons. 100 gons is equal to 90 degrees.

Units

Volume

Select unit for volumes calculation. Possible values are:
l Cubic Meters – if linear units is defined as meters.
l Cubic Feet – if linear units is defined as feet or US feet.
l Cubic Yards – if linear units is defined as feet or US feet.

Scale Factor and Mean Elevation
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Field Description

Base Scale Factor

Defines the projection scale factor.

It is applied to all distances when computing coordinate positions. The
ground distance will always be shown when computed lines or missing lines
are inquired.

Mean Elevation Defines the mean elevation for the project.

Rotation By

Mathematical Angle Defines the orientation in standard mode. East is 0 degrees and north is 90
degrees.

Survey Bearing Defines the orientation in bearing mode. North is 0 degrees and east is 90
degrees.

Format Station

Chainage

Defines the chainage format of stations distance displaying. The distance
from the start point will be displaying as the ordinary number.

For example: if the length is 2145.87, the end station number will be
2145.87.

Station

Defines the station format of stations distance displaying. The distance from
the start point will be displaying as the station number and distance from it.

For example: if the length is 2145.87 and distance between stations is 100,
the end station number will be 21+45.87.

Output

Proposed Scale 1 Defines the intended output plot scale and enables the display of symbols,
line types, and text as they will appear when printed or plotted.

Base—Horizontal Angle

North Azimuth The horizontal angle is defined with zero degrees set to the north.

South Azimuth The horizontal angle is defined with zero degrees set to the south.

Base—Vertical Angle

Zenith The vertical angle is defined with zero degrees set to the zenith (directly
above). See figure 1 for details.

Vertical The vertical angle is defined with zero degrees set parallel to the ground.
See figure 1 for details.

Nadir The vertical angle is defined with zero degrees set to the nadir (directly
below). See figure 1 for details.

Display—Coordinates

East/North Coordinates is displayed as east value, followed by the north value.

North/East Coordinates is displayed as north value, followed by the east value.

Display—Directions
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Field Description

Azimuth The directions is displayed as azimuth angles. The North axis is zero and
angles are counted clockwise.

Quadrant
The directions is displayed as angles in quadrants. Quadrants are pictured at
figure 2. Angles are counted clockwise within each quadrant.

For example: azimuth angle of 130 degrees will be displayed as S 50° E.

Display

Elevation Tick to display elevations on the screen.

Decimal Places

Linear Defines the number of decimal places for linear units for displaying.

Angular Defines the number of decimal places for angular units for displaying.

Figure 1. Vertical angles zero axis

Figure 2. Quadrants
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Program symbols
The Symbols tab of the Program Settings dialog allows you to configure symbols for project layout.

To configure the symbols layout:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Symbols tab.
3. Make the required configurations. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Symbols tab
Field Description

North Point Symbol Defines the symbol of the north point. You may select it from the drop-
down list.

Point Mark Plot Size Defines point marks size in millimeters for printing.

Clip lines around sym-
bols and point marks

when plotted
Tick it to make line clip around symbols and point marks for printing.

Annotation Symbols Define the symbols to be displayed in annotations for different units. To
change the default symbol, click and select the required font and symbol.

Program coordinate system
The Coordinate System tab of the Program Settings dialog allows you to define default coordinate system pro-
jection for the MAGNET Office.

To edit default coordinate system:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Coordinate System tab.
3. Select the required projection.

Projection details are displayed on the Selected Parameters pane.
4. If you need projection ellipsoid different from the projection default one, in the Projection ellipsoid field

untick the Use default checkbox, and select the required ellipsoid from the drop-down list.
5. If needed, select the datum from the Datum drop-down list.
6. If you need to use a geiod file in conjunction with the defined settings, in the Geoid file group box, click ...

and select the required file.
7. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

To reset the coordinate system settings click Clear Projection.
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Program preferences
The Preferences tab of the Program Settings dialog allows you to configure interface, report and saving settings.

To edit program preferences:
1. In the Settings group of the Settings tab, click the Program Settings icon.

The Program Settings dialog is displayed.
2. Click the Preferences tab.
3. Make the required configurations. Fields are described in the table below.
4. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Preferences tab
Field Description

User Interface

Maximize when opened Tick to maximize the views windows when project is opened or created.

Use enter key to move
to next input field

Tick to move to the next input field, when press Enter, while manually
input data.

If not ticked, use Tab to move to the next input field and press Enter to fin-
ish and apply changes.

Copy selected entity
properties

Tick to copy the properties of the selected entity to apply them to new
entities that are connected.

Display Application
Startup Dialog Tick to turn on the startup dialog.

Select last entity cre-
ated

If ticked, the last created entity will be selected after completing the cre-
ation procedure.

Survey view back-
ground color Defines a background color for the survey view.

Language Select the preferred language for the MAGNET Office.

Display views when
opened Tick to open all existing views in the project when the project is opened.

Display entity detail
when cursor flies over

Tick to display a pop-up window with information about entity when point-
ing on it.

Point Display Size Select the size of point mark for screen displaying.
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Field Description

Automatic Contour on
Import

Tick to automatically create contours from imported data that contains
entities with an elevation.

The prerequisite for this option is to have a code library that matches
those of the imported data. These codes should each be set to “Use in Sur-
face”. In most cases, the codes of the imported points will be unknown.
Preferably, you should set the code named, “Default” to Use in Surface,
so that all imported data with an unknown code or without a code will be
set to Use in Surface. This allows the automatic contour setting to create
both the contours and the DTM.

NOTE
This option works only when using the import utility. Opening a project
will not automatically generate contours from the data.

Drawing view back-
ground color Defines a background color for the drawing view.

Default beep Tick it to make the "ding" sound appear each time you select an object in
the survey view. When not ticked, selection will be quite.

Report

Use external editor Tick to use an external text editor for reports. Select it from the drop-
down list, or click Browse and select the required application.

Save

Enable Save Reminder Tick to enable save reminder. After specified time interval a message win-
dow prompts to save the data.

Enable Auto Save
Recovery Tick to enable automatic saving after each specified time interval.

Create backup on Save
in sub-directory
.\BACKUP

Tick this box to create a backup copy of the project each time you save it.
The backup directory will be automatically created when you save the pro-
ject for the first time.

Roads Specify the maximum and minimum superelevation for curves.

Sewer Plot Select either Drainage or Sewer for plot settings.

Product Updates
When ticked, the MAGNET Office will automatically check whether any
updates are available for application within the interval defined in the
drop-down list.
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Display Settings dialog
The Display Settings dialog allows you to configure data layout in the MAGNET Office.

To open a dialog click one of the three icons from the Settings group of the Settings tab — Display icon,
Grid/Snap icon or Default Properties icon. Each of them will open a specific tab of the dialog, described in the
corresponding sections:

l "General display settings" section below
l "Grid/Snap displaying settings" section on page 601
l "Defaults of the display settings" section on the facing page

General display settings
The Display tab of the Display Settings dialog allows you to configure displaying of entities in the survey view.

To configure display settings:
1. In the Settings group of the Settings tab, click the Display icon.

The Display Settings dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Display tab
Field Description

Entities Display On/Off

Points Tick to display points. If this checkbox is not ticked, than the points, point
marks and symbols will not be displayed.

Point Marks
Tick to display point marks as defined in the Point properties. If ticked, define
the appropriate marks size, by selecting either Small or Large radiobutton.

If this checkbox is unticked, the points will be displayed as the dots.

Point Symbols Tick to display the point symbols, as defined in the Point properties.

Lines Tick to display lines. If this checkbox is unticked, than the lines will not be dis-
played.

Thickness Tick to display lines with thickness as defined in the Line properties.

Line Styles Tick to display lines in style, defined in the Line properties.

Polygon Area Tick to display polygon areas. If this checkbox is unticked, than the polygons,
boundaries, pads and lots will not be displayed.

Text Tick to display text. If this checkbox is unticked, than the text entities will not
be displayed. Annotations will be displayed regardless to this option.
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Field Description

Images
Tick to display images. If this checkbox is unticked, than the images and PDFs
will not be displayed. Background images will be displayed regardless to this
option.

Use Clipping
Tick to ensure the data is clipped to the drawing area of the title block.

NOTE
This option available only when the project is created from a drawing.

Point Information (Display Only)

Number Tick to turn on displaying of the points numbers. You may also use the Point
Number icon.

Elevation Tick to turn on displaying of the points elevations. You may also use the Point
Height icon.

Code Tick to turn on displaying of the points codes. You may also use the Point Code
icon.

Auto hide Tick to automatically hide data, which cannot be read from the project data-
base.

Text Size Define the text size for point information displaying, by selecting the appro-
priate radiobutton.

DTM

Surface Model Tick to display the DTM surface model, selected in the adjacent drop-down
list.

Contours Tick to display the DTM contours, selected in the Surface Model drop-down
list, by using the properties and contour intervals defined for the surface model.

Output

Proposed Scale 1 Defines the intended output plot scale and enables the display of symbols, line
types, and text as they will appear when printed or plotted.

Defaults of the display settings
The Default Properties tab of the Display Settings dialog allows you to configure defaults of the display settings.

To configure default display settings:
1. In the Settings group of the Settings tab, click the Default Properties icon.

The Display Settings dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Default Properties tab
Field Description

Prompt for point
properties

Tick to turn on prompting of the additional attributes when creating new points.
If unticked, only east and north coordinates will be prompted.
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Field Description

Default Point Properties

Code Defines the default code for new points.

Elevation Defines the default elevation activity and value for new points.

Use in Surface Defines whether the new points may be used for DTM creation.

Next Point No Defines the number of the next new point.

Number Annota-
tion Tick to turn on displaying of the point number annotations.

Elevation Annota-
tion Tick to turn on displaying of the point elevation annotations.

Code Annotation Tick to turn on displaying of the point code annotations.

Default Line/Arc/String Properties

Break Line Tick to define the new lines/arcs/strings as break lines.

Lines Annotation Tick to turn on displaying of the lines annotations.

Arcs Annotation Tick to turn on displaying of the arcs annotations.

String Annotation Tick to turn on displaying of the string annotations.

Default Lots Properties

Lots Annotation Tick to turn displaying of the lots annotation.

Default Text Properties

Rotation Defines the default rotation of the text.

Display Settings

Point Numbers Tick to turn on displaying of the point numbers annotation. Only points which
have annotation turned on will be annotated.

Point Elevations Tick to turn on displaying of the point elevations annotation. Only points which
have annotation turned on will be annotated.

Point Codes Tick to turn on displaying of the point codes annotation. Only points which
have annotation turned on will be annotated.

Point Attributes Tick to turn on displaying of the point attributes annotation. Only points which
have annotation turned on will be annotated.

Line Bearings Tick to turn on displaying of the lines bearings. Only lines which have annota-
tion turned on will be annotated.

Line Lengths Tick to turn on displaying of the lines lengths. Only lines which have annota-
tion turned on will be annotated.

Line Annotation
Table

Tick to turn on displaying of the line annotation table. Only lines, which have
appropriate annotation settings, will be displayed in the table.
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Field Description

Lines Attributes Tick to turn on displaying of the lines attributes. Only lines which have annota-
tion turned on will be annotated.

Arc Details Tick to turn on displaying of the arcs details. Only arcs which have annotation
turned on will be annotated.

Arc Annotation
Table

Tick to turn on displaying of the arc annotation table. Only arcs, which have
appropriate annotation settings, will be displayed in the table.

String Details Tick to turn on displaying of the strings details. Only strings which have annota-
tion turned on will be annotated.

Lot Details Tick to turn on displaying of the lots details. Only lots which have annotation
turned on will be annotated.

Polygon Area
Attributes

Tick to turn on displaying of the polygon attributes. Only polygons which have
annotation turned on will be annotated.

Grid/Snap displaying settings
The Grid/Snap tab of the Display Settings dialog allows you to configure displaying of the grid and snap modes.

To configure display settings:
1. In the Settings group of the Settings tab, click the Grid/Snap icon.

The Display Settings dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. When finished, do one of the following:

l Click OK to close the dialog.
l Click another tab to configure more settings.

Fields of the Grid/Snap tab
Field Description

Grid

Show Grid Tick to turn on grid displaying.

Spacing Defines the major X and Y spacing for the grid.

Divisions
The major grid can be divided into sections, displayed with the dashed lines.
These editboxes define the quantity of such sections for each major grid. If the
divisions are set to 1, only the major grid spacing will be displayed.

Origin Defines the grid start position. Note that changing the origin alters only the
grid position, and does not affect to coordinates of the objects.

Color Defines color for major and minor grid lines.

Minimum Display
Interval

Defines a minimum value in pixels between two grid lines. If the grid spacing
is less than the minimum pixel interval, then the divisions will not be dis-
played.

Snap
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Field Description

Snap

Defines the snap tolerance, which is the distance the cursor must be away
from the point before the point is no longer recognized. It is measured by the
size of the cursor. The snap will be to the point closest to the center of the
cursor or to the entity closest to the center. At the normal setting, the cursor is
the standard size. At the 0.5x setting, the cursor is half of the standard size.
At the 2x setting, the cursor is twice the standard size.

Snap Mode

Point

Tick to turn on the nearest point snap mode. The tolerance area is located
around a point, and will be treated as the point itself. It means the following:

l If you try to create a new point within the snap tolerance of the existing
one, MAGNET Office will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line, within the snap tolerance of the existing
point, MAGNET Office will automatically use this point instead.

l If you click within the snap tolerance of a point, it will be selected. If
the wrong entity is selected, do the right-click, and select Next Selec-
tion in the shortcut menu.

End Point

Select to turn on the end point snap mode. The tolerance area is located
around the start and end points of lines, arcs and strings. It means the fol-
lowing:

l If you try to create a new point within the snap tolerance of the existing
start or end point of a line, an arc or a string, MAGNET Office will
treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line within the snap tolerance of the existing
start or end point of a line, an arc, MAGNET Office will automatically
use this point of a line, an arc or a string instead.

l If you click within the snap tolerance of an start or end point of a line,
an arc or a string, it will be selected. If the wrong entity is selected, do
the right-click, and select "Next Selection" in the shortcut menu.

Intersect

Select to turn on the intersection snap mode. The tolerance area is located
around the intersection points of two crossing entities. It means the following:

l If you try to create a new point within the snap tolerance of the existing
intersection point, MAGNET Office will treat it like the duplicate
point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line within the snap tolerance of the existing
intersection point, MAGNET Office will automatically use this inter-
section point instead.

l If you click within the snap tolerance of an intersection point, it will be
selected. If the wrong entity is selected, do the right-click, and select
"Next Selection" in the shortcut menu.
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Field Description

Mid Point

Select to turn on the middle point snap mode. The tolerance area is located
around the middle points of lines, arc or strings. It means the following:

l If you try to create a new point within the snap tolerance of the existing
middle point of a line, an arc or a string, MAGNET Office will treat it
like the duplicate point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line within the snap tolerance of the existing
middle point of a line, an arc or a string, MAGNET Office will auto-
matically use this middle point instead.

l If you click within the snap tolerance of a middle point of a line, an arc
or a string, it will be selected. If the wrong entity is selected, do the
right-click, and select Next Selection in the shortcut menu.

Arc Center

Select to turn on the arc center snap mode. The tolerance area is located
around the arc center points. It means the following:

l If you try to create a new point within the snap tolerance of the existing
arc center point, MAGNET Office will treat it like the duplicate point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line within the snap tolerance of the existing
arc center point, MAGNET Office will automatically use this arc cen-
ter point instead.

l If you click within the snap tolerance of an arc center point, it will be
selected. If the wrong entity is selected, do the right-click, and select
Next Selection in the shortcut menu.

Line

Select to turn on the line snap mode. The tolerance area is located near the
lines. It means the following:

l If you try to create a new point within the snap tolerance of the existing
line or string, MAGNET Office will place this point on the line, or
include in into the string.

l If you try to create the end point of a line, an arc of a string, within the
snap tolerance of the existing line or string, MAGNET Office will auto-
matically this point on the line or the string.

Perpendicular
Select to turn on the perpendicular snap mode. It means that if you try to loc-
ate the end point of a line within the snap tolerance of the existing line of
string, the new line will be created as perpendicular to this line or string.

Grid Point

Select to turn on the grid point snap mode. The tolerance area is located near
the grin lines intersections. It means the following:

l If you try to create a new point within the snap tolerance, it will be loc-
ated exactly at the grid intersection point.

l If you try to create a point, which is the part of entity, for example the
start or the end point of a line within the snap tolerance,
MAGNET Office will place exactly at the grid intersection point.
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Annotation Styles dialog
The Annotation Styles dialog allows you to manage the annotation styles for various entities.

To configure an annotation style:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Make the required configurations. More detailed information about each style may be found in the cor-

responding sections:
l "Point annotation settings" section below
l "Line annotation settings" section on the facing page
l "Arc annotation settings" section on page 607
l "Angle annotation settings" section on page 608
l "Area annotation settings" section on page 609
l "Dimension settings" section on page 611
l "Arrow settings" section on page 611
l "String annotation settings" section on page 612
l "Lot annotation settings" section on page 613
l "Bearing annotation settings" section on page 614
l "Distance annotation settings" section on page 615

3. Click OK to close the dialog

Point annotation settings
The Point Annotation Settings tab of the Annotation Styles dialog allows you to define the style for point annota-
tions. The point annotation is displayed for points which have any of their three point annotation flags selected.
Fields of the tab are described in the table below.

Fields of the Point Annotation Settings tab
Field Description

Text Style

Defines the text style for the point name, code and height annotation. You may
select the style from the drop-down list or modify it, by clicking the Modify
button. For more information about modifying text styles, refer to "Editing text
styles" section on page 123.

Order
Defines the order of the point code and height annotation. The proposed values
are 1, 2 and 3, where 1 is the first attribute. If one of point annotation flags is
not select, than it will not be displayed, and replaced with the next position.

Text Before
Defines the text before the point name, code, height, and note annotation.

For example: "ID=", "Code=", "H=", and "Note:".

Text After
Defines the text after the point name, code and height annotation.

For example – m for "meters" after each point height.
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Field Description

Rotation

Defines the orientation for the point name, code and height annotation. It is dis-
played in the rotation unit settings, as defined in the "Project unit settings" sec-
tion on page 583. Horizontal position of the annotation text corresponds with
the azimuth angle of 90 degrees.

Following If ticked, the annotation, with the Order attribute set to 2 will be placed to the
right of the first attribute, and so on.

Alignment

Height Centered Tick to center annotation around the point.

Horizontal
Select either left or center or right position of the first attribute, regarding to
position of the point.

For example: "Right" will place annotation to the right of the point.

Vertical
Select either above or center or below position of the first attribute, regarding
to position of the point.

For example: "Below" will place annotation below the point.

Number Justification

Defines the justification styles for the heights. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more
information about modifying justification styles, refer to "Editing justification
styles" section on page 125.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the Point Annotation Settings tab.
3. Click Get Default.
4. Select the required library item and click OK. For more information about annotation styles library, refer to

"Annotation styles library" section on page 635.

The settings are copied from the library.

Line annotation settings
The Line Annotation Settings tab of the Annotation Styles dialog allows you to define the style for line annotations.
The line annotation is displayed only for lines, which have annotation flag selected. Fields of the tab are described
in the table below. See picture below for example of the annotation.

Fields of the Line Annotation Settings tab
Field Description

Type
Defines the format of annotation displaying. A line means that annotation will
be displayed relative to the line. Options without a line means, that annotation
will be displayed above or below the line.

Text Before
Distance Type any text to be displayed before distance annotation.
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Field Description

Text After
Distance Type any text to be displayed after distance annotation.

Bearing Settings
Defines the bearing settings. You may select the style from the drop-down list,
or modify it at the Bearing annotation settings tab or in the Annotation styles lib-
rary.

Distance Settings
Defines the distance settings. You may select the style from the drop-down
list, or modify it at the Distance annotation settings tab or in the Annotation
styles library.

Clear Distance Defines the clearance in feet between the line and annotation.

Annotate Defines whether the annotation will be displayed above or below the line.

Spread Bearing Tick to spread bearing along the line.

Show Short Line
Annotation

Tick to display annotations even for too short lines, where annotations don't fit
along the line. If not selected, the line will be annotated only in the short line
table.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the Line Annotation Settings tab.
3. Click Copy From Lib.
4. Select the required library item and click OK. For more information about annotation styles library, refer

to "Annotation styles library" section on page 635.

The settings are copied from the library.

Line annotation example
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Arc annotation settings
The Arc Annotation Settings tab of the Annotation Styles dialog allows you to define the style for arc annotations.
The arc annotation is displayed only for arcs, which have annotation flag selected. Fields of the tab are described
in the table below. See picture below for example of the annotation.

Fields of the "Arc Annotation Settings" tab
Field Description

Arc Radius Tick to display the arc radius annotation. In the Plot Order editbox, type the
order of the arc radius displaying.

Arc Length Tick to display the arc length annotation. In the Plot Order editbox, type the
order of the arc length displaying.

Chord Length Tick to display the chord length annotation. In the Plot Order editbox, type the
order of the chord length displaying.

Chord Bearing Tick to display the chord bearing annotation. In the Plot Order editbox, type
the order of the chord bearing displaying.

Delta Angle

Tick to display the delta angle annotation. In the Plot Order editbox, type the
order of the delta angle displaying.

NOTE
Delta angle is the angle between the arc radius to the start point, and arc
radius to the end point.

Distance Settings
Defines the distance settings for arc radius, arc length and chord length. You
may select the style from the drop-down list or modify it at the Distance annota-
tion settings tab, or in the Annotation styles library.

Bearing Settings
Defines the bearing settings for chord bearing. You may select the style from
the drop-down list or modify it at the Bearing annotation settings tab, or in the
Annotation styles library.

Angle Settings
Defines the angle settings for delta angle. You may select the style from the
drop-down list or modify it at the Angle annotation settings tab, or in the
Annotation styles library.

Text Before Type any text to be displayed before the arc radius, arc length, chord length,
chord bearing and delta angle annotations.

Text After Type any text to be displayed after the arc radius, arc length, chord length,
chord bearing and delta angle annotations.

Along Arc Tick to spread annotations along the arc, one after the other.

Show Short Arc
Annotation

Tick to display annotations even for too short arcs, where annotations don't fit
along the arc. If not selected, the arc will be annotated only in the short line
table.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the Arc Annotation Settings tab.
3. Click Copy From Lib.
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4. Select the required library item and click OK. For more information about annotation styles library, refer
to "Annotation styles library" section on page 635.

The settings are copied from the library.

Example of the arc annotation

Angle annotation settings
The Angle Annotation Settings tab of the Annotation Styles dialog allows you to define the style for angle annota-
tions. Fields of the tab are described in the table below.

Fields of the Angle Annotation Settings tab
Field Description

Name Defines the current angle annotation style. You may select any existing style
from the drop-down list.

Text Style Name

Defines the text style for angle annotations. You may select the style from the
drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.

Round Angles to
nearest seconds Defines the value of angle seconds for rounding angles.

Show Trailing
Zeros Tick to display trailing zeros.
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Field Description

Show Trailing 00
Seconds Tick to display seconds, even if the value is 00.

Show Trailing 00
Minutes Tick to display minutes, even if the value is 00.

Buttons of the Angle Annotation Settings tab
Button Description

New Click it to create a new angle annotation style.

Reset Click it to restore previous angle annotation style settings.

Rename
Click it to rename current angle annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current angle annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Copy From Lib
Click it to copy the annotation settings from the library. For more information
about annotation styles library, refer to "Annotation styles library" section on
page 635.

Area annotation settings
The Area Annotation Settings tab of the Annotation Styles dialog allows you to define the style for lot's area
annotations. Fields of the tab are described in the table below.

Fields of the Area Annotation Settings tab
Field Description

Name Defines the current area annotation style. You may select any existing style
from the drop-down list.

Text Style Name

Defines the text style for area annotations. You may select the style from the
drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.

Use Significant
Figures

Displays the area annotation to the minimum number of significant figures
entered in the appropriate editboxes.

Use Min no of
Decimals

Displays the area annotation to the minimum number of decimal places entered
in the appropriate editboxes for both major and minor units of area.

Round Down Tick to round area value for annotation down, instead of standard rounding
rules. If ticked, specify the rounding tolerance in the appropriate editbox.

Show Trailing
Zeros Tick to display trailing zeros.
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Field Description

Show Trailing
Decimal Tick to display decimals, even if the value is 00.

Squared Symbol Tick to display squared symbol.

Minor Limit Defines the maximum value of the area, which uses the minor units, before
changing to major ones.

Minor Unit Text Defines the label for minor units. The sign of square units will be added auto-
matically.

Major Unit Text Defines the label for major units.

Buttons of the Area Annotation Settings tab
Button Description

New Click it to create a new area annotation style.

Reset Click it to restore previous area annotation style settings.

Rename
Click it to rename current area annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current area annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Copy From Lib
Click it to copy the annotation settings from the library. For more information
about annotation styles library, refer to "Annotation styles library" section on
page 635.

Area annotation example
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Dimension settings
The Dimension Settings tab of the Annotation Styles dialog allows you to configure the style for dimension annota-
tions. Fields of the tab are described in the table below.

Fields of the Dimension Settings tab
Field Description

Dimensioning Defines the format of annotation displaying. A line means that annotation will
be displayed relative to the line.

Distance Settings
Defines the distance settings. You may select the style from the drop-down list
or modify it at the Distance annotation settings tab, or in the Annotation styles
library.

Bearing Settings
Defines the bearing settings. You may select the style from the drop-down list
or modify it at the Bearing annotation settings tab, or in the Annotation styles
library.

Clearance Defines the clearance in feet between the line and the annotation.

Offset Defines the offset between the line and dimension entities.

Leader Line Tick to add extension lines to the dimensions.

Arrow Head

Type Defines the arrow type. You may select it from the drop-down list.

Angle Defines the angle of the arrow head in degrees. You may select it from the
drop-down list or type your own value.

Length Defines the length of the arrow head in millimeters. You may select it from the
drop-down list or type your own value.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the Dimension Settings tab.
3. Click Copy From Lib.
4. Select the required library item and click OK. For more information about annotation styles library, refer to

"Annotation styles library" section on page 635.

The settings are copied from the library.

Arrow settings
The Arrow Settings tab of the Annotation Styles dialog allows you to define the style for arrow annotations. Fields
of the tab are described in the table below.

Fields of the Arrow Settings tab
Field Description

Type Defines the arrow type. You may select it from the drop-down list.
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Field Description

Angle Defines the angle of the arrow head in degrees. You may select it from the
drop-down list or type your own value.

Length Defines the length of the arrow head in millimeters. You may select it from the
drop-down list or type your own value.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the Arrow Settings tab.
3. Click Copy From Lib.
4. Select the required library item and click OK. For more information about annotation styles library, refer

to "Annotation styles library" section on page 635.

The settings are copied from the library.

String annotation settings
The String Annotation Settings tab of the Annotation Styles dialog allows you to turn on/off the annotation of the
strings. Fields of the tab are described in the table below.

Fields of the String Annotation Settings tab
Field Description

Lines Tick to turn on the line annotations.

Arcs Tick to turn on the arc annotations.

Line annotation
table Tick to display the line annotations in the line annotation table.

Arc annotation
table Tick to display the arc annotations in the arc annotation table.

To copy the annotation settings from the library:
1. In the Settings group of the Settings tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Click the String Annotation Settings tab.
3. Click Copy From Lib.
4. Select the required library item and click OK. For more information about annotation styles library, refer

to "Annotation styles library" section on page 635.

The settings are copied from the library.
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Lot annotation settings
The Lot Annotation Settings tab of the Annotation Styles dialog allows you to define the style for lot annotations.
The lot annotation is displayed only for lots, which have annotation flag selected. Fields of the tab are described in
the table below.

Fields of the Lot Annotation Settings tab
Field Description

Lot Name Prefix Defines the prefix, which will be displayed before the lot name.

Lot Name
Tick to display lot name in annotation. You may select the style from the drop-
down list or modify it, by clicking the Modify button. For more information
about modifying text styles, refer to "Editing text styles" section on page 123.

Area Tick to display lot area in the annotation. You may select the style from the
drop-down list.

Angle Tick to display lot angles in the annotation. You may select the style from the
drop-down list.

Lines Tick to display annotations of the lot lines.

Line Annotation
Table Tick to display the line annotations in the line annotation table.

Arcs Tick to display annotations of the lot arcs.

Arc annotation
table Tick to display the arc annotations in the arc annotation table.

Back Boundary Tick to display the annotation for the lot back edge.

Annotation of
Angle Tick to display the annotation of the internal lot angles.

Annotation of Com-
plementary Angle Tick to display the annotation of the external lot angles.
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Lot annotation example

Bearing annotation settings
The Bearing Annotation Settings tab of the Annotation Styles dialog allows you to define the style for bearing
annotations. Fields of the tab are described in the table below.

Fields of the Bearing Annotation Settings tab
Field Description

Name Defines the current bearing annotation style. You may select any existing style
from the drop-down list.

Text Style Name

Defines the text style for bearing annotations. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.

Distance <

Define the rounding of the bearing annotations. It has the following algorithm:
l If the distance is shorter, than the value from the first Distance editbox,
than the bearing annotation will be rounded to the value from the first
Round To editbox.

l If the distance is longer, than the value from the first Distance editbox,
but shorter than the value from the second Distance editbox, than the
bearing annotation will be rounded to the value from the second Round
To editbox.

l If the distance is longer, than the value from the second Distance edit-
box, than the bearing annotation will be rounded to the value from the
third Round To editbox.

Round To
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Field Description

Max Spread
Distance Defines the maximum distance among which annotation may be spread.

Show ' " < 10 with
leading zero

Tick to display minutes and seconds less than 10 with a zero in the first pos-
ition, i.e. 08 instead of 8.

Show Trailing 00
Seconds Tick to display seconds, even if the value is 00.

Show Trailing 00
Minutes Tick to display minutes, even if the value is 00.

Buttons of the Bearing Annotation Settings tab
Button Description

New Click it to create a new bearing annotation style.

Reset Click it to restore previous bearing annotation style settings.

Rename
Click it to rename current bearing annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current bearing annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Copy From Lib
Click it to copy the annotation settings from the library. For more information
about annotation styles library, refer to "Annotation styles library" section on
page 635.

Distance annotation settings
The Distance Annotation Settings tab of the Annotation Styles dialog allows you to define the style for distance
annotations. Fields of the tab are described in the table below.

Fields of the Distance Annotation Settings tab
Field Description

Name Defines the current distance annotation style. You may select any existing
style from the drop-down list.

Text Style Name

Defines the text style for distance annotations. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.
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Field Description

Distance <

Define the rounding of the distance annotations. It has the following algorithm:
l If the distance is shorter, than the value from the first Distance editbox,
than the distance annotation will be rounded to the value from the first
Round To editbox.

l If the distance is longer, than the value from the first Distance editbox,
but shorter than the value from the second Distance editbox, than the dis-
tance annotation will be rounded to the value from the second Round To
editbox.

l If the distance is longer, than the value from the second Distance edit-
box, than the distance annotation will be rounded to the value from the
third Round To editbox.

Round To

Max Spread
Distance Defines the maximum distance among which annotation may be spread.

Show Trailing
Zeros

Tick to display the trailing zeroes up to the number of decimals from the round-
ing settings.

Show Trailing
Decimals Tick to display the trailing decimal points for integers.

Buttons of the Distance Annotation Settings tab
Button Description

New Click it to create a new distance annotation style.

Reset Click it to restore previous distance annotation style settings.

Rename
Click it to rename current distance annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current distance annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Copy From Lib
Click it to copy the annotation settings from the library. For more information
about annotation styles library, refer to "Annotation styles library" section on
page 635.
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Contour Settings dialog
The Contour Settings dialog allows you to manage the contour settings. It contains the list of the existing contour
settings sets. You may create new sets, edit or delete existing sets. Buttons of the dialog are described in the table
below.

Buttons of the Contour Settings dialog
Button Description

New Click it to create a new contour settings set. For more information, refer to
"Creating contour settings sets" section below.

Modify Click it to modify an existing contour settings set. For more information, refer
to "Editing contour settings sets" section on the next page.

Rename
Click it to rename an existing contour settings set.

NOTE
The $$DEFAULT set cannot be renamed.

Delete
Click it to delete an existing contour settings set.

NOTE
The $$DEFAULT set cannot be deleted.

Copy From Lib
Click it to copy the contour settings from the library. For more information
about contour settings library, refer to "Contour settings library" section on
page 655.

OK Click it to close the dialog.

Creating contour settings sets
To create a new set of contour settings:

1. In the Settings group of the Settings tab, click the Contour icon.

The Contour Settings dialog is displayed.
2. Click New.

The Contour Settings dialog is displayed.
3. Make the required configurations. Fields are described in the table below.
4. Click OK.

The new set of contour setting is created.

Fields of the Contour Settings dialog
Field Description

Name Defines the name of the contour settings.

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level
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Field Description

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Editing contour settings sets
To edit an existing set of contour settings:

1. In the Settings group of the Settings tab, click the Contour icon.

The Contour Settings dialog is displayed.
2. Select the required contour settings set, and clickModify.

The Contour Settings dialog is displayed.
3. Make the required configurations. Fields are described in the table below.
4. Click OK.

The set of contour settings is modified.
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Fields of the Contour Settings dialog
Field Description

Name Defines the name of the contour settings.

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.
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Background Images dialog
The Background Images dialog allows you to manage the background images for the survey view.

A background image is a picture, which is placed behind all entities in the project. Its aim is to help the user in
the design of the project – to simplify the creation of the existing objects and understanding of how new object
will interact with them. It may be satellite photo of the area, its map, etc. A background image may be calibrated,
which means that the area of the image will be matched to the entities in the survey view.

The Background Images dialog contains table, with all background images listed. Fields are described in the
table below.

Fields of the Background Images table
Field Description

Image Name Displays the name of the background image.

On Defines whether the background image is active and displayed in the survey
view, or not.

Marks Defines whether the anchor points displayed on the picture or not.

Transparency Defines the transparency of the background picture. 100% is fully transparent
(i.e. invisible) picture, 0% is fully opaque picture.

Buttons of the Background Images dialog
Button Description

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Recalibrate by
Points

Click it to redefine the correspondence between the coordinates of the image
pixels and the grind coordinate system by matching the points in the survey
view with the points in the picture. See Image recalibration by matching points
for details.

Recalibration by
Setting

Click to redefine the anchor point, scale and rotation of the background image.
See "Image recalibration by settings" section on page 622 for details.

Delete Click it to delete the selected background image. To activate this button, click
the number of the required row in the table.

Switch All On Click it to turn on displaying of all the background images.

Switch All Off Click it to turn on displaying of all the background images.

Report Click it to generate a report about selected background images. To activate this
button, click the number of the required row in the table.

Image recalibration by matching points
MAGNET Office allows you to redefine the position of the background image by matching the point entities in
the survey view with the points at the image.
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To recalibrate an image, by adding more matching points:
1. Click one of the following icons:

l The B/G Images icon in the Features group of the View tab,
l The Recalibrate icon in the Raster/Vector group of the Model tab.

The Background Images dialog is displayed.
2. Select the required background picture, by clicking the number of the corresponding row in the table.
3. Click Recalibrate by Points.

The Reposition Image dialog is displayed. It contains table of the calibration points. Fields of the table and
the dialog are described in the table below.

4. Click Add.

The input panel is displayed at the bottom toolbar.
5. Pick the matching point entity. Do one of the following:

l Click the required point in the survey view.
l Type the required point number in the Number editbox at the bottom toolbar, and press Enter.

6. Click the corresponding point on the image.
7. Repeat steps 5 and 6 for all required points.
8. When finished, do the right click, and select Accept the image in the context menu.

The Reposition dialog is displayed, containing newly added matching points.
9. Click Close.

The Background Images dialog is displayed. If needed, perform more configurations. For more information
refer to "Background Images dialog" section on the previous page.

To remove matching points:
1. Click one of the following icons:

l The B/G Images icon in the Features group of the View tab,
l The Recalibrate icon in the Raster/Vector group of the Model tab.

The Background Images dialog is displayed.
2. Select the required background picture, by clicking the number of the corresponding row in the table.
3. Click Recalibrate by Points.

The Reposition Image dialog is displayed. It contains table of the calibration points. Fields of the table and
the dialog are described in the table below.

4. Untick the Incl field for the required points.
5. Click Close.

The message window prompts to update the matching points.
6. Click Yes.

The Background Images dialog is displayed. If needed, perform more configurations. For more information
refer to "Background Images dialog" section on the previous page.

Fields of the Reposition Image table
Field Description

Incl Define if the point included in the picture calibration.

Pt No Displays the number of the point entity.
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Field Description

Easting Displays the East (X) coordinate of the point entity.

Northing Displays the North (Y) coordinate of the point entity.

Image X Displays the X coordinate of the corresponding point at the picture. The origin
of the picture coordinates is the bottom left corner of the picture.

Image Y Displays the Y coordinate of the corresponding point at the picture. The origin
of the picture coordinates is the bottom left corner of the picture.

Residule X Displays the X (East) axis residual of the matching point after calculating the
calibration parameters.

Residule Y Displays the Y (North) axis residual of the matching point after calculating the
calibration parameters.

Fields of the Reposition Image dialog
Field Description

Scale Factor Displays the change of image scale.

Swing Displays the image rotation.

N Shift Displays change of the North (Y) coordinate.

E Shift Displays change of the East (X) coordinate.

Image recalibration by settings
MAGNET Office allows you to redefine the position of the background image by changing the anchor point,
scale and rotation of the background image. The anchor point is a point entity in the survey view, which position
on the picture in known. It is used to define adjoining point between the survey view and background image.

NOTE
Matching point settingswill be ignored after reposition by this settings.

To recalibrate a background picture by settings, you need to pick the anchor point and define the scale and rota-
tion of the image. See the corresponding section for details:

l "Picking the anchor point" section on the facing page
l "Positioning by plotting scale" section on the facing page
l "Position by known line" section on page 624

Fields of the Reposition Image dialog
Field Description

Anchor Point
Displays the East and North coordinates of the background image anchor point.
It is also displays the number of the current anchor point and its coordinates on
the picture. The origin of the picture coordinates is the bottom left corner.

Position by plotting scale

Scale Defines the scale of the background image, based on its original plotting size.
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Field Description

North orientation

Defines the rotation of the background image.

IMPORTANT
This parameter defines the orientation of the picture itself, not
the bearing of any project entity. Rotation is defined around
the anchor point, the positive direction is counterclockwise.

Position by image

Actual Distance Displays the actual distance for the specified line on the picture.

Rotation Defines the bearing for the specified line on the picture.

North Orientation

Defines the rotation of the background image.

IMPORTANT
This parameter defines the orientation of the picture itself, not
the bearing of any project entity. Rotation is defined around
the anchor point, the positive direction is counterclockwise.

Picking the anchor point
The anchor point is a point entity in the survey view, which position on the picture in known. It is used to define
adjoining point between the survey view and background image.

To pick the anchor point:
1. Click one of the following icons:

l The B/G Images icon in the Features group of the View tab,
l The Recalibrate icon in the Raster/Vector group of the Model tab.

The Background Images dialog is displayed.
2. Select the required background picture, by clicking the number of the corresponding row in the table.
3. Click Recalibrate by Settings.

The Reposition Image dialog is displayed. See "Image recalibration by settings" section on the previous
page for details.

4. In the Anchor Point panel, click Pick >>.
5. Pick the anchor point entity. Do one of the following:

l Click the required point in the survey view.
l Type the required point number in the Number editbox at the bottom toolbar, and press Enter.

6. Click the corresponding point on the image.

The anchor point is defined. The Reposition Image dialog is displayed.

Positioning by plotting scale
When position a background image by plotting scale, you need to specify the scale between the actual picture size
and its size in the survey view and rotation of the image.

To scale picture by using the plotting scale:
1. Click one of the following icons:

l The B/G Images icon in the Features group of the View tab,
l The Recalibrate icon in the Raster/Vector group of the Model tab.
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The Background Images dialog is displayed.
2. Select the required background picture, by clicking the number of the corresponding row in the table.
3. Click Recalibrate by Settings.

The Reposition Image dialog is displayed. See "Image recalibration by settings" section on page 622 for
details.

4. If needed, pick the anchor image. See "Picking the anchor point" section on the previous page for details.
5. In the Scale and Rotation panel, select the Position by plotting scale radiobutton.
6. In the Scale editbox, define the scale of the background image.
7. In the North Orientation editbox, define the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.

8. Click OK.

The picture is scaled. The Background Images dialog is displayed.

Position by known line
When position a background image by known line, you need to pick the known line and define its length and bear-
ing.

To scale picture by using the known line:
1. Click one of the following icons:

l The B/G Images icon in the Features group of the View tab,
l The Recalibrate icon in the Raster/Vector group of the Model tab.

The Background Images dialog is displayed.
2. Select the required background picture, by clicking the number of the corresponding row in the table.
3. Click Recalibrate by Settings.

The Reposition Image dialog is displayed. See "Image recalibration by settings" section on page 622 for
details.

4. If needed, pick the anchor image. See "Picking the anchor point" section on the previous page for details.
5. In the Scale and Rotation panel, select the Position by image radiobutton.
6. In the Scale and Rotation panel, click Pick >>.
7. Pick the known line on the picture.
8. In the Actual Distance editbox, define the length of the known line.
9. Define the bearing of the known line. Do one of the following:

l In the Rotation editbox, define the bearing of the known line.
l In the North Orientation editbox, define the rotation of the background image.

TIP

Rotation is defined around the anchor point, the positive direction is counterclockwise.

10. Click OK.

The picture is scaled. The Background Images dialog is displayed.
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Annotation Table Settings dialog
The "Annotation Table Settings" dialog allows you to configure the parameters of the line and arc annotation
tables. To open the dialog, do the double click inside the line or arc annotation table. Fields and buttons of the dia-
log are described below.

Fields of the "Annotation Table Settings" dialog
Field Description

Insertion Point Defines the X (East) and Y (North) coordinates of the table bottom left corner.

Columns Defines the quantity of column sets.

Text Style Defines the text style, used in the table.

ID Text Style Defines the text style, used for line/arc marks.

Sorted by Select the parameter for table data sorting.

Ascending Tick to sort the table data in the ascending order. If unticked, data will be sor-
ted in the descending order.

Display Tick to display the line/arc annotation table in the survey view. If unticked, the
line/arc annotation table will be invisible.

Buttons of the "Annotation Table Settings" dialog
Button Description

Reset Click it to restore the default settings.

Renumber Click it to renumber the line and arc marks, starting from 1.

Refresh Click it to refresh the line/arc annotation table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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DTM Settings dialog
The DTM Settings dialog allows you to edit an existing DTM. It appears during the creation of a new DTM. 

To edit a DTM:
1. In the DTM Settings group of the Surface tab, click the DTM Settings icon.

The DTM dialog is displayed.
2. Select the required DTM and click Edit.

The DTM Settings dialog is displayed.
3. Set up the required properties at each tab of the dialog. Fields are described in the tables below.
4. Click OK.

Fields of the General tab of the DTM Settings dialog
Field Description

Name Displays the name of the DTM.

Boundary

Num Points Displays the quantity of the points in the DTM.

Highest Displays the highest elevation in the DTM.

Lowest Displays the lowest elevation in the DTM.

Ave. Elev Displays the average elevation in the DTM.

Plan Area Displays the horizontal area of the DTM.

Surface Area Displays the full surface area, including slopes.

Description Defines short DTM description.

Display

Mesh When ticked, the created triangular mesh will be displayed in the survey
view. Select the required color form the drop-down list.

Contour When ticked, the contours will be displayed in the survey view.

Color Fill
When ticked, the shadings and patterning will be colored. Click Settings to
define the required colors. See "Color Fill Settings dialog" section on page 628
for details.

Slope When ticked, the slopes will be colored. Click Settings to configure it. See
"Slope dialog" section on page 628 for details.

Fields of the Contour tab of the DTM Settings dialog
Field Description

Display

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.
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Field Description

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Color

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it. See "Color Range Settings dialog" section on the next page for details.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

You may use the contour settings library to load the pre-configured contour settings.

To load contour library settings:
1. At the Contour tab of the DTM Settings dialog, click Load Library Settings.

The selection dialog is displayed.
2. Select the required library settings, and click OK.

To save current contour settings to the library:
1. At the Contour tab of the DTM Settings dialog, click Save Library Settings.

The selection dialog is displayed.
2. Select existing library settings from the drop-down list, or type the name of a new library.
3. Click OK.

Fields of the Contour Label tab of the DTM Settings dialog
Field Description

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.
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Field Description

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Color Fill Settings dialog
The Color Fill Settings dialog allows you to configure gradual change in color for filling boundaries from the
highest to the lowest elevation.

To configure the color range:
1. In the Color Fill group box, from the General tab of the DTM Settings dialog, click Settings.

The Fill Color dialog is displayed.
2. In the High Level editbox, specify the highest value of the height range.
3. In the Low Level editbox, specify the lowest value of the height range.
4. In the Datum Level editbox, specify the level of the datum.
5. Select the required colors from the appropriate drop-down lists.
6. Click OK.

Color Range Settings dialog
The Color Range Settings dialog allows you to configure gradual change in color for each minor contour interval
from the highest to the lowest contour.

To configure the color range:
1. In the Color group box, from the Contour tab of the DTM Settings dialog, click Define.

The Color Range Settings dialog is displayed.
2. In the High Value editbox, specify the highest value of the height range.
3. In the Low Value editbox, specify the lowest value of the height range.
4. In the Interval editbox, specify the interval of color changing.
5. Click OK.

Slope dialog
The Slope dialog allows you to analyze the slopes of the individual triangles. You can allocate different colors to
the slope ranges with the option to set the shape of the arrows that display the slopes.

To configure the slope:
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1. In the Slope group box, from the General tab of the DTM Settings dialog, click Settings.

The Slope dialog is displayed.
2. From the Arrow Head drop-down list, select the required arrow head shape.
3. From the Arrow Angle drop-down list, select the required angle of the arrow head, or specify custom value.
4. From the Arrow Length drop-down list, select the required length of the arrow, or specify custom value.
5. If needed, tick the Drawing Units checkbox, to plot the slope units.
6. In the table, specify consecutive steps for the slope range with an appropriate color for each slope
7. Click OK.
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MAGNET Office Libraries
The libraries in the MAGNET Office are the sets of various configurations, which are stored in the program dir-
ectory. These sets are global and may be used in any project, created in the MAGNET Office.

Description of the existing libraries may be found in the appropriate sections:
l "Contour settings library" section on page 655
l "Colors library" section below
l "Text styles library" section on the facing page
l "Justification styles library" section on page 632
l "Annotation styles library" section on page 635
l "Legal description templates library" section on page 646
l "Symbol library" section on page 648
l "Line styles library" section on page 649
l "Plot settings library" section on page 650
l "Contour settings library" section on page 655
l "Genio translation tables library" section on page 658
l "AutoCAD layer definition tables library" section on page 660
l "AutoCAD layer translation tables library" section on page 663
l "Sewer library" section on page 666
l "Drainage library" section on page 668

Colors library
The Colors library allows you to manage the MAGNET Office color palette. This palette is global, and available
for all projects.

To create a new color:
1. In the Library group of the Library tab, click the Colors icon.

The Create Custom Colors dialog is displayed.
2. In the Custom Colors palette select a cell for the new color.
3. Do one of the following:

l Configure the new color by using the color palette and shade bar.
l Manually enter the required data in the "Hue", "Sat", "Lum", "Red", "Green" and "Blue" editboxes.

4. Click Add to Custom Colors.

The configured color is added to the selected cell.
5. Click OK.

To import the current palette to the color file, click Import.

To load previously configuration from the external file, click Export.
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Text styles library
Text styles define layout of all textual data in the MAGNET Office – point numbers, entities annotations, etc. The
settings, configured in the library are global, and available for all projects.

To access the text styles library, in the Library group of the Library tab, click the Text Styles icon. The
Text styles dialog appears after clicking. It contains the list of the existing text styles and font, size, color and
formatting for each style. Buttons of the dialog are described in the table below.

Buttons of the Text Style dialog
Button Description

New Click it to create a new text style. For more information refer to "Creating text
styles" section below.

Modify Click it to edit an existing text style. For more information refer to "Editing text
styles" section below.

Rename
Click it to rename an existing text style.

NOTE
The $$DEFAULT text style cannot be renamed.

Delete
Click it to delete an existing text style.

NOTE
The $$DEFAULT text style cannot be deleted.

Import Click it to load a text style from an external file.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Creating text styles
To create a new text style:

1. In the Library group of the Library tab, click the Text Styles icon.

The Text Style dialog is displayed.
2. Click New.

The Text Style dialog is displayed.
3. In the Name editbox, type the name of the new text style.
4. From the Font drop-down list, select the font.
5. From the Size drop-down list, select the font size, or type your own value.
6. From the Color drop-down list, select the font color, or create a custom color for font. For more inform-

ation, refer to "Custom Colors icon" section on page 127.
7. In the Style panel define the bold, italic and underscore formatting.
8. Review your font style in the Preview field. If needed, change the font parameters.
9. Click OK.

The text style is created.

Editing text styles
To edit an existing text style:
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1. In the Library group of the Library tab, click the Text Styles icon.

The Text Style dialog is displayed.
2. Select text style to be edited.
3. ClickModify.

The Text Style dialog is displayed.
NOTE
You cannot change the name of the text style in this dialog. To rename a text style, use theRename but-
ton of themain dialog.

4. From the Font drop-down list, select the font.
5. From the Size drop-down list, select the font size, or type your own value.
6. From the Color drop-down list, select the font color, or create a custom color for font. For more inform-

ation, refer to "Custom Colors icon" section on page 127.
7. In the Style panel define the bold, italic and underscore formatting.
8. Review your font style in the Preview field. If needed, change the font parameters.
9. Click OK.

The parameters of the text style are changed.

Justification styles library
Justification style defines the format of the number and its decimal precision. It controls the appearance of the
numerical values used in such text items as height annotation, grid values, chainage, and levels in road drawings.
The settings, configured in the library are global, and available for all projects.

To access the text styles library, in the Library group of the Library tab, click the Justification icon. The Jus-
tification Style dialog appears after clicking. It contains the list of the existing justification styles with their para-
meters. Buttons of the dialog are described in the table below.

Buttons of the Justification Style dialog
Button Description

New Click it to create a new justification style. For more information refer to Creat-
ing justification styles.

Modify Click it to edit an existing justification style. For more information refer to Edit-
ing justification styles.

Rename
Click it to rename an existing justification style.

NOTE
The $$DEFAULT justification style cannot be renamed.

Delete
Click it to delete an existing justification style.

NOTE
The $$DEFAULT justification style cannot be deleted.

OK Click it to save changes and close the dialog.

Cancel Click it to close the dialog without saving changes.
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Creating justification styles
To create a new library justification style:

1. In the Library group of the Library tab, click the Justification icon.

The Justification Style dialog is displayed.
2. Click New.

The Number Style dialog is displayed.
3. In the Name editbox, type the name of the new justification style.
4. In the Width editbox, type the number of digits, used in the style. Note that it includes the characters used

for the decimal point and decimal figures
5. In the Precision editbox, type the number of decimal places.
6. Select either left of right justified position.
7. Configure the following parameters:

l Zero Padding – tick to fill the empty character spaces with zeroes.
l Space Fill – tick to make a number right-justified with prefixed spaces to make up the number of
characters in the width.

l Display Decimal – tick to display the decimal point.
l Rounding – tick to round a number to the precision setting.

8. Click OK.

The new justification style is created.

Editing justification styles
To edit an existing justification style:

1. In the Library group of the Library tab, click the Justification icon.

The Justification Style dialog is displayed.
2. Select justification style to be edited.
3. ClickModify.

The Number Style dialog is displayed.
NOTE
You cannot change the name of the justification style in this dialog. To rename a justification style, use the
Rename button of the "Number Justification Style" dialog.

4. In the Precision editbox, type the number of decimal places.
5. Select either left of right justified position.
6. Configure the following parameters:

l Zero Padding – tick to fill the empty character spaces with zeroes.
l Space Fill – tick to make a number right-justified with prefixed spaces to make up the number of
characters in the width.

l Display Decimal – tick to display the decimal point.
l Rounding – tick to round a number to the precision setting.

7. Click OK.

The parameters of the justification style are changed.
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NOTE
These changeswill apply only to justification styles in the current project, and don't affect to the styles in
the Justification styles library.
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Annotation styles library
The Annotation Styles library allows you to manage the annotation styles for various entities. These styles are
global and available in all projects.

To configure annotation styles library:
1. In the Library group of the Library tab, click the Annotation icon.

The Annotation Styles dialog is displayed.
2. Make the required configurations. More detailed information about each style may be found in the cor-

responding sections:
l "Point annotation settings" section below
l "Line annotation settings" section on the next page
l "Arc annotation settings" section on page 637
l "Angle annotation settings" section on page 638
l "Area annotation settings" section on page 639
l "Dimension settings" section on page 640
l "Arrow settings" section on page 641
l "String annotation settings" section on page 641
l "Lot annotation settings" section on page 642
l "Bearing annotation settings" section on page 643
l "Distance annotation settings" section on page 644

3. Click OK to close the dialog

Point annotation settings
The Point Annotation Settings tab of the Annotation styles library allows you to define the style for point annota-
tions. The point annotation is displayed for points which have any of their three point annotation flags selected.
Description of the fields and buttons may be found in the table below.

Fields of the Point Annotation Settings tab
Field Description

Name Defines the name the point annotation settings set.

Text Style

Defines the text style for the point name, code and height annotation. You may
select the style from the drop-down list or modify it, by clicking the Modify but-
ton. For more information about modifying text styles, refer to "Editing text
styles" section on page 123.

Order
Defines the order of the point code and height annotation. The proposed values
are 1, 2 and 3, where 1 is the first attribute. If one of point annotation flags is
not select, than it will not be displayed, and replaced with the next position.

Text Before
Defines the text before the point name, code and height annotation.

For example: "ID=", "Code=" and "H=".

Text After
Defines the text after the point name, code and height annotation.

For example – m for "meters" after each point height.
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Field Description

Rotation

Defines the orientation for the point name, code and height annotation. It is dis-
played in the rotation unit settings, as defined in the "Project unit settings" sec-
tion on page 583. Horizontal position of the annotation text corresponds with
the azimuth angle of 90 degrees.

Following If ticked, the annotation, with the Order attribute set to 2 will be placed to the
right of the first attribute, and so on.

Alignment

Height Centered Tick to center annotation around the point.

Horizontal
Select either left or center or right position of the first attribute, regarding to
position of the point.

For example: "Right" will place annotation to the right of the point.

Vertical
Select either above or center or below position of the first attribute, regarding
to position of the point.

For example: "Below" will place annotation below the point.

Number Jus-
tification

Defines the justification styles for the heights. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying justification styles, refer to "Editing justification styles"
section on page 125.

Buttons of the Point Annotation Settings tab
Button Description

New Click it to create a new point annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the point annotation settings set.

Delete Click it to delete the point annotation settings set.

Line annotation settings
The Line Annotation Settings tab of the Annotation styles library allows you to define the style for line annota-
tions. The line annotation is displayed only for lines, which have annotation flag selected. Description of the
fields and buttons may be found in the table below.

Fields of the Line Annotation Settings tab
Field Description

Name Defines the name the line annotation settings set.

Type
Defines the format of annotation displaying. A line means that annotation will
be displayed relative to the line. Options without a line means, that annotation
will be displayed above or below the line.

636



Arc annotation settings

Field Description

Text Before
Distance Type any text to be displayed before distance annotation.

Text After
Distance Type any text to be displayed after distance annotation.

Bearing Settings
Defines the bearing settings. You may select the style from the drop-down list,
or modify it at the Bearing annotation settings tab or in the Annotation styles lib-
rary.

Distance Settings
Defines the distance settings. You may select the style from the drop-down
list, or modify it at the Distance annotation settings tab or in the Annotation
styles library.

Clear Distance Defines the clearance in feet between the line and annotation.

Annotate Defines whether the annotation will be displayed above or below the line.

Spread Bearing Tick to spread bearing along the line.

Show Short Line
Annotation

Tick to display annotations even for too short lines, where annotations does not
fit along the line. If not selected, the line will be annotated only in the short
line table.

Buttons of the Line Annotation Settings tab
Button Description

New Click it to create a new line annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the line annotation settings set.

Delete Click it to delete the line annotation settings set.

Arc annotation settings
The Arc Annotation Settings tab of the Annotation styles library allows you to define the style for arc annotations.
The arc annotation is displayed only for arcs, which have annotation flag selected. Description of the fields and
buttons may be found in the table below.

Fields of the Arc Annotation Settings tab
Field Description

Name Defines the name of the arc annotation settings set.

Arc Radius Tick to display the arc radius annotation. In the Plot Order editbox, type the
order of the arc radius displaying.

Arc Length Tick to display the arc length annotation. In the Plot Order editbox, type the
order of the arc length displaying.

Chord Length Tick to display the chord length annotation. In the Plot Order editbox, type the
order of the chord length displaying.

Chord Bearing Tick to display the chord bearing annotation. In the Plot Order editbox, type
the order of the chord bearing displaying.
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Field Description

Delta Angle

Tick to display the delta angle annotation. In the Plot Order editbox, type the
order of the delta angle displaying.

NOTE
Delta angle is the angle between the arc radius to the start point, and arc
radius to the end point.

Distance Settings
Defines the distance settings for arc radius, arc length and chord length. You
may select the style from the drop-down list or modify it at the Distance annota-
tion settings tab.

Bearing Settings Defines the bearing settings for chord bearing. You may select the style from
the drop-down list or modify it at the Bearing annotation settings tab.

Angle Settings Defines the angle settings for delta angle. You may select the style from the
drop-down list or modify it at the Angle annotation settings tab.

Text Before Type any text to be displayed before the arc radius, arc length, chord length,
chord bearing and delta angle annotations.

Text After Type any text to be displayed after the arc radius, arc length, chord length,
chord bearing and delta angle annotations.

Along Arc Tick to spread annotations along the arc, one after the other.

Show Short Arc
Annotation

Tick to display annotations even for too short arcs, where annotations does not
fit along the arc. If not selected, the arc will be annotated only in the short line
table.

Buttons of the Arc Annotation Settings tab
Button Description

New Click it to create a new arc annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the arc annotation settings set.

Delete Click it to delete the arc annotation settings set.

Angle annotation settings
The Angle Annotation Settings tab of the Annotation styles library allows you to define the style for angle annota-
tions. Description of the fields and buttons may be found in the tables below.

Fields of the Angle Annotation Settings tab
Field Description

Name Defines the current angle annotation style.

Text Style Name

Defines the text style for angle annotations. You may select the style from the
drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.
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Field Description

Round Angles to
nearest seconds Defines the value of angle seconds for rounding angles.

Show Trailing
Zeros Tick to display trailing zeros.

Show Trailing 00
Seconds Tick to display seconds, even if the value is 00.

Show Trailing 00
Minutes Tick to display minutes, even if the value is 00.

Buttons of the Angle Annotation Settings tab
Button Description

New Click it to create a new angle annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the angle annotation settings set.

Delete Click it to delete the angle annotation settings set.

Area annotation settings
The Area Annotation Settings tab of the Annotation styles library allows you to define the style for lot's area
annotations. Description of the fields and buttons may be found in the tables below.

Fields of the Area Annotation Settings tab
Field Description

Name Defines the current area annotation style. You may select any existing style
from the drop-down list.

Text Style Name

Defines the text style for area annotations. You may select the style from the
drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.

Use Significant
Figures

Displays the area annotation to the minimum number of significant figures
entered in the appropriate editboxes.

Use Min no of
Decimals

Displays the area annotation to the minimum number of decimal places entered
in the appropriate editboxes for both major and minor units of area.

Round Down Tick to round area value for annotation down, instead of standard rounding
rules. If ticked, specify the rounding tolerance in the appropriate editbox.

Show Trailing
Zeros Tick to display trailing zeros.

Show Trailing
Decimal Tick to display decimals, even if the value is 00.

Squared Symbol Tick to display squared symbol.
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Field Description

Minor Limit Defines the maximum value of the area, which uses the minor units, before
changing to major ones.

Minor Unit Text Defines the label for minor units. The sign of square units will be added auto-
matically.

Major Unit Text Defines the label for major units.

Buttons of the Area Annotation Settings tab
Button Description

New Click it to create a new area annotation style.

Reset Click it to restore previous area annotation style settings.

Rename
Click it to rename current area annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current area annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Dimension settings
The Dimension Settings tab of the Annotation styles library allows you to configure the style for dimension annota-
tions. Description of the fields and buttons may be found in the tables below.

Fields of the Dimension Settings tab
Field Description

Name Defines the name of the dimension settings set.

Dimensioning Defines the format of annotation displaying. A line means that annotation will
be displayed relative to the line.

Distance Settings Defines the distance settings. You may select the style from the drop-down list
or modify it at the Distance annotation settings tab.

Bearing Settings Defines the bearing settings. You may select the style from the drop-down list
or modify it at the Bearing annotation settings tab.

Clearance Defines the clearance in feet between the line and the annotation.

Offset Defines the offset between the line and dimension entities.

Leader Line Tick to add extension lines to the dimensions.

Arrow Head

Type Defines the arrow type. You may select it from the drop-down list.
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Field Description

Angle Defines the angle of the arrow head in degrees. You may select it from the
drop-down list or type your own value.

Length Defines the length of the arrow head in millimeters. You may select it from the
drop-down list or type your own value.

Buttons of the Dimension Settings tab
Button Description

New Click it to create a new dimension settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the dimension settings set.

Delete Click it to delete the dimension settings set.

Arrow settings
The Arrow Settings tab of the Annotation styles library allows you to define the style for arrow annotations.
Description of the fields and buttons may be found in the tables below.

Fields of the Arrow Settings tab
Field Description

Name Defines the name of the arrow settings set.

Type Defines the arrow type. You may select it from the drop-down list.

Angle Defines the angle of the arrow head in degrees. You may select it from the
drop-down list or type your own value.

Length Defines the length of the arrow head in millimeters. You may select it from the
drop-down list or type your own value.

Buttons of the Arrow Settings tab
Button Description

New Click it to create a new arrow settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the arrow settings set.

Delete Click it to delete the arrow settings set.

String annotation settings
The String Annotation Settings tab of the Annotation styles library allows you to turn on/off the annotation of the
strings. Description of the fields and buttons may be found in the table below.
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Fields of the String Annotation Settings tab
Field Description

Name Defines the name of the string annotation settings set.

Lines Tick to turn on the line annotations.

Arcs Tick to turn on the arc annotations.

Line annotation
table Tick to display the line annotations in the line annotation table.

Arc annotation
table Tick to display the arc annotations in the arc annotation table.

Buttons of the String Annotation Settings tab
Button Description

New Click it to create a new string annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the string annotation settings set.

Delete Click it to delete the string annotation settings set.

Lot annotation settings
The Lot Annotation Settings tab of the Annotation styles library allows you to define the style for lot annotations.
The lot annotation is displayed only for lots, which have annotation flag selected. Description of the fields may be
found in the table below.

Fields of the Lot Annotation Settings tab
Field Description

Lot Name Prefix Defines the prefix, which will be displayed before the lot name.

Lot Name
Tick to display lot name in annotation. You may select the style from the drop-
down list or modify it, by clicking the Modify button. For more information
about modifying text styles, refer to "Editing text styles" section on page 123.

Area Tick to display lot area in the annotation. You may select the style from the
drop-down list.

Angle Tick to display lot angles in the annotation. You may select the style from the
drop-down list.

Lines Tick to display lot lines in the annotation.

Line Annotation
Table Tick to display the line annotations in the line annotation table.

Arcs Tick to display lot arcs in the annotation.
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Field Description

Arc annotation
table Tick to display the arc annotations in the arc annotation table.

Back Boundary Tick to display the annotation for the lot back boundary.

Annotation of
Angle Tick to display the annotation of the lot angles.

Annotation of Com-
plementary Angle Tick to display complementary or supplementary angles.

Buttons of the Lot Annotation Settings tab
Button Description

New Click it to create a new lot annotation settings set.

Reset Click it to discard changes and reset settings to the last saved ones.

Rename Click it to rename the lot annotation settings set.

Delete Click it to delete the lot annotation settings set.

Bearing annotation settings
The Bearing Annotation Settings tab of the Annotation styles library allows you to define the style for bearing
annotations. Description of the fields and buttons may be found in the tables below.

Fields of the Bearing Annotation Settings tab
Field Description

Name Defines the current bearing annotation style. You may select any existing style
from the drop-down list.

Text Style Name

Defines the text style for bearing annotations. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.

Distance <

Define the rounding of the bearing annotations. It has the following algorithm:
l If the distance is shorter, than the value from the first Distance editbox,
than the bearing annotation will be rounded to the value from the first
Round To editbox.

l If the distance is longer, than the value from the first Distance editbox,
but shorter than the value from the second Distance editbox, than the
bearing annotation will be rounded to the value from the second Round
To editbox.

l If the distance is longer, than the value from the second Distance edit-
box, than the bearing annotation will be rounded to the value from the
third Round To editbox.

Round To

Max Spread
Distance Defines the maximum distance among which annotation may be spread.
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Field Description

Show < 10 with
leading zero

Tick to display minutes and seconds less than 10 with a zero in the first pos-
ition, i.e. 08 instead of 8.

Show Trailing 00
Seconds Tick to display seconds, even if the value is 00.

Show Trailing 00
Minutes Tick to display minutes, even if the value is 00.

Buttons of the Bearing Annotation Settings tab
Button Description

New Click it to create a new bearing annotation style.

Reset Click it to restore previous bearing annotation style settings.

Rename
Click it to rename current bearing annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current bearing annotation style.

NOTE
The $$DEFAULT style cannot be deleted.

Distance annotation settings
The Distance Annotation Settings tab of the Annotation styles library allows you to define the style for distance
annotations. Description of the fields and buttons may be found in the tables below.

Fields of the Distance Annotation Settings tab
Field Description

Name Defines the current distance annotation style. You may select any existing
style from the drop-down list.

Text Style Name

Defines the text style for distance annotations. You may select the style from
the drop-down list or modify it, by clicking the Modify button. For more inform-
ation about modifying text styles, refer to "Editing text styles" section on
page 123.
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Field Description

Distance <

Define the rounding of the distance annotations. It has the following algorithm:
l If the distance is shorter, than the value from the first Distance editbox,
than the distance annotation will be rounded to the value from the first
Round To editbox.

l If the distance is longer, than the value from the first Distance editbox,
but shorter than the value from the second Distance editbox, than the dis-
tance annotation will be rounded to the value from the second Round To
editbox.

l If the distance is longer, than the value from the second Distance edit-
box, than the distance annotation will be rounded to the value from the
third Round To editbox.

Round To

Max Spread
Distance Defines the maximum distance among which annotation may be spread.

Show Trailing
Zeros

Tick to display the trailing zeroes up to the number of decimals from the round-
ing settings.

Show Trailing
Decimals Tick to display the trailing decimal points for integers.

Buttons of the Distance Annotation Settings tab
Button Description

New Click it to create a new distance annotation style.

Reset Click it to restore previous distance annotation style settings.

Rename
Click it to rename current distance annotation style.

NOTE
The $$DEFAULT style cannot be renamed.

Delete
Click it to delete current distance annotation style.

NOTE
The $$DEFAULT style cannot be deleted.
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Legal description templates library
The legal description templates define the automatically generated text, based on the entities from the survey
view, which describes these entities.

To access the legal description templates library, in the Library group of the Library tab, click the Legal Descrip-
tion icon. The Legal Description Templates Library dialog appears after clicking. It contains the list of the exist-
ing templates. Buttons of the dialog are described in the table below.

Buttons of the Legal Description Templates Library dialog
Button Description

New Click it to create a new legal description template. For more information refer
to "Creating legal description templates" section below.

Modify Click it to edit an existing legal description template. For more information
refer to "Editing legal description templates" section on the facing page.

Rename
Click it to rename an existing legal description template.

NOTE
The $$DEFAULT template cannot be renamed.

Delete
Click it to delete an existing legal description template.

NOTE
The $$DEFAULT template cannot be deleted.

Import Click it to load the legal description template from an external XML (*.xml)
file.

Export Click it to save the legal description template to an external XML (*.xml) file.

Cancel Click it to close the dialog.

Creating legal description templates
To create a new legal description template:

1. In the Library group of the Library tab, click the Legal Description icon.

The Legal Description Template Library dialog is displayed.
2. Click New.

The Template Name dialog is displayed.
3. Type the name of the new template and click OK.

The Legal Description Template Design dialog is displayed.
4. From the Template Components list, select the required template component.
5. In the Component Content field, type the required text.
6. Repeat for all required template components.
7. Click Save.
8. Click Close to close the dialog.

To import the legal description template from an external XML (*.xml) file, click Import.

To save the created description under a new name:
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1. Click Save As.

The Template Name dialog is displayed.
2. Type the name of the new template and click OK.
3. Click Close.

Editing legal description templates
To edit an existing legal description template:

1. In the Library group of the Library tab, click the Legal Description icon.

The Legal Description Template Library dialog is displayed.
2. Select the required template and click Edit.

The Legal Description Template Design dialog is displayed.
3. From the Template Components list, select the required template component.
4. In the Component Content field, type the required text.
5. Repeat for all required template components.
6. Click Save.
7. Click Close to close the dialog.

To import the legal description template from an external XML (*.xml) file, click Import.

To save the edited template under a new name:
1. Click Save As.

The Template Name dialog is displayed.
2. Type the name of the new template and click OK.
3. Click Close.
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Symbol library
Symbols are used for marking out points, which represent various entities in the survey view.

To access the symbols library, in the Library group of the Library tab, click the Symbols icon. The Symbols dia-
log appears after clicking. It contains the list of the existing symbols. Buttons of the dialog are described in the
table below.

Buttons of the Symbols dialog
Button Description

New Click it to create a symbol.

Modify Click it to edit an existing symbol.

Rename Click it to rename an existing symbol.

Delete Click it to delete an existing symbol.

Import Click it to load the symbol from an external AutoCAD drawing (*.dwg) or
CivilCAD Symbol (*.bcd) file.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog.
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Line styles library
Line styles are used for marking the lines, which represent various entities in the survey view, by varying the lay-
out of different lines.

To access the line styles library, in the Library group of the Library tab, click the Line Styles icon. The Line
Styles dialog appears after clicking. It contains the list of the existing line styles. Buttons of the dialog are
described in the table below.

Buttons of the Line Styles dialog
Button Description

New Click it to create a line style.

Modify Click it to edit an existing line style.

Rename Click it to rename an existing line style.

Delete Click it to delete an existing line style.

Import Click it to load the line style from an external CivilCAD line style (*.blm) file.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog.
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Plot settings library
The plot settings library contains global sets of plot settings, which are available in all projects. Note that if you
change library settings in one project, they will change for all projects.

The library is managed by the Library Plot Settings dialog. It contains the list of the existing plot settings sets.
You may create new sets, edit or delete existing sets.

To open the dialog, in the Output group of the Library tab, click the Plot Settings icon. Buttons of the dialog are
described in the table below.

The plot settings, both new and existing ones, are configured in the Library - Plot Settings dialog. It appears after
clicking New orModify buttons, and contains seven tabs, described in appropriate section:

l "General tab" section on the facing page
l "Survey Object tab" section on the facing page
l "Grid tab" section on the facing page
l "Contour tab" section on page 653
l "Annotations tab" section on page 653
l "Annotation Table Settings tab" section on page 653

To create a new set of plot setting:
1. In the Output group of the Library tab, click the Plot Settings icon.

The Library Plot Settings dialog is displayed.
2. Click New.

The Library - Plot Settings dialog is displayed.
3. Make the required configurations on each tab. Detailed descriptions may be found in the appropriate sec-

tions, listed above.
4. Click OK.

The new plot settings set is created.

To edit an existing set of plot settings:
1. In the Output group of the Library tab, click the Plot Settings icon.

The Library Plot Settings dialog is displayed.
2. Select the required settings set and clickModify.

The Library - Plot Settings dialog is displayed.
3. Make the required configurations on each tab. Detailed descriptions may be found in the appropriate sec-

tions, listed above.
4. Click OK.

The new plot settings set is edited.

Buttons of the Library Plot Settings dialog
Button Description

New Click it to create a new library set of contour settings.

Modify Click it to modify an existing library set of contour settings.
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Button Description

Rename
Click it to rename an existing library set of contour settings.

NOTE
The $$DEFAULT set cannot be renamed.

Delete
Click it to delete an existing library set of contour settings.

NOTE
The $$DEFAULT set cannot be deleted.

OK Click it to close the dialog.

General tab
The General tab of the Library - Plot Settings dialog allows you to configure the general plotting settings. Fields
of the tab are described in the table below.

Fields of the General tab of the Library - Plot Settings dialog
Field Description

Name Defines the name of the plot settings set.

Entities Defines the entities, which will be plotted, when using this set. Tick the
required entities checkboxes to add them to plot.

Clipping When ticked, the entities outside of the border will be clipped to prevent them
from being plotted.

Display Word
Coordinate

Tick to display real world coordinates of the points. Otherwise, you cannot
identify point coordinates.

NOTE
The coordinates can only be displayed and cannot be edited in any way in
the plot window.

Point Mark Plot
Size Defines a size for the point mark plotting.

Survey Object tab
The Survey Object tab of the Library - Plot Settings dialog allows you to configure the appearance of survey
objects in plotting.

Tick the required objects to add them to plotting.

Grid tab
The Grid tab of the Library - Plot Settings dialog allows you to configure the appearance and configuration of
grid, when plotting. Fields of the tab are described in the table below.
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Fields of the General tab of the Library - Plot Settings dialog
Fields Description

Grid Marker

Defines the appearance of grid, when plotting. You may select one of the fol-
lowing options:

l Full Grid – full grid will be plotted.
l Grid Ticks at Border – only ticks of grid lines will be plotted at page bor-
ders.

l Grid Ticks and Crosses – ticks of grid lines at page borders and crosses
at grid lines intersections will be plotted.

Spacing

Major Defines the major X and Y spacing, grid lines color and style.

Divisions

The major grid can be divided into sections, displayed with the dashed lines.
The X and Y editboxes define the quantity of such sections for each major grid.
If the divisions are set to 1, only the major grid spacing will be displayed. Also
defines division lines color and style.

Origin Defines the grid start position. Note that changing the origin alters only the grid
position, and does not affect to coordinates of the objects.

Size Defines the size of grid ticks and crosses at grid lines intersections.

Text These settings defines where the text labels for the grid cuts will be displayed

Left North

Tick the On checkbox to display the text on the Left North grid. This is usually
the vertical left margin of the drawing area.

Tick the Above Ticks checkbox to write the text for the grid cuts above the tick
line, otherwise it will be written beneath the tick line.

Left East

Tick the On checkbox to display the text on the Left East grid. This is usually
the horizontal bottom margin of the drawing area.

Tick the Above Ticks checkbox to write the text for the grid cuts above the tick
line, otherwise it will be written beneath the tick line.

Right North

Tick the On checkbox to display the text on the Right North grid. This is usu-
ally the vertical right margin of the drawing area.

Tick the Above Ticks checkbox to write the text for the grid cuts above the tick
line, otherwise it will be written beneath the tick line.

Right East

Tick the On checkbox to display the text on the Right East grid. This is usually
the horizontal top margin of the drawing area.

Tick the Above Ticks checkbox to write the text for the grid cuts above the tick
line, otherwise it will be written beneath the tick line.

Justification Table Defines the justification style for the grid text.

Text Style Table Defines the text style for the grid text.
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Fields Description

Before North
Defines the text to be displayed before the grid number.

Before East

After North
Defines the text to be displayed after the grid number.

After East

Contour tab
The Contour tab of the Library - Plot Settings dialog allows you to configure the contour plotting settings. Fields
of the tab are described in the table below.

Fields of the Contour tab of the Library - Plot Settings dialog
Field Description

Smoothing Defines the smoothing of contour lines.

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Annotations tab
The Annotations tab of the Library - Plot Settings dialog allows you to configure the annotations plotting settings.

Tick the required annotations to add them to plotting.

Annotation Table Settings tab
The Annotation Table Settings tab of the Library - Plot Settings dialog allows you to configure the appearance of
the line/arc annotation tables when plotting. Fields and buttons of the tab are described in the table below.

Fields of the Annotation Table Settings tab of the Library - Plot Settings dialog
Field Description

Insertion Point Defines the X (East) and Y (North) coordinates of the table bottom left corner.

Columns Defines the quantity of column sets.

Text Style Defines the text style, used in the table.
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Field Description

ID Text Style Defines the text style, used for line marks.

Sorted by Select the parameter for table data sorting.

Ascending Tick to sort the table data in the ascending order. If unticked, data will be sor-
ted in the descending order.

Display Tick to display the line/arc annotation table when plotting. If unticked, the
line/arc annotation table will be invisible.

Buttons of the Annotation Table tab of the Library - Plot Settings dialog
Button Description

Reset Click it to restore the default settings.

Renumber Click it to renumber the line/arc marks, starting from 1.

Refresh Click it to refresh the line/arc annotation table.
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Contour settings library
The contour settings library contains global sets of contour settings, which are available in all projects. Note that
if you change library settings in one project, they will change for all projects.

The library is managed by the Library Contour Settings dialog. It contains the list of the existing contour settings
sets. You may create new sets, edit or delete existing sets.

To open the dialog, in the Output group of the Library tab, click the Contour Settings icon.

Buttons of the dialog are described in the table below.

Buttons of the Library Contour Settings dialog
Button Description

New Click it to create a new library set of contour settings. For more information,
refer to "Creating library contour settings sets" section below.

Modify Click it to modify an existing library set of contour settings. For more inform-
ation, refer to "Editing library contour settings sets" section on the next page.

Rename
Click it to rename an existing library set of contour settings.

NOTE
The $$DEFAULT set cannot be renamed.

Delete
Click it to delete an existing library set of contour settings.

NOTE
The $$DEFAULT set cannot be deleted.

OK Click it to close the dialog.

Creating library contour settings sets
To create a new contour settings set :

1. In the Output group of the Library tab, click the Contour Settings icon.

The Library Contour Settings dialog is displayed.
2. Click New.

The Contour Settings dialog is displayed.
3. Make the required configurations. Field are described in the table below.
4. Click OK.

The new set of contour settings is created.

Fields of the Contour Settings dialog
Field Description

Name Defines the name of the contour settings.

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.
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Field Description

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.

Editing library contour settings sets
To edit an existing contour settings set :

1. In the Output group of the Library tab, click the Contour Settings icon.

The Library Contour Settings dialog is displayed.
2. Select the required contour settings set, and clickModify.

The Contour Settings dialog is displayed.
3. Make the required configurations. Field are described in the table below.
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4. Click OK.

The contour settings set are modified.

Fields of the Contour Settings dialog
Field Description

Name Defines the name of the contour settings.

Major Defines the major contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minor Defines the minor contour interval. Set the line width and style, and tick the
check box to display the major contours.

Minimum Level Defines the range of levels in which the contours are created. The range
should be between the lowest and highest point elevation in the DTM.Maximum Level

Major Start Level Defines the level where the first major contour is created.

Additional Major
Contours Defines the levels where the extra contours will be created, in addition to the

levels calculated by the MAGNET Office.Additional Minor
Contours

Discrete Color Defines the colors for the major and minor contour lines. Select the required
colors from the appropriate drop-down lists.

Color Range Defines the color range for contour lines displaying. Click Define to configure
it.

Low
Defines the lowest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

High
Defines the highest value of height range. Click the color button to choose a
color from the palette. This displays the lowest DTM elevation with the color
you selected.

Plot Major/Minor
Labels Plots major/minor labels on the contour.

Remove Over-
plotted Labels Removes overlapping contour labels.

Plot Labels Along
Contour Places the labels along the contour.

Plot End Labels Plots labels at the end of the contour.

Plot Labels Uphill Places the labels at the uphills.

Text Style Defines the text style for the labels.

Justification Style Defines the justification style for the labels.

Label Distance Defines the spacing between the labels along the contour.
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Genio translation tables library
The genio translation tables library contains global genio tables. Genio tables can basically have cross-section
data, horizontal alignment data, and vertical alignment data. It is a generalized input/output format used to import/-
export various design file formats.

The library is managed by the Genio Translation Tables dialog. It contains the list of the existing translation
tables. You may create new tables, edit or delete existing ones.

To open the dialog, in the Output group of the Library tab, click the Genio Translation icon.

Buttons of the dialog are described in the table below.

Buttons of the Genio Translation Tables dialog
Button Description

New Click it to create a new genio translation table. For more information, refer to
"Creating genio translation tables" section below.

Modify Click it to modify an existing genio translation table. For more information,
refer to "Editing genio translation tables" section on the facing page.

Rename
Click it to rename an existing genio translation table.

NOTE
The $$DEFAULT table cannot be renamed.

Delete
Click it to delete an existing genio translation tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

Creating genio translation tables
To create a new genio translation table:

1. In the Output group of the Library tab, click the Genio Translation icon.

The Genio Translation Tables dialog is displayed.
2. Click New.

The Moss Export LookUp Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Moss Export LookUp Table dialog
Field Description

Table Name Defines the name of the translation table.

Entity Defines the entity for translation.

Code/Name Defines the code of the entity.
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Field Description

Layer Defines the layer where entity will be placed.

Moss String Defines, whether the entity will be in the moss format.

Buttons of the Moss Export LookUp Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Restore Click it to discard all changes and load last saved configuration.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog.

Editing genio translation tables
To edit an existing genio translation table:

1. In the Output group of the Library tab, click the Genio Translation icon.

The Genio Translation Tables dialog is displayed.
2. Select the required table and clickModify.

The Moss Export LookUp Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Moss Export LookUp Table dialog
Field Description

Table Name Defines the name of the translation table.

Entity Defines the entity for translation.

Code/Name Defines the code of the entity.

Layer Defines the layer where entity will be placed.

Moss String Defines, whether the entity will be in the moss format.

Buttons of the Moss Export LookUp Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Restore Click it to discard all changes and load last saved configuration.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog.

659



MAGNET Office libraries

AutoCAD layer definition tables library
The AutoCAD layer definition tables library contains global Autocad definition tables. These tables define layer
names and layer settings to use in the Autocad Layer Translation table for Aoutodesk RealDWG (*.dxf or *.dwg)
files export.

The library is managed by the Layer Definition Table dialog. It contains the list of the existing definition tables.
You may create new tables, edit or delete existing ones.

To open the dialog, in the Output group of the Library tab, click the ACAD Layer Definition icon.

Buttons of the dialog are described in the table below.

Buttons of the Layer Definition Table dialog
Button Description

New Click it to create a new layer definition table. For more information, refer to
"Creating AutoCAD layer definition tables" section below.

Modify Click it to modify an existing layer definition table. For more information, refer
to "Editing AutoCAD layer definition tables" section on the facing page.

Rename
Click it to rename an existing layer definition table.

NOTE
The $$DEFAULT table cannot be renamed.

Delete
Click it to delete an existing layer definition tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

Creating AutoCAD layer definition tables
To create a new layer definition table:

1. In the Output group of the Library tab, click the ACAD Layer Definition icon.

The Layer Definition Table dialog is displayed.
2. Click New.

The Layer Definition Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Layer Definition Table dialog
Field Description

Table Name Defines the name of the translation table.

Autocad Layer Defines the name of the layer to be used in AutoCAD file.

Color Defines the default color of the layer.
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Field Description

Line Style Defines the default line style of the layer.

Thickness Defines the default line thickness of the layer.

Buttons of the Layer Definition Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Restore Click it to discard all changes and load last saved configuration.

Get Job Layers Click it to load layers from the current project.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog.

Editing AutoCAD layer definition tables
To edit an existing layer definition table:

1. In the Output group of the Library tab, click the ACAD Layer Definition icon.

The Layer Definition Table dialog is displayed.
2. Select the require table and clickModify.

The Layer Definition Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Layer Definition Table dialog
Field Description

Table Name Defines the name of the translation table.

Autocad Layer Defines the name of the layer to be used in AutoCAD file.

Color Defines the default color of the layer.

Line Style Defines the default line style of the layer.

Thickness Defines the default line thickness of the layer.

Buttons of the Layer Definition Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Restore Click it to discard all changes and load last saved configuration.

Get Job Layers Click it to load layers from the current project.

OK Click it to apply changes and close the dialog.
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Button Description

Cancel Click it to close the dialog.
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AutoCAD layer translation tables library
The AutoCAD layer translation tables library contains global Autocad translation tables. These tables contain two
columns. The Layer column lists the layers in the MAGNET Office project, the Acad Layer column lists the cor-
responding layer the MAGNET Office layer will be translated into.

The library is managed by the Layer Translation Table dialog. It contains the list of the existing definition tables.
You may create new tables, edit or delete existing ones.

To open the dialog, in the Output group of the Library tab, click the ACAD Layer Translation icon.

Buttons of the dialog are described in the table below.

Buttons of the Layer Translation Table dialog
Button Description

New Click it to create a new layer definition table. For more information, refer to
"Creating AutoCAD layer translation tables" section below.

Modify Click it to modify an existing layer definition table. For more information, refer
to "Editing AutoCAD layer translation tables" section on the next page.

Rename
Click it to rename an existing layer definition table.

NOTE
The $$DEFAULT table cannot be renamed.

Delete
Click it to delete an existing layer definition tablet.

NOTE
The $$DEFAULT table cannot be deleted.

OK Click it to close the dialog.

Creating AutoCAD layer translation tables
To create a new layer translation table:

1. In the Output group of the Library tab, click the ACAD Layer Translation icon.

The Layer Translation Table dialog is displayed.
2. Click New.

The Layer Translation Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Layer Translation Table dialog
Field Description

Table Name Defines the name of the translation table.

Layer Lists layer from the current project.

Acad Layer Lists the name of the layer to be used in AutoCAD file.

Acad Layer Table Defines the layer definition table, to be used in export. For more information,
refer to "AutoCAD layer definition tables library" section on page 660.
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Field Description

Annotation Layer Defines the layer, where all annotations will be placed.

Contours Layer Defines the layer, where all contours will be placed.

Triangles Layer Defines the layer, where all triangles will be placed.

Slope Layer Defines the layer, where all slope arrows will be placed.

Undefined Layer Defines the layer, where all entities not specified to acad layers will be
placed.

Buttons of the Layer Translation Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Update Click to update the table, and include all layers existing in the current project.

Settings Click it to open the layer definition table. For more information, refer to
"AutoCAD layer definition tables library" section on page 660.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog.

Editing AutoCAD layer translation tables
To edit an existing layer translation table:

1. In the Output group of the Library tab, click the ACAD Layer Translation icon.

The Layer Translation Table dialog is displayed.
2. Select the required table and clickModify.

The Layer Translation Table dialog is displayed.
3. Make the required configurations. Fields and buttons of the dialog are described in the tables below.
4. Click OK.

Fields of the Layer Translation Table dialog
Field Description

Table Name Defines the name of the translation table.

Layer Lists layer from the current project.

Acad Layer Lists the name of the layer to be used in AutoCAD file.

Acad Layer Table Defines the layer definition table, to be used in export. For more information,
refer to "AutoCAD layer definition tables library" section on page 660.

Annotation Layer Defines the layer, where all annotations will be placed.

Contours Layer Defines the layer, where all contours will be placed.
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Field Description

Triangles Layer Defines the layer, where all triangles will be placed.

Slope Layer Defines the layer, where all slope arrows will be placed.

Undefined Layer Defines the layer, where all entities not specified to acad layers will be
placed.

Buttons of the Layer Translation Table dialog
Button Description

Insert Click it to add a row to the table.

Delete Click it to delete a row from the table.

Update Click to update the table, and include all layers existing in the current project.

Settings Click it to open the layer definition table. For more information, refer to
"AutoCAD layer definition tables library" section on page 660.

OK Click it to apply changes and close the dialog.

Cancel Click it to close the dialog.
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Sewer library
The sewer library allows you to configure and store sewer parameters for the region where you work. It can be
used for any sewer project. By default the information is stored in the SewerLib.lsr file in the Library directory.
Once you configure the library, you may copy the file and use at other PCs in your company.

Also you may import civilcad sewer (*.bse) library file. To do so:
1. In the Program Settings dialog, click the Libraries tab. For more information refer to "Program Settings

dialog" section on page 589.
2. Double click the Sewer item in the library list.

The library edit dialog is displayed.
3. Click Import.

The Open dialog is displayed.
4. Navigate to the required file and open it.

Configuring sewer library
To configure the sewer library double click the Sewer item in the Libraries tab of the Program Settings dialog.
Configuration of the sewer library contains of two parts – default data and pipe class.

Default data configuring
This is general data for all the pipes and pits in the current network. Click plus sign to extend the Default Data
list. Double click a default data record to open the Default Data dialog for editing.

Fields of the Default Data dialog
Field Description

Name Displays the name of the default data set.

Flow for Plotting Select the appropriate option.

Sewer Data

Pit Diameter Defines the diameter of the pit (manhole).

Min. Drop Defines the minimum drop through the manhole from the higher upstream pipe
to the lower downstream pipe.

Max. Drop Defines the maximum drop through the manhole from the higher upstream pipe
to the lower downstream pipe.

Pipe Class Defines the pipe class for the data set.

BCIL Data

Block Control Invert Level.

These settings are optional, but useful for designing the main sewer line in rela-
tion to the connections at the house drain points. When using BCIL, MAGNET
Office designs the sewer pipe at a suitable level to allow for a nominated min-
imum depth and slope from the drain point of each house. See "Create BCIL
icon" section on page 384 for details.
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Field Description

Min. Cover Defines the minimum cover over the connecting pipe from the house drain
point.

Drop at House
Drain Defines the drop at the house drain.

Min. Slope (%) Defines the minimum slope for the connecting pipe from the house drain point.

Drop into Sewer Defines the drop into the sewer network.

To configure the color layout, click Colors and select the required colors.

Pipe class configuring
The library holds pipe class details. It is taken from the combination of the definition labels used for the pipe type,
pipe class and joint type. The cost ($/m) column entries are not used by the program.
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Drainage library
The drainage library allows you to configure and store drainage parameters for the region where you work. It can
be used for any drainage project. By default the information is stored in the DrainLib.ldr file in the Library dir-
ectory. Once you configure the library, you may copy the file and use at other PCs in your company.

Also you may import civilcad drainage (*.bfl) library file. To do so:
1. In the Program Settings dialog, click the Libraries tab. For more information refer to "Program Settings

dialog" section on page 589.
2. Double click the Drain item in the library list.

The library edit dialog is displayed.
3. Click Import.

The Open dialog is displayed.
4. Navigate to the required file and open it.

Configuring drainage library
To configure the drainage library double click the Drain item in the Libraries tab of the Program Settings dialog.
Configuration of the drainage library contains of six parts:

l Default Data
l Flood Frequency factors (FFy Factors)
l Rainfall Data
l Gutter Profiles
l Pit Inlets
l Pipe Sizes

Default Data configuring
This is general data for all the pipes and pits in the current network. Click plus sign to extend the Default Data
list. Double click a default data record to open the Default Data dialog for editing.

Fields of the Default Data Dialog
Field Description

Rain Defines the Rainfall Data for the network. See "Rainfall Data configuring" sec-
tion below for details.

Inlet ID Defines Pit Inlet style for the network. See "Pit Inlet configuring" section
below for details.

Gutter ID Defines the Gutter Profile style for the network. See "Gutter Profiles con-
figuring" section below for details.

Default Hydrological Data

Design Freq Define the recurrence interval of the storm event.

Max Tc Defines the minimum time of concentration in minutes required for the net-
work.
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Field Description

Min Tc Defines the minimum time of concentration in minutes required for the net-
work.

Surface Rough-
ness Defines the default surface roughness.

Default Hydraulic Data

Drop Defines the default setting for the drop through the manhole from the higher
upstream pipe to the lower downstream pipe.

Hz/deg Drop Defines added drop per horiz degree of change between angle of upstream pipe
and downstream pipe at pit.

Freeboard Defines the default freeboard for the design.

Pipe Class Defines the pipe class for the design.

Mannings 'n'
(pipe) Defines the roughness parameter for the pipe surface.

Cover Defines the default setting for the cover from the natural surface to the top
(obvert) of the pipe.

Roughness Defines default pipe roughness for design.

Min Slope Defines the minimum pipe slope required in the design.

Manning 'n' (road) Defines the roughness parameter for the road surfaces when calculating gutter
flows.

Backwater HGL Select the limiting of the level to match either the obvert or the actual water
level

Flood Frequency factors configuring
Flood Frequency factors for a given Average Recurrence Interval help you to adjust your runoff coefficient value.
These FFy factors are selected along with the Rainfall Data for the pipe network.

Rainfall Data configuring
This is where you specify the rainfall intensity for a given area for various recurrent storms via either MAP, or
LOG, or IFD method. You can obtain copies of rainfall data in any format in any location from your local or
regional authority.

Gutter Profiles configuring
The next step in the library process is to define the various gutter profiles. They are used to calculate the flow
time along the channel of the curb, and the flow width and depth in the curb channel. MAGNET Office creates a
vertical wall at either side of the defined gutter to handle flow depths that exceed the capacity of the gutter pro-
file.

To add a new point into the gutter profile, simply type a new offset and level and the profile will automatically re-
sort the data. There is no need to define left and right hand gutter profiles.

Pit Inlet configuring
This allows you to define the capacity of a curb inlet or catch pit. Pit inlets do not have unlimited inlet capacity.
As the flow from the upstream gutter increases, eventually some water will fail to enter the inlet and it is referred
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to as the bypass flow.

The curb inlet behavior can be described by the following formula:

Where:
l Qi— flow entering the pit.
l Qu — flow arriving from upstream.
l A — maximum inlet capacity before bypass occurs.
l B — dimensionless coefficient. A fraction of excess entering pit.

The term (Qu - A) represents the excess flow arriving at the pit and the coefficient B represents the fraction of
this excess that will enter the pit (in addition to quantity A).

In many cases the above algorithm is not sufficient to describe the curb inlet, so the software allows a second
method of entering curb inlet data. The second method allows the user to enter a complete table of Qu/Qi values
that will specify the desired inlet behavior. The two methods of entering the data are thus described as "AB" and
"CURVE".

Whichever method is selected, the data is given an Inlet ID. This is then referred to during the hydrological cal-
culations to describe the inlet capacity of a given pit.

The curb inlet screen allows you to select the method being used by clicking on the appropriate radiobutton. If the
AB method is selected then the A & B values should be defined. The rest of the data can be ignored.

If the CURVE method is selected then Qu/Qi pairs should be defined in the Flow_Us and Flow_In fields of the
table respectively. A new pair can be entered at the end of the list and the program will automatically re-sort the
data based on increasing Qu, and then re-draw the Qu/Qi relation in the graphic window. The graphic display
serves as a check for any obvious errors.

Pipe Sizes configuring
The library holds pipe class details. It is taken from the combination of the definition labels used for the pipe
type, pipe class and joint type. The cost ($/m) column entries are for informational purposes only and not used by
the program.
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Road Design View
The name "Road" is taken from that of the horizontal alignment used for the center line of the road. This align-
ment will be the zero offset of the cross sectional data used for the road.

A horizontal alignment may be created from a simple line, a string or an alignment frame with curve geometry
applied at the horizontal intersection points along the alignment. Cross sectional data is extracted along the align-
ment from a natural or existing surface. This surface may be:

l A digital terrain model created from surveyed or imported data, typically used in “green field” designs or
subdivisional development.

l Three-dimensional string data representing the changes in grade along individual feature lines, typically
used when reconstructing or upgrading an existing road.

l Cross section point data surveyed at right angles to a pinned center line, usually at 10 or 20 meters spacing.

When the cross sections have been extracted, a road is listed in the list, which may be accessed via Roads icon.

The Road design view has three panels in the main view area:
l Alignment panel – displays the alignment and design strings. The plan data from the survey view may also
be shown. Its location is top left.

l Cross Section panel – displays the cross section for one chainage. Several surfaces may be shown. Its loc-
ation is top right.

l Profile panel – displays the profile for the natural surface and the design profile with vertical IP points, for
the reference alignment or any one selected string. Its location is bottom.

The Road Design View has its own ribbon, different from the default MAGNET Office ribbon. Descriptions may
be found in the appropriate sections:

l "File tab" section on the next page
l "View tab" section on page 673
l "Settings tab" section on page 674
l "Alignment tab" section on page 678
l "Cross Section tab" section on page 683
l "Profile tab" section on page 691
l "Design tab" section on page 701
l "Plotting tab" section on page 720
l "Library tab" section on page 732
l "Window tab" section on page 740
l "Help tab" section on page 740

NOTE
TheAlignment, theProfile and theCross Section tabs share the same position in the Road design view
ribbon. Displaying of these tabs depends on which panels of the Road design view is currently active.
To switch between tabs, click the appropriate panel:

• Alignment panel (top left) – to view theAlignment tab.

• Cross Section panel (top right) – to view theCross Section tab.

• Profile panel (bottom) – to view theProfile tab.
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File tab

Open icon
Click it to open an existing road.

Saver icon
Click it to save the current road.

Close icon
Click it to close the current road.
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View tab
Refresh group

Redraw icon
Click it to refresh the displaying of entities in the current view.

Regen icon
Click it to regenerate the current view.

Navigate group

Zoom icon
Click it to it to fit all data in the view.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom in the center area of the survey view.

Pan icon
Click it to scroll the view

Features group
Google Earth/Map icon

Click it to view the current project in Google Earth or Google Maps.
Survey icon

Click it to switch to the survey view.
Options group

Toolbar icon
Click it to enable/disable toolbars.

Status icon
Click it to enable/disable toolbar.
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Settings tab
Alignment icon

Click it to configure the layout of the alignment panel.
Profile icon

Click it to configure the layout of the profile panel.
Cross Section icon

Click it to configure the layout of the cross section panel.

Alignment icon
The Alignment icon of the Road design view allows you to configure the displaying of alignments at the align-
ment panel.

To configure the alignment displaying:
1. At the Settings tab of the Road design view, click the Alignment icon.

The Road Display Settings dialog, opened at the Alignment tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Alignment tab of the Road Display Settings dialog
Field Description

Display Strings Tick to display the design strings after computation.

Display String
TPs

Tick to show the tangent points on the design strings after computation. The tan-
gent points will be displayed on the main design string.

Display String IPs Tick to show the intersection points on every chainage of the design strings
after computation

Display Peg Align-
ment Tick to show the alignment at the zero offset of the cross sections

Display Align TPs Tick to show the tangent points on the alignment.

Display Align IPs Tick to show the intersection points on the alignment.

Display Survey
Data

Tick to display the data on active layers in the Survey View. If the triangular
mesh and the contours are active in the Survey View, they will display in the
Alignment pane.

Profile icon
The Profile icon of the Road design view allows you to configure the displaying of the profile panel.

To configure the profile displaying:
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1. At the Settings tab of the Road design view, click the Profile icon.

The Road Display Settings dialog, opened at the Profile tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Profile tab of the Road Display Settings dialog
Field Description

Display Leaders Tick to display the vertical leader lines in the profile view.

Design Levels Tick to display the levels for the vertical profile design on each leader line.

Natural Levels Tick to display the levels for the natural surface on each leader line.

Level Differences

Tick to display the difference between the levels of design and natural sur-
faces.

l Fill – when design surface is above the natural surface. Displayed as
positive value, followed by F. For example, 0.15F.

l Cut – when design surface is below the natural surface. Displayed as
negative value, followed by C. For example, -0.15C.

CL Stations Tick to display the chainage or running distance along the Road for the ref-
erence or pegged string. This is at the zero offset of the sections

Offset Stations Tick to display the chainage or running distance along the current string.

IPs
Tick to display the level of the IP point for the profile design. The chainage and
level is displayed vertically above the triangular symbol used to define an IP
position.

Curve Length
Tick to to display the length of the vertical curves for each IP point of the pro-
file design. The curve length is displayed at the top of the screen above a hori-
zontal line that shows the position and length of the curve.

Hi/Low Points
Tick to display the high and low points on the formation levels of the vertical
profile design. The chainage and level is displayed vertically above the high or
low point and marked HI for high point and LO for low point.

Grades

Tick to display the grade of the designed profile line between two adjacent IP
points. The grade is displayed as a positive or negative percentage below the
curve length data at the top of the screen, and above a horizontal line that
shows where the grades change at each IP point. The grade is measured from
left to right, from the lower chainage or distance position to the higher chain-
age or distance position.

Vertical Exag
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.

Precision Defines the number of decimal places in the data displayed in the profile view.

Reference String Select the string used to define the stations on the long section plot. This is not
necessarily the current string

Envelope Details
The envelope allows you to see the design string profile designed within two
different cross falls. This may be useful if you want to design a prefer string to
match in with existing strings.
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Field Description

Natural Defines whether the envelope is calculated from the natural or design surface
of the source.Design

String Defines the base string for the envelope.

Min X Fall Defines the minimum cross fall for the envelope.

Max X Fall Defines the maximum cross fall for the envelope.

Cross Section icon
The Cross Section icon of the Road design view allows you to configure the displaying of the cross section
panel.

To configure the profile displaying:
1. At the Settings tab of the Road design view, click the Cross Section icon.

The Road Display Settings dialog, opened at the Cross Section tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Cross Section tab of the Road Display Settings dialog
Field Description

Display Point Info
Tick to display the point information.

Select which information will be displayed - either Code, or Level or Offset by
selecting the appropriate radiobutton.

Display Point Mark
Tick to display point marks.

Define the size of the marks, by selecting the appropriate radiobutton.

Display Text Size

Display Cross Fall
Tick to display the cross fall on each leg of the cross section of the current sur-
face. Crossfalls are hidden if the mapping scale is such that the data would
overlap.

Display Road
Reserve

Tick to display vertical yellow lines on the cross section where the two offsets
in the next two fields represent the left and right road reserve or a known lim-
itation of the design corridor. The center line will be marked with a vertical
green line. These lines are a useful guide to mark specified offsets.

Left Road Reserve Defines the left road reserve. The default is 7.00m left of the center line

Right Road Reserve Defines the right road reserve. The default is 7.00m right of the center line

Vertical Exaggeration
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.
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Field Description

Natural Surface
The Natural Surface displayed in the cross section and long section panes. This
surface will be set when cross sections are extracted from the survey view.
The surface set in this field is the current natural surface

Design Surface The design surface displayed in the cross section and long section panes. The
surface set in this field is the current design surface

Subgrade Surface
Multiple subgrade surfaces may be computed, representing different materials
of varying thicknesses. The surface set in this field is the current subgrade sur-
face
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Alignment tab
NOTE
TheAlignment tab shares the same position with theProfile and theCross Section tabs. Displaying of
these tabs depends on which panels of the Road design view is currently active. To switch between
tabs, click the appropriate panel:

• Alignment panel (top left) – to view theAlignment tab.

• Cross Section panel (top right) – to view theCross Section tab.

• Profile panel (bottom) – to view theProfile tab.

String group
Add icon

Click it to a new string to the road design.
Edit icon

Click it to edit a string in the road design.
Delete icon

Click it to delete strings from the road design.
Transfer group

Update Survey icon
Click it to transfer data from the road design to the survey view.

Data Transfer Table icon
Click it to set up the parameters for transferring road data into the survey

view.
Report group

Curve Report icon
Click it to generate a curve report.

Add icon
The Add icon of the Road design view allows you to add a new string in the dataset or another alignment defined
in the survey view.

To add a string:
1. At the Alignment tab of the Road design view, click the Add icon.

The Add String dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The new string is created. It is set as the current string.
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Fields of the Add String dialog
Field Description

Name

Defines the name of the new string.

It is useful to allocated a name that suits the definition of the string, so that the
user may easily select it

For example, NESL new edge of seal left, or NEB new edge of bitumen, or R2
right side of a widened road

Active

Tick to activate the string as a design string with its own design profile.

If this string has VIPs designed for the design levels on the string this checkbox
must be ticked to use these design levels.

If the string has this checkbox ticked, but there are no design levels, then the
levels on the natural surface will be automatically incorporated into the final
design surface. This is a useful tool if an existing property boundary is to be
used for the batter.

Definition of the
String

A string must follow a path along the data for the road. The following ways are
available for defining a string:

l Fixed Offset – the string will run at a specified offset from the reference
alignment (zero offset of the road dataset). In the editbox, specify a neg-
ative offset to the left of the road or a positive offset to the right of the
road.

l Coded Offset – the string will follow a particular code from the Natural
Surface cross sectional data, such as EML [edge metal left] and EMR
[edge metal right].

l Extension – the Code Offset and Alignment options may be modified by
an offset to define the string to the left or right of the line following the
code or alignment.

For example, enter –1.5 to create the string 1.5m to the left of the line
defined by the code offset or alignment definition.

l Alignment – the string will follow a horizontal alignment created in the
survey view.

l String – the string will follow a string created in the survey view.
l String By Intersecting Grade – the string at the position and level of
intersection of two grades from two existing strings.

Start Chainage Defines the start chainage for the string. By default this is the start chainage of
the main alignment.

End Chainage Defines the end chainage for the string. By default this is the end chainage of
the main alignment.

Color Defines a color for the design string.

Plotting Label Defines a label to be used for this string in the long section plotting.

Plot Label Tick to plot the label on the profile.

Plot Design
Details Tick to plot design levels along the string on the profile.
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Edit icon
The Edit icon of the Road design view allows you change the definition of a string.

To edit a string:
1. In the Alignment panel, select the required string.
2. At the Alignment tab of the Road design view, click the Edit icon.

The Edit String dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The string is edited.

Fields of the Edit String dialog
Field Description

Name Displays the name of the string.

Active

Tick to activate the string as a design string with its own design profile.

If this string has VIPs designed for the design levels on the string this checkbox
must be ticked to use these design levels.

If the string has this checkbox ticked, but there are no design levels, then the
levels on the natural surface will be automatically incorporated into the final
design surface. This is a useful tool if an existing property boundary is to be
used for the batter.

Definition of the
String

A string must follow a path along the data for the road. The following ways are
available for defining a string:

l Fixed Offset – the string will run at a specified offset from the reference
alignment (zero offset of the road dataset). In the editbox, specify a neg-
ative offset to the left of the road or a positive offset to the right of the
road.

l Coded Offset – the string will follow a particular code from the Natural
Surface cross sectional data, such as EML [edge metal left] and EMR
[edge metal right].

l Extension – the Code Offset and Alignment options may be modified by
an offset to define the string to the left or right of the line following the
code or alignment.

For example, enter –1.5 to create the string 1.5m to the left of the line
defined by the code offset or alignment definition.

l Alignment – the string will follow a horizontal alignment created in the
survey view.

l String – the string will follow a string created in the survey view.

Ref. Start Station Displays the start chainage for the string.

Ref. End Station Displays the end chainage for the string.
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Field Description

Color Defines a color for the design string.

Plotting Label Defines a label to be used for this string in the long section plotting.

Plot Label Tick to plot the label on the profile.

Plot Design
Details Tick to plot design levels along the string on the profile.

Delete icon
The Delete icon of the Road design view allows you to delete strings from the road design.

To delete a string:
1. At the Alignment tab of the Road design view, click the Delete icon.

The Delete String dialog is displayed.
2. In the Strings list, select strings to be deleted.
3. Click Delete.

The strings are deleted.

Update Survey icon
The Update Survey icon of the Road design view allows you to update the survey view with the design surface
strings and a surface model, as defined by the Data Transfer Table.

The design should be completed to use this option.

To update the survey data:
1. Configure the Data Transfer Table. See "Data Transfer Table icon" section below for details.
2. At the Alignment tab of the Road design view, click the Update Survey icon.

Data Transfer Table icon
The Data Transfer Table icon of the Road design view allows you to set up the parameters for transferring road
data into the survey view.

To configure the Data Transfer Table:
1. At the Alignment tab of the Road design view, click the Data Transfer Table icon.

The Transfer Data to Survey dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.
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The Transfer Data to Survey dialog
Field Description

Road Code

The name used to define each string in the road design. These strings comprise
the reference alignment, the strings created for each template leg that is
labelled and has its plot box ticked, and certain standard strings automatically
named by the software, such as LBAT [left batter] and RT1 [table drain at the
right leg 1].

Survey String
The code of each point on this design string. This code will also name the
string created in the survey view. This is set to the same name as the road code
but may be modified.

Layer

The layer created to hold this string and all its node points in the survey view.
This is set to the same name as the road code but may be modified. An existing
layer may be selected from the pick list available in this field or a new name
may be entered.

Transfer Tick to transfer this string to the survey view with the option Update Survey.

Road Number

Allows you to add the road number to the Survey String name and the Layer
name.

To add road number to the Survey String name:
1. Specify the required number in the editbox.
2. Define whether it will be used as prefix or suffix, by selecting the appro-

priate radiobutton.
3. Click Survey String.

To add road number to the layer name:
1. Specify the required number in the editbox.
2. Define whether it will be used as prefix or suffix, by selecting the appro-

priate radiobutton.
3. Click Layer.

Create DTM

Tick to create a DTM for the selected surface defined in the Surface field. Spe-
cify a name for the DTM in the editbox.

The DTM created will be the complete surface from the far left edge of the
design to the far right edge of the design. These are usually the left and right
batter lines. The surface is complete even if the user does not transfer all the
strings from this surface.

Surface
Select the surface to be transferred to the survey view from the pick list of sur-
faces. This will usually be the Design surface, and the string names are dis-
played from the Design surface.
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Cross Section tab
NOTE
TheCross Section tab shares the same position with theProfile and theAlignment tabs. Displaying of
these tabs depends on which panels of the Road design view is currently active. To switch between
tabs, click the appropriate panel:

• Alignment panel (top left) – to view theAlignment tab.

• Cross Section panel (top right) – to view theCross Section tab.

• Profile panel (bottom) – to view theProfile tab.

The Cross Section tab shares the same position in the Road design view ribbon with the Profile and the
Alignment tabs. Displaying of these tabs depends on which panels of the Road design view is currently
active. To switch between tabs, click the appropriate panel:

• Alignment panel (top left) – to view the Alignment tab.

• Cross Section panel (top right) – to view the Cross Section tab.

• Long Section panel (bottom) – to view the Profile tab.

Surface group
Add icon

Click it to add a surface to the road design.
Sequence icon

Click it to re-order the subgrade surfaces.
Delete icon

Click it to delete surfaces from the road design.
Points group

Add icon
Click it to add a new point to the cross section.

Raise icon
Click it to raise/lower the level on a section of the current cross section.

Adjust Side Slope icon
Click it to adjust the slope of a single existing batter in the current cross

section.
Intersect Side Slope icon

Click it to add individual batters to a single cross section
Volumes group

Strip Depth icon
Click it to specify the depth of stripping topsoil from the natural surface.

Volume Factors icon
Click it to define the cut/fill factor.

Omit Stations icon
Click it to omit a chainage from the plotted cross sections and also from the

volumes report.
Compute Volumes icon

Click it to calculate volumes in the road design.
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Reports group
Cross Section icon

Click it to generate a cross section report.
Construction icon

Click it to generate a construction report.
Survey group

Update from Survey icon
Click it to re-extract the cross-sections from the survey view.

Add icon
The Add[Surface] icon of the Road design view allows you to add another surface to the road design. This sur-
face is usually a subgrade surface but may be an alternate design surface.

To add a surface:
1. At the Cross Section tab of the Road design view, in the Surface group, click the Add icon.

The Add Surface dialog is displayed.
2. In the Surface Name editbox, type the name of the surface. You may also select a name from the drop-

down list.
3. Define the type of the surface, by selecting the appropriate radiobutton:

l Design - when the new surface is to be a design surface.
l Subgrade - if the new surface is to be a subgrade surface. If so, configure the following parameters:

1. In the Material editbox, specify the material used. This is optional but the material will be lis-
ted on the subgrade volumes report.

2. In the Class editbox, specify a character or characters to label and allocate the subgrade to a
class. This is optional but the class may be used to categorize the subgrade on the volumes
report.

4. If needed, tick the Copy Current Data checkbox box to copy the data allocated to the current design or sub-
grade surface to the new surface.

5. Click OK.

The surface is created and set as current Design or Subgrade surface.

Fields of the Add Surface dialog
Field Description

Surface Name Defines the name of the new surface.

Surface Type
Defines the type of the new surface.
Design - when the new surface is to be a design surface.
Subgrade - if the new surface is to be a subgrade surface.

Material Defines the material used. This is optional but the material will be listed on the
subgrade volumes report.
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Field Description

Class
Defines a character or characters to label and allocate the subgrade to a class.
This is optional but the class may be used to categorize the subgrade on the
volumes report.

Copy Current
Data

Tick to copy the data allocated to the current design or subgrade surface to the
new surface.

Sequence icon
The Sequence icon of the Road design view allows you to to re-order the subgrade surfaces. The sequence is ori-
ginally defined in the order that the subgrade surfaces are created, with the first surface being the top subgrade sur-
face. The sequence should be set correctly so that appropriate surfaces intersect each other.

To re-order surfaces:
1. At the Cross Section tab of the Road design view, click the Sequence icon.

The Subgrade Sequence dialog is displayed.
2. Sort the surfaces as you need. Use the Existing Surfaces list to hold the surfaces while the sequence is

being re-ordered.
3. Click OK.

The subgrades are re-ordered.

Delete icon
The Delete icon of the Road design view allows you to delete surfaces from the road design.

To delete a surface:
1. At the Cross Section tab of the Road design view, click the Delete icon.

The Delete Surface dialog is displayed.
2. In the Surfaces list, select surfaces to be deleted.

NOTE
Natural and Design surfaces cannot be deleted.

3. Click Delete.

The surfaces are deleted.

Add icon
The Add [Point] icon of the Road design view allows you to point to a single cross section to modify the current
surface of the section displayed in the cross section panel.

To add a point to the cross section:
1. In the Profile panel, select the required cross section.
2. Click the Cross Section panel, to activate the Cross Section tab.
3. At the Cross Section tab of the Road design view, in the Points group, click the Add icon.
4. Locate the new point. Do one of the following:
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l Click the required place in the Cross Section panel.
l Specify the offset and level of the new point in the appropriate editboxes at the bottom toolbar.

5. If needed, create more points.
6. When finished, press Esc.

Raise icon
The Raise icon of the Road design view allows you to raise or lower the level on a section of the current cross
section in the cross section panel by a fixed amount. The section is defined by an offset range. Alternatively, the
height changed may be applied to a point or points with a defined code.

To adjust height of a section:
1. At the Cross Section tab of the Road design view, click the Raise icon.

The Raise XSect Points dialog is displayed.
2. In the Increment editbox, specify the amount of height adjustment. Use the positive value to raise and neg-

ative value to lower the section.
3. Define which points will be adjusted. You may do it either by offset of the cross section, or by the point

code. Do one of the following:
l Select the Offset From radiobutton and specify the offset range in the editboxes. The height will be
adjusted for all points within this offset range.

l Select the Code radiobutton and select the required code from the drop-down list. The height will be
adjusted for all points in this cross section with this code.

4. Click OK.

Adjust Side Slope icon
The Adjust Side Slope icon of the Road design view allows you to adjust the slope of a single existing side slope
in the current cross section by specifying an offset for the side slope intercept or a its slope.

This change will be lost if the Compute Design icon is used.

To adjust the slope:
1. In the Profile panel, select the required cross section.
2. Click the Cross Section panel, to activate the Cross Section tab.
3. Make sure that the Design surface is selected at the Property toolbar.
4. At the Cross Section tab of the Road design view, in the Points group,click the Adjust Side Slope icon.
5. Select an existing batter point on the Design Surface with the mouse.

The point is highlighted in yellow and the batter line will move with the point.
6. Specify the offset and slope in the appropriate editboxes at the bottom toolbar.
7. Press Enter.
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Intersect Side Slope icon
The Intersect Side Slope icon of the Road design view allows you to add individual batters to a single cross sec-
tion where no batters exist. A hinge point for the batter is selected and a slope or offset is entered.

This change will be lost if the Compute Design icon is used.

To adjust the slope:
1. In the Profile panel, select the required cross section.
2. Click the Cross Section panel, to activate the Cross Section tab.
3. Make sure that the Design surface is selected at the Property toolbar.
4. At the Cross Section tab of the Road design view, in the Points group,click the Intersect Side Slope icon.
5. Select an existing batter point on the Design Surface with the mouse.

This point will be the point at the edge of a template from which a batter line will intersect the natural sur-
face. A batter line is highlighted in yellow with the batter point moving along the natural surface.

6. Specify the offset and slope in the appropriate editboxes at the bottom toolbar.
7. Press Enter.

Strip Depth icon
The Strip Depth icon of the Road design view allows you to specify the depth of stripping topsoil from the natural
surface. This is usually stripped from the left batter offset to the right batter offset. The strip volume will be item-
ized in the volume report. The stripping volume will be applied to pavement volumes in the volumes report.

To specify the depth:
1. At the Cross Section tab of the Road design view, click the Strip Depth icon.

The Strip Depth dialog is displayed.
2. Configure the strip depth table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Strip Depth dialog
Field Description

Chainage

Defines the chainage where the stripping starts on the first row of the table. If
the stripping depth changes, specify the start chainage of the new depth on the
next row. The new strip depth will be applied from that chainage. There is no
interpolation between the chainages on any two rows of data.

If the left and right string extents change, set up a new row of data with the
start chainage for the new extents

Depth Defines the stripping depth in metrs.

Left String

Select the string which will be the left edge of the stripping.

This is usually the LBAT string but may be another feature. A new string may
have to be created, especially if the edge of the stripping is a natural surface
feature.
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Field Description

Right String

Select the string which will be the right edge of the stripping.

This is usually the RBAT string but may be another feature. A new string may
have to be created, especially if the edge of the stripping is a natural surface
feature.

Volume Factors icon
The Volume Factors icon of the Road design view allows you to define the cut/fill factor, which leads to increas-
ing or decreasing volume by specified ratio.

To specify a volume factor:
1. At the Cross Section tab of the Road design view, click the Volume Factors icon.

The Volume Factor dialog is displayed.
2. In the Chainage field, specify the chainage to which the cut/fill factor will be applied.
3. Specify the cut or fill factors in the appropriate fields.
4. Click OK.

Omit Stations icon
The Omit Stations icon of the Road design view allows you to omit a chainage or a range of chainages from the
plotted cross sections and also from the volumes report.

To omit chainages:
1. At the Cross Section tab of the Road design view, click the Omit Stations icon.

The Omit Chainage dialog is displayed.
2. In the Start Chainage field, specify the chainage where the omission starts.
3. In the End Chainage field, specify the chainage where the omission ends.
4. Tick the Break Vol checkbox to break the volumes report between these two chainages. Leave unticked to

omit chainages from the plot.
5. Click OK.

Fields of the Omit Chainage dialog
Field Description

Start Chainage

Defines the chainage where the omission starts.

If one chainage is to be omitted from the cross section plot, the start chainage
should be set at a value before the chainage being omitted, such as 79.00 above
to omit chainage 80.00
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Field Description

End Chainage

Defines the chainage where the omission ends.

If one chainage is to be omitted from the cross section plot, the end chainage
should be a value after the chainage being omitted, such as 81.00 above to omit
chainage 80.00

Break Vol Tick to break the volumes report between these two chainages. Leave unticked
to omit chainages from the plot.

Compute Volumes icon
The Compute Volumes icon of the Road design view allows you to create a customized volumes report that can
be saved and printed. The information displayed on the report can be defined by various settings.

To compute volumes:
1. At the Cross Section tab of the Road design view, click the Compute Volumes icon.

The Volumes Report dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The volume report is displayed.

Fields of the Volumes Report dialog
Field Description

Output Format

The following options are available:
l Std Volumes – this will produce the Volumes Report displaying the stand-
ard format.

l Multiple Subgrade Volumes – this will produce a report listing the
volumes of the various subgrade layers in the design. This report may be
formatted in one of two ways:

l Volumes by subgrade surface – Volumes are listed for each sub-
grade layer.

l Volumes by subgrade class – Volumes are listed by the class
allocated to the subgrade surfaces defined in the option Add Sur-
face.

l Include cut fill in XS listing – Tick to list volumes between each
cross section. The total volume will also be included into report.
Leave unticked to produce a total volume only.

Volumes for com-
plete design This will compute volumes for the full length of the road design.

Volumes by chain-
age range

This will limit the computation of volumes between the start chainage and end
chainage defined in the appropriate editboxes.

List by cross sec-
tions

Tick to list the volumes between each cross section in the dataset, with total
volumes at the end of the report.

Untick the check box to produce a summary of the total volumes.
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Field Description

Include Areas Tick to include the areas of cut and fill between adjacent cross sections.

Include Stripping
Volumes

Tick to include the stripping volumes between adjacent cross sections plus the
total stripping volume. To include these volumes, define the required stripping
parameters. See "Strip Depth icon" section on page 687 for details.

Include Pavement
Volumes

Tick to include the pavement volumes between adjacent cross sections plus the
total pavement volume.

The pavement volume is the top subgrade layer, between the design surface
and the top subgrade surface. If only one subgrade is defined, this will be the
pavement volume.

Use Cross Section
Limits

Tick to limit the volume computation between the left string and right string
selected from the appropriate drop-down lists.
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Profile tab
NOTE
TheProfiletab shares the same position with theAlignment and theCross Section tabs. Displaying of
these tabs depends on which panels of the Road design view is currently active. To switch between
tabs, click the appropriate panel:

• Alignment panel (top left) – to view theAlignment tab.

• Cross Section panel (top right) – to view theCross Section tab.

• Profile panel (bottom) – to view theProfile tab.

Add IP group
Add IP icon

Click it to add a new IP to the profile.
Add IP by Grade icon

Click it to create a new IP at the grade line from an existing IP.
Add IP by Intersection icon

Click it to create a new IP at the intersection of grades from two exist-
ing IPs.

Add IP by TP icon
Click it to create a new IP based on the existing IPs and the slope of the

tangent segment.
Edit IP group

Move IP icon
Click it to move an existing IP to a new position.

Modify IP icon
Click it to change properties of an existing IP.

Delete IP icon
Click it to delete an existing IP from the profile design.

Delete All IPs icon
Click it to delete all existing IPs from the profile design.

Profile group
Raise/Lower Design icon

Click it to adjust design by level.
Compute VCs icon

Click it to create a longitudinal design for a defined and selected string
based on levels on the natural surface or on the design levels of another

string.
Compute Resheet Level icon

Click it to compute a design profile that gives a minimum depth cover
over the existing pavement.
Resheet Parameters icon

Click it to configure the parameters for the Compute Resheet Levels
options.
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Report group
Level Difference icon

Click it to calculate level differences along the road between the
defined strings.

Profile Report icon
Click it to generate a profile report, listing all chainages.

VC Report icon
Click it to calculate levels for the different strings involved in a profile.

Add IP icon
The Add IP icon of the Road design view allows you to insert a new IP at a defined position.

To add an IP to the profile design:
1. At the Profile tab of the Road design view, click the Add IP icon.
2. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage, level, approach and departure grades in the appropriate editboxes at the bot-
tom toolbar.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value
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Field Description

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Grade icon
The Add IP by Grade icon of the Road design view allows you to insert a new IP at a grade from an existing IP.

To add an IP by grade:
1. At the Profile tab of the Road design view, click the Add IP by Grade icon.
2. In the profile view, select the base IP.
3. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage and grade from the base IP in the appropriate editboxes at the bottom toolbar.

The IP Details dialog is displayed.
4. Review the parameters, if needed change them. Fields are described in the table below.
5. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.
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Field Description

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Intersection icon
The Add IP by Intersection icon of the Road design view allows you to insert a new IP at an intersection of
grades from two existing IPs.

To add an IP:
1. At the Profile tab of the Road design view, click the Add IP by Intersection icon.
2. In the profile view, select the first base IP.
3. Define the grade from the first IP. Do one of the following:

l Click the required place in the profile view.
l Specify the grade in the appropriate editboxes at the bottom toolbar.

4. Repeat steps 2 and 3 for the second base IP.

The IP Details dialog is displayed.
5. Review the parameters, if needed change them. Fields are described in the table below.
6. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value
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Field Description

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by TP icon
The Add IP by TP icon of the Road design view allows you to create a new IP based on the existing IPs and the
slope of the tangent segment.

To add an IP:
1. At the Profile tab of the Road design view, click the Add IP by TP icon.
2. At the Profile panel select the first and second TP.

The message prompts you to delete vertical IPs between selected intersection points.
3. Click Yes or No as you need.

The new IP is created.

Move IP icon
The Move IP icon of the Road design view allows you to move an existing IP to a new position.

To change an IP:
1. At the Profile tab of the Road design view, click the Modify IP icon.
2. In the profile view, select the required IP.
3. Move the IP to a new position. Left click to confirm the position.

Modify IP icon
The Modify IP icon of the Road design view allows you to change the parameters of an existing IP.

To change an IP:
1. At the Profile tab of the Road design view, click the Modify IP icon.
2. In the profile view, select the required IP.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.
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Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Delete IP icon
The Delete IP icon of the Road design view allows you to delete an existing IP from the profile design.

To delete an IP:
1. At the Profile tab of the Road design view, click the Delete IP icon.
2. In the profile view, select the required IP.

The IP is deleted.

Delete All IPs icon
The Delete All IPs icon of the Road design view allows you to delete all existing IPs from the profile design.

To delete all IPs:

696



Raise/Lower Design icon

1. At the Profile tab of the Road design view, click the Delete All IPs icon.

The confirmation message is displayed.
2. Click Yes.

The IPs are deleted.

Raise/Lower Design icon
The Raise/Lower Design icon of the Road design view allows you to raise the level of all existing IPs within a
nominated chainage range. This will raise or lower all or a section of the design profile.

To adjust a design:
1. At the Profile tab of the Road design view, click the Raise/Lower Design icon.

The Raiser/Lower IP's dialog is displayed.
2. In the Raiser/Lower Amount editbox, specify the required level change. Positive value will raise the IP

levels; negative value will lower the IP levels.
3. In the From Station editbox, specify the start chainage of the range within which IP levels will be adjusted.
4. In the To Station editbox, specify the end chainage of the range within which IP levels will be adjusted.
5. Click OK.

The design is adjusted.

Fields of the Raiser/Lower IP's dialog
Field Description

Raiser/Lower
Amount

Defines the required level change. Positive value will raise the IP levels, neg-
ative value will lower the IP levels.

From Station Defines the start chainage of the range within which IP levels will be adjusted.

To Station Defines the end chainage of the range within which IP levels will be adjusted.

Compute VCs icon
The Compute VCs icon of the Road design view allows you to create a longitudinal design for a defined and
selected string based on levels on the natural surface or on the design levels of another string.

This option is the basis of stringl ine design. It is normally used in road reconstruction work to calculate levels for
the different strings involved in the design, such as the addition of curb and channel to an existing road, or widen-
ing a lane of a road using the existing pavement grading.

The computed levels are based on existing levels for surveyed strings and design alignments using nominated
grades and offsets from the existing information.

The option will create a VIP (vertical intersection point) at each cross section and the you can then edit this pro-
file design if necessary.

To compute VCs:
1. In the Alignment panel, select the required string.
2. Click the Profile panel, to activate the Profile tab.
3. At the Profile tab of the Road design view, click the Compute VCs icon.

The Compute VC dialog is displayed.
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4. Configure the parameters as you need. Fields are described in the table below.
5. Click OK.

The existing IPs are overwritten with the new levels and the reports is displayed.

Fields of the Compute VC dialog
Field Description

Compute
VC From

Defines the surface from which the VC levels will be computed.

Natural Surface

Calculate Level
From

Defines the string from which the levels of the new IPs will be calculated.

Select the required string from the drop-down list, it may be an existing string
defined from an alignment, or coding from surveyed data, or from a string
already computed in an intermediate design.

Use Grade

Defines the grade for the design levels from the string, selected in the Cal-
culate Level From field. You may use one of the following ways of grade cal-
culating, by selecting the appropriate radiobutton:

l Constant – a constant grade or cross fall from the level of the string,
selected in the Calculate Level From field to the current string.

l From... To – defines the grade from existing data between one string
and another. This will be computed separately for each cross section. It
is ideal for computing the existing cross fall from the crown of the road
when the road is being widened, utilizing existing grades between the
center line and road edge. To use select the required stings in the From
and To drop-down lists.

Level Adjustment
Defines a level that will be added to the computed IP at each cross section.
This would be used if an overlay is to be built over the existing surface from
which the IPs are being calculated.

Compute Resheet Level icon
The Compute Resheet Level icon of the Road design view allows you to compute a design profile that gives a
minimum depth cover over the existing pavement.

The MAGNET Office essentially calculates a series of IPs (vertical intersection points) with zero vertical curve
length for each chainage in the natural surface cross section dataset. This vertical curve design may be modified
to suit design conditions, bearing in mind that the IP level computed at any cross section is the minimum overlay.
For example, you may need to define curve lengths at some IPs.

You must configure road templates and superelevation tables must be configured before using this option. For
details, see "Templates icon" section on page 702 and "Super Elevation icon" section on page 703 respectively.
These will define the finished pavement shape that is required for the design. Other parameters for this option are
defined in the Resheet Parameters table. See "Resheet Parameters icon" section on the facing page for details.

The resheet levels are computed from the defined crossfalls at each cross section. These are applied to any point
on the natural surface at or within the string extents specified in the Resheet Parameters table. In effect, the
shape of the finished cross section, complete with any superelevation, is laid on the current surface to find the
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critical high point. The minimum overlay depth is added to the high point and the resulting level at the center line
is adopted for the design IP level.

To use this option, prepare the required data and click the Compute Resheet Level icon.

Resheet Parameters icon
The Resheet Parameters icon of the Road design view allows you to configure the parameters for the Compute
Resheet Levels options.

Click the icon to open the Resheet Parameters table. Fill in required information and click OK. Fields are
described in the table below.

Fields of the Resheet Parameters table
Field Description

Chainage

Defines the chainage, where the resheet parameters start to be applied, on the
first row of the table. If the minimum depth, left string and right string are the
same for the full length of the road no further rows of data are required.

If the minimum depth or the string extents change, specify the start chainage of
these settings on the next row. The settings will be applied from that chainage.

Min Depth Defines the minimum depth of the resheet or overlay in metres

Left String Select the string that defines the left edge of the computation of the overlay.

Right String Select the string that defines the right edge of the computation of the overlay.

Level Difference icon
The Level Difference icon of the Road design view allows you to calculate level differences along the road
between the defined strings.

To calculate the difference between road levels:
1. At the Profile tab of the Road design view, click the Level Difference icon.

The Compute Level Differences dialog is displayed.
2. From the Design Surface drop-down list, select the surface to be used as the design surface.
3. From the Natural Surface drop-down list, select the surface to be used as the natural surface.
4. From the Left String and Right String drop-down lists, select the edges of the level difference computation.
5. In the Minimum Depth editbox, specify the minimum difference, which will be added to the report.
6. Click OK.

The report, listed level difference details is displayed.

VC Report icon
The VC Report icon of the Road design view allows you to generate a report, listing levels for the different
strings involved in a design, such as the addition of a curb and channel to an existing road or widening a lane of a
road using the existing pavement grading.

To generate a VC Report:
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1. At the Profile tab of the Road design view, click the VC Report icon.

The VC Details dialog is displayed.
2. Configure the parameters as you need and click OK.

The report, listing selected profile details is displayed.
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Design tab
Templates/Tables group

Templates icon
Click it to manage road templates.

Super Elevation icon
Click it to configure the super elevation table.

Create Super Table icon
Click it to create the super elevation table by interfacing the definition of

the HIPs.
Compound Side Slope icon

Click it to define details of the compound side slopes.
Symbol icon

Click it to attach symbols to the special survey codes.
Selection group

Template icon
Click it to define the design surface templates.

Super Table icon
Click it to define super elevation tables to modify a road template.

Design Section icon
Click it to define various sections of an existing surface, which are to be

retained in the final design of road reconstruction work.
Subgrade Selection group

Subgrade Template icon
Click it to define details of the templates used for the individual subgrade

surfaces.
Subgrage Super icon

Click it to apply superelevation tables to modify the templates of the indi-
vidual subgrade surfaces.
Subgrade Section icon

Click it to define the section of an existing road surface to be retained as
part of the subgrade surface.
Pavement Parameters icon

Click it to define a subgrade surface based on a section of the template
used for the surface above.

Side Slopes group
Side Slopes icon

Click it to specify side slopes to be used in the road design by nominating
side slope ratios.

Fixed Offset Slopes icon
Click it to specify side slopes to be used in the road design by nominating

the offset from the string.
Compound Slopes icon

Click it to define the format of any compound side slopes.
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Ditches icon
Click it to define table drains for the road design.

Shoulder Extension icon
Click it to apply verges to a road design

Compute group
Compute Design icon

Click it to compute and store the design surface of the road.

Templates icon
The Templates icon of the Road design view allows you to create and modify the road templates. A road tem-
plate is the road cutting, which may be crated from the base line.

Using of these templates may significantly simplify the roads creation. You only need to create the base line of
the road, and use the "Parallel Figure" command to automatically create the road cutting. See "Parallel Figure
icon" section on page 204 for details.

Buttons and fields of the dialog are described in the tables below

Fields of the Road Template Dialog
Field Description

Template Name Defines the name of the current template. This field also contains the list of the
existing templates. Click to see it.

Vert. Exag. Defines the vertical scale of the template preview.

Template table

HDist Defines the horizontal size of the template segment. See picture below for
details.

VDist

Defines the vertical size of the template segment. See picture below for
details. Positive vertical distance means that the end point of the segment is
higher than the start point. Negative vertical distance means that the end point
of the segment is higher than the start point.

Slope

Defines the slope of the template segment. Positive slope means that the end
point of the segment is higher than the start point. Negative slope means that
the end point of the segment is higher than the start point.

IMPORTANT
The VDist field has the priority. If both VDist and Slope fields
are filled in, the value from the VDist field will be used.

Label Defines the name of the string, created by the template segment.

Plot Defines whether the template segment will be plotted in the preview.
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Road template parameters

Buttons of the Road Template dialog
Button Description

New Click it to create a new template.

Del Template Click it to delete the current template.

CopyToLeft

Click it to copy the right segments to the left.

CAUTION
The left segments will be overwritten. All existing left seg-
ments will be lost.

CopyToRight

Click it to copy the left segments to the right.

CAUTION
The right segments will be overwritten. All existing right seg-
ments will be lost.

CopyFromLib Click it to select the road template from the pre-configure set of templates,
stored in the road template library.

CopyToLib Click it to copy the current template to the library.

Insert Click it to insert an additional row to the template table.

Delete Click it to delete the selected row from the template table.

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Super Elevation icon
The Super Elevation icon of the Road design view allows you to define superelevation and widening details into
individual tables so that changes may be applied to the design template at particular chainages.

Each table contains a number of rows of data that map the change of the crossfall and width of particular legs
defined in the template. The rate of change is dictated by the data entered on any two adjacent rows. This inform-
ation is available to any road in the current job. The Super Elevation Table is applied to the template at the chain-
ages defined by the Super Table icon. See "Super Table icon" section on page 710 for details.

If a Super Elevation Table can be applied as a standard for many projects, its details should be stored in the lib-
rary Super Elevation Table. See "Super Elevation Table icon" section on page 734 for details. You may load con-
figuration from the current table to the library and copy library settings to the library, by using the Copy from Lib
or Copy To Lib buttons respectively.
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A Super Elevation Table will also be used to apply grade and width changes to the template used for subgrade sur-
faces.

To configure the Super Elevation Table:
1. At the Design tab of the Road design view, click the Super Elevation icon.

The Super Table dialog is displayed.
2. Do one of the following:

l From the Super Table drop-down list, select the table for editing.
l Click New to create a new super table, and type its name in the Super Table field.

3. Configure the parameters as you need. Fields are described in the table below. Also, keep in mind the fol-
lowing:

l The first row of information in the table should relate to the existing design template. The first Dist
From SS (Start Superelevation) must be 0, the first Offset To Control should be 0 and the first slope
and width should be equal to the slope and width of the selected leg in the design template. The sub-
sequent rows indicate the changes to be made to this template as distance increases along the align-
ment. The user inputs distance increments and a new cross fall and width to be applied at that point.
Any cross section that lies between the two adjacent rows has its crossfall, and width if widening is
applied, interpolated from this data.

l If the curve is symmetrical and the superelevation returns to the standard template settings at the
same rate as the approach into the curve, the user may simply enter the data from the Start of Super-
elevation to the Maximum Superelevation.

l The option Super Table Selection is used to nominate the chainage at which a super table should
start to be applied. If the table only maps the changes up to the maximum superelevation, the return
to the standard template may be defined from the end of the maximum superelevation.

l It is usual to apply these templates to the first and possibly subsequent legs. If the first leg is
changed using these tables, the other legs will automatically join to the end point of this leg without
the user having to apply changes to them.

l Multiple superelevation changes can be applied at the same chainage range if required. For example
it may be necessary to use one table to apply changes to one leg of the template, and another to
apply changes to another leg where the rate of change is different for this leg. It may be possible to
handle all the necessary changes with one table but multiple tables can be used if necessary.

4. Click OK.

Fields of the Super Table dialog
Field Description

Super Table
Defines the name of the super table.

An existing table cannot be renamed.

Radius This is a label to assist you to select the appropriate table for a particular
radius curve.

Speed This is a label to assist you to select the appropriate table for a particular
design speed.
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Field Description

Left Leg/Right Leg

Defines the number relating to the left template leg and the right template leg
that will be modified by the data in the two columns for width and crossfall
beneath these fields.

Up to two template legs at each side of the template may be modified by the
one super table.

Label
Defines an optional label for particular points defined by each row of the super
table. These will help the user to check the definitions of the changes in the
table/

Dist (From) SS Defines the distance from the start of the changes. The first row is usually set
to 0 and the distances increase through the subsequent rows of data.

Offset (To) Con-
trol

Defines the center line offset to allow for shift in transitions if these are not
applied in the horizontal alignment. The first row must be set to 0 if these set-
tings are used. If this column is left blank the offset to control is assumed to be
0.

Width Defines the width for the relevant template leg at the distance from the SS
(start of the superelevation or widening)

XFall (%) Defines the cross fall as a percentage for the relevant template leg at the dis-
tance from the SS. (start of the superelevation or widening)

Create Super Table icon
The Create Super Table icon of the Road design view allows you to interface the definition of the HIP (hori-
zontal intersection point) of each curve in the horizontal alignment with the selected design template(s), and cre-
ate a suitable Super Elevation Table for that curve.

Before the user can open this option the templates must be defined and allocated to the design by using the Tem-
plate icon. There is no need to have a vertical longitudinal design completed at this stage.

To define the Super Elevation Table:
1. At the Design tab of the Road design view, click the Create Super Table icon.

The Create Super Table dialog is displayed.

The first data for the first curve in the horizontal alignment is displayed. Many fields are greyed out. They
contain data defined elsewhere in the dataset for the selected curve. Some will be modified as data is
entered into the editable fields.

2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.
4. The Super Table dialog is displayed.
5. Review the parameters, if needed change them. See "Super Elevation icon" section on page 703 for details.
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Fields of the Create Super Table dialog
Field Description

Horiz IP The first curve will be listed as Curve1. The drop-down list contains all the
curves in the horizontal alignment in sequence

Table Name Defines the super elevation table name. Type the proper name in the editbox.

Left Crossfall Displays the crossfall of the left leg of the template.

Right Crossfall Displays the crossfall of the right leg of the template.

Left Width Displays the width of the left leg of the template.

Right Width Displays the width of the right leg of the template.

Speed Displays the design speed defined for the HIP.

Radius Displays the radius of the curve defined for the HIP.

Super Displays the superelevation defined for the HIP.

Calc Super Dev Superelevation Development Length is the distance required from the start of
superelevation (SS) through to the maximum superelevation (E).

Line Widening

Widening
A calculated value is displayed for suitable widening of the template leg
through the curve. Accept this or modify the width as required. If no widening
is required set this to 0.000

Apply To Both
Lanes

Tick to widen both lanes through the curve.

Leave unticked to widen only the inside leg of the curve

Incl Ease
Untick this option unless required by local road design standards.

Tick only if required by the local road design standards to include ease and set
the Interval for this data.

Approach
This data defines the superelevation changes going into the curve. The fields
will depend on whether the curve is a plain curve or a spiral curve. For a plain
curve the Spiral Length field is replaced with the Dev/Ratio field.

Spiral Length
Displays the spiral length applied to the curve design in the survey view.

NOTE
This field only displays for spiral curves.

Dev/Ratio

The development ratio of a plain curve may be selected. This ratio defines the
percentage of the superelevation development length that is required prior to
the tangent point approaching the curve and that required past the tangent point
in the body of the curve. Select the appropriate ratio from the drop-down list.

For closely spaced or common curves, all or most of the development will be
within the curve at the departure of the first curve and the approach of the
second curve.

NOTE
This field only displays for plain curves.
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Field Description

Req Super Dev Defines the required superelevation development length for the approach to the
curve. This is usually that computed in the Calc Super Dev field.

Plan Transition Displays the plan transition. It is also known as the pavement rotation length.

Curve Type

The following curve types are available:
l Normal – The curve is positioned in the alignment so that the approach
to the curve starts from the standard crossfalls defined in the template,
and rotates to the maximum superelevation.

l Reverse – The curve is positioned in the alignment so that the curve
starts from the end of a previous curve, and reverses direction. All the
development is within the curve. The curve starts from the 0% tangent
point position and builds up to maximum superelevation.

l Compound – The approach to this curve follows a previous curve in the
same direction, with insufficient room between the curves to return to
the standard crossfall of the template. Usually not recommended by the
design rules of Roading Authorities, but may be necessary in some cir-
cumstances.

Departure
This data defines the superelevation changes leaving the curve. The fields will
depend on whether the curve is a plain curve or a spiral curve. For a plain
curve the Spiral Length field is replaced with the Dev/Ratio field.

Spiral Length
Displays the spiral length applied to the curve design in the survey view.

NOTE
This field only displays for spiral curves.

Dev Ratio

The development ratio of a plain curve may be selected. This ratio defines the
percentage of the superelevation development length that is required prior to
the tangent point approaching the curve and that required past the tangent point
in the body of the curve. Select the appropriate ratio from the drop-down list.

For closely spaced or common curves, all or most of the development will be
within the curve at the departure of the first curve and the approach of the
second curve.

NOTE
This field only displays for plain curves.

Req Super Dev Defines the required superelevation development length for the approach to the
curve. This is usually that computed in the Calc Super Dev field.

Plan Transition Displays the plan transition. It is also known as the pavement rotation length.
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Field Description

Curve Type

The following curve types are available:

Normal – The curve is positioned in the alignment so that the departure from
the curve rotates from the maximum superelevation back to the standard cross-
falls defined in the template.

Reverse – The curve is positioned in the alignment so that it joins to the next
curve, which reverses direction. All the development is within the curve. The
curve rotates from the maximum superelevation and ends at the 0% tangent
point position.

Compound – The departure from this curve allows insufficient room to return to
the standard crossfall of the template, before the next curve, which turns in the
same direction.

Compound Side Slope icon
The Compound Side Slope icon of the Road design view allows you to define details of multiple and varying
side slope legs to form compound side slopes. Each page or sheet of side slope information represents the detail
for one leg of the side slope as it occurs in either a cut or fill situation. Up to four different side slope solutions
may be defined on each sheet, of which only one will be applied. The side slope chosen at each cross section will
depend on the depth to the natural surface compared to the calculated depth of the side slope. An unlimited num-
ber of side slope legs may be defined on multiple sheets.

Information defined in this option is available for any road in the current project. Side slope sheets are applied by
using the Compound Slopes icon.

Compound side slope definitions, that meet standard specifications, should be defined by using the same option
from the Library tab. See "Compound Side Slopes icon" section on page 735 for details. A sheet held in the lib-
rary may be copied from the library into a job, so that it may be modified to suit the job, by clicking Copy From
Lib, or a sheet may be copied to the library for use in other jobs, by clicking Copy To Lib. Library sheets may
also be used directly in the road design.

To configure the compound side slope:
1. At the Design tab of the Road design view, click the Compound Side Slope icon.

The Compound Side Slope dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Compound Side Slope dialog
Field Description

Compound Side
Slope

The $$DEFAULT side slope is displayed. This data relates to one leg of the
compound side slope.

You may create new compound side slopes by clicking New. You may change
the name of the compound side slope in this field.
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Field Description

Cut / Fill
Each section has four rows for defining four varying side slopes, dependent on
the depth to the natural surface compared to the calculated depth of the side
slope. The settings for cut and fill situations will often be different.

Depth Defines the depth below the natural surface (cut) or above the natural surface
(fill) up to which this side slope definition will be applied.

Horizontal
Distance

Defines the horizontal component of the side slope leg. This is usually positive
but could be negative if defining a bridge structure.

Vertical Distance

Defines the vertical component of the side slope leg. This field is not used if
the fixed side slope type is used. This value should be entered as a positive
value, even in a fill situation. A negative value may be used to force a leg in
the opposite direction to the norm.

End Depth Defines the end depth required. It is only used with normal and continue types
of side slope.

Normal The compound side slope is stopped if it intersects the natural surface.

Intersect The side slope continues at the specified grade until the natural surface is inter-
sected.

Fixed Width The side slope intersects the natural surface at the specified width.

Fixed Depth The side slope intersects the natural surface at the specified depth.

Continue The side slope continues for the distance specified. The side slope will con-
tinue through the natural surface to complete the leg

Symbol icon
The Symbol icon the Road design view allows you to define symbols that may be attached to particular feature
codes on a cross section plot.

The symbol is selected from the list of symbols in the symbol library. It is allocated to a code that is available on
any surface in the cross section.

To define symbols:
1. At the Design tab of the Road design view, click the Symbol icon.

The Symbol Table dialog is displayed.
2. In the Code field, type the code to which the symbol will be attached.
3. In the Symbol field, select the required symbol from the drop-down list.
4. In the Scale field, type the required symbol scale.
5. Repeat steps from 2 to 4 for all required codes.
6. Click OK.
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Template icon
The Template icon the Road design view allows you to define a template that will be applied to create the design
surface of a road at specified chainage ranges.

This option does not define the subgrade surfaces, superelevation, batters or table drains.

To configure the design surface templates:
1. At the Design tab of the Road Design view, click the Template icon.

The Template Selection dialog is displayed.
2. In the Chainage field, type the chainage at which a template is applied.
3. In the Template fields, select the required template from the drop-down list. Templates in the current job

are listed in blue text and those in the library in black text.
4. Repeat steps 2 and 3 for all required chainages. Each row defines the start of another template.
5. Click OK.

Super Table icon
The Super Table icon the Road design view allows you to define a super elevation table that will be applied to
modify a road template. These changes are made to either widen a leg of the template or to modify the crossfall
(grade) of a leg of the template through a curve. In many cases both parameters will be changed.

This option only modifies the template legs defined in the super table from the chainage where the super table is
applied until the changes are completed.

To define the super elevation tables:
1. At the Design tab of the Road design view, click the Super Table icon.

The Super Table Selection dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Super Table Selection dialog
Field Description

Station Start
Defines the chainage at which the super table is applied. Each row defines the
start of another super table. The specified chainage relates to the running dis-
tance on the road where a superelevation change table will begin.

Station End

Defines the chainage where a super table is to be reversed. This is only used
when the super table only defines the changes up to the maximum super-
elevation for a symmetrical curve. The specified chainage will relate to the
end of the maximum superelevation where the crossfalls reverse to their stand-
ard settings.

If no reversal is required, leave this field blank

Super Table Select the Super Table from the drop-down list. Super Tables in the current job
are listed in blue text and those in the Library are listed in black text
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Field Description

Mirror

Tick to mirror the changes defined in the super table. Do this to apply the
changes to a curve that turns in the opposite direction to that defined in the
table. The left leg changes are applied to the right leg and vice versa.

Leave this field unticked if the template changes are applied to the curve
exactly as defined in the super table.

Hinge Select a code to hinge the super table off other than the CL.

Design Section icon
The Design Section icon the Road design view allows you to define various sections of an existing surface, which
are to be retained in the final design of road reconstruction work.

Each section is defined by a start and end chainage for its length and by a left and right string for its width. The
strings must exist before this option can be used.

To defines surface sections:
1. At the Design tab of the Road design view, click the Design Section icon.

The Design Section Selection dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. If needed, click the >> at the end of each row to display the Surface Record table for defining subgrade sur-

faces.

The Surface Record dialog is displayed.
4. Fill in the table as you need. Fields are described in the table below.
5. Click OK.
6. Click OK to close the Design Section Selection dialog and apply changes.

Fields of the Design Section Selection dialog
Field Description

Start Chainage Defines the start chainage to define a chainage range within which the selec-
ted section will be applied as part of the design surface.

End Chainage Defines the end chainage to complete a chainage range within which the selec-
ted section will be applied as part of the design surface.

Left String
Select a string from the drop-down list to define the left limit of the section.
This string is usually a natural surface string and must already have been added
to the road dataset.

Left CutBack Defines an optional offset to be applied to the selected string so that the sur-
face will be cut back a fixed distance inside the string.

Right String
Select a string from the drop-down list to define the right limit of the section.
This string is usually a natural surface string and must already have been added
to the road dataset.

Right CutBack Defines an optional offset to be applied to the selected string so that the sur-
face will be cut back a fixed distance inside the string.
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Field Description

Lift Defines a height difference in meters to be added to the selected section, so
that the final surface is raised by this amount to allow for an overlay.

Active Tick to activate the section defined in this row of data.

Fields of the Surface Record dialog
Field Description

Surface Name Select a subgrade name from the drop-down list to define the depth of the sub-
grade at the extents of the section defined in the main table.

Depth Left Defines the depth to this surface from the left limits of the section defined in
the main table.

Depth Right Defines the depth to this surface from the right limits of the section defined in
the main table.

Subgrade Template icon
The Subgrade Template icon the Road design view allows you to define details of the templates used for the
individual subgrade surfaces. These templates are usually different to the design surface template, especially if
curbing is used. The templates are set up in a similar way to those used for the design surface, however the last
leg of the subgrade is controlled by the End Mode setting in this table.

The order in which the subgrade surfaces are applied is determined by the Sequence icon.

To define templates for the individual subgrades:
1. At the Design tab of the Road design view, click the Subgrade Template icon.

The Subgrade Template Selection dialog is displayed.
2. From the Subgrade Surface drop-down list, select the required surface.
3. Fill in the table as you need. Fields are described in the table below.
4. Click OK.

Fields of the Subgrade Template Selection dialog
Field Description

Subgrade Surface
Select the subgrade surface in turn to define their own template details.

Each subgrade surface in the job will be in the drop-down list.

Chainage Defiens the chainage at which a template is applied to the subgrade surface.
Each row defines the start of another template

Template Select the template from the drop-down list. Templates in the current job are
listed in blue text and those in the library in black text.

Depth Defines the depth to the subgrade in metres. This is measured vertically below
the design surface levels of the string that the subgrade is being applied to
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Field Description

Left/Right End
Mode

These two fields control the way the last leg of the subgrade intersects with
either the design surface or the subgrade level on a string to the left or right of
the current string:

l None – The end of the subgrade defined by this template will join to the
end of the same subgrade defined on the adjacent string. If this does not
exist the subgrade will join vertically with the design surface.

l Rural – The end of the subgrade defined by this template will continue
at the crossfall of the last leg until it intersects with the design surface.

l Cut – If this cannot be achieved in a cut situation, the leg con-
tinues out to the end of the design template, verge or table drain
and joins vertically with the design surface at this point.

l Fill – If this cannot be achieved in a fill situation where the sub-
grade is below the batter point, the leg continues out to the batter
and joins vertically with the design surface at this point.

l Urban – The end of the subgrade defined by this template will turn ver-
tically and intersect with the design surface at this point.

Subgrage Super icon
The Subgrade Super icon the Road design view allows you to apply superelevation tables to modify the templates
applied to the individual subgrade surfaces. In many cases the data in the super table defined for the design sur-
face may be duplicated for the subgrade surfaces.

To modify the subgrade templates:
1. At the Design tab of the Road design view, click the Subgrade Super icon.

The Subgrade Super Selection dialog is displayed.
2. From the Subgrade Surface drop-down list, select the required surface.
3. Fill in the table as you need. Fields descriptions may be found in the Super Table icon. Keep in mind, that

each subgrade surface is selected in turn, so that suitable entries may be made for it.
4. Click OK.

Subgrade Section icon
The Subgrade Section icon the Road design view allows you to define the section of an existing road surface to
be retained as part of the subgrade surface or surfaces, when the road is being overlaid using the resheet options.

Each section is defined by a start and end chainage for its length and by a left and right string for its width. The
strings must exist before this option can be used.

To configure the subgrade section selection:
1. At the Design tab of the Road design view, click the Subgrade Section icon.

The Subgrade Section Selection dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
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3. Click OK.

When the Compute Design option is run, the existing natural surface lying between the two strings will be
used as the part of each subgrade surface. Each subgrade surface will return to its specified depth at either
side of this section.

If a subgrade surface is above part of the selected section, it will be defined as a surface over the selected
section until it intersects the natural surface. At this point the natural surface will become part of the sub-
grade surface. This usually occurs only when considerable shape correction is being applied to the road.

Fields of the Subgrade Section Selection dialog
Field Description

Start Station Defines the start chainage to define a chainage range within which the sub-
grades will use the existing surface.

End Station Defines the end chainage to define a chainage range within which the sub-
grades will use the existing surface.

Left String
Select a string from the drop-down list to define the left limit of the section.
This string is usually a natural surface string and must already have been added
to the road dataset.

Right String
Select a string from the drop-down list to define the right limit of the section.
This string is usually a natural surface string and must already have been added
to the road dataset.

Active Tick to activate the section defined in this row.

Pavement Parameters icon
The Pavement Parameters icon the Road design view allows you to define a subgrade surface based on a sec-
tion of the template used for the surface above. Two labels on the template define the section. The subgrade sur-
face also follows the higher surface through any superelevation, so the user does not need to set up templates or
superelevation tables when this feature is used.

Pavement parameters can be set up for different design strings with templates attached to them, enabling multiple
subgrade sections for a single cross section.

To define a subgrade surface:
1. At the Design tab of the Road design view, click the Pavement Parameters icon.

The Pavement Parameters dialog is displayed.
2. From the Subgrade Surface drop-down list, select the required surface.
3. Fill in the table as you need. Fields are described in the table below.
4. Click OK.

Fields of the Pavement Parameters dialog
Field Description

Subgrade Surface
Select the subgrade surface in turn to define their own template details.

Each subgrade surface in the job will be in the drop-down list.
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Field Description

Station
Define the chainage at which the parameters on the row apply. If different
parameters are required for a different segment of the design, enter data on a
new row.

Thickness
Defines the thickness of this subgrade surface in meters.

This is the thickness of this particular surface, unlike the settings for subgrade
templates that are set at a depth from the design surface.

Left Code Defines the code for the left extent of the template used for the subgrade. This
will be a label used in the definition of one leg of the design surface template.

Left Ext If the pavement is to extend to the left of the template leg specified by the
code, specify a distance in meters. Do not specify a negative value.

Left/Right End
Mode

These two fields control the way the last leg of the subgrade intersects with
either the design surface or the subgrade level on a string to the left or right of
the current string:

l None – The end of the subgrade defined by this template will join to the
end of the same subgrade defined on the adjacent string. If this does not
exist the subgrade will join vertically with the design surface.

l Rural – The end of the subgrade defined by this template will continue
at the crossfall of the last leg until it intersects with the design surface.

l Cut – If this cannot be achieved in a cut situation, the leg con-
tinues out to the end of the design template, verge or table drain
and joins vertically with the design surface at this point.

l Fill – If this cannot be achieved in a fill situation where the sub-
grade is below the batter point, the leg continues out to the batter
and joins vertically with the design surface at this point.

l Urban – The end of the subgrade defined by this template will turn ver-
tically and intersect with the design surface at this point.

Right Code
Defines the code for the right extent of the template used for the subgrade.
This will be a label used in the definition of one leg of the design surface tem-
plate.

Right Ext If the pavement is to extend to the right of the template leg specified by the
code, specify a distance in meters. Do not specify a negative value.

Side Slopes icon
The Side Slopes icon the Road design view allows you to specify side slopes to be used in the road design by nom-
inating side slope ratios. The ratios are defined as 1 for the vertical element and the value entered in the table as
the horizontal element of the ratio.

A side slope is a leg that is attached to the end of the last template leg (the hinge point) and pivots round this point
to follow the slope specified at a particular chainage until the side slope intersects with the natural surface. This
position will become the batter point and will be the extent of the design surface. These points are labelled LBAT
and RBAT on the design surface.
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If your need side slopes to finish at a particular offset from the centreline, you should use the Fixed Offset Slopes
icon.

To specify side slopes for the road design:
1. At the Design tab of the Road design view, click the Side Slopes icon.

The Side Slopes dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Side Slopes dialog
Field Description

Start Chainage Define the start chainage for the side slope settings defined on this row

Left/Right Cut
Defines the horizontal component of the side slope to be applied in cut situ-
ations to the left and right ends of the template. Leave a field blank if no slop-
ing side slope is to be applied.

Left/Right Fill
Defines the horizontal component of the side slope to be applied in fill situ-
ations to the left and right ends of the template. Leave a field blank if no slop-
ing side slope is to be applied.

Fixed Offset Slopes icon
The Fixed Offset Slopes icon the Road design view allows you to specify side slopes to be used in the road
design by nominating the offset from the string where the side slope intersects the natural surface. The side slope
intercept is specified in meters to the left or right of the string.

To specify side slopes for the road design:
1. At the Design tab of the Road design view, click the Fixed Offset Slopes icon.

The Fixed Offset Slopes dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Side Slopes dialog
Field Description

Start Chainage Define the start chainage for the side slope settings defined on this row

Left/Right Offset
Defines the horizontal offset from the design string to create the side slope
intercept with the natural surface. Leave the field blank if no fixed width side
slope is required at one side of the string

Compound Slopes icon
The Compound Slopes icon the Road design view allows you to define the format of any compound side slopes
required in the road design. You can select the format for each leg of the compound side slope from the legs
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defined on individual pages by using the Compound Side Slope icon.

A compound side slope contains one or more legs that are used to create a suitable intercept with the natural sur-
face, allowing for benching where the design of the road requires it. This is usually due to the difference in depth
between the surfaces or the material in which the road is to be built.

This option is only used when sloping or fixed width batters are not suitable.

To assign the compound side slopes:
1. At the Design tab of the Road design view, click the Compound Slopes icon.

The Compound Side Slopes Selection dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Compound Side Slopes Selection dialog
Field Description

Station Start Defines the start chainage to define a chainage range within which the com-
pound side slope will be applied.

Station End Defines the end chainage to define a chainage range within which the com-
pound batter will be applied.

Compound Batter
Left

In this column select the sheet or page that will define the first leg of the com-
pound side slope at the left side of the design. The second leg will be set on the
second row and subsequent legs on the third row onwards, until the compound
side slope has been completely defined. The last leg would usually enable an
intercept with the natural surface.

Leave the rows blank if no compound batter is allocated at the left.

Compound Batter
Right

In this column select the sheet or page that will define the first leg of the com-
pound side slope at the right side of the design. The second leg will be set on
the second row and subsequent legs on the third row onwards, until the com-
pound side slope has been completely defined. The last leg would usually
enable an intercept with the natural surface.

Leave the rows blank if no compound batter is allocated at the left.

Ditches icon
The Ditches icon the Road design view allows you to define table drains for the road design. The table drain will
be attached to the last leg of the road template and if a side slope is specified, the side slope will be attached to
the last leg of the table drain. The table drain can be defined with one leg, forming a V-shaped drain with the side
slope leg, or with two legs, forming a U-shaped drain with the side slope leg.

This option only applied in a cut situation.

To define table drains:
1. At the Design tab of the Road design view, click the Ditches icon.

The Ditches dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.
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The table drains will be created and displayed in the cross section pane when the Compute Design icon is
clicked.

Fields of the Ditches dialog
Field Description

Start Chainage Defines the start chainage for the addition of the table drains defined on this
row.

H1 Defines the horizontal component of the first leg of the drain in meters. Leave
the field blank if no drain is to be applied.

V1
Defines the vertical component of the first leg of the drain in meters. The end
of this leg will be lower than, or equal to, the start of the leg. This is defined as
a depth so no minus sign should be entered.

H2 Defines the horizontal component of the second leg of the drain in meters.
Leave the field blank if no second leg is required.

V2
Defines the vertical component of the second leg of the drain in meters. The
end of the leg will be higher than, or equal to, the start of the leg. Enter 0.00
for a leg that has no crossfall

Mode

The Mode is used to define whether the template is assumed to be in a cut situ-
ation at a cross section.

Tick to apply the table drain, if the invert of the drain is below the natural sur-
face level.

Leave unticked to apply the table drain, if the end leg of the template is below
the natural surface level.

Shoulder Extension icon
The Shoulder Extension icon the Road design view allows you to apply verges to a road design. A verge is an
extension of the last leg of the template and it continues at the existing crossfall for a specified width. Verges can
be applied to a section of the road.

Verges are only applied where the template ends in a fill situation.

To apply a verge:
1. At the Design tab of the Road design view, click the Shoulder Extension icon.

The Shoulder Extension dialog is displayed.
2. Fill in the table as you need. Fields are described in the table below.
3. Click OK.

Fields of the Shoulder Extension dialog
Field Description

Start Chainage Defines the start chainage for the additional verges defined on this row.
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Field Description

Left Width Defines the width of the verge. This extends the last left hand leg of the tem-
plate by this horizontal width. Leave the field blank if no verge is to be applied.

Right Width Defines the width of the verge. This extends the last right hand leg of the tem-
plate by this horizontal width. Leave the field blank if no verge is to be applied.

Plot
Tick to plot a leader with levels for the verges on the cross sections.

Leave unticked to plot the lines only.

Compute Design icon
The Compute Design icon the Road design view allows you to compute and store the design surface of the road.
It should be used when any of the design parameters are altered to update the design surface in the alignment and
cross section panes and to save the design ready for the next stage.

Click the icon to compute the design. The design surface is computed to reflect the new design parameters. The
results are displayed in the road design view panels.
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Plotting tab
Plot Settings group

Profile Settings icon
Click it to configure profile plotting parameters.

Cross Section Settings icon
Click it to configure cross section plotting parameters.

Plot group
Standard Profile icon

Click it to plot a standard profile as a drawing.
Offset Profile icon

Click it to plot an offset profile as a drawing
Cross Section icon

Click it to plot sheets of cross sections as a drawing.

Profile Settings icon
The Profile Settings icon of the Road design view allows you to customize all of the parameters necessary to cre-
ate a profile drawing.

You may use two formats of plotting:
l Standard Format – A leader line is defined for each chainage and level position of the natural and design
surfaces.

l Grid Format – A grid is displayed with leaders at nominated intervals of chainage.

To configure a profile plotting:
1. At the Plotting tab of the Road design view, click the Profile Settings icon.

The Profile Plot Settings dialog is displayed.
2. At the General Plot Settings tab, configure the position of the profile drawing on a title block; define the

scales and the information included on the profile. See "General Plot Setting tab" section on the facing
page for fields description.

3. At the Standard Profile Settings tab, configure the plot parameters for the two profile lines. See "Standard
Profile Settings tab" section on page 723 for fields description.

4. At the Offset Profile Settings tab, define up to 8 profile lines along a selection of different strings and from
different surfaces. It is only used when plotting offset profiles. See Offset Profile Settings tab for fields
description.

5. At the Profile Table tab, define standard parameters for plotting profile sections. See "Profile Table tab"
section on page 724 for fields description.

6. At the Cut/Fill Settings tab, define the plot parameters for the cut/fill row on the profile layout. See
"Cut/Fill Settings tab" section on page 725 for fields description.

7. At the Volumes Settings tab, define the plot parameters for the volumes row on the profile layout. See
"Volume Settings tab" section on page 726 for fields description.

8. Click OK.

720



Profile Settings icon

General Plot Setting tab
This section describes the General Plot Settings tab of the Profile Plot Settings dialog of the Road design view.
At this tab you may position the profile drawing, or drawings, on a title block. Additional settings define the scales
used the required information included on the profile.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the General Plot Settings tab
Field Description

Horizontal Scale
(1 in .) Defines the horizontal scale for the profile.

Vertical Scale (1
in .) Defines the vertical scale for the profile.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block.

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block.

Minimum Datum
Select the radiobutton to this option to define a minimum datum level in mil-
limeters on the plan. The value specified in the editbox sets the minimum dis-
tance of the profile line from the datum line of the profile layout.

Maximum Datum

If the Minimum Datum radiobutton is selected, specify the maximum datum
level in millimeters on the plan. The specified value sets the maximum dis-
tance of the profile line from the datum line of the profile layout.

If the profile line is still rising when the maximum datum is reached, the datum
will be reset to the minimum datum position

Datum Level Select the radiobutton to this option to define a fixed datum level (in meters) in
the editbox. The profile line will be drawn relevant to this level on the profile.

Max Plot Length

Defines the maximum plot length of the profile layout in millimeters on the
selected title block. This length will need to be modified for smaller paper
sizes.

For example, Max Plot Length = 700 represents 700mm on an A1 sheet.

Start Station
Defines the start chainage of the profile for this drawing.

Default is 0.000 and can be used if the full length of the road is to be plotted

End Station
Defines the end chainage of the profile for this drawing.

Default is 99999.999 and can be used if the full length of the road is to be plot-
ted
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Field Description

Title Block Defines the required title clock to the drawing. Select it from the library by
clicking >>.

Plot Grid Tick to plot in a Grid Format.

Station Interval Defines the chainage intervals.

Horizontal Inter-
val Defines the space between the horizontal grid lines in meters.

Vertical Interval Defines the space between the vertical grid lines in meters.

Grid Height

Defines the height of the grid above the datum line on the drawing in mil-
limetres.

If this height is greater than the height available on the title block, the plot will
stop at the extents of the title block.

Plot Datum Tick to plot the datum value at the left hand end of the datum line.

Plot IPs Tick tto plot the levels of the IP positions on the leader line below the profile
line.

Plot Min/Max Tick to plot the high and low point details on the surface of the design profile.

Plot Obstructions Tick to plot any obstructions.

Plot VC Length Tick to plot all the vertical curve lengths. These are plotted in a horizontal line
between the profile line and the datum line.

Plot VC Grade Tick to plot all the grades between IPs. These are plotted in a horizontal line
between the profile line and the datum line.

Super Elevation
Details

Tick to plot an extra row of data at the bottom of the profile. The super-
elevation details for the various curves in the design are plotted.

Plot Cut/Fill

Tick to plot an extra row of data above the surface levels. The cut or fill dif-
ference between the natural surface and design surface is plotted. The para-
meters from the Cut/Fill Settings tab must be configured to achieve the correct
results

Plot Volumes

Tick to plot an extra row of data above the surface levels. The volumes
between the adjacent cross sections are displayed as cut and fill. The para-
meters from the Volume Settings tab must be configured to achieve the correct
results.

Alignment Details Tick to plot an extra row of data below the chainages of the profile. The hori-
zontal alignment details for the road are plotted.

Extra Row Tick to include an extra row at the bottom of the profile figure for additional
information.

With Leader
Tick to extend the leader lines through this new row.

Leave unticked to leave the row free of leader lines.
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Standard Profile Settings tab
This section describes the Standard Profile Settings tab of the Profile Plot Settings dialog of the Road design
view. At this tab you may configure the plot parameters for the two profile lines. Use it to plot a profile containing
only the design and natural surface profiles of the current string. Select line types and colors for these two sur-
faces.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Standard Profile Settings tab
Field Description

Design Surface

Tick the Active checkbox to plot the profile of the design surface and its data.
Specify a label in the editbox. The label is used to name this row of levels on
the profile plot.

Select the color, line type and thickness of the design profile line, and select
the text style used for the design surface levels.

Natural Surface

Tick the Active checkbox to plot the profile of the natural surface and its data.
Specify a label in the editbox. The label is used to name this row of levels on
the profile plot.

Select the color, line type and thickness of the natural profile line, and select
the text style used for the natural surface levels.

Justification Select the required justification table from the drop-down list to set the format
and precision of the chainage and level numerical data on the profile plot.

Plot Sequence Define the order in which the three lines of detail will be plotted.

Offset Profile Settings tab
This section describes the Offset Profile Settings tab of the Profile Plot Settings dialog of the Road design view.
At this tab you may define up to 8 profile lines along a selection of different strings and from different surfaces.
Each profile line may have a separate datum by allocating spacing by using the Sep column. This data is only used
when plotting offset profiles.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Offset Profile Settings tab
Field Description

Active Tick to define and later plot the profile of a string on a nominated surface.
When the checkbox is ticked the row is activated for data entry.

String Selected a string from the drop-down list. The strings will be from the natural
surface data and any strings created for the design.

Surface Select a surface from the drop-down list. The surfaces listed will be every nat-
ural, design and subgrade surface created for the road.
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Field Description

Label Specify a label in this field. The label is used to name the levels for this profile
on the profile plot.

Color Select a color for the profile line defined on this row.

Sep
For all profile lines at the same datum, leave this field set to 0.00

To allocate a separation to the profiles on the profile plot, specify a value in
millimeters.

Justification Select the required justification table from the drop-down list to set the format
and precision of the chainage and level numerical data on the profile plot.

In each row you may click >> to open the Additional Offset Profile Specification dialog.

Fields of the Additional Offset Profile Specification dialog
Field Description

Text Style Defines the text style used for the levels of this profile line.

Line Style Defines the line style used for this profile line.

Thickness Defines the line thickness used for this profile line.

Profile Table tab
This section describes the Profile Table tab of the Profile Plot Settings dialog of the Road design view. At this
tab you may define standard parameters for plotting longitudinal sections. The parameters stored in the profile
table will be used for both offset profile and standard profile drawings.

The Profile Table is used to define the appearance of the profile layout with respect to grid lines, leaders, hori-
zontal line spacings, labels, text types and colors.

You may save the configuration to the default one, by clicking Save To Lib. These settings will be available in
other projects.

To load previously saved configuration, click Load From Lib.

Fields of the Profile Table tab
Field Description

Horizontal Lines Defines the color and thickness for the horizontal lines.

Grid/Leader Lines Defines the color and thickness for the horizontal lines.

Line Spacing Defines the spacing between the horizontal lines.

Station Tolerance Defines the tolerance for the chainage grid.

Station Format Defines the format of chainage displaying.

Station Label Defiles the label and the text style for station labels.

Stations Defines the text and justification styles for stations.

Datum Defines the text and justification styles for datum.

724



Profile Settings icon

Field Description

IP Max/Min Defines the text and justification styles for max and min IPs.

VC Grade Defines the text and justification styles; and the line color for the VC grade
lines.

VC Length Defines the text and justification styles; and the line color for the VC length
lines.

Align Defines the text and justification styles; and the line color for the alignment
lines.

Super Defines the text and justification styles; and the line color for the super elev-
ation lines.

Cut/Fill Settings tab
This section describes the Cut/Fill Settings tab of the Profile Plot Settings dialog of the Road design view. At this
tab you may define the plot parameters for the cut/fill row on the profile layout.

This option enables the correct level differences between nominated surfaces to be computed and plotted on the
profile. When using the standard profile option, the cut/fill differences will be between the natural surface and
design surface at the center line or string position.

When using the offset profile option, the cut/fill differences may be defined between any nominated surfaces.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Cut/Fill Settings tab
Field Description

First Line

Defines the number for the first surface to compute the cut/fill.

If plotting standard profile the natural surface is surface 2 and the design sur-
face is surface 1.

If plotting offset profile the surface number is taken from the row number on
the Offset Profile Settings tab.

Second Line Defines the number of the second surface to complete the cut/fill.

First Line Text Defines the text required on the first line of the label in a 2 line format, or the
only line of the label in a 1 line format.

Second Line Text Defines the text required on the Second line of the label in a 2 line format, or
the only line of the label in a 1 line format.

Text Style (Cut) Defines the text style used for the cut data.

Text Style (Fill) Defines the text style used for the fill data.

Justification Defines the justification style used for the cut/fill data.

Cut Text Before Defines text that is required before each cut numeric.

Cut Text After Defines text that is required after each cut numeric.
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Field Description

Fill Text Before Defines text that is required before each fill numeric.

Fill Text After Defines text that is required after each fill numeric.

Line Format

Defines the line format:
l 1 Line – fill depth is written as a negative number such as -1.2 and cut
depth is written as a positive number such as +1.5

l 2 Lines – fill depth is written as a negative number on the first line and
cut depth is written as a positive number on the second line.

Sign

l Show +/- – Select to show the positive and negative sign on the cut and
fill values. This would usually be selected for a 1 line format.

l No Sign – Select to show no signs on the cut and fill values. This may be
used if a 2 lines format is chosen.

Volume Settings tab
This section describes the Volumes Settings tab of the Profile Plot Settings dialog of the Road design view. At
this tab you may define the plot parameters for the volumes row on the long section layout.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Volumes Settings tab
Field Description

Text Defines the text used as a label for this row of data on the profile.

Text Style (Cut) Defines the text style used for the cut volumes.

Text Style (Fill) Defines the text style used for the fill volumes.

Justification Defines the justification table used for the format and precision of the numeric
data plotted for the volumes.

Cross Section Settings icon
The Cross Section Settings icon of the Road design view allows you to customize all of the parameters neces-
sary to create a cross section drawing.

To configure a cross section plotting:
1. At the Plotting tab of the Road design view, click the Cross Section Settings icon.

The Cross Section Plot Settings dialog is displayed.
2. At the Cross Section Plot Settings tab, configure the position of the cross section drawing on a title block;

define the scales and the information included on the cross section. See "Cross Section Plot Setting tab"
section on the facing page for fields description.

3. At the Surface Plot Settings tab, define the plot parameters for the various surfaces included in the
drawing. See "Surface Plot Settings tab" section on page 729 for fields description.
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4. At the Cross Section Table tab, define the standard plot parameters for the cross section layout, including
the text styles used.

5. Click OK.

Cross Section Plot Setting tab
This section describes the Cross Section Plot Settings tab of the Cross Section Plot Settings dialog of the Road
design view. At this tab you may position the cross section drawing, or drawings, on a title block. Additional set-
tings define the scales used the required information included on the cross section.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Cross Section Plot Settings tab
Field Description

Horizontal Scale
(1 in .) Defines the horizontal scale for the cross section.

Vertical Scale (1
in .) Defines the vertical scale for the cross section.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
cross section layout. This is measured in millimeters from the bottom left
corner of the title block.

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
cross section layout. This is measured in millimeters from the bottom left
corner of the title block.

Left / Right Plot
Limit-Figures

Defines the offset limits for the plotting of offset and level figures.

Defines an offset in meters to the left and right of the center line or string
around which the sections are designed. Any data outside this limit is excluded
from the cross sections.

Left / Right Plot
Limit-Lines

Defines the offset limits for the plotting of lines.

Defines an offset in meters to the left and right of the center line or string
around which the sections are designed. Any data outside this limit is excluded
from the cross sections

Start Chainage
Defines the start chainage of the cross sections for this drawing.

Default is 0.000 and can be used if the full length of the road is to be plotted.

End Chainage
Defines the end chainage of the cross sections for this drawing.

Default is 99999.999 and can be used if the full length of the road is to be plot-
ted.

Title Block Defines the required title clock to the drawing. Select it from the library by
clicking >>.
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Field Description

Datum Level

Tick to specify a fixed datum level (in metres) in the editbox. The cross sec-
tions will be drawn relevant to this level on all the sections, even when the
grade of the road changes.

Leave unticked for the datum to be reset to a suitable value by the software, fol-
lowing the rules in the cross section Table.

Design Level
Selections

The format of the fields in this section will be dependent on the setting for the
radiobutton in the Type field below. They are only applied on rural format cross
sections.

Type

l Offsets – The editboxes from the Design Level Selection group box are
set for the input of specified offsets. Specify a minus sign for offsets to
the left of the center line. Levels will be interpolated from the design sur-
face at these offsets and plotted on the cross sections at these positions
for rural format cross sections.

l Labels(Codes) – The editboxes from the Design Level Selection group
box are set for the input of the labels or codes applied to the ends of par-
ticular legs of the cross section. Levels will be interpolated from the
design surface at these points and plotted on the rural format cross sec-
tions.

Spacing

l Regular – Cross sections are positioned on the sheet by the row spacing
set in the Cross Section Table, so that this vertical spacing is applied
from the datum line of the first section to the datum line of the next sec-
tion.

l Auto – Cross sections are positioned on the sheet by the Auto row spa-
cing set in the Cross Section Table, so that this vertical spacing is
applied from the highest point on the first section to the datum line of the
next section.

X Fall Fomat
l Percent (%) – the crossfall will be represented in percents withing the
specified range.

l Ratio (1:x) – the crossfall will be represented as ratio.

Level Difference

Tick to plot the height difference between the natural and design surfaces at
each offset on the full format cross sections. These are plotted in an extra row
above the surface levels. Where the design surface is cut below the natural sur-
face the level difference is negative.

Plot Sign On
XFall

Tick to plot the minus sign on the crossfall, if the crossfall is activated on the
Surface Plot Settings tab.

Plot Volumes Tick to plot the volumes between this cross section and the previous one. The
volumes must have been computed using the Compute Volumes icon.

728



Cross Section Settings icon

Field Description

Plot design level
on natural leader

Tick to plot the design surface levels on the leader lines for the natural surface
when a full format cross section is plotted.

A design level will be interpolated and plotted wherever there is a leader line
relating to the natural surface.

Leave unticked to plot the design levels only where the leader lines relate to
the design surface.

Plot natural level
on design leader

Tick to plot the natural surface levels on the leader line for the design surface
when a full format cross section is plotted.

A natural surface level will be interpolated and plotted wherever there is a
leader line relating to the design surface.

Leave unticked to plot the natural surface levels only where the leader lines
relate to the natural surface.

Plot Obstructions Tick to plot any obstructions.

Mirror Cross Sec-
tion Tick to mirror the cross section plotting for the both sides.

Surface Plot Settings tab
This section describes the Surface Plot Settings tab of the Cross Section Plot Settings dialog of the Road design
view. At this tab you may define the plot parameters for the various surfaces included in the drawing. Additional
options allow you to label cross sections with cross falls and plot symbols on each section.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Surface Plot Settings tab
Field Description

Active Tick to plot the surface defined on this row of the dialog.

Surface Select the required surface from the drop-down list.

Label Defines the surface name, used to label rows of levels on the full format cross
sections.

Plot Levels

Tick to plot the levels for this surface, or leave unticked to plot no levels for
this surface. Subgrades usually have this box unticked. A row of levels is
included in the full format cross sections. The centreline level is displayed for
the surface for rural format cross sections.

Plot Lines Tick to plot the line work for this surface. If the check box is unticked no lines
will appear on the plot for this surface.

Plot XFalls Tick to plot the crossfalls on the surface. Leave unticked to exclude crossfalls.
Normally this checkbox is only ticked for the design surface.
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Field Description

Plot Leads
Tick to plot the leader lines for this surface on the full format cross section.
Normally this checkbox is ticked for the natural and design surfaces but not for
the subgrades.

Plot Symbols

Tick to plot the symbols defined in the symbol table. See "Symbol icon" section
on page 709 for details. Normally this box is ticked only for the Natural surface
to marked specific features such as fence lines, boundaries or existing seal pos-
itions

Plot Codes Tick to plot the survey codes from the cross section. If ticked, click >> and spe-
cify the codes for plotting in the table.

Color Defines the color plotted for this surface on the cross sections.

Angle
Defines the angle for the display of design levels specified for rural format
cross sections using the field Design Level Selection from the Cross Section
Plot Setting tab.

In each row you may click >> to open the More Surface Plot Specification dialog.

Fields of the More Surface Plot Specification dialog
Field Description

Text Style Defines the text style used for the levels of this surface.

Line Style Defines the line style used for this surface.

Thickness Defines the line thickness used for this surface.

Justification Defines the justification style used for this surface.

Standard Profile icon
The Standard Profile icon of the Road design view allows you to plot a standard long section as a drawing in the
drawings view. A standard long section contains profiles of the natural surface and the design surface for the cur-
rent string in the roads view.

Click the icon to plot the profile. The drawings view is opened as the current view and a linked drawing is cre-
ated containing the sheet or sheets that make up the long section drawing.

If more than one sheet is required to plot the long section at the required scale on the selected title block, multiple
sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Standard Profile icon again from the roads view, as this will
create another drawing, losing any modifications already made in the drawings view.

Offset Profile icon
The Offset Profile icon of the Road design view allows you to plot an offset long section as a drawing in the
drawings view. An offset long section contains up to 8 profiles along various strings and surfaces in the roads
view.
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Click the icon to plot the profile. The drawings view is opened as the current view and a linked drawing is created
containing the sheet or sheets that make up the offset long section drawing.

If more than one sheet is required to plot the long section at the required scale on the selected title block, multiple
sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Offset Profile icon again from the roads view, as this will cre-
ate another drawing, losing any modifications already made in the drawings view.

Cross Section icon
The Cross Section icon of the Road design view allows you to plot sheets of cross sections as a drawing in the
drawings view.

Click the icon to plot the cross section. The drawings view is opened as the current view and a linked drawing is
created containing the sheet or sheets that make up the cross section drawing.

If more than one sheet is required to plot the cross section at the required scale on the selected title block, multiple
sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Cross Section icon again from the roads view, as this will cre-
ate another drawing, losing any modifications already made in the drawings view.
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Library tab
Templates group

Templates icon
Click it to manage road templates library.

Super Elevation Table icon
Click it to configure the super elevation table library.

Compound Side Slopes icon
Click it to define details of the compound side slopes library.

Plot Table group
Profile Plot Table icon

Click it to configure the standard parameters for plotting profile sec-
tions.

Cross Section Plot Table icon
Click it to configure the standard plot parameters for the cross section

layout
Reference group

Sight Distance icon
Click it to manage the sight distance tables.

Symbol icon
Click it to attach symbols to the special survey codes

Friction Factors icon
Click it to manage the friction factor tables.

Curve Radius icon
Click it to manage the curve radius tables.

Templates icon
The Templates icon of the Road design view allows you to create and modify the library road templates. A road
template is the road cutting, which may be crated from the base line.

Road templates from the library are available for all MAGNET Office projects.

Using of these templates may significantly simplify the roads creation. You only need to create the base line of
the road, and use the "Parallel Figure" command to automatically create the road cutting. See "Parallel Figure
icon" section on page 204 for details.

Buttons and fields of the dialog are described in the tables below

Fields of the Road Template Dialog
Field Description

Template Name Defines the name of the current template. This field also contains the list of the
existing templates. Click to see it.
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Field Description

Vert. Exag. Defines the vertical scale of the template preview.

Template table

HDist Defines the horizontal size of the template segment. See picture below for
details.

VDist

Defines the vertical size of the template segment. See picture below for
details. Positive vertical distance means that the end point of the segment is
higher than the start point. Negative vertical distance means that the end point
of the segment is higher than the start point.

Slope

Defines the slope of the template segment. Positive slope means that the end
point of the segment is higher than the start point. Negative slope means that
the end point of the segment is higher than the start point.

IMPORTANT
The VDist field has the priority. If both VDist and Slope fields
are filled in, the value from the VDist field will be used.

Label Defines the name of the string, created by the template segment.

Plot Defines whether the template segment will be plotted in the preview.

Road template parameters

Buttons of the Road Template dialog
Button Description

New Click it to create a new template.

Del Template Click it to delete the current template.

CopyToLeft

Click it to copy the right segments to the left.

CAUTION
The left segments will be overwritten. All existing left seg-
ments will be lost.

CopyToRight

Click it to copy the left segments to the right.

CAUTION
The right segments will be overwritten. All existing right seg-
ments will be lost.

Insert Click it to insert an additional row to the template table.

Delete Click it to delete the selected row from the template table.
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Button Description

OK Click it to save the changes and close the dialog.

Cancel Click it to close the dialog without saving changes.

Super Elevation Table icon
The Super Elevation Table icon of the Road design view allows you to define superelevation and widening
details into individual tables so that changes may be applied to the design template at particular chainages.

Each table contains a number of rows of data that map the change of the crossfall and width of particular legs
defined in the template. The rate of change is dictated by the data entered on any two adjacent rows. This inform-
ation is available to any road in the current job.

The library Super Elevation Table can be applied as a standard for many projects.

A Super Elevation Table will also be used to apply grade and width changes to the template used for subgrade sur-
faces.

To configure the Super Elevation Table:
1. At the Library tab of the Road design view, click the Super Elevation icon.

The Super Table dialog is displayed.
2. Do one of the following:

l From the Super Table drop-down list, select the table for editing.
l Click New to create a new super table, and type its name in the Super Table field.

3. Configure the parameters as you need. Fields are described in the table below. Also, keep in mind the fol-
lowing:

l The first row of information in the table should relate to the existing design template. The first Dist
From SS (Start Superelevation) must be 0, the first Offset To Control should be 0 and the first slope
and width should be equal to the slope and width of the selected leg in the design template. The sub-
sequent rows indicate the changes to be made to this template as distance increases along the align-
ment. The user inputs distance increments and a new cross fall and width to be applied at that point.
Any cross section that lies between the two adjacent rows has its crossfall, and width if widening is
applied, interpolated from this data.

l If the curve is symmetrical and the superelevation returns to the standard template settings at the
same rate as the approach into the curve, the user may simply enter the data from the Start of Super-
elevation to the Maximum Superelevation.

l The option Super Table Selection is used to nominate the chainage at which a super table should
start to be applied. If the table only maps the changes up to the maximum superelevation, the return
to the standard template may be defined from the end of the maximum superelevation.

l It is usual to apply these templates to the first and possibly subsequent legs. If the first leg is
changed using these tables, the other legs will automatically join to the end point of this leg without
the user having to apply changes to them.

l Multiple superelevation changes can be applied at the same chainage range if required. For example
it may be necessary to use one table to apply changes to one leg of the template, and another to
apply changes to another leg where the rate of change is different for this leg. It may be possible to
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handle all the necessary changes with one table but multiple tables can be used if necessary.
4. Click OK.

Fields of the Super Table dialog
Field Description

Super Table
Defines the name of the super table.

An existing table cannot be renamed.

Radius This is a label to assist you to select the appropriate table for a particular
radius curve.

Speed This is a label to assist you to select the appropriate table for a particular
design speed.

Left Leg/Right Leg

Defines the number relating to the left template leg and the right template leg
that will be modified by the data in the two columns for width and crossfall
beneath these fields.

Up to two template legs at each side of the template may be modified by the
one super table.

Label
Defines an optional label for particular points defined by each row of the super
table. These will help the user to check the definitions of the changes in the
table/

Dist (From) SS Defines the distance from the start of the changes. The first row is usually set
to 0 and the distances increase through the subsequent rows of data.

Offset (To) Con-
trol

Defines the center line offset to allow for shift in transitions if these are not
applied in the horizontal alignment. The first row must be set to 0 if these set-
tings are used. If this column is left blank the offset to control is assumed to be
0.

Width Defines the width for the relevant template leg at the distance from the SS
(start of the superelevation or widening)

XFall (%) Defines the cross fall as a percentage for the relevant template leg at the dis-
tance from the SS. (start of the superelevation or widening)

Compound Side Slopes icon
The Compound Side Slope icon of the Road design view allows you to define details of multiple and varying side
slope legs to form compound side slopes. Each page or sheet of side slope information represents the detail for one
leg of the side slope as it occurs in either a cut or fill situation. Up to four different side slope solutions may be
defined on each sheet, of which only one will be applied. The side slope chosen at each cross section will depend
on the depth to the natural surface compared to the calculated depth of the side slope. An unlimited number of side
slope legs may be defined on multiple sheets.

These compound side slope definitions, meet standard specifications, and available for all MAGNET Office pro-
jects.

To configure the compound side slope:
1. At the Library tab of the Road design view, click the Compound Side Slope icon.

The Compound Side Slope dialog is displayed.

735



Road design view

2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Compound Side Slope dialog
Field Description

Compound Side
Slope

The $$DEFAULT side slope is displayed. This data relates to one leg of the
compound side slope.

You may create new compound side slopes by clicking New. You may change
the name of the compound side slope in this field.

Cut / Fill
Each section has four rows for defining four varying side slopes, dependent on
the depth to the natural surface compared to the calculated depth of the side
slope. The settings for cut and fill situations will often be different.

Depth Defines the depth below the natural surface (cut) or above the natural surface
(fill) up to which this side slope definition will be applied.

Horizontal
Distance

Defines the horizontal component of the side slope leg. This is usually positive
but could be negative if defining a bridge structure.

Vertical Distance

Defines the vertical component of the side slope leg. This field is not used if
the fixed side slope type is used. This value should be entered as a positive
value, even in a fill situation. A negative value may be used to force a leg in
the opposite direction to the norm.

End Depth Defines the end depth required. It is only used with normal and continue types
of side slope.

Normal The compound side slope is stopped if it intersects the natural surface.

Intersect The side slope continues at the specified grade until the natural surface is inter-
sected.

Fixed Width The side slope intersects the natural surface at the specified width.

Fixed Depth The side slope intersects the natural surface at the specified depth.

Continue The side slope continues for the distance specified. The side slope will con-
tinue through the natural surface to complete the leg

Sight Distance icon
The Sight Distance icon of the Road design view allows you to manage the sight distance tables library.

A sight distance table is used when editing a vertical IP, to create a vertical curve that is based on sight distance
criteria from the applicable standards such. You set up multiple tables in the library based on local standards.

These tables will be available for all MAGNET Office projects.

To create a new sight distance table:
1. At the Library tab of the Road design view, click the Sight Distance icon.

The Sight Distance dialog is displayed.
2. Click New.
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3. In the Sight Distance editbox, type the name of the new sight distance table.
4. Fill in the table. Fields are described in the table below.
5. Click OK.

To edit an existing sight distance table:
1. At the Library tab of the Road design view, click the Sight Distance icon.

The Sight Distance dialog is displayed.
2. From the Sight Distance drop-down list, select the required sight distance table.
3. Fill in the table. Fields are described in the table below.
4. Click OK.

Fields of the Sight Distance dialog
Field Description

Sight Distance This is the name of the current sight distance table.

Speed Defines the design speed for the parameters on this row of data.

Stopping Defines the visibility required (in meters) to see an object in the lane of travel
and stop before striking it.

Intermediate
Defines a value (in meters) that enables a driver to travel a road in comfort
with reasonably safe overtaking opportunities. This is used in a situation where
the Overtaking sight distance provision is prohibited by cost.

Overtaking
Defines a value (in meters) that provides sufficient visibility to detect oncom-
ing vehicles in time to allow safe overtaking of a vehicle moving below the
speed limit.

Headlight Defines a value (in meters) that enables a drive to sight a stopped vehicle. This
is usually only used at low speeds.

Symbol icon
The Symbol icon the Road design view allows you to define symbols that may be attached to particular feature
codes on a cross section plot.

The symbol is selected from the list of symbols in the symbol library. It is allocated to a code that is available on
any surface in the cross section.

To define a new symbols table:
1. At the Library tab of the Road design view, click the Symbol icon.

The Symbol Table dialog is displayed.
2. Click New.
3. In the Symbol Table editbox, type the name of the new symbol table.
4. In the Code field, type the code to which the symbol will be attached.
5. In the Symbol field, select the required symbol from the drop-down list.
6. In the Scale field, type the required symbol scale.
7. Repeat steps from 4 to 6 for all required codes.
8. Click OK.

To edit an existing symbols table:
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1. At the Library tab of the Road design view, click the Symbol icon.

The Symbol Table dialog is displayed.
2. From the Symbol Table drop-down list, the required symbol table.
3. In the Code field, type the code to which the symbol will be attached.
4. In the Symbol field, select the required symbol from the drop-down list.
5. In the Scale field, type the required symbol scale.
6. Repeat steps from 4 to 6 for all required codes.
7. Click OK.

Friction Factors icon
The Friction Factors icon of the Road design view allows you to manage the friction factor tables library.

A friction factor table is used, when editing a Horizontal IP, to define the maximum design values of side friction
for the type of pavement surface, at nominated design speeds.

The table will be set up for the applicable standards. You may set up multiple tables in the library based on local
standards. These tables will be available for all MAGNET Office projects.

Variables are defined and applied for a specified design speed when computing the superelevation for the curve.

To create a new friction factor table:
1. At the Library tab of the Road design view, click the Friction Factors icon.

The Friction Factors dialog is displayed.
2. Click New.
3. In the Friction Factors editbox, type the name of the new friction factors table.
4. In the Speed field, specify the design speed.
5. In the Friction Factors field, specify the corresponding friction factor.
6. Click OK.

To edit an existing friction factor table:
1. At the Library tab of the Road design view, click the Friction Factors icon.

The Friction Factors dialog is displayed.
2. From the Friction Factors drop-down list, the required friction factors table.
3. In the Speed field, specify the design speed.
4. In the Friction Factors field, specify the corresponding friction factor.
5. Click OK.

Curve Radius icon
The Curve Radius icon of the Road design view allows you to manage the curves radius tables library.

A curve radius table is used, when editing a Horizontal IP, to define the minimum curve radius at nominated
design speeds.
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The table will be set up for the applicable standards. You may set up multiple tables in the library based on local
standards. These tables will be available for all MAGNET Office projects.

Variables are defined and applied for a specified design speed when computing the minimum radius for the curve.

To create a new curve radius table:
1. At the Library tab of the Road design view, click the Curve Radius icon.

The Curve Radius dialog is displayed.
2. Click New.
3. In the Radius Table editbox, type the name of the new curve radius table.
4. In the Speed field, specify the design speed.
5. In the Radius (min) field, specify the corresponding minimal radius of a curve.
6. Click OK.

To edit an existing curve radius table:
1. At the Library tab of the Road design view, click the Curve Radius icon.

The Curve Radius dialog is displayed.
2. From the Radius Table drop-down list, the required curve radius table.
3. In the Speed field, specify the design speed.
4. In the Radius (min) field, specify the corresponding minimal radius of a curve.
5. Click OK.
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Window tab

New icon
Click it to open current road design in another window.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

Split icon
Click it to change the sizes of the road design view panels.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.

Display Hints icon
Click it to display product hints.
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Profile Design View
The Profile Design View allows you to view and edit existing profiles to produce suitable grading of the road for
vehicles turning from one road into the other at the intersection. These new design levels may then be updated in
the Survey View to provide finished surfaces. For information about creating profiles refer to "Profile group" sec-
tion on page 348.

A profile may be created from a string, polygon, line or arc. It is usually used to represent the horizontal shape
and vertical design profile of a profile line that runs from one road through an arc into another road at an inter-
section.

This option may also be used to create a simple long section through the surveyed or design levels of a pipe line or
service or other feature.

The Profile Design View has its own ribbon, different from the default MAGNET Office ribbon. Descriptions
may be found in the appropriate sections:

l "File tab" section on the next page
l "View tab" section on page 743
l "Settings tab" section on page 744
l "Design tab" section on page 745
l "Plotting tab" section on page 752
l "Window tab" section on page 755
l "Help tab" section on page 755
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File tab

Open icon
Click it to open an existing profile.

Saver icon
Click it to save the current profile.

Close icon
Click it to close the current profile.
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View tab
Refresh group

Redraw icon
Click it to refresh the displaying of entities in the current view.

Navigate group

Zoom icon
Click it to it to fit all data in the view.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom in the center area of the survey view.

Pan icon
Click it to scroll the view

View group

Toolbar icon
Click it to enable/disable toolbar.

Status icon
Click it to enable/disable toolbar.
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Settings tab
Display Settings icon

Click it to configure the layout of the main view.
Profile Settings icon

Click it to configure the profile surfaces.

Display Settings icon
The Display Setting icon of the Profile design view allows you to configure which information will be displayed
in the profile view.

To configure the profile view layout:
1. At the Settings tab of the Profile design view, click the Display Settings icon.

The Profile dialog is displayed.
2. Define which information should be displayed by ticking the appropriate checkboxes. Fields are described

in the table below.
3. Click OK.

Fields of the Profile dialog
Field Description

Display Leaders Tick to display the vertical leader lines in the profile view.

Design Levels Tick to display the levels for the vertical profile design on each leader line.

Natural Levels Tick to display the levels for the natural surface on each leader line.

Level Differences

Tick to display the difference between the levels of design and natural sur-
faces.

l Fill – when design surface is above the natural surface. Displayed as
positive value, followed by F. For example, 0.15F.

l Cut – when design surface is below the natural surface. Displayed as
negative value, followed by C. For example, -0.15C.

Peg Chainage
Tick to display the peg chainage or running distance along the profile curb.
This chainage would be the same with the Shift chainage for a curb, so only
tick one option.

Shift Chainage
Tick to display the shift chainage or running distance along the curb. This chain-
age would be the same with the Peg chainage for a curb, so only tick one
option.

IPs
Tick to display the level of the IP point for the profile design. The chainage and
level is displayed vertically above the triangular symbol used to define an IP
position.
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Field Description

Curve Length
Tick to to display the length of the vertical curves for each IP point of the pro-
file design. The curve length is displayed at the top of the screen above a hori-
zontal line that shows the position and length of the curve.

Hi/Low Points
Tick to display the high and low points on the formation levels of the vertical
profile design. The chainage and level is displayed vertically above the high or
low point and marked HI for high point and LO for low point.

Grades

Tick to display the grade of the designed profile line between two adjacent IP
points. The grade is displayed as a positive or negative percentage below the
curve length data at the top of the screen, and above a horizontal line that
shows where the grades change at each IP point. The grade is measured from
left to right, from the lower chainage or distance position to the higher chain-
age or distance position.

Vertical Exag
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.

Precision Defines the number of decimal places in the data displayed in the profile view.

Start Chainage Defines the start chainage of the profile.

Profile Settings icon
The Profile Settings icon of the Profile design view allows you to configure the displaying of the profile and the
natural surface in the profile view.

Click the icon to open the Profile Settings dialog.

To configure a surface layout:
1. Do one of the following:
l Double click the required surface in the list.
l Select the required surface in the list, and click Edit.

The Settings dialog is displayed.
2. In the Name editbox, type the name of the surface.
3. Define whether the surface is active or not, by ticking the Active checkbox.
4. From the Color drop-down list, select the color for the surface displaying.
5. Click OK.

To set a surface as current, select the required surface in the list, and click Set Current.

To delete a surface from the design, select the required surface in the list, and click Delete.

Design tab
The Design tab of the Profile design view allows you to add, modify and delete IPs of the profile, so its initial
design may be changed. These changes may be posted back to the survey view, to change the appropriate data in
that view.

The tab contains 10 icons, divided to four groups, described in the table below.
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Add IP group
Add IP icon

Click it to add a new IP to the profile.
Add IP by Grade icon

Click it to create a new IP at the grade line from an existing IP.
Add IP by Intersection icon

Click it to create a new IP at the intersection of grades from two exist-
ing IPs.

Edit IP group
Modify IP icon

Click it to change properties of an existing IP.
Move IP icon

Click it to move an existing IP to a new position.
Delete IP icon

Click it to delete an existing IP from the profile design.
Delete All IPs icon

Click it to delete all existing IPs from the profile design.
Raise Design icon

Click it to adjust design by level.
Report group

VC Report icon
Click it to calculate levels for the different strings involved in a profile.

Transfer group
Update Survey icon

Click it to update changes in the profile design to the survey view.

Add IP icon
The Add IP icon of the Profile design view allows you to insert a new IP at a defined position.

To add an IP to the profile design:
1. At the Design tab of the Profile design view, click the Add IP icon.
2. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage, level, approach and departure grades in the appropriate editboxes at the bot-
tom toolbar.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.
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Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Grade icon
The Add IP by Grade icon of the Profile design view allows you to insert a new IP at a grade from an existing
IP.

To add an IP by grade:
1. At the Design tab of the Profile design view, click the Add IP by Grade icon.
2. In the profile view, select the base IP.
3. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage and grade from the base IP in the appropriate editboxes at the bottom toolbar.

The IP Details dialog is displayed.
4. Review the parameters, if needed change them. Fields are described in the table below.
5. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).
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Field Description

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and and select the speed from the drop-down list to com-
pute the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Intersection icon
The Add IP by Intersection icon of the Profile design view allows you to insert a new IP at an intersection of
grades from two existing IPs.

To add an IP:
1. At the Design tab of the Profile design view, click the Add IP by Intersection icon.
2. In the profile view, select the first base IP.
3. Define the grade from the first IP. Do one of the following:

l Click the required place in the profile view.
l Specify the grade in the appropriate editboxes at the bottom toolbar.

4. Repeat steps 2 and 3 for the second base IP.

The IP Details dialog is displayed.
5. Review the parameters, if needed change them. Fields are described in the table below.
6. Click OK.
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Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and and select the speed from the drop-down list to com-
pute the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Modify IP icon
The Modify IP icon of the Profile design view allows you to change the parameters of an existing IP.

To change an IP:
1. At the Design tab of the Profile design view, click the Modify IP icon.
2. In the profile view, select the required IP.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.
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Field Description

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Move IP icon
The Move IP icon of the Profile design view allows you to move an existing IP to a new position.

To move an IP:
1. At the Design tab of the Profile design view, click the Move IP icon.
2. In the profile view, select the required IP.
3. In the profile view, click the new place for the IP.

The IP is moved.

Delete IP icon
The Delete IP icon of the Profile design view allows you to delete an existing IP from the profile design.

To delete an IP:
1. At the Design tab of the Profile design view, click the Delete IP icon.
2. In the profile view, select the required IP.

The IP is deleted.
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Delete All IPs icon
The Delete All IPs icon of the Profile design view allows you to delete all existing IPs from the profile design.

To delete all IPs:
1. At the Design tab of the Profile design view, click the Delete All IPs icon.

The confirmation message is displayed.
2. Click Yes.

The IPs are deleted.

Raise Design icon
The Raise Design icon of the Profile design view allows you to raise the level of all existing IPs within a nom-
inated chainage range. This will raise or lower all or a section of the design profile.

To adjust a design:
1. At the Design tab of the Profile design view, click the Raise Design icon.

The Raiser/Lower IP's dialog is displayed.
2. In the Raiser/Lower Amount editbox, specify the required level change. Positive value will raise the IP

level, negative value will lower the IP level.
3. In the From Station editbox, specify the start chainage of the range within which IP levels will be adjusted.
4. In the To Station editbox, specify the end chainage of the range within which IP levels will be adjusted.
5. Click OK.

The design is adjusted.

Fields of the Raiser/Lower IP's dialog
Field Description

Raiser/Lower
Amount

Defines the required level change. Positive value will raise the IP levels, neg-
ative value will lower the IP levels.

From Station Defines the start chainage of the range within which IP levels will be adjusted.

To Station Defines the end chainage of the range within which IP levels will be adjusted.

VC Report icon
The VC Report icon of the Profile design view allows you to generate a report, listing levels for the different
strings involved in a design, such as the addition of a curb and channel to an existing road or widening a lane of a
road using the existing pavement grading.

To generate a VC Report:
1. At the Design tab of the Profile design view, click the VC Report icon.

The VC Details dialog is displayed.
2. Configure the parameters as you need and click OK.

The report, listing selected profile details is displayed.
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Plotting tab
The Plotting tab of the Profile design view allows you to configure the parameters required on the plotted long
section, and the creation of the long section drawing in the Drawings View.

Plot Settings icon
Click it to configure the profile plot settings.

Plot Profile icon
Click it to plot the profile.

Plot Settings icon
The Plot Setting icon of the Profile design view allows you to position the profile drawing, or drawings, on a title
block of choice. Additional settings define the scales used and the required information included on the profile.

Two formats may be used:
l Standard Format – A leader line is defined for each chainage and level position of the natural and design
surfaces.

l Grid Format – A grid is displayed with leaders at nominated intervals of chainage.

To configure the profile view:
1. At the Plotting tab of the Profile Design view, click the Plot Settings icon.

The Profile Plot Settings dialog is displayed.
2. Make the required configurations on each tab of the dialog. Fields are described in the table below.
3. Click OK.

Fields of the General Plot Settings tab of the Profile Plot Settings dialog
Field Description

Horizontal Scale Defines the horizontal scale for the profile.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block

Minimum Datum
Select the radio button to set a minimum datum level in millimeters on the plan.
The value specified in the editbox field sets the minimum distance of the pro-
file line from the datum line of the profile layout.

Datum Level Select the radio button to specify a fixed datum level (in meters) in the editbox
field. The profile line will be drawn relevant to this level.

Start Station Defines the start chainage of the profile for this drawing.

Title Block Defines the title block for plotting.

Vertical Scale Defines the vertical scale for the profile.

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block
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Field Description

Maximum Datum
If the radio button is set toMinimum Datum, specify the maximum datum level
in millimeters on the plan. The value entered sets the maximum distance of the
profile line from the datum line of the profile layout.

Max Plot Length
Defines the maximum plot length of the profile layout in millimeters on the
selected title block. This length will need to be modified for smaller paper
sizes. Max Plot Length = 700 represents 700 mm on an A1 sheet

End Station Defines the end chainage of the profile for this drawing.

Plot Grid Tick to plot in a Grid format.

Station Interval Defines the chainage interval for plotting.

Horizontal Inter-
val Defines the space between the horizontal grid lines in meters.

Vertical Interval Defines the space between the vertical grid lines in meters.

Grid Height

Defines the height of the grid above the datum line on the drawing in mil-
limeters.

If this height is greater than the height available on the title block, the plot will
stop at the extents of the title block

Plot Datum Tick to plot the datum value at the left hand end of the datum line.

Plot IPs Tick to plot the levels of the IP positions on the leader line below the profile
line.

Plot Max/Min Tick to plot the high and low point details on the profile line.

Plot Obstructions Tick to plot any obstructions.

Plot VC Length Tick to plot all the vertical curve lengths. These are plotted in a horizontal line
between the profile line and the datum line.

Plot VC Grade Tick box to plot all the grades between IPs. These are plotted in a horizontal
line between the profile line and the datum line.

Extra Row Tick to include an extra row at the bottom of the long section figure for addi-
tional information.

With Leader Tick to extend the leader lines through this new row.

Level Differences
Tick to plot the height difference between the natural surface and the design
surface at each station. You may configure the level difference layout at the
Level Diff Settings tab of the dialog.
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Fields of the Standard Profile Settings tab of the Profile Plot Settings dialog
Field Description

Design Surface

Tick the Active checkbox to plot the profile of the design surface and its data.

Type the appropriate label in the editbox to mark the row of levels on the long
section plot.

Select the colour, line type and thickness of the design profile line.

Select the text style used for the design line levels.

Natural Surface

Tick the Active checkbox to plot the profile of the natural surface and its data.

Type the appropriate label in the editbox to mark the row of levels on the long
section plot.

Select the colour, line type and thickness of the design profile line.

Select the text style used for the design line levels.

Justification Select the Number Justification Table from the drop-down list to set the format
and precision of the chainage and level data on the long section plot.

Plot Sequence
Select the order in which the three lines of detail will be plotted. By default the
line of Design levels is above the line of Natural Surface levels with the Chain-
age levels on the bottom line. Change the settings if another order is required.
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Window tab
Cascade icon

Click it to cascade windows in the working area.
Tile Horizontally icon

Click it to tile windows in the working area horizontally.
Tile Vertically icon

Click it to tile windows in the working area vertically.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.

Display Hints icon
Click it to display product hints.
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Intersection Design View
An Intersection comprises a number of curb strings and a design surface (DTM) that define all the grade lines
through the intersection of two or more roads. The curb strings will follow the grade lines around the lip of a curb
from one road into the next, and around traffic islands such as roundabouts. Other strings may also be defined as
curbs to represent the grading along the center lines through the intersection. The various curb returns and string
lines defined as curbs are created using the control icons from the Intersection group of the Design tab.

Standard strings may also be incorporated into the intersection design; however the levels on these strings may
not be modified in the Intersection design view.

In the Intersection design view you will interactively modify the levels on the individual curbs to update the sur-
face model.

The Intersection design view has three panels in the main view area:
l Plan panel — displays curbs, other strings and the DTM. Its location is top left.
l Cross Section — displays the design surface as a cross section along the current position of the indicator
bar in the Plan panel. Each movement of the indicator bar in the Plan panel will display a different cross
section through the data. Its location is top right

l Curb or Long Section — displays the long section profile and the current design IPs, with curve lengths
where these have been computed around the curved part of the curb return. Its location is bottom.

The Intersection Design View has its own ribbon, different from the default MAGNET Office
ribbon. Descriptions may be found in the appropriate sections:

l "File tab" section on the facing page
l "View tab" section on page 758
l "Settings tab" section on page 758
l "Curb tab" section on page 763
l "Plotting tab" section on page 770
l "Window tab" section on page 773
l "Help tab" section on page 773
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File tab

File tab

Open icon
Click it to open an existing intersection.

Saver icon
Click it to save the current intersection.

Close icon
Click it to close the current intersection.
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View tab
Refresh group

Redraw icon
Click it to refresh the displaying of entities in the current view.

Navigate group

Zoom icon
Click it to it to fit all data in the view.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom in the center area of the survey view.

Pan icon
Click it to scroll the view

View group

Toolbar icon
Click it to enable/disable toolbar.

Status icon
Click it to enable/disable toolbar.

Settings tab
Settings

Display Settings icon
Click it to configure layout of the main view.

DTM
Create DTM icon

Click it to create a new DTM. See "Create DTM icon" section on page 440 for
details.
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Trim DTM icon
Click it to trim a DTM to an existing boundary. See "Create DTM icon" section

on page 440 for details.
Strings/Curbs

Add/Remove Strings icon
Click it to add to/remove strings from the intersection design.

Add/Remove Curbs icon
Click it to add to/remove curbs from the intersection design.

Select Curb Template icon
Click it to assign road templates to curbs in the intersection design.

Display Settings icon
The Display Settings icon of the Intersection design view allows you to configure which information will be dis-
played in the intersection view.

To configure the intersection view layout:
1. At the Settings tab of the Intersection design view, click the Display Settings icon.

The Display Settings dialog is displayed.
2. Make the required configurations. Fields are described in the table below.
3. Click OK.

Fields of the Display Settings dialog
Field Description

Plan tab

DTM Tick the appropriate checkboxes to display the triangular model of the inter-
section and contours through the intersection.

Reference String
Color Defines the color for the reference string.

Profile tab

Display Leaders Tick to display the vertical leader lines in the intersection view.

Design Levels Tick to display the levels for the vertical profile design on each leader line.

Natural Levels Tick to display the levels for the natural surface on each leader line.

Level Differences

Tick to display the difference between the levels of design and natural sur-
faces.

l Fill – when design surface is above the natural surface. Displayed as
positive value, followed by F. For example, 0.15F.

l Cut – when design surface is below the natural surface. Displayed as
negative value, followed by C. For example, -0.15C.

Peg Chainage
Tick to display the peg chainage or running distance along the profile curb.
This chainage would be the same with the Shift chainage for a curb, so only
tick one option.
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Field Description

Shift Chainage
Tick to display the shift chainage or running distance along the curb. This chain-
age would be the same with the Peg chainage for a curb, so only tick one
option.

IPs
Tick to display the level of the IP point for the profile design. The chainage and
level is displayed vertically above the triangular symbol used to define an IP
position.

Curve Length
Tick to to display the length of the vertical curves for each IP point of the pro-
file design. The curve length is displayed at the top of the screen above a hori-
zontal line that shows the position and length of the curve.

Hi/Low Points
Tick to display the high and low points on the formation levels of the vertical
profile design. The chainage and level is displayed vertically above the high or
low point and marked HI for high point and LO for low point.

Grades

Tick to display the grade of the designed profile line between two adjacent IP
points. The grade is displayed as a positive or negative percentage below the
curve length data at the top of the screen, and above a horizontal line that
shows where the grades change at each IP point. The grade is measured from
left to right, from the lower chainage or distance position to the higher chain-
age or distance position.

Vertical Exag
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.

Precision Defines the number of decimal places in the data displayed in the profile view.

Start Chainage Defines the start chainage of the profile.

Cross Section tab

Display Point Info
Tick to display the point information.

Select which information will be displayed - either Code, or Level or Offset by
selecting the appropriate radiobutton.

Display Point
Mark

Tick to display point marks.

Define the size of the marks, by selecting the appropriate radiobutton.

Display Point
Mark

Tick to display point marks.

Define the size of the marks, by selecting the appropriate radiobutton.

Colors Defines the colors for design and natural surfaces.

Display Cross
Fall Tick to display the cross fall of the design legs.
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Add/Remove Strings icon
Any strings that are available in the survey view may be added to or removed from the display in the Intersection
View. The levels on these strings will also be incorporated into the DTM.

The Add/Remove Strings icon of the Intersection design view allows you to add to or remove strings from the
intersection design.

To add strings to the view:
1. At the Settings tab of the Intersection design view, click the Add/Remove Strings icon.

The Add/Remove Strings dialog is displayed.
2. In the Strings in the area list, select the strings to be added to the design.
3. Click Add.

The strings are added to the design.
4. Click OK.

To remove strings from the view:
1. At the Settings tab of the Intersection design view, click the Add/Remove Strings icon.

The Add/Remove Strings dialog is displayed.
2. In the Selected Strings list, select the strings to be added to the design.
3. Click Remove.

The strings are deleted from the design.
4. Click OK.

Add/Remove Curbs icon
Any curbs that are available in the survey view may be added to or removed from the intersection. The levels on
these curbs will also be incorporated into the DTM

The Add/Remove Curbs icon of the Intersection design view allows you to add to or remove from curbs to the
intersection design.

To add curbs to the view:
1. At the Settings tab of the Intersection design view, click the Add/Remove Curbs icon.

The Add/Remove Curbs dialog is displayed.
2. In the Curbs in the area list, select the curbs to be added to the design.
3. Click Add.

The curbs are added to the design.
4. Click OK.

To remove curbs from the view:
1. At the Settings tab of the Intersection design view, click the Add/Remove Curbs icon.

The Add/Remove Curbs dialog is displayed.
2. In the Selected Curbs list, select the curbs to be added to the design.
3. Click Remove.

The curbs are deleted from the design.
4. Click OK.
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Select Curb Template icon
The Select Curb Template icon of the Intersection design view allows you to define a template for each curb in
the intersection design.

To assign to or change the template of curbs:
1. At the Settings tab of the Intersection design view, click the Select Curb Template icon.

The Curb Template Selection dialog is displayed.
2. In the Curb column of the table, type the name of the template.
3. In the Template column of the table, select the required road template. See "Templates icon" section on

page 702 for details.
4. Repeat steps 2 and 3 for all required curbs.
5. Click OK.

To edit road templates, click Edit Templates. See "Templates icon" section on page 702 for details.
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Curb tab
The Curb tab of the Intersection design view allows you to add, modify and delete IPs of the intersection, so its ini-
tial design may be changed. These changes may be posted back to the survey view, to change the appropriate data
in that view.

Add IP group
Add IP icon

Click it to add a new IP to the intersection.
Add IP by Grade icon

Click it to create a new IP at the grade line from an existing IP.
Add IP by Intersection icon

Click it to create a new IP at the intersection of grades from two exist-
ing IPs.

Edit IP group
Modify IP icon

Click it to edit an existing IP.
Move IP icon

Click it to move an existing IP to a new position.
Delete IP icon

Click it to delete an existing IP from the intersection design.
Delete All IPs icon

Click it to delete all existing IPs from the intersection design.
Raise Design icon

Click it to adjust design by level.
Report group

VC Report icon
Click it to calculate levels for the different strings involved in a inter-

section.
Transfer group

Update Survey icon
Click it to update changes in the intersection design to the survey view.

Add IP icon
The Add IP icon of the Intersection design view allows you to insert a new IP at a defined position.

To add an IP to the intersection design:
1. At the Curb tab of the Intersection design view, click the Add IP icon.
2. Locate the new IP. Do one of the following:

l Click the required place in the intersection view.
l Specify the chainage, level, approach and departure grades in the appropriate editboxes at the bottom
toolbar.

The IP Details dialog is displayed.
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3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Grade icon
The Add IP by Grade icon of the Intersection design view allows you to insert a new IP at a grade from an exist-
ing IP.

To add an IP by grade:
1. At the Curb tab of the Interscection design view, click the Add IP by Grade icon.
2. In the intersection view, select the base IP.
3. Locate the new IP. Do one of the following:

l Click the required place in the intersection view.
l Specify the chainage and grade from the base IP in the appropriate editboxes at the bottom toolbar.

The IP Details dialog is displayed.
4. Review the parameters, if needed change them. Fields are described in the table below.
5. Click OK.
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Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Intersection icon
The Add IP by Intersection icon of the Intersection design view allows you to insert a new IP at an intersection
of grades from two existing IPs.

To add an IP:
1. At the Curb tab of the Intersection design view, click the Add IP by Intersection icon.
2. In the intersection view, select the first base IP.
3. Define the grade from the first IP. Do one of the following:

l Click the required place in the intersection view.
l Specify the grade in the appropriate editboxes at the bottom toolbar.

4. Repeat steps 2 and 3 for the second base IP.

The IP Details dialog is displayed.
5. Review the parameters, if needed change them. Fields are described in the table below.
6. Click OK.
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Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Modify IP icon
The Modify IP icon of the Intersection design view allows you to change the parameters of an existing IP.

To change an IP:
1. At the Curb tab of the Intersection design view, click the Modify IP icon.
2. In the intersection view, select the required IP.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.
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Field Description

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Move IP icon
The Move IP icon of the Intersection design view allows you to move an existing IP to a new position.

To move an IP:
1. At the Curb tab of the Intersection design view, click the Move IP icon.
2. In the intersection view, select the required IP.
3. In the intersection view, click the new place for the IP.

The IP is moved.

Delete IP icon
The Delete IP icon of the Intersection design view allows you to delete an existing IP from the intersection
design.

To delete an IP:
1. At the Curb tab of the Intersection design view, click the Delete IP icon.
2. In the intersection view, select the required IP.

The IP is deleted.
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Delete All IPs icon
The Delete All IPs icon of the Intersection design view allows you to delete all existing IPs from the intersection
design.

To delete all IPs:
1. At the Curb tab of the Intersection design view, click the Delete All IPs icon.

The confirmation message is displayed.
2. Click Yes.

The IPs are deleted.

Raise Design icon
The Raise Desing icon of the Intersection design view allows you to raise the level of all existing IPs within a
nominated chainage range. This will raise or lower all or a section of the design intersection.

To adjust a design:
1. At the Curb tab of the Intersection design view, click the Raise Design icon.

The Raiser/Lower IP's dialog is displayed.
2. In the Raiser/Lower Amount editbox, specify the required level change. Positive value will raise the IP

levels, negative value will lower the IP levels.
3. In the From Station editbox, specify the start chainage of the range within which IP levels will be adjusted.
4. In the To Station editbox, specify the end chainage of the range within which IP levels will be adjusted.
5. Click OK.

The design is adjusted.

Fields of the Raiser/Lower IP's dialog
Field Description

Raiser/Lower
Amount

Defines the required level change. Positive value will raise the IP levels, neg-
ative value will lower the IP levels.

From Station Defines the start chainage of the range within which IP levels will be adjusted.

To Station Defines the end chainage of the range within which IP levels will be adjusted.

VC Report icon
The VC Report icon of the Intersection design view allows you to generate a report, listing levels for the dif-
ferent strings involved in a design, such as the addition of a curb and channel to an existing road or widening a
lane of a road using the existing pavement grading.

To generate a VC Report:
1. At the Curb tab of the Intersection design view, click the VC Report icon.

The VC Details dialog is displayed.
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2. Configure the parameters as you need and click OK.

The report, listing selected intersection details is displayed.
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Plotting tab
The Plotting tab of the Intersection design view allows you to configure the parameters required on the plotted
long section, and the creation of the long section drawing in the Drawings View.

Plot Settings icon
Click it to configure the profile plot settings.

Plot Profile icon
Click it to plot the profile.

Plot Settings icon
The Plot Setting icon of the Intersection design view allows you to position the intersection drawing, or draw-
ings, on a title block of choice. Additional settings define the scales used and the required information included
on the intersection.

Two formats may be used:
l Standard Format – A leader line is defined for each chainage and level position of the natural and design
surfaces.

l Grid Format – A grid is displayed with leaders at nominated intervals of chainage.

To configure the intersection view:
1. At the Plotting tab of the Intersection Design view, click the Plot Settings icon.

The Profile Plot Settings dialog is displayed.
2. Make the required configurations on each tab of the dialog. Fields are described in the table below.
3. Click OK.

Fields of the General Plot Settings tab of the Profile Plot Settings dialog
Field Description

Horizontal Scale Defines the horizontal scale for the profile.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block

Minimum Datum
Select the radio button to set a minimum datum level in millimeters on the plan.
The value specified in the editbox field sets the minimum distance of the pro-
file line from the datum line of the profile layout.

Datum Level Select the radio button to specify a fixed datum level (in meters) in the editbox
field. The profile line will be drawn relevant to this level.

Start Station Defines the start chainage of the profile for this drawing.

Title Block Defines the title block for plotting.

Vertical Scale Defines the vertical scale for the profile.

770



Plot Settings icon

Field Description

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block

Maximum Datum
If the radio button is set toMinimum Datum, specify the maximum datum level
in millimeters on the plan. The value entered sets the maximum distance of the
profile line from the datum line of the profile layout.

Max Plot Length
Defines the maximum plot length of the profile layout in millimeters on the
selected title block. This length will need to be modified for smaller paper
sizes. Max Plot Length = 700 represents 700mm on an A1 sheet

End Station Defines the end chainage of the profile for this drawing.

Plot Grid Tick to plot in a Grid format.

Station Interval Defines the chainage interval for plotting.

Horizontal Inter-
val Defines the space between the horizontal grid lines in metres.

Vertical Interval Defines the space between the vertical grid lines in metres.

Grid Height

Defines the height of the grid above the datum line on the drawing in mil-
limeters.

If this height is greater than the height available on the title block, the plot will
stop at the extents of the title block

Plot Datum Tick to plot the datum value at the left hand end of the datum line.

Plot IPs Tick to plot the levels of the IP positions on the leader line below the profile
line.

Plot Max/Min Tick to plot the high and low point details on the profile line.

Plot Obstructions Tick to plot any obstructions.

Plot VC Length Tick to plot all the vertical curve lengths. These are plotted in a horizontal line
between the profile line and the datum line.

Plot VC Grade Tick box to plot all the grades between IPs. These are plotted in a horizontal
line between the profile line and the datum line.

Extra Row Tick to include an extra row at the bottom of the long section figure for addi-
tional information.

With Leader Tick to extend the leader lines through this new row.
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Fields of the Standard Profile Settings tab of the Profile Plot Settings dialog
Field Description

Design Surface

Tick the Active checkbox to plot the profile of the design surface and its data.

Type the appropriate label in the editbox to mark the row of levels on the long
section plot.

Select the colour, line type and thickness of the design profile line.

Select the text style used for the design line levels.

Natural Surface

Tick the Active checkbox to plot the profile of the natural surface and its data.

Type the appropriate label in the editbox to mark the row of levels on the long
section plot.

Select the colour, line type and thickness of the design profile line.

Select the text style used for the design line levels.

Justification Select the Number Justification Table from the drop-down list to set the format
and precision of the chainage and level data on the long section plot.

Plot Sequence
Select the order in which the three lines of detail will be plotted. By default the
line of Design levels is above the line of Natural Surface levels with the Chain-
age levels on the bottom line. Change the settings if another order is required.
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Window tab

Window tab
Cascade icon

Click it to cascade windows in the working area.
Tile Horizontally icon

Click it to tile windows in the working area horizontally.
Tile Vertically icon

Click it to tile windows in the working area vertically.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.
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Resurface Design View
The Resurface design view allows you to create a new road design for existing road, for example when renov-
ating the road surface by lying new asphalt, within the constrains that apply to that particular project.

The Resurface design view has three panels in the main view area:
l Alignment panel – displays the alignment and design strings. The plan data from the survey view may also
be shown. Its location is top left.

l Profile panel – displays the profiles for the natural surface and the design profile with vertical IP points,
for the reference alignment and strings. Its location is top right.

l Cross Section panel – displays the cross section for one chainage. Several surfaces may be shown. Its loc-
ation is bottom.

The Resurface design view has its own ribbon, different from the default MAGNET Office ribbon. Descriptions
may be found in the appropriate sections:

l "File tab" section below
l "Edit tab" section on the facing page
l "View tab" section on page 776
l "Settings tab" section on page 777
l "Alignment tab" section on page 781
l "Profile tab" section on page 785
l "Cross Section tab" section on page 792
l "Design tab" section on page 795
l "Plotting tab" section on page 805
l "Library tab" section on page 817
l "Window tab" section on page 817
l "Help tab" section on page 817

File tab

Open icon
Click it to open an existing resurface alignment.

Save icon
Click it to save the current resurface alignment.

Close icon
Click it to close the resurface alignment.
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Edit tab
Undo/Redo group

Undo icon
Click it to cancel the last action.

Redo icon
Click it to restore the last canceled action.

Clipboard group

Cut icon
Click it to cut the selected object to the clipboard.

Copy icon
Click it to copy the selected object to the clipboard.

Paste icon
Click it to paste an object from the clipboard.
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View tab
Refresh group

Redraw icon
Click it to refresh the displaying of entities in the current view.

Regen icon
Click it to regenerate the current view.

Navigate group

Zoom icon
Click it to it to fit all data in the view.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom in the center area of the survey view.

Pan icon
Click it to scroll the view

Features group
Show/Hide Strong icon

Click it to configure the string visibility.
Google Earth/Map icon

Click it to view the current project in Google Earth or Google Maps.
Survey icon

Click it to switch to the survey view.
Options group

Toolbar icon
Click it to enable/disable toolbars.

Status icon
Click it to enable/disable toolbar.
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Settings tab
Alignment icon

Click it to configure the layout of the alignment panel.
Profile icon

Click it to configure the layout of the profile panel.
Cross Section icon

Click it to configure the layout of the cross section panel.
Resurfacing icon

Click it to configure the layout of new road surface.

Alignment icon
The Alignment icon of the Resurface design view allows you to configure the displaying of alignments at the
alignment panel.

To configure the alignment displaying:
1. At the Settings tab of the Resurface design view, click the Alignment icon.

The Road Display Settings dialog, opened at the Alignment tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Alignment tab of the Road Display Settings dialog
Field Description

Display Strings Tick to display the design strings after computation.

Display String
TPs

Tick to show the tangent points on the design strings after computation. The tan-
gent points will be displayed on the main design string.

Display String IPs Tick to show the intersection points on every chainage of the design strings
after computation

Display Peg Align-
ment Tick to show the alignment at the zero offset of the cross sections

Display Align TPs Tick to show the tangent points on the alignment.

Display Align IPs Tick to show the intersection points on the alignment.

Display Survey
Data

Tick to display the data on active layers in the Survey View. If the triangular
mesh and the contours are active in the Survey View, they will display in the
Alignment pane.

Profile icon
The Profile icon of the Resurface design view allows you to configure the displaying of the profile panel.

To configure the profile displaying:
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1. At the Settings tab of the Resurface design view, click the Profile icon.

The Road Display Settings dialog, opened at the Profile tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Profile tab of the Road Display Settings dialog
Field Description

Display Leaders Tick to display the vertical leader lines in the profile view.

Design Levels Tick to display the levels for the vertical profile design on each leader line.

Natural Levels Tick to display the levels for the natural surface on each leader line.

Level Differences

Tick to display the difference between the levels of design and natural sur-
faces.

l Fill – when design surface is above the natural surface. Displayed as
positive value, followed by F. For example, 0.15F.

l Cut – when design surface is below the natural surface. Displayed as
negative value, followed by C. For example, -0.15C.

CL Stations Tick to display the chainage or running distance along the Road for the ref-
erence or pegged string. This is at the zero offset of the sections

Offset Stations Tick to display the chainage or running distance along the current string.

IPs
Tick to display the level of the IP point for the profile design. The chainage and
level is displayed vertically above the triangular symbol used to define an IP
position.

Curve Length
Tick to display the length of the vertical curves for each IP point of the profile
design. The curve length is displayed at the top of the screen above a hori-
zontal line that shows the position and length of the curve.

Hi/Low Points
Tick to display the high and low points on the formation levels of the vertical
profile design. The chainage and level is displayed vertically above the high or
low point and marked HI for high point and LO for low point.

Grades

Tick to display the grade of the designed profile line between two adjacent IP
points. The grade is displayed as a positive or negative percentage below the
curve length data at the top of the screen, and above a horizontal line that
shows where the grades change at each IP point. The grade is measured from
left to right, from the lower chainage or distance position to the higher chain-
age or distance position.

Vertical Exag
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.

Precision Defines the number of decimal places in the data displayed in the profile view.

Reference String Select the string used to define the stations on the long section plot. This is not
necessarily the current string
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Cross Section icon

Field Description

Envelope Details
The envelope allows you to see the design string profile designed within two
different cross falls. This may be useful if you want to design a prefer string to
match in with existing strings.

Natural Defines whether the envelope is calculated from the natural or design surface
of the source.

Design Design

String Defines the base string for the envelope.

Cross Section icon
The Cross Section icon of the Resurface design view allows you to configure the displaying of the cross section
panel.

To configure the profile displaying:
1. At the Settings tab of the Resurface design view, click the Cross Section icon.

The Road Display Settings dialog, opened at the Cross Section tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Cross Section tab of the Road Display Settings dialog
Field Description

Display Point Info
Tick to display the point information.

Select which information will be displayed - either Code, or Level or Offset by
selecting the appropriate radiobutton.

Display Point Mark
Tick to display point marks.

Define the size of the marks, by selecting the appropriate radiobutton.

Display Text Size

Display Cross Fall
Tick to display the cross fall on each leg of the cross section of the current sur-
face. Crossfalls are hidden if the mapping scale is such that the data would
overlap.

Display Road
Reserve

Tick to display vertical yellow lines on the cross section where the two offsets
in the next two fields represent the left and right road reserve or a known lim-
itation of the design corridor. The center line will be marked with a vertical
green line. These lines are a useful guide to mark specified offsets.

Left Road Reserve Defines the left road reserve. The default is 7.00 m left of the center line

Right Road Reserve Defines the right road reserve. The default is 7.00 m right of the center line

Vertical Exaggeration
This value defaults to 1.000. Increase to change the vertical scale as a ratio to
the horizontal scale in the onscreen display. A value of 2.000 will set the ver-
tical scale at twice the horizontal scale.
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Field Description

Natural Surface
The Natural Surface displayed in the cross section and long section panes. This
surface will be set when cross sections are extracted from the survey view.
The surface set in this field is the current natural surface

Design Surface The design surface displayed in the cross section and long section panes. The
surface set in this field is the current design surface

Subgrade Surface
Multiple subgrade surfaces may be computed, representing different materials
of varying thicknesses. The surface set in this field is the current subgrade sur-
face

Resurfacing icon
The Resurfacing icon of the Resurface design view allows you to configure the layout of the changes made in
the road design.

To configure the resurface displaying:
1. At the Settings tab of the Resurface design view, click the Profile icon.

The Road Display Settings dialog, opened at the Resurface tab is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Resurface tab of the Road Display Settings dialog
Field Description

Profile view Defines the layout of the profile panel.

Profile and cross
section view Defines the color layout of the profile and cross section panels.

Movement Inform-
ation Defines the information, which will be displayed while

Shading Defines the color of shading.

Volume Cal-
culation Defines the data for calculation volume of a new surface.
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Alignment tab
String group

Add icon
Click it to a new string to the road design.

Edit icon
Click it to edit a string in the road design.

Delete icon
Click it to delete strings from the road design.

Transfer group
Update Survey icon

Click it to transfer data from the road design to the survey view.
Data Transfer Table icon

Click it to set up the parameters for transferring road data into the survey
view.

Report group
Curve Report icon

Click it to generate a curve report.

Add icon
The Add icon of the Resurface design view allows you to add a new string in the dataset or another alignment
defined in the survey view.

To add a string:
1. At the Alignment tab of the Resurface design view, click the Add icon.

The Add String dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The new string is created. It is set as the current string.

Fields of the Add String dialog
Field Description

Name

Defines the name of the new string.

It is useful to allocated a name that suits the definition of the string, so that the
user may easily select it

For example, NESL new edge of seal left, or NEB new edge of bitumen, or R2
right side of a widened road
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Field Description

Active

Tick to activate the string as a design string with its own design profile.

If this string has VIPs designed for the design levels on the string this checkbox
must be ticked to use these design levels.

If the string has this checkbox ticked, but there are no design levels, then the
levels on the natural surface will be automatically incorporated into the final
design surface. This is a useful tool if an existing property boundary is to be
used for the batter.

Definition of the
String

A string must follow a path along the data for the road. The following ways are
available for defining a string:

l Fixed Offset – the string will run at a specified offset from the reference
alignment (zero offset of the road dataset). In the editbox, specify a neg-
ative offset to the left of the road or a positive offset to the right of the
road.

l Coded Offset – the string will follow a particular code from the Natural
Surface cross sectional data, such as EML [edge metal left] and EMR
[edge metal right].

l Extension – the Code Offset and Alignment options may be modified by
an offset to define the string to the left or right of the line following the
code or alignment.

For example, enter –1.5 to create the string 1.5m to the left of the line
defined by the code offset or alignment definition.

l Alignment – the string will follow a horizontal alignment created in the
survey view.

l String – the string will follow a string created in the survey view.
l String By Intersecting Grade – the string at the position and level of
intersection of two grades from two existing strings.

Start Chainage Defines the start chainage for the string. By default this is the start chainage of
the main alignment.

End Chainage Defines the end chainage for the string. By default this is the end chainage of
the main alignment.

Color Defines a color for the design string.

Plotting Label Defines a label to be used for this string in the long section plotting.

Plot Label Tick to plot the label on the profile.

Plot Design
Details Tick to plot design levels along the string on the profile.

Edit icon
The Edit icon of the Resurface design view allows you change the definition of a string.
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Edit icon

To edit a string:
1. In the Alignment panel, select the required string.
2. At the Alignment tab of the Resurface design view, click the Edit icon.

The Edit String dialog is displayed.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

The string is edited.

Fields of the Edit String dialog
Field Description

Name Displays the name of the string.

Active

Tick to activate the string as a design string with its own design profile.

If this string has VIPs designed for the design levels on the string this checkbox
must be ticked to use these design levels.

If the string has this checkbox ticked, but there are no design levels, then the
levels on the natural surface will be automatically incorporated into the final
design surface. This is a useful tool if an existing property boundary is to be
used for the batter.

Definition of the
String

A string must follow a path along the data for the road. The following ways are
available for defining a string:

l Fixed Offset – the string will run at a specified offset from the reference
alignment (zero offset of the road dataset). In the editbox, specify a neg-
ative offset to the left of the road or a positive offset to the right of the
road.

l Coded Offset – the string will follow a particular code from the Natural
Surface cross sectional data, such as EML [edge metal left] and EMR
[edge metal right].

l Extension – the Code Offset and Alignment options may be modified by
an offset to define the string to the left or right of the line following the
code or alignment.

For example, enter –1.5 to create the string 1.5m to the left of the line
defined by the code offset or alignment definition.

l Alignment – the string will follow a horizontal alignment created in the
survey view.

l String – the string will follow a string created in the survey view.

Ref. Start Station Displays the start chainage for the string.

Ref. End Station Displays the end chainage for the string.

Color Defines a color for the design string.

Plotting Label Defines a label to be used for this string in the long section plotting.

Plot Label Tick to plot the label on the profile.

Plot Design
Details Tick to plot design levels along the string on the profile.
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Delete icon
The Delete icon of the Resurface design view allows you to delete strings from the road design.

To delete a string:
1. At the Alignment tab of the Resurface design view, click the Delete icon.

The Delete String dialog is displayed.
2. In the Strings list, select strings to be deleted.
3. Click Delete.

The strings are deleted.

Update Survey icon
The Update Survey icon of the Resurface design view allows you to update the survey view with the design sur-
face strings and a surface model, as defined by the Data Transfer Table.

The design should be completed to use this option.

To update the survey data:
1. Configure the Data Transfer Table. See "Data Transfer Table icon" section below for details.
2. At the Alignment tab of the Resurface design view, click the Update Survey icon.

Data Transfer Table icon
The Data Transfer Table icon of the Resurface design view allows you to set up the parameters for transferring
road data into the survey view.

To configure the Data Transfer Table:
1. At the Alignment tab of the Resurface design view, click the Data Transfer Table icon.

The Transfer Data to Survey dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

The Transfer Data to Survey dialog
Field Description

Road Code

The name used to define each string in the road design. These strings comprise
the reference alignment, the strings created for each template leg that is
labelled and has its plot box ticked, and certain standard strings automatically
named by the software, such as LBAT [left batter] and RT1 [table drain at the
right leg 1].

Survey String
The code of each point on this design string. This code will also name the
string created in the survey view. This is set to the same name as the road code
but may be modified.
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Profile tab

Field Description

Layer

The layer created to hold this string and all its node points in the survey view.
This is set to the same name as the road code but may be modified. An existing
layer may be selected from the pick list available in this field or a new name
may be entered.

Transfer Tick to transfer this string to the survey view with the option Update Survey.

Road Number

Allows you to add the road number to the Survey String name and the Layer
name.

To add road number to the Survey String name:
1. Specify the required number in the editbox.
2. Define whether it will be used as prefix or suffix, by selecting the appro-

priate radiobutton.
3. Click Survey String.

To add road number to the layer name:
1. Specify the required number in the editbox.
2. Define whether it will be used as prefix or suffix, by selecting the appro-

priate radiobutton.
3. Click Layer.

Create DTM

Tick to create a DTM for the selected surface defined in the Surface field. Spe-
cify a name for the DTM in the editbox.

The DTM created will be the complete surface from the far left edge of the
design to the far right edge of the design. These are usually the left and right
batter lines. The surface is complete even if the user does not transfer all the
strings from this surface.

Surface
Select the surface to be transferred to the survey view from the pick list of sur-
faces. This will usually be the Design surface, and the string names are dis-
played from the Design surface.

Profile tab
IP

Add IP icon
Click it to add a new IP to the profile.

Add IP by Grade icon
Click it to create a new IP at the grade line from an existing IP.

Add IP by Intersection icon
Click it to create a new IP at the intersection of grades from two exist-

ing IPs.
Move IP icon

Click it to move an exiting IP to a new position.
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Modify IP icon
Click it to change properties of an existing IP.

Delete IP icon
Click it to delete an existing IP from the profile design.

Delete All IPs
Click it to delete all existing IPs from the profile design.

Profile group
Raise/Lower Design icon

Click it to adjust design by level.
Report group

Profile Report icon
Click it to generate a profile report, listing all chainages.

VC Report icon
Click it to calculate levels for the different strings involved in a profile.

Add IP icon
The Add IP icon of the Resurface design view allows you to insert a new IP at a defined position.

To add an IP to the profile design:
1. At the Profile tab of the Resurface design view, click the Add IP icon.
2. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage, level, approach and departure grades in the appropriate editboxes at the bot-
tom toolbar.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.
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Field Description

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and and select the speed from the drop-down list to com-
pute the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Grade icon
The Add IP by Grade icon of the Resurface design view allows you to insert a new IP at a grade from an exist-
ing IP.

To add an IP by grade:
1. At the Profile tab of the Resurface design view, click the Add IP by Grade icon.
2. In the profile view, select the base IP.
3. Locate the new IP. Do one of the following:

l Click the required place in the profile view.
l Specify the chainage and grade from the base IP in the appropriate editboxes at the bottom toolbar.

The IP Details dialog is displayed.
4. Review the parameters, if needed change them. Fields are described in the table below.
5. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.
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Field Description

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and and select the speed from the drop-down list to com-
pute the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Add IP by Intersection icon
The Add IP by Intersection icon of the Resurface design view allows you to insert a new IP at an intersection
of grades from two existing IPs.

To add an IP:
1. At the Profile tab of the Resurface design view, click the Add IP by Intersection icon.
2. In the profile view, select the first base IP.
3. Define the grade from the first IP. Do one of the following:

l Click the required place in the profile view.
l Specify the grade in the appropriate editboxes at the bottom toolbar.

4. Repeat steps 2 and 3 for the second base IP.

The IP Details dialog is displayed.
5. Review the parameters, if needed change them. Fields are described in the table below.
6. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.
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Field Description

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Move IP icon
The Move IP icon of the Resurface design view allows you to move an existing IP to a new position.

To change an IP:
1. At the Profile tab of the Resurface design view, click the Modify IP icon.
2. In the profile view, select the required IP.
3. Move the IP to a new position. Left click to confirm the position.

Modify IP icon
The Modify IP icon of the Resurface design view allows you to change the parameters of an existing IP.

To change an IP:
1. At the Profile tab of the Resurface design view, click the Modify IP icon.
2. In the profile view, select the required IP.

The IP Details dialog is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Click OK.

Fields of the IP Details dialog
Field Description

IP Chainage Defines the chainage of the new intersection point (IP).

IP Level Defines the level of the new IP.

Grade Displays the grid at the new IP.

Approach
Grade %

Displays the grade of the road approaching this IP from the previous IP at the
lower chainage
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Field Description

Departure Grade
%

Displays the grade of the road departing from this IP to the next IP at the
higher chainage.

Algebraic Dif-
ference

Displays the change in grade. Calculated as Departure Grade – Approach
Grade.

Maximum Length Displays the maximum curve length available to fit a vertical curve at this IP.

VC Length Select the radiobutton and specify the length of the parabolic vertical curve at
this IP.

K Value Select the radiobutton and specify the K Value. This is the value required for a
1% change in grade. The VC length is computed from this value

Design Speed Select the radiobutton and select the speed from the drop-down list to compute
the VC length from the Sight Distance criteria.

Sight Distance Cri-
teria These are used to compute suitable curve lengths.

Sight Distance
Select a sight distance table from the drop-down list. These tables are set up in
the roads library and relate the design speed to suitable sight distances that are
allowed for in local standards.

Delete IP icon
The Delete IP icon of the Resurface design view allows you to delete an existing IP from the profile design.

To delete an IP:
1. At the Profile tab of the Resurface design view, click the Delete IP icon.
2. In the profile view, select the required IP.

The IP is deleted.

Delete All IPs
The Delete All IPs icon of the Resurface design view allows you to delete all existing IPs from the profile
design.

To delete all IPs:
1. At the Profile tab of the Resurface design view, click the Delete All IPs icon.

The confirmation message is displayed.
2. Click Yes.

The IPs are deleted.
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Raise/Lower Design icon

Raise/Lower Design icon
The Raise/Lower Design icon of the Resurface design view allows you to raise the level of all existing IPs
within a nominated chainage range. This will raise or lower all or a section of the design profile.

To adjust a design:
1. At the Profile tab of the Resurface design view, click the Raise/Lower Design icon.

The Raiser/Lower IP's dialog is displayed.
2. In the Raiser/Lower Amount editbox, specify the required level change. Positive value will raise the IP

levels, negative value will lower the IP levels.
3. In the From Station editbox, specify the start chainage of the range within which IP levels will be adjusted.
4. In the To Station editbox, specify the end chainage of the range within which IP levels will be adjusted.
5. Click OK.

The design is adjusted.

Fields of the Raiser/Lower IP's dialog
Field Description

Raiser/Lower
Amount

Defines the required level change. Positive value will raise the IP levels, neg-
ative value will lower the IP levels.

From Station Defines the start chainage of the range within which IP levels will be adjusted.

To Station Defines the end chainage of the range within which IP levels will be adjusted.

VC Report icon
The VC Report icon of the Resurface design view allows you to generate a report, listing levels for the different
strings involved in a design, such as the addition of a curb and channel to an existing road or widening a lane of a
road using the existing pavement grading.

To generate a VC Report:
1. At the Profile tab of the Resurface design view, click the VC Report icon.

The VC Details dialog is displayed.
2. Configure the parameters as you need and click OK.

The report, listing selected profile details is displayed.
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Cross Section tab
Surface group

Add Surface icon
Click it to add a surface to the road design.

Sequence icon
Click it to re-order the subgrade surfaces.

Delete icon
Click it to delete surfaces from the road design.

Points group
Add Point icon

Click it to add a new point to the cross section.
Raise icon

Click it to raise/lower the level on a section of the current cross section.
Reports group

Cross Section Report icon
Click it to generate a cross section report.

Add Surface icon
The Add Surface icon of the Resurface design view allows you to add another surface to the road design. This
surface is usually a subgrade surface but may be an alternate design surface.

To add a surface:
1. At the Cross Section tab of the Resurface design view click the Add Surface icon.

The Add Surface dialog is displayed.
2. In the Surface Name editbox, type the name of the surface. You may also select a name from the drop-

down list.
3. Define the type of the surface, by selecting the appropriate radiobutton:

l Design— when the new surface is to be a design surface.
l Subgrade — if the new surface is to be a subgrade surface. If so, configure the following para-
meters:

1. In the Material editbox, specify the material used. This is optional but the material will be lis-
ted on the subgrade volumes report.

2. In the Class editbox, specify a character or characters to label and allocate the subgrade to a
class. This is optional but the class may be used to categorize the subgrade on the volumes
report.

4. If needed, tick the Copy Current Data checkbox box to copy the data allocated to the current design or sub-
grade surface to the new surface.

5. Click OK.

The surface is created and set as current Design or Subgrade surface.
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Fields of the Add Surface dialog
Field Description

Surface Name Defines the name of the new surface.

Surface Type
Defines the type of the new surface.
Design - when the new surface is to be a design surface.
Subgrade - if the new surface is to be a subgrade surface.

Material Defines the material used. This is optional but the material will be listed on the
subgrade volumes report.

Class
Defines a character or characters to label and allocate the subgrade to a class.
This is optional but the class may be used to categorize the subgrade on the
volumes report.

Copy Current
Data

Tick to copy the data allocated to the current design or subgrade surface to the
new surface.

Sequence icon
The Subgrade Sequence icon of the Resurface design view allows you to to re-order the subgrade surfaces. The
sequence is originally defined in the order that the subgrade surfaces are created, with the first surface being the
top subgrade surface. The sequence should be set correctly so that appropriate surfaces intersect each other.

To re-order surfaces:
1. At the Cross Section tab of the Resurface design view, click the Sequence icon.

The Subgrade Sequence dialog is displayed.
2. Sort the surfaces as you need. Use the Existing Surfaces list to hold the surfaces while the sequence is

being re-ordered.
3. Click OK.

The subgrades are re-ordered.

Delete icon
The Delete Surface icon of the Resurface design view allows you to delete surfaces from the road design.

To delete a surface:
1. At the Cross Section tab of the Resurface design view, click the Delete Surface icon.

The Delete Surface dialog is displayed.
2. In the Surfaces list, select surfaces to be deleted.

NOTE
Natural and Design surfaces cannot be deleted.

3. Click Delete.

The surfaces are deleted.
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Add Point icon
The Add Point icon of the Resurface design view allows you to point to a single cross section to modify the cur-
rent surface of the section displayed in the cross section panel.

To add a point to the cross section:
1. In the Profile panel, select the required cross section.
2. At the Cross Section tab of the Resurface design view, click the Add Point icon.
3. Locate the new point. Do one of the following:

l Click the required place in the Cross Section panel.
l Specify the offset and level of the new point in the appropriate editboxes at the bottom toolbar.

4. If needed, create more points.
5. When finished, press Esc.

Raise icon
The Raise Points icon of the Resurface design view allows you to raise or lower the level on a section of the cur-
rent cross section in the cross section panel by a fixed amount. The section is defined by an offset range. Altern-
atively, the height changed may be applied to a point or points with a defined code.

To adjust height of a section:
1. At the Cross Section tab of the Resurface design view, click the Raise Points icon.

The Raise XSect Points dialog is displayed.
2. In the Increment editbox, specify the amount of height adjustment. Use the positive value to raise and neg-

ative value to lower the section.
3. Define which points will be adjusted. You may do it either by offset of the cross section, or by the point

code. Do one of the following:
l Select the Offset From radiobutton and specify the offset range in the editboxes. The height will be
adjusted for all points within this offset range.

l Select the Code radiobutton and select the required code from the drop-down list. The height will be
adjusted for all points in this cross section with this code.

4. Click OK.
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Design tab
Limits group

Set Limits on Plan icon
Click it to define the resurfacing limits.

Edit Limits icon
Click it to edit an existing resurfacing limits set.

Minimum Thickness
Over Surface icon

Click it to calculate minimum thickness over the surface.
At Lowest Point icon

Click it to calculate minimum thickness at lowest point of the surface.
At Highest Point icon

Click it to calculate minimum thickness at highest point of the surface.

Along String icon
Click it to calculate minimum thickness along a reference string.

Set Thickness icon
Click it to manually set thickness of the asphalt.

Correct icon
Click it to correct minimum asphalt thickness.
Design group

Raise/Lower Design icon
Click it to tune the design or natural surface.

Cross Slopes group
Average icon

Click it to apply an average cross slope to strings.
Transition icon

Click it to apply a transition cross slope to strings.
Apply to Current Range icon

Click it to manually configure the cross slopes.
Profile group

Smooth Profile icon
Click it to create a smooth profile.

Set Level icon
Click it to define a profile elevation.

Average Level icon
Click it to create a smooth profile by averaging its elevations.

Update from Cross Section icon
Click it to transfer the changes from cross sections to a profile.
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Apply by Grade icon
Click it to apply a profile slope over the strings.
Reports group

Compute Volume icon
Click it to recalculate volumes.

Resurface Report icon
Click it to generate a resurface report.

Set Limits on Plan icon
The Set Limits on Plan icon of the Resurface design view allows you to set the resurfacing parameters for the
selected segment of the road.

To set limits:
1. At the Design tab of the Resurface design view, click the Set Limits on Plan icon.
2. At the Alignment panel, select the required start and end chainages.
3. At the Alignment panel, select the string which will be used in resurfacing.
4. When finished, press Esc.

The Set Limits dialog is displayed.
5. Configure the parameters as you need. Fields are described in the table below. To activate parameter, tick

its checkbox, to activate all parameters, tick the All check boxes checkbox.
6. Click OK.

Fields of the Set Limits dialog
Field Description

From station (m) Defines the start station of the resurfacing design.

To station (m) Defines the end station of the resurfacing design.

String Defines the strings to which the resurface changing will be applied. Select
required strings in the drop-down list.

Min thickness
(mm) Defines the minimum thickness of the asphalt surface.

Max thickness
(mm) Defines the maximum thickness of the asphalt surface.

Min milling (mm) Defines the minimum allowed thickness of milling.

Max milling (mm) Defines the maximum allowed thickness of milling.

Min cross slope
(%)

Defines the minimum slope of cross sections (from the centerline to the road
edge).

Max cross slope
(%)

Defines the maximum slope of cross sections (from the centerline to the road
edge).
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Field Description

Min long slope
(%) Defines the minimum slope of profile (from one IP to another).

Max cross slope
(%) Defines the maximum slope of cross sections (from one IP to another).

Relative slope
band

Defines the maximum slope angle between approaching and departing align-
ment segments at one IP, which may be defined as "smooth".

Edit Limits icon
The Edit Limits icon of the Resurface design view allows you to edit an existing resurfacing parameters.

To set limits:
1. At the Design tab of the Resurface design view, click the Edit Limits icon.

The Edit Limits dialog is displayed.
2. From the String drop-down list, select the string for editing.
3. Configure the parameters as you need. Fields are described in the table below.
4. Click OK.

Fields of the Edit Limits dialog
Field Description

From station (m) Defines the start station of the resurfacing design.

To station (m) Defines the end station of the resurfacing design.

String Defines the strings to which the resurface changing will be applied. Select
required strings in the drop-down list.

Min thickness
(mm) Defines the minimum thickness of the asphalt surface.

Max thickness
(mm) Defines the maximum thickness of the asphalt surface.

Min milling (mm) Defines the minimum allowed thickness of milling.

Max milling (mm) Defines the maximum allowed thickness of milling.

Min cross slope
(%)

Defines the minimum slope of cross sections (from the centerline to the road
edge).

Max cross slope
(%)

Defines the maximum slope of cross sections (from the centerline to the road
edge).

Min long slope
(%) Defines the minimum slope of profile (from one IP to another).

Max cross slope
(%) Defines the maximum slope of cross sections (from one IP to another).

Relative slope
band

Defines the maximum slope angle between approaching and departing align-
ment segments at one IP, which may be defined as "smooth".
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Over Surface icon
The Over Surface icon of the Resurface design view allows you to apply minimum thickness of the asphalt,
defined in limits, over the entire design surface. In that case level of asphalt will be calculated at each point
along alignment strings over the entire surface.

To set minimum thickness:
1. At the Design tab of the Resurface design view, click the Over Surface icon.

The Apply Min Thickness over Surface dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. Click OK.

At Lowest Point icon
The At Lowest Point icon of the Resurface design view allows you to apply minimum thickness of the asphalt,
defined in limits, at lowest point of the surface. In that case level of asphalt will be calculated at lowest point of
the surface and spread all over it.

To set minimum thickness:
1. At the Design tab of the Resurface design view, click the At Lowest Point icon.

The Apply Min Thickness at Lowest Point dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. Click OK.

At Highest Point icon
The At Highest Point icon of the Resurface design view allows you to apply minimum thickness of the asphalt,
defined in limits, at highest point of the surface. In that case level of asphalt will be calculated at highest point of
the surface and spread all over it.

To set minimum thickness:
1. At the Design tab of the Resurface design view, click the At Highest Point icon.

The Apply Min Thickness at Lowest Point dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. Click OK.
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Along String icon
The Along String icon of the Resurface design view allows you to apply minimum thickness of the asphalt,
defined in limits, along a reference string. In that case level of asphalt will be calculated at points of the reference
string and spread all over surface.

To set minimum thickness:
1. At the Design tab of the Resurface design view, click the Along String icon.

The Apply Min Thickness along String dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. From the Reference String drop-down list, select the string along which min thickness will be calculated.
5. Click OK.

Set Thickness icon
The Set Thickness icon of theResurface design view allows you to define thickness of the asphalt, over the entire
design surface. In that case level of asphalt will be calculated at each point along alignment strings over the entire
surface.

To set thickness:
1. At the Design tab of the Resurface design view, click the Set Thickness icon.

The Set Thickness dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the Thickness editbox, type the required asphalt thickness.
4. Click OK.

Correct icon
The Correct icon of theResurface design view allows you to correct minimum thickness of the asphalt. In that
case level of asphalt will be re-calculated at points of the reference string and spread all over surface.

To correct minimum thickness:
1. At the Design tab of the Resurface design view, click the Correct icon.

The Correct Min Thickness dialog is displayed.
2. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. Click OK.

Raise/Lower Design icon
The Raise/Lower Design icon of the g allows you to raise/lower design and/or natural surfaces.
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To raise/lower a surface:
1. At the Design tab of the Resurface design view, click the Raise/Lower Surface icon.

The Raise/Lower Surface dialog is displayed.
2. In the Surface group box, define the surface which will be tuned, by selecting the appropriate radiobutton.
3. In needed, in the From station (m) and To station (m) ediboxes, specify the chainage range to which min

thickness will be applied.
4. In the String drop-down list, select strings to which min thickness will be applied.
5. Define the direction and amount of tuning, by selecting either Raise or Lower radiobutton and typing the

amount in the appropriate editbox.
6. Click OK.

Average icon
The Average icon of the Resurface design view allows you to apply an average cross slope over the points on the
selected strings per cross section, basing on the design surface or the natural surface. In the result a straight
between the left and right of the selected strings parallel with the average of either the points on the natural sur-
face or the design surface will be created.

To apply an average cross slope:
1. At the Design tab of the Resurface design view, click the Average icon.

The Average Cross Slope dialog is displayed.
2. In the Surface group box, define the surface which will be tuned, by selecting the appropriate radiobutton.
3. In needed, in the From station (m) and To station (m) ediboxes, specify the requred chainage range.
4. In the String drop-down list, select strings to which min thickness will be applied.
5. From the Reference String drop-down list, select the string which is used as reference one. When recal-

culating elevations for the new cross fall, elevation of this string will not change.
6. Click OK.

Transition icon
The Transition icon of the Resurface design view allows you to apply cross slopes resulting in a linear transition
within the specified chainage range over the selected strings.

To apply a cross slope transition:
1. At the Design tab of the Resurface design view, click the Transition icon.

The Cross Slope Transition dialog is displayed.
2. In the From station (m) and To station (m) ediboxes, specify the chainage range to which min thickness

will be applied.
3. In the String drop-down list, select strings to which min thickness will be applied.
4. From the Reference String drop-down list, select the string which is used as reference one. When recal-

culating elevations for the new cross fall, elevation of this string will not change.
5. Click OK.
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Apply to Current Range icon
The Apply to Current Range icon of the Resurface design view allows you to configure cross slopes sections (a
slope from the centerline to the road edge) within the specified range of chainages.

To apply the cross slope:
1. At the Design tab of the Resurface design view, click the Apply to Current Range icon.

The Apply Design by Cross Fall dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Apply Design by Cross Fall dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.

To Chainage (m) Defines the end station of the resurfacing design.

Cross Fall (%) Defines the cross fall slope value.

From String Defines the start string of the cross fall.

To String Defines the end string of the cross fall.

Elev Ref String Defines the string which is used as reference one. When recalculating elev-
ations for the new cross fall, elevation of this string will not change.

Cross Fall Calculation

Left to Right Slope is counted from left string to right with the defined value.

Right to Left Slope is counted from right string to left with the defined value.

Treated as Crown Slope is counted from the reference string to the left and the right ones with the
defined value.

Smooth Profile icon
The Smooth Profile icon of the Resurface design view allows you to create a smooth profile within the specified
chainage range. It means tuning the slope between approaching and departing alignment segments at one IP to the
defining value, by using the selecting ratio between filling and milling the surface.

To smooth a profile:
1. At the Design tab of the Resurface design view, click the Smooth Profile icon.

The Smooth Profile dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Smooth Profile dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.
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Field Description

To Chainage (m) Defines the end station of the resurfacing design.

String Select strings to which smoothing will be applied.

Spacing
Defines the spacing of points at which smoothness will be controlled.

Default value is 0.00, in that case IPs of aliments will be used for spacing.

Max allowed rel-
ative slope (%)

Defines the maximum slope between approaching and departing alignment seg-
ments at one IP, with which profile may be defined as "smooth".

Fill/Mill Ratio

Defines the ratio between filling (lifting) and milling (lowering) which may be
used to achieve smoothing. Define the required value by using slider, or type it
in the editbox.

The value 0 defines using mill only, which means that only removing of the
existing surface will be used, and not any new asphalt will be added.

The value 100 defines using fill only, which means that only adding of the new
asphalt will be used, and any part of the existing one will not be removed.

Set Level icon
The Set Level icon of the Resurface design view allows you to define the elevation of the profile within the spe-
cified chainage range.

To set the profile elevation:
1. At the Design tab of the Resurface design view, click the Set Level icon.

The Set Level dialog is displayed.
2. In the From station (m) and To station (m) ediboxes, specify the chainage range to which the elevation will

be applied.
3. In the String drop-down list, select strings to which level will be applied.
4. In the Level editbox, type the required elevation value.
5. Click OK.

Fields of the Set Level dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.

To Chainage (m) Defines the end station of the resurfacing design.

String Select strings to which leveling will be applied.

Level Defines the required elevation value.
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Average Level icon
The Average Level icon of the Resurface design view allows you to create a smooth profile between specified
chainages range by averaging elevations over the specified distances.

To smooth a profile:
1. At the Design tab of the Resurface design view, click the Average Level icon.

The Average Level dialog is displayed.
2. In the From station (m) and To station (m) ediboxes, specify the chainage range to which smoothing will be

applied.
3. In the String drop-down list, select strings to which smoothing will be applied.
4. In the Avg Length editbox, type the required averaging distance.
5. Click OK.

Fields of the Average Level dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.

To Chainage (m) Defines the end station of the resurfacing design.

String Select strings to which smoothing will be applied.

Avg Length Defines the required distance, over which the elevations will be averaged.

Update from Cross Section icon
The Update from Cross Section icon of the Resurface design view allows you to transfer the changes from the
cross sections to the profile.

To update a profile:
1. At the Design tab of the Resurface design view, click the Update from Cross Section icon.

The Update Profile from Cross Section dialog is displayed.
2. In the From station (m) and To station (m) ediboxes, specify the chainage range to which the changes will

be applied.
3. In the String drop-down list, select strings to which changes will be applied.
4. Click OK.

Fields of the Update Profile from Cross Section dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.

To Chainage (m) Defines the end station of the resurfacing design.

String Select strings to which changes will be applied.
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Apply by Grade icon
The Apply by Grade icon of the Resurface design view allows you to apply a profile slope over the strings.

To update a profile:
1. At the Design tab of the Resurface design view, click the Apply by Grade icon.

The Apply Design by Grade dialog is displayed.
2. In the From station (m) and To station (m) ediboxes, specify the chainage range to which the grade will be

applied.
3. In the Grade editbox, specify the required grade.
4. Click OK.

Fields of the Apply Design by Grade dialog
Field Description

From Chainage
(m) Defines the start station of the resurfacing design.

To Chainage (m) Defines the end station of the resurfacing design.

Grade Defines the required profile grade.
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Plotting tab
Plot Settings group

Profile Plot Settings icon
Click it to configure profile plotting parameters.

Cross Section Plot Settings icon
Click it to configure cross section plotting parameters.

Plot Standard Profile icon
Click it to plot a standard profile as a drawing.

Plot Offset Profile icon
Click it to plot an offset profile as a drawing

Plot CrossSection icon
Click it to plot sheets of cross sections as a drawing.

Profile Plot Settings icon
The Profile PLot Settings icon of the Resurface design view allows you to customize all of the parameters neces-
sary to create a profile drawing.

You may use two formats of plotting:
l Standard Format – A leader line is defined for each chainage and level position of the natural and design
surfaces.

l Grid Format – A grid is displayed with leaders at nominated intervals of chainage.

To configure a profile plotting:
1. At the Plotting tab of the Resurface design view, click the Profile Plot Settings icon.

The Profile Plot Settings dialog is displayed.
2. At the General Plot Settings tab, configure the position of the profile drawing on a title block; define the

scales and the information included on the profile. See "General Plot Setting tab" section on the next page
for fields description.

3. At the Standard Profile Settings tab, configure the plot parameters for the two profile lines. See "Standard
Profile Settings tab" section on page 808 for fields description.

4. At the Offset Profile Settings tab, define up to 8 profile lines along a selection of different strings and from
different surfaces. It is only used when plotting offset profiles. See Offset Profile Settings tab for fields
description.

5. At the Profile Table tab, define standard parameters for plotting profile sections. See "Profile Table tab"
section on page 809 for fields description.

6. At the Cut/Fill Settings tab, define the plot parameters for the cut/fill row on the profile layout. See
"Cut/Fill Settings tab" section on page 810 for fields description.

7. At the Volumes Settings tab, define the plot parameters for the volumes row on the profile layout. See
"Volume Settings tab" section on page 811 for fields description.

8. Click OK.
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General Plot Setting tab
This section describes the General Plot Settings tab of the Profile Plot Settings dialog of the Resurface design
view. At this tab you may position the profile drawing, or drawings, on a title block. Additional settings define the
scales used the required information included on the profile.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the General Plot Settings tab
Field Description

Horizontal Scale
(1 in .) Defines the horizontal scale for the profile.

Vertical Scale (1
in .) Defines the vertical scale for the profile.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block.

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
profile layout. This is measured in millimeters from the bottom left corner of
the title block.

Minimum Datum
Select the radiobutton to this option to define a minimum datum level in mil-
limeters on the plan. The value specified in the editbox sets the minimum dis-
tance of the profile line from the datum line of the profile layout.

Maximum Datum

If the Minimum Datum radiobutton is selected, specify the maximum datum
level in millimeters on the plan. The specified value sets the maximum dis-
tance of the profile line from the datum line of the profile layout.

If the profile line is still rising when the maximum datum is reached, the datum
will be reset to the minimum datum position

Datum Level Select the radiobutton to this option to define a fixed datum level (in meters) in
the editbox. The profile line will be drawn relevant to this level on the profile.

Max Plot Length

Defines the maximum plot length of the profile layout in millimeters on the
selected title block. This length will need to be modified for smaller paper
sizes.

For example, Max Plot Length = 700 represents 700 mm on an A1 sheet.

Start Station
Defines the start chainage of the profile for this drawing.

Default is 0.000 and can be used if the full length of the road is to be plotted

End Station
Defines the end chainage of the profile for this drawing.

Default is 99999.999 and can be used if the full length of the road is to be plot-
ted
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Field Description

Title Block Defines the required title clock to the drawing. Select it from the library by
clicking >>.

Plot Grid Tick to plot in a Grid Format.

Station Interval Defines the chainage intervals.

Horizontal Inter-
val Defines the space between the horizontal grid lines in meters.

Vertical Interval Defines the space between the vertical grid lines in meters.

Grid Height

Defines the height of the grid above the datum line on the drawing in mil-
limeters.

If this height is greater than the height available on the title block, the plot will
stop at the extents of the title block.

Plot Datum Tick to plot the datum value at the left hand end of the datum line.

Plot IPs Tick to plot the levels of the IP positions on the leader line below the profile
line.

Plot Min/Max Tick to plot the high and low point details on the surface of the design profile.

Plot Obstructions Tick to plot any obstructions.

Plot VC Length Tick to plot all the vertical curve lengths. These are plotted in a horizontal line
between the profile line and the datum line.

Plot VC Grade Tick to plot all the grades between IPs. These are plotted in a horizontal line
between the profile line and the datum line.

Super Elevation
Details

Tick to plot an extra row of data at the bottom of the profile. The super-
elevation details for the various curves in the design are plotted.

Plot Cut/Fill

Tick to plot an extra row of data above the surface levels. The cut or fill dif-
ference between the natural surface and design surface is plotted. The para-
meters from the Cut/Fill Settings tab must be configured to achieve the correct
results

Plot Volumes

Tick to plot an extra row of data above the surface levels. The volumes
between the adjacent cross sections are displayed as cut and fill. The para-
meters from the Volume Settings tab must be configured to achieve the correct
results.

Alignment Details Tick to plot an extra row of data below the chainages of the profile. The hori-
zontal alignment details for the road are plotted.

Extra Row Tick to include an extra row at the bottom of the profile figure for additional
information.

With Leader
Tick to extend the leader lines through this new row.

Leave unticked to leave the row free of leader lines.
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Standard Profile Settings tab
This section describes the Standard Profile Settings tab of the Profile Plot Settings dialog of the Resurface design
view. At this tab you may configure the plot parameters for the two profile lines. Use it to plot a profile con-
taining only the design and natural surface profiles of the current string. Select line types and colors for these two
surfaces.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Standard Profile Settings tab
Field Description

Design Surface

Tick the Active checkbox to plot the profile of the design surface and its data.
Specify a label in the editbox. The label is used to name this row of levels on
the profile plot.

Select the color, line type and thickness of the design profile line, and select
the text style used for the design surface levels.

Natural Surface

Tick the Active checkbox to plot the profile of the natural surface and its data.
Specify a label in the editbox. The label is used to name this row of levels on
the profile plot.

Select the color, line type and thickness of the natural profile line, and select
the text style used for the natural surface levels.

Justification Select the required justification table from the drop-down list to set the format
and precision of the chainage and level numerical data on the profile plot.

Plot Sequence Define the order in which the three lines of detail will be plotted.

Offset Profile Settings tab
This section describes the Offset Profile Settings tab of the Profile Plot Settings dialog of the Resurface design
view. At this tab you may define up to 8 profile lines along a selection of different strings and from different sur-
faces. Each profile line may have a separate datum by allocating spacing by using the Sep column. This data is
only used when plotting offset profiles.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Offset Profile Settings tab
Field Description

Active Tick to define and later plot the profile of a string on a nominated surface.
When the checkbox is ticked the row is activated for data entry.

String Selected a string from the drop-down list. The strings will be from the natural
surface data and any strings created for the design.
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Field Description

Surface Select a surface from the drop-down list. The surfaces listed will be every nat-
ural, design and subgrade surface created for the road.

Label Specify a label in this field. The label is used to name the levels for this profile
on the profile plot.

Color Select a color for the profile line defined on this row.

Sep
For all profile lines at the same datum, leave this field set to 0.00

To allocate a separation to the profiles on the profile plot, specify a value in
millimeters.

Justification Select the required justification table from the drop-down list to set the format
and precision of the chainage and level numerical data on the profile plot.

In each row you may click >> to open the Additional Offset Profile Specification dialog.

Fields of the Additional Offset Profile Specification dialog
Field Description

Text Style Defines the text style used for the levels of this profile line.

Line Style Defines the line style used for this profile line.

Thickness Defines the line thickness used for this profile line.

Profile Table tab
This section describes the Profile Table tab of the Profile Plot Settings dialog of the Resurface design view. At
this tab you may define standard parameters for plotting longitudinal sections. The parameters stored in the profile
table will be used for both offset profile and standard profile drawings.

The Profile Table is used to define the appearance of the profile layout with respect to grid lines, leaders, hori-
zontal line spacing, labels, text types and colors.

You may save the configuration to the default one, by clicking Save To Lib. These settings will be available in
other projects.

To load previously saved configuration, click Load From Lib.

Fields of the Profile Table tab
Field Description

Horizontal Lines Defines the color and thickness for the horizontal lines.

Grid/Leader Lines Defines the color and thickness for the horizontal lines.

Line Spacing Defines the spacing between the horizontal lines.

Station Tolerance Defines the tolerance for the chainage grid.

Station Format Defines the format of chainage displaying.

Station Label Defiles the label and the text style for station labels.

Stations Defines the text and justification styles for stations.
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Field Description

Datum Defines the text and justification styles for datum.

IP Max/Min Defines the text and justification styles for max and min IPs

VC Grade Defines the text and justification styles; and the line color for the VC grade
lines.

VC Length Defines the text and justification styles; and the line color for the VC length
lines.

Align Defines the text and justification styles; and the line color for the alignment
lines.

Super Defines the text and justification styles; and the line color for the super elev-
ation lines.

Cut/Fill Settings tab
This section describes the Cut/Fill Settings tab of the Profile Plot Settings dialog of the Resurface design view.
At this tab you may define the plot parameters for the cut/fill row on the profile layout.

This option enables the correct level differences between nominated surfaces to be computed and plotted on the
profile. When using the standard profile option, the cut/fill differences will be between the natural surface and
design surface at the center line or string position.

When using the offset profile option, the cut/fill differences may be defined between any nominated surfaces.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Cut/Fill Settings tab
Field Description

First Line

Defines the number for the first surface to compute the cut/fill.

If plotting standard profile the natural surface is surface 2 and the design sur-
face is surface 1.

If plotting offset profile the surface number is taken from the row number on
the Offset Profile Settings tab.

Second Line Defines the number of the second surface to complete the cut/fill.

First Line Text Defines the text required on the first line of the label in a 2 line format, or the
only line of the label in a 1 line format.

Second Line Text Defines the text required on the Second line of the label in a 2 line format, or
the only line of the label in a 1 line format.

Text Style (Cut) Defines the text style used for the cut data.

Text Style (Fill) Defines the text style used for the fill data.
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Field Description

Justification Defines the justification style used for the cut/fill data.

Cut Text Before Defines text that is required before each cut numeric.

Cut Text After Defines text that is required after each cut numeric.

Fill Text Before Defines text that is required before each fill numeric.

Fill Text After Defines text that is required after each fill numeric.

Line Format

Defines the line format:
l 1 Line – fill depth is written as a negative number such as -1.2 and cut
depth is written as a positive number such as +1.5

l 2 Lines – fill depth is written as a negative number on the first line and
cut depth is written as a positive number on the second line.

Sign

l Show +/- – Select to show the positive and negative sign on the cut and
fill values. This would usually be selected for a 1 line format.

l No Sign – Select to show no signs on the cut and fill values. This may be
used if a 2 lines format is chosen.

Volume Settings tab
This section describes the Volumes Settings tab of the Profile Plot Settings dialog of the Resurface design view.
At this tab you may define the plot parameters for the volumes row on the long section layout.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Volumes Settings tab
Field Description

Text Defines the text used as a label for this row of data on the profile.

Text Style (Cut) Defines the text style used for the cut volumes.

Text Style (Fill) Defines the text style used for the fill volumes.

Justification Defines the justification table used for the format and precision of the numeric
data plotted for the volumes.

Cross Section Plot Settings icon
The Cross Section Plot Settings icon of the Resurface design view allows you to customize all of the parameters
necessary to create a cross section drawing.

To configure a cross section plotting:
1. At the Plotting tab of the Resurface design view, click the Cross Section Plot Settings icon.

The Cross Section Plot Settings dialog is displayed.
2. At the Cross Section Plot Settings tab, configure the position of the cross section drawing on a title block;

define the scales and the information included on the cross section. See "Cross Section Plot Setting tab" sec-
tion on the next page for fields description.

811



Resurface design view

3. At the Surface Plot Settings tab, define the plot parameters for the various surfaces included in the
drawing. See "Surface Plot Settings tab" section on page 814 for fields description.

4. At the Cross Section Table tab, define the standard plot parameters for the cross section layout, including
the text styles used.

5. Click OK.

Cross Section Plot Setting tab
This section describes the Cross Section Plot Settings tab of the Cross Section Plot Settings dialog of the Resur-
face design view. At this tab you may position the cross section drawing, or drawings, on a title block. Additional
settings define the scales used the required information included on the cross section.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Cross Section Plot Settings tab
Field Description

Horizontal Scale
(1 in .) Defines the horizontal scale for the cross section.

Vertical Scale (1
in .) Defines the vertical scale for the cross section.

Start Position X
Defines the X coordinate of the starting position of the lower left corner of the
cross section layout. This is measured in millimeters from the bottom left
corner of the title block.

Start Position Y
Defines the Y coordinate of the starting position of the lower left corner of the
cross section layout. This is measured in millimeters from the bottom left
corner of the title block.

Left / Right Plot
Limit-Figures

Defines the offset limits for the plotting of offset and level figures.

Defines an offset in meters to the left and right of the center line or string
around which the sections are designed. Any data outside this limit is excluded
from the cross sections.

Left / Right Plot
Limit-Lines

Defines the offset limits for the plotting of lines.

Defines an offset in meters to the left and right of the center line or string
around which the sections are designed. Any data outside this limit is excluded
from the cross sections

Start Chainage
Defines the start chainage of the cross sections for this drawing.

Default is 0.000 and can be used if the full length of the road is to be plotted.

End Chainage
Defines the end chainage of the cross sections for this drawing.

Default is 99999.999 and can be used if the full length of the road is to be plot-
ted.

Title Block Defines the required title clock to the drawing. Select it from the library by
clicking >>.
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Field Description

Datum Level

Tick to specify a fixed datum level (in meters) in the editbox. The cross sec-
tions will be drawn relevant to this level on all the sections, even when the
grade of the road changes.

Leave unticked for the datum to be reset to a suitable value by the software, fol-
lowing the rules in the cross section Table.

Design Level
Selections

The format of the fields in this section will be dependent on the setting for the
radiobutton in the Type field below. They are only applied on rural format cross
sections.

Type

l Offsets – The editboxes from the Design Level Selection group box are
set for the input of specified offsets. Specify a minus sign for offsets to
the left of the centre line. Levels will be interpolated from the design sur-
face at these offsets and plotted on the cross sections at these positions
for rural format cross sections.

l Labels(Codes) – The editboxes from the Design Level Selection group
box are set for the input of the labels or codes applied to the ends of par-
ticular legs of the cross section. Levels will be interpolated from the
design surface at these points and plotted on the rural format cross sec-
tions.

Spacing

l Regular – Cross sections are positioned on the sheet by the row spacing
set in the Cross Section Table, so that this vertical spacing is applied
from the datum line of the first section to the datum line of the next sec-
tion.

l Auto – Cross sections are positioned on the sheet by the Auto row spa-
cing set in the Cross Section Table, so that this vertical spacing is
applied from the highest point on the first section to the datum line of the
next section.

X Fall Format
l Percent (%)— the crossfall will be represented in percents withing the
specified range.

l Ratio (1:x)— the crossfall will be represented as ratio.

Level Difference

Tick to plot the height difference between the natural and design surfaces at
each offset on the full format cross sections. These are plotted in an extra row
above the surface levels. Where the design surface is cut below the natural sur-
face the level difference is negative.

Plot Sign On
XFall

Tick to plot the minus sign on the crossfall, if the crossfall is activated on the
Surface Plot Settings tab.

Plot Volumes Tick to plot the volumes between this cross section and the previous one.

Plot design level
on natural leader

Tick to plot the design surface levels on the leader lines for the natural surface
when a full format cross section is plotted.

A design level will be interpolated and plotted wherever there is a leader line
relating to the natural surface.

Leave unticked to plot the design levels only where the leader lines relate to
the design surface.
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Field Description

Plot natural level
on design leader

Tick to plot the natural surface levels on the leader line for the design surface
when a full format cross section is plotted.

A natural surface level will be interpolated and plotted wherever there is a
leader line relating to the design surface.

Leave unticked to plot the natural surface levels only where the leader lines
relate to the natural surface.

Plot Obstructions Tick to plot any obstructions.

Mirror Cross Sec-
tion Tick to mirror the cross section plotting for the both sides.

Surface Plot Settings tab
This section describes the Surface Plot Settings tab of the Cross Section Plot Settings dialog of the Resurface
design view. At this tab you may define the plot parameters for the various surfaces included in the drawing.
Additional options allow you to label cross sections with cross falls and plot symbols on each section.

You may save the configuration as the default one, by clicking Save Default. These settings will be available in
other projects.

To load previously saved configuration, click Load Default.

Fields of the Surface Plot Settings tab
Field Description

Active Tick to plot the surface defined on this row of the dialog.

Surface Select the required surface from the drop-down list.

Label Defines the surface name, used to label rows of levels on the full format cross
sections.

Plot Levels

Tick to plot the levels for this surface, or leave unticked to plot no levels for
this surface. Subgrades usually have this box unticked. A row of levels is
included in the full format cross sections. The centreline level is displayed for
the surface for rural format cross sections.

Plot Lines Tick to plot the line work for this surface. If the check box is unticked no lines
will appear on the plot for this surface.

Plot XFalls Tick to plot the crossfalls on the surface. Leave unticked to exclude crossfalls.
Normally this checkbox is only ticked for the design surface.

Plot Leads
Tick to plot the leader lines for this surface on the full format cross section.
Normally this checkbox is ticked for the natural and design surfaces but not for
the subgrades.

Plot Symbols
Tick to plot the symbols defined in the symbol table. Normally this box is
ticked only for the Natural surface to marked specific features such as fence
lines, boundaries or existing seal positions
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Field Description

Plot Codes Tick to plot the survey codes from the cross section. If ticked, click >> and spe-
cify the codes for plotting in the table.

Color Defines the color plotted for this surface on the cross sections.

Angle
Defines the angle for the display of design levels specified for rural format
cross sections using the field Design Level Selection from the Cross Section
Plot Setting tab.

In each row you may click >> to open the More Surface Plot Specification dialog.

Fields of the More Surface Plot Specification dialog
Field Description

Text Style Defines the text style used for the levels of this surface.

Line Style Defines the line style used for this surface.

Thickness Defines the line thickness used for this surface.

Justification Defines the justification style used for this surface.

Plot Standard Profile icon
The Plot Standard Profile icon of the Resurface design view allows you to plot a standard long section as a draw-
ing in the drawings view. A standard long section contains profiles of the natural surface and the design surface
for the current string in the roads view.

Click the icon to plot the profile. The drawings view is opened as the current view and a linked drawing is created
containing the sheet or sheets that make up the long section drawing.

If more than one sheet is required to plot the long section at the required scale on the selected title block, multiple
sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Plot Standard Profile icon again from the roads view, as this
will create another drawing, losing any modifications already made in the drawings view.

Plot Offset Profile icon
The Plot Offset Profile icon of the Resurface design view allows you to plot an offset long section as a drawing
in the drawings view. An offset long section contains up to 8 profiles along various strings and surfaces in the
roads view.

Click the icon to plot the profile. The drawings view is opened as the current view and a linked drawing is created
containing the sheet or sheets that make up the offset long section drawing.

If more than one sheet is required to plot the long section at the required scale on the selected title block, multiple
sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Plot Offset Profile icon again from the roads view, as this will
create another drawing, losing any modifications already made in the drawings view.
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Plot CrossSection icon
The Plot CrossSection icon of the Resurface design view allows you to plot sheets of cross sections as a draw-
ing in the drawings view.

Click the icon to plot the cross section. The drawings view is opened as the current view and a linked drawing is
created containing the sheet or sheets that make up the cross section drawing.

If more than one sheet is required to plot the cross section at the required scale on the selected title block, mul-
tiple sheets will be created within the one drawing.

If the design in the roads design view is modified, the linked drawing may be updated in the drawings view by
using the Regen icon. There is no need to use the Plot CrossSection icon again from the roads view, as this will
create another drawing, losing any modifications already made in the drawings view.
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Library tab
Library group

Profile Plot Table icon
Click it to configure the standard parameters for plotting profile sec-

tions.
Cross Section Plot Table icon

Click it to configure the standard plot parameters for the cross section
layout

Window tab

New icon
Click it to open current road design in another window.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

Split icon
Click it to change the sizes of the road design view panels.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.

Display Hints icon
Click it to display product hints.
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Drainage Design View
The Drainage design view is the final step of the drainage design in the MAGNET Office. It comes into action
when you have already configured the drainage library and define drainage network in the survey view. You may
found details in Drainage library and Drainage group respectively.

TIP
Youmay alsomanage sewer library by using the icons from the Library tab of the Sewer design view.

The work area of the Design design displays the Design network with each pit and line labeled.

The Drainage design view has its own ribbon, different from the default MAGNET Office ribbon. Descriptions
may be found in the appropriate sections:

l "File tab" section on the facing page
l "View tab" section on the facing page
l "Library tab" section on page 820
l "Data tab" section on page 825
l "Calcs tab" section on page 828
l "Plot tab" section on page 831
l "Window tab" section on page 834
l "Help tab" section on page 834
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File tab

Open icon
Click it to open an existing drainage network.

Save icon
Click it to save the current drainage network.

Close icon
Click it to close the drainage network.

View tab
Refresh group

Surface Profile icon
Click it to view the profile of the natural and design surfaces.

Survey icon
Click it to switch to the survey view.
View group

Toolbar icon
Click it to enable/disable toolbar.

Status icon
Click it to enable/disable status bar.
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Library tab
Library group

Default Data icon
Click it to configure the default data of the drainage library.

FFy Factors icon
Click it to configure and store Flood Frequency factors.

Gutter Profiles icon
Click it to define the various gutter profiles.

Pit Inhelts icon
Click it to define the capacity of a curb inlet or catch pit.

Pipe Sizes icon
Click it to configure the pipe diameters in the pipe classes.

Rainfall Data group
Map Format icon

Click it to configure the rainfall data by using the map format.
Log Format icon

Click it to configure the rainfall data by using the logarithmic format.
IFD Format icon

Click it to configure the rainfall data by using the IDF format.

Default Data icon
The Default Data icon of the Drainage design view allows you to configure and store drainage parameters for
the region where you work.

To create a new default data dataset:
1. At the Library tab of the Drainage design view, click the Default Data icon.

The Default Data dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new dataset.
4. Configure the parameters as you need. Fields are described in the table below.
5. To configure the color layout, click Colors and select the required colors.
6. Click OK.

To edit an existing default data dataset:
1. At the Library tab of the Drainage design view, click the Default Data icon.

The Default Data dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need. Fields are described in the table below.
4. To configure the color layout, click Colors and select the required colors.
5. Click OK.
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Fields of the Default Data dialog
Field Description

Name Defines the name of the default data dataset.

Rain Defines the Rainfall Data for the network. See "Rainfall Data configuring" sec-
tion below for details.

Inlet ID Defines Pit Inlet style for the network. See "Pit Inlet configuring" section
below for details.

Gutter ID Defines the Gutter Profile style for the network. See "Gutter Profiles con-
figuring" section below for details.

Default Hydrological Data

Design Freq Define the recurrence interval of the storm event.

Max Tc Defines the minimum time of concentration in minutes required for the net-
work.

Min Tc Defines the minimum time of concentration in minutes required for the net-
work.

Surface Rough-
ness Defines the default surface roughness.

Default Hydraulic Data

Drop Defines the default setting for the drop through the manhole from the higher
upstream pipe to the lower downstream pipe.

Hz/deg Drop Defines added drop per horiz degree of change between angle of upstream pipe
and downstream pipe at pit.

Freeboard Defines the default freeboard for the design.

Pipe Class Defines the pipe class for the design.

Mannings 'n'
(pipe) Defines the roughness parameter for the pipe surface.

Cover Defines the default setting for the cover from the natural surface to the top
(obvert) of the pipe.

Roughness Defines default pipe roughness for design.

Min Slope Defines the minimum pipe slope required in the design.

Manning 'n' (road) Defines the roughness parameter for the road surfaces when calculating gutter
flows.

Backwater HGL Select the limiting of the level to match either the obvert or the actual water
level.

FFy Factors icon
The FFy Factors icon of the Drainage design view allows you to configure and store Flood Frequency factors.
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Flood Frequency factors for a given Average Recurrence Interval help you to adjust your runoff coefficient value.
These FFy factors are selected along with the Rainfall Data for the pipe network.

To create a new Flood Frequency factors dataset:
1. At the Library tab of the Drainage design view, click the FFy Factors icon.

The Flood Frequency Factors dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new dataset.
4. Configure the parameters as you need.
5. Click OK.

To edit an existing default data dataset:
1. At the Library tab of the Drainage design view, click the FFy Factors icon.

The Flood Frequency Factors dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need.
4. Click OK.

Gutter Profiles icon
The Gutter Profiles icon of the Drainage design view allows you to define the various gutter profiles.

They are used to calculate the flow time along the channel of the curb, and the flow width and depth in the curb
channel. MAGNET Office creates a vertical wall at either side of the defined gutter to handle flow depths that
exceed the capacity of the gutter profile.

To create a new gutter profile:
1. At the Library tab of the Drainage design view, click the Gutter Profiles icon.

The Gutter Profiles dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new profile.
4. Configure the parameters as you need. Simply type a new offset and level and the profile will auto-

matically re-sort the data. There is no need to define left and right hand gutter profiles.
5. Click OK.

To edit an existing gutter profile:
1. At the Library tab of the Drainage design view, click the Gutter Profiles icon.

The Gutter Profiles dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need. Simply type a new offset and level and the profile will auto-

matically re-sort the data. There is no need to define left and right hand gutter profiles.
4. Click OK.
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Pit Inhelts icon
The Pit Inhelts icon of the Drainage design view allows you to define the capacity of a curb inlet or catch pit.

Pit inlets do not have unlimited inlet capacity. As the flow from the upstream gutter increases, eventually some
water will fail to enter the inlet and it is referred to as the bypass flow.

The curb inlet behavior can be described by the following formula:

Where:
l Qi – flow entering the pit.
l Qu – flow arriving from upstream.
l A – the maximum inlet capacity before bypass occurs.
l B – dimensionless coefficient. A fraction of excess entering pit.

The term (Qu - A) represents the excess flow arriving at the pit and the coefficient B represents the fraction of
this excess that will enter the pit (in addition to quantity A).

In many cases the above algorithm is not sufficient to describe the curb inlet, so the software allows a second
method of entering curb inlet data. The second method allows the user to enter a complete table of Qu/Qi values
that will specify the desired inlet behavior. The two methods of entering the data are thus described as "AB" and
"CURVE".

Whichever method is selected, the data is given an Inlet ID. This is then referred to during the hydrological cal-
culations to describe the inlet capacity of a given pit.

The curb inlet screen allows you to select the method being used by clicking on the appropriate radiobutton. If the
AB method is selected then the A & B values should be defined. The rest of the data can be ignored.

If the CURVE method is selected then Qu/Qi pairs should be defined in the Flow_Us and Flow_In fields of the
table respectively. A new pair can be entered at the end of the list and the program will automatically re-sort the
data based on increasing Qu, and then re-draw the Qu/Qi relation in the graphic window. The graphic display
serves as a check for any obvious errors.

To create a new pit inhelt dataset:
1. At the Library tab of the Drainage design view, click the Pit Inhelts icon.

The Pit Inhelts dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new dataset.
4. Configure the parameters as you need.
5. Click OK.

To edit an existing gutter profile:
1. At the Library tab of the Drainage design view, click the Pit Inhelts icon.

The Pit Inhelts dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need.
4. Click OK.
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Pipe Sizes icon
The Pipe Sizes icon of the Drainage design view allows you to configure the pipe diameters in the pipe classes.

The library holds pipe class details. It is taken from the combination of the definition labels used for the pipe
type, pipe class and joint type. The cost ($/m) column entries are for informational purposes only and not used by
the program.

To create a new pipe sizes dataset:
1. At the Library tab of the Drainage design view, click the Pipe Sizes icon.

The Pipe Sizes dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new dataset.
4. Configure the parameters as you need.
5. Click OK.

To edit an existing pipe sizes dataset:
1. At the Library tab of the Drainage design view, click the Pipe Sizes icon.

The Pipe Sizes dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need.
4. Click OK.
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Data tab
Settings group

Network Settings icon
Click it to configure common design parameters of the drainage network.

Specify Area for Pit icon
Click it to define catchment area for the pit.

Set Bypass Pit icon
Click it to define a bypass pits.

Edit group
Edit Pit Data icon

Click it to edit properties of the selected pit.
Edit All Pits icon

Click it to edit properties of all existing pits.
Edit All Pipes icon

Click it to edit properties of all existing pipes.
Other group

Copy to Clipboard icon
Click it to copy the selected object to the clipboard.

Create Pipe icon
Click it to write pipe data as the annotation.

Specify Area for Pit icon
The Specify Area for Pit icon of the Drainage design view allows you to define polygons in the survey view for
the catchment areas of the various pits. Instead of typing in the data for each pit, the area can be selected from the
polygons.

To define catchment area for the pit:
1. At the Data tab of the Drainage design view, click the Specify Area for Pit icon.
2. In the working area select the required pit.

The Area Option dialog is displayed.
3. Click either Full Area or Part Area as you need.

The Pit Area Data dialog is displayed.
4. Click Polygon and select the required polygon in the working area.
5. Click OK.

Set Bypass Pit icon
The Set Bypass Pit icon of the Drainage design view allows you to nominate a bypass pit, which will catch the
bypass flow from the other overflooded pit.

To set a bypass pit:
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1. At the Data tab of the Drainage design view, click the Set Bypass Pit icon.
2. In the working area, select the pit which seems to be overflooded.
3. In the working area, select the pit which will be used as the bypass pit.
4. If needed, repeat steps 2 and 3.
5. When finished, press Esc.

Edit Pit Data icon
The Edit Pit Data icon of the Drainage design view allows you to view and edit properties of one selected pit
(manhole) in the sewer network.

You may also double click the required pit to edit its parameters.

To edit pit parameters:
1. In the work area of the Drainage design view, select the required pit.
2. At the Data tab, click the Edit Pit Data icon.

The Pit Details dialog is displayed.
3. Review the parameters, if needed change them.
4. Do one of the following:

l Click Next to proceed to the next pit in the flow.
l Click Prev to proceed to the previous pit in the flow.
l Click OK to close the dialog.

You may select a pit for editing in one of the following ways:
l Select the required pit in the work area of the Drainage design view and click Edit Pit Data.
l Double click the required pit in the work area of the Drainage design view.
l By using the Next or Prev buttons of the Pit Details dialog.

Edit All Pits icon
The Edit All Pits icon of the Drainage design view allows you to edit properties of all existing pits (manholes) in
the sewer network.

To edit pit parameters:
1. At the Data tab of Drainage design view, click the Edit All Pits icon.

The Edit All Pits dialog is displayed.
2. Configure the parameters as you need.
3. Click OK.

Edit All Pipes icon
The Edit All Pits icon of the Drainage design view allows you to edit properties of all existing pipes in the sewer
network.

TIP
To edit parameters of the exact pipe, double click it in the working area.
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Edit All Pipes icon

To edit pit parameters:
1. At the Data tab of the Drainage design view, click the Edit All Pipes icon.

The Edit All Pipes dialog is displayed.
2. Configure the parameters as you need.
3. Click OK.
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Calcs tab
Calcs group

Hydrology icon
Click it to calculate a hydrology data.

Pipe Design icon
Click it to calculate pipe design.

Pipe Analysis icon
Click it to analyze the design.

Hydrology icon
The Hydrology icon of the Drainage design view allows you to calculate runoff, gutter flow, pipe flow and
bypass flow. It assumes that the water entering a pit will flow down the pipe (ignores surcharge). As you run
option you will be prompted to select a method for computing the flows.

To compute hydrology:
1. At the Calcs tab of the Drainage design view, click the Hydrology icon.

The Hydrological Calculation Options dialog is displayed.
2. Select the required methods:

l Program calculate from contributing areas – to use the areas defined in the Pit Area Data option.
l User Input (see pit data, alternate flow) – to use the flows defined in the User input–alternate to
contributing areas (Analysis) field from the Pit Details dialog. If you use this section you must have
entered the flows for every pit in the Pit Details dialog box.

l Ilsax flow (see pit data) – use this if you have calculated flows from ILSAX.
l Assumed velocity (m/s) – If no design has been done, the program will simply use the value typed in
the editbox. Range of input: 1m/s to 3m/s.

l Designed pipe velocity (pipe full or part full) – to use the actual velocity taken from the last pipe
design or analysis process.

l Designed pipe (Equiv pipe-full vel, Q/A) – to use the equivalent pipe-full velocity taken from the
last pipe design or analysis process.

3. Click OK.

Pipe Design icon
The Pipe Design icon of the Drainage design view allows you to re-compute/edit the pipe design of current drain-
age network.

To re-compute the design:
1. At the Calcs tab of the Drainage design view, click the Pipe Design icon.

The Pipe Design dialog is displayed.
2. Click Re-Design.

The Pipe Design Options dialog is displayed.
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3. Configure the design and click OK.

The design is computed. The Pipe Design dialog is displayed.
4. Review the design, if needed, change it.
5. When finished, do one of the following:

l Click Select Pipe to select another pipe from the list.
l Click Next Pipe to proceed to the next pipe in the flow.
l Click Prev Pipe to proceed to the previous pipe in the flow.
l Click OK to close the dialog.

To edit the design:
1. At the Calcs tab of the Drainage design view, click the Pipe Design icon.

The Pipe Design dialog is displayed.
2. ClickModify Design.

The Pipe Design dialog is displayed.
3. Review the design, if needed, change it.
4. When finished, do one of the following:

l Click Select Pipe to select another pipe from the list.
l Click Next Pipe to proceed to the next pipe in the flow.
l Click Prev Pipe to proceed to the previous pipe in the flow.
l Click OK to close the dialog.

Buttons of the Pipe Design dialog
Button Description

Set Diam Click it to change the diameter of the pipe to another size from the pipe class
list.

Set K Click it to set the pit loss coefficient for the upstream pit. This may be obtained
from Missouri charts and added to any angular loss factor.

Set Slope Click it to set downstream invert to a level based on the slope from the
upstream invert.

Set All U/S Inv Click it to re-calculate the invert levels back upstream from the current pit or
the outlet. Set either the outfall from a pit invert level or a known outfall level

Move Parallel
Click it to move the pipe, resetting the upstream and downstream invert levels
by a relative value, prefixed with a ‘+’ or ’–‘ sign. Click Repeat to repeat the
last movement.

Move U/S Inv Click it to specify a new level for the upstream invert or change the level by a
relative value. Click Repeat to repeat the last movement.

Move D/S Inv Click it to specify a new level for the downstream invert or change the level by
a relative value. Click Repeat to repeat the last movement.

Clear U/S Inv Click it to reposition the upstream invert using the design constraints in your
data.

Clear D/S Inv Click it to reposition the downstream invert using the design constraints in your
data.
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Button Description

Clear Both Inv Click it to reposition both the upstream and downstream invert using the design
constraints in your data.

Select Pipe Click it to select a pipe from the list.

Next Click it to proceed to the next pipe in the flow.

Prev Click it to proceed to the previous pipe in the flow.

Redraw Click it to refresh the preview.

Calc BW Click it to run a backwater analysis of the system.

Show BW Click it to display the backwater analysis. Check for surcharging at a pit.

Pipe Analysis icon
The Pipe Analysis icon of the Drainage design view allows you to analize design of current drainage network
without saving it and applying changes.

To analyze the design:
1. At the Calcs tab of the Drainage design view, click the Pipe Analysis icon..

The Pipe Analysis Options dialog is displayed.
2. Configure the design and click OK.

The design is computed. The Pipe Design dialog is displayed.
3. Review the design, if needed, change it.
4. When finished, do one of the following:

l Click Select Pipe to select another pipe from the list.
l Click Next Pipe to proceed to the next pipe in the flow.
l Click Prev Pipe to proceed to the previous pipe in the flow.
l Click OK to close the dialog.

Buttons of the Pipe Design dialog
Button Description

Set K Click it to set the pit loss coefficient for the upstream pit. This may be obtained
from Missouri charts and added to any angular loss factor.

Set All U/S Inv Click it to re-calculate the invert levels back upstream from the current pit or
the outlet. Set either the outfall from a pit invert level or a known outfall level

Select Pipe Click it to select a pipe from the list.

Next Click it to proceed to the next pipe in the flow.

Prev Click it to proceed to the previous pipe in the flow.

Redraw Click it to refresh the preview.

Calc BW Click it to run a backwater analysis of the system.

Show BW Click it to display the backwater analysis. Check for surcharging at a pit.
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Plot tab
Reports group

Printed Reports icon
Click it to plot a report as a drawing.

Plotting group
Plot Calc icon

Click it to plot a calculation as a drawing.
Plot Profile icon

Click it to plot a profile as a drawing.
Settings group

Profile Plot Settings icon
Click it to configure the profile plotting.

Printed Reports icon
The Printed Reports icon of the Drainage design view allows you to plot a drainage report as a drawing.

To plot a report:
1. At the Plot tab of the Drainage design view, click the Printed Reports icon.

The Select Reports dialog is displayed.
2. Select the report for plotting from the list.
3. Click OK.

The report is plotted.

Plot Calc icon
The Plot Calc icon of the Drainage design view allows you to plot a drainage calculation as a drawing.

To plot a calculation:
1. At the Plot tab of the Drainage design view, click the Plot Calc icon.

The Select Calc Sheet To Plot dialog is displayed.
2. Select the calculation for plotting from the list.
3. In the Title Block field, define the title block for plotting.
4. In the Offset field, define the coordinates of the plotting position.
5. Click OK.

The calculation is plotted.

Profile Plot Settings icon
The Profile Plot Settings icon of the Drainage design view allows you to customize all of the parameters neces-
sary to create a profile drawing.
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To configure a profile plotting:
1. At the Plot tab of the Drainage design view, click the Profile Settings icon.

The Plot Profile dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click Colors to configure the color layout of plotting.
4.

Fields of the Plot Profile dialog
Filed Description

Title Defines the name of the drawing.

Line Defines the drainage line for plotting.

Start Pit Defines the upstream pit from which you wish to start the long section plot.
Only the pits in the nominated pipe line will be displayed.

End Pit Defines the last downstream pit of the pipe line.

Horizontal Scale Defines the horizontal scale for profile plotting.

Vertical Scale Defines the vertical scale for profile plotting.

Start

Start Position X Defines the X coordinate of the starting position of the plot on the sheet of
paper in mm.

Start Position Y Defines the Y coordinate of the starting position of the plot on the sheet of
paper in mm.

Minimum Level Defines the minimum distance of the profile line from the datum line. This is
not used if the datum level is set.

Maximum Level Defines the maximum distance of the profile line from the datum line

Bottom Spacing Defines the text spacing in mm for plotting the bottom rows of data.

Top Spacing Defines the text spacing in mm for plotting the top rows of data.

Circle Diameter Circular size for pit labels in mm.

Max Plot Length Defines the maximum length of the plot in mm. This will be dependent on the
size of the title block.

Start Chainage Defines the chainage for the first pit plotted on the drainage line.

Datum Level Defines the datum level. If blank, the minimum datum level is used.

Pit Label Defines a generic label for all the pits – leave blank if not required.

Datum Ronding
This will round the datum to the nearest multiple of the entered value. (eg. spe-
cify 1.0 and the datum will be to the nearest metre) This field will have no
effect if the datum level is set.

Title Block Click << to define the title block for plotting.

Plot Scale Info Tick to plot the horizontal & vertical scales on each sheet.
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Filed Description

Plot titles (to LH
side) Tick to plot the titles of each row of data on the left hand side of the linework.

Plot Second Sur-
face Tick to plot the second surface if it exists

Plot Reverse Tick to plot the profile from the downstream pit to the upstream pit (ie. Uphill).
The default (unticked) is downhill or upstream to downstream.

Plot HGL (Back-
water)

Tick to plot the Backwater HGL and select whether HGL is limited to Obvert
or is the Actual water level.

Plot Depth to
invert Tick to plot the depth to the invert level of the pipe.

Plot Capacity Tick to show capacity in cubic meters per second.

Plot Velocity Tick to show velocity for that pipe reach.

Plot Flow Tick to show flow rate in cubic meters per second.

Plot All lines Tick to plot all the drainage lines of this network. They will plot on separate
sheets unless the Plot Multiple Lines on Page checkbox is ticked.

Plot Obstructions Tick to plot the obstructions in the appropriate position on the plot.

Plot Obstructions
Description Tick to plot description of obstruction as text adjacent to the obstruction.

Plot Multiple
Lines on Page

Tick to maximize the usage of page area to fit the profiles of multiple lines on
the sheet.

Plot at Surface
Points

Tick to plot a leader line to surface changes between pits with depth to invert
and chainage.

Plot Pipe Dia-
meter Tick to plot pipe size row.

Next to D If ticked, pipe class plots next to the diameter. If unticked, the pipe class plots
below the pipe diameter.

Text Table Defines the text tables to be used in plotting.

Justification Table Defines the justification tables to be used in plotting.
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Window tab

New Window icon
Click it to create a new window in the work area.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.

Display Hints icon
Click it to display product hints.
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Sewer Design View
The Sewer design view is the final step of the sewer design in the MAGNET Office. It comes into action when
you have already configured the sewer library and define sewer network in the survey view. You may found
details in "Sewer library" section on page 666 and "Sewer group" section on page 382 respectively.

TIP
Youmay alsomanage sewer library by using the icons from the Library tab of the Sewer design view.

The work area of the Sewer design displays the Sewer network with each pit and line labeled.

The Sewer design view has its own ribbon, different from the default MAGNET Office ribbon. Descriptions may
be found in the appropriate sections:

l "File tab" section on the next page
l "View tab" section on the next page
l "Library tab" section on page 837
l "Data tab" section on page 840
l "Calcs tab" section on page 848
l "Plot tab" section on page 850
l "Window tab" section on page 852
l "Help tab" section on page 852
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File tab

Open icon
Click it to open an existing sewer network.

Save icon
Click it to save the current sewer network.

Close icon
Click it to close the sewer network.

View tab
Refresh group

Surface Profile icon
Click it to view the profile of the natural and design surfaces.

Survey icon
Click it to switch to the survey view.
View group

Toolbar icon
Click it to enable/disable toolbar.

Status icon
Click it to enable/disable status bar.
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Library tab
Default Data icon

Click it to manage the sewer library default data.
Pipe Class icon

Click it to manage the sewer library pipe classes.

Default Data icon
The Default Data icon of the Sewer design view allows you to manage the sewer library default data. This is gen-
eral data for all the pipes and pits in the current network.

To create a new default data dataset:
1. At the Library tab of the Sewer design view, click the Default Data icon.

The Default Data dialog is displayed.
2. Click New.
3. In the Name editbox, type the name of the new dataset.
4. Configure the parameters as you need. Fields are described in the table below.
5. To configure the color layout, click Colors and select the required colors.
6. Click OK.

To edit an existing default data dataset:
1. At the Library tab of the Sewer design view, click the Default Data icon.

The Default Data dialog is displayed.
2. From the Name drop-down list, select the required dataset.
3. Configure the parameters as you need. Fields are described in the table below.
4. To configure the color layout, click Colors and select the required colors.
5. Click OK.

Fields of the Default Data dialog
Field Description

Name Displays the name of the default data set.

Flow for Plotting Select the appropriate option.

Sewer Data

Pit Diameter Defines the diameter of the pit (manhole).

Min. Drop Defines the minimum drop through the manhole from the higher upstream pipe
to the lower downstream pipe.

Max. Drop Defines the maximum drop through the manhole from the higher upstream pipe
to the lower downstream pipe.

Pipe Class Defines the pipe class for the data set.
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Field Description

BCIL Data

Block Control Invert Level.

These settings are optional, but useful for designing the main sewer line in rela-
tion to the connections at the house drain points. When using BCIL, MAGNET
Office designs the sewer pipe at a suitable level to allow for a nominated min-
imum depth and slope from the drain point of each house. See "Create BCIL
icon" section on page 384 for details.

Min. Cover Defines the minimum cover over the connecting pipe from the house drain
point

Drop at House
Drain Defines the drop at the house drain.

Min. Slope (%) Defines the minimum slope for the connecting pipe from the house drain point.

Drop into Sewer Defines the drop into the sewer network

Pipe Class icon
The Pipe Class icon of the Sewer design view allows you to manage the sewer library pipe classes. The library
holds pipe class details. It is taken from the combination of the definition labels used for the pipe type, pipe class
and joint type.

To create a new pipe class dataset:
1. At the Library tab of the Sewer design view, click the Pipe Class icon.

The Pipe Class dialog is displayed.
2. Click New.
3. In the Pipe Class Definition groupbox, specify the following information:

l In the Pipe Type editbox, type the abbreviation for the pipe type.
l In the Joint Type editbox, type the abbreviation for the joint type.
l In the Pipe Class editbox, type the abbreviation for the pipe class.
l In the Plot Annotation editbox, type any relevant information to be used to annotate pipes. This field
is optional.

The name of the pipe class will be automatically generated from this information.
4. Fill in the pipe class table.
5. Click OK.

To rename a pipe class dataset:
1. At the Library tab of the Sewer design view, click the Pipe Class icon.

The Pipe Class dialog is displayed.
2. From the Pipe Class drop-down list, select the required dataset.
3. Click Rename.
4. In the Pipe Class Definition groupbox, specify the following information:
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l In the Pipe Type editbox, type the abbreviation for the pipe type.
l In the Joint Type editbox, type the abbreviation for the joint type.
l In the Pipe Class editbox, type the abbreviation for the pipe class.
l In the Plot Annotation editbox, type any relevant information to be used to annotate pipes. This field
is optional.

The name of the pipe class will be automatically generated from this information.
5. Click OK.

To edit a pipe class dataset:
1. At the Library tab of the Sewer design view, click the Pipe Class icon.

The Pipe Class dialog is displayed.
2. From the Pipe Class drop-down list, select the required dataset.
3. In needed, In the Plot Annotation editbox, type any relevant information to be used to annotate pipes.
4. Fill in the pipe class table.
5. Click OK.
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Data tab
Settings group

Network Settings icon
Click it to configure the sewer network settings.

Edit group
Edit Pit icon

Click it to edit properties of the selected pit.
Edit Pipe icon

Click it to edit properties of the selected pipe.
Edit BCIL icon

Click it to edit the BCIL data.
Edit All group

Edit All Pits icon
Click it to edit several pits at once.

Edit All Pipes icon
Click it to edit several pipes at once.
Update group

Update Network icon
Click it to update sewer network to include all changes made.

Network Settings icon
The Network Setting icon of the Sewer design view allows you to view and edit properties of the current sewer
network.

To edit sewer network parameters:
1. At the Data tab of the Sewer design view, click the Network Settings icon.

The Sewer Design dialog, opened at the Network Settings tab is displayed.
2. Review the parameters, if needed change them. Fields are described in the table below.
3. Click OK.

Fields of the Pit Data tab of the Sewer Design dialog
Field Description

Color Defines the colors for the sewer network layout.

Network Name Displays the name of the network.

Description Type any relevant description of the network.

Primary DTM Displays the primary DTM of the sewer design.

Secondary DTM Displays the secondary DTM of the sewer design.
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Field Description

Default Sewer
Data Defines the default values for the elements of the sewer network.

Pit Diameter Defines the diameter of the pit (manhole).

Pipe Class Defines the pipe class. It is displayed as a combination of the type of pipe, its
class and the joint type.

Min Drop Defines the minimum drop through the pit. This drop will be automatically
applied to every pit PLUS the Hz/deg angle change drop.

Max Drop Defines the maximum drop through the pit.

Hz/deg Drop
Defines the additional drop added to the minimum drop through the pit. Drop
applied is calculated on the angle change between a pipe reach entering a pit
and the pipe reach leaving a pit

Chainage Origin Displays the properties of the main sewer line.

Sewer Line Displays the name of the main sewer line.

U/S Pit Displays the upstream pit of the main sewer line.

D/S Pit Displays the downstream pit of the main sewer line.

Start At Defines where the start chainage will be located – either at the upstream or at
the downstream pit.

Start Chainage Defines the start chainage at the beginning of the main sewer line.

Default BCIL
Data

Defines the default values for the BCIL data. See "Create BCIL icon" section
on page 384 for details.

Min. Cover Defines the minimum cover over the connecting pipe from the house drain
point

Drop at House
Drain Defines the drop at the house drain.

Min. Slope (%) Defines the minimum slope for the connecting pipe from the house drain point.

Drop into Sewer Defines the drop into the sewer network

Use BCIL Tick to use the BCIL data in the current Sewer design.

Edit Pit icon
The Edit Pit icon of the Sewer design view allows you to view and edit properties of one selected pit (manhole)
in the sewer network.

You may also double click the required pit to edit its parameters.

To edit pit parameters:
1. In the work area of the Sewer design view, select the required pit.
2. At the Data tab, click the Edit Pit icon.

The Sewer Design dialog, opened at the Pit Data tab is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
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4. Do one of the following:
l Click Select to edit another pit.
l Click Next to proceed to the next pit in the flow.
l Click Prev to proceed to the previous pit in the flow.
l Click OK to close the dialog.

You may select a pit for editing in one of the following ways:
l Select the required pit in the work area of the Sewer design view and click Edit Pit.
l Double click the required pit in the work area of the Sewer design view.
l At the Pit Data tab of the Sewer Design dialog, click Select and select the required pit from the list.
l Select the required pit at the preview area at the Pit Data tab of the Sewer Design dialog.

Fields of the Pit Data tab of the Sewer Design dialog
Field Description

Pit Name Displays the name of the pit.

Easting Displays the East coordinate of the pit.

Northing Displays the North coordinate of the pit.

U/S Pit Displays the pit immediately upstream from the selected pit.

Sewer Line Displays the sewer line to which the pit belongs to.

D/S Pit Displays the pit immediately downstream from the selected pit.

Chainage Displays the running chainage of this pit from the last outlet pit of the main ter-
minating sewer line.

Pit Comment Type any relevant comment for the pit.

Pit Type Defines the type for depicting the pit.

Invert Level Displays the design invert level at outlet of the pit.

Lid Level Defines the level of point depicting pit lid level.

Survey Level Displays level of surface where pit intersects with the nominated primary
DTM.

Pit Diameter Defines the diameter of the pit (manhole).

Min Drop Defines the minimum drop through the pit. This drop will be automatically
applied to every pit PLUS the Hz/deg angle change drop.

Max Drop Defines the maximum drop through the pit.

Hz/deg Drop
Defines the additional drop added to the minimum drop through the pit. Drop
applied is calculated on the angle change between a pipe reach entering a pit
and the pipe reach leaving a pit

Locked Tick to lock the properties of the pit, so they cannot be changed by any function
in the Sewer design view.
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Edit Pipe icon
The Edit Pipe icon of the Sewer design view allows you to view and edit properties of one selected pipe in the
sewer network.

You may also double click the required pipe to edit its parameters.

To edit pipe parameters:
1. In the work area of the Sewer design view, select the required pipe.
2. At the Data tab, click the Edit Pipe icon.

The Sewer Design dialog, opened at the Pipe Data tab is displayed.
3. Review the parameters, if needed change them. Fields are described in the table below.
4. Do one of the following:

l Click Select to edit another pipe.
l Click Next to proceed to the next pipe in the flow.
l Click Prev to proceed to the previous pipe in the flow.
l Click OK to close the dialog.

You may select a pipe for editing in one of the following ways:
l Select the required pipe in the work area of the Sewer design view and click Edit Pipe.
l Double click the required pipe in the work area of the Sewer design view.
l At the Pipe Data tab of the Sewer Design dialog, click Select and select the required pipe from the list.
l Select the required pipe at the preview area at the Pipe Data tab of the Sewer Design dialog.

Fields of the Pipe Data tab of the Sewer Design dialog
Field Description

Sewer Line Displays the sewer line to which the pipe belongs to.

U/S Pit Displays the pit at the upstream end of the pipe.

D/S Pit Displays the pit at the downstream end of the pipe.

Length Displays the length of the pipe, i.e. the distance between U/S and D/S pits.

Pipe Comment Type any relevant comment for the pipe.

Min Slope (%) Defines the minimum slope for this pipe reach.

Min Cover Defines the minimum cover for this pipe reach.

NPipes Defines the number of pipes.

Pipe Class Defines the pipe class. It is displayed as a combination of the type of pipe, its
class and the joint type.

Set-up by Pipe
Design Defines the pipe diameter. The U/S invert and D/S invert are based on it.

Locked Tick to lock the properties of the pipe, so they cannot be changed by any func-
tion in the Sewer design view.

843



Sewer design view

Edit BCIL icon
The Edit BCIL icon of the Sewer design view allows you to configure the parameters of the BCIL (Block Con-
trol Invert Level) points.

The BCIL (Block Control Invert Level) is a tool will ensure that Magnet Office designs the sewer pipe low
enough to carter for a specified minimum slope from the drain point at the house so the house may be connected
to the sewer line properly.

NOTE
The BCIL is an optional feature.

BCIL data are defined in the survey view by the point entities, with the special point code. There are three types
of the BCIL points:

l House Connection (HC) – this point should have @HCxxxx code.
l Sewer Connection (SC) – this point should have @SCxxxx code.
l Intermediate Connection (IC) – this point should have @ICxxxx code.

The xxxx part in the point codes represents any alphanumeric string. Usually it defined by the lot name. BCIL
points from the same lots should have the same alphanumeric parts.

All BCIL point must have defined elevations and must be located at the same layer with the sewer line to which
they are must be connected.

To edit the BCIL parameters:
1. At the Data tab of the Sewer design view, click the Edit BCIL icon.

The Block Control Invert Level dialog is displayed.
2. Select the required BCIL point. Do one of the following:

l From the Name drop-down list, select the required point.
l Click Find and perform search by point name.

3. Review the parameters, if needed, change them.
4. Click OK.

Edit All Pits icon
The Edit All Pits icon of the Sewer design view allows you to view and edit properties of several pits (man-
holes) in the sewer network at once.

To edit pit parameters:
1. At the Data tab of the Sewer design view, click the Edit All Pits icon.

The Edit All Pits dialog is displayed.
2. Define the pit selection for editing. Do one of the following:

l Select the All Pits radiobutton to edit all existing pits.
l Select the Pits by Line radiobutton. If so, configure the selection. Do one of the following:

l From the Line drop-down list, select the required sewer line.
l From the U/S Pit and D/S Pit drop-down lists, select the start and end pits of the required
sewer line.
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3. Tick the checkboxes for the parameters to be changed and specify their values in the appropriate fields.
Fields are described in the table below.

4. Click OK.

Fields of the Pit Data tab of the Sewer Design dialog
Field Description

Select From Defines the selection of the pits to be edited.

Line Define the sewer line to which the pits to be edited belongs to.

U/S Pit Displays the start pit of the sewer line to which the pits to be edited belongs to.

D/S Pit Displays the end pit of the sewer line to which the pits to be edited belongs to.

Comment Type any relevant comment for the pits.

Min Drop Defines the minimum drop through the pit. This drop will be automatically
applied to every pit PLUS the Hz/deg angle change drop.

Pit Diameter Defines the diameter of the pit (manhole).

Max Drop Defines the maximum drop through the pit.

Hz/deg Drop
Defines the additional drop added to the minimum drop through the pit. Drop
applied is calculated on the angle change between a pipe reach entering a pit
and the pipe reach leaving a pit

Edit All Pipes icon
The Edit All Pipes icon of the Sewer design view allows you to view and edit properties of the several pipes in
the sewer network at once.

To edit pipe parameters:
1. At the Data tab of the Sewer design view, click the Edit All Pipes icon.

The Sewer Design dialog, opened at the Pipe Data tab is displayed.
2. Define the pit selection for editing. Do one of the following:

l Select the All Pipes radiobutton to edit all existing pipes.
l Select the Pipes by Line radiobutton. If so, configure the selection. Do one of the following:

l From the Line drop-down list, select the required sewer line.
l From the U/S Pit and D/S Pit drop-down lists, select the start and end pits of the required
sewer line.

3. Tick the checkboxes for the parameters to be changed and specify their values in the appropriate fields.
Fields are described in the table below.

4. Click OK.

Fields of the Pipe Data tab of the Sewer Design dialog
Field Description

Select From Defines the selection of the pipes to be edited.

Line Define the sewer line to which the pipes to be edited belongs to.

845



Sewer design view

Field Description

U/S Pit Displays the start pit of the sewer line to which the pipes to be edited belongs
to.

D/S Pit Displays the end pit of the sewer line to which the pipes to be edited belongs
to.

Length Displays the length of the pipe, i.e. the distance between U/S and D/S pits.

Pipe Comment Type any relevant comment for the pipes.

Locked Tick to lock the properties of the pipe, so they cannot be changed by any func-
tion in the Sewer design view.

Min Slope (%) Defines the minimum slope for this pipe reach.

Min Cover Defines the minimum cover for this pipe reach.

NPipes Defines the number of pipes.

Pipe Class Defin-
ition

Defines the pipe class. It is displayed as a combination of the type of pipe, its
class and the joint type.

Pipe Diameter Defines the pipe diameter. The U/S invert and D/S invert are based on it.

Update Network icon
The Update Network icon of the Sewer design view allows you to update current sewer network to apply all the
changes made.

To update a sewer network:
1. At the Data tab of the Sewer design view, click the Update Network icon.

The Update Sewer Network dialog is displayed.
2. From the Network Name drop-down list, select the required network.
3. From the Network Settings drop-down list, select the required library settings set. See "Sewer library" sec-

tion on page 666 for details.
4. If needed, define the primary and secondary DTMs by ticking the appropriate checkboxes and selecting

DTMs from the drop-down lists to generate surfaces.
5. Nominate obstruction strings. See "Compute obstructions" section on the facing page for details.
6. In the Pit Name group box, define the pit name creation method.
7. Click OK.

Fields of the Create Sewer Network dialog
Field Description

Network Name Defines the name of the new sewer network.

Primary DTM Defines the primary DTM for generating surface.

Secondary DTM Defines the secondary DTM for generating surface.
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Field Description

Compute Obstruc-
tions

Defines obstruction strings. See "Compute obstructions" section below for
details.

Pit name

From the dialog Select to manually define the pit name in the respective editbox.

From the point
name

Select to use the point number as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

From the point
code

Select to use the point code as the pit name.
NOTE
Youmay manually edit the pit name in thePit name editbox.

Compute obstructions
MAGNET Office allows you to specify obstructions along a given pipe reach at certain depths and to specify the
clearances required. All obstruction points created in the survey view must be given heights and be joined into a
string.

An obstruction is created as a string in the survey view, with the node points defining the level of the obstruction
in or above the ground surface. The string is saved and named and set as a service.

Other networks such as Drainage networks are automatically identified as an obstruction if the other network
crosses a sewer line. Drainage network pipe sizes are extracted directly from Drainage Design.

To configure this option:
1. Tick the Compute Obstructions checkbox.
2. Click Set Obstructions.

The Select Obstructions dialog is displayed.
3. Select the required service strings from the Valid Service String list and click >>.
4. The selected strings are displayed in the Selected Obstructions list. If needed to remove a string, select it

and click <<.
5. Click OK.
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Calcs tab
Calcs group

Compute Pipe Design icon
Click it to compute the design of the pipes.

Edit Pipe Design icon
Click it to edit the existing pipe design.

Compute Pipe Design icon
The Compute Pipe Design icon of the Sewer design view allows you to compute the pipe design of current
sewer network.

To compute the design:
1. At the Calcs tab of the Sewer design view, click the Compute Pipe Design icon.

The Pipe Design dialog is displayed.
2. If needed, tick the Clear locked flag checkbox, to unlock all locked pits and pipes.
3. If needed, tick the Use BCIL checkbox to include the BCIL data to the design.
4. In the Smoothing of pipe-ends at pits group box, define the smoothing usage by selecting the appropriate

radiobutton.
5. Click OK.

The design is computed. The Sewer Design dialog, opened at the Pipe Design tab is displayed.

Edit Pipe Design icon
The Edit Pipe Design icon of the Sewer design view allows you to edit the design of the particular pipe.

To edit a pipe design:
1. At the Calcs tab of the Sewer design view, click the Edit Pipe Design icon.

The Sewer Design dialog, opened at the Pipe Design tab is displayed.
2. Click Select Pipe and select the required pipe from the list.

The selected pipe is displayed in the preview area with its pits and BCIL points.
3. If needed, tick the Update This Pipe Only checkbox, to apply any changes.
4. Review the parameters. If needed, change the design. See table below for details.
5. If needed, tick the Lock checkbox to lock the properties of the pit, so they cannot be changed by any func-

tion in the Sewer design view.
6. When finished, do one of the following:

l Click Select Pipe to select another pipe from the list.
l Click Next Pipe to proceed to the next pipe in the flow.
l Click Prev Pipe to proceed to the previous pipe in the flow.
l Click OK to close the dialog.
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Buttons of the Pipe Design tab of the Sewer Design dialog
Button Description

Set Diameter Click it to change the diameter of the pipe to another size from the pipe class
list.

Set USlope Click it to set upstream invert to a level based on the slope from the down-
stream invert.

Set DSlope Click it to set downstream invert to a level based on the slope from the
upstream invert.

Set All U/S Inv Click it to re-calculate the invert levels back upstream from the current pit or
the outlet. Set either the outfall from a pit invert level or a known outfall level

Move Parallel
Click it to move the pipe, resetting the upstream and downstream invert levels
by a relative value, prefixed with a ‘+’ or ’–‘ sign. Click Repeat to repeat the
last movement.

Move U/S Inv Click it to specify a new level for the upstream invert or change the level by a
relative value. Click Repeat to repeat the last movement.

Move D/S Inv Click it to specify a new level for the downstream invert or change the level by
a relative value. Click Repeat to repeat the last movement.

Restore U/S Inv Click it to reposition the upstream invert using the design constraints in your
data.

Restore D/S Inv Click it to reposition the downstream invert using the design constraints in your
data.

Restore Both Inv Click it to reposition both the upstream and downstream invert using the design
constraints in your data.

Select Pipe Click it to select a pipe from the list.

Next Pipe Click it to proceed to the next pipe in the flow.

Prev Pipe Click it to proceed to the previous pipe in the flow.
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Plot tab
Plot group

Profile Settings icon
Click it to configure profile plotting parameters.

Plot Profile icon
Click it to plot a profile as a drawing.

Profile Settings icon
The Profile Settings icon of the Sewer design view allows you to customize all of the parameters necessary to
create a profile drawing.

To configure a profile plotting:
1. At the Plot tab of the Sewer design view, click the Profile Settings icon.

The Plot Profile dialog is displayed.
2. Configure the parameters as you need. Fields are described in the table below.
3. Click OK.

Fields of the Plot Profile dialog
Filed Description

Sewer Line Defines the sewer line for plotting.

U/S Pit Defines the upstream pit from which you wish to start the profile plot.

D/S Pit Defines the last downstream pit of the pipe line.

Plot Format File Click << to define the format file.

Title Block Click << to define the title block for plotting.

Plot Scale Hori-
zontal Defines the horizontal scale for the profile plotting.

Plot Scale Ver-
tical Defines the vertical scale for the profile plotting.

Plot Origin X Defines the X coordinate of the starting position of the plot on the sheet of
paper in mm.

Plot Origin Y Defines the Y coordinate of the starting position of the plot on the sheet of
paper in mm.

Plot Dimension Defines the maximum size of the plot in mm. This will be dependent on the
size of the title block.

Chainage

U/S Pit Displays the running distance at the upstream pit.

D/S Pit Displays the running distance at the downstream pit.
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Filed Description

Interval Defines the interval between stations.

Zero Chainage at
D/S Pit Tick to place starting chainage at the downstream pit.

Datum Level Defines the datum level. If blank, the minimum datum level is used.

Datum Rounding
This will round the datum to the nearest multiple of the entered value. (e.g.
Enter 1.0 and the datum will be to the nearest meter) This field will have no
effect if the datum level is set

Plot Annotation Defines the annotation which will be used in plot.

Plot Option Tick checkboxes for information you want to plot.
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Window tab

New Window icon
Click it to create a new window in the work area.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.

Display Hints icon
Click it to display product hints.
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Cut/Fill Design View
The Cut/Fill Design view allows you to view and plot existing cut/fill color maps.

The main view displays the cut/fill map itself. It has its own ribbon, different from the MAGNET Office default
ribbon, see descriptions below.

File tab
Standard group

Open icon
Click it to open an existing cut/fill map.

Save icon
Click it to save current cut/fill map.

Close icon
Click it to close current cut/fill map.

Print group

Print Setup icon
Click it to configure plotting of the current cut/fill map.

Print icon
Click it to plot the current cut/fill map.

View tab
Navigate group

Zoom icon
Click it to see the list of the zoom options.

All icon
Click it to fit all data in the view.

Window icon
Click it to draw a rectangle area to be fits the screen.

Previous icon
Click it to return to the previous view.

In icon
Click it to zoom in the center area of the survey view.

Out icon
Click it to zoom in the center area of the survey view.

Pan icon
Click it to scroll the view

853



Cut/Fill design view

View group

Toolbar icon
Click it to enable/disable toolbar.

Status icon
Click it to enable/disable toolbar.

Settings tab
Display settings icon

Click it to configure the layout of the cut/fill map.

Window tab

New Window icon
Click it to create a new window in the work area.

Cascade icon
Click it to cascade windows in the working area.

Tile Horizontally icon
Click it to tile windows in the working area horizontally.

Tile Vertically icon
Click it to tile windows in the working area vertically.

Help tab

Help icon
Click it to open product help.

About icon
Click it to display information about MAGNET Office application.
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Display Hints icon
Click it to display product hints.
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MAGNET Office Activation
To use full functionality of the MAGNET Office you have to perform online or offline activation. Online activ-
ation of the application requires an Internet connection of the computer where the application was installed.

When you first start the application, the Product Activation dialog prompts you to select the activation method.
Select one of the following radiobuttons:

l Online – to perform the online activation. See "Online activation" section on the facing page for details.
l Network – to perform activation within your network. See "Network activation" section on page 859 for
details.

l Offline – to perform the offline activation. See "Offline activation" section on page 860 for details.

Also you may close the dialog to postpone the activation and run the application in demo mode.
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Online activation
At the Online activation page you may activate the MAGNET Office by using your Enterprise account; also you
may change or reset your enterprise password.

To perform an online activation:
1. At the Activation type page, select the Online radiobutton and click Next.

The Mange account page is displayed.
2. Select the Logon with MAGNET Enterprise account radiobutton and click Next.

The Enterprise logon page is displayed.
NOTE
An e-mail which you have received from Topcon, when your company's account administrator adds you
into the user list, contains only a temporary password. The temporary password does not allow you to
establish the connection with MAGNET Enterprise. Please follow the recommendation from the e-mail to
update your password.

3. Specify you login (e-mail) and password in the respective fields.
4. Click Next.

The Online activation page is displayed.
5. In the Serial number field, specify your serial number.
6. From the Device-id drop-down list, select the device to which your serial number will be assigned. You

may select one of the following:
l An identification number of the computer. In this case, the serial number ties to the computer and
operation system (OS) of this computer. If the OS is reinstalled, the system identical number
changes and activation is disabled.

l An identification number of the computer's network card. In this case, the serial number ties to the
network adapter. A reinstallation of the OS does not affect the application activation.

l An identification number of the external USB flash drive. The type of the given driver must be
approved by Topcon Company to use in MAGNET activation procedure. In this case, the serial num-
ber ties to the external USB flash drive. You can use the given serial number and the given USB
flash drive for activation of the application on any computer.

NOTE
The application is activated only if the USB flash drive is plugged to the USB port. Removing of the
USB flash drive will disable the activation. Youmay re-plug the USB flash drive and any time – the
activation will be restored after the next launch.

7. Click Next.

The License agreement page is displayed.
8. Carefully read the End User License Agreement.
9. Tick the I have read, understand and agree with license checkbox.
10. Click Next.

The application checks the entered serial number. If the number is correct, the MAGNET Office is activ-
ated and the table, listing available modules is displayed.

If you do not have an Enterprise account, contact your Administrator to obtain it. Only Administrators may create
accounts. If you are going to work in a team of the Company, you should not create an account yourself – the
Administrators are unable to add account, created by user to the Company account.

To change a password:
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1. Select the Change password radiobutton.
2. Click Next.

The Change Password page is displayed.
3. In the Login (email) editbox, type your Enterprise login.
4. In the Old password editbox, type your current password.
5. In the New password editbox, type your new password.
6. In the Confirm New editbox, re-type your new password.
7. Click Next.

To reset a password:
1. Select the Forgot password radiobutton.
2. Click Next.

The Reset password page is displayed.
3. In the Login (email) editbox, type your Enterprise login.
4. Click Next.

Topcon will send you a temporary password to your e-mail address.

The confirmation message is displayed.
5. Click OK.

The Change Password page is displayed.
6. In the Login (email) editbox, type your Enterprise login.
7. In the Old password editbox, type temporary password from the e-mail.
8. In the New password editbox, type your new password.
9. In the Confirm New editbox, re-type your new password.
10. Click Next.
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Network activation
When the several users from one company simultaneously work with MAGNET Office, Topcon recommend per-
forming the software activation via network activation. This way supposes:

l the users computers are joined in a local subnet
l a server is organized.

This server (a computer) has to be located on the same subnet. The special software is installed on the server com-
puter for the coordination the use of a licensed application by multiple computers.

Before running MAGNET Office, all users have not activated MAGNET Office on the computers. After running
the software, the user selects the network activation. During activation the software sends a request for a license
across the network to the license server. The server will grant license authorization to the requester after verifying
licensing conditions for the given product.

To perform network activation:
1. Select the Network radiobutton.
2. Click Next.

The Network Server Setup page is displayed.
3. In the Server field, specify the license server.
4. In the Port field, specify the port for connection.
5. From the Product name drop-down list, select the required product.
6. Click Next.

The License agreement page is displayed.
7. Carefully read the End User License Agreement.
8. Tick the I have read, understand and agree with license checkbox.
9. Click Next.

The application sends request to the license server. If the license is granted, the MAGNET Office is activ-
ated and the table, listing available modules is displayed.
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Offline activation
You must have the activation code to perform the offline activation. Contact your Administrator to obtain it.

To perform offline activation:
1. At the Activation type page, select the Offline radiobutton.
2. Click Next.

The Offline activation page is displayed.
3. In the Serial number field, specify your serial number.
4. From the Device-id drop-down list, select the device to which your serial number will be assigned. You

may select one of the following:
l An identification number of the computer. In this case, the serial number ties to the computer and
operation system (OS) of this computer. If the OS is reinstalled, the system identical number
changes and activation is disabled.

l An identification number of the computer's network card. In this case, the serial number ties to the
network adapter. A reinstallation of the OS does not affect the application activation.

l An identification number of the external USB flash drive. The type of the given driver must be
approved by Topcon company to use in MAGNET activation procedure. In this case, the serial num-
ber ties to the external USB flash drive. You can use the given serial number and the given USB
flash drive for activation of the application on any computer.

NOTE
The application is activated only if the USB flash drive is plugged to the USB port. Removing of
the USB flash drive will disable the activation. Youmay re-plug the USB flash drive and any time –
the activation will be restored after the next launch.

5. Specify the activation code. Do one of the following:
l Select the Use activation code radiobutton and specify the code in the appropriate editbox.
l Select the Import activation code from file radiobutton and click Browse to define the license (*.lic)
file, containing and activation code.

6. Click Next.

The License agreement page is displayed.
7. Carefully read the End User License Agreement.
8. Tick the I have read, understand and agree with license checkbox.
9. Click Next.

The application is activated and the table, listing available modules is displayed.
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